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The Dionex Chromatography
Management System - Tutorial

Welcome to the Dionex CMS, the innovative chromatography
management system!

This tutorial will help you to learn how to use the Dionex Chromatography
Management System step by step:

• Starting the program

• Performing an analysis

• Reprocessing data

 Tip: The following arrow ÎÎÎÎ    marks references within the Tutorial.
The arrow is given in front of the title to which the reference
relates:  (e.g.  ÎÎÎÎContents Overview).
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Contents Overview

I. ÎStarting the Dionex Chromatography
Management System: As soon as your
computer and one of the operating systems
Windows 98 or Windows NT/Windows 2000
are running, the Dionex Chromatography
Management System can be started via the
Windows Start button on the task bar.

II. Managing Data: The Dionex
Chromatography Management System
allows you to manage data in folders and
directories similar to Microsoft Windows.
The tool that helps you to handle your
chromatography data is the ÎBrowser.

III. Controlling your HPLC system: Ensure
that your chromatography, HPLC, GC, or
CE instruments are correctly connected to
the PC via a serial port. Using the ÎControl
Panel allows you to operate the pump,
autosampler, detector, etc. from your PC. In
addition, you can create a ÎControl File
(PGM File) to control your system
automatically.

IV. Analyzing Samples: Are your instruments
controllable via the PC? Then, you can start
your first analysis. Create a ÎSample List
(= Sequence) to use all capabilities the
Dionex Chromatography Management
System offers.
Use the ÎSequence Wizard to include the
samples to be processed in the sample list.
The Wizard allows you to define the order
of sample processing, the injection
volumes, the sample type (analysis or
standard), and where the Dionex
Chromatography Management System
finds information on how to perform the
analysis.
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The latter is by entering a program and a
method name, and by creating the
corresponding files (PGM file, QNT file, see
below).
As soon as you have created the sample
list, you can start the ÎAnalysis. The
resulting data is automatically saved.

V. Reprocessing Data: The analysis result
can be viewed and edited on the screen.
ÎData Reprocessing allows you to
manually change integration limits directly
in the chromatogram or to evaluate samples
again ("offline") based on new parameters.

VI. Quantifying: Using a ÎQuantification
Method (QNT File) allows you to minimize
the reprocessing effort for individual
chromatograms. The QNT Method defines
the detection parameters, the peak
identification, and the calibration of the
substances in the sequence.

VII. Printing Results: Analysis data can be
Îprinted at any time. For perfect
adjustment to your personal requirements,
you can create your own report templates in
the ÎPrinter Layout, define your own result
variables, or embed your company logo.

VIII. Online Help: This Tutorial can only deal
with selected aspects of the Dionex
Chromatography Management System. For
further information, please see the detailed
descriptions in the ÎOnline Help or in the
User Manual.
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I. Starting the Dionex Chromatography
Management System

The Dionex Chromatography Management System can be used both, under
Windows 98 and Windows NT/Windows 2000. It has been designed as
client/server program to allow operation in a network.

The main characteristic of client/server systems is: Certain processes are
performed on the client, while others run on the server. The correct cooperation
between the client and the server is crucial to the full functionality of the
program. The client and the server are not required to be located on the same
computer. Communication via a network or a modem will be sufficient. Since
the client and the ÎServer are independent programs, they have to be started
separately.

• Click the Start button to open the Start menu. Move the mouse cursor to
Programs to display the submenus.

• Move the mouse cursor to the submenu of your Dionex Chromatography
Management System, e.g. CHROMELEON. Again, several submenus are
shown.

Starting the Client Program
• Click CHROMELEON to start the chromatography management system.

• If User Management was enabled during the installation, a logon dialog box
appears. In this case, enter your user ID and your personal password.
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Starting the Server Program

If you do not only want to view data but control an entire chromatography
system and perform your own analyses, you need to start the server program
(Server Monitor). The server controls all connected instruments and allows
direct instrument operation and control via the PC.

• Choose Server Monitor to start the Chromeleon Server Monitor program.
The CHROMELEON icon appears on the Windows task bar next to the
Windows system clock.

 Tip: When being installed, the Dionex Chromatography Management
System creates a link in the Autostart group and the
corresponding icon will be displayed. You can also configure the
program to start whenever the computer is started.

• Move the mouse cursor over the icon. You will see the quick info message:
CHROMELEON Server is not running.

• Open the context menu (right mouse button) and choose Start Server (or
double-click the icon and press Start). The icon goes through different color
phases. Gray coloring indicates that the server is running idle.
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• Both, the client program and the server program are active now. The client
control panel allows direct access to all instruments connected to the
server.

 Note: The instruments of a system are combined in a common
ÎTimebase. Installing and configuring instruments and
timebases are via the installation program (= Server
Configuration). The Dionex Service normally performs this during
the installation.
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II. The Browser
The Browser window is loaded automatically whenever the Dionex
Chromatography Management System is started.

Opening the Browser

• Click the Browser icon  to open the Browser window or to display it on
top.

1. Browser Appearance and Functions

 Caution: The Browser window is similar to the Windows Explorer.
However, do not confuse the Browser window with the Windows
Explorer! Do not use the Windows Explorer for operations within
the datasources of the Dionex Chromatography Management
System!

The left window section consists of a tree structure with different levels. The
right window section shows detailed information on the currently selected item.
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The ÎDatasources (e.g. <ComputerName_local>) are the top level of the
structure and serve to store data and results. The icon next to the datasource
name indicates its type (CHROMELEON, GynkoSoft etc.).

• Click the + or - symbol next to a datasource to expand or collapse the
corresponding directory structure (yellow folders).

The lowest levels contain the ÎSequences (blue folders) created by the user.
The easiest case is that one sequence is created per timebase when the
Dionex Chromatography Management System is installed. This sequence is
called Manual and is located in a separate directory of the local datasource.
The directory has the name of the local timebase.

• Select a directory to display its subdirectories in the right window section.

• Select a sequence to view files and samples contained in the sequence.
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The upper window section shows different file types,

Symbol File Extension File Type
*.pgm Control file or PGM file

*.qnt Quantification method

*.rdf Report template or report
definition

while the lower window section shows the individual samples of the sequence
in the sample list. The different icons stand for the different sample types:

Symbol Name Sample Type
Unknown Unknown sample

Blank Run Blank

Validation Validation sample

Standard Standard sample

 Matrix Matrix blank sample

Opening Files
Open a file by double-clicking its name in the Browser window. Depending on
the file type, the Dionex Chromatography Management System will load the
appropriate chromatographic environment.

• Double-clicking a control file (PGM file) opens the PGM editor.

• Double-clicking a quantification method (QNT file) opens the QNT editor.

• Double-clicking a PAN file opens a control panel.

• Double-clicking a report template (report definition file = RDF) opens the
Printer Layout.
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Opening Samples
When opening samples, consider the following (independent of the file type):

• If for a processed sample (Status = finished) raw data exist for several
channels, double-clicking the sample opens one channel only.

• Select a sample (here sample1) and open the context menu via the right
mouse button. Choose the channel to be opened. In the submenu of the
Open command, the Dionex Chromatography Management System lists all
channels that exist for one sample.

If four different channels of a sample are recorded with a diode array detector
during sample processing, as is in this example, a separate chromatogram will
be available for each channel (here: 3DFIELD and UV_VIS-1 to UV_VIS-3).

• Select the channel or the chromatogram you wish to view.

The highlighted channel (here: UV_VIS-1) is used as the "preferred channel".
The preferred channel is automatically opened when double-clicking a sample.
The channel to be used by the Dionex Chromatography Management System
as preferred channel is set in the File menu under Preferences.

Moving and Copying Items
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• Use the mouse cursor to select the subdirectory, the sequence, or the file
you wish to move or copy. Within a datasource, dragging and dropping an
object will move the item. However, when you drag an item from one
datasource to another, it will be copied, not moved.

• Simultaneously holding the CTRL key copies the item instead of moving it
and moves it instead of copying it, respectively.

• Exception: For security reasons, samples can only be copied and deleted
afterwards. They cannot be moved directly!

2. Installing Datasources
Datasources
Datasources represent the top level in the Browser. Each user can access at
least one datasource, the default datasource created during the installation
(<PC-NAME_LOCAL>).

Creating additional datasources or accessing datasources on other computer in
the network is often useful. Therefore, these options are supported as well. The
section below describes how to create links to other datasources (Note: for a
detailed description of how to create a new datasource, refer to the section
How to ...: Actions in the Browser / Setting up a Datasource in the User
Manual and the Online Help).

All steps required for setting up datasources start via the Datasources
command in the File menu.

• Open the Browser and choose the Datasources command.

The Datasource Manager shows all datasources that the client can currently
access.
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Connecting an Existing Datasource ("Connect")
If the user knows the directory in which the other datasource is located, he can
connect to this datasource.

• Press the Connect button of the Datasource Manager to establish the
connection.

• Choose the format of the underlying database.

Usually, you will select datasources of the Dionex Chromatography
Management System (Native Chromeleon Data Source) or "old" directories of
the GynkoSoft chromatography data system (= "GynkoSoft Drives" from
version 5.xx). Other formats that are supported include default Microsoft
Access databases (mdb container), SQL server, and Oracle databases.

• Choose the appropriate datasource type and press OK.
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• Via the following dialog box, navigate to the network folder that houses the
datasource.

• Select the folder and press OK.

 Caution: If the folder and the datasource are located on a remote
computer, the user of the computer must share the
corresponding folder (Windows 98 command: "Shared as")! If he
does, the connection to the selected datasource will be
established. The name and the type icon of the datasource will
appear in the Browser.
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3. Finding Samples (Query)
Often, you will have to find samples according to defined problems. Instead of
endlessly poring over old folders, you can use the query function of the
Browser to do so easily, fast, and purposefully. Select New in the File menu to
start the Query Wizard:

On the first query page, define whether to perform the query in the selected
datasource or in a fixed one. Also, define whether to search for sequence
properties, sample properties, or any other properties of samples.

On the next pages, define the variable whose properties you want to find in the
Data Field. Select an operator and define the value. The combo box to the
right of the respective line allows you to enter a logical connective with another
query property. Only after having entered AND or OR you can enter another
property:
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The following query searches for all samples with
• sample type = Matrix Blank and

• whose comments start with Charge 123456 or

• an injection date between 2/2/2000 and 2/3/2000

On the next page, enter the following settings in order to restrict the query to
samples
• containing an Anthracene peak or

• containing more than 10 calibration points.
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4. Saving / Exchanging Data (Backup/Restore)
In the course of time, large amounts of data will result, especially when PDA
detectors are used, but also when a great number of sequences is recorded.
To ensure that you can continue to store data on your hard disc, you have to
delete some of your data from time to time. However, these data must not be
destroyed permanently. They still have to be available for future use. Of
course, you can save the respective sequences and datasource on your
network as well.

However, the Dionex Chromatography Management System offers the
possibility to backup sequences, directories, or entire datasources and save
these backup files (which can also be compressed) e.g. on CD. Proceed as
follows:
• Select the object to be saved.

• Use Backup of Export/Backup command in the File menu.

• Indicate where to save the backup file and define all further backup options:
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• Start the Backup to create the backup file. The extension of the backup file
is cmb.

Data that were saved in this way can be used again later via the Restore
function. Use Restore of Import/Restore command in the File menu. Find the
respective backup file and indicate where to restore it.

The Backup and Restore functions are an easy way to save large amounts of
data in such a way that they can be quickly accessed later. Structure and
cross-references remain intact. In addition, these functions facilitate
exchanging data via E-mail.

5. Electronic Signature
Electronic Signature allows you to sign the results from your ÎRaw Data,
which is an important function within the scope of quality assurance and GLP.
Thus, you can sign and save ÎSequence reports that have been accepted as
correct so that the results can be checked and understood to the last detail.
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Electronic Signature includes three steps:
• Submit

• Review

• Approve

Typically, the report is signed and submitted by the user who created it.
Having reviewed the report, the laboratory manager will sign it. Finally, the
quality assurance manager will approve the results.

 Note: Electronic Signature is available only for activated user databases
that have been created with version 6.10 (or a higher version) of
the CmUser program. Update your database by opening it with a
new CmUser program (version 6.10 or higher) if an error message
notifies you that electronic signature will not be possible.

To sign a sequence proceed as follows:
• Click the sequence and select the Submit Results command (first

signature step) in the context menu.

• In the opening dialog, select the pages to be signed, the report definition file
(RDF), and the channel:
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• The Check Signed Results dialog box opens which allows you to check
the reports to be signed. Use the arrow keys to toggle between the samples
of the sequence. For each sample, the tabs for the selected report pages
are displayed. Having terminated your checks, press OK:

• Sign these pages by entering your User ID and your signature password in
the opening dialog box.
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• The extension of the newly created file is .SOR.

• Use the Verify command (see File menu: Electronic Signature) to let your
chromatography management system check the signed report of the
sequence once again, i.e. the sequence, the corresponding files (pgm, qnt,
rdf, sor), and the individual samples.

The Signature tab in the sequence property dialog indicates the status of the
current sequence:
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A signature can be removed only if the user has the corresponding privileges
assigned. Removing the signature also deletes the corresponding SOR File.
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III. Control

1a) The Control Panel
The Dionex Chromatography Management System allows controlling one or
several analysis instruments via the Control Panel.

The above screen shows a control panel that allows controlling the basic
functions of a pump, an autosampler, and a two-channel UV detector. On the
right, you can see the detector signal.

The user can change the appearance and the functionality of a control panel.
The Dionex Chromatography Management System includes numerous default
control panels that cover most applications.

Opening a Default Control Panel
From the Browser
• Open the Panels directory and select the control panel corresponding to

your system.

• Double-click the name of the window to open it.
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From the File or context Menu
• Choose the Open command from the File menu.

• In the Open dialog box, select Control Panel under Object of type.

• Via the Look in field, choose the local ÎDatasource of the system. When
installing the Dionex Chromatography Management System, this
datasource is automatically saved on your computer.
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The datasource has the name <NAME_LOCAL>, where <NAME> is
replaced by the Computer name listed under Network/Identification in the
Windows Control Panel. If the Look In field contains further datasources,
you can also search here for an appropriate control panel.

• Open the Panels directory and choose one of the default control panels (
*.pan).

• Double-click a name to open the window.

As soon as a control panel has been opened, the Dionex Chromatography
Management System will attempt to establish a connection to a specific
ÎTimebase. With the control panels that are included in the Dionex
Chromatography Management System, a link to the SYS1 timebase on the
local server will be created.

If it is not possible to establish a connection, the control panel is grayed. The
system shows an error message.

1b) Connecting a Control Panel with a
Timebase

If a control panel is currently open, you can establish a connection to a
timebase at any time. However, the server on which the timebase was installed
needs to be started as described under ÎStarting the Dionex Chromatography
Management System.

• Choose the Connect to Timebase command from the Control menu to
create or change the timebase assignment (ÎOnline Help).

• Via the following dialog box, determine the ÎServer and the ÎTimebase to
which you whish to connect the control panel.
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• If the server is started locally on your computer, you can click the +
character to open the My Computer submenu. If the server is running, the
names of all timebases that are installed on the respective server will be
displayed. If the server is not running, a corresponding message will be
given. In this case, you need to start the server first before you can choose
the desired timebase (e.g. SYS1). The Computer field will automatically
show your PC, i.e. its name that was determined during the Windows
installation. In the Protocol field, the entry My Computer will appear.

• If your PC is connected to other computers via a network or a modem,
accessing a server that was not started on your local computer, but another
PC is possible as well. In this case, open the Network Neighborhood
submenu to browse for the required timebase. Under Protocol, the
corresponding network protocol will be given.

• The Dionex Chromatography Management System remembers the servers
that you have accessed on other computers. These servers can be selected
under Favorites.

As soon as you complete the dialog, the Dionex Chromatography Management
System will attempt to access the timebase you selected. If there is no
communication, this may be due to several reasons.
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Possible Problems when Connecting to a Timebase

Cannot connect to timebase ...

⇒ This error message indicates that the corresponding server is not running,
that the selected timebase does not exist on this server, or that the wrong
protocol was selected for the communication.

• Start the server as described under Starting the Dionex Chromatography
Management System or select the required timebase or protocol.

 Tip: The Dionex Chromatography Management System can
communicate via various network protocols such as IPX,
TCP/IP, or NetBEUI. Communication between two stations is
possible only if the same (!) network protocol is installed and
selected. Generally, it is sufficient to install the corresponding
Microsoft ("IPX/SPX-compatible protocol"; "NetBEUI"; "TCP/IP")
or Novell ("Novell IPX ODI Protocol") network protocols via
Settings/Control Panel/Network/Configuration. Which
protocol is actually used depends on the current network
installation. Please contact your network administrator. If a
connection should be established to a Windows NT computer,
this is frequently via the supplied Named Pipes protocol.

This timebase contains no object named...

⇒ The control panel attempts to access an instrument (or a function of this
instrument) that is not part of the current installation environment. The control
panel and installation environment do not correspond. Load an appropriate
control panel or change the existing configuration of the timebase in the
installation program (= Server Configuration). For details on how to change the
server configuration, see How to ...: Actions in the Server Configuration
Program in the User Manual and the Online Help.
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Device is not remote.

⇒ The control panel attempts to access an instrument that is currently not
ready to operate. Check whether all instruments listed in the configuration are
actually connected to the server PC and that they are switched on. It may be
necessary to restart the instrument to ensure the proper functionality.

The connection is established correctly (no error message), but the
controls are grayed.

⇒ The Monitor Only mode is activated. The control panel cannot be actively
operated. This is always the case when the selected timebase is already
controlled by a different workstation. The Monitor Only mode can be
deactivated via the Control menu. After that, actively controlling the timebase
is possible (which indicated by the controls on the control panel).
Simultaneously, the previously controlling workstation loses the control rights
and is in the Monitor Only mode.

 Tip: Follow the Audit Trail entries. It is usually possible to draw
conclusions about the error.

1c) Using the Control Panel
As soon as a control panel is correctly connected to a timebase, the individual
instruments of this timebase can be operated via the controls shown in the
window.

Depending on the currently used default control panel, various active and
passive control and display elements (Lamp, ... Signal Plot) are available for
controlling instruments and for displaying system functions. The appearance of
the controls (size, shape, and color) can be altered.
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The basic commands such as controlling the pump flow, the inject command,
or starting the data acquisition are available via a separate toolbar. This toolbar
is only active with an open control panel.

However, how will the system know that moving a slider should change the
pump flow, and not the oven temperature? Very simple: It is not only possible
to change the size, the color, and the shape of each control, but also its
functionality. These assignments are preset for the controls of the default
control panels. Of course, you can change them according to your
requirements.
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1d) Modifying the Control Panel
Changing the Functionality and the Shape of Controls

 Note: If it is not possible to perform the following steps with your
software version, you do not have the user privileges required for
these actions. In this case, contact your system administrator.

• Move the mouse cursor on the corresponding control and open the context
menu (right mouse button).

• Choose the Properties command to open the edit box.

Depending on the selected control, the Properties dialog box includes various
tabs. For a slider, the Style tab will look as follows:

• Choose the General, Color, or Style tab to change the appearance such as
the color, the shape, or the caption of the control.

• Choose the Link tab to determine the function and the instrument to be
operated via the control.
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• Under Object, choose the instrument itself and under Object Property
choose the instrument's function. Instrument and function selection depend
on the components installed with the timebase.

With the settings shown above, a slider can control the pump flow rate.

2. The Control File (PGM File)
By entering commands, the user can instruct individual instruments to perform
specific tasks. Commands can be entered either via the controls on the control
panel or by pressing the corresponding buttons.

As this can be time-consuming, it is also possible to list the series of required
commands in a file. When starting the file, the listed commands are executed
consecutively, observing the relative time differences. This file type is called
control file or PGM file.
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Control File Properties
The control file window will be similar to the following illustration:

Below the Title line, there are various commands (starting with the time entry).
For information on how to create a PGM file, see the following sections.

3. The Program Wizard
Using the Program Wizard is recommended for creating a basic program
structure. This is especially true since a specific syntax must be observed for
entering the commands.
• Check whether the server is running. If not, start the server as described

under ÎStarting the Dionex Chromatography Management System.

• Choose the New command from the File menu.

• Choose Program File from the list and press OK to start the Program
Wizard.
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Depending on the installed instruments, various steps must be performed. For
each screen, detailed information is available via the F1 key or the Help button.
Pressing Back or Next allows you to toggle between the edit screens.

Step 1: Timebase and Server
Determine the server and the timebase to be used.

• If the server was started locally, click the + sign to open the My Computer
submenu and select the desired timebase. Choose My Computer in the
Protocol field. If you want to access a server that was not started on your
computer but on a remote PC, open the Network Neighborhood submenu
and click the appropriate timebase there. In this case, you have to select a
network protocol under Protocol. For details, press the F1 key.
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The Next button allows you to proceed to the next page of the Program
Wizard. Press Finish to generate a program with the settings you made so
far.

Step 2: Flow Conditions
If your chromatography system includes a controllable pump, define how to
operate the pump.

• Choose isocratic to deliver a constant solvent composition. Under %A,
%B, etc. you can enter the names of the currently used solvents. Instead of
%A, %B, etc. the actual solvent name will be indicated in the control panel
or in the report. If more than one solvent is used, the Start field determines
the solvent composition in percent (e.g. B = 45%, C = 0%, D = 5%). %A is
calculated by the system from the portions of B, C, and D. Enter the flow
rate under Total Flow.
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• If Ramp is selected as type instead of Isocratic, you can set the start and
end time of the gradient ramp. You can also select a multi-step gradient.
In this case, click Next to open another edit box.

Step 3: Gradient
The Flow Gradient Options window allows specifying a gradient. Enter the
following data:
• Retention time

• Flow

• Solvent composition

To append lines to the table, press the down arrow key on your keyboard. The
window will show a graphical representation of your gradient. A blue line
indicates the flow, while the area represents the gradient composition. The
following example shows a gradient at a flow rate of 1 ml/min, with a constant
5%D during the entire gradient.
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Step 4: Data Acquisition
After that, determine the signals to be recorded during sample processing.

• Select the signals. Under Acquisition Time, enter how long an individual
sample should be analyzed.

For a two-channel UV detector, e.g. the channels UV_VIS_1 and UV_VIS_2
are recorded for 30 minutes (From 0.000 min to 30.00 min). 0.000 means that
data acquisition starts immediately after the injection (t = 0).
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Step 5: Signal Parameters
Define the signal parameters for each signal that was selected under Step 4.

• Depending on the signal type, various parameters must be set (e.g.
Excitation Wavelength for the fluorescence detector). In the case of a UV
detector, the wavelength, the bandwidth, and the step used for recording
(e.g. Wavelength = 225nm, Bandwidth = 1nm, Step = Auto, Average = On
(selected) must be specified.

Step 6: Completing and Saving the Program
• Choose Finish to complete the Program Wizard. In addition to your input,

the completed program that is displayed in the QNT editor also includes
commands that are automatically added by the Dionex Chromatography
Management System (e.g. Inject and End commands). These commands
are required for executing the file. The completed program may have the
following appearance:
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• You can edit a completed program later, as necessary. If invalid commands
are entered, the Dionex Chromatography Management System will
recognize these and show the respective line in red (Glow instead of Flow
in the above example).

• Save the PGM file under a descriptive name via the Save as command
from the File menu.



III. Control T-41

4. Editing the Control File
Each line can be edited directly via the keyboard, provided the control file is
connected with a timebase.

• Open the PGM file via the Open command from the File menu or double-
click the corresponding file name directly in the Browser.

• Check whether your server is running. If not, start the server as described
under ÎStarting the Dionex Chromatography Management System.

• Choose the Connect to Timebase command from the Control menu.

You can now edit the program. Instead of overwriting the command syntax
directly in the PGM file, we recommend to proceed as follows:
• Move the mouse cursor in the line to be edited; press the F8 key. The

Dionex Chromatography Management System opens the Commands
dialog box for the currently selected command. You can now edit the input
by selecting defined values, without having to worry about the correct
syntax of each command.

• Save the edited PGM file (Save as).

 Caution: If you have not specified a control file when creating a sequence
(Step 4 of the Sequence Wizard), the fields of the Program
column in the sample list will be empty! In this case, change to
the Browser, select the sequence, and enter the name of the
PGM file for each sample that is to be processed based on the
created program. Copy each required PGM file to the sequence
directory afterwards.
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IV. The Analysis

1. The Sample List (Sequence)
Opening the Sample List (Sequence Table)
• Select a sequence (blue folder) in the left Browser section to view all

samples and files contained in that sequence in the right Browser section.

The upper section is reserved for files that are (or were) required for processing
a sample. The lower section lists all samples belonging to the selected
sequence. This section is referred to as Sample List.

Sample List Contents
The sample list forms the basis for sample processing. It lists the samples
intended for processing (one line corresponds to one sample) and how
processing is or was performed (contents of individual columns).

For example, the table can contain the volume in µl (Inj.Vol column), the
position (Pos), the program (Program) that is used for processing the sample,
and the method (Method) used for evaluation purposes. The vial color in the
Name column indicates whether the sample is an unknown sample (=
Unknown (blue)) or a standard sample (= Standard (yellow)). The current
sample status is indicated in the Status column. If the sample was already
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processed, i.e. analyzed, it is labeled finished. Samples to be processed are
labeled single. If the sample is currently processed, the entire line has a green
background. The sample status is running. Multiple indicates that the sample
can be processed several times, however, with the old run being overwritten
each time.

Samples are always processed in the order of their appearance in the sample
list.

2. The Sequence Wizard
Start the Sequence Wizard to create the basic structure of a sample list.

Starting the Sequence Wizard
• Choose New from the File menu.

• From the list, choose Sequence (using Wizard).

• Press OK to start the Sequence Wizard.

A sequence is created in five steps: Each step is performed on a separate
page. For each page, detailed information is available via the F1 key or the
Help button. Pressing Back or Next allows you to toggle between the pages.

Step 1
Specify the timebase on which the sequence to be created shall run. Select a
timebase in the right window section. The corresponding entries for Computer
and Protocol will be made automatically.

• Enter a name in the Sequence Name field, choose the local datasource
<USERNAME_LOCAL> in the Datasource field, and generate a separate
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sequence directory in the Directory field (creating a new directory at this
point is possible).

 Caution: Do not use special characters (e.g. umlaut) for new directory
names or sequences, as this may cause problems in Novell
networks!

Step 2
Generate all unknown samples to be processed.

• Choose Use Template; enter the number of samples to be processed
(Number of Vials), the sample volume to be injected (Injection Volume),
the number of injections (Injections per Vial), and the position of the first
sample (Start position). Then enter a sample name and use the arrow key
to add e.g. "#n" to number the samples consecutively (e.g. "sample#n").
Press Apply to view the result of your input as sample list (Sequence
Preview). If the result requires editing, e.g., because the injection volume
should not always be the same or because the positions of the individual
vials are not consecutive, you can change the information manually in the
Browser after closing the Sequence Wizard. In the Rack Preview, you can
also view the positions for the currently entered samples in the rack.



T-46 IV. The Analysis

Step 3
Generate all standard samples to be processed.

• Proceed as in step 2. In addition, you can specify any number of standards
(Variation:) that shall be analyzed after a specified number of samples
(after each).

Step 4
Determine how to process, evaluate, and print the sequence.

• Enter the name and the directory of the ÎPGM file and the ÎQNT file to be
used (see the Program and Quantification Method fields) or choose a file
via the Browse... button. If you have not generated a new PGM file or QNT
file before, you can leave these fields empty for now.
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• Under Preferred Report, choose the DEFAULT.RDF report template from
the REPORT directory of the local database to open the default report.
Choosing a Preferred Channel determines the channel whose the data are
to be displayed.

 Note: The Quantification Method, Preferred Report, and Preferred
Channel fields are optional at this point.

Step 5
Specify the name for the sequence to be created and where to save it.
• Enter any name in the Sequence Name field and select the local data

<BENUTZERNAME_LOCAL> in the Datasource field. Generate a separate
sequence directory by specifying a directory name in the Directory field (a
new directory can be created as well).
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 Caution: Do not use special characters (e.g. umlaut) in new sequences
and directories names as this may cause problems in Novell
networks!

• Press Done on the last page of the wizard to complete your input.

Editing the Sequence
Pressing Finish generates a sequence based on the entered information. The
sequence is displayed in the Browser. As mentioned before, the sequence is a
basic structure that needs to be adjusted to special requirements.

If, for example, you wish to inject different volumes, edit the sequence. Also,
select a PGM and/or a QNT file if you have not specified these files in step 4 of
the Sequence Wizard.
• Change to the Browser and select the name of the newly created sequence.

• In the sample list, change individual fields directly via the keyboard or open
an edit box by pressing the F8 key.

• Adding samples is possible via Append new line.

3. Starting the Analysis
Analyzing one sample can be performed manually. For several samples,
automatic sample processing is recommended.

 Tip: Creating the sample list, the control file, and the quantification
method is only required for automatic sample processing!

Manual Sample Processing
The analysis is performed systematically by entering single commands.

• Open a control panel and connect to the desired timebase.

• Choose the Flow ... command from the Control menu (or use the

corresponding button on the Online toolbar: ). Enter the flow rate and
the solvent composition the pump should deliver.
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• Choose the Inject... command from the Control menu (or use the

corresponding button on the Online toolbar: ). Enter the injection
volume in µl and the autosampler position.

• Choose the Acquisition On command from the Control menu (or use the

corresponding button on the Online toolbar: ). Choose the signals to
record and start data acquisition by pressing OK. The injected sample
amount is transported over the column. The chromatography management
system records the signals supplied by the detector.

These commands are also included in the Online toolbar. If your control panel
supports this, you can execute these commands directly from the control panel.

• If you want to finish data acquisition and thus complete the analysis, choose
the Acquisition Off command and stop the pump flow (Stop Flow).

If your control panel is connected to a timebase on the local server, the
recorded data is saved to the Manual sequence in the <Timebase Name>
directory of the local datasource.

Creating this sequence is not required. The sequence is automatically
generated during the installation; it contains one sample only. With each
new manual sample processing, the data is overwritten by the newly
analyzed sample. This type of sample processing should be used for test
runs etc. only!

Automatic Sample Processing
Automatic sample processing can be started as soon as the chromatographic
conditions, the samples to be processed, and their order have been defined
during sequence creation.

Automatic sample processing is also called Online Batch or Batch
Processing.

• Open a Control Panel and choose the Edit command from the Batch menu.

Alternatively, press the  icon on the Online toolbar.
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• Press the Add button on the Batch List tab and find the previously created
sequence within your datasource via the Open dialog box.

The path and the name of the sequence are entered in the Batch dialog box. If
a sequence contains a sufficient number of samples, sample processing is
possible around the clock. Instead of listing all samples in one sequence, you
can create several sequences. In this case, enter all required sequence names
in the Batch List (max. 16).

• Add the sequences until all required sequences are displayed in the display
field.

The order of the listed sequences determines the order of sample processing,
i.e., when starting a batch, samples 1 to n of the first sequence are analyzed,
followed by samples 1 to n of the second sequence, etc.
• Select a sequence and change the processing order via the Move Up and

Move Down buttons.

• Press Ready Check to check whether automatic sample processing (batch)
can be carried out, i.e., whether all devices to be used are ready for use
(turned on, connected, lamp switched on, etc.) In addition, it is checked
whether all data are available and whether the memory capacity is
sufficient.

• Then start the analysis process by pressing Start.
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As soon as the online batch is started, all samples of the sequence(s) that have
the status Single or Multiple are analyzed in the listed order. During a running
batch, the currently processed sequence is labeled with a green triangle in the
batch list.
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V. Data Reprocessing
Data reprocessing refers to the presentation of raw data under various aspects.
This can include the display of an integrated chromatogram, manual
chromatogram re-integration, and chromatogram comparison, checking peak
purity, representing calibration curves, or searching individual spectra in a
spectra library.

Each action is performed in a separate window. These windows are also called
partial methods. Each partial method is intended for a specific task and has its
own window arrangement and menu structure. Use the icons on the Method
toolbar to quickly change from one view to another:

The following partial methods are available (order as on the toolbar):
• Calibration

• Integration

• Peak Purity Analysis (PPA)
(opens a window for presenting data of a diode array detector)

• Printer Layout

• Quantification Method (QNT Editor)

The next tool allows you to view the signed results. Use the next icons to open
another two window sections:

• Spectra Plot (opens a window for spectra representation)

• Report (opens a Report window)

Let us see the points that must be considered in the following example of the
Integration partial method. Changing the other method windows is in the same
way.



T-54 V. Data Reprocessing

1. The Integration Window
• Open a sample chromatogram by double-clicking the sample name in the

Browser.

You will see the chromatogram of a sample, e.g.:

• Choose the Decorations command from the context menu to change the
appearance of the chromatogram. The captions, axis ratios, and coloring
can be changed as well as the actual chromatogram representation (display
of peak heights, additional chromatograms or grid).
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• Double-clicking an individual peak shows its properties:

• Select a peak and click the corresponding icons to view the Spectra Plot
and the Report.

On the top right, the spectrum of the selected peak, e.g., anthracene (provided
the analysis was performed with a diode array detector) is displayed; the lower
section shows part of the integration report (three lines, the currently selected
peak is highlighted by a different background color). As before, the Spectra Plot
window can be changed via the Decorations command. Choose this
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command to view the available options. This command also allows minimizing
the spectrum in the chromatogram.

The displayed default report contains information on various parameters. Each
worksheet has a number of default variables that are an integral part of a
specific report type. For example, the integration report contains the columns
Ret.Time, Area and Amount, the calibration report includes the columns
Offset (c0), Slope (c1), and Curve (c2), etc.

Double-clicking a peak name in a report window changes the selection of the
current peak, i.e., instead of anthracene; pyrene is then highlighted by a
different color. The spectra representation is also updated.

2. Modifying the Chromatogram
In individual cases, it may be useful to change the automatically performed
integration of a sample, e.g., by moving peak delimiters. This is possible via the
icons on the Integration toolbar:

The most important actions can be performed with the Automatic Tool. The
shape of the mouse cursor indicates the performed action.

  Move left/right peak delimiter
    Change baseline point (left/right/center)

    Move baseline point (left/right/center)
Move perpendicular line
Move baseline segment
Move detection parameter
Insert peak
Display spectra
Zoom out an area
Action not possible

The action that can be performed at the current position is indicated in the
status bar:

Example:
Near the blue peak delimiters, the mouse cursor changes its shape. 
symbolizes the peak start, while  marks the peak end.
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• Press the left mouse button to change the integration limits of a peak by
moving the peak delimiters.

It is not possible to "run over" another peak delimiter. After moving a peak
delimiter, the Dionex Chromatography Management System draws a new
baseline between the peak start and the peak end. All peak properties such as
area, width, substance amount etc. are recalculated. The integration report is
immediately updated.

• Choose the Save Manipulations command (via the context or Edit menu)
to save the reprocessing result.

Similar to moving peak delimiters, other actions can be performed, e.g.,
inserting or deleting peaks or changing the baseline.

3. Modifying the Report
In the report, choose the Column Properties command from the context menu
to change the appearance of the current worksheet. You will see the following
dialog box.
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Divided in various categories, this dialog box offers all result variables that are
calculated and evaluated by the Dionex Chromatography Management
System. As soon as you have selected a variable, its properties (Formula...,
Header..., Dimension..., Format...) are displayed.

Header.. shows the text of the column head, Dimension.. shows the
dimension name, and Format.. defines the number of decimal places. Choose
the Selected Channel option to display the values of the current channel, or
choose Fixed Channel to output the data of a specific channel independently
of the representation in the integration window.

• Press OK to extend the current report by an additional variable column.

• Select a column and choose Delete Column(s) to remove the column.

 Caution: These report options influence the representation on the screen
only. The appearance of the printed report is defined in the
Printer Layout!
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4. Saving Changes
The Save Report Definition.. command allows saving all changes within a
report under a separate name. The arrangement and the appearance of the
individual report window sections are saved plus the variables to be displayed.

With each new start of the Dionex Chromatography Management System, the
report is opened just as it was saved last. You can choose a different
appearance via Load Report Definition.. (provided that you have created your
own Report Definition Files (RDF)).

Please note that each sequence is saved with a preferred profile. Then, upon
opening a sample of the corresponding sequence, it is not the appearance of
the window saved last that is used but the appearance of a specific report
definition file (RDF). Proceed as follows to define a sequence for a preferred
report:

• Select a sequence in the Browser and choose the Properties command via
the context menu.

• Under Preferred RDF File, enter the name of the report definition to load.
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VI. Quantification Method (QNT File)
As soon as you want to present the results of sample processing, e.g. the
chromatogram or a report, the Dionex Chromatography Management System
searches the Method column of the sample list for the name of the
quantification method. The settings made in this QNT file determine how
substances are calibrated and how chromatogram peaks are integrated and
identified.

Strictly speaking, the QNT file is required after the analysis only. However, it is
recommended to create the file earlier. This allows you to follow and evaluate
the course of the analysis.

Creating a Quantification Method
• Choose the New command from the File menu.

• Choose Method File as file type and press OK to create a new method.

The QNT File Window
The QNT file window contains various worksheets (General, Detection, Peak
Table, Amount Table, Peak Tracking, MS Tracking, Calibration, Spectra
Library Screening, SST, and MS). Open the required worksheet by clicking
the respective.
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To create a simple evaluation method, it is sufficient to enter the Peak Table
settings.

Creating a Peak Table
The peak table allows recognizing peaks (= ÎDetect), assigning names to the
peaks in a chromatogram (= ÎIdentify), and converting the determined peak
areas into substance amounts (= ÎQuantify). The required information is
usually entered before the analysis.

Saving the QNT File
Save the quantification method via Save as under a separate name.

Editing the QNT File
When the QNT file is edited, all changes will be implemented immediately in all
involved components.

If you have opened a channel of a specific sample (see: ÎBrowser
Appearance and Functions) and you see the corresponding chromatogram, this
representation is updated immediately after changing the QNT file. The same
applies to the representation of numerical values as they appear in any report.
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 Caution: If you have not specified a quantification method when creating a
sequence (Step 4 of the ÎSequence Wizard), the fields of the
Method column in the sample list will be empty! Enter the name
of the desired QNT file for each of the samples. To evaluate all
samples with the same QNT file, just select the QNT file for the
first sample and copy the entry for all entries using F9.

1. Detecting Peaks
Before peaks can be identified and quantified, they have to be detected. Based
on default values for the peak recognition algorithm the Dionex
Chromatography Management System is able to detect even the smallest
peaks. Normally, however, you will not be interested in these small peaks so
that you may want to include certain filters to exclude them from being
displayed. This and other detection tasks are defined on the Detection tab.

Usually, the Minimum Area filter will be sufficient. Normally, 1.000 mAU*min is
an appropriate value for HPLC-UV. In addition, the detection parameters
Minimum Height, Minimum Width as well as Maximum Height and
Maximum Width can be used as filters.

Use the detection parameters Rider Threshold and Maximum Rider Ratio to
define the peaks that shall be classified as riders. Use Rider Skimming to
define how to divide a rider peak from the main peak.

Besides, you can use

Detect Negative Peaks to detect negative peaks,

Valley to Valley to enforce valley-to-valley integration,

Inhibit Integration to inhibit integration, and

Fronting/Tailing Sensitivity Factor to influence the peak start and peak end
determination.

Clicking the detection parameter tool allows viewing the position of the
detection parameters in the chromatogram.

This is especially useful if you want to change the position of detection
parameters or graphically insert additional parameters. Use the Detection
Parameter Tool to change the position of detection parameters. Open the tool
via the respective command of the context menu or via the {Tool_DetPar.bmp}
icon. In the chromatogram, the parameters are marked by a dotted line at
which the abbreviation for the parameter and the respective parameter value is
indicated. The figure below, for example, shows the values for the Rider
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Threshold (in short: RidThd), Rider Skimming (RidSki), and Maximum Rider
Ratio (RidRat) at 1.000 min. Positioning the mouse on a detection parameter in
the chromatogram activates the detection parameter tool so that you can move
this parameter via the left mouse button.

Use the Detection Parameters command of the context menu to insert a
detection parameter at the position of the mouse cursor:

This setting, for example enforces valley-to-valley integration as from the
selected time.
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Alternatively, you can enter detection parameters graphically by selecting a
chromatogram area via the right mouse button. The opening context menu
provides the following options:
• Set Averaged Baseline Start/End

• Set Minimum Area

• Set Minimum Height

• Set Minimum Width

• Set Peak Slice & Sensitivity

• Set Inhibit Integration Range

 Tip: You can undo the graphical input of detection parameters. Click
into one of the QNT editor tables and select the Undo command
of the Edit menu. (In the chromatogram itself, you can undo
changes only that were made in currently open chromatograms.)

2. Identifying Substances
• Select the Peak Table tab to open the peak table.

Most frequently, peaks are identified via the retention time.

• Enter the names of all peaks to identify in the Peak Name column. Assign
the expected retention time to each peak in the column Ret.Time (=
nominal retention time (Tret)). (Tip: additional lines can be added via the
Lines .../ Append Line commands of the context menu).
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If a peak is detected at the specified time, the name is assigned automatically
(fig. a). An additional tolerance range is defined via the Window column (fig.
b). The width corresponds to the double Window value. If a peak is detected in
this range, it is identified even if the actual retention time does not correspond
to the entered "set" (nominal) retention time (fig. c). If several peaks are
detected within this range, the chromatography management system identifies
the greatest, the first, or the nearest peak to the retention time (fig. D),
depending on the extension of the Window parameter.

Tret (g)

Tret (n)

Tret (f)

Tret

a) b) c) d)

peak name window

set

actual

• In the Window column, enter e.g. 0.25 AG for each peak to identify the
largest peak within a 30-second window. Time input is in industry minutes,
e.g. the value 1.00 corresponds to 60 s. The value 0.25 thus corresponds to
15 s, which means a window range of 30 s. The setting 0.25AF identifies
the first peak; the setting 0.25AN identifies the nearest peak to the set
retention time.

 Note: To create the peak table automatically, use the Autogenerate
Peak Table command of the context menu. You can also have
the peaks numbered consecutively or use the results of the
ÎSpectra Library Screening.



VI. Quantification Method (QNT File) T-67

3. Quantifying Substances
Each substance that should not only be identified but also quantified requires a
standard substance. The known substance amount of this sample needs to be
entered in the peak table together with the standard method. Enter this
information in the Amount and Standard columns.

"Amount" Column
• Search the peak table for the substance name of the standard substance(s).

If the required names are not listed, enter the names and the retention times
as described under Identifying Substances.

• Move along the line until you reach the Amount column.

• Enter the amount values of the substances (Substance A, Substance B,
etc.).

Either a concentration value (e.g. µg/µl) or an absolute value (e.g. µg) can be
entered. If standards are available in various concentrations, i.e. in several
vials, the concentration of each vial from which to inject "must" be entered in a
separate Amount column.

• Choose the Columns.../ New Amount Column... commands of the context
menu to add additional Amount columns.

• Enter the concentration value of the second vial in the new Amount
column.

However, if injection is several times from the same sample vial (multiple
injection), one amount value is sufficient, as the concentration is constant. This
is also true if a different volume and thus different substance amounts are



T-68 VI. Quantification Method (QNT File)

injected, as the chromatography management system considers this
automatically!

"Standard" Column
The standard method determines how a calibration is performed. A general
distinction is made between calibrations based on an external or internal
standard.

External standard means that the calibration is performed based on one or
several standard samples (= normal case). Internal standard means adding a
known amount of standard to the unknown sample (= special case that is not
described in this Tutorial!).

• Ensure that the correct standard method for each peak to calibrate is
entered in the Standard column (= external = default value).

For information on further calibration options (internal or internal/external), see
the Online Help or the User Manual (in the Calibration section).

Further Columns
All other peak table columns determine how the determined area values are
converted into the resulting substance amount values. Generally, the standard
settings can be used, i.e. no changes are required.

Ensure the following settings:
• Calibration Type = Lin

• Integr. Type = Area

• Right/Left Limit = 0,000

• Group = --

• Response Factor = 1,000
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4. Spectra Library Screening
The Spectra Library Screening tab of the QNT editor allows searching
spectra libraries for reference spectra for the different peaks of the current
chromatogram. As the chromatographic conditions, considerably influence the
spectra, we recommend filling your library with spectra from chromatograms
that were recorded under the same conditions as the current chromatogram.

On the Spectra Library Screening tab, select the spectra library in which to
search for the reference spectra. In addition, enter the comparison criteria for
the spectra search. Normally, the default values of the Match Criterion (Least
Squares) and Hit Threshold (950) will be sufficient. However, you can also
specify many additional search criteria.

Start the spectra search by pressing Apply. The retention spectrum of the
actual peaks is compared to the reference spectrum that was found. To the top
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right of the spectra plot, the corresponding match factor is displayed. The
match factor indicates the correspondence of the two spectra. A value of 1000
indicates that the spectra are identical while they would be completely different
with a match factor of 0. If no corresponding spectrum is found based on the
selected criteria, the No spectra library hits found! message will be given.

 Note: You can use the spectra library screening results for automatic
peak table creation (see ÎIdentifying Substances).
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VII. Printing Results

1. General
Printing in Automatic Batch Operation
As mentioned in the previous chapter, printing results can be started together
with automatic sample processing (Online Batch). Let us have another look at
the Batch dialog box.

• Change to the Reporting tab.
• Activate the Print/Export Report check box to print the sample processing

results.

• Choose Print each sample immediately to start printing after each
sample. Choose Print when the entire batch has finished to print all
sample results after the entire sequence is completed.

• The report type and the extent of the printed output are determined via the
Report Setup button and the following dialog box.
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Choose a report template in the Use Report Definition field. The default report
template DEFAULT.RDF of the Dionex Chromatography Management System
is stored in the REPORT directory.
• From the With Selected Channel field, choose the channel to print (e.g.

UV_VIS_1). If the field remains empty, the preferred channel (see ÎThe
Browser: Appearance and Function) will be printed.

• Select the Printout option to print the sheets.

• The Printer field shows the name of the previously selected default printer.
Choose Setup to select another printer.

So far, you have specified the channel, the printer, and the report definition for
the printed output. However, what is included in the selected template? Is it
possible to change the appearance of the printed results? Yes, it is!
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As described in detail in ÎThe Printer Layout section, a report template
contains several special sheets for different print data. The sheets included in
the selected report template can be viewed in the Selected sheets to be
printed field. The Integration, Calibration (Curr.Peak), Calibration (Batch),
Peak Analysis, Summary, and Audit Trail sheets are included in the default
report template.
• Under Selected sheets to be printed, choose the worksheets of the report

template you wish to print.

• For each selected worksheet, it is necessary to determine whether all
samples or only samples of a specific type should be printed.

• Choose Print for every sample to print results for each sample type.

• Choose Print under certain conditions to print results for a specific
sample type only.

If you want to print, for example, the Calibration worksheet for standard
samples only, choose the Print under certain conditions option and press the
Conditions button. In the following dialog box, activate the Standard check
box.
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The other options of these two dialog boxes are for later use.
• Press OK to return to the Batch Report dialog box and define the other

worksheets.

• Then start sample processing by pressing Start, as described under
ÎStarting the Analysis.

Printing Samples
Of course, sample-processing results can be printed independently of the
online batch. This applies to all samples for which raw data are available. The
Dionex Chromatography Management System assigns Finished as sample
status in the sample list. Proceed as follows to print the results of any samples.

• Open the Browser and choose the Print Setup command to select a
printer for printing the results.

• Open the sequence directory and select the name of a sequence to print the
results of all included samples.

• If you want to print specific samples of a sequence only, select them one by
one with the mouse. Use the CTRL key to select several samples.

• Choose the Batch Report... command from the File or context menu and
determine how to print the report (see Printing in Automatic Batch
Operation above).

Printing with your own Report Templates
The Dionex Chromatography Management System allows each user to change
the default report that was created with the DEFAULT.RDF report template
according to individual requirements. This requires creating a new report
template in the Printer Layout window. The new template is saved under a
new name and is now available as a separate template. The new report
template can be selected in the Using Report Definition field instead of the
file DEFAULT.RDF.
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2. Printer Layout
The Printer Layout window serves to create custom print templates. Proceed
as follows:

• Double-click a sample name in the Browser to open the sample
chromatogram. For representing the chromatogram, the Dionex
Chromatography Management System opens the Integration window.

• Use the Printer Layout command (View menu) to change from the
Integration view to the Printer Layout view.

 Tip: To quickly change from one view to another, the Dionex
Chromatography Management System offers a Method toolbar
(described under ÎData Reprocessing) Place the mouse cursor
over an icon to read its label in the quick info.

The following view shows a section of a report based on the default report
template DEFAULT.RDF:
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The Integration, Calibration (Curr. Peak), Calibration (Batch), Peak
Analysis, Summary, and Audit Trail worksheets are part of the
DEFAULT.RDF report template.

• Choose one of the tabs on the window bottom to change between the
individual sheets of a report template and to view the different worksheets.

The appearance and the structure of an individual worksheet are very similar to
Microsoft Excel spreadsheets. Each sheet consists of a large number of
columns (256) and lines (16000) and thus is much larger than a single printed
page. A worksheet can consist of many horizontally or vertically arranged
printed pages.
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Chromatograms or tables that exceed one printed page are automatically
printed on two or more pages. The order in which the pages are printed is
defined in the Page Setup (File menu).

Editing an Existing DEFAULT.RDF Template
It is much easier to change an existing report template rather than to create a
completely new one. As only the DEFAULT.RDF template (and the
DEFLTDAD.RDF template) is available at first, copy this template, and then
modify it.

• Choose the Save Report Definition command from the context or
Workspace menu and save the template under a new name.

You can now perform changes without overwriting the default report template.
For an overview on how to proceed and on the available options, see below.
For a detailed description on the individual steps, see the How to ...: Actions
in the Window Printer Layout section in the User Manual or the Online Help
system.

• Choose the Layout Mode command from the Edit menu.

This command serves as write protection for the report templates. Only after
having activated the Layout Mode, you can change report templates or
individual worksheets.

• Choose the worksheet you wish to edit or add an additional (empty)
worksheet via the Insert Sheet command (Edit menu).

• Choose the Delete Sheet command (Edit menu) to delete an unnecessary
worksheet.

• Double-click a tab to assign it a different name (e.g. Integration Special).
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• Choose the Insert Row(s)/Column(s) or Delete Row(s)/Column(s)
commands to add or remove single rows or columns on the worksheet (not
of an included table).

• Select a field, a column or an area and choose the Clear ... command from
the context menu to clear unnecessary information from the worksheet.

Having removed all unnecessary parts, you can now fill cells, columns, or
areas of the worksheet with new contents. You can either use the Windows
clipboard (copy / paste) or the Insert ... command of the context menu.

• Insert ... Chromatogram reserves an area for a chromatogram.

• Insert ... CHROMELEON Report Table reserves an area for a complete
report table.

• Insert ... CHROMELEON Report Column inserts a column for a new report
variable in an existing table.

• Insert ... Spectra Plot reserves an area for a spectrum.

• Insert ... Chart reserves an area for a chart, etc.

"Reserved area" means that a section is reserved for inserting a specific
chromatogram, spectrum, etc. instead of actually inserting it. For tables, the
number and the contents of all columns are defined. When printing a sample,
the reserved area is filled with the actual chromatogram, the spectrum, or the
table values.

• Choose the Save Report Definition command from the context menu or
the Workspace menu and save the result of your changes.
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VIII. Online Help
When working with the Dionex Chromatography Management System, there
may be issues and questions that are not discussed in this Tutorial. In this
case, refer to the User Manual and to the Online Help for more detailed
information. You can access the Online Help system anywhere in the program.
Choose one of the following ways to view help information.

• ÎContext-sensitive Help answers your questions regarding any topics of
your current position.

• ÎSystematic Help allows

• selecting an interesting topic from the contents tab or

• searching the index for any required information.

1. Viewing Context-sensitive Online Help
Depending on your current cursor position, you can view different online help
windows. If a help window is opened, you can access systematic help. In other
cases, a popup window opens providing a short context-sensitive description.
Usually, you can jump to related topics.

Help via the Context Menu
The right mouse button allows you to view help on the topic that is currently
selected:

Select How to ... to view detailed information on actions that are possible at the
current position. Click What’s this? for a description of the selected item,
command, etc. In some cases, What’s this? topics offer information that is
more general. Normally, various links are available for specific information.
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Help via the Help Button and Icon

After clicking the  icon on the toolbar, a question mark is appended to the
cursor. With this special cursor, you can now click any item on the screen to
view specific information on the selected topic.

Several screens offer a Help button instead of the context menu or the
question mark. This button allows you to view information on the current
screen. In the QNT editor, where you can enter parameters and variables, the
Explain Param. and Explain Variable buttons provide explanations on the
selected parameter or variable.

Help via the F1 Key
Finally, you always have the possibility to view help information via the F1 key.
This help information corresponds to the context-sensitive help available via
the question mark cursor or the Help button.

2. Viewing Systematic Online Help
Open the Help menu and click Index for a topic overview in the Help system.
The help window offers the following tabs:

• Contents

• Index

• Find

Contents Tab
This tab shows the Help system's table of contents. Double-click the book
symbol to view the topic titles contained in the chapter. Double-click the
opened book symbol to close the book (chapter) again.

Topic titles are indicated by a page symbol with a blue question mark. Double-
clicking a topic title allows viewing the topic.
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Index Tab
This tab assists you in finding a specific term via index entries in the entire
Help. Enter the first few letters in the first field until the required term appears in
the second field. To view the topic, press View as soon as you have selected
the topic. If several topics are found, you can open one of them in the Topics
Found window.

Find Tab
This tab assists you in finding a specific key word in the entire help system.
First, the Dionex Chromatography Management System generates a list
containing all words in the entire Online Help. Similar to the index, you can
search the resulting list for a specific term.
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Addendum: Short Glossary

Datasource and Database
The term datasource is used for a database that is registered on a server.
Setting up (registering) a datasource is performed in the Browser. The user
specifies the format and the location of the database.

During the initial installation, a local default datasource is created on each
client PC. In network operation, the datasource name is composed of the
computer name and the extension LOCAL (<PC-NAME_LOCAL>). On a local
station that is not included in a network, the name that is stated in the operating
system below Control Panel / Network / Identification is used. If no
identification is entered, the datasource is named DEFAULT_LOCAL.

Normally, Dionex Chromatography Management System data is stored in an
Access database, i.e. in a MDB (Microsoft Data Base) container. The default
datasource is based on an Access database, too. The ODBC capability of the
chromatography management system allows using various other formats
(dBASE, SQL, Oracle, etc.) as well. Independently of the chosen format, data
of single samples (Sample data) is saved in a datasource as well as data of
sequences (Sequence data). Databases can be saved on a local hard disk or
any other mass storage device.

In the Dionex Chromatography Management System, the Directory command
allows creating individual subdirectories below a datasource. The directories
are used for saving ÎSequences and the corresponding data and programs.

If the datasource is located on a centralized network PC, the database is
accessible by all clients that have the appropriate access rights assigned by
the system administrator. If the datasource is stored on a local hard disk, it is
up to the corresponding client to decide whether the database can be accessed
via the File Sharing option. The Dionex Chromatography Management System
also offers the possibility to lock datasources, directories, or sequences.

 Note: "Old" GynkoSoft data has the required database structure. The
Dionex Chromatography Management System is therefore
capable of handling this data as "real" data of the Dionex
Chromatography Management System. The user simply
establishes a connection (Connect) to the data stored under
Drive.... (see: ÎInstalling Datasources). For details on creating
a datasource, see the Online Help and the User Manual.
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Raw Data
Raw data refers to all analog and digital data points that are digitally stored on
a PC. Raw data therefore exists for signals or channels only that were selected
by the user before data acquisition.

The scope and accuracy of the stored raw data depends on the selected
Sampling Rate and Step.

Sequence
A sequence combines samples that belong together due to their origin or
processing. The names of all samples belonging to one sequence are entered
in the sample list (also called sequence table). A sequence is thus a container
for various samples.

Theoretically, the number of samples is not limited, but 100 sample entries
should be exceeded only in exceptions. Creating more sequences reduces the
number of samples included in one sequence, thus accelerating access to the
individual samples. In addition, it is easier for the user to keep track of the
processed samples.

The sequence table also defines how to process a sample. This includes
information on the sample itself (injection volume, position, amount, dilution
factor, etc.) as well as references to chromatographic methods that specify the
program (PGM file) to be performed for the analysis and the evaluation
parameters to be used (QNT method).

The entire data collected in connection with creating and processing a
sequence, including raw data and protocol data recorded during the analysis, is
saved in the sequence directory of a datasource or in the underlying database.
Of course, this includes the raw data and the protocol data that were recorded
during the analysis.

Similar to ÎDatasources, sequences can be "locked." In this status, data and
results are read-only; they cannot be modified or extended.
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(Chromatography) Server
PCs connected to the components of a system via a serial interface can be
used as chromatography servers.

A chromatography server is automatically installed on the PC during the
installation. The chromatography server controls the data exchange between
the system and the PC. Upon starting, each server is capable of serving up to
six controlled or 16 non-controlled systems (ÎTimebases). The server
receives the commands entered by a client PC in a control panel and executes
them at the specified time (e.g., by transmitting them to the corresponding
device driver of the HPC system). In the opposite direction, the server also
assumes this buffer function. Thus, the raw data of each system is stored at the
location specified by the client and the entire system-relevant data is forwarded
to the client.

Configuring a server and installing a timebase is performed via the Server
Configuration program. If the server and the client software of the
chromatography management system are located on the same PC, this is
called a local installation; if they are not, it is a network installation.

 Tip: In case of manual data acquisition, the ÎRaw Data from the
system is always stored in the server directory
PCNAME_LOCAL. In the case of a batch, the user can choose
where to store the data. To minimize the risk of losing data, raw
data should always be stored temporarily on the server. In the
course of archiving, it can be transferred to a different computer.

Timebase
All components combined in a chromatography system to enable the
chromatographic separation and related in a time context with each other, are
assigned to the same timebase.

A timebase can be a very complex system (that includes e.g. two pumps, one
autosampler, one column oven, and two detectors switched in series).
However, an isolated integrator or a gas chromatograph can represent a
timebase as well.

Another system that is completely independent from the first one represents a
new timebase. Administration of different timebases is on one or several
ÎChromatography Servers. The name for a timebase is assigned in the Server
Configuration program.
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Introduction

Tutorial

To become familiar with the Dionex Chromatography Management System we
recommend you to work through the Tutorial. From there, proceed to the
desired topics via Contents Overview. Besides, you can also open the Tutorial
directly via Start>Programs>CHROMELEON>Tutorials.

The Tutorial has the following sections:

I. Starting the Program: As soon as your
computer and one of the operating systems
Windows 98 or Windows NT/2000 are
running, the Dionex Chromatography
Management System can be started via the
Windows Start button on the task bar.

II. Managing Data: The Dionex
Chromatography Management System allows
you to manage data in folders and directories
similar to Microsoft Windows. The tool that
helps you to handle your chromatography
data is the  Browser.

III. Controlling your HPLC system: Ensure that
your chromatography, HPLC, GC, or CE
instruments are correctly connected to the PC
via a serial port. Using the ¾Control Panel
allows you to operate the pump,
¾Autosampler, detector, etc. from your PC. In
addition, you can create a ¾PGM File to
control your system automatically.

IV. Analyzing Samples: Are your instruments
controllable via the PC? Then, you can start
your first analysis. Create a Sample List
(= ¾Sequence) to use all capabilities the
Dionex Data System offers.
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First, use the Sequence Wizard to include
the samples to process in the sample list. The
Wizard allows you to define the order of
sample processing, the injection volumes, the
sample type (analysis or standard), and where
the Dionex Chromatography Management
System finds information on how to perform
the analysis. The latter is by entering a
program and a method name, and by creating
the corresponding files (PGM File, QNT File,
see below).

As soon as you have created the sample list,
the program file, and the quantification
method, you can start the Analysis. The
resulting data is automatically saved.

V. Reprocessing Data: The analysis result can
be viewed and edited on the screen. Data
Reprocessing allows you to manually change
integration limits directly in the chromatogram
or to evaluate samples again ("offline") based
on new parameters.

VI. Quantifying: Using a ¾Quantification Method
(QNT file) allows you to minimize the
reprocessing effort for individual
chromatograms. The QNT method defines the
detection parameters, the peak identification,
and the calibration of the substances in the
sequence.

VII. Printing Results: Analysis data can be
printed at any time. For perfect adjustment to
your personal requirements, you can create
your own report templates in the  Printer
Layout, define your own result variables, or
embed your company logo.

VIII. Online Help: This Tutorial can deal with
selected aspects of the Dionex
Chromatography Management System, only.
For further information, see the detailed
description in the Online Help or the User
Manual.
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Using the Online Help System and the Manual

The Online Help system and this user manual differ only slightly in their
respective contents, but they are intended for different situations.

• Refer to the Online Help system to look up terms or find information on how
to use the application in a specific situation on the current screen. The
easiest and quickest way to receive help is by pressing the ¾F1 Key. For
further information, see  Activating Online Help.

• Look up information in the user manual to become familiar with the
fundamental features and operation of the data system. We recommend
that you read the topics of the first two sections and look up unfamiliar
terms in the glossary.

Overview: Online Help

As with most Windows programs, the Online Help features various windows
and levels. These largely correspond to the various parts of the user manual,
such as table of contents, main section, appendix, and index. In addition to the
manual, the Online Help provides many context-sensitive tips that open only
from the respective program window.
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The overview displayed via the Contents button corresponds to the table of
contents in the user manual:

• Double-click a book symbol to view further levels ("branches").
• Double-click a question mark symbol to open the corresponding topic.
• Click the Index tab to search Online Help for an index term.
• Select the Find tab to search Online Help for any non-indexed string.

The selected topic appears in a separate Help window. This window will have a
white background if the topic deals with questions regarding theory, installation,
and operation. The background color will be yellow if tips that are more
practical are opened (How to ...:). Both windows can be displayed
simultaneously.

 Tip: Online Help is automatically displayed in the language (German
or English) of the current language setting (see Windows Control
Panel/International Settings). As default, the system loads the
English version.
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Activating Online Help

There are several ways to access Online Help.

¾¾¾¾F1-Key Pressing the F1 key opens a Help topic containing context-
sensitive Help information.

Choose How to ... from the context menu to view
information on the currently possible operations (practical
tips). Choose What’s this? to view a description of the
corresponding control or the currently displayed window
(theory).

Help menu The ¾Index option in the Help menu opens the contents
overview of Online Help.
The Using Help option shows how to use Online Help.

After clicking this button, the mouse cursor changes to a
question mark. Click any screen element to display the
corresponding description.

The Help button in dialog boxes opens the corresponding
explanations for this dialog box.

When viewing a Help topic in the Online Help, you can ¾jump to another Help
topic by clicking the hyperlink term underlined with a single line or by clicking a
shortcut symbol.

Topics underlined with a dotted line can be viewed simultaneously with the
current window.

Overview: User Manual

The user manual contains the sections Theory, Installation, Operation, How
to ...: and the Glossary. Use Contents and Index to search for specific terms
and to get an overview over the various topics described in the manual.

1. Section: Theory, Installation, and Operation
This section describes the structure and the functions of the Dionex
Chromatography Management System as well as basic chromatographic facts
and methods. Where appropriate, the user is referred to related topics.
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These references are indicated as follows:

Jump term Refers to technical terms in the glossary section.

⇒ Jump term Refers to topics in the reference manual.

Shortcut
symbol

Refers to topics in the Theory, Installation, Operation or How
to .... sections.

"Installation"
link

Refers to topics in the Installation Instructions for Different
Devices section.

2. Section: How to ...:
In this section, you will find helpful answers to frequently asked questions, for
example:

"How do I perform external calibrations?"

"How do I generate program files?" or

"How do I re-integrate chromatograms manually?"

3. Section: Installations Instructions
The installation section provides detailed information on how to install:
• All third-party devices that can be controlled.

• All Dionex PC plug-in boards and interfaces.

• An appendix on cables and pin assignments.

4. Section: Reference Manual
The reference manual includes tabular descriptions on Commands,
Parameters, Variables, and Report Categories.

Appendix: Glossary
The glossary section contains an alphabetically sorted list of chromatographic
and program-related terms.

Refer to the glossary to view exact definitions of technical terms (e.g., Blank
Run Subtraction), a command (e.g., Draw), or a parameter (e.g., Skewness).
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Index
Refer to the index to locate information on a specific term. In addition to the
page numbers that refer to the first two sections, page numbers preceded by
the letter A refer to the glossary section, e.g.:

Command
Reconnect...............A-93
Wait......................A-147
Wash....................A-147

Command button
Creating...................166

Comment.....................A-30
Communication.........11; 21
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Theory, Installation, Operation

Theory, Installation,
Operation
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Hardware and Software Chromatography
Components

Overview: Components of a Chromatography System

A modern HPLC (High Pressure/Performance Liquid Chromatography) system
or IC (Ion Chromatography) system consists of the following components:

From one or several reservoirs (a), up to four solvents are drawn via the pump
(b), mixed to supply a defined solvent mixture and are then directed to the
system with a different flow rate. In this liquid flow, the solution to be analyzed
is injected via the injection unit (c). On the column (d), the contained
substances are separated into individual fractions or components. Using a
thermostat-controlled oven can optimize the separation process. When a
substance reaches the detector flow cell (e), a signal is produced that is
proportional to the measured concentration. Additionally, a ¾Suppressor is
added before the detector in suppressed conductivity mode IC. The signal
whose profile corresponds to a Gaussian distribution is called a peak. By
determining the peak area and by means of a previously acquired calibration
curve, the exact quantity of each individual substance can be calculated
(quantitative analysis). Optionally, a fraction collector (f) can then distribute
individual substances or fractions to different containers (g).
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Determination of the peak area is performed by the chromatography data
system installed on a PC (h). In addition, the data system

• controls and monitors all connected chromatography instruments, collects
data and status messages, and

• enables quantitative and qualitative evaluation of the data when used
together with photodiode array detectors.

Communication between chromatography instruments on the one hand and
computer and data system on the other hand is via serial interfaces or via
additional boards such as A/D converter and the pump control board.

If several PCs are connected via a network, systems can be controlled from
remote locations in the network. Data can be managed centrally and can be
retrieved from any workstation.

For detailed information on the components of a chromatography system, see
the topics below:

 Chromatography Instruments
 Device Communication
 PC and   Operating System
 Network
 Data System

Chromatography Instruments

The Dionex Chromatography Management System is especially designed to
control and monitor the following Dionex instruments. Appropriate instrument
control options may need to be purchased and installed in order to control the
particular instrument.

HPLC pumps: M480, P580
IC pumps: GP40, GP50, GS50, IP20, IP25, IS25
Autosamplers: GINA 50, GINA 50T, GINA 160, AS50,

AS3500, ASI-100
UV/VIS detectors:
     Single wavelength AD20, AD25
     Multiple wavelength UVD 160S, UVD 170S
     Full-spectrum (PDA) UVD 320S, UVD 340S, PDA-100
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Electrochemical detectors: CD20, CD25, CD25A, ED40, ED50,
ED50A

Instrument/PC interface: UI20 Universal Interface, UCI-100
Universal Chromatography Interface

Eluent generator: EG40 Eluent Generator (installed via
the IC pumps)

Temperature control
modules:

LC25, LC30, AS50 Thermal
Compartment

System modules: DX-120, IC20, IC25, IC25A

In addition, the following instruments, which are available from Dionex, are
supported.

Fluorescence detectors: RF1002, RF2000
Refractive index detector: RI-71 (data acquisition only)
Column oven: STH-585

Third-party analytical instruments are also supported. See the following
examples. Appropriate instrument control options may need to be purchased
and installed in order to control these instruments.

Gas chromatographs: e.g. Agilent (formerly HP) HP5890;
HP6890

Radioactivity detectors: e.g. Berthold LB507A
Electrochem. detectors: ANTEC DECADE, ANTEC INTRO
HPLC systems Agilent (formerly HP) HP1100

Should you have any questions regarding product support, please contact your
Dionex sales representative.

Device Communication

To control a chromatography system and to record chromatograms and
spectra, the Dionex Chromatography Management System constantly
communicates with peripherals such as ¾Autosamplers, pumps, and
¾Photodiode Array Detectors.

On the one hand, the data system sends control commands to the instruments;
on the other hand, the detector transmits large quantities of data (3D-fields,
chromatograms, and spectra) to the data system. Depending on the type of the
exchanged data, various transmission methods are used.

Also, see the topics below:
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 A/D Converter
 Pump Control Board (Frequency/Pulse Width Modulation) 
 Serial Interface (Digital)
 Dionex Universal Chromatography Interface (UCI-100)
 DX LAN

 A/D Converter
Chromatographic detectors convert ¾Signals, e.g., absorption or conductivity,
into electric voltage. As a PC can only process digital information, the electric
voltage must be converted into digital data by an additional interface board. If
the detector is not capable of this conversion, an analog/digital converter (the
A/D converter) performs the conversion.

The ¾A/D Converter has 16 analog inputs and several (digital) ¾Remote
Inputs. Analog signals of the detector are recorded via the analog inputs, and
external events (for example, injection of a sample) are communicated via the
remote inputs.

Modern photodiode array detectors such as the Dionex UVD 320S and 340S
detectors are capable of generating digital data. Detectors of this type do not
require an additional A/D interface board. Transmission of the data to the data
system is digitally via a  Serial (RS232) Interface or a separate PC board.

For installation information, see  Installing the A/D Converter.

 Caution: Wrong polarity (remote inputs) and input voltages outside the
valid range will destroy the board!

 Pump Control Board
Pumps without a built-in serial RS232 or DX-LAN interface receive their flow
commands via special control lines (9-pin SUB-D-connector). The signals
transmitted on these lines, such as the required frequencies for operating a
frequency-controlled pump, are generated in the PC by the pump control
board. The Dionex Chromatography Management System is thus capable of
controlling the flow of up to three pumps simultaneously. Furthermore, the
pump control board is fitted with four relay outputs that are available for
transmitting events to other instruments.
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You need the board to run flow or percent gradients with the Gynkotek pump
M300. You can also use the pump control board to control the flow of the
Dionex pumps M480 and P580. However, the flow of these two Dionex pumps
can be controlled without the pump control board as well. For further details,
see  Installing the Pump Control Board.

 Serial Interface
The operating systems Windows 98 and Windows NT/2000 allow direct data
exchange via serial interfaces. Without any problems, several serial interfaces
and thus a large number of chromatography instruments can be controlled from
the PC. If more ports are required, additional interface boards can be installed
(for further details, see  Installing a Serial Interface Board.)

Drawbacks of this type of data transmission are the relatively short range
(< 10m) and limited speed. When transmitting large quantities of data, as does
the Dionex photodiode array detector UVD340S, special interface boards must
be used.

 Dionex Universal Chromatography Interface (UCI-100)
In chromatographic systems, different interfaces are required for data
acquisition and device control. The Universal Chromatography Interface
(¾UCI-100) provides these different interface types and makes them available
to the chromatography server. For communication with the chromatographic
data system of the server, either a USB or an Ethernet connection can be
used.

This chromatography interface, which is designed to meet the requirements of
modern chromatographic systems controlled by the Dionex Chromatography
Management System, is equipped with 8 analog inputs, 8 (digital) ¾Remote
Inputs, 8 digital outputs (relay outputs), as well as BCD inputs for the sample
position. In addition, 4 RS232 ports are available.

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! NT4 computers do not support USB. Thus, if LAN
connections are required, additional Equinox boards must be
used for instrument control via RS232. We recommend using a
peer-to-peer connection for analog data acquisition via LAN
(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC - see

 Connecting the UCI-100 via a Peer-to-Peer Connection
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under NT4).

For installation information, see  Installing the Dionex Universal
Chromatography Interface (UCI-100).

 DX-LAN
Many Dionex instruments can communicate with the Dionex Chromatography
Management System through a Dionex local area network (DX-LAN). The DX-
LAN network consists of a PC equipped with a DX-LAN interface card and at
least one additional device, for example, a GP50 pump, AS50 autosampler, or
ED40 detector. The additional device must also be equipped with a DX-LAN
interface card.

For installation information, see  Installing the DX-LAN Card.

Timebase

If you intend to operate a single chromatographic system with the Dionex
Chromatography Management System, you will work with a single timebase.
All instruments (sampler, pumps, detector etc.) are time-dependent on each
other and are synchronized during operation, i.e., they have a common clock. If
you control several systems, the individual systems work independently
(asynchronously) from each other: the Dionex Chromatography Management
System must manage a separate timebase for each system, i.e., the systems
behave as if they were controlled by separate PCs.

PC

To work with the Dionex Chromatography Management System, a Windows
PC with a Pentium processor (minimum 100 MHz) with a 32-bit  Operating
System Windows 98, Windows NT or Windows 2000) is required. To work
efficiently, we recommend at least 32MByte RAM for Windows 98 and 64
Mbytes for Windows NT/Windows 2000. For graphical representation, you
need a graphic board with a resolution of minimum 800 x 600 pixels. However,
for a clear and ergonomically representation a 17" monitor with a resolution of
1024 x 768 pixels is recommended. An industry-standard mouse and sufficient
hard disc capacity (at least 200 Mbytes free capacity should be available) are
necessary for comfortably working with the data system.
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These requirements apply to systems with one or two timebases without the
diode array option. If you use several timebases or diode array detectors,
higher requirements must be met. In this case, we recommend a Pentium II PC
(266 MHz or higher) with 64 Mbytes RAM and a free disc capacity of at least 1
Gbyte.

PC requirements for acquiring mass spectra
The complete XC system (REV 1.2) must be installed on every computer (also
pure Remote Clients of the Dionex Chromatography Management System) that
should be able to access MS data. That is why the minimum system
requirements for an LC/MS System are as follows:
• 400 MHz PII CPU
• 128 MB RAM
• 10 GB hard disc
• 1024 x 768 x 16 screen resolution

Operating System

The Dionex Chromatography Management System supports the following
operating systems:
• Windows 98
• Windows NT 4.0/Windows 2000.

In contrast to the earlier operating systems Windows 3.0 and 3.1, these are 32-
bit ¾Multi-Tasking operating systems, i.e., several programs can be executed
simultaneously. This is especially important for instrument control, data
acquisition, and comfortable printer support.

 Caution: Note the differences between the operation of the Dionex
Chromatography Management System under Windows 98 and
Windows NT/Windows 2000. See  The Dionex
Chromatography Management System under Windows 98
and Windows NT/2000 in the Installation section.

Network

The network capability of the Dionex Chromatography Management System
allows operation of the data system within local and global networks, also
referred to as LAN ("local area network") or WAN ("wide area network").
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The Dionex Chromatography Management System cannot only be operated
locally in a single-user installation, but also within a network. This includes data
transfer and remote operation via ISDN. The stations of the Dionex
Chromatography Management System can be linked around the world (Wide
Area Network).

To use all advantages and possibilities offered by network operation, such as
centralized data storage, backup and administration, shared access to methods
and worldwide availability, safe and fast data exchange is essential.

Sometimes even state-of-the-art networks have difficulty coping with the
enormous amount of data. That is why client/server systems offer decisive
advantages by specifically selecting transferred data.

Client/Server System
From a decentralized PC (client), sub-programs are started on a central
computer (¾Server or Chromatography Server) via ¾RPC commands (Remote
Procedure Calls). The server executes the actual "work," e.g., searching for
data in a database or running an application. The client merely receives the
search result or the status of the application. This means that the client
provides the user interface, and the actual operation is performed on the server
via "remote control." The Dionex Chromatography Management System also
uses this "division of labor."

The user starts the Dionex Chromatography Management System on a local
PC, the ¾Client. Now the user can perform all server-independent tasks. This
includes re-processing of raw data, creating sequences, or searching individual
spectra in a library.

If a Chromatography ¾Server has been activated via the ¾Server Monitor
Program, controlling and monitoring the chromatography instruments
connected to the server is possible. Theoretically, each client that is connected
with a running server via a ¾Control Panel can perform this control. In practice,
the first client using this possibility also has control rights. From this point, all
other users of the Dionex Chromatography Management System can only
monitor the system status.

Via device drivers, the server converts the control commands entered on the
first client PC for the analytical instruments. Inversely, the server receives
information from the system and forwards it to the appropriate locations. Thus,
status information, such as the current flow rate, appears on all client PCs
connected with this chromatography system. Raw data is automatically stored
in the directory of a ¾Datasource and the underlying database.
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Depending on whether the client and the server are located on the same PC or
on different PCs in a network, a distinction is made between the following
installation types: local client/server installation and network installation. For
further details, see the topics below:

 Local Client/Server Installation
 Network Installation

 Local Client/Server Installation
The ¾Client and the (Chromatography) ¾Server are located on the same PC.
They must be started separately.

The controlled instruments in the chromatography system are connected to the
PC via RS232 ports or a ¾DX-LAN. Additional interface boards can supply a
sufficient number of ports. Each chromatography server can operate a
maximum of 6 controlled or 16 non-controlled ¾Timebases (chromatography
systems).

Saving data is on the local PC. During the initial installation of the Dionex
Chromatography Management System, a local datasource is installed on each
local computer.

If the PC is part of a local network (LAN = Local Area Network or WAN = Wide
Area Network), data can also be saved externally. In the same way, external
data can be used for data editing.

RS232

Operating 
SystemClient

Server
Data 
Sources

If the local PC is connected to a network, all options of a network installation
are available.

 Network Installation
The ¾Client, the Chromatography ¾Server, and the ¾Datasource can be
installed on different computers. They are connected via the network and the
corresponding network server (generally a Windows NT/2000 server). Each
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chromatography server can operate up to 6 controlled or 16 non-controlled
chromatography systems (¾Timebases).

Client, Server and Datasource are independent units within the network.

ISDN

WAN

Network
Server

Client

Server

Chrom. System

On each PC, a server, a client, and a local datasource are set up during the
installation of the Dionex Chromatography Management System.
Independently of this, each PC can act as "server only" or "client only."
Theoretically, each client can access each datasource and each server. In
practice, this may not be desirable for safety reasons. Therefore, various
options are available to restrict user access.

• The ¾Server Configuration program allows defining the extent of network
operation for each ¾Server and for each timebase. A server can be made
available for the entire network or ¾Access Groups, only, or the server can
be locked partly or completely. If the server is partly locked, e.g.,
monitoring the server is possible, but controlling the connected instruments
is disabled. In this case, control is reserved for the local client. This
distinction also applies to the timebases. If three timebases (TIME1/2/3)
are installed on a server, TIME1 could be completely shared, TIME2 could
be excluded from the network operation, and TIME3 could be shared for
monitoring only.

• Datasources and/or their subdirectories can also be protected from
undesired access. Depending on the location of the corresponding
database (on the local hard disk or a network PC), the respective user or
the network administrator decides (by "sharing" a directory) who which data
can be accessed and by whom. In addition, datasources shared in
Windows can be locked in the Dionex Chromatography Management
System.

• Another type of access restriction is possible via the ¾User Mode or User
Management of the Dionex Chromatography Management System. If
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access control is activated (the CmSecure program is available for
administrators), the user must be identified via password input. From this
point, the user can only perform specific operations assigned by the
network administrator via the CmUser program. Thus, it is possible to deny
controlling rights or prohibit "locking" of datasources.

Important data are often stored on central data server PCs. If, during data
acquisition, the network connection is interrupted or the data server PC
crashes, data acquisition should be continued, nevertheless. All data that are
relevant for the server of the Dionex Chromatography Management System are
locally stored on the server's hard disc thus ensuring that the data acquisition
will not be interrupted in case of a network failure. The ¾Network Failure
Protection is available for Windows NT and Windows 2000, only.

In addition to allowing data exchange within a local area on a Windows, Novell,
DEC, or UNIX network (LAN), data transfer across huge distances (WAN) via
ISDN is of course also possible. The basic requirement for any type of network
operation is the availability of the corresponding network drivers for Windows
98 or Windows NT/2000.

 Caution: Note the differences between the operation of the Dionex
Chromatography Management System under Windows 98 and
Windows NT/2000. Also, see  Dionex Chromatography
Management System under Windows 98 and Windows
NT/2000 in the Installation section.
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Overview: Chromatography Data System

The data system is the control center of a modern chromatography system.

Tasks of a Data System
• It converts user input into time-precise control commands.

• It monitors the state of the connected chromatography instruments.

• It logs all user entries and modifications to the system.

• It saves and archives all data.

• It graphically represents data and allows the user to check the system
status and system results.

• It allows the user to thoroughly check and evaluate data.

Components
• The basis for precise control is a real-time capable  Operating System.

• Installation and configuration is the task of the  Server Configuration.

• Communication with the different instruments and device types is enabled
by the  Chromatography BIOS and various  Device Drivers as well
as  Virtual Channel Drivers.

• Each operation, for example, execution of a command or display of an
error message, is included in the  Audit Trail.

• Depending on the required scope of performance, the Dionex
Chromatography Management System offers various  Options.
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User Interface of the Dionex Chromatography Management System

• Regarding the menu structure, screen elements and operation, the Dionex
Chromatography Management System offers all typical Windows
properties. A homogeneous, situation-related menu structure is as evident
as the Windows technology, toolbars, and context-sensitive use of the right
mouse button (see  The Client User Interface).

• Each user can save and activate a "personal" screen (  User
Profile/Workspace).

• The user can modify the graphical representation of the online control
windows (see  Control Panel).

Operation
• Before the  Program Start, the correct hardware configuration,

connections between the PC and the system and between the PC and a
datasource must be ensured.

• In  Network Operation, the client PC can control systems and
datasources that are not directly connected with the PC.

• Operating the data system is facilitated by various assistants, the
¾Wizards.

 New Features Compared to GynkoSoft
The Dionex Chromatography Management System for Windows 95/98 and
Windows NT/Windows 2000 offers a variety of new features and
enhancements in comparison with the previous product (GynkoSoft), including
the following:

• Modern control technology via Client/Server Architecture and Windows
RPC technology (see  Network)

• Complete  Network Installation

• Individual subprogram for user management: CmUser  (The Online Help
provides further assistance if this program is installed on your PC).

• Query-based data access via an integrated ¾Database

• Connection to standard ¾ODBC / SQL databases
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• Tele-service (Remote maintenance)

• Freely definable workspace in the  Control Panel

• ¾Mass Spectrometer control and MS data evaluation

• ¾Sample-Oriented Operation

• ¾Electronic Signature of sequences

• GLP compliant: automated ¾Instrument Qualification (IQ) and
¾Operational Qualification (OQ) as well as Instrument OQ and
¾Performance Qualification (PQ) of the Dionex Chromatography
Management System

• ¾Year 2000 Conformity (either 2- or 4-digit year formats are supported,
e.g., 1-1-00 or 1-1-2000)

User interface and operation correspond to the standard Windows
requirements:

• Comprehensive ¾Online Help

• Easy operation due to ¾Toolbars, Windows Technology (see Basic
Operation  Working with Several Windows) and ¾Wizards

• Comprehensive context menus via the ¾Right Mouse Button

• ¾Drag & Drop functionality

• Real ¾Multi-Tasking and ¾Multi-Threading

In addition, the new chromatographic interface now features special novelties
and enhancements:

• Optical representation of the gradient profile

• Online zooming beyond the current time

• Grid in online window

• Additional peak variables

• Determination of reference wavelength for individual channels

• Wavelength compensation via holmium oxide filter

• Enhanced data compression and restoration of old data
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• Baseline subtraction, now called blank run

• Base area correction/base area recognition

• Comprehensive Online Help for any situation

For detailed information on any differences that might occur when creating
programs, also see How to ...: Actions in the PGM Editor  Differences
Compared to GynkoSoft

 Options of the Dionex Chromatography Management
    System
The Dionex Chromatography Management System's scope of performance can
be adjusted to the requirements of a specific application. In addition to the
basic software package, various options can be purchased.

The purchased scope of performance is coded in a copy protection chip or from
the ¾License Server (see  Software Protection). The Dionex
Chromatography Management System can only be started with the full range of
features if a protection device was detected, i.e., a ¾Dongle on the parallel PC
interface or a ¾PAL on the A/D converter, or if a license was detected, which
was provided by the license server.

The following options are available for the Dionex Chromatography
Management System:

Basic:

Basic (c'ntd)

The basic license (without additional features) includes:
Signal acquisition with one timebase from any number of synchronous
channels; Multi-Tasking; Reports from the following partial methods:
single and multiple point calibration with various fit models, integration,
ratio test, user programs, etc.
The following drivers are available if only the basic license is available:
1. Sharable Devices

"Dionex 16 Chl. A/D Converter" (  A/D Converter for ports only):
"Dionex 16 Relays ISA Board (ME63)"
"Dionex 16 Relays PCI Board (ME630)"
"Dionex Digital I/O ISA Board (ME14)"
"Dionex Digital I/O PCI Board (ME1400)"
"Dionex PDA DA Converter (16 Bit)"

"Dionex Pump Control Board" (  Pump Control Board for relays
and inputs only; pump control is not supported)

2. ¾UV and Photodiode Array Detectors (properties cannot be changed
in the PGM or commands cannot be changed during the data



26 Hardware and Software Chromatography Components

acquisition):
"Dionex UVD340S"
"Dionex UVD170S"
"Dionex UVD320S"
"Dionex UVD160S"

3. In addition, the following general ¾Device Drivers are available:
Integrator Driver (provides A/D channels for the timebase)
Remote Inject (input required)
¾Shared Relays and Inputs
¾Virtual Channel Driver

Therefore, the basic license does not provide most of the device drivers
that are available with a Control or Extended Device Control license.
This also means that the corresponding commands are not available,
e.g., ⇒Wait or ⇒Delay. In addition, you cannot ⇒trigger commands.

Control: Control allows controlling chromatography systems. The software module
must be purchased once to control any number of timebases.

Extended
Device Control

The Extended Device Control option allows controlling additional
chromatography instruments not supported by Control (Control licenses
included)

RPC: With the RPC extension, the Dionex Chromatography Management
System can be controlled network-wide. For each installed
Chromatography ¾Server one option is required.

Timebase: Additional license for extending the Dionex Chromatography Management
System by one timebase. Per PC, a maximum of 6 timebases can be
installed.

Client: Additional single-user license for data reprocessing on a network PC
including control of any number of systems in the network.

Data: Additional single-user license for data reprocessing on a network PC
without control.

PDA: Additional single-user license for photodiode array detectors: digital data
acquisition of a three-dimensional data field which is required for the
representation as 3D-plot as well as for peak purity control

Library: Additional single-user license for the access to special spectra libraries.
IC Control: Module for controlling ion chromatography timebases (IC Control SE

license included).
IC Control SE: Special control module for stand-alone ion chromatography systems,

such as DX-120 Ion Chromatography System.
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 Chromatography BIOS
BIOS is the abbreviation for Basic Input/Output System. As a (software)
component of each MS-DOS PC, it serves for a uniform control of all PC
peripherals, i.e. the screen, disks, keyboard etc. BIOS allows the operating
system MS-DOS to communicate with disk drives or keyboards from different
manufacturers. From the viewpoint of a PC user, a keyboard delivers command
strings to a PC; a disk provides a certain amount of storage capacity. The
technical realization of these components is irrelevant.

The Dionex Chromatography Management System implements this reliable
and well-proven concept in its unique chromatography BIOS:

From the viewpoint of the user, the fluidic system of an HPLC pump consists of
a flow total and several partial flows that are usually referred to as %A, %B,
and %C. The sampler injects varying volume quantities from different positions
and performs additional derivation steps, as necessary. Analysis by a
conventional UV detector offers the following functions: The user specifies one
(or several) wavelength(s), varies the full scale, and executes Autozero etc.
How the individual functions are realized technically, is of no interest for the
operation. The user assumes that the commands are executed, regardless
whether they were entered manually via the user interface or via a control
program (  Control Program).

The Dionex Chromatography Management System control therefore only
knows "virtual" commands, e.g., ⇒Flow (Flow Rate) or ⇒Partial Flows. The
chromatography BIOS converts these commands into control commands
readable by the instruments. To the user, it is thus irrelevant whether a
command (for example, %B) is directed to a low-pressure gradient pump or a
high-pressure gradient system.

This is possible by conversion programs that are available for each instrument
and device type, the  Device Drivers.

 Device Drivers
The Dionex Chromatography Management System is capable of operating a
number of different analytical instruments via a uniform, device-independent
control language. The Dionex Chromatography Management System uses the
driver concept, which means that the appropriate ¾Device Driver must be
loaded for each controlled device. This is done automatically when the data
system is started.

The device driver determines the instrument's scope of functions. The driver is
responsible for all device-specific tasks such as sending commands in the
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command language of the device or deciphering the data sent by the device.
Thus, the control ¾Program of the data system does not have to deal with
specifics but prompts the driver to execute certain instrument functions (for
example, inject 9 ml from vial 17).

All drivers are stored in the BIN directory. They have a version number
assigned that can be viewed in the Explorer via the Properties context menu.

Third-party instruments can be controlled if the corresponding driver support is
available. Please contact Dionex Service for information on supported
instruments.

 Virtual Channel Drivers
In addition to the ¾Device Drivers, the Dionex Chromatography Management
System offers the possibility to install a driver for virtual channels (¾Virtual
Channel Driver). Similar to device drivers, this driver is installed in the

 Server Configuration. Also, see  Virtual Channel Driver: Installation.

By default, the Dionex Chromatography Management System generates 16
virtual channels. All individual channels have the same sampling step. If you
require different sampling steps, install another instance of the virtual channel
driver.

Following the installation, delete any channels you do not need. Open the
context menu (right mouse button), click Properties, and then choose the
Signals tab. To change the default channel name, click the Change button.

As ¾Virtual Signals cannot be generated manually, the corresponding
¾Program must be started. For information on how to enter commands, see
How to ...: Device Control   Virtual Channel Commands.
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 Audit Trail
The Dionex Chromatography Management System device drivers do not only
send the parameters specified in the control file to the corresponding devices,
but also constantly monitor the device parameters and compare the nominal
values with the actual values. Deviations from the nominal values are either
corrected or indicated by an error message.

Each command, each correction, and each error message is both, recorded
and stored by the Dionex Chromatography Management System with split-
second accuracy and displayed in the Audit Trail window of the  Control
Panel.

 Caution: Complete documentation of all performed commands and status
messages is only possible with Dionex instruments. Not all third
party instruments are capable of communicating current device
parameters regularly or upon request.

For further information on storing protocol data, see  Protocol Data (Audit
Trail) in the Data chapter.
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Installation: Software

Tips for Software Installation

In general, the Dionex Service or an Authorized Dionex Distributor installs the
Dionex Chromatography Management System.

If this is not the case, proceed as described in the  Initial Installation and
Update section. After the installation, see  Program Start.

Initial Installation and Update

 Note: Please note that the PC Power Management features must be
switched off in the BIOS! Otherwise, problems may occur when
controlling instruments.

 Note: Please note the information on using  Dionex
Chromatography Management System under Windows 98
and Windows NT/Windows 2000 The installation under
Windows NT/Windows 2000 is only possible if the user
performing the setup has administrator rights!

Setup of the Dionex Chromatography Management System
Opening the Dionex Chromatography Management System Setup program
SETUP.EXE starts initial installation of the Dionex Chromatography
Management System. If CD Autostart is active on your PC, the installation is
started automatically upon insertion of the CD into the respective drive.

 Caution: Neither the ¾Server, nor the ¾Client, nor the server monitor
must be active during the Setup procedure. Ensure that there are
no minimized program buttons on the Windows task bar and that
there is no server monitor icon!
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 Caution: Controlling an aQa ¾Mass Spectrometer requires installing the
¾Xcalibur software before you install the software of the Dionex
Chromatography Management System. For information on how
to proceed, see How to..: Actions Related to the aQa-MS

 Installing MS Components.

Follow the installation steps to correctly install the Dionex Chromatography
Management System. Please note:

• Answer Yes to the question Enable mass spectrometry support in the
server if Xcalibur is already installed.

• Take a note of the directory name in which the Dionex Chromatography
Management System is installed.

• When prompted whether to create a link to the Server Monitor program in
the Autostart group, choose Yes.

At the end of the installation process, a program group <NAME of
DIRECTORY> is generated in which you find five links to start the different
program parts and to uninstall the Dionex Chromatography Management
System.

The programs on which the links are based are located in the BIN directory in
the directory structure created by the Dionex Chromatography Management
System:
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The DATA directory contains various subdirectories (PANELS, REPORTS,
PROGRAMS, PCNAME_1) that serve to save default templates. A default
¾Datasource is also created. The underlying database is located directly in the
DATA directory under the name CM_LOCAL.mdb.

Datasources are only visible in the Browser of the Dionex Chromatography
Management System (see Data  Browser). The environment created by the
Setup program has the following structure:

The local datasource has the name <PCNAME_local>. It contains the
subdirectory PCNAME_1 in which the ¾Sequence "manual" is located. The
sequence consists of a single default sample and enables the manual data
acquisition. To access default templates directly in the Dionex Chromatography
Management System, subdirectories of the DATA directory are mapped
(PANELS, REPORT...).
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Modifications to the described directory structure are realized by creating new:
• Datasources and sequences (in the Browser)

• Timebases (in the  Server Configuration).

 Caution: If the Dionex Chromatography Management System is not
started correctly, there may be a version conflict between the
system files in the Windows system directory. In this case, install
MDAC_TYP.EXE once again. The  Installation Qualification
Manager (described in the Validation section) provides an
overview on the version numbers used

Updating the Dionex Chromatography Management System
Updating the Dionex Chromatography Management System is started by file
SETUP.EXE.

 Tip: When updating the Dionex Chromatography Management
System, uninstalling a previous Dionex Chromatography
Management System version is not required and not
recommended, as this would delete all entries in the Registry of
the Dionex Chromatography Management System (e.g., key
code, PAL location, and datasources). Before updating the
version, close the server, the client, the Server Monitor Program,
and all other applications!

If the Setup program detects "old" PAN files (control panel) or RDFs (report
definition files) in the directories PANELS and REPORT, the user is prompted
whether to overwrite existing destination files. Therefore, it is highly
recommended to save personal PAN files, RDFs, and, if necessary, GEN files
to prevent inadvertent overwriting.

 Tip: Before performing an update, copy all PAN files, RDFs, and GEN
files you created to a separate directory to prevent inadvertently
overwriting the files.
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The Dionex Chromatography Management System under
Windows 98 and Windows NT/Windows 2000

The Dionex Chromatography Management System supports the operating
systems Windows 98 or Windows NT/Windows 2000. Although Windows
NT/Windows 2000 and Windows 98 have similar user interfaces, their cores
differ considerably. Windows NT resembles more the "large" operating systems
such as UNIX or VMS, while traces of DOS can still be found in Windows 98.
The focus of Windows NT/Windows 2000 has been stability, safety, and
security. These properties are responsible for the higher storage capacity
demands of Windows NT and Windows 2000.

When operating the Dionex Chromatography Management System under
Windows NT or Windows 2000, note the following aspects:

Setup
For performing the Setup of the Dionex Chromatography Management System,
PC administrator privileges are required on the Windows NT computer.

Otherwise, it is not possible to create ¾Datasources or install various system
programs. The Dionex Chromatography Management System cannot operate
correctly without these settings.

Under Windows NT/Windows 2000, SETUP creates the user group
Chromeleon Operators. The user currently logged onto the system is
immediately included in this group. All users wishing to work with the Dionex
Chromatography Management System must also be members of this group.
Under Windows NT, adding new users and assigning them to various groups is
via the User Manager. Access the User Manager by pressing Start menu →→→→
Programs →→→→ Administrative Tools. The registered users can be added to a
group.

Datasources
When generating a new datasource or when connecting to an existing
datasource, activate the check box Common Datasource for system-wide
access sharing. Instead of being assigned to a specific user, the datasource is
recognized in the entire system as a system datasource. Creating system
datasources also requires administrator rights on the local PC.

All datasources that are accessed by the server of the Dionex Chromatography
Management System to process sequences must be system datasources.
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Server Access to the Network
Users logging onto a PC have a personal Windows NT user account defining
the currently granted rights. Under Windows 98, this user account is not
required.

If a server is installed simultaneously on the PC, it will automatically have the
same rights under Windows 98 as the current user. As soon as the user logs
off, the server looses the network access.

Under Windows NT, this is not the case. Here, the server is installed as a
system-inherent service. As long as the server only works on the local
datasource, this will have no negative effects. In contrast, the server will
continue operation even if a user logs off the system.

Problems occur when the server is to perform operations via the network. If the
server should process sequences located on a network datasource, a special
procedure may be necessary under Windows NT. The server must be assigned
a user account for its network accesses. This is only possible if the user has
administrator rights.
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Proceed as follows:

• Click the Services icon in the control panel.

• Choose the Chromeleon Server item from the list and press the "Start..."
button.

• Caution: do not modify the Chromeleon Driver entry!

• In the Services dialog box, activate This Account. Enter a user name and
password with access to the corresponding network directory. With the
button on the right of the edit field, you can choose a user name from the
list.

 Tip: The selected user must be a member of the CHROMELEON
Operators group.

If users have to change their passwords at regular intervals,
establishing a separate account for the server is recommended
as this saves the effort to change the passwords for the server
service of the Dionex Chromatography Management System at
regular intervals as well.
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After completion and restarting the system, the server of the Dionex
Chromatography Management System is automatically logged on under the
new user account.

Network Failure Protection
A ¾Network Failure Protection is available for Windows NT and Windows
2000. It is disabled on Windows 98 because these systems are unstable under
network failure conditions.

The network failure protection ensures uninterrupted data acquisition on an
external server PC in case of a network failure. For this purpose, the server of
the Dionex Chromatography Management System stores all relevant data on
its local hard disc. The ¾Server of the Dionex Chromatography System
continues processing these sequences even in case of a network failure. In
addition, the failure of the network connection is logged in the Audit Trail
(  Protocol Data).
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Software Protection

Each station of the Dionex Chromatography Management System, regardless
of whether it is a server and/or a client, is protected by a copy protection chip
(¾Dongle) or a hard-protect plug-in board (¾PAL). PALs and dongles store the
licensed serial number for one Dionex Chromatography Management System
station.

For large installations, a ¾License Server has been developed for the Dionex
Chromatography Management System to manage the availability of licenses.

Each user of a dongle or PAL-protected station must enter a 12-digit or a 24-
digit ¾Key Code during the installation of the Dionex Chromatography
Management System. The key code includes all functions and  Options of
the Dionex Chromatography Management System made available to a
specific user. A key code matches exactly one serial number.

 Caution: It is not possible to operate several stations of the Dionex
Chromatography Management System with the same key code
or to expand the scope of functions on a different station. Only if
the entered key code matches the dongle or the PAL plug-in
board, operation of the Dionex Chromatography Management
System is possible beyond the one-hour demo mode.

If the functions of the Dionex Chromatography Management System are
upgraded by acquiring the corresponding license, the user receives a new key
code. The extended scope of functions is made available upon entering the
new code.

Also, see How to ...: Actions in the Server Configuration  Selecting the
Copy Protection Location and Entering the Key Code.

Access Control

The network capabilities of the Dionex Chromatography Management System
allow the user to perform any operation from any workstation (Client). As the
network itself, the Dionex Chromatography Management System has a
comprehensive system of user management. The ¾CmUser and CmSecure
programs enable the system administrator to control access to data, systems,
and stations.

This is to guarantee that only authorized users can access specific
¾Timebases, data, ¾Datasources, directories, ¾Sequences, templates, etc.
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Access-protected operations include:
• Creating, modifying, and deleting ¾Clients, datasources, directories,

sequences, samples, work lists, workspaces, ¾Queries, server
configurations, timebases, spectra libraries, ¾Control Panel, report
definitions, and quantification methods (QNT files)

• Starting data acquisition and batch processing, exporting and printing batch
data

• ¾Electronic Signature of sequences

• Saving and deleting peak manipulations

• ¾Backup and restoring datasources, directories and sequences
(see: ¾Restore)

• Importing and exporting data

• Access to ¾Servers and timebases

Granting Privileges
The administrator performs granting privileges. When access control is
activated, the administrator thus defines the scope of functions available to
each user and assigns passwords.

When the user logs onto a station subject to access control with his/her
¾Password, the "personal" privileges are available. It is irrelevant on which
station the user logs onto the system.

 Caution: Client stations that are not subject to access control have free
network access to any unprotected objects of other clients'
stations. In the case of a datasource, this means that access is
possible as soon as the datasource directory is shared in the
Windows Explorer. Access is restricted as soon as an ¾Access
Group is assigned in the Browser of the Dionex Chromatography
Management System. This is possible after selecting the
datasource and choosing the Properties command (context
menu or Edit menu).

In the ¾Server Configuration program, the Properties dialog allows limiting the
operations that can be performed from another PC. For example, to allow
monitoring but not controlling a timebase, deactivate the Control checkbox
under Allow Remote (see example below).
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Executing Privileges
In general, personal access options and ¾Privileges are already defined when
the user of the Dionex Chromatography Management System logs onto the
system. This means that the user can perform all tasks available on the screen
or accessible via mouse click. The user has no influence on the status of the
entire system.

This can be different for users who are granted extensive privileges. These
users are able to change access to datasources, directories, sequences,
servers, and timebases in the Dionex Chromatography Management System or
in the Server Configuration. The corresponding object is selected in the
Browser or the Server Configuration and can then be supplied with a new
access group assignment via the Properties (context menu). In addition,
datasources, directories, and sequences can be locked. A red lock ( )
on an icon indicates that the respective item is locked.

CmUser.EXE and CmSecure.EXE
Two separate programs are available to the Administrator, the CmUser
program (CmUser.EXE), and a program for enabling the ¾User Mode
(CmSecure.EXE). Both programs are included in the CmUser directory of the
Setup, but are not automatically copied to the program directory.

The CmUser program is password-protected as well and can be opened only
by the Administrator or persons with similar functions.

 Tip: Authorized persons should copy the CmUser directory to a floppy
disk to enable on-site changes to the user management. This
directory also contains an Online Help file describing all steps
and options of the user management.

The main task of the CmUser program is administration of User, Privileges, and
AccessGroups. The following operations are possible:

• Creating and editing ¾Access Groups (A-group)

• Creating and editing ¾Privileges (privilege group or P-Group)

• Creating and editing new users in the Dionex Chromatography
Management System. The user’s name and title, the logon and signature
¾Password, and the reaction on a failed ¾Logon can be defined.

The CmSecure program allows enabling and disabling the User Mode on the
clients of the Dionex Chromatography Management System. In addition, a
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CmUser database containing the status of each user and his/her rights is
selected in the CmSecure program. Starting the Dionex Chromatography
Management System requires a password when the User Mode is enabled.
Signing sequences electronically is possible with enabled User Mode only (see
¾Electronic Signature).

The CmSecure program serves to create a CmUser database that contains the
status of each user and the rights granted to him/her. In addition, user control is
enabled and disabled on regular stations of the Dionex Chromatography
Management System. With enabled CmUser mode, a password is required to
start the Dionex Chromatography Management System.

Users can work with an object if they are members of an A-group granting
access to this object. The actions they are allowed to perform are determined
by the assigned privileges (to members of a P-group).

Example
A Dionex Chromatography Management System with the two timebases TB1
and TB2 is to be operated by five users, U1, U21, U22, U31, and U32. U1 is
the system administrator with unlimited access to all objects of the Dionex
Chromatography Management System. U21 and U22 are authorized to record
data with both timebases; U31 and U32 can only use TB1 for analyses. The
administrator sets up the following users, A-groups and P-groups in the
CmUser program:
• Users: U1, U21, U22, U31, and U32,

• A-groups: A1 (contains only U1), A2 (members: U1, U21, and U22) and A3
(U1, U31, and U32),

• P-groups: P1 (U1), P2 (U1, U21, and U22) and P3 (U1, U31, and U32).

After that, the administrator assigns the access privileges for the timebases
TB1 and TB2 in the ¾Server Configuration program. To perform this task, click
the corresponding timebase and select the Properties in the context menu or
from the Edit menu.

In the example, the properties of TB2 are as follows:
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Only the members of the A1 and A2 groups can access the timebase TB2.
From other network computers, it is possible to view the results, start data
acquisition and control batches. However, controlling the timebase from other
computers is not possible.

The Server Configuration

Function
The ¾Server Configuration program serves to install ¾Timebases on a
¾Server. It is only required by users who use the Dionex Chromatography
Management System to control a chromatography system and who wish to
change the current instrument configuration.

For users who exclusively perform data evaluation it is not necessary to be
familiar with this program part.

Starting the Server Configuration
• To start the Server Configuration and perform changes to the server

configuration, select Server Configuration from the Start/Programs menu
on the task bar. For example, for CHROMELEON, choose Start >
Programs > Chromeleon > Server Configuration.

 Caution: Modifications of the installation are possible only if the server to
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be configured is started (see  Program Start in the Installation
section) and if no sequences or samples are currently processed
on this server.

When opening the Server Configuration for the first time or when changing an
existing server configuration, there are also changes in the directory structure.

Description
The user interface of the Server Configuration has two partial windows (see
figure below). The left window section lists the names of all currently active
(started) chromatography servers. The right-hand section of the Server
Configuration logs the configuration process (Audit Trail).

A running server is shown in the shape of a PC icon; an inactive server is
crossed out red. A red prohibitive sign (red circle with white line) indicates that
a server is active (for example, processing samples).

Click the "+" character next to any server name to see its timebases and
hardware components (Timebase, Hardware). In the same way, the
chromatography instruments assigned to a timebase (Devices) are made
visible. Information on the type and number of all installed components is,
together with their configuration, stored in the file CMSERVER.CFG.
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Installation/Configuration Procedure
Access to a server (and thus changing its configuration) is only possible after it
is started. In addition, sequence or sample processing is not possible at the
same time!

If this is ensured, the Server Configuration allows adding and removing
timebases, hardware and instrument components. The configuration of each
component can be changed here. The changes are saved in the ¾Server
Configuration.

• Select Connect Remote Computer in the Server menu to establish a
connection to a specific server. Enter the computer name of the server and
the protocol to use. As soon as there is a connection to the server, its
name and symbol appear in the left window section of the Server
Configuration.

• Select Add Timebase / Add Device / Add Sharable Device in the Edit
menu to add new components to the system.

• Select a component in the file structure and double-click to change its
configuration. Alternatively, you can choose the Properties option in the
context menu. In both cases, a dialog box is opened with several tab dialog
boxes; these contain all configuration options.

When opening the Server Configuration for the first time or changing an
existing server configuration, the directory structure also changes.

• The Dionex Chromatography Management System creates a local
datasource under <PCNAME_local>.

• For each timebase on the current server, the datasource receives a
separate subdirectory for storing the corresponding raw data.

• Below each timebase, a sequence directory with a corresponding
sequence is created. The sequence contains a sample for manual data
acquisition.

For detailed information on the server configuration, see How to ... Actions in
the Server Configuration  Changing the Server Configuration
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Installing Dionex Instruments

The following instruments are installed via the ¾Server Configuration:

Pumps and connected components

Instruments Driver Names Remarks

M480, P580 Dionex M480/P580 Pump HPLC gradient pumps

GP40, GP50,
GS50

Dionex GP40/GP50/GS50
Pump

IC gradient pumps

IP20, IP25,
IS20, IS25

Dionex IP20/IP25/IS20/IS25
Pump

IC isocratic pumps

EG40 Dionex GP40/GP50/GS50
IP20/IP25/IS20/IS25 Pump

Eluent generator (installed via
the IC pump drivers)

LC25, LC30 Dionex GP40/GP50/GS50/
IP20/IP25/IS20/IS25 Pump

Temperature control modules
(installed via the IC pump
drivers)

For information on the respective control commands, see
 Dionex Pumps

Autosamplers

Instruments Driver Names Remarks

GINA 50 Dionex GINA50
Autosampler

Autosampler (50 positions;
cooling option: GINA50T)

GINA 160 Dionex GINA160
Autosampler

Autosampler (160 positions)

ASI-100 /
ASI-100T

Dionex ASI-100
Autosampler

Autosampler (100 positions) /
ASI-100 = with temperature
control

AS50 Dionex AS50 Autosampler Autosampler (50 positions,
optionally available with
temperature control)

AS 3500 Dionex AS 3500
Autosampler

Autosampler (160 positions)
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For information on the respective control commands, see

 Dionex Autosamplers GINA 50 and GINA 160
 Dionex Autosamplers ASI-100 / ASI-100T
 Dionex Autosamplers AS50

Detectors

Instrument Driver Names Remarks

AD20, AD25 Dionex AD20/AD25
Detector

UV detectors (single wavelength)

UVD 160S,
UVD 170S

Dionex 160S /170S
Detector

UV detectors (several wavelengths -
can be upgraded to PDA functions)

UVD 320S,
UVD 340S,

Dionex 320S/340S PDA PDA detectors (200-595 nm)

PDA-100 Dionex PDA-100 Detector PDA detectors (190-800 nm)

CD20/CD25/
CD25A

Dionex CD20/CD25/CD25A
Detector

Electrochemical detectors
(conductivity)

ED40/ED50/
ED50A

Dionex ED40/ED50/ED50A
Conductivity Detector
Dionex ED40/ED50/ED50A
DC Amperometry Detector
Dionex ED40/ED50/ED50A
Integrated Amperometry
Detector

Electrochemical detectors in the
respective versions

RF1002,
RF2000

Dionex RF1002/2000
Fluorescence Detector

Fluorescence detectors (available via
Dionex)

In addition, the Finnigan aQa ¾Mass Spectrometer is available from Dionex as
well. For installation information, see  FINNIGAN in the Installation section.
For information on the control commands for Dionex detectors, see

 Dionex Absorbance Detectors AD20/AD25
 Dionex UV/PDA Detectors UVD 160S/320S and UVD 170S/340S
 Dionex Photodiode Array Detector PDA-100
 Dionex Electrochemical Detectors CD20/CD25/CD25A,
ED40/ED50/ED50A, and IC20/IC25/IC25A
 Dionex Fluorescence Detectors RF1002/RF2000
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IC systems and other components

Instruments Driver Names Remarks

DX-120 Dionex DX-120 System Integrated IC system module with
injector, pump, and detector

IC20/IC25/
IC25A

Dionex IC20/IC25/IC25A
System

Integrated IC system modules with
pump and detector

UI20 Dionex UI20 Universal
Interface

Instrument/PC interface

UCI-100 Dionex UCI-100 Universal
Chromatography Interface

Instrument/PC interface

STH-585 Dionex STH Column Oven Column oven

For information on the respective control commands for the DX-120, see

 Dionex DX-120 Ion Chromatograph

For information on the respective control commands for the IC20 and IC25, see

 Dionex Electrochemical Detectors
 Dionex Pumps

In order to control the instruments, the respective control options must be
available.

Should you have any questions, please contact your Dionex sales
representative.
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Basic Operation

Operation via the Keyboard

All menu items can be reached via the keyboard. Open the desired pull-down
menu by simultaneously pressing the Alt key and the underlined letter (=
hotkey). Enter another hotkey to select a menu item. You can also move to the
desired menu item via the arrow keys. Then, confirm your choice by pressing
the Enter key.

Example: To execute the Align Left function in the Edit menu,
subsequently press the keys E, A, and L while you press and
hold the Alt key. Alternatively, you can enter Alt+E and
select a menu item via the Ð and Î arrow keys.

In addition, important commands have "shortcuts." Shortcuts are displayed on
the right-hand side of menu items and functions. Entering the key combination
directly executes the corresponding function.

Example: Press the keys Control and C (Ctrl+C) to copy a selected
item.

For a list of available shortcuts, see

How to ...: Device Control  Using Keyboard Shortcuts.

Operation via the Mouse

The Dionex Chromatography Management System features all windows-typical
properties and capabilities of a two-button mouse.

The left mouse button serves to point and select menus, menu items and icon
buttons, for the operation of display and control elements as well as to modify
windows (increase / reduce the size of window, zoom, modify display and
control elements etc.). Double-click the left-hand mouse button to execute the
selected function.
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Press the left mouse button and the SHIFT key to simultaneously select
several cells in a table. Select the first cell with the left mouse button, then
press the SHIFT-key, and select a new cell. All cells between the two will be
selected.

Use the left mouse button and the CTRL key to select cells in a table that are
not adjacent. Select the first cell with the left mouse button, then press the
CTRL key, and select a new cell. Keep the CTRL key depressed and repeat
until all required cells are selected.

Click an object with the left mouse button and drag it to the desired position
(Drag and Drop). Thus, you can move selected text items or entire samples.
Perform this operation while pressing the CTRL key to copy the corresponding
object.

The right mouse button is reserved for opening context-sensitive menus.
These menus contain functions that are required or allowed in the current
situation. After a very short time, even users not accustomed to Windows will
appreciate this new and comfortable way to access menus.

For further information, refer to your Windows manual.

Undo / Redo Commands

The Dionex Chromatography Management System "remembers" the user's last
modification. The operation can be undone via the Undo command in the Edit
menu. Select Redo to repeat the last operation.

Program Start

The Dionex Chromatography Management System is operated exclusively via
a PC equipped with Windows 98 or Windows NT/Windows 2000. As of
Windows NT 4.0, both operating systems feature the same (Windows 98) user
interface. A correctly installed Dionex Chromatography Management System is
started as follows:

Start
• Click the Start button to open the Start menu. Move the mouse cursor to

the Programs option and wait until the submenus display.

• Move the mouse cursor to CHROMELEON or PeakNet. A submenu
displays with several choices.
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Client (CHROMELEON or PeakNet)
• Choose CHROMELEON or PeakNet to start the data system and the data

evaluation.

• If the Dionex Chromatography Management System was installed with
integrated access control, users must be identified via user name and
password input. If you have any questions regarding system access,
please contact your system administrator.

 Tip: If you wish to control your chromatography system via the Dionex
Chromatography Management System you must start the server
of the Dionex Chromatography Management System.

Server (Server Monitor)
• Choose Server Monitor to start the ¾Sever Monitor Program. On the

Windows task bar, the Dionex Chromatography Management System icon
will appear next to the Windows system clock.

 Tip: Normally, the Dionex Chromatography Management System will
have created a link in the Autostart group during installation. The
program is thus started as soon as the computer is started. You
will see the corresponding icon.

• Move the mouse cursor over the icon. You will see a quick info message:
Chromeleon (or PeakNet) Server is not running.

• Choose the Start Server command in the context menu (or double-click
the icon and then press Start). The icon will show various color steps
according to its status. The gray coloring indicates that the server is
running (and the message is displayed: Chromeleon (or PeakNet) Server
is running idle). From this point, you will have direct access (via control
panels) to the devices installed below a timebase. Provided the instruments
are correctly installed, they can be operated online.

 Tip: Any problems occurring when controlling single instruments may
be caused by an incorrect server configuration. Start the

 Server Configuration to check the configuration.
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The Client User Interface

The user interface of the Dionex Chromatography Management System
features all known Windows elements such as menu bar, ¾Toolbar, and
¾Status Bar.

Via the View menu, display of the individual bars listed below can be enabled
or disabled.

Standard Toolbar
for various standard
functions

Online Tools for
using the control
panel

Layout Tools for
designing the
control panel

Method Tools for
selecting a method
window

Integration Tools
for the most
important
operations in the
Chromatogram
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Move the mouse cursor over one of the buttons to view their description.

The space between the task and the status bar represents the workspace. It
serves to display various windows. Five different  Window Types are
available in the Dionex Chromatography Management System.

Window Types

In the Dionex Chromatography Management System, there are five different
window types with different appearances and functions. For descriptions, see
the topics below:

 Control Panel
 Browser
 Method Window
 Table Editor
 PGM Editor

Control Panel

A ¾Control Panel (in short: panel, also referred to as online plot or online
window) controls and monitors the chromatography instruments of a
¾Timebase. With regard to appearance and function, it is a special type of
window. In accordance to the Dionex Chromatography Management System
philosophy, you are free to design its appearance in any way to meet the user
requirements. For details, see

 Appearance
 Function
 Audit Trail
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 Appearance
¾Control Panels do not have a uniform user interface. The appearance is
determined by a combination of various default controls.

These controls can include:
• A slider to change the pump flow or another variable parameter.

• A separate field to display status information such as the running retention
time.

• A screen LED to indicate the active detector lamp.

• A command buttons to execute the inject command.

• A signal plot to monitor the detector signal.

• The current ¾3D Field and the current ¾Mass Spectrum.

• The Audit Trail to follow the execution of an operation.

The user can determine the number of available controls and their functionality,
depending on individual requirements. Each user thus "designs" a personal
interface. The available functions depend on the functionality of the analytical
instruments that are combined in a timebase. If a user integrated a controllable
column oven into the system, the temperature of the oven can be controlled.

The system administrator determines via user-specific ¾Privileges in the
¾CmUser program whether a user is authorized to create his "personal" user
interface. The organization of the panel allows locking certain functions on the
user interface or disabling the display of irrelevant information.

A new user interface can be saved as a separate file (*.pan). Each user who
has access to the directory containing the file can select and use the file via
File/Open.

If this type of screen arrangement seems confusing at first, the system offers
several default control panels that cannot be modified. These do not only cover
all standard control functions but they can also be used easily and intuitively.

For details on creating control panels, see How to ...:  Actions in the
Control Panel.
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 Function
¾Control Panels serve to control and monitor individual ¾Timebases. The
timebase to be controlled is specified when creating the control panel. As soon
as the control panel is opened, establishing a connection with the specified
timebase is automatically attempted. If this is not possible, e.g., because the
corresponding timebase was renamed or because the corresponding
Chromatography ¾Server is not in operation, the user is informed by a
message. In this case, assignment must be changed manually. Proceed as
follows:

• Open the desired control panel via File/Open.

• Choose Connect to Timebase from the Control menu and specify the
name of the timebase to be connected with the control panel or select the
name from the available list.

The new assignment is valid until the window is closed. Store the window to
have the current assignment available next time you open the window.

The currently selected timebase is displayed in the status bar.

 Tip: You can also view the report for the running sample from within
the panel via the Integrate command of the View menu.

 Signal Plot

The signal plot is an essential part of the  Control Panel. The ¾Signals of
the channels, which have been selected by the user, are displayed online, i.e.,
during data acquisition.

Different commands are available via the context menu (right mouse button)
allowing you to define how the signals shall be displayed:

Autoscale Each time when performed, the ¾Autoscale command adjusts the scaling
of the signal axis exactly to the current chromatogram or a section
thereof.

Double-clicking the signal axis also executes the Autoscale command.

Auto Autoscale The ¾Auto Autoscale option automatically adjusts the scaling of the
signal axis exactly to the current chromatogram or a section thereof
whenever the signal leaves the signal plot
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Auto Plot Speed Select the Auto Plot Speed option to prolong the time axis automatically
by the period defined on the Axis/Decoration tab as soon as the end of
the signal plot is reached.

Replot from
Beginning

Performing the ¾Replot from Beginning command has the following
effect:
When the signal leaves the right border of the signal plot, the window is
enlarged by the period defined on the Axis/Decoration tab so that always
the complete recorded chromatogram will be displayed.

 Audit Trail
The Audit Trail in a ¾Control Panel logs all commands performed during
sample processing and saves information regarding the entire system. This
includes graphical and text information. The Dionex Chromatography
Management System classifies ⇒Control Commands, status information, and
error messages as indicated below:

System Message
Warning
Error
Abort Error
Next command
(Symbol appears only during the batch and only if there is a connection
 to a datasource containing the ⇒Sequence to process!)
Executed instruction. The color indicates the filter level. The message is
displayed from this level on:

Green: Normal

Yellow: Advanced

Red: Expert
This color code is not yet valid for manual and triggered commands.
Protocol; comments program steps or describes chromatographic conditions
⇒Message on the screen that must be confirmed by the user
Fulfilled ⇒Trigger condition
Triggered command
Manually executed command
⇒Log (performed manually / by the device driver)

After starting data acquisition, the Audit Trail window shows the start time and
any subsequently performed commands (⇒AcqOn/Off, ⇒Inject, etc.).
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Even commands and status messages that are not automatically recorded
(e.g., the current system pressure) can be periodically retrieved and displayed
using the Log command.

Of course, each event included in the Audit Trail window is stored. Storage is
very precise and comprehensive. This allows determining later how a sample
was processed and which events occurred during sample processing. For
further information, see  Protocol Data (Audit Trail) in the Data chapter.

For documentation purposes, single events can be included in a report. For
details see How to ...: Actions in the Report  Audit Trail.

Browser

The ¾Browser of the Dionex Chromatography Management System is the tool
for data management. It displays the directories in which chromatographic data
is located and that can be accessed.

The browser allows opening, moving, and deleting chromatographic data as
well as searching for specific data in various databases. When a file is
selected, it can be opened and its contents can be viewed in a separate
window.

 Caution: Functions and structure are similar to the Windows Explorer.
However, do not confuse the Browser window with the Windows
Explorer! Do not use the Windows Explorer for operations within
¾Datasources of the Dionex Chromatography Management
System!
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For further details, see the topics below:

 Common Features with the Windows Explorer
 Differences from the Windows Explorer
 Function

 Common Features with the Windows Explorer
The window has two separate sections. As in the Explorer, the directory
structure of all selectable directories is displayed on the left. Detailed
information on files and ¾Sequences is shown on the right. Operation is also
identical to the Explorer:

• Click the + and - symbols next to each directory name to expand or
collapse the subdirectory structure.

• Select a directory to view its contents in the right-hand window section.
Files and single samples are displayed.

• Double-click a file or sample in the right-hand window section to open the
appropriate editor for a file or the corresponding chromatogram for a
sample.
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For convenient identification, each file type (sequence, ¾PGM File,
¾Quantification Method, ...) has a type-specific icon. The Dionex
Chromatography Management System automatically recognizes the ⇒Type
(Sample Type) (standard sample, unknown sample, Program File (PGM file) or
the stored data format (3D-field etc.) and displays the data appropriately, i.e. in
the respective chromatographic environment.

• Select a subdirectory, a sequence, or a file to drag it with the mouse to a
different directory.

 Caution: For safety reasons, the corresponding data is always copied. To
move files, copy them and then delete the original files. Directly
moving files is currently not supported.

 Differences from the Windows Explorer

Structure
Only the chromatographic data that is part of a ¾Datasource is presented (for
details see Data chapter) in the Browser.

A datasource always represents the top level of the Browser hierarchy. The
datasource can be created exclusively with the Browser and cannot be
compared to the "normal" subdirectory in the Windows Explorer. A small icon
indicates the type of data on which it is based (CHROMELEON, GynkoSoft
data, etc.). Users can only see those datasources for which they have the
appropriate access rights.

Below the datasource level, there is the familiar Explorer directory structure
(yellow file folder). The directory structure serves to manage different
¾Sequences in a datasource. A blue file folder represents a sequence. It is not
possible to create a subdirectory below the sequence level.

Operation
• Select a datasource, any subdirectory, or sequence to view its contents in

the right pane of the browser.

In the case of the datasource or subdirectory, you see the usual list of all
directories and files. If you select a sequence, the right-hand window half is
divided in two horizontal sections. These include the header with general
properties of the selected sequence and a list of all analysis and standard
samples and their sample data (Sequence Editor).
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 Caution: The sample data can be edited directly here! GynkoSoft users
recognize the Sample (SMP) File. Additional samples can be
included in the sequence, existing sample data can be modified,
or old samples can be removed. For a detailed description of the
sequence editor, refer to the Sequences section.

• Choose the Query command in the context menu to search for specific
sequences, data or samples (also simultaneously in several datasources).
This is a true ¾Query that can also search for specific properties, e.g., "all
samples starting with PAK."

Moving, deleting, or copying directories, data, and files largely corresponds to
the Microsoft Explorer (see Browser  Common Features with the
Windows Explorer). Note the following warning:

 Caution: Moving, deleting, or opening chromatographic files must be
performed exclusively in the Browser, as processes below the
surface are performed apart from the visible result!

 Function
• Use the Browser to set up ¾Datasources and create subdirectories, to

move files via Drag & Drop or to delete files.

• Select a ¾Sequence in the left window (blue folder) to view a list of its
contents on the right.

• Double-click a sample name to view the corresponding chromatogram.

• Double-click a ¾PGM File name to open the PGM editor.

• Select a file and press the right mouse button for further functions.

• Select several files (as in the Windows Explorer) and press the right mouse
button to perform a function for several files simultaneously.

• Select a file, press the right mouse button, and start a ¾Query for several
sequences and/or datasources. The result of the query, i.e. different files or
samples with at least one common feature, is displayed in the right pane of
the Browser.
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Method Window

Offline windows serve to represent chromatographic results. They show
chromatograms, 3D-fields, spectra, calibration data and result lists.

General
Method windows are opened via:

• The View menu,

• The respective toolbar icons or

• A double-click on a file

The appearance of different method windows can vary considerably. A window
can have various window sections of which the borders can be moved (a). If
the size of the window section is not large enough to show the entire
information, the hidden area can be viewed via the scroll arrows or bars (b).

The contents of the window section depends on the type of the represented
data. Table or text editors can also be integrated as a window section in a
method window. Window sections with a graphical representation show the
coordinates of the mouse cursor in the status bar.
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Types
There are currently five different method windows:

• ⇒Quantification Method (QNT editor)

• Control window (see  PGM Editor below)

• Integration

• Peak Purity Analysis (PPA)

• Printer Layout

• Spectra Library

Each window can be opened any number of times and shows the current data
from various viewpoints.

It certainly makes sense not to limit the display of chromatograms to the
method window Integration, but to enable it in the Calibration Curve or PPA
methods. The same applies to the output of numerical data in the form of a
report that can be displayed in any window.

Table Editor

The table editor is used for representation and entry of various parameters and
variables. This includes creating sequences in the sequence table,
determination of integration, calibration and peak table parameters as well as
representation of all result and report variables.

• Appearance and use of all tables correspond to the Windows standard.
Editing is by cell, column, or line.

• Selected columns can be moved, hidden, or made visible at the current
cursor position. The width of a column is adjusted by moving the left or
right delimiter or by applying the Optimum column width function.

• Adding or removing selected lines is possible anywhere in the table.

• The described functions can be accessed conveniently in the context
menu.

• The font size can be changed. Choose a smaller font to display more
information on the screen.

• Press the F1 key to view Online Help information on a specific column.
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• Press the F8 key to open an Edit dialog box for a specific field. This
prevents the input of incorrect or invalid values and names.

• Press the F9 key to fill an entire column with the value of the current field.
Logical rows of numbers can also be extended with this method. If the input
is 2, 4, and 6 in the first three fields, the row is continued with 8, 10, 12, etc.

PGM Editor

The PGM editor is used for editing a PGM file. It includes three views that can
be accessed via the corresponding icons in the left pane (the so-called shortcut
bar):
• Commands

• Finnigan AQA

• Post-acquisition steps

Commands
The Commands view is the actual program editor, a normal text editor, similar
to the Windows Wordpad text editor. It serves to create a ⇒Program. Apart
from comment lines, this file contains all commands that are executed exactly
at the time indicated in automatic routine operation.
• As in most word processors, input is line by line.

• The Cut & Paste function is available for comfortable editing.

• The Dionex Chromatography Management System interprets pure ASCII
text only. Formatted texts cannot be generated with this editor, nor can
formatting be integrated with imported texts.

Different colors are used to facilitate orientation in the program. Distinctions are
made between control commands (black text), comment lines (green text),
⇒Trigger commands (blue text), and incorrect instructions (red text).
A program can be modified directly or via the edit box. Open the edit box by
pressing the F8 key.
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 Tip: Editing the file is only possible after connecting the PGM file with
a timebase while the server is active (see: Connect to
Timebase command in the Control menu). If there is no
connection to a ¾Timebase, all program lines are displayed in
gray print.

For detailed information on creating and editing PGM files, see the chapter
Control under:

 Control Program
 Program Syntax
 Program Wizard

For a description of the different ⇒Control Commands, see How to ...: 

Actions in the PGM Editor  Creating a Program
Device Control  Extending a Program

Finnigan AQA
This view of the PGM editor is part of ¾Xcalibur and serves to specify the
method that is used by the aQa mass spectrometer.

On the Ionization Mode tab, specify the mode of ionization (Electrospray /
APCI). On the Analysis tab, specify the sensitivity and fine-tune the mass
spectrometer.

 Caution: When using the Xcalibur method editor, the Other detectors
section is irrelevant. Do not use this section for data acquisition
with other detectors (e.g. UV detector)! In this case, perform data
acquisition as usual.

The Acquisition tab allows setting the aQa-specific signal parameters for
¾Mass Spectra acquisition.

 Tip: This view of the PGM editor is part of Xcalibur. Thus, you can
open the Xcalibur help via either the Help menu or the Help
button. The Xcalibur help provides detailed information on mass
spectra acquisition.
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Post-acquisition steps
Post-acquisition steps are extraction and smoothing steps that are performed
by the PGM file after data acquisition. These steps can be performed online
after data acquisition of offline outside of the chromatogram, UV spectrum, and
mass spectrum.

Working with Several Windows

The Dionex Chromatography Management System not only supports working
efficiently with several open windows as is typical in Windows programs, but
also introduces what has become possible with object-oriented programming of
applications and was not common before:

The display of data is always updated in all windows!

Below please find two examples of samples with chromatograms; Specific
detection parameters were used for integration and analysis.

Example 1: If the ⇒Minimum Area detection parameter is corrected in
the QNT method window by entering a smaller value, the
corresponding chromatogram is immediately adjusted, i.e.
peaks with an area smaller than the minimum are not
considered.

Example 2: Similarly, the result of a manually modified baseline can be
seen immediately in the window of the integration report.

User Profiles (Workspaces)

The Dionex Chromatography Management System offers the possibility to save
the window arrangement of any work situation, i.e. the combination of different
windows, in a workspace.

This facilitates opening single files or windows and allows the user to work with
his/her own work environment on the screen.

The information, which windows should be used, is stored in a WSP file. Users
who want to start working with a specific workspace, open the corresponding
WSP file or generate it by storing the screen contents.

• Choose the Open Workspace command from the Workspace menu to
open an existing workspace.
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• Choose the Save Workspace command to save the current workspace.

• Select the Save Workspace as command to save the current workspace
with a new name.

• Select the Autosave Workspace command to always save the most
recent workspace as the default workspace.

The number of  Windows saved with each workspace is not restricted.

A possible and useful workspace arrangement combines, for example, the
PGM editor, a control panel, and the Browser (see illustration).

The appearance of each individual window is stored in the  Report
Definition.
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 Tip: When the Dionex Chromatography Management System is
started, the most recently used workspace is loaded.

Increasing the number of displayed windows and data in a
workspace also increases the loading time!

Report Definition

The ¾Report Definition File (RDF) comprises the current settings such as the
names and scaling of axes, the representation of chromatograms and spectra,
display of additional information or auxiliary lines, setting various font types and
sizes as well as arranging columns in a table. The report definition also
determines how the current screen contents (Hardcopy) or online batch results
are printed (see  Printing).

In contrast to the workspace, a report definition can be used for individual
windows. The report definition is required whenever a window is not opened via
the workspace. The most recent report definition will be opened. If a user has
not saved a RDF, the default report definition supplied with the Dionex
Chromatography Management System (DEFAULT.RDF) is used. It is located in
the REPORT directory.
• Choose Save Report Definition from the context or View menu to save

the current settings.
• Choose Load Report Definition from the context or View menu to open a

previously saved report definition.

Create/Open Files, Windows, and Templates

There are several ways to open or create files, windows, and templates.
Frequently, other information is required for this.

For example, when being opened, each control panel searches "its" timebase,
i.e. the correct link between the client PC and a certain chromatography system
(¾Timebase) and each method window searches data from a specific
¾Datasource.

 Tip: If problems arise in this context, they may be caused by the fact
that the user later renames timebases or datasources that are
correctly installed by the Dionex Service.
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Similar problems may occur if databases are located on a
network PC to which no link can be currently established or for
which the user has no share authorization.

In this case, see How to ...: Actions in the Browser
 Connecting a Database.

Automatically Loading the Most Recent User Profile
The Dionex Chromatography Management System automatically loads the
most recently used workspace. If this is not possible, the Browser is started.

Opening Existing File Types and Windows
Choose the Open command of the File menu; select the datasource and the
directory containing the file to open and the file type to represent. Refer to
Online Help for further help on the opened dialog box.

Alternatively, a file can be opened by selecting it in the ¾Browser (File menu)
and double-clicking it.

Open Most Recent Files and Templates
The lower section of the File and Workspace menu lists the most recently used
templates and files. Click a template or file to open it. This is the most simple
and quickest way to continue an interrupted task.

New
Select the New command of the File menu to receive a list of all possible file
types and chromatographic operations.
• Select Control Panel to open a window for the control of chromatography

devices of a specific timebase.

• Select Sequence File (using Wizard) to start the  Sequence Wizard
for creating a ¾Sequence. The samples to be analyzed are entered in the
sequence.

• Select Sequence (from LIMS Worklist) to include data and a ¾Sequence
of a ¾LIMS in the ¾Worklist format.
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• A ¾PGM File includes all ⇒Control Commands that must be transferred to
the different chromatography devices to process a sample or a series of
samples. Select Program File to start the  Program Wizard for creating
a  Control Program.

• Select Method File to create a new quantification method.

• Select Spectra Library to create a new spectra library.

Printing

The ¾Printer Layout of the Dionex Chromatography Management System
offers numerous options for presenting results. Similar to a word processor, the
user can choose between printing screen contents and printing based on
defined templates.

Printing the Screen Contents
The contents of the currently active window can be printed via the respective
Print ... command. Via Print Sequence, you can print in the Browser the
current sample list either with the corresponding PGM or QNT files. If a ¾PGM
File is open, you can print the required views via Print... In the same way, you
can print the selected pages of a ¾Quantification Method (QNT Method) via
Print QNT Method in the QNT editor.

Printing Based on Report Templates
If one or several samples or sequences are selected in the Browser, Batch
Report starts the printed output. The user specifies the report template
(¾Report Definition File (RDF)) to be used and which pages of the printer
layout shall be printed for which sample type and for which channel from the
selected report template. Creating a report template is performed with the

 Printer Layout method.

 Note: Use the Setup button in the Printer Layout to define the page
format (see How to ...: Actions in the Printer Layout

 Changing the Page Format)
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Printing in an Online Batch
If several samples are processed in an automatic sample batch (¾Batch
Processing) it is possible to define whether and, if yes, for which channel and
how to output results after completing the process.

Printing can be started either after processing a single sample or after
processing a complete sequence.

 Note: The report template used for printing is stored with other settings
(e.g., screen settings) in the Report Definition File (RDF). Future
versions of the Dionex Chromatography Management System
versions will save the screen and the print settings separately.
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Control

Control Concept

The chromatographic equipment of an analytical laboratory usually comprises
instruments from different manufacturers and of various generations.
Depending on whether this heterogeneous instrument pool can be controlled
via a PC or not, it is called a controlled or a non-controlled system.

Non-controlled system
In non-controlled systems, individual instruments are operated manually. The
data system only records the data. For this, two conditions must be fulfilled:

• The injection time is communicated to the data system by connecting the
Inject contact of the injection valve with a ¾Remote Input of the system.
This guarantees time synchronization between sample start and recording
time.

• Detector data is transferred to the data system in digital or analog form
(serial interface or ¾A/D Converter).

Controlled System
Controlling a system makes high demands on adaptability of a modern
chromatography data system, as operation of individual components must be
easy and thus device-independent. That is, input and representation of a
specific control command (for example the pump flow) is always performed in
the same way, regardless of whether the instrument is by manufacturer X or Y.
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The Dionex Chromatography Management System enables this by the
 Chromatography BIOS and the available  Device Drivers. The

advantages of the uniform user interface are obvious:

• Short training time for inexperienced users.

• Uniform, device-independent operation: the same commands are used for
all systems.

• Chromatographic methods can usually be transferred from one system to
another. This requires the availability of corresponding device functions on
both systems.

• Clear, uniform documentation.

In principle, there are two ways to control a chromatography system. For
details, see the topics below:

 Control (Direct)
 Control (Programmed)

Control (Direct)

Direct control means the immediate and interactive operation of individual
instruments and device functions via a  Control Panel. Observe the
following requirements:

• The data system must be extended by one of the  Options of the
Dionex Chromatography Management System.

• Correct installation and configuration of the controlled instruments and
device drivers via the  Server Configuration.

• Establishment of an intact connection between the PC and the
chromatography server.

• Establishment of an intact connection between the chromatography server
and the Chromatography system via a  Serial Interface,  DX-LAN, or
other interface (GPIB, USB).
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For an overview of executable system and instrument commands, see the
topics below:

 System Commands
 Dionex Pumps
 Controlling Pumps without Separate Device Driver
 Dionex Autosamplers
 Dionex Detectors
 Dionex DX-120 Ion Chromatograph
 Dionex Column Oven STH585

Optimum support for all functions is ensured for Dionex instruments.
Information on support for third-party instruments is included in the Installation
Instructions.

For a list of the third-party instruments that are currently supported, see
 Installing and Controlling Third-Party Instruments.

 System Commands
System control comprises all commands that concern the entire
chromatographic process or the entire system. The commands are available
both, via Command in the Control menu and via the F8 key in Commands
view of the PGM editor. In addition, some of them are available on the toolbar
as well.

Abort Sample Stop data acquisition and sample; continue the ¾Batch with the next
sample

⇒Abort Batch: Stop data acquisition and batch processing
⇒StopFlow: Stop pump flow, interrupt data acquisition, stop batch processing
⇒Hold: Freeze running gradient program, interrupt data acquisition, hold batch

processing
⇒Continue Continue all functions in hold mode
⇒Acquisition On/Off Start / terminate data acquisition

Via the Sound command, you can select the frequency and the length of a
sound to be heard at a specified time.
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 Dionex Pumps
For controlling HPLC and IC pumps, the following commands are available to
the user:

⇒Flow Change flow rate
⇒Pressure Limits Set pressure limits

In addition, the following commands are available for controlling gradient
pumps (M480, P580, GP40/GP50, and GS50):

⇒%A, %B, %C, %D Change solvent composition, determine gradient course

The commands can be given either directly (toolbar and menu bar or control) or
as part of a ¾Program (programmable button).

They enable delivery of a specific liquid volume of defined composition as well
as starting and holding the pump. The pump is automatically held as soon as
the upper or lower pressure limits are exceeded. Changing the flow rate
creates a ¾Flow Gradient, changing the solvent composition creates a ¾%
Gradient. Flow and % gradients can be realized simultaneously (!).

 Tip: Dionex GP40/GP50, IP20/IP25, IC20/IC25, GS50, and IS25
pumps do not deliver flow gradient ramps. Instead, changing the
flow rate creates a step change; that is, flow rate changes are
made immediately, not gradually over time. Also, see How
to ...: Device Control  Pump Commands for additional
information.

Dionex Pumps M480 and P580

The Dionex Pumps M480 and P580 support the automatic precompression
control, i.e., the pumps are capable of adjusting to the compressibility of
commonly used solvents. Optionally, the commands Learn and Freeze can be
used for extending the P580 precompression control to unknown solvent types.
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Important specifications (subject to technical alterations) of the Dionex Pump
P580 are:

P580
Operating principle: Available models include the isocratic model P580A, the quaternary

low pressure gradient system P580A LPG, and the binary high
pressure gradient system P580 HPG.

Flow range: 1 - 10000 µl/min in 1 µl increments
Pressure range: 1 - 500 bar
Flow accuracy: 0.1% or 0.5 µl
Gradient accuracy: 1% absolute from set value between 250 and 2000µl (P580A LPG)

0.2% absolute from set value or 0.5 µl per branch (P580A HPG)
Pressure pulsation: 0.5 bar or 0.5%

For the user, it is irrelevant whether the system is a ¾Low-Pressure Gradient
System or a ¾High-Pressure Gradient System. Command input is identical.

 Caution: Chromatography pumps are high-precision instruments! Dry
operation or crystallization of buffer solutions within the fluidic
system must be avoided. These problems occur especially when
the pump flow is stopped while the detector lamp is still switched
on. The flow cell heats up, and the solvent evaporates.
Depositions of substances can result, e.g., salt in a buffer
solution.

Dionex Pumps GP40/GP50, IP20/IP25, IC20/IC25, GS50, and IS25
In addition to the general pump commands, the following commands are
available for controlling the isocratic or gradient pumps listed above:

On Turn on the pump motor
Off Turn off the pump motor
Prime Prime the pump

For pump operating specifications, refer to the individual pump operator's
manuals.

Also, see  Controlling Pumps without Separate Device Driver
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 Controlling Pumps without Separate Device Driver

In addition to the device drivers for  Dionex Pumps, the Dionex
Chromatography Management System offers many drivers for controlling third-
party pumps. (For an overview on the different manufacturers whose devices
can be controlled via the Dionex Chromatography Management System, see

 Installing and Controlling Third-Party Instruments in the Installation
section.

Besides, pumps can be controlled for which separate device drivers or serial
interfaces are not available (e.g., the former Gynkotek pump M300). Depending
on the type of pump to be controlled, the following plug-in boards are available:

1. "Dionex Pump DA Converter (12 Bit)" (for voltage-controlled pumps) or

2. "Dionex Pump Control Board" (  Pump Control Board) (for frequency-
controlled pumps).

For installation information, see the following topics in the Installation section:

  Installing the Dionex 12-Bit DAC Board

  Installing the Pump Control Board

In addition, the respective device driver DAC Pumps (for voltage-controlled
pumps) and Pump Control Board Pump(s) (for frequency-controlled pumps)
must be installed (see How to ...: Actions in the Server Configuration

 Changing the Server Configuration).

The following control commands are available for voltage-controlled pumps
(DAC pumps):

⇒Flow: Changes the flow rate
⇒%A, %B, %C, %D: Changes the solvent composition, determines the course of the

gradient

With frequency-controlled pumps (Pump Control Board Pump(s)), a reset can
be performed in addition.
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 Dionex Autosamplers
Automatic sample injection using a modern ¾Autosampler offers several
advantages:

• Comfortable processing of large sample batches

• Reproducible and verifiable dosing precision

• Loss-free and bubble-free injection of the sample

In spite of the vast scope of performance, only the "simple" commands Inject,
Position, and Volume are required for automatic control of the Dionex
Autosamplers:

Simple Commands
⇒Inject Inject sample
⇒Position: Vial Position
⇒Volume: Volume to inject

For information on the individual autosamplers and their respective
specifications, see the following topics:

 Dionex Autosamplers GINA 50 and GINA 160
 Dionex Autosampler ASI-100 / ASI-100T
 Dionex Autosampler AS50

 Dionex Autosamplers GINA 50 and GINA 160

Beyond the simple commands (see  Dionex Autosamplers), the Dionex
Autosamplers GINA 50 and GINA 160 offer additional commands enabling
further functions. These include multiple suck operations (Suck) from one
sample, washing the sample loop (Wash), moving the sample needle
(NeedleUp for GINA 50, Needle for GINA 160), or cooling the sample vials.
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The following commands are available:

Special Commands
⇒NeedleUp Move needle
Load Switching the internal sample valve without moving the needle

(also, see NeedleUp)
⇒Wash: Wash
Segment: Draw an air volume (command available for GINA 160 only)
⇒Suck: General: Suck liquid quantity (special for GINA 50: position = 100

means suck air segment from an imaginary "air vial")
⇒Dispense: General: Dispense sucked liquid quantity (special for GINA 50: Position

= 101 means dispense sucked volume in needle seat)
TempCtrl This command activates the temperature control of the Dionex

Autosampler GINA 50T. This sampler is capable of controlling the rack
temperature and, thus, the sample temperature within a 15°C range. At
room temperature (20°C), maximum sample cooling is to 5°C above
zero.

The GINA 50 Autosampler offers the following specifications (subject to
technical alterations):

GINA 50
Operating principle: Sample loop valve with inline principle (also see

¾Autosampler)
Sample capacity: 50 plus 1 standard or 80 minivials
Dosing volume: 1 - 250 µl with standard syringe
Reproducibility: <0.3% at 10 µl with standard syringe
Sample loss: None
Flush volume: None

For information on how to use the commands in practical operation, see How
to ...: Device Control  Autosampler Commands (GINA 50).
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 Dionex Autosamplers ASI-100 / ASI-100T
For a basic description of the Dionex Autosamplers including the simple
commands, see  Dionex Autosamplers. Beyond this, the Dionex
Autosampler ASI-100/ASI-100T (ASI-100T = with temperature control) provides
many commands for controlling all functions an autosampler can possibly
control, among others drawing a sample repeatedly (= Draw), mixing different
samples (= Mix), or washing the needle (= Wash). You can specify these
commands in more detail via the vial whose contents shall be mixed (= Mix
Subject) or the volume to be used for the Draw, Dispense, and Mix
(= MixVolume) commands.

Special commands:

Command/
Property

Description

BlueSegment Select the segment type that is used in the blue segment. Available
types are: Analytical - Semiprep - Mini - Eppendorf.

Busy Indicates whether the sampler is busy (working) or idle (comp.
Ready).

⇒Connect Connects the device to the data system, enables computer control
(comp. Connected, Disconnect).

Connected Indicates whether the device is connected to the data system, i.e.
under computer control (comp. Connect, Disconnect).

CoolingPower
(ASI-100T only)

Indicates the cooling power (for diagnosis purposes only).

Disconnect Disconnects the device from the data system, enables manual
control from the device's front panel (comp. Connected, Connect).

⇒Dispense Dispenses the previously drawn volume.
DispSpeed Specify the speed with which the contents of the syringe shall be

dispensed.
DownSpeed Specify the speed with which the needle moves down.
⇒Draw Draws the specified volume.
DrawSpeed Specify the speed for filling the syringe.
ExternalMSV State of the external valve.
FirmwareDownload Triggers download of device firmware appropriate for this driver.
FirmwareVersion Indicates the sampler's firmware version.
GreenSegment Select the segment type that is used in the green segment. Available

types are: Analytical - Semiprep - Mini - Eppendorf.
HeatSinkTemperature
(ASI-100T only)

Indicates the heat sink temperature (read only).
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Command/
Property

Description

⇒Inject Injects a sample.
InjectCounter Number of injections.
InjectMode Inject Mode. if set to Normal, the sampler draws the specified

volume from the specified position and injects. If set to Mix, the
sampler injects whatever volume is left in the syringe after preceding
draw/dispense operations.

InjectWaitTime Period between the issuing of the command by the data system and
the acknowledgement of the sampler.

Input1, 2, 3 or 4 State of the digital inputs 1, 2, 3, or 4.
Internal MSV State of the internal motorized switching valve.
Mix From the position that is determined via the parameter MixSubject,

the syringe draws and dispenses the volume that is determined via
the parameter MixVolume. If MixVial is selected as Mix Subject,
the parameter MixVial must be specified as well. The parameter
MixRepeat indicates the number of replicates during mixing.

MixHeight Needle height for draw, dispense and mix operations, specify how
deep the needle will dip into the vial for mixing.

MixRepeat Repeat count for draw, dispense, and mix operations for mixing.
MixSpeed Syringe speed for draw and dispense operations for mixing.
MixSubject Specify the subject to be used for draw, dispense, and mix

operations. The following subjects are available: MixVial,
SampleVial, WashVial, Air, ReagentAVial, ReagentBVial,
ReagentCVial, ReagentDVial. If Air is specified as mix subject, air is
drawn in. During Dispense, the needle moves into the needle port
and is dispensed there.

MixVial Specify the vial position if MixVial is selected as MixSubject (comp.
MixSubject).

MixVolume Volume to be used for the Draw, Dispense, and Mix.
Msv2ToInject Switches the external valve to Inject.
Msv2ToLoad Switches the external valve to Load.
MsvToInject Switches the injection valve to Inject.
MsvToLoad Switches the injection valve to Load.
NeedleSealCounter Needle seal wear.
⇒Position The sample's position on the tablet.
RadialSpeed The speed of the radial needle movement.
Ready Sampler ready flag, true when sampler is idle (comp. Busy).
ReagentACapacity Specify how often the volume can be drawn from the vial with

reagent A (reagent B, C, and D, respectively).
ReagentAVial Position of the reagent A (reagent B, C, and D, respectively) vial - is

used only if ReagentAVial is selected as MixSubject (comp.
MixSubject).
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Command/
Property

Description

RedSegment Select the segment type that is used in the red segment. Available
types are: Analytical - Semiprep - Mini - Eppendorf.

Relay1, 2, 3 or 4 The following commands are available: State (indicates or sets the
state of the relay), Duration (when set, the relay's state toggles after
the specified time), On (turns the relay on), and Off (turns the relay
off).

Relay3Enabled Relay3 mode. If set to Yes, the relay can be controlled by the data
system. If set to No, the sampler controls the relay and the relay
indicates, whether the sampler is operable.

Relay4Enabled Relay 4 mode. If set to Yes, the relay can be controlled by the data
system. If set to No, the relay is controlled by the sampler and
indicates injection.

Reset Resets the sampler to its initial conditions, as attained after power-
up.

SampleHeight Indicates the height at which the sample is drawn, measured from
the vial bottom to the needle tip.

SerialNumber Indicates the sampler's serial number.
State Indicates that the sampler has injected.
Syringe Indicates the volume of the syringe that is installed in the sampler.
SyringeCounter Indicates the number of syringe movements.
SyringeDelay Specify the time the needle shall remain in the vial after loading.
⇒Temperature
(ASI-100T only)

Defines the set temperature of the sampler's tray and hence of the
sample. Opening the command tree shows the following commands:
Value (= actual temperature, read-only), Nominal (= set
temperature), UpperLimit,and Lower Limit. With UpperLimit and
LowerLimit, the system aborts the batch and starts emergency
handling if the nominal temperature is outside these limits.

TemperatureControl
(ASI-100T only)

The following settings are available: On (= cooling/heating enabled),
Off (= cooling/heating disabled) and Fixed (= diagnosis setting only
which should not be used by the end user) (comp. Nominal, Value,
HeatSinkTemperature, CoolingPower).

Test Moves the needle to the specified vial. If no vial is specified,
MixSubject is used (comp. MixSubject).

TrayDetection Turns tray detection (including manual interference monitoring) on or
off. With enabled tray detection, a home run is executed when the
tray is mounted.
If, with disabled tray detection, the tray was removed, a self-test
must be performed when the tray is mounted again. This is to ensure
that the sample is injected from the correct position.

UpSpeed The speed used to move the needle up.
⇒Volume Injection volume.
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Command/
Property

Description

⇒Wash The internal MSV is switched to Load, if necessary. The volume
specified under WashVolume is drawn from the position specified
under WashVial and dispensed into the needle port/waste. The
parameters WashSpeed and WashHeight are also considered.

WashHeight Wash height  = distance between the bottom of the wash vial and the
needle tip (= the depth with which the needle will dip into the vial).

WashSpeed The speed with which the syringe draws the wash volume.
WashVial Position of the wash vial.
WashVialVolume Total volume of the wash vial.
WashVolume Specify the volume to be drawn from the wash vial.

The ASI-100/ASI-100T samplers offer the following specifications (subject to
technical alterations):

ASI-100/ASI-100T
Principle: Sample loop valve with in-line split-loop principle (please also refer to

¾Autosampler)
Sample capacity: Depending on the used segment type

Semiprep: 63 vials at 4 ml (to be filled with 2 ml only!),
Analytical: 117 vials at 1.8 ml (to be filled with 1.2 ml!)
Mini: 192 vials at 1.2 ml, (to be filled with 0.6 ml only!)
Eppendorf: 66 vials at 2 ml (to be filled with 1 ml!) or at 1.5 ml (to be
filled with 0.5 ml only!)

Injection volume: 0.1 - 250 µl with standard syringe and the corresponding sample loop
Reproducibility: < 0.3% at 5 µl with standard syringe, typically < 1% at 1 µl
Sample loss: None
Flush volume: None
Temperature Control In the range of 4 - 45°C (39.2 - 113°F)

cooling: 18°C (64.4F) from ambient
heating: 35°C (95°F) from ambient

 Note: All inputs of the ASI-100/ASI-100T are also available as CM-
Input ports, i.e., other device drivers can use them as well (e.g.,
Remote Inject).

For information on how to use the commands in practical operation, see How
to ...: Device Control  Autosampler Commands (ASI-100/ASI-100T).
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 Dionex Autosamplers AS50
For a basic description of the Dionex Autosamplers including the simple
commands, see  Dionex Autosamplers). Beyond this, the Dionex AS50
Autosampler provides many additional commands for controlling autosampler
functions, such as flushing the liquid lines (Flush), moving the needle arm to
the home position (Home), and preparing the sample before injection (Pipet,
Mix, Dilute, etc.). The following commands are available:

Special Commands

¾Cycle Set time between injections
Flush Flush inject port
Home Move needle arm to home position
Prime Prime liquid lines
Stop Stop current process
¾Syringe Speed Set syringe speed

Special Commands for Sample Preparation

¾Pipet Move sample between vials
¾Mix Mix vial contents
¾Delay Pause sample preparation
¾Flush (SP) Flush inject port during sample preparation
¾Needle Height Position needle above vial bottom

The following commands are only available if the AS50 is equipped with the
sample prep option:

¾Dilute Dilute sample with reagent
¾Dispense Dispense reagent to a vial

The following command is only available if the AS50 is equipped with a thermal
compartment:

¾Column Temperature Sets the temperature of the thermal compartment
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The following command is only available if the AS50 is equipped with the
sample temperature control option:

¾Tray Temperature Sets the temperature of the sample tray.

For information on how to use the commands in practical operation, see How
to ...: Device Control  Autosampler Commands (AS50).

 Dionex Detectors
The following "simple" commands and functions for representing the recorded
data are available for all detectors, even if they supply analog signals via the
A/D converter.

Simple Commands

⇒AcqOn/Off Start/stop data acquisition
⇒Autozero Automatic autozero
¾AutoAutoscale Axis/scaling adjustment
⇒Step Step width adjustment
⇒Average Average between datapoints

For information on the special commands available for the individual detectors
and their respective specifications, see the following topics:

 Dionex UV/PDA Detectors UVD 160S/320S and UVD 170S/340S
 Dionex Photodiode Array Detector PDA-100
 Dionex Absorbance Detectors AD20/AD25
 Dionex Fluorescence Detectors RF1002/RF2000
 Dionex Electrochemical Detectors CD20/CD25/CD25A,
ED40/ED50/ED50A, and IC20/IC25/IC25A
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 Dionex UV/PDA Detectors UVD 160S/320S and
UVD 170S/340S

In addition to the "simple" commands available for all detectors (see  Dionex
Detectors), "special" control commands are also supported if the detector is
connected to a server PC via an appropriate interface.

Special Commands

⇒Lamp on/off UV lamp on/off
⇒Wavelength Wavelength setting
⇒Bandwidth Bandwidth setting
⇒Reference
Wavelength

Reference wavelength setting

⇒Reference Bandwidth Reference bandwidth setting
⇒Bunch Width Photodiode signal averaging
CheckWavelength This performs a wavelength check on the UVD170S and the 340S

via the ¾Holmium-Oxide Filter.
LampIntensity States the lamp intensity at 254 nm in counts/seconds. The value

can be used as a comparison value to determine how much the
lamp intensity decreased. This requires that the value be first
measured when the lamp is new.

The Dionex Photodiode Array Detectors UVD 170S and UVD 340S are
controllable in remote operation, i.e., all commands listed above can be
executed via the data system. The detectors offer the following specifications
(subject to technical alterations):

UVD 170S UVD 340S
Operating principle: ¾UV Detector ¾Photodiode Array Detectors
Wavelength range ([nm]) 200 -595 200 -595
Wavelength accuracy ([nm]) ± 0.75 (UV), ± 1.5 (visible) ± 0.75 (UV), ± 1.5 (visible)
Light source Deuterium lamp Deuterium lamp
Spectral resolution ([nm]) 1.9 (variable up to 400nm)
Pixel resolution ([nm]) 1.9 nm (UV), 3.3 (visible) 1.9 (UV), 3.3 (visible)
Noise (AU peak/peak)
(254nm/16nm/1 sec))

<± 0.4 x 10-5 <± 0.4 x 10-5

Drift (AU/h (254nm/1.9nm/1 sec)) <5 x 10-4 <5 x 10-4
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 Note: For the UVD 340/170, a voltage offset (in millivolt) can be defined
via a registry key on the 16-Bit DAC board for the analog output
of the detector signal. The offset values for all 16-Bit DAC
channels of the CM server are identical.

Enter the respective offset in millivolt into the registry key:

Example for 100 millivolt (hexadecimal entry):
[HKEY_LOCAL_MACHINE\Software\Dionex\Chromeleon\drivers\UVD340]
"DAC Offset"=dword:00000064

 Dionex Photodiode Array Detector PDA-100
In addition to the "simple" commands available for all detectors (see  Dionex
Detectors), the PDA-100 detector provides the following "special" control
commands.

Special Commands

⇒Wavelength Wavelength setting
⇒Bandwidth Bandwidth setting
⇒Reference
Wavelength

Reference wavelength setting

⇒Reference Bandwidth Reference bandwidth setting
⇒Bunch Width Photodiode signal averaging
¾Recorder Range Set the range of a full-scale recorder response
¾Offset Level Offset the analog output signal
¾Rise Time Set how quickly the detector responds to a change in signal
¾Data Collection Rate Set the rate at which the data system collects digital data points

from the detector
¾UV Lamp Switch the UV lamp off and on
¾Visible Lamp Switch the visible lamp off and on
UV Lamp Age Report (or reset) the number of hours the UV lamp has been on
Visible Lamp Age Report (or reset) the number of hours the visible lamp has been

on
Leak Detector
Calibration

Perform the leak detector calibration

Leak Detector Test Perform a test of the leak detector
Wavelength Calibration Perform a wavelength calibration.
Wavelength Verification Perform a wavelength verification via the ¾Holmium-Oxide Filter
Serial Number Report the detector serial number
¾TTL Input Mode Set the TTL input signal mode
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The commands can be given either directly (¾Toolbar, menu bar, or ¾Control),
as part of a ¾Program, or via a programmable button).

The following are important specifications (subject to technical alteration) of the
Dionex PDA-100 detector:

PDA-100
Operating principle: ¾Photodiode Array Detectors
Wavelength range ([nm]) 190 - 800
Wavelength accuracy ([nm]) ±1
Light sources Deuterium lamp (30 W) for UV spectra

Tungsten lamp (15 W) for visible spectra
Pixel resolution ([nm]) 0.7
Noise ±10 µAU; 2 sec rise time, 254 nm, 4 nm bandwidth

±10 µAU; 2 sec rise time, 520 nm, 10 nm bandwidth
Drift (µAU/h) <500 (after warm-up)
Linearity (AU) >2

 Dionex Absorbance Detectors AD20/AD25

In addition to the "simple" commands available for all detectors (see  Dionex
Detectors), Dionex absorbance detectors provide the following "special"
control and analog output commands.

Special Commands

¾Data Collection Rate Set the rate at which the data system collects digital data points
from the detector

⇒Wavelength Wavelength setting
¾UV Lamp Switch the UV lamp to Off, Low, or High (AD20 detector), or Off or

On (AD25 detector)
¾Visible Lamp Switch the visible lamp to Off, Low, or High (AD20 detector), or Off

or On (AD25 detector)

Analog Output Commands

¾Full Scale Set the full-scale analog out voltage
¾Offset Level Offset the analog output signal
¾Polarity Switch the analog output polarity (+/-)
¾Recorder Range Set the range of a full-scale recorder response
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¾Rise Time Set how quickly the detector responds to a change in signal

 Dionex Fluorescence Detectors RF1002/RF2000
In addition to the commands available for various detector types, such as Step,
Average, Autozero (see  Dionex Detectors), controllable fluorescence
detectors allow modifying the Emission and Excitation wavelengths.

¾Emission Modifying the measuring wavelength
¾Excitation Modifying the excitation wavelength

These parameters are supported by the Dionex Fluorescence Detector RF1002
and the successor model RF2000. The model RF2000 also enables the Scan
mode. For details, see Scanning in the Online Help.

 Caution: For connecting the Dionex RF1002 and RF2000 Detectors, the
following must be strictly noted:

Pin Assignment
Different pin assignments are required for the RF1002 and for the RF2000! The
connecting cables (Dionex part no. 8914.0106 for the RF1002 connecting cable
and Dionex part no. 8914.0115 for the RF2000 connecting cable) must be
configured as follows:

PC RF1002
9-Pin Sub-D-Connector (female) (9-Pin Sub-D-Connector (male)

2 --------------------- 2
3 --------------------- 3
5 --------------------- 5

4 on 6
7 on 8

PC RF2000
9-Pin Sub-D-Connector (female) 9-Pin Sub-D-Connector (male)

2 --------------------- 2
3 --------------------- 3
5 --------------------- 7

4 on 6
7 on 8
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Settings on the Instrument RF2000 (also see RF2000 Manual)
The communications parameters (9600 baud, 7 data bits, no parity, 1 stop bit;
handshake: OFF) are set as follows:

• Press the func key (or the keys shift + func) until RS232C is shown in the
display. Confirm by pressing ENTER.

• Press the func key until BAUD appears in the display. Press 6 for 9600
BAUD. Press ENTER.

• Press the func key until DATA BITS appears in the display. Press 7 for 7
Data Bits. Press ENTER.

• Press the func key until PARITY appears in the display. Press 0 for No
Parity. Press ENTER.

• Press the func key until STOP BIT appears in the display. Press 1 for 1
Stop Bit. Press ENTER.

Proceed as follows to connect the RF2000 with your PC:
• Press the keys shift + func, until RS232C appears again in the display.

Press ENTER.
• CONNECT will be displayed. Confirm by pressing ENTER.

Specifying a handshake is not required. The detector is now working in remote
operation. The keyboard of the instrument is now locked.

 Note: To release the keyboard lock, press <SHIFT> and <CE> for a
minimum of 3 seconds.

 Dionex Electrochemical Detectors CD20/CD25/CD25A,
ED40/ED50/ED50A, and IC20/IC25/IC25A

In addition to the "simple" commands available for all detectors (see  Dionex
Detectors), Dionex electrochemical detectors provide special commands. Data
Collection Rate and the analog output commands are available for all Dionex
electrochemical detectors in any operating mode. Other special commands
depend on the selected operating mode.

¾Data Collection Rate Set the rate at which the data system collects digital data points
from the detector
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Analog Output Commands (All Modes)

¾Full Scale Set the full-scale analog out voltage
¾Offset Level Offset the analog output signal
¾Polarity Switch the analog output polarity (+/-)
¾Recorder Range Set the range of a full-scale recorder response
¾Rise Time Set how quickly the detector responds to a change in signal

Special Commands (Conductivity Mode)
The following commands are available for conductivity detectors
(CD20/CD25/CD25A, ED40/ED50/ED50A, or IC20/IC25/IC25A):

DS3 Temperature Set the ¾DS3 temperature
Current Set the current supplied to the SRS or AES
¾Temperature
Compensation

Set the temperature compensation factor, which is used to stabilize
conductivity readings

In addition, the following commands are available for CD25A, ED50A, and
IC25A detectors:
Suppressor Type Select the installed ¾Suppressor
Eluent Concentration Specify the concentration of the eluent(s); this command is enabled

only if an AES suppressor is installed

Special Commands (DC Amperometry Mode)
The following commands are available for the ED40/ED50/ED50A detectors in
DC amperometry mode:

Cell Turn the cell on and off
¾DC Voltage Set the voltage applied to the cell
Electrode Select the type of electrode installed

Special Commands (Integrated Amperometry Mode)
The following commands are available for the ED40/ED50/ED50A detectors in
integrated amperometry mode:

Cell Turn the cell on and off
Electrode Select the type of electrode installed
¾Waveform Program a waveform (a plot of potential vs. time)
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 Dionex DX-120 Ion Chromatograph
The following commands are available for direct control of DX-120 operating
functions:

Controlled AC Switches the AC power outlet on the DX-120 rear panel on and off.
This provides on off control of an external accessory connected to
the outlet. See the DX-120 operator’s manual for cabling
instructions.

Column If the DX-120 is in ¾Column Mode, the Column command sets the
flow path to column A or column B.

Eluent If the DX-120 is in ¾Eluent Mode, the Eluent command selects the
eluent reservoir (A or B).

¾Data Collection Rate Set the rate at which the data system collects digital data points
from the detector.

Eluent Pressure Turns the pressure to the eluent reservoir(s) on and off.
Pressure Unit Selects the units of pressure to use (psi or MPa).
Pump Turns the pump on and off.
SRS Turns the current supplied to the ¾Self-Regenerating Suppressor

(SRS) on and off.

 Dionex Column Oven STH585
The following commands are available for controlling the operating functions of
the STH585 Column Oven:

Connect Connects the unit to the column thermostat
(also see ⇒Connect/Disconnect)).

Connected Indicates whether the unit is connected to the data system, i.e.
under control
(also see Connect, Disconnect).

Disconnect Disconnects the unit from the column oven
(also see Connect, Connected).

LowerLimit Upper temperature limit (range: 5 - 85°C)
UpperLimit Lower temperature limit (range: 5 - 85°C)
Temperature Nominal temperature,

the temperature must be set within the current limits, otherwise the
command will not be executed.
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The column oven's technical specification is as follows (subject to technical
alterations):

STH585
Temperature range 5 - 85°C
Temperature accuracy ± 0,5°C
Temperature stability ± 0,15°C (measured in a 25 cm test column)
Temperature change 2 - 3°C/min.
Nominal voltage 100 - 230 V AC
Rated Frequency 47 - 63 Hz
Power Consumption max. 100 W

 General Commands
Independent from the installed instruments, the following general commands
are available.

⇒Branch Terminates currently active ¾Program and starts another one
⇒Log Logs device variable values in the Audit Trail (  Protocol

Data)
⇒Message Displays a message to the user and interrupts the program

until the message is clicked.
⇒Protocol Logs any message in the ¾Audit Trail
⇒Wait: Interrupts the program until a certain condition is fulfilled.
⇒Delay Especially with trigger commands, execution of the next

program command is delayed for the specified time.
⇒Trigger Freezes a running gradient program, stops data acquisition,

stops sample processing.
⇒EndTrigger Continues all processes in hold mode.
⇒End Starts / stops data acquisition.
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Control (Programmed)

Instead of immediately executing a command as in the case of  Direct
Control, commands can be written using a specific syntax in the ¾PGM File
and can be executed later.

With this type of control, not only the command itself but the time of execution
(relative to the time of injection) must be determined.

If several commands are added to a sequence, and if the command sequence
contains an ⇒Inject and an ⇒AcqOn/Off command, this is referred to as
(control) ¾Program. To view the program, open the Commands view of the
PGM editor.

When starting the program, all contained commands are executed precisely at
the defined time. The same conditions apply as for the direct control.

For further details, see the topics below:

 Control Program
 Program Syntax
 Program Wizard

 Control Program

The control program includes a list of time-precise ⇒Control Commands, the
actual control program (often just referred to as ¾Program) put together by the
user. The aim is the automatic and repeated execution of specific routine tasks
such as automated sample processing or conditioning a column by rinsing with
various solvents. Monitoring certain parameters or limits, or triggering reactions
when these limits are exceeded, can also be performed via a program.

A program is created either manually or automatically with the help of a
¾Wizard, the  Program Wizard. All user entries are converted automatically
in commands that can be read by the data system. Even new users are thus
able to create operative programs.

Independently of whether the program was created manually or automatically,
the complete program is always saved as a normal text file. Users familiar with
the command syntax can therefore change existing programs at any time.

To edit an existing program, open the program by double-clicking the program
name in the Browser. This action opens the Commands view of the PGM
editor, the actual program editor.
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 Caution: The steps described below are only possible if the PGM file -
analogous to a control panel - is connected to a ¾Timebase. As
this is only possible when the server is active, you must first start
the server via the ¾Monitor Program of the Dionex
Chromatography Management System.

If the PGM file is connected correctly with a timebase, the edit
box (F8 box) will offer exactly the commands required for
controlling the instruments on this timebase.

If the PGM file and the timebase were not correctly connected,
you will recognize this by the gray coloring of the program lines.
It is now possible to edit the PGM file manually, but not via the
F8 edit box.

Editing a Program Line
• Position the cursor in the line to edit and press the F8 key.

• The Dionex Chromatography Management System opens the Commands
edit box (F8 box) that allows editing the program lines.

• Press OK to complete the input, press OK & Prev or OK & Next to change
the command in the previous or next line.

Inserting a New Program Line
• Position the cursor in an empty line or generate one by pressing Enter at

the end of a line.

• Press the F8 key.

• Create a command line.

Proceed as follows:
• Choose the instrument (in the following called Device) for which you want

to edit an instruction. A device can be any instrument of a timebase, but
also an installed channel, a relay, a remote input, or the system itself. The
icon  icon represents a device. Click the preceding + character to see
details.

• Each device has its own commands ( ) and/or properties ( , ,
, ).
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• As soon as you select a command or a property, further edit fields and a
short help text (Help) will appear in addition to the retention time field.

• Enter the retention time at which to execute the command.

• Assign the required value (e.g., a number) or a status (e.g., On) to the
command / property.

• Press OK to complete the input, press OK & Prev or OK & Next to change
the previous or the next program line.

• Repeat the input procedure until the PGM file is complete.

Manual Input
Each program can be edited directly, if the corresponding program syntax is
known. In this case, the user is responsible for the correct input.

• Perform the Check command from the Control menu to check the syntax.

• Perform the Sort On Retention Time command from the Control menu to
sort all commands based on ascending retention times.

Input Result
The created command in inserted in the program. To facilitate orientation within
a program, commands are displayed in black, triggers in blue, and comments
in green print.

The input procedure via the F8 key prevents entering invalid command syntax.
If The Dionex Chromatography Management System finds an unknown or
wrong syntax, the corresponding line is displayed in red print.

• Via F4/Shift+F4, you can browse through the errors to correct wrong input.
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After a short period, new users will be able to create clever and efficient
programs. An example is the control of a fraction collector depending on the
signal height and flank slope of a peak.

For further details, see Control (Programmed):

 Program Syntax
 Program Wizard

For practical tips, see How to ...:

Actions in the PGM Editor  Creating a Program
Device Control  Extending a Program

 Program Syntax

For uniform operation by different users, ⇒Control Commands are always
entered in English. The commands of a ¾Program are based on the following
pattern:

Retention Time DeviceName.Command

or
Retention Time DeviceName.Property = Value

If you are not familiar with the program syntax, use the  Program Wizard
(see the following topic) that guides you through program creation.

 Note: The syntax of the commands differs from the syntax of the
GynkoSoft data system! For information, see How
to ....: Actions in the PGM Editor  Differences from
GynkoSoft.

When opening "old" GynkoSoft program files, the commands
used are automatically converted into the syntax of the Dionex
Chromatography Management System. If a command cannot be
converted, a corresponding comment will be included in a
separate comment line.
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Time Value (Retention Time)
The time value is entered at the beginning of the control command. It
determines when the command is to be executed. The information is entered in
¾Industry Minutes, for example,

2.500

This input is optional. If no time is entered, the time specified in the previous
program line will be used.

Device
Devices are all instruments, channels, relays, or remote inputs that are
available in the current timebase. They can be recognized in the F8 dialog box
by the device symbol ( ). Each Device has a number of commands and/or
properties.

As various instruments can have the same commands or properties, adding the
device name in front of the command makes a distinction. The syntax is as
follows:

Retention Time DeviceName.Command

or
Retention Time DeviceName.Property = Value

If no confusion with other commands or properties is possible, the device name
can be omitted (e.g., the Flow command when only one single pump is
installed). The syntax is:

Retention Time Flow = Value

Command
Commands are represented in the F8 edit box by an exclamation mark ( ). If a
command can be clearly assigned to an instrument, the name is sufficient for
identification:

2.500 NeedleUp

The ⇒NeedleUp command exists for the Dionex Autosampler GINA 50, only.
In this case, the device name can be omitted. This is in contrast to:

2.500 UV_VIS_1.AcqOn
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The ⇒AcqOn command by itself is not unique (if there is more than one
channel in the system). To address one specific channel, the channel name
must be added to the command.

In addition, commands can be extended by additional parameters, for example:

2.500 ⇒Inject Position = 20, Volume = 30 or

2.500 Relay1.On Duration = 20

The possible command extensions are predefined as well as their order. They
are listed in the F8 edit box. As no confusions are possible here, the following
syntax is also valid:

2.500 Inject 20, 30 or

2.500 Relay1.On 20

Device-Independent Control Commands
If a command cannot be assigned to a Device, it is listed in the F8 edit box by
itself. This applies to the commands  ⇒Branch, ⇒Log, ⇒Message,
⇒Protocol, ⇒Wait, ⇒Delay, ⇒Trigger, ⇒EndTrigger and ⇒End.

For further details, see How to ...: Device Control

 Trigger Commands

 Mixed Commands

Property
Properties are distinguished by their value. Values predefined by the system
(e.g., On, Off, Auto etc.) are represented in the F8 edit box by an I/0-symbol
( ). Freely selectable values are indicated by the -symbol. A command
string is also considered a property ( ), e.g.:

2.500 UV.Lamp = On or

2.500 UV_VIS_1.Wavelength = 300

2.500 %A.Equate = "%A"

If a property gives an actual value (e.g., Pressure (bar), %A (%), Signal (mAU)
etc.), this is indicated by a separate symbol ( ). Properties in connection with
the actual value are subordinate to it. For example, the Dionex
Chromatography Management System enables the output of the current
system pressure (  pressure) and the definition of an upper and lower
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pressure limit (  UpperLimit and  LowerLimit). Assigning a solvent name is
via the same method (  %B,  Value, Equate). The corresponding syntax is:

2.500 pressure.UpperLimit = 350

2.500 pressure.LowerLimit = 20

2.500 %B.Value = 30

2.500 %B.Equate = "Methanol"

Here the same applies: if the syntax is not clear, the device name must
precede the command or property, e.g.:

2.500 UV_VIS_1.Signal.UpperLimit = 500

Text, Names
Before, after, or between individual commands, comments on the program or
individual commands can be included. The comment lines are started by a
semicolon ";."

; The following program ...

Text that is displayed on the screen because of a command and is then
included in the Audit Trail, as is the case of the commands Protocol,
Message, or Equate, must be placed in quotation marks.

2.500 Protocol "Test program"

If these commands are entered via the F8 edit box, the quotation marks are
added automatically.

 Program Wizard
The Program Wizard facilitates creating a ¾Program. To start the Program
Wizard, select New from the File menu. Then, select Program File.

In single steps, the complete necessary information is collected to generate a
basic program. Each step consists of a template in which the user enters or
selects data. Depending on the installation, different steps are required. With a
typical HPLC timebase, the Program Wizard offers the following steps:



100 Control

Step 1: Selecting a ¾Timebase

Step 2: Selecting the temperature settings (if supported)

Step 3: Selecting a flow system

Step 4: Determining a gradient profile (option)

Step 5: Determining channels and duration of the data acquisition

Step 6: Determining signal parameters for the individual channels

Step 7: Completing the Program Wizard

From the information entered in Steps 1 to 6, the Dionex Chromatography
Management System creates an operable program by adding the ⇒Inject and
⇒End commands. This file is displayed in the PGM editor window.

Pressing F8 opens a dialog box that allows you to edit the program after
closing the Wizard even if you are not familiar with the program syntax. Users
familiar with the  Program Syntax (Control (Programmed) topic), can freely
modify or extend the created file directly via the keyboard. Then, the ¾PGM
File is saved using the Save as command of the File menu.
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Data

Data: Overview

Input Data
For the analysis of a sample and for documentation and archiving purposes,
various types of input data are required, which the user must determine or
enter before starting the analysis.

These include e.g. the sample name, weight, injection volume,
chromatographic conditions (solvent, flow, detection wavelength, connected
devices, etc.), as well as the run time. A distinction is made between:

• Data describing a sample (¾Sample Data),
• Data describing a sequence (¾Sequence Data, usually entered

automatically), and
• Data describing the chromatographic treatment of a sample

(¾Chromatographic Methods).

The user input data serves as the basis for the analytical process.

Input Data Output Data

Raw Data,
Protocol Data

Sample Data,
Chromatographic Method Analysis

Output Data
The data recorded during analysis is referred to as output data. Output data
includes:
• Data provided by the analysis process itself (analysis and ¾Raw Data)

• Protocol data on the analysis (¾Audit Trail).

Due to this variety of data types, systematic data organization, and  Data
Storage is especially important.
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Datasource

The term ¾Datasource is used for the top level of the directory structure
displayed in the ¾Browser. The Browser is also the tool for handling
datasources. Each datasource is based on a separate database. When setting
up a datasource, a path to an existing database is entered or a new database
is created.

• Choose the Datasources command of the File menu to set up a
datasource. For detailed information on the required steps, see How
to ...: Actions in the Browser  Setting up a Datasource.

The Browser indicates only the name of the datasource, not the name of the
underlying database. The type and number of the datasources visible to the
user determine the data that can be accessed. This simplified representation
offers the following advantages:

• Data is always accessed in the same way. The user does not have to worry
about the data’s actual storage location in the network. Entering the path is
not necessary. The location is specified when the datasource is created.

• Each user can take advantage of a database without having to deal with
special database programs.

Database Formats of a Datasource
The Dionex Chromatography Management System supports several database
formats. In addition to the most frequently used Access database format (mdb
container), the data system’s ¾ODBC Capability enables handling SQL
("Structured Query Language") or database formats such as ORACLE and
SQL servers. "Old" GynkoSoft directories ("drives") and third-party data can be
displayed as if they were datasources with an underlying database. GynkoSoft
and the datasources of the Dionex Chromatography Management System are
easily recognized by their different symbols (see figure).

GynkoSoft - Datasource
local CHROMELEON datasource
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When installing the Dionex Chromatography Management System, a default
datasource is created automatically on each client PC. Its name is derived from
the computer name (assigned during the installation under Windows
installation) and the addition Local. This guarantees that each user has a
separate datasource in which "personal" results and data are stored. For single
systems and for users that do not have additional access rights within a
network, this is the only possibility for data storage. Raw data of each manually
performed analysis is stored here. Therefore, do not delete the datasource
<PCNAME_LOCAL>!

Directory Structure of a Datasource
Each datasource can be equipped with any number of hierarchically organized
subdirectories via the File / New Directory commands. The result is a data
tree similar to the MSDOS data tree.

 Caution: Do not use special characters (e.g. umlaut) for new directory
names or sequences, as this may cause problems in Novell
networks!

 Caution: Actions performed in the Browser, e.g. creating datasources or
directories, require complex operations below the user interface
and cannot be compared to or performed by the Windows
Explorer! The representation of directories and data also differs
considerably from the Explorer.
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The following illustration shows three example datasources as well as their
different directory structures.

Subdirectories

Sequences

Default Sequence

Below the datasource SOURCE1, the user created the subdirectories LAB201,
LAB202, and DYES. The DYES directory offers the ¾Sequences SEQ1,
SEQ2, and SEQ3.

The default datasource PCNAME_local has a subdirectory with the name of
the timebase installed on this computer, in which there is the default sequence
manual.
When a sequence is selected, its "inner life" is visible in the right-hand Browser
window. The three parts of the Browser window are displayed: the file structure
(control programs ( ), quantification methods ( ), report templates, etc.), the
sequence information, the samples (standard samples ( ), and unknown
samples ( ), etc.). The presentation is described in the  Browser section.
For information on the functions and significance of sequences, see the
Samples and Sequences section and the  Sample List (Sequence Table)
topic.
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Subdirectories, sequences, and chromatographic methods can be moved via
Drag & Drop within a datasource, but also between datasources of different
types. This copy process can also change the underlying database! If you want
to actually move a sample, note that the original sample must be deleted in the
Browser after the copy process.

 Caution: Drag & Drop operations can be executed exclusively via the
¾Browser. Actions outside of the Dionex Chromatography
Management System, e.g. in the Windows Explorer, will result in
data losses!

Locking Datasources, Directories, and Sequences
To protect data and results, the Dionex Chromatography Management System
offers the possibility to lock datasources, directories, or sequences. If the
Locked status is enabled, it is not possible to modify the corresponding object.
This also applies to all objects below the locked one. If, for example, a
datasource is locked, all contained directories and sequences are also locked.
Locked items can be recognized in the Browser by the red lock on the icon
( ).

To lock an object proceed as follows:
• Select the object in the Browser.
• Choose the Properties command via the context menu and activate the

Locked check box in the edit box.
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Repeat these steps to undo the operation.

 Note: Locking and sharing objects are subject to the  Access
Control and can only be performed by users who have the
corresponding privilege.

In addition to locking datasources and directories via the Locked check box,
access to these items can be controlled by adding them to or removing them
from ¾Access Groups.

• Select the object in the Browser.

• Choose the Properties command via the context menu, and define the
Access group assignment via the Add and Remove buttons.

Access to datasources and directories is only possible for users who are
members of an A-group listed in the Access Groups.

Data Acquisition, Sensitivity, and Detection Limit

Even the best method of  Data Storage is only as good as the quality of the
stored data. Therefore, data acquisition plays a very important role.

Data acquisition starts with the quality of the used detector, it comprises all
components participating in the data flow and is concluded with processing the
data in the data system.

The best results are obtained with a detector that is capable of communicating
digital signals via a  Serial RS232 Interface. Detectors that supply analog
signals have to rely on precise conversion of the signals. The product range
available from Dionex includes an extremely sensitive and low-noise A/D
converter. The A/D converter guarantees highest precision with minimum
noise.

The detection limit, i.e. the lowest concentration that is just distinguishable from
zero (¾Blank Run Sample), is reached when the signal to noise ratio is smaller
than 2.5. The signal height of a peak is than less than 3 times the signal
¾Noise. The lower the noise during analysis, the lower the detection limits. In
contrast to sensitivity, the detection limit depends on the instruments used.
Sensitivity is the smallest difference in substance concentration resulting from
the method itself, i.e. by the slope of the calibration curve.
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Data Acquisition with Detectors without Separate
Drivers

In addition to the device drivers for Dionex detectors, the Dionex
Chromatography Management System offers many drivers to control third-party
detectors. (For an overview on the different manufacturers whose devices can
be controlled via the Dionex Chromatography Management System, see

 Installing and Controlling Third-Party Instruments
In addition, detectors for which separate device drivers are not available can
acquire data. Please use the driver Integrator Driver.
For information on how to install the device drivers, see How to ...: Actions in
the Server Configuration  Changing the Server Configuration

Data Storage

For fast and efficient access to specific data, intelligent storage, and
organization of the complete data is very important. The Dionex
Chromatography Management System solves this problem by storing data and
files in different locations. Databases and sequence directory are available for
this purpose. Both are part of the  Datasource.

Storage in a Database
Data that can be compared across sequences is stored and managed in a
relational, ¾ODBC-capable database. This applies to the entire ¾Sample and
¾Sequence Data. The advantage of this type of data management is not only
the comfortable integration in other applications such as Excel, Access, dBase,
etc., but also the efficient searching and sorting capabilities.

A ¾Query allows finding all samples processed on a certain day, created by a
certain user and/or carrying a certain name.

Storage with the Sequence
The entire data describing the chromatographic treatment of a sample or data
recorded during the analysis is stored in a ¾Sequence. This includes control
files (¾PGM File) and evaluation parameters (QNT method), but also the entire
raw and protocol data (see  Raw Data Storage).
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History (File History)

• Select a datasource in the Browser and activate the Enable Modification
History options from the Properties of the context menu.

When the ¾History Mode is activated, the Dionex Chromatography
Management System prompts the user for a comment on the modification or
operation before saving any modified object. This allows documenting all
performed modifications together with the user name and the object name. In
combination with the Copy, Create, and Save as commands, the comment is
entered automatically.

Objects can be samples, sequences or datasources, ¾Control Panels,
¾Report Definition Files (RDFs), ¾PGM Files and/or ¾QNT files and modified
chromatograms.

• Select a datasource or a single directory and perform the Show History
command of the context menu to see all objects that were modified and
that received a comment.

Depending on the filter you use, the Dionex Chromatography Management
System will show a list of all objects that were modified within a certain period
and/or by a certain operator.

• Select an object from the list and press the Details button to view
information on an object.

The comment entered by a user when storing an object can be modified later
by the same user (and only by this user). The user must have the
corresponding modification privilege as a member of a ¾Privilege group.
Enabling and disabling the History Mode is also via the corresponding privilege.

Data Export

The Dionex Chromatography Management System offers various options for
data export to enable communication with other programs:

1. You can export report pages from the ¾Browser with the Batch Report
command of the File menu. Clicking the Export checkbox opens the dialog
box Batch Setup where you can export the respective report pages in five
different formats:

a)  ANDI/Chromatography - ¾AIA  (*.cdf)
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b)  ASCII text format (*.txt)

c)  Excel file format (*.xls)

d)  Adobe Acrobat file format (*.pdf)

e)  Archive format (*.cmb) of the Dionex Chromatography Management
System

2. A modified version of the Batch Setup dialog box can be opened in the
 Printer Layout. This box offers the same functionality as the box that is

opened in the Browser.

3. In addition, raw data can be exported in the AIA format from the Browser via
the Export/Backup command under ANDI/Chromatography (AIA) (Also,
see  Raw Data Export)

If you wish to send data of the Dionex Chromatography Management System
to another laboratory e.g. via e-mail, we recommend executing a  Backup
first and transmitting the compressed data in the archive format of the Dionex
Chromatography Management System.

Backup

To avoid unforeseen data losses that can occur for example due to a defective
hard disk, we recommend to regularly backup the saved data on a different
data medium using the Backup command in the File menu of the ¾Browser
(see Actions in the Browser  Creating Backup Files).

Backup data is compressed, i.e. "packed" and stored in a different location. For
security reasons (GLP does not allow modification of backup data), direct
access to the data is not possible. The data must be "unpacked" via the
Restore command in the File menu of the Browser (see Actions in the
Browser  Restoring Backup Files).

The backup logs each single file that is copied and issues warnings if errors
occur. The directory structure is maintained.
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Raw Data

All analog or digital values measured by a detector and stored digitally on the
PC are referred to as raw data. Raw data only exists for those signals or
channels that were selected by the user before the analysis!

The extent and the precision of the stored raw data depend on the selected
¾Sampling Rate or ⇒Step.

For further details, see

 Raw Data Storage
 Raw Data Compression

Raw Data Storage

Raw data storage refers to saving the signals received from a detector in digital
form. Other important data is also stored, e.g. analysis time, signal unit,
number of data points etc.

If a detector is only supplied with an analog output, the data must be converted
into digital signals. The A/D converter performs this task.

Storage Procedure
With conventional data systems, an analog value is digitized at a fixed time
interval, e.g. a digital value of defined accuracy is stored every second. The
number of stored values per second is normally referred to as the ¾Sampling
Rate. The inverse of the sampling rate (the time interval between two data
points) is referred to as ⇒Step.

The higher the sampling rate, i.e. the smaller the step, the more data points are
stored, and the more exactly the original signal can be restored from the stored
data. However, a higher sampling rate has a higher memory requirement. The
Dionex Chromatography Management System solves this problem by the step
setting step=auto. This type of storage requires high algorithmic resources in
real time (!), which is justified by the following advantages:

• Raw data files are as small as possible, as fewer data points would result
in a loss of precision! If an analysis requires a conventional step width of
0.5 seconds, your Dionex Chromatography Management System can
typically acquire such chromatograms with an average step width
(= chromatogram length divided by the number of data points) of 2
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seconds. The compression factor of 4:1 is thus achieved, making optimum
use of the available storage capacity.

• Despite this minimal file size, maximum integration accuracy is ensured for
the given chromatographic conditions, as the continuous signal is
approximated to the optimum. Generally, more data points are stored
below peaks than with conventional acquisition methods.

• The processing speed, e.g. for peak detection, re-integration, graphical
output etc. is significantly higher due to the reduced number of data points.

Storage Location
Raw data is stored in the directory of the current sequence. For each channel
that is specified during the installation of the Dionex Chromatography
Management System, a separate subdirectory is created. In addition, a
protocol data directory is created. The directories are not visible in the Browser.

The reason for this is: the Dionex Chromatography Management System
manages the entire raw data automatically. At no time, the user must access
the raw data directly.

Viewing this type of data is only possible via the Windows Explorer provided
the datasources are not locked. As, however, the datasource names are not
displayed in the browser, you must follow the path to the corresponding
sequence directory (see figure).
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In this example, the channels 3dfield, Ext228nm. Uv_vis-1, and Uv_vis-2
were defined. The protocol data directory Audit_Tr was added. If a directory is
expanded, the raw data of the corresponding channel is visible.

A separate raw data file is created for each sample in a sequence, for
which raw data of a specific channel was recorded.

 Caution: Do not modify these directories! Operations outside of the Dionex
Chromatography Management System are not permitted!
Therefore, we recommend that you protect your datasources to
prevent that they are accessed via the Windows Explorer. In the
file or context menus of the browser, activate the Protect Data
Set Directory option on the Properties tab of the respective
datasource

Raw Data Compression

Storing raw data automatically compresses the data. For the signal value, this
is achieved by storing the difference to the next data point instead of storing
each data point. Only from time to time, the actual value is stored. This way,
the compression is increased by 50%. This effect is especially noticeable in the
case of ¾3D-Fields.
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The size of the raw data file of a 3D-field increases with the number of
recorded data points. These depend on the ¾Optical Resolution of the
detector, the field size (area between the upper and lower limit of the 3D-field)
as well as the selected ¾Sampling Rate.

At a sampling rate of e.g. two spectra per second (step = 0.5) and an optical
resolution of 2nm, this means that 2 x 60 x 70 = 8400 data points per minute
must be recorded for the UV range from 200 to 340nm. As each absorption
value is recorded with an accuracy of 25bits, a hard disk storage capacity of m
x (N+1) x 4 = 70 x ((2x60)+1) x 4 = 33.88kByte per minute is required. The
storage requirement for the 3D-field of a "normal" (20-minute) chromatogram is
thus 0.678 MByte!

However, by skillful data compression procedures, it is possible to reduce the
required storage capacity by approx. 50-60%. This is possible by completely
storing approx. each eighth spectrum. Of all other spectra, only the difference
to the previous one is stored and is re-calculated, when needed. This
procedure is a good compromise between optimum data compression and the
required time for restoring a 3D-field.

 Note: The compression procedure is not destructive, i.e. the complete
data is stored. The 3D-field thus contains the complete
information provided by the detector. The data can be restored at
any time.

Furthermore, there are three ways to minimize storage capacity requirements:

• Limit the wavelength range to the necessary range.
• Reduce the sampling rate (step) so that no more than 10 to 20 spectra are

below the narrowest peak, or select an automatic sampling rate (step).
• Use the possibilities of the ⇒Diode Bunching.

Restoring a Chromatogram from Raw Data

When restoring a chromatogram from the raw data, equidistant data points are
joined with straight lines. A diagram "resembling" the recorded analog signal is
thus created.

Clearly, the resemblance (and thus the precision of integration) is increased
with an increasing sampling rate. However, a higher sampling rate requires
more storage capacity. When using a fixed sampling rate, the sampling rate
must be set so that a minimum of 10 datapoints is stored during the smallest
peak in order to integrate the smallest peaks of a chromatogram (generally the
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earlier peaks) with the same precision as the larger peaks. This results,
however, in huge data volumes especially in the case of wide peaks and long
baseline sections.

Using a dynamic sampling rate can solve this problem. The Dionex
Chromatography Management System is capable of continuously optimizing
the sampling rate during an analysis, i.e. few data points are stored during
baseline sections, whereas many are stored below peaks. The local sampling
rate is set according to the actual information volume such that the deviation
between the resulting diagram and the actual analog signal is never greater (or
smaller) than the actual noise component of the signal. This method ensures
that neither too many nor too few data points are stored, but always the
optimum. The ⇒Step values vary between 0.01 and 5 seconds (sampling rate:
0.2 to 100 Hz).

Raw Data Export

The Dionex Chromatography Management System supports exporting raw
data by conversion into ¾AIA and ASCII formats. In addition, raw data can be
exported as a ¾Backup file (*.cmb). Use the Export / Backup option from the
File menu to export as an AIA or backup file.

Format Description
AIA Cat.     2 Samples and peak variables are stored in the AIA format.
AIA Cat. 1+2 In addition to samples and peak variables, the raw data of a

chromatogram (each stored data point) is stored in the AIA format.
Dionex
Chromatograph
y Management
System backup
(*.cmb):

All data of a ¾Sequence or a ¾Datasource are stored in the cmb format.

ASCII Raw data may be exported in the ASCII format as well. Use the command
Batch Report from the File or context menu. Click Export in the dialog
box and then select the ASCII export format. All raw data from the
channels selected for the actual sequence are stored in the ASCII format.

 Tip: If you intend to export raw data to other applications or other
computers, it may be necessary to use a fixed ⇒Step
(= equidistant raw data storage) instead of a dynamic step.

It is also possible to export data sheets of the report in different formats (see
 Data Export).
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Raw Data Import

Importing the following raw data is possible:

• ¾AIA data (*.txt)

• GynkoSoft data

• ¾LIMS/¾Worklist data (*.wle)

• PeakNet (up to version 5.2) data

• Files in the archive format (*.cmb) of the Dionex Chromatography
Management System

In the File menu of the Browser, choose Import / Restore and the
corresponding option. Use Import to import any of the above raw data. Use
¾Restore to import ¾Backup data of the Dionex Chromatography Management
System.

In addition, it is possible to install databases from third-party chromatography
data systems. Proceed as follows:

• Open the Browser and choose the Datasource command from the File
menu.

• Follow the instructions described under: How to ...: Actions in the
Browser  Connecting a Database.

For details on importing PeakNet 5.2 or earlier data files, see How to ...:
Actions in the Browser  Importing PeakNet (Release 4.5 through 5.2)
Data Files.

Raw Data Storage in Case of Power-Failure

The raw data of a sample interrupted by a power failure is not lost, as a raw
data autosave is performed continuously during sample processing. The
autosave ensures that the raw data is stored on the hard disk in short intervals.
The user can reduce the time intervals to approx. 30 seconds. In the case of a
power failure, the maximum data loss is thus 30 seconds.

If a power failure interrupts the automatic sample batch, the ¾Power-Failure
Protection and the power-failure handling ensure that processing is continued



116 Data

at the same position after starting the system anew. In addition, you can run a
power-failure program before to reset the system to a defined state.

If processing is interrupted by warnings or error messages, it is possible to
react with an appropriate ¾Emergency Program. The system is then in a
defined state that is recorded in the ¾Audit Trail.

For information on how to develop appropriate programs for both cases, see:

How to ...: Actions in the PGM Editor:

 Creating an Emergency Program

 Creating a Power-Failure Program

Protocol Data (Audit Trail)

In addition to raw data, the Dionex Chromatography Management System also
records the data of the  Audit Trail (protocol data storage). The following
information is included:
• Commands from a control file

• Manually executed commands

• Commands activated by a trigger condition

• Error messages

• Start of sample processing

• New start of the Dionex Chromatography Management System after
booting the computer

Each item is stored with the current time. Furthermore, the current program
time is added to information during recording of data and processing a sample
batch, respectively.

Storage is continuous over a whole workday as well as for the duration of
processing a single file. That is why the following distinction is made:

 Daily Protocol
 Sample Protocol
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Audit Trails can be displayed either from the Browser (as daily or sample
protocols) or as audit trail control in the control panel. To select extent and type
of the display, a display filter (Normal, Advanced, Expert, and Error, or
Warning, respectively) can be chosen by means of the context menu (right
mouse click). The display options Advanced and Expert can only be used for
audit trails created with version 4.0 or higher of the Dionex Chromatography
Management System.

 Daily Protocol
The daily protocol stores the entire GLP relevant data that is related to the
status of a specific timebase. This information is displayed in the Audit Trail
Control of the control panel.

When starting the ¾Server of the Dionex Chromatography Management
System, the AUDIT directory is created in the server datasource below the
timebase. The server saves the daily protocol in this directory. The daily
protocol receives the current date as the file name (e.g. ‘19980527.slg’ for the
daily protocol of May 27, 1998). A new file will be created for each day.

On the right section of the Browser window, the daily protocols are displayed
together with their names and the time of their last change. Double-clicking
opens the file and shows its content in a separate window. The display
corresponds to the audit trail control of the control panels and a printout of the
display is possible as well.

In the Browser, you can copy and delete daily audit trails. For both actions, the
corresponding user rights are defined in the user mode of the Dionex
Chromatography Management System.

 Note: In contrast to the GynkoSoft data system, the daily protocol is not
overwritten by the protocol of the following day. As the Dionex
Chromatography Management System generates a new file for
each daily protocol, old protocols that are no longer required
should be deleted from time to time.
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 Sample Protocol
The sample protocol contains the entire audit trail data of the corresponding
sample. The sample protocol is part of each default report.
• Display a report in any method window and select the worksheet Audit

Trail to view the Audit Trail data of the current sample.

The sample protocol can be activated via the Browser. Open the context menu
of the sample in the Browser. Via Open, open a box and then open the sample
protocol via Audit Trail.
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Samples and Sequences

Sample Preparation

Sample preparation is a major part of the chromatographic analysis. It can
include simple procedures as weighing, solving, and diluting a sample, as well
as more complicated physical (filtration, centrifugation etc.) and chemical
separation procedures (liquid-liquid-extraction, fixed phase extraction).
Generally, the careful performance contributes substantially to the quality and
the reproducibility of chromatographic separations.

Furthermore, the Dionex Chromatography Management System offers two
correction factors (¾Sample Weight and ¾Dilution Factor) that allow using the
"approximate weight" as well as defining dilution steps and can thus be used to
consider the sample preparation when evaluating the data.

Sample Processing

Sample processing includes three major steps:

• Sample definition (single samples and sequence / batch)

• Analytical procedure (manual or automatic control)

• Evaluation (methods and reports)

The performance of each step primarily depends on the used methods and the
available instruments. The working environment could range from a fully
automatic sample laboratory with large quantities of samples to single-user
applications in a research lab. Easy and quick analysis procedures may be the
focus in the first case, while special methods and parameters for peak
recognition may have priority in the latter case. Thus, it is not surprising that
functions crucial to one group of users may be irrelevant to others.

Consider these facts, when information is presented from different viewpoints
in the following sections.
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Sample Definition

In the Dionex Chromatography Management System, the term sample has a
more specific meaning than in normal colloquial use.

Each injection is defined as an individual "sample"!
Multiple injections from the same sample vial under similar conditions are
considered several samples.

Defining a sample means the process of determining how much of a substance
is injected from which vial and under which conditions, and which evaluation
parameters are used. A distinction is made between a single sample and a
sample series.

Single Sample
A sample can be analyzed individually by entering all required information and
user commands via the keyboard or the mouse.

The user selects the Inject command, enters the volume to inject, and
performs the injection via a hand-operated valve. If an ¾Autosampler is
available, the user determines the sample location with the ⇒Inject command.
Then, data acquisition is started (via the ¾AcqOn/Off command). When the
end of the sample is reached, the user terminates data acquisition (Acq Off
command) and specifies where to save the acquired data.

The recorded data is temporarily saved to the manual sequence of the default
datasource of the system. In network operation, this datasource is designated
with the computer name of the user in the network.

As soon as the user terminates data acquisition, the user is prompted to select
the final storage location for the temporarily saved data.

Sequence / Batch
If several samples are to be processed successively, they are included in a
sample list (sequence table), together with the instrument control and
evaluation information. The samples are then processed by starting automatic
¾Batch Processing.

For details on how to create a sample list, see  Sample List (Sequence
Table).
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Sample List (Sequence Table)

The sample list (sequence) is part of the  Browser. It appears on the lower
right window section as soon as a ¾Sequence is selected, and it is "read" line
by line. One line corresponds to one sample.

A sample is characterized by various column entries. The entries are managed
in a database and are referred to as ¾Sample Data. A short explanation of
each column is displayed upon pressing the F1 key.

The user has to create the list of samples to be processed with the
characteristic sample data before each analysis. There are various options:

• Select a cell with the mouse, then change the cell input via the keyboard.
• Select a cell with the mouse, press F8 to open an edit dialog box facilitating

data input.
• Open a similar, existing sequence table and modify the input.
• Automatically generate a sequence table via the  Sequence Wizard.

Having entered all relevant information, the sample list is saved under a unique
name using the Save as command in the File menu.

In addition to "real" sample data, e.g. the sample name, the injection volume,
the vial, and the sample type (unknown or standard), especially the Program
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File and Method columns are important for the analysis procedure. Entries
here refer to specific ¾Chromatographic Methods determining the performance
of the analysis. These include programs (  Control Program) required for
fully automatic control of analytical instruments as well as evaluation
instructions (  Overview: Quantification Method) determining the
integration and calibration.

The number of samples per sequence is not limited, but it should exceed 100
only in exceptional cases. The fewer samples are added to a sequence, i.e. the
more sequences are created, the faster single samples can be accessed and
the easier it is for the user to keep track of the processed samples. Criteria for
combining several samples in one sequence could be, for example, the same
analysis conditions, the same origin, the samples of the same day etc.

For detailed information on how to create a sample list, see How
to ...: Actions in the Browser  Creating a Sample List (Sequence Table).

Sequence Wizard

The Sequence ¾Wizard helps you to quickly create a basic sample list
consisting of analysis and standard samples. The Sequence Wizard is opened
via the File/New command in the Browser. Creating a ¾Sequence is
performed in five easy steps (for further information see links below to the
respective topics in the Online Help):

• Step 1: Selecting the timebase

• Step 2: Generating the analysis samples

• Step 3: Generating the standard samples

• Step 4: Determining the ¾PGM File and the analysis method

• Step 5: Saving the sequence and assigning a name

Also, see the Online Help for a detailed description of the mentioned steps .

Each step is performed in a separate input screen. Press one of the two arrow
buttons (<Back, Next>) to browse through the input screens.

Press the <Finish> button in the fifth step to save the sequence and close the
wizard.

 Caution: Do not use special characters (e.g. umlaut) for new directory
names or sequences, as this may cause problems in Novell
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networks!

 Note: In future versions of the Dionex Chromatography Management
System, including validation and/or blank run samples with the
Sequence Wizard will also be possible.

Automatic Batch Operation (Online Batch)

The enormous technical complexity of modern chromatography systems, the
resulting high purchasing costs and the constantly increasing number of
samples in analysis laboratories make continuous operation even outside of
regular working hours a necessity. Thanks to ¾Autosamplers, very efficient
PCs, and modern data systems, this has become routine. The user merely
provides "replenishment."

When the actual sample preparation is completed, the chromatographic
conditions of processing, the samples to be processed and in which order must
be communicated to the data system. This is performed in the sequence table.
The result is stored as a ¾Sequence.

Independently processing one or several sequences is known as ¾Batch
Processing. To start processing, the following steps are required:

Starting the Automatic Batch
After data input is completed, the analytical process can be started in an online
batch.

• Open a control panel and choose the Edit command from the Batch menu.
• Enter the names of the sequences containing the samples to be analyzed.
• Perform a ¾Ready Check.
• Start the analysis process by pressing the Start button.

Processing the Automatic Batch
As soon as the online batch is started, all samples of the sequence with the
status single or multiple are analyzed successively. If a sequence contains a
sufficient number of samples, sample processing "around the clock" is
possible.
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Instead of including all samples in one sequence, they can be distributed on
several sequences. Accordingly, more sequences are then entered in the batch
dialog (max. 16).

This list can be considered a batch; it is also referred to as online sample batch
or online batch. The order of the sequences determines the order of
processing, i.e. when starting the batch process, samples 1 to n of the first
sequence, then samples 1 to n of the second sequence are analyzed.

Saving the Results
The results of the online batch are saved with the individual samples.

Sample Evaluation

In spite of largely automated work processes and intelligent pre-settings, it is
within the responsibility of each user to set the framework conditions of sample
evaluation.

Calculations
As in the case of sample processing, which is performed based on a program
(¾PGM File) previously created and included in the Sample List, the analysis
results are calculated based on the evaluation method indicated in the Sample
List. The method itself is created in the QNT Editor.

Result Output
The result of sample processing can be represented in graphics and tables,
either on the screen or in a printed output. The Dionex Chromatography
Management System provides method windows for generating this output. In
the Printer Layout, templates can be defined for standardized presentations of
the sample results.

For a list and detailed description of available method windows, see  Data
Reprocessing.

Electronic Signature

During the last decades, quality assurance and ¾GLP have become
increasingly important with the data verification being one of the key aspects.
Especially ¾Raw Data must not be modified later. In addition, the results,
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which have been generated from the raw data, should not be modified without
asking once they have been accepted. Contrary to the data system, this can be
achieved with a printout in part, only.

If the ¾CmUser mode is activated, the electronic signature allows you to sign
the results from your raw data that is important within the scope of quality
assurance and GLP. In this way, you can sign and save ¾Sequence reports
that have been accepted as correct so that the current state of your results is
"frozen".

 Note: Electronic signature is available for user databases only that
were created with a CmUser program version 6.10 or higher.
Update your database if an error message notifies you that
electronic signature will not be possible.

Electronic signature includes three steps:
• Submit

• Review

• Approve

Typically, the report will be signed and submitted by the user who created it.
Having reviewed the report, the laboratory manager will sign it. Finally, the
quality assurance manager can approve the results.

For information how to electronically sign reports see How to ...: Actions in
the Browser  Signing Sequences Electronically.
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Theory of Calibration

Calibration: Overview

The signal of an HPLC Detector is suitable for quantitative determination if it is
proportional to the concentration of a substance in the flow cell. This
characteristic is for example offered by the absorption supplied within the range
of validity of the Lambert-Beer law by a UV detector.

The corresponding proportionality constant does not only depend on the
chemical quality of the substance in question, but also on the physical
properties of the used detector. For UV detectors these are, above all, the
optical wavelength and the spectral bandwidth. As integration programs can
only determine the area (and height, respectively) below a peak, conversion
into absolute amount or concentration units is only possible if a calibration was
executed before the analysis.

For details, see the topics below:

 Principle
 Calibration Types (Linear)
 Calibration Types (Non-linear)
 Using the Calibration Curve
 Calculating the Calibration Curve
 Standard Methods (External / Internal / ...)
 Evaluation with Various Standard Methods
 Implementation

At the end of a calibration, the Dionex Chromatography Management System
creates calibration curves from the available calibration points for each
calibrated substance. Representing and evaluating the curves is performed in
the method window

 Calibration Curve
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 Principle
The principle of the calibration is based on that one or several samples of
known composition are analyzed by chromatography and a conversion factor
amount (or concentration)/ area is calculated from the detected areas below
the individual peaks and the known amounts or concentrations. This factor can
then be used to multiply the area of the respective peak of an unknown sample.
The result is the corresponding amount of the substance  (or concentration of
the substance). However, this simple method will work only,
• if the relation between amount and area is strictly linear (i.e. if, e.g. for UV

detectors, the Lambert Beer Law is applicable) and

• if the area zero equals the amount zero, i.e. the calibration line leads
through the origin (no offset).

If the detector signal S is proportional to the concentration (K) of a dissolved
substance, the proportionality factor c1 applies:

S  =  c1 * K

Under certain conditions, the area F(x) corresponding to a certain amount (x) is
proportional to the contained amount.

F(x)  =  c1 * x

If a sample of the substance A of known concentration (the standard /
calibration sample) is analyzed chromatographically, the result is a specific
ratio between the injected amount and the determined area value. The result
can be graphically presented by entering the value pair in an amount / area
diagram. In this diagram, each injection corresponds to one ¾Calibration Point.

Ideally, all calibration points are located on a straight line, and there is a direct
ratio between the amount and the determined area. The "conversion factor"
corresponds to the slope of the calibration line (left fig. "ideal").
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During each calibration, deviations from the ideal behavior might occur which
are above all caused by weight and/or dilution errors. This causes scattering of
calibration points. Therefore, the Gaussian method of the least squares (see

 Calculating the Calibration Curve) is used to calculate a regression line.
This line is defined as the best approximation to the existing calibration points
and, usually, it does not go through the origin (right fig. "real").

If the various calibration points are not located on a straight line, but show a
parabola or exponential shape, the slope of the curve and the distance to the
zero point (offset) describe the corresponding (approximate) curve
(calibration curve). The basic mathematical function is referred to as
¾Calibration Function; the coefficients are the calibration coefficients.

By selecting the ⇒Calibration Type peak table variable, the user decides
whether a linear or a non-linear calibration curve is calculated from the existing
calibration points. The following distinction can be made:

 Calibration Types (Linear)
 Calibration Types (Non-linear)

 Calibration Types (Linear)
If one calibration sample of a standard substance is analyzed for calibration
only, the user enters exactly one concentration value in the first ⇒Amount
column of the peak table. The result is exactly one ¾Calibration Point.
Connecting the calibration point with the origin then forms the calibration curve.
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It is described by the function derived from the Lambert Beer law:

xcxF *)( 1=

The slope of the line corresponds to the proportionality factor c1 (left partial
fig.). C1 is also called RF value.
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If one calibration sample is analyzed several times, several points can be
entered in the amount/area diagram. The points of one concentration are called
replicates. With an increasing number of available replicates, the impact of
imprecision decreases after averaging. In spite of several replicates, only one
amount/area ratio is determined. This is referred to as multi-point calibration
on one calibration level (in the middle of the partial fig.).

The result is better secured if several concentrations are measured instead of
one. Of course, several replicates can be used per concentration. As a result,
calibration points at different concentrations are received in addition to the
replicates of one concentration. This is called a multiple point calibration on
several levels  (e.g. 3-level calibration (see right partial fig.)). The calibration
curve does not necessarily have to go through the origin. The linear
¾Calibration Function is therefore corrected by an offset.

xccxF *)( 10 +=

 Caution: The decision whether a calibration type differing from the linear
default is physically sensible, is within the responsibility of the
user, not the data system!
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 Calibration Types (Non-linear)
In (the more general) case of a non-linear calibration, further terms are added
to the linear ¾Calibration Function.

Parabola-shaped curves are described as follows:

2
21 **)( xcxcxF += (Quadratic)

2
210 **)( xcxccxF ++= (Quadratic with offset)

To calculate curves of this type, a minimum of two (quadratic) or three
(quadratic with offset) calibration samples must be available (left partial).
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The power function is described as follows:

1*)( 0
cxcxF =

To calculate curves of this type, a minimum of two calibration samples must be
available (right partial fig.).

If none of the above described functions can be applied to the available
¾Calibration Points, the calibration curve can be described as a polygon, i.e. a
linear interpolation between two adjacent calibration points (Point to Point). If
several replicates of one calibration level are available, these are averaged
before interpolation.

 Caution: The decision whether a calibration type differing from the linear
default is physically sensible, is within the responsibility of the
user!
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 Caution: A large number of replicates increases the precision and the
reliability of the curve at this point (on the calibration level), but is
not decisive for the entire curve. The more calibration levels are
examined, i.e., the more standards of different concentrations are
measured, and the more precise is the area/amount allocation for
a larger range. To be exact, the calibration is valid for the range
of the calibration samples only and not beyond it.

 Using the Calibration Curve
If the calibration coefficients are known, the amount value can be calculated for
any area value by inserting the coefficients in the formula of the respective
calibration type.

Within the range of the curve that is covered by the calibration points it is
possible to convert any peak area into the corresponding amount. This is
shown in the following example:

Standard Sample
The user enters the amounts (x1 to x4) of the different standard samples and
determines the ¾Calibration Function by selecting the calibration type (here:
linear with offset). Depending on the selected integration type, area values (F1
- F4) are established from the detected peaks. One area and one substance
amount value form one calibration point. The positions of the calibration points
determine the curve that the Dionex Chromatography Management System
calculates with an approximate method. The final course of the calibration
curve is determined by the calibration coefficients (here: c0, c1).

F = c0 + c1 * x x = + * F
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Unknown Sample (Analysis Sample)
In the case of an unknown sample, the previously calculated calibration
coefficient and one or several area values are known. The area value is now a
known parameter and is thus drawn in x-direction. In the diagram, the two axes
must be exchanged for one another. As a result, the calibration function must
be converted in its inverse function. This is also performed by the data system.
Now, the amount can be calculated by inserting the calibration coefficients and
area values.

Furthermore, the exclusion of outliers, the different weighting of calibration
points, and the formation of "averaged" calibration points from one calibration
level, offer additional ways of calculating the calibration curve.

 Calculating the Calibration Curve
Calculation of the calibration curve (¾Calibration Function) is based on the
method of least squares. With a given calibration type (linear, linear with
offset,...), the parameters of the calibration curve F(a), i.e. c0, c1, and c2 are
determined so that the sum of the squared distances of all measured points
becomes negligible. For this purpose, the following optimization problem is
solved:

w x F ai i i
i

n

*( ( )) min− →
=
∑ 2

1

(xi- F(ai)) refers to the distance of the xi-value from the calibration curve F(a),
wi is the selected weighting (see ¾Weights, e.g. wi=1, wi=1/Amount or
wi=1/Amount2) and xi is the actual value.

 Standard Methods
Calibrations can be based on an external or ¾Internal Standard ("ISTD").
External standard means that there is a separate standard sample. Using an
internal standard means adding the standard to the unknown sample. This
can be either before (External/Internal) or after (Internal) sample preparation.
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Standard Description
external = Default setting. Calibration is via one or several standard samples. Via the

amount values entered in the Amount column, a ratio is established between
the area and the amount. On this basis, the amount in samples of unknown
concentration is determined via the peak area.
With an increasing number of different amounts, the area/amount ratio
(=calibration curve) can be determined more exactly.
If different amounts are obtained by diluting the original substance, a ¾Dilution
Series is resulting. The amount of each concentration is entered in a separate
amount column in the corresponding line of the peak table.
If the calibration is performed with a single standard sample by injecting
different volumes (Var.InjectVol.), only the amount of the original sample is
stored in an amount column. The remaining amount values (for the different
injection volumes) are calculated by the data system.

internal/
external

As ¾Internal Standard ("ISTD") choose a substance with a retention time
behavior similar to the behavior of the substances to be analyzed. Before the
sample preparation, an internal standard is added to all samples (unknown and
standard samples) in exactly the same amount so that the concentration is
identical in all samples. For example, diluting the sample or performing a pre-
column derivatization later will change the concentration of the internal
standard. During calibration, the internal standard and the substances to be
determined are calibrated.

internal In the pure internal standard method, calculation is via area and amount ratios
instead of absolute areas and amounts. For this procedure, it is necessary to
inject a constant amount of the ¾Internal Standard ("ISTD"), i.e. the internal
standard is added before the sample preparation. In a dilution series, the
standard does not have to be diluted (Const. Internal Standard). Due to the
equivalent amount of added internal standard, the same ISTD result should be
achieved for all samples. Forming the ratio of ISTD values allows drawing
conclusions about the precision of the analysis and calculating the actual result.
Due to the intense experimental procedure, this type of calibration is rarely used
in HPLC.

For examples of the different standard methods, see How to ...: Actions in the
QNT Editor  Calibration.

 Evaluation with Various Standard Methods
The following describes how the Dionex Chromatography Management System
calculates calibration points which form the basis for any calibration function F.
Please note that there are differences depending on the selected standard
methods (External, Internal/External (with/without Var.ISTD), Internal
(with/without Var.ISTD)).
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For evaluating unknown samples, i.e. calculating the ⇒Amount values, the
inverted form of the corresponding ¾Calibration Function F is used (=inverted
function A). This means that the c0, c1, and c2 calibration coefficients form
function A that is inverted for amount calculation. The result is F.

'External' Evaluation:
Calibration:
• Y(i,k) = RESPONSE(i,k)

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ (WEIGHT(k)/DILFAC(k)) ∗
            (INJECTVOL(k)/REFINJECT)

Evaluation: Calculation of the Amount peak variable for peak i in the sample x
• AMOUNT(i,x) = F( RESPONSE(i,x) ) ∗ (DILFAC(x)/WEIGHT(x)) ∗ RSP-FACTOR(i)

Description: see below.

'Internal' Evaluation:
Calibration:
• Y(i,k) = 100 ∗ (RESPONSE(i,k)/RESPONSE(ISTD,k)

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ (WEIGHT(k)/DILFAC(k))

Evaluation: Calculation of the Amount peak variable for peak i in the sample x
• AMOUNT(i,x) = F(100 ∗ (RESPONSE(i,x)/RESPONSE(ISTD,x)) ∗

                         (DILFAC(x)/WEIGHT(x)) ∗ RSP-FACTOR(i)

The ISTD peak itself will not be evaluated!

Description: see below.
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'Internal' Evaluation (with variable ISTD):
Calibration:
• Y(i,k) = AMOUNT_NOMINAL(ISTD) ∗ RESPONSE(i,k)/RESPONSE(ISTD,k)

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ (WEIGHT(k)/ DILFAC(k)) ∗
            (INJECTVOL(k)/REFINJECT)

Evaluation: Calculation of the Amount peak variable for peak i in sample x
• AMOUNT(i,x) = F(AMOUNT_NOMINAL(ISTD) ∗ (RESPONSE(i,x)/RESPONSE(ISTD,x)) ∗

                      (DILFAC(x)/WEIGHT(x)) ∗ RSP-FACTOR(i)

The ¾Internal Standard ("ISTD") peak itself is not evaluated!

Description: see below.

'Internal/External' Evaluation:
Calibration:

'External' calibration, including the ISTD peak! (Also, see 'External')

Evaluation: Calculation of the Amount peak variable for peak i in the sample x
• The ISTD peak itself is evaluated 'Externally'!
• FACTOR_IS(x) = AMOUNT_NOMINAL(ISTD)/AMOUNT(ISTD,x)

• AMOUNT(i,x) = F(RESPONSE(i,x)) ∗ (DILFAC(x)/WEIGHT(x)) ∗ RSP-FACTOR(i) ∗
                         FACTOR_IS(x)

Description: see below.

'Internal/External' Evaluation (with variable ISTD):
Calibration:

Calibration is 'External', including the ISTD peak! However, the nominal amount
for the ISTD peak from the sample list (Sample Amount) is used. The sample
weight of the ISTD peak is not considered.
• Y(i,k) = RESPONSE(i,k)

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ (WEIGHT(k)/DILFAC(k)) ∗
            (INJECTVOL(k)/REFINJECT)

• X(ISTD,k) = AMOUNT_NOMINAL(ISTD,k) ∗ (1/DILFAC(k)) ∗
                   (INJECTVOL(k)/REFINJECT)

Evaluation: Calculation of the Amount peak variable for peak i in the sample x
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The ISTD peak itself is evaluated 'Externally', but without Weight correction.
• AMOUNT(ISTD,x) = F(RESPONSE(ISTD,x)) ∗ (DILFAC(x)) ∗ RSP-FACTOR(ISTD)

• FACTOR_IS(x) = AMOUNT_NOMINAL(ISTD,x)/AMOUNT(ISTD,x)

• AMOUNT(i,x) = F(RESPONSE(i,x)) ∗ (DILFAC(x)/WEIGHT(x)) ∗
                         RSP-FACTOR(i) ∗ FACTOR_IS(x)

Description:

F: Calibration function
X(i,k): X-coordinate of a calibration point for peak i for the

standard sample k
Y(i,k): Y-coordinate of a calibration point for peak i for the

standard sample k
k: Calibration sample
x: Unknown sample (analysis sample)
RESPONSE(i): Reference variable (Int.Type; i.e. Area, Height, CE-Area)

of peak i in a sample
RESPONSE(ISTD): Reference variable (Int.Type; i.e. Area, Height, CE-Area)

of the corresponding ISTD peak of a sample
AMOUNT_NOMINAL(i): Amount of peak i from the peak table for the standard

sample k
AMOUNT_NOMINAL(ISTD): Amount of the ISTD peak from the sample list (Sample

Amount) for the sample k
AMOUNT(ik): Calculated amount of the peak i for the sample k
WEIGHT: Sample weight of a sample
DILFAC: Dilution factor of a sample
INJECTVOL: Injection volume
REFINJECT: Injection volume of the first sample in a calibration series
RSP-FACTOR(i): Response factor of the peak i from the peak table
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 Implementation
To perform a calibration, user input is required as follows.

Sample List

• The available standard samples are entered in the  Sample List, similar
to unknown samples.

• Input can be automated via the  Sequence Wizard.
• Then, each sample in the sample list can be converted into a standard

sample by assigning the ¾Sample Type STD. Please note that the position
(line number) in the sample list determines the order of processing. If a
standard sample is to be injected several times, a separate line for each
injection is created in the sample list.

• In the Method column, specify the quantification method to be used for
evaluating the sample.

• Input in the remaining fields of the sample list is analog to each unknown
sample (Position, Injection Volume, ...).

• For a detailed description of the procedure, see How to ...: Actions in the
Browser  Creating a Sample List.

Quantification Method (QNT Editor)

• Open the worksheet General and check the current settings. Define the
calibration⇒ Mode to be used.

• Enter the names and the retention times of the peaks to be determined on
the Peak Table sheet. If a processed sample refers to a QNT file with an
"empty" peak table, the peak table can be automatically filled with the
retention times of the integrated (!) peaks after the analysis by executing
the Autogenerate Peak Table command. Each peak contains a
successively numbered default name.

• Enter the amount values of the standard substances in the amount
columns. Determine the standard method, the calibration type, and the
integration type for the calibration.

• Determine the standard method, the calibration type, and the integration
type to be used for the calibration.

• For a detailed description of the procedure, see How to ...: Actions in the
Browser  Creating a Peak Table.
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Validation and System Wellness

Validation

Analysis data from various workstations or laboratories can only be compared if
it is possible to determine the quality of the results that were produced with a
chromatography system.

Validation (Definition)
The process ensuring that a system and its analysis procedures supply
reproducible and reliable results is referred to as validation. This includes
procedures guaranteeing the optimum technical condition of instruments
(hardware and firmware) and of computers (hardware and software), especially
regarding planning, implementing, and documenting a method. Validation is
thus an integral part of ¾Good Laboratory Practice (GLP).

When is validation necessary?
Instruments should be validated before bringing them into service and in
regular intervals. This especially applies after exchanging wear parts, repairs,
or complete replacement of an instrument. Also following a software update,
the system must be validated.

Besides, the Data System itself should be validated at least following an update
using the ¾Installation Qualification and ¾Operational Qualification.

¾Quantification Methods (QNT Methods) and ¾PGM Files should be validated
before they are used in daily laboratory procedure. As the quantification
method changes when modifying single parameters, validation is also
necessary in the daily routine.

The SST tab in the ⇒QNT Editor allows you to define ¾System Suitability
Tests for checking whether your quantification method and your program file
are suitable for analyzing special samples.
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How is validation performed?
At startup, many instruments perform an automatic self-test, ensuring optimum
function. For example, automatic spectra calibration via the ¾Holmium Oxide
Filter is performed on the Dionex Photodiode Array Detector UVD340S after
each startup.

First, the focus of an analysis procedure is on  Calibration as described
above in detail. Within the scope of validation checking, calibration is important:
The precision, detection limits, dynamic work range, and robustness of a
procedure and the involved components are to be determined using
¾Validation Samples, ¾Blank Run Samples, ¾Matrix Blank Samples,
averaging, normal distribution, outlier tests, detection of statistical and
systematic errors, ¾Correlation Coefficient, ¾Standard Deviation, ¾Relative
Standard Deviation, etc. .

The Dionex Chromatography Management System offers numerous options to
meet all GLP and validation requirements. See the topics below for details:

 Installation Qualification Manager
 Log File CMSetup.log
 Operational Qualification of the Dionex Chromatography

     Management System
 System Suitability Test (SST)

Further modules are currently under preparation and will be available in future
versions of the Dionex Chromatography Management System.

 Installation Qualification Manager
The program CMIQ.EXE located in the IQ directory of the Dionex
Chromatography Management System is referred to as Installation
Qualification Manager. Following each update of the Dionex Chromatography
Management System, this program automatically checks the current installation
(¾Installation Qualification). This check can be started manually as well.
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Activating CMIQ.EXE Automatically
After copying all files and completing the Setup, the program is automatically
activated. CMIQ.EXE generates an ASCII report that can be read using the
Windows Notepad or any other word processor. The report in the file
CHKSETUP.log contains information on:
• The system (time, computer name, user name, operating system,

processor)

• The Dionex Chromatography Management System (version, Setup date,
Setup operator, ¾Key Codes, serial number, number of installed
¾Timebases, status of installed software modules)

• All copied files (file name and path, file version, date of last modification
date, file size in bytes, product version, 32-bit check sum)

The data is compared to the data in a write-protected list (IQDATA.dat)
supplied with the Setup. If the lists are identical, successful installation of the
Dionex Chromatography Management System is confirmed. As soon as there
are differences, the Dionex Chromatography Management System issues a
warning or error.

If a warning is displayed, the functionality of the Dionex Chromatography
Management System should not be affected. You can start the Dionex
Chromatography Management System as usual.

If any problems occur, please contact the Dionex Service. The same applies if
the Dionex Chromatography Management System reports an error.

Activating CMIQ.EXE Manually
Especially after installing or updating other software packages, it is possible
that specific system files (DLL) used by several programs are overwritten.
Thus, they impair the functionality of the Dionex Chromatography Management
System.

In this case, it can be useful to open the program outside the Setup routine via
the Installation Qualification command of the Qualification menu.

 Tip: For a correct system check of all files all applications must be
closed (not just modules of the Dionex Chromatography
Management System). Do not forget to close the ¾Server and
the ¾Monitor Program of the Dionex Chromatography
Management System.

There are three options:
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Check Installation: Checks the files of the current Dionex Chromatography Management
System version and the required Windows system files. Type and
scope are freely selectable.
Normal: Checks the Setup.
Extended: Compares the installation with the stored status

(see Save System Status). The scope of the report
is freely selectable.

Full: Checks and reports all files.
Short: Checks all files. The report includes only errors and

warnings.
System Information: Generates the system info of your Dionex Chromatography

Management System
Save System Status: Saves the current system status.

Use this option to save the names and the versions of all files
contained in the Windows System directory and in the BIN directory
of the Dionex Chromatography Management System.
If you performed this option once, the saved system status can be
used as the basis for the file check (see Check Installation /
Extended) instead of the IQDATA list.

 Log File CMSETUP.LOG
The entire information on the system and the operations performed by the
Setup is logged in the file CmSetup.log. The file is first saved to the Windows
installation root directory and is moved to the main directory of the Dionex
Chromatography Management System after successful completion of the
Setup.

This file includes the information by whom and when the installation was
performed, which files were copied and which files did other files with the same
name replace. The latter is especially important to find out which default reports
or ¾Control Panels were replaced.

 Operational Qualification of the Dionex Chromatography
    Management System
Within the scope of the Instrument ¾Operational Qualification, it is important to
prove the functionality of your instruments. The purpose of the Dionex
Chromatography Management System OQ is to prove that the software
functions according to its operating specification in your specific working
environment. The software regenerates data from special files and reevaluates
them. These newly calculated results are then compared to the data generated
by the manufacturer.
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Select the Chromeleon OQ or PeakNet OQ option in the Qualification menu
to start the operational qualification of the Dionex Chromatography
Management System from the ¾Client. A ¾Wizard guides you through the
process so that the OQ runs almost automatically. Below please find the steps
that must be performed:
• Establish a connection to the local ¾Server PC.
• If the server is running and a process is active, the user will be prompted to

terminate the current process. Otherwise the qualification cannot be
performed. If the server is running and no process is active, the server will
be stopped.

• Load the server configuration CM_OQ.CFG which is required for the OQ:
Dionex P580 LPG (¾Demo Mode)
Dionex GINA 50 (demo mode)
Dionex UVD 340S (demo mode: read).

• The demo mode allows you to simulate all program commands that are
available for the selected instruments. Besides, special files are available
for the UV detector from which new raw data are generated. Depending on
the set measuring parameters the data provided in the demo files are
processed in the same way as the data acquired from a real sample.

• Restart the local CM server with the new configuration CM_OQ.CFG being
loaded.

• Select the source directory that holds the sequence template CM_OQ.seg
and specify the target directory for saving the OQ results. Afterwards start
the OQ, which will now run automatically.

• The seven samples of the sequence will be processed. The resulting raw
data are evaluated with the ¾Report Template CM_OQ.rdf. The results can
be printed automatically. If you did not select the option to print the results
automatically when specifying the target directory for saving the results on
the respective page of the wizard, the report can be printed via the function
Batch Report in the File menu of the browser. This ensures that all pages
are updated.

• Finally, the wizard will stop the server and reload the configuration that was
used before the OQ was started.
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For further information, see the following topics:

 Preconditions for the Chromeleon/Peaknet OQ
 Documenting the Chromeleon/PeakNet OQ

For performing the operational qualification of the Dionex Chromatography
Management System, see

How to ...: Actions in the Browser  Performing the
Chromeleon/PeakNet OQ

 Preconditions for the Chromeleon/PeakNet OQ
The operational qualification of the Dionex Chromatography Management
System can be performed both, for pure ¾Client PCs and for ¾Server PCs.
Connect the ¾Datasource which is available on the CD to the Client. You can
either use the original datasource from the CD or a copy saved on any drive.

The logged on user must have the right to start and stop the server of the
Dionex Chromatography Management System and to start its client. Without
having those rights, he cannot perform the operational qualification of the
Dionex Chromatography Management System automatically using the wizard.
(User rights are assigned via the membership of the user in the respective
¾Privilege group. For further information on access rights see the CmUser
Online Help if this program is installed on your PC.)

If the logged on user does not have the right to start and stop the server of the
Dionex Chromatography Management System, he must at least be entitled to
define its configuration and to start its client. For information on how to
proceed, see How to ...: Actions in the Browser  Performing the
Chromeleon/PeakNet OQ Manually.

If the logged on user is not allowed to define the configuration of the Server, he
cannot perform the operational qualification of the Dionex Chromatography
Management System.

For further information regarding the operational qualification of the Dionex
Chromatography Management System, see

 Operational Qualification of the Dionex Chromatography
     Management System

 Documenting the Chromeleon/Peaknet OQ

For performing the operational qualification of the Dionex Chromatography
Management System automatically, see
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How to ...: Actions in the Browser  Performing the Chromeleon /
PeakNet OQ Automatically.

 Documenting the Chromeleon/PeakNet OQ
The Report (Printer Layout) CM_OQ.RDF contains nine pages:
1. Current_Formula
2. Current_CM
3. Reference_CM
4. Reference_CM_vs_Current_CM
5. Current_Formula_vs_Current_CM
6. General_Information
7. Report_Formula
8. Report_CM
9. Difference_Report

If the report is printed automatically or via the batch report, pages 6 to 8 will be
output. All other pages are for calculation purposes only, but can be printed as
well.

Two different tests will be performed: 1. The results of the calibration parameter
test are indicated on page 7 Report_Formula. 2. The results of the function
test are given on page 8 Report_CM.

Test 1: On the first page, Current_Formula, all parameters required for a
⇒Calibration Type are calculated  (Calibration Type: Linear with Offset,
⇒Integration Type: Area,  Standard Method: External, ⇒Calibration Mode:
Total). Some calibration coefficients are calculated with the ¾Functions of the
¾Report Publisher. The fifth page, Current_Formula_vs_Current_CM,
compares the ¾Calibration Coefficients that resulted from the calculations in
the Dionex Chromatography Management System to those resulting from the
calculation with the documented formulas. TRUE is indicated if the values
correspond to each other within the limits of the comparison format described
on the ninth page, Difference_Report. Otherwise, FALSE will be given. The
above is performed for each substance. The results of the comparisons are
transferred to the seventh page, Report_Formula, where TRUE is replaced by
Ok and FALSE by Deviation. The whole test is evaluated either as "passed"
(there is no deviation for any of the variables) or as "failed" (there is a deviation
for at least one variable).

Test 2: On the second page, Current_CM, the measured values are evaluated
with the functions implemented in Dionex Chromatography Management
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System. The third page, Reference_CM, shows the numerical values that were
calculated by the manufacturer during the validation of the respective version.
On the fourth page, Reference_CM_vs_Current_CM, the newly evaluated
parameters are compared to the values received from the manufacturer. The
used comparison format is described on the ninth page, Difference_Report.
TRUE is indicated if both values correspond to each other within the limits of
the comparison format. Otherwise "FALSE" is given. The above is performed
for each sample. On the eighth page, Report_CM, each parameter is given
only once. If the fourth page, Reference_CM_vs_Current_CM, shows TRUE
for all samples, the respective parameter is Ok. In all other cases, Deviation
will be indicated. Again, the result of the whole test is either "passed" (there is
no deviation for any of the variables) or "failed" (there is a deviation for at least
one variable).

The sixth page, General Information, provides information on the used
version as well as on the computer and the user names.

For further information on the operational qualification of the Dionex
Chromatography Management System, see

 Operational Qualification of the Dionex Chromatography
     Management System

 Preconditions for the Chromeleon/PeakNet OQ

For performing the operational qualification of the Dionex Chromatography
Management System, see

How to ...: Actions in the Browser  Performing the Chromeleon /
PeakNet OQ
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 System Suitability Test (SST)
Checking whether the quantification method and the ¾PGM File are suitable
for analyzing special samples is by defining ¾System Suitability Tests (SSTs)
on the SST tab in the ⇒QNT Editor. (For further details, see How
to ...: Actions in the QNT Editor  Defining the System Suitability Test.)
The System Suitability Test can already be performed during chromatogram
recording. The corresponding QNT method needs to be available in the sample
list (in the Browser). Defining Abort Batch as Fail Action allows aborting the
sample ¾Batch automatically if a test condition is not met.

 System Wellness: Overview

What is System Wellness?
System Wellness monitors the overall "health" of a chromatographic system. It
provides built-in diagnostic and calibration features that help prevent
unscheduled system shutdowns and assure reliable operation of system
devices. Calibration and diagnostic commands are available from Wellness
control panels and Help topics are provided for performing the various tasks.

Supported Devices
For System Wellness support, a device must be connected to the Dionex
Chromatography Management System via the DX-LAN and it must have a
version of ¾Moduleware installed that supports System Wellness. The
following devices are supported:

Device Moduleware Version
Required

IC Pumps
GP40 / IP20 3.46 (or higher)
GP50 / IP25 3.46 (or higher)
GS50 / IS25 1.00 (or higher)
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Device Moduleware Version
Required

Detectors
AD25 1.02 (or higher)
CD20 / ED40 3.05 (or higher)
CD25 / ED50 1.05 (or higher)
CD25A/ED50A 1.00 (or higher)
PDA-100 1.04 (or higher)

¾Autosampler
AS50 1.05 (or higher)

¾Eluent Generator
EG40 2.23 (or higher)

System Modules
IC20 3.08 (or higher)
IC25 1.04 (or higher)

        IC25A 1.00 (or higher)

System Wellness Features
• System Wellness control panels, which allow easy access to diagnostic

and calibration commands and data
• Download of current, previous, or factory calibration data
• Leak detector testing and calibration
• Wavelength verification and calibration for UV and PDA detectors
• Cell calibration for conductivity detectors
• pH calibration for amperometry detectors
• Pressure offset and degas calibration for pumps
• Flow rate calibration for pumps

For instructions on setting up and using System Wellness features, see

How to ...: Actions in the Browser  System Wellness
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Data Reprocessing

Definition: Data Reprocessing

Data reprocessing is the presentation of raw data under various aspects. This
includes the simple display of an integrated chromatogram, peak purity
analysis, representation of calibration curves, or searching single spectra in a
spectra library.

Each operation is displayed in a separate window. Opening a partial method
is also mentioned in this context. Each partial method is intended for one
specific task and has its own window arrangement and menu structure. The
Dionex Chromatography Management System features the following partial
methods that are described in separate chapters:

 Integration
 Calibration
 Printer Layout
 Peak Purity Analysis
 Spectra Library

In addition, the  Quantification Method (QNT Editor) that is required for
evaluating a sequence can be considered part of data reprocessing. The
reason for this is as simple as sensible:

If the detection and peak table parameters chosen in the QNT method prove to
be inappropriate after the analysis, the parameters can be changed without
requiring a new analysis of the corresponding samples.

All modifications are immediately and globally effective, i.e. modified
variables are immediately re-calculated. The new values are displayed on the
screen.

If the modified quantification method is saved, the results of all samples using
this method will be adjusted.

 Caution: The automatic offline batch necessary in the data system
"GynkoSoft" is no longer required! The entire data is always
updated and displayed.
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QNT Editor

Quantification Method (QNT Editor): Overview

In the Dionex Chromatography Management System, all instructions and
parameters representing the basis of calculation for the sample evaluation are
included in the Quantification Method (QNT file). This refers for example to the
following questions:

• Below which height, width, or area a peak will be ignored?

• Which course has the baseline?

• Which peaks are classified as ¾Riders?

• What is the ⇒Amount of the standard samples?

• Which ¾Calibration Function is used for creating a calibration curve?

• Which peaks are identified by name?

Before the actual analysis, these evaluation parameters are defined in the
Quantification method (QNT file).

• Select File / New / Method File to generate a new QNT file.

• Alternatively, select a sequence in the Browser and double-click the
corresponding QNT file to open it.

• To open the QNT editor from a method file, click the QNT Editor icon on
the toolbar. This allows you to view the QNT file data of the current sample.

The QNT editor is divided in two window sections. The upper section serves for
information purposes. To create a QNT file, use the lower window section, only.
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Upper Window Pane
The upper section serves to display additional plots:

• Choose Show Chromatogram or Show Calibration Curve from the View
menu to enable or disable the display of the chromatogram and/or the
calibration curve.

• Press the F4 key/Shift+F4 or choose the Next / Previous Chromatogram
option (in the File menu) to toggle between the chromatograms of the
individual samples.

• Choose Show Spectra to enable or disable the display of the spectrum of
a single peak.

Of course, representation is only possible for chromatograms, spectra, and
calibration curves of samples that were already analyzed.
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Lower Window Pane
The lower window pane serves to determine the evaluation parameters.

• By selecting a specific tab in the lower left corner, a worksheet is opened,
similar to Microsoft Excel.

• The user can freely select the names of the worksheets. Double-click the
corresponding name, and enter a new name in the edit dialog box.

Below it is assumed that the default names have not been modified. The
following worksheets described below are available:

 General
 Detection
 Peak Table, Amount Table, Peak Tracking, and MS Tracking
 Calibration
 Spectra Library Screening
 System Suitability Test

 Mass Spectra (MS)

 Tip: These topics describe the structure and functions of the
individual worksheets. For detailed information on how to enter
data, see How to ...:   Actions in the QNT Editor section.

 General

The sheet contains global settings for the worksheets  Peak Table
("Retention Time Settings"), Amount Table ("Amount Interpretation"), and

 Calibration ("Global Calibration Settings"). Use the Title field to enter a
name for the current QNT file. The name appears in the Browser and can be
included in a Report when printing data of the QNT editor. The Unidentified
Peaks button allows you to determine how to quantify unidentified peaks.
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Retention Time Settings

• Select the check box Use Recently Detected Ret. Times, if the
⇒Retention Time of the preceding sample should be used when identifying
a peak via a retention time window (⇒Window). You can also use the
retention time of the last standard. The button Option provides further
options. (For details see ⇒Use Recently Detected Retention Time). This
function allows the system to automatically react to changing retention
times, e.g. due to column trends. If the option is disabled, the actually
determined retention time listed in the peak table is used for identifying the
peak.

• Enter the ⇒Dead Time in the field Dead Time. This time is used for
calculating the ¾Capacity Factor k' and the ⇒Kovats Indexes.

Delay of 2nd Detector
• Select the name of the second detector in the Detector Name field.

• Enter the delay time in the ⇒Delay Time field (also, see  Defining the
QNT Method for Several Detectors).
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Amount Interpretation
• For documentation purposes (exclusively), the physical dimension (amount

or concentration) that is used for the amount values can be included in the
field ⇒Dimension of Amounts. Amount values are not automatically
converted into concentration values or vice versa.

• In addition, the reference injection volume is defined on this page. Either
select the injection volume of the first standard (Use inject volume of first
standard) or enter any volume via Fixed.

Global Calibration Settings
• Use the Mode field to determine how and based on which ⇒Calibration

Mode the samples of a sequence are calibrated. This allows, for example,
calibrating certain samples as a group or including calibration samples for
samples that are analyzed later.

• When Auto Recalibrate is activated, each modification within a
chromatogram (e.g. moving peak delimiters) results in an automatic
recalculation of the ¾Calibration Coefficient as well as all derived
calibration data. If you deactivate Auto Recalibrate in your peak table so
that the c0, c1, and/or c2 columns are included, re-calibration is preformed
by pressing the Calibrate button. Nevertheless, the corresponding values
can be entered manually as well.

Blank Run & Matrix Blank
Use the section Blank Run Subtraction on the General sheet of the QNT
editor to determine whether the absorption values of a ¾Blank Run Sample are
considered (= subtracted) in the sample evaluation (= ¾Blank Run
Subtraction). You can also subtract the results of a single ¾Matrix Blank
Sample.
• Select No Blank Run Subtraction if no correction is to be performed.
• Select Subtract Recent Blank Run Sample in Corresponding

Sequence to use a finished blank run sample of the current sequence for
the subtraction. The chromatogram of the blank run sample is subtracted
point by point from the current chromatogram.

• Select Subtract a Fixed Sample to perform the correction with any
sample. Choose Browse to search for the sample.

• Enable Matrix Blank Subtraction activates the subtraction of matrix blank
samples. Contrary to the other options the resulting peak areas or peak
heights are subtracted.
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 Detection Parameters (Detection)
Detection parameters serve e.g. to recognize, classify and suppress peaks as
well as to determine the baseline.

The default values are normally suitable for optimum integration of 90% of all
recorded chromatograms.

In critical cases, e.g. with wavelength switching, the user can improve the
integration results by modifying the parameters.

Detection parameters are time-dependent. Each parameter can be activated,
deactivated, or changed in its value at a specific time. The time when the
parameter shall change, the parameter name and its value are entered in the
corresponding column of the first line. It is possible to change a parameter
several times in succession.

Detection parameters are defined in the QNT editor. You can either enter them
in the table of the Detection tab or define them graphically in the
chromatogram.

In the example above, integration is inhibited (command: ⇒Inhibit Integration)
at the time t = 0.000 (On). After three minutes (t = 3.000), integration is
activated again (Off). It is also stipulated that peaks with a minimum area of 1 x
[Signal] *min only are recognized as peaks.

The last defined value of each parameter is valid until the sample run is
completed. After that, the parameters assume their preset (default) values.

The ¾Channel column indicates whether the settings are valid for a specific
channel (as in this example) or for all channels.
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For further details and examples of possible detection parameter modifications,
see How to ...: Actions in the QNT Editor  Defining Detection
Parameters and ⇒Detection Parameters (Overview).

 Peak Table, Amount Table, Peak Tracking, and MS
Tracking
The peak table contains all parameters required for identifying a peak and to
determine the amounts of the substances serving as standards. The peak table
contains 26 columns (the Amount, C0, C1, and C2 columns are duplicated
according to the number of different standards) and is therefore spread over
three tabs: Peak Table, Amount Table, and Peak Tracking. Individual
columns and whole pages can be faded in and out.

Creating the peak table is usually performed manually, i.e. the user enters the
names and retention times of the expected peaks. Peaks that serve as
standards must be labeled accordingly in the ⇒Standard column. The (known)
concentration of a standard is included as ⇒Amount value in the Amount
column of the table. The values form the basis for any type of calibration.

Via the Autogenerate Peak table command of the Edit menu, it is possible to
automate the creation of the peak table. Two different types are available. If
Enumerate peaks of current chromatogram is selected, the system includes
all peaks integrated (!) in the current sample in the peak table. As peak name,
a combination of sequence name and consecutive number is assigned.

When reference spectra were found via  Spectra Library Screening, you
can also use these for automatic peak table creation. Choose the type Use
Spectra Library Screening results. In both cases, the values for the
Retention Time and Window columns are recalculated. Default settings are
used for all other entries (see How to ...: Actions in the QNT Editor

 Autogenerating the Peak Table’ by Including Library Screening
Results).

 Caution: All previous entries are overwritten and lost when saving the
peak table or the QNT file!

For detailed instructions, see How to ...: Actions in the QNT Editor
 Creating a Peak Table
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Peak Identification / Peak Tracking and MS Tracking
Peak identification refers to the following procedure: a previously unknown
peak is recognized due to peak-specific properties (e.g. the retention time or its
UV spectrum) and is then labeled with a characteristic substance name.

Most frequently, peaks are identified via their retention time. If the user knows
the exact retention time of a peak, the retention time is entered together with
the Substance name in the corresponding columns of the peak table. If a peak
is detected at the specified time, the name is automatically assigned (Fig. a).

Even if there are retention time fluctuations or neighboring peaks, identification
is possible. This is enabled by a tolerance range defined via the ⇒Window
peak table parameter (fig. b). If a peak is detected within the tolerance range, it
is identified, even if the set (nominal) and the actual retention time do not
match exactly (fig. c). If several peaks are detected within this range, the data
system identifies the "greatest," the "first" or the "nearest" peak, depending on
the selected extension for the window parameter (fig. d).

Tret (g)

Tret (n)

Tret (f)

Tret

a) b) c) d)

peak name window

set

actual

The retention time value previously entered in the peak table is corrected
accordingly!

Another method to identify peaks is offered by the UV spectrum. For
identification purposes you can either use the Spectrum only or the spectrum
and the retention time (Spectrum and time). A photodiode array detector (e.g.
Dionex UVD 320S or UVD 340S) is required for this elegant and very reliable
method. The substance spectrum is recorded for each peak and is compared
to the spectra in a library based on certain criteria (see How to ...: Actions in
the QNT Editor  Peak Tracking). If the spectra match, the peak is
identified.

If you use an aQa ¾Mass Spectrometer, peaks can also be identified based on
¾Mass Spectra. Mass spectra present a very reliable method for peak
identification. The MS Tracking tab allows you to select different options as
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described under How to ...: Actions in the QNT Editor  Identifying Peaks
via Their Mass Spectra (MS Tracking).

Calibration / Amount Table
In a calibration, the peak area of a known amount is determined. Then, the
result is used for calculating the amount of an unknown sample via the
area/amount ratio.

For this method, not only the peaks serving as standard substances and the
amount of the corresponding standard samples are required, but also a
mathematical procedure that determines how a generally valid ratio is
established from the area/amount of few standard samples.

This is performed via the Amount, Standard, Cal.Type, and Integration Type
columns in the Amount Table. For a detailed description of the columns and
instructions on the input required for the columns, see How to ...: Actions in
the QNT Editor  Creating a Peak Table.

 Tip: Background information on calibration is available in the chapter
 Calibration.

 Calibration Settings (Calibration)
In the simplest case of a chromatographic analysis, first one or several
standard samples and then the unknown samples are analyzed. All samples of
a sequence are evaluated based on the same standard samples. If the quality
of the column changes between processing the first and the last sample, this
will not be considered.

Therefore, the Dionex Chromatography Management System allows evaluating
samples via specific patterns or based on any selected standard samples. This
is determined via the ⇒Calibration Mode on the General sheet of the QNT
Editor.
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The Calibration sheet indicates which standard samples will be used for
evaluating the current sample of a sequence. When changing from the current
sample to another one via F4 or SHIFT+F4, the list of the displayed standard
samples is updated again.

If you notice that a specific standard sample falsifies your calibration results,
you can deactivate this sample in the Enabled column. The standard sample is
then excluded from the calculation. The corresponding calibration points are
then highlighted in the curve by a different color.

 Spectra Library Screening
To identify substances, spectra can be compared to library spectra. The
spectra search can be performed via the Spectra Library Screening sheet of
the QNT Editor.
For details on how to perform spectra library screening, see How
to ...: Actions in the QNT Editor  Spectra Library Screening.

 System Suitability Test
The aim and objective of the ¾System Suitability Test (SST) is to ensure that
the operational conditions required for a specific measurement are achieved.
Specify the conditions for the SST on the SST tab in the QNT Editor.

For details on how to perform System Suitability Testing, see How
to …: Actions in the QNT Editor /  Defining the System Suitability Test.

 Mass Spectra (MS, MS Tracking)
Acquiring mass spectra with your Dionex Chromatography Management
System is possible provided a Finnigan aQa ¾Mass Spectrometer mass is
installed. For further information on how to install the spectrometer and acquire
data, see How to ...:  Actions Related to the aQa-MS.
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In HPLC MS, mass spectra especially serve for peak identification. Using mass
spectra for identifying substances is via the MS Tracking tab. For details, see
How to ...: Actions in the QNT Editor  Identifying Peaks via Their Mass
Spectra.

As MS chromatograms normally show heavy noise ¾Mass Spectra need to be
processed before being used. On the MS tab, define the number of single peak
spectra to be averaged. Also, define how many background spectra shall be
aggregated into a total background spectrum that is then subtracted from the
averaged peak spectrum.

For details, see How to ...: Actions in the QNT Editor  Processing Mass
Spectra



162 QNT Editor



Integration 163

Integration

Overview: Integration

The chromatographic process of converting peak areas below peaks in amount
or concentration values is referred to as integration.

The integration is performed based on the  Calibration. It supplies a
calibration curve and a ¾Calibration Coefficient.

Inserting the calibration coefficients in the ¾Formula for Amount Calculation
supplies the amount concentration in a single peak area. The data system
automatically performs this process for all peaks it "finds."

A

A A

Integration

Standard sample/~s
(known amount)

Analysis sample/~s
(Amount = ?)

Determine
peak area

Determine
peak area

   Amount
Substance A

Calibr. Curve /
Calibr. coeff.

Calibration

How many peaks are detected and whether at least part of these peaks can be
identified, depends on the  Quantification Method (QNT File) specified for
each sample before the analysis. 
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The results of the area calculation and peak identification processes are
represented graphically (chromatogram) and as a table (Report) in the window
of the partial method Integration.

For further details and features, see the following topics:

 Opening a Sample
 Operation
 Manual Re-Integration
 Chromatogram Comparison
 Data Smoothing
 Peak Ratio
 Spectra Plot
 Mass Spectra Plot

 Opening a Sample
Opening a sample automatically opens the integration method window and
displays the sample chromatogram. There are three options:

• Select a sample via the Open command of the File menu, or

• Double-click a sample of a specific sequence in the ¾Browser, or

• Select a sample in the Browser and select a channel of the sample via the
Open command of the context menu (right mouse button).

Usually, you will open samples that have been completely processed.
However, samples can be opened as well while being analyzed, i.e., while
being in Running ⇒Status. A certain amount of data must have already been
acquired in a running sample. Depending on the ⇒Step and other detector
settings the sample must have run for up to several minutes. A running sample
can be opened either
• From the Browser (via different options - see above) or

• From a ¾Control Panel via the Integrate command of the View menu.
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 Operation

Modifying the Appearance
Each displayed chromatogram can be changed by enabling/disabling the
display of various elements and by modifying them.

• Double-click a peak to see its Peak Properties.

• Draw a frame around the section of the chromatogram you want to view
enlarged.

• Select the Decoration ... command in the context menu (right mouse click)
to modify the window background, the different axes, the layout of
individual peaks as well as the color, shape, and size of their captions.

• Activate the Spectra Tool command in the context menu (or press the
corresponding icon in the Integration Toolbar (topic available in the Online
Help only)) to view the spectrum from the chromatogram at the time t. As
soon as the spectrum symbol is added to the mouse cursor, clicking any
position will extract a spectrum that is displayed in the Spectra Plot
window (if the corresponding data exists). A minimized representation of
the spectrum itself is displayed in the integration window. Repeat the
operation while pressing the SHIFT key to overlay single spectra.
Alternatively, choose the Overlay Spectra command in the context menu.
Hide Time Spectra will remove overlaid spectra again.

Opening Additional Window Sections
Using one of the following commands displays further window sections:

• Perform the Split Zoom command from the View menu to split the window.
By drawing a frame, you can zoom a section of the window. The upper half
of the window shows the entire chromatogram and the frame, the lower half
displays the zoomed section. Use the mouse to move and position the
frame in the upper window section. This mode is recognized by the shape
of the mouse cursor ( ). Of course, a new frame can be drawn any time.

• Select the Report command from the View menu to display the integration
report (see  Integration/Integration Report).

• Choose the Show Spectra command from the View menu to display the
peak spectrum of the currently selected peak (see  Integration/Spectra
Plot).
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• Compare two chromatograms by enabling the display of an additional
chromatogram (see  Integration/Chromatogram Comparison).

 Manual Re-Integration
The Dionex Chromatography Management System largely automates sample
integration. In special cases, the user may prefer to perform manual
modifications. The Dionex Chromatography Management System therefore
allows manually moving peak delimiters, inserting, and deleting peaks, or
modifying the baseline, etc.

If the Automatic Tool is selected via the context menu, these alterations are
possible directly in the chromatogram. The shape of the mouse pointer
indicates the performed operation.

  Move left / right peak delimiter

    Change baseline point (left / right / center)

    Move baseline point (left/right/center)
Move
Move baseline segment
Move ⇒Detection Parameter

Insert peak
Zoom out an area

Display spectrum
Operation not possible

Use the individual commands such as Baseline Tool, Insert Peak Tool, or
Zoom Tool, if you only need a specific scope of functions. For details on the
possible operations see

How to ...: Actions in the Chromatogram  Manual Re-Integration.

 Tip: If manual modifications are performed, the numeric result can be
seen when displaying the  Integration Report.

 Chromatogram Comparison
When comparing two or more samples or chromatograms, comparing their
numerical results would be the most exact method. However, overlaying the
chromatograms is in many cases sufficient. This is performed via the
chromatogram comparison.
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What can be compared?
Chromatogram comparison always compares individual channels. Whether
these channels are from the same or from different samples, is irrelevant. The
number of simultaneously displayed chromatograms in the Dionex
Chromatography Management System is theoretically not limited.

As the presentation becomes confusing with an increasing number of displayed
chromatograms, the Dionex Chromatography Management System prompts
the user to confirm whether to display more than 20 chromatograms. This
prevents the display of chromatograms due to an operator error and a resulting
decrease in system performance.

How are chromatograms compared and displayed?
A comparison is performed by displaying the chromatograms in the integration
window. One chromatogram represents the currently active chromatogram. It is
selected with the mouse. It can be recognized by the displayed additional
information (decoration etc.). The names of all represented chromatograms are
listed above the window. The currently active chromatogram is marked by a
different color. Click the name of any chromatogram to select it as the active
chromatogram.

The presentation of the window and the active chromatogram is controlled via
Decoration of context menu.

How do I select the chromatograms or channels to be compared?
There are various ways to select one or several chromatograms.

• Select one or several samples in the Browser and drag them into an open
integration window. The Dionex Chromatography Management System
automatically attempts to load the ¾Channel of the current sample. If this is
not possible, e.g. because the channel does not exist, the default channel
is loaded. The default channel is the first channel in the list when opening a
sample (Open command of the context menu in the Browser).

• Choose the Add Overlay ... command from the File menu to display a
specific channel of any sample in an opened integration window.

• To compare all channels of a single sample choose the command
Open / All Channels.

• Choose the Compare command to compare a specific channel in several
selected samples.

• Perform a query to specifically compare samples with certain properties.
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• Click the Next Chromatogram icon ( ) while holding down the CTRL key
to additionally display the chromatogram of the next sample.

• Click the Previous Chromatogram icon ( ) while holding down the
CTRL key to additionally display the chromatogram of the previous sample.

• Click the Next Channel icon ( ) while holding the CTRL key to
additionally display the next channel of the same sample.

• Click the Previous Channel icon ( ) while holding the CTRL key to
additionally display the previous channel of the same sample.

For details on selecting chromatograms / channels to be compared, see How
to ...: Actions in the Chromatogram  Performing a Chromatogram
Comparison.

Placing chromatograms and channels in relation to each other
The appearance of a chromatogram is determined considerably by external
influences such as flow rate, solvent, column quality, detector amplification etc.

As these conditions cannot be modified later, other possibilities must be found
to perform the comparison as exact as possible. This is achieved by adapting
the position and the size of a chromatogram to match another. The Dionex
Chromatography Management System offers several options:

• Chromatograms can be assigned an offset in x- and y-direction

• Chromatograms can be time-normalized, i.e. they can be overlaid at a
specific retention time

• Peak height can be normalized, i.e. the height of a specific peak can be
adjusted

• Chromatograms can be stretched and compressed

• Chromatograms can be subtracted from each other

For the active chromatogram, the Decoration command is chosen via the
context menu. The settings are entered via the Comparison dialog.

For further details, see How to ...: Actions in the Chromatogram
 Performing a Chromatogram Comparison.
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 Data Smoothing
Data smoothing applies a digital filter to sample data to reduce signal noise and
helps improve chromatogram appearance and reproducibility of peak
baselines. Data smoothing is performed in the integration window (for MS
chromatograms, data smoothing is defined in the ¾PGM File or during ¾Mass
Trace extraction.) After smoothing, the smoothed chromatogram is displayed
overlaid over the original chromatogram. The original sample data file is not
altered and the smoothed data file is stored separately.

Filter Types
The Savitzky-Golay filter smoothes to least-squares fit, using a weighting
function based on second-degree and third degree polynomials. Savitzky-
Golay smoothing is useful for reducing high-frequency noise of a data set that
is continuous (such as a chromatogram) without significantly degrading the
underlying signal.

The Moving Average (= Boxcar) filter is a simple algorithm that produces a
set of output values in which each output value is equal to the average of n
points centered around the corresponding input value, where n represents the
filter size. Because the Moving Average filter equally weights each point, its
ability to discriminate between noise and signal is limited.

The Olympic filter is very similar to the Moving Average filter, except that the
maximum and minimum points of each input data set are rejected before the
average is calculated. This provides better rejection of impulse noise (spikes)
than the moving average filter.

In addition, the Gaussian filter is available for acquiring MS chromatograms
and extracting a mass trace (in the Mass Spectra window). This filter applies
the Gaussian distribution for chromatogram smoothing.

Filter Size
Filter size is the number of input data points used to generate each output data
point. The filter size is an odd number between 5 and 999. Use a narrow filter
size if desired peaks are narrow, and a wider filter size for wider peaks. As a
rule of thumb, select a filter size that approximately equals the peak's half
width. Note that too narrow a filter results in insufficient smoothing while too
wide a filter can lead to distorted data.

 Tip: Distortion of data during data smoothing mainly affects the peak
height. Therefore, it is generally better to evaluate smoothed
chromatograms by area rather than height.
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Iterations
If a filter is applied several times, by far the highest smoothing result (>95%) is
achieved when the filter is applied the first time. Thus, normally a single
smoothing step is sufficient. However, applying a narrower filter multiple times
often provides improved noise reduction without the signal degradation that can
occur when using a wider filter size. This requires additional processing time,
however, so a wider filter size may be preferable if its results are acceptable.

For additional details, see How to ...: Actions in the Chromatogram
 Performing Data Smoothing.

For MS Chromatograms, see How to ...: Actions Related to the aQa MS
 Extracting Mass Traces Afterwards.

 Peak Ratio
If the baseline-corrected signals of two channels (of the same sample!) are
related to each other, a rectangular curve results. This curve is referred to as
peak ratio. It is based on the observation that the ratio between two detector
signals must be constant, as according to the Lambert-Beer law the detector
signal (S) must always be proportional (c1) to the concentration (K) of a
dissolved substance.

S c xK= 1

If the quotient q is formed of the two channels, the substance concentration K
is canceled out. The quotient now only depends on the ratio of the two
wavelengths, not the time.

q
S
S

c
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1
2

1 1
2 2
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If q is entered against the time, the (theoretical) result for each peak of the
sample is a horizontal line of the height c1(λ1)/c1(λ2).

The width of the rectangle is determined by the baseline and the ⇒Peak Purity
Threshold parameter. The ratio formation is only performed where both (!)
peaks have a baseline and where both (!) peaks have intensity above the
defined peak purity threshold. The range to be actually overlaid (= width of the
rectangle) is thus the intersection of the baseline and Peak Purity Threshold
condition. The default Peak Purity Threshold value is 10% of the peak
maximum and can be changed in the QNT editor.
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The rectangle heights of two adjacent peaks differ if the corresponding peaks
have different spectra and if the two wavelengths are selected so that the
absorption quotient is significantly different.

Consider the following limitations and requirements:
• The detector may not drift.

• The correlation only applies to the linear range of the Lambert-Beer law
(<2000 mAU).

• The solvent composition may not be altered (isocratic conditions).

• The solvent only slightly contributes to the absorption. The baseline
correction allows eliminating the solvent absorption.

 Note: A peak ratio can only be formed with the signals of the same
detector.



172 Integration

Forming the Peak Ratio
• Within the integration window, overlay two channels of the same sample

(e.g. by clicking the Next/previous channel icon while holding down the
CTRL key).

• Use the Decoration command of the context menu to open the dialog
Chromatogram Decoration.

• Activate the check box Peak Ratio under Peak Decoration.

In the integration window, a rectangle curve in a different color should appear
in any place where two peaks are overlaid in addition to the two
chromatograms.

Result
A regular rectangle shape, as shown at 12.70min in the illustration, can serve
as a criterion for evaluating the peak purity. The more the curve deviates from
the rectangle shape, the higher the probability that the overlaid peaks do not
originate from the same substance. If the rectangle slightly overshoots on the
right or on the left, this is tolerable due to the lower signal intensity at the peak
start and the peak end.

To express the result of the peak ratio numerically, the Peak Ratio Mean Value
and RSD Peak Ratio report variables are available (in the Online Help only).
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 Spectra Plot

Overview
The Spectra Plot enables the display of UV spectra. The prerequisite for the
spectra plot is the availability of the corresponding raw data. Raw data is
generated by recording a 3D field with a ¾Photodiode Array Detector. The
spectra plot can be opened from the Integration method.

• Open the Spectra Plot window via either the Show Spectra command of

the View menu or the  button.

The representation of a spectrum in the Spectra Plot is usually (height)
normalized, i.e., the height of the spectrum is represented in percent and thus
independent of the concentration (also, see ¾Normalization). As a default, this
normalization is by the greatest relative maximum within the spectrum.

Normalization allows objectively comparing two spectra of different
concentrations. If spectra of the same peak, but from different peak heights are
overlaid, these will generally coincide despite the differences in concentration.

• Use the Decorations command from the View or context menu to
determine via the Frame & Axes tab which type of normalization should be
applied to the spectrum.

The normalized spectra representation allows performing the following tasks:
• Comparing two spectra (e.g. a standard and a sample)

• Determining the number and position of minima and maxima

• Selecting an appropriate type of normalization

• Verifying the linearity of the Lambert-Beer law

• Deciding: Baseline correction Yes/No

• Determining exact integration limits by checking peak purity at various
wavelengths and peak heights

• Identifying components

Displaying Spectra of one Peak
• In the chromatogram window, select the peak for which to display the peak

spectrum (= spectrum in the peak maximum).
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• If several peak heights were activated below Peak Spectra in the
Decoration dialog of the Spectra Plot window, the spectra from different
peak heights are displayed simultaneously when clicking the peak.

Displaying any Spectra of a Chromatogram
Perform the following steps to extract any spectra of a chromatogram via
mouse-click.
• Activate the Spectra Tool command in the context menu (or click the

corresponding icon on the Integration Toolbar (for further information see
the respective Online Help topic). The changed mode will be indicated by a
spectra symbol that is added to the mouse pointer.

• Click anywhere in the chromatogram to view the corresponding spectrum.

• Repeat the operation while keeping the Shift key depressed to overlay
several spectra.

Displaying Spectra of Different Samples
To objectively compare spectra of different samples, proceed as follows:

• Open the Decoration dialog box and select the Peak Spectra tab.

• Select the Retention time spectrum of fixed sample option and navigate
to the desired sample in any sequence via the Browse... button.

• Alternatively, you may also use the retention time spectrum of the last
standard (= Retention time spectrum of recent standard), the reference
spectrum of the peak table (= Reference spectrum in corresponding
peak table), or any spectra that was found during library screening
(Spectra library screening result).

Match Factor, Difference Spectra, and 1st and 2nd Derivative of Spectra
As soon as two or more spectra are represented with the Spectra Plot, a
frequent question is the similarity between the various spectra.

This can be expressed by the Match Factor, the formation of difference spectra
or by representing the first or second derivative of a spectrum.

• Choose the Decorations command from the View or context menu and
activate the Show match check box on the Label tab. The Dionex
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Chromatography Management System issues a value for each represented
spectrum specifying the match degree relative to the main spectrum (0 =
no match; 1000 = perfect match).

• On the Analysis tab choose whether the difference spectrum or the first or
second derivative of a spectrum are displayed in a second window in
addition to the actual spectra.

In the case of the match factor and the difference spectrum, the question which
spectrum is considered a main spectrum is especially important, as this is the
basis of comparison or the basis for all calculations.

Usually, this is the peak spectrum extracted at the retention time. If there is no
peak spectrum, a distinction is made between two situations: If the spectra
were extracted individually from the chromatogram via spectra tool, the
spectrum that is first extracted is the main spectrum. If spectra are
automatically extracted at different peak heights (see Displaying Spectra of
one Peak), the spectrum with the "oldest" retention time is considered the main
spectrum. When representing difference spectra, the entry Difference to ...
indicates the basis of calculation.

Comparing a Spectrum with Spectra of an Existing Spectra Library
To clearly identify a spectrum, it should be compared to a reference spectrum
stored in a spectra library.

• Via the context menu, perform the Library Search command to start the
comparison. The window of the method  Spectra Library lists all library
spectra that have a minimum similarity with the (normalized) spectrum. For
details on performing the library search, see How to ...: Actions in the UV
Spectra and Mass Spectra  Starting a UV Spectra Search.

If the Spectra Plot window contains more than one starting spectrum, the
Dionex Chromatography Management System always uses the spectrum that
is displayed first for the comparison with library spectra.

 Mass Spectra Plot

General
The Mass Spectra Plot enables the display of ¾Mass Spectra. The prerequisite
for opening the mass spectra plot is the availability of the corresponding raw
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data that were recorded by a ¾Mass Spectrometer. The mass spectra plot can
be opened from the Integration method.

• Open the Spectra Plot windows via either the Show Mass Spectra

command of the View menu or the  button.

The representation of a mass spectrum is height normalized, i.e. the height of
the spectrum is represented in percent and thus independent of the
concentration (also, see ¾Normalization). As a default, this normalization is by
the ¾Base Peak of the spectrum.

Normalization allows objectively comparing two spectra of different
concentrations. If mass spectra of the same peak, but from different peak
heights are overlaid, these will generally coincide despite the differences in
concentration. Due to their higher information density, mass spectra are
displayed in the Dionex Chromatography Management System one below the
other, which is contrary to the display of UV spectra that are overlaid.

Displaying Mass Spectra of one Peak

• In the chromatogram window, select the peak for which to display the mass
spectrum (= spectrum in the peak maximum).

• If several peak heights were activated below Peak Spectra in the
Decoration dialog of the Mass Spectra Plot, the mass spectra from
different peak heights are displayed simultaneously when clicking a peak.
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Displaying Mass Spectra of Different Samples
To objectively compare mass spectra of different samples, proceed as follows:

• Open the Decoration dialog box and select the Peak Spectra tab.

• Select the Retention time spectrum of fixed sample option and navigate
to the desired sample in any sequence via the Browse... button.

• Alternatively, you may also use the retention time spectrum of the last
standard (= Retention time spectrum of recent standard), the reference
spectrum of the peak table (= Reference spectrum in corresponding
peak table), or any spectra that was found during library screening
(Spectra library screening result).
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Report

Report: Overview

The report (or better: screen report - contrary to the printer layout that defines
the printout) includes several tables for displaying all relevant data of samples,
sequences, datasources, etc. on the screen. The report is saved in the
⇒Report Definition File together with the printer layout.

The report is opened via either the Show Report command (in the View menu)

or the  button. Usually, it is displayed in the window of the partial method
Integration. Nevertheless, you can have the report displayed in the ⇒QNT
Editor as well to directly check the effects of changes in the QNT method.

You can add, edit, or extend the individual report tables as required. The
following tables are available via the Insert Report command of the Table
menu:

Report Type Description
Audit Trail Shows the  Audit Trail.
Calibration History Documents the course of the calibration.
Calibration Report Shows the calibration report.
Database Query Shows the results of a database query.
Detection Parameter
Report

Shows the �Detection Parameters.

History Report Shows the ¾History report.
Integration Report Shows the integration report.
MS Instrument Info
Report

Provides information on the ¾Mass Spectrometer.

MS Instrument Method
Report

Indicates the MS method.

MS Raw Report Shows the raw data of the current ¾Mass Spectrum.
MS Status Log Report Indicates the mass spectrometer settings.
MS Tune Data Report Indicates the tune data of the ¾Xcalibur raw data file.
Peak Summary Shows the peak summary
Program Report Shows the ⇒PGM File for the current sample.
SST Report Shows the report regarding the ¾System Suitability Test

 Tip: Using the Print command of the File menu allows printing the
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chromatogram and the report at any time. The pages that have
been defined in the printer layout will be printed, also from within
a report.

For further details on some of the reports mentioned above, see the following
topics:

 Integration Report
 Calibration Report
 Peak Summary Report
 History Report

 Integration Report
The first page of a report usually is an integration report. The DEFLTDAD
⇒Report Definition File , for example, includes the following integration report
tables:
• Integration

• Peak Purity

• Peak Analysis

Contents
• The integration report contains all relevant numeric data of the current

sample such as retention time, peak area and height, amount, peak type,
and other ⇒Peak Variables.

• The individual columns contain variables of the ⇒Peak Results report
category. Nevertheless, you can add further columns from other ⇒Report
Categories.

• If the chromatogram is modified, e.g. by manual re-integration of a peak,
this is reflected immediately by the changed report data.
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• Via the Windows clipboard, data of the report can be directly integrated in
other Windows applications.

• Within the report, the values of different cells are added, subtracted,
multiplied, or divided, as is possible in MS Excel. To do so change into the
Layout Mode via the Layout Mode command of the Table menu.

Formatting
You can design your integration report mostly according to your requirements.
The necessary commands are available in the context menu or in the Table
menu.

For further details, see How to ...:  Actions in the Report.

 Calibration Report

The calibration report is very similar to the  Integration Report:

Contents

• Similar to the integration report, the calibration report shows data of the
current sample. In the calibration report, however, this data refers to the
calibration of the current sample.

• The individual columns contain variables of the ⇒Peak Calibration report
category. Nevertheless, you can add further columns from other ⇒Report
Categories.

• The calibration report allows understanding changes made during the
calibration (in the QNT method).

For further details, see How to ...:  Actions in the Report.

 Peak Summary Report

Commonly used reports (e.g.  Integration Report and  Calibration
Report) contain data of one sample only. In case of a chromatogram
comparison, only the data of the selected, i.e. the current, chromatogram is
displayed.
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Comparing peak data from different samples is possible via the Peak
Summary report type.

Sample Selection
• If one sample is selected and opened from the Browser, the Peak

Summary is based on the corresponding ⇒Sequence.

• If several samples are selected in the Browser, these selected samples
only will be part of the Peak Summary.

• If a ¾Query is started in the Browser, the search result forms the basis for
the Summary. In this way, it is possible to compare peaks from different
sequences.

Peak Selection
• Normally, no peak is selected in the chromatogram of the sample. The

Peak Summary Report therefore contains no entries. All fields are marked
n.a. (not available) or Div/0 (Division/0). Only when a peak is selected
manually within a chromatogram, the Peak Summary Table receives
entries. As soon as this is performed, this peak is searched in all previously
selected samples. The search result is displayed in the Summary Report.

• For each Peak Summary column (!), it is possible to define whether the
values of the currently selected (Selected Peak) or one specific peak
(Fixed Peak) are displayed. Access these options by choosing Column
Properties from the context menu.

• If the currently selected peak is an identified peak, i.e. a peak labeled with
its name in the peak table, all involved samples are searched for this peak
name. The corresponding values of all found peaks are displayed in the
Summary.

• If the currently selected peak is a non-identified peak, i.e. a peak not
labeled with its name in the peak table, a "fixed time window" (± 5% of the
detected retention time) is calculated for this peak. All peaks within this
time window will be included in the summary. If two or more peaks are
detected in the time window, the peak that is nearest to the specified
retention time will be selected. If the peak is an identified peak, this will be
indicated by Ambiguous? in the Summary header.

Creating a Summary
• Double-click one of the samples to open the Integration window.
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• Display the Report and select the default worksheet Summary available in
the Dionex Chromatography Management System. It contains a selection
of the most important default ⇒Peak Variables. For each sample that is
part of the Summary, a separate line is reserved in the report.

• If the default Summary Report is not available, a new worksheet can be
defined. Proceed as described in: How to ...: Actions in the Report  
Adding/Renaming a Worksheet.

As in all reports, the currently selected sample in the chromatogram window is
highlighted in the Summary Table.

 History Report

The default ⇒Report Definition Files include both, an  Integration Report
and a  Calibration Report but no history report. However, you can include it
without problems (see: How to ...: Actions in the Report

 Adding/Renaming a Worksheet).

Contents
• As default, the history report shows the ¾History of the current sample.

The Objects tab of the Table Properties (context menu), however, allows
displaying the histories of other objects.

• In addition, you can limit the displayed history as to time and/or certain
actions / users.

Formatting
• The entries of the history report can be sorted according to specific details.

• The history mode includes a special layout mode that can be activated on
the Layout tab.

 Special Reports

The default ⇒Report Definition Files include both, an  Integration Report
and a  Calibration Report but none of these special reports. However, you
can include them without problems (see: How to ... Actions in the Report

 Adding/Renaming a Worksheet).
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MS-Reports

MS Instrument Info
Report

Information on the ¾Mass Spectrometer.

MS Instrument Method
Report

MS method.

MS Raw Report Raw data of the current ¾Mass Spectrum.
MS Status Log Report Mass spectrometer settings.
MS Tune Data Report Tune data of the ¾Xcalibur raw data file.

 Note: If you do not have the MS Control option enabled on your PC,
the MS reports will not be displayed in the Insert Report dialog.

Other Special Reports

Database Query Results of a database query.
Detection Parameter
Report

Indicates the⇒ Detection Parameters.

Program Report ¾Program of the current sample.
SST Report ¾System Suitability Test.

 Note: All MS reports as well as the Database Query report, the
Detection Parameter Report, and the Program Report comprise
the default columns only; further columns cannot be added.
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Calibration Curve

Calibration Curve

For evaluating the calibration, the Calibration Curve method window is
available. Detailed background information on the calibration is included in the

 Theory of Calibration section.

• Open the window from a different method (e.g. from the Integration
window) by choosing the Show Calibration Curve command from the
View menu, or

• Click the corresponding icon on the toolbar.

As shown via the methods QNT Editor and Integration, various window
sections can be displayed. Generally, the window arrangement consists of the
Chromatogram, Calibration curve, and Report windows.
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• Press F4 or Shift+F4 to change to the chromatogram of a different sample.
Generally, all chromatograms of a sequence can be thus displayed on after
the other.

• In the chromatogram, select the peak for which you want to see the
calibration curve. The corresponding peak will be indicated by a different
background color.

• The Calibration tab of the Report window shows the most important
calibration data such as the ⇒Calibration Type, the number of calibration
points, the ¾Relative Standard Deviation  (Rel.Std.Dev.), the ¾Correlation
Coefficients as well as the calibration coefficients ¾Offset, ¾Slope, and
¾Curve (Offset c0, Slope c1, Curve c2). In addition, you can view e.g. the
¾Variance or the ¾Standard Deviation (Std.Dev.).

• Choose the Decoration command of the context menu to change the
colors and the captions of various window elements.
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• Choose the Column Properties or Table Properties command of the
context menu to change the contents and the layout of the table. For
further details refer to How to ...:  Actions in the Report.

 Note: We would like to point out that the Dionex Chromatography
Management System’s default division of the report variables in
the Integration report, the calibration report and the peak
summary is not binding. Each one of the three reports is freely
configurable and can be supplied with any variables or renamed
as any new report.
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Printer Layout

Printer Layout: Overview

The increasing number of samples makes printing analytical results a complex
and time-consuming procedure especially because results are not only used on
hardcopy but in all types of presentations.

The Dionex Chromatography Management System considers this fact and
emphasizes flexible report generation that meets all your requirements. Use
the appropriate  Report Template to produce reports. With each installation
of the Dionex Chromatography Management System, the respective DEFAULT
report template is stored in the REPORT directory of the Client PC.

• Choose the Printer Layout command from the View menu to open a new
report template.

 Note: For further printing options, see Basic Operation  Printing.

Report Template

The report template represents a type of folder for various worksheets. Each
sheet describes one or several printed pages (size of the chromatogram, where
to position it, columns included in the numerical report, results represented in a
chart, what is included in headers and footers).

With an increasing number of worksheets in the report template, the printing
possibilities also increase. If, for example, you want to print all samples of one
sequence, it may be a good idea to present the results of a calibration sample
differently from the unknown samples, and the lines of a PGM file or summary
report in yet another way. Specify which sample or file type should be printed
and worksheet to be used.

The DEFAULT report template contains the worksheets Integration,
Calibration (Curr.Peak), Calibration (Batch), Peak Analysis, Summary, and
Audit Trail, and, thus, covers all default requirements.

If the report template consists of only one worksheet, it includes a single
template. These are used to print a single object such as a ¾PGM File or the
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result of a single sample. If a single template is used for an entire sequence, all
samples are printed in the same way.

For details, see the topics below:

 Appearance and Function
 Creating Your Own Templates and Worksheets
 Printing

 Appearance and Function
Important features of a report template are:

• The appearance and the structure of report templates are similar to
Microsoft Excel. The functional scope is similar to Excel as well. For
entering formulas and for creating diagrams, the ¾Report Publisher is
required, which is an add-on product to the Dionex Chromatography
Management System.
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• Toggling between the individual sheets of a report template is by clicking
on the tabs on the lower left window corner.

• Double-click a tab to assign a name to it (e.g. Integration Special).

• Each sheet consists of a large number of columns (256) and lines (16000).

• Choose Insert Row(s)/Column(s) or Delete Row(s)/Column(s) to insert
columns or to delete columns or lines on the worksheet.

• Single areas or cells of a worksheet can be "filled" using the Windows
clipboard or via the Insert ... command from the context menu (for details,
see  Creating Your Own Templates and Worksheets).

 Tip: Note that you can place several report tables on a worksheet.
The tables, however, must be positioned one below the other,
not next to each other!

The worksheets that are virtually unrestricted in horizontal and vertical
direction, allow creating page layouts larger that one printed page. Depending
on the selected page size on the printer, one or several pages are required for
printing this type of page layout. The worksheet is divided in many invisible
horizontally and/or vertically positioned print pages.

If the user, for example, inserts a chromatogram that does not fit on one page,
the rest is printed on a new page.

• Via the Page Setup command from the File menu, you can specify in
which order ("from left to right" or "top to bottom") the printed pages of a
worksheet are printed.

 Creating Templates and Worksheets
In addition to the included default report templates, the Dionex
Chromatography Management System allows you to create your own report
templates. Perform the following steps:
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• Select the Printer Layout command in the View menu to change to the
Printer Layout from your currently selected view. The Dionex
Chromatography Management System automatically opens the default
report template. Use the Load Report Definition command of the context
menu to open a specific report template.

 Note: If only the default report template is available in your system,
save it under a new name via the Save Report Definition
command. Now you can edit the duplicate as follows:

• Choose Layout Mode command from the Edit menu to perform manual
changes on the report template.

• Choose the worksheet you wish to edit, or insert an additional (empty)
worksheet via the Insert Sheet command (Edit menu).

• Choose Delete Sheet (Edit menu) to delete a superfluous worksheet.

• Choose Insert ... in the context menu to position chromatograms, tables,
diagrams, report variables or similar elements on the worksheet.

 Caution: Note that you can place several report tables on a worksheet.
The tables, however, must be positioned one below the other,
not next to each other!

Each element inserted in this way reserves a specific area on the worksheet. If
a report template or a single worksheet serves as a print template, these areas
are "filled" with the values or graphics of the current sample. It is also possible
to determine whether the printed output includes data and chromatograms of
all channels of a sample or only of one channel.
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 Note: In addition to report variables that can be combined to form new
functions via the four basic arithmetical operations (plus powers),
it is possible to calculate additional functions known from
Microsoft Excel. For a list of supported functions, see
¾Additional Functions in the Glossary.

For detailed information on creating worksheets and report templates, see How
to ...:  Actions in the Printer Layout.

 Printing

From the Printer Layout
The Printer Layout allows printing the created report template at any time.

• Choose Print from the File menu to start printing.
• Press Preview in the Print dialog box to preview the layout of the printed

output.

The printed output uses the data of the current sample with the layout of the
currently opened sheet.

From the Browser
Use the Browser to print larger quantities of data. The Browser allows printing
single samples and entire sample series.

• Use the mouse to select the samples to print. If you want to print all
samples of one ore several sequences, just select the corresponding
sequence(s).

• Perform a ¾Query to use samples from several sequences.
• Choose Batch Report ... from the context menu and select the Report

Definition to be used for the printed output. Also, choose the channel to
print and specify the printer.

In addition to the results, it is possible to print sample data, i.e., the information
in the sample list.
• Open a sample list and choose Print Table ... from the context menu.
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PPA

PPA: Peak Purity Analysis

 Caution: The basic requirement for using the PPA method is the
availability of a Dionex ¾Photodiode Array Detector. In this case,
the data supplied by a detector can be "read" and viewed on any
client PC. The most common method to relate chromatograms to
spectra is the representation of data in a ¾3D-field in the method
PPA. The 3D-field is the default view in the iso-pixel plot
representation.

Use one of the following methods to view a sample (for which you have the
corresponding 3D-raw data) in the method PPA:

• Select the sample in the Browser and choose the Open / 3DFIELD
command from the context menu, or

• Change from a different method to the PPA method. Use the icon or the
PPA command from the View menu.

View and Operation
In the default view, the method window is divided in four sections. The 3D-field
window (A3) is the most important section. Choose either the Iso Pixel Plot or
the 3D-Plot (see ¾3D-Field Presentation Modes).

The cross-wires that are freely positioned via the left mouse button or the arrow
keys "extract" a chromatogram at a specific wavelength in horizontal orientation
from the plot representation. In vertical orientation, a spectrum is extracted at
the time t and is displayed above (A1) or next (A2) to the 3D-field (A3). Use the
¾Zoom function for a more detailed view.
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The display of the window sections A1 and A2 can be enabled or disabled via
the Show Chromatogram or Show Spectra options. Optionally, an additional
numeric report (PPA report) can be displayed (Show Report). The line of the
currently selected peak is highlighted by a different color.

In addition to the context menu commands that allow undoing a Zoom
operation, restoring the original 3D-field, selecting a different 3D
representation, or displaying additional information such as the ¾PPI Index,
¾Match Factor, etc., there are additional operations that can be executed via
the keyboard or a mouse-click.

• Double-clicking in the A3 windows opens the 3D-field Decorations ... dialog
box.

• Pressing the right mouse button while the 3D-field is redrawn stops
redrawing. This option is useful when the wrong zoom area was chosen.

• Double-clicking the time axis of the window executes the Full Size
command. In the wavelength scaling, the same operation performs the
Autoscale command.
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• Pressing the CTRL key makes the currently displayed spectrum in the
spectra window "permanent," i.e., it is still displayed even when moving the
cross-wires. The spectrum extracted via the cross-wires is displayed in
addition. If the operation is performed several times, any number of
individual spectra can be displayed in the spectra window.

• It is also possible to combine pressing the CTRL key and moving the cross-
wires: Position the x-axis of the cross-wires on the required wavelength
and press the CTRL key. Then move the y-axis over a peak in the
chromatogram. The spectra window now shows all spectra within the
covered range. This procedure can be performed for various peaks in a
chromatogram. Release the CTRL key between the individual peaks to
represent each peak in a different color. For each peak, a number of
spectra can thus be displayed.

• If the y-axis of the cross-wires is located on a peak, the peak spectrum
(= spectrum in the peak maximum) can be copied to the Windows
clipboard via the Copy command. From there, the spectrum can be
included in the spectra library. For this operation, approximately positioning
the y-axis is sufficient.

• Choose one of the Extract: ... commands to extract the current
chromatogram, the optimum integration path, the current spectrum or the
3D-field data and save the item under a separate name. For a description
of the required steps, see How to ...: Actions in the PPA Window

 Extracting Spectra, Chromatograms, and 3D-Field Data, and
 Selecting the Optimum Integration Path.

 Note: Copying or printing a 3D-plot is more time-consuming than
copying or printing the Iso-plot!

• Choose the Library Search command from the context menu to search the
spectra library for the displayed spectrum. For a detailed description of the
required steps, see How to ...: Actions in the UV Spectra and Mass
Spectra  Starting a UV Spectra Search.
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Function
The PPA method allows the following:

• Peak purity analysis (see How to ...: Actions in the PPA Window
 Checking Peak Purity).

• Interactive peak assignment via the spectrum

• Extraction of chromatograms, spectra, and the optimum integration path
(see How to ...: Actions in the PPA Window  Selecting the Optimum
Integration Path, and  Extracting Spectra, Chromatograms, and 3D-
Field Data).

• Visualization of chromatograms for presentation and archiving purposes

• Evaluation of baseline effects

• Checking the Lambert-Beer linearity range

• Quantitative analysis of overlapping peaks

These methods are completed by various procedures and calculations that
enable interpreting or comparing results. These include:

¾Baseline Correction

¾Blank Run Subtraction

¾Normalization

¾PPI: Peak Purity Index

¾PPI: Match Factor
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Spectra Library

Overview: Spectra Library

The partial method Spectra library enables the comparison of ¾Normalized
and ¾baseline-corrected individual spectra with spectra from various libraries.
There are three sections:

Spectra Table
The upper section indicates all spectra contained in a library as well as their
data (= ¾Spectra Criteria). Double-clicking a column header sorts the list
according to the criteria of the selected column (e.g. name, ID, or number of
extremes). Select the first column of the table to select the corresponding
spectrum.
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• As soon as you move the mouse cursor over the first column, the cursor
changes to a horizontal arrow. Press the left mouse button to select a
spectrum.

• Press and hold the CTRL key to select several spectra.

Spectra Plot
The spectra plot is shown in the lower left window section. It shows the spectra
of all substances selected in the spectra table.

• Double-click the window or choose the Decoration... command of the
context menu to change the spectra representation. For details, see

 Spectra Plot in the Integration chapter.

Data Window
The lower right window section of the Spectra Library is reserved for
representing the data. It shows important data regarding the spectrum currently
selected in the spectra table.

Working with the Spectra Library
The aim of any spectra administration is the identification of an unknown
substance based on its UV spectrum. If you have a spectrum of a previously
unidentified substance (e.g. in the spectra window of the PPA method), you
can start searching various libraries from there.

The Dionex Chromatography Management System compares the curve form of
the two spectra (comparison process), calculates a similarity value (evaluation
process), and displays similar spectra (hit criterion).

Depending on whether a single spectrum is identified or whether all peaks of a
sample were identified, the Dionex Chromatography Management System
makes the following distinction:

Hit List
This procedure shows all library spectra that have a certain similarity to the
extracted (and normalized) spectrum. For details, see How to ...: Actions in
the UV Spectra and Mass Spectra  Starting a UV Spectra Search.
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Peak Tracking
This procedure assigns each peak in a chromatogram the spectrum of a library
that matches the spectrum extracted at the peak maximum best.

For further details on the Spectra Library, see the topics below:

 Creating a New Library
 Comparing Spectra

 Creating a New Library

Generating
Choose File / New to open a new and empty spectra library by selecting the
type Spectra Library.

Filling
There are two options for filling a spectra library:
• Copy a spectrum to the Windows clipboard (Copy) from the partial

methods How to ...:  PPA: Peak Purity Analysis or
Integration  Spectra Plot and insert it in the opened library via Paste
Spectra. Or:

• Generate a subset of an existing selection based on specific ¾Hit Criteria.

 Note: To be able to compare UV spectra with each other, the spectrum
and the reference spectrum should be recorded under identical
conditions. The best search results are therefore obtained based
on spectra that were recorded and saved by the user. It is highly
recommended to write down the conditions under which the
spectrum is recorded. The notes will be very useful when there
are several spectra for the same sample.
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Saving
Via the Save as command, save an open library under a different name to a
directory of your choice. Libraries have the file extension LIB.

 Comparing Spectra
To compare two spectra with each other, the curve of the normalized spectrum
can be compared to those of individual library spectra. In some cases, better
results are achieved when the first or second derivations are compared instead
of the spectra themselves.

Via the comparison function (see ⇒Check Derivative), the user determines the
curve form to be used for the comparison.

In the next step, the user determines how the individual curves are compared
with each other. This is by selecting one of three mathematical methods
(⇒Match Criterion).

The combination of comparison function and standard of comparison results in
a "similarity value" between 0 and 1000 that expresses the match degree
between the search spectrum and various library spectra. The similarity value
is known as ¾Match Factor. A perfect match has the value 1000.

Depending on the method (hit list or peak tracking), a similarity list is displayed
or each peak is assigned the most similar spectrum. Entering a minimum
similarity value (threshold) displays only the hits above the threshold.

For a detailed introduction to the required steps in a spectra search, see How
to ...: Actions in the UV Spectra and Mass Spectra  Starting a UV
Spectra Search.

Result Presentation in a Hit List
Using the hit list, a similarity list sorted by the match factor and a representation
of the original spectrum and the library spectrum with the best match are
displayed. Entering a minimum similarity value excludes dissimilar spectra.

Due to the frequently insufficient characteristics of UV spectra, it may be
necessary to further limit these hit lists. That is why ¾Hit Criteria are available
as a further filter. Only the spectra fulfilling the selected criteria will be
displayed.
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How to ...:
How to …:
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Actions in the Browser
The  Browser serves to manage, copy, move, and delete chromatographic
data and files.

 Warning: Its functions are similar to the Windows Explorer. However, do
not the confuse Browser window with the Windows Explorer!
Do not use the Windows Explorer for operations within the
datasource of the Dionex Chromatography Management
System.

In addition, the Browser allows creating a sample list, setting up datasources,
searching and selecting data in a database. For further details, see:

 Creating a Sample List (Sequence Table)
 Creating User-defined Columns
 Setting up a Datasource
 Creating SQL Server Databases
 Handling Files, Datasources, and the Network
 Signing Sequences Electronically
 Performing a Query
 Performing the Chromeleon/PeakNet OQ
 System Wellness
 Importing PeakNet Method Files (Release 4.5 Through 5.2)

Creating a Sample List (Sequence Table)
For creating a  Sample List, there are the following two possibilities:

1.  Manually editing an existing sequence and saving them under a different
name

2.  Automatically creating a new sequence using the Sequence Wizard
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Proceed as follows:

Manually
• Select a sequence in the left pane of the  Browser whose QNT and

PGM File you wish to use (probably edited) for the new sequence.
Saving the sequence under a different name (Save as) creates a new
sequence that can now be edited.

• Enter the name and the properties of the standard samples and the
unknown samples to be analyzed line by line in the lower right window
section. Proceed as follows:

• Click the cell in the table and enter the new value or the name via the
keyboard.

• Enter a name for each of the samples to be analyzed in the ⇒Name
(sample name) column.

• Determine the sample type (Unknown/Standard/Blank Run/Validate) via
⇒Type.

• Determine the autosampler position and the substance volume via the
⇒Pos. (sample position) and ⇒Inj. Vol. (injection volume) columns.

• In the ⇒Program and ⇒Method columns, enter the names of the
Chromatographic Methods to be used for the analysis.

• Determine via the sample ⇒Status (sample status) whether to process a
sample once (Single) or several times (Multiple).

• To analyze two unknown samples (Sample I and II) on the basis of a 2-
point calibration the input can be as follows:

• Input in the remaining columns, e.g., ⇒Weight (sample weight), ⇒Dil.
Factor (dilution factor) and ⇒Inj. Date/Time is not necessary. These
special parameters or fields are automatically filled by the system after the
analysis.
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• If you are not sure which values or names to enter, select the cell and
press the F8 key. This opens an edit dialog box, in which values and
options are listed that are valid. Select the desired value. The cell input is
then automatically updated.

• Press the F1 key to view further information on the individual columns.

• Select the F9 key to fill all subsequent cells of a column with the same
input.

• Save the sequence with a new name (Save as).

• Check the sequence properties by pressing Alt + Enter.

 Note: It is of course possible to edit an existing sequence. Exception: A
currently running sample cannot be edited (the corresponding
line in the sample list is indicated by a different color).

Automatically
• Select the New item in the File menu and select Sample List.

• Press OK to start the  Sequence Wizard.

• Follow the instructions from steps 1 to 5 to create a basic sequence
structure.

• Press F1 if you require further help.

Also, see  Creating User-defined Columns

Creating User-defined Columns
In addition to the existing columns, new columns can be created both, in the
sample list of the  Browser and in the peak table of the QNT editor as
follows:
1. a) In the Browser sample list: Click the datasource for whose sequences

the new columns will be displayed and select Properties in the context
menu. In the dialog box, open the User-defined Columns tab.
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b) In the peak table of the QNT editor: Click Display User-defined
Columns ... under Columns in the context or Edit menu.

2. Under Columns, select <New user-defined column> to activate the right
part under Properties.

3. Under Name, type the desired caption for the new column.

 Note: When entering the name, keep the following restrictions in
mind:

• Use characters, numbers, and the underscore only. The first
character must be a letter.

• Do not use the German "Umlaute" and "ß".

• Names starting with SEQ_ or SMP_ are not permitted.

• In addition, names that are already used as SQL keywords
(e.g., INTEGER), we recommend placing a company prefix
before the desired caption (e.g., with DX=Dionex:
DX_INTEGER). This avoids collisions with already used
SQL keywords. Thus, having the further advantage that
user-defined column will be recognized instantly.

• Names of columns that have been deleted in the current
‘dialog session’, cannot be entered again. Close and open
the dialog box, to re-enter these names.

4. Use Value type: to define the type for the values in the new column:

• Integer (whole numbers)

• Floating point (numbers with a defined number of decimal points)

• Date

• Time

• Date and Time

• Enumeration (open the combo box to select an item from the list)

• String (any sequence of characters)

5. Define the dimension for the values in the new column.

6. Depending on the selected type of variable, further specifications can be
set for the column.
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 Note: Due to the restrictions of the operating system, dates can be
entered for the period 1/2/1970 - 12/30/2037, only.

7. Use the Append Column command to add the new column to the list.
Pressing OK appends the new column to the existing ones.

The new column, which was created in the sample list of the Browser, applies
to the entire Datasource, i.e., it is used for all Sequences of the respective
datasource.

 Tip: Be careful when creating user-defined columns in the Browser
sample list. Ensure that you do not assign column names twice in
the different datasources and even on different computers that
may communicate with each other. Otherwise, unless the column
definitions are identical, problems may occur when copying
sequences or when  Restoring backup files.

Setting up a Datasource
All steps connected with the  Datasource setup are initiated using the
Datasources command in the File menu.

• Open the Browser and choose the Datasources command from the File
menu.

The datasource manager lists all Datasources that can be accessed by the
Client.

 Note: As a minimum, the default datasource (<PC-NAME_LOCAL>)
created during the installation of the Dionex Chromatography
Management System should be visible here. In case of a local
station that is not integrated in a network, the name entered in
the operating system under Control Panel / Network /
Identification is used instead of the computer name. If no
identification was entered, the datasource receives the name
DEFAULT_LOCAL.
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The following actions are possible:

 Connecting a Database ("Connect")
 Disconnecting a Database ("Disconnect")
 Creating a New Database ("New")

 Note: GynkoSoft data and third-party data are regarded as existing
databases to the Dionex Chromatography Management System.
To display these data in the Dionex Chromatography
Management System; a connection must be available to the
corresponding directory (Connect). Setup of a new datasource is
not required.

 Connecting a Database
Accessing data of an existing database is possible only for the client, if a
connection is available between the Client and the database.
• Open the Browser and choose the Datasources command.
• Select the Connect button in the datasource manager to establish a

connection to a datasource.
• Select the type of the underlying datasource.

Currently, connection is possible to genuine database of the Dionex
Chromatography Management System ("Native Chromeleon Datasource"),
"old" directories of the GynkoSoft chromatography data system (= "GynkoSoft
Drives" as of version 5.xx), standard Microsoft Access databases ("mdb
containers"), SQL, and Oracle databases. Support for other formats will be
made available in future versions.

Depending on the datasource type, different input is required, e.g.:
• In the case of Access datasources, the mdb container must be specified,
• For GynkoSoft datasources, a directory must be specified, and
• For SQL data sources, the dialog of the ODBC driver will be opened.

 Note: If you want to include databases in SQL or ORACLE formats,
see to the information in the corresponding Online Help sections.
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 Disconnecting a Database
The Datasource can be disconnected at any time, if necessary.

• Open the Browser and perform the Datasources command.

• Select the datasource in the datasource manager and press the
Disconnect button.

Via this method, a client can be denied access (e.g. by the system
administrator) to a specific datasource.

 Note: The connection to a datasource can also be terminated via the
Dismount Datasource command from the context menu. For
details on the Mount/Dismount Datasource commands, see How
to ...: Actions in the Browser  Locking Datasources on
Removable Media.

 Creating a New Database ("New")
The Dionex Chromatography Management System enables setting up a
datasource with a new database. The new database is always in the Microsoft
Access database format (mdb container).

• Open the Browser and choose the Datasources command from the File
menu.

• Select New to create a new database.

• Enter the name of the new datasource. This name will be displayed in the
Browser.

• Enter the path of an empty subdirectory in which to store the database for
the new datasource. Use the Browse button to search for an empty
directory.

 Tip: Creating a database is possible only if the selected directory is
empty!
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• Activate Common Data Source if the Server of the Dionex
Chromatography Management System shall be able to access this
datasource. Processing sequences is possible only on datasources with
activated Common Data Source setting.

 Note: The local datasource is always selected as Common Data
Source.

• If a datasource is not defined as Common Data Source under
Windows NT/Windows 2000, the datasource must be set up for each
potential user.

Upon completing the procedure (OK), the Dionex Chromatography
Management System generates a database called cm_local.mdb in the
selected directory. Databases with different formats cannot be generated in the
Dionex Chromatography Management System but must be created with the
respective database software, instead (also, see  Creating an SQL Server
Database).

Creating an MS SQL Server Database
In order to use Microsoft SQL Server as the database management system for
a Chromeleon datasource, proceed as follows:

 Create the SQL Database via the SQL Enterprise Manager

 Create the Folder Structure for Data

 Connecting the Dionex Chromatography Management System to
     the SQL Database

 Tip: A similar procedure is followed with the CmUser Manager if the
user database is to be located on an SQL Server. The third step
of the procedure differs in that connection to the database is
done through the CmUser Manager application rather than
through the Client application of the Dionex Chromatography
Management System.
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 Creating the SQL Database via the SQL Enterprise
    Manager

 Tip: This guide only provides specific details relevant to the Dionex
Chromatography Management System for creating an SQL
database. For general instructions on installing MS SQL Server
and creating a database, refer to the Microsoft MS SQL Server
documentation.

• Create a Database through the SQL Enterprise Name using the default
settings.

• Give the new database a meaningful name (this will be used in the ODBC
connection.

• Assign at least two users to the database -- an administrator and a normal
user -- using the SQL login (create specific users for the database).

Administrator
The administrator account is used to set up and manage the database of the
Dionex Chromatography Management System, so full privileges should be
granted to this account. Essential privileges are those for creating tables and
views; all the tables are created at the time the administrator first connects to
the database via Dionex Chromatography Management System. (A typical
name for the administrator would be CMADMIN.)

Normal User
This is the normal user account that connects to the database via the Dionex
Chromatography Management System during normal operation. This account
must have the following two privileges for the database of the Dionex
Chromatography Management System:
• db_datareader

• db_datawriter

Further privileges are not necessary in order to access the data through the
Dionex Chromatography Management System later on. (A typical name for the
common user would be CMUSER or simply CM.)
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 Tip: The SQL login is required to impersonate the user on the
database. Once the connection is made, any user can log in to
Chromeleon, subject to the access rights and privileges set in the
security system of the Dionex Chromatography Management
System.

For further information on how to create SQL data sources, see How
to ...: Actions in the Browser:

 Create the Folder Structure for Data

 Connecting the Dionex Chromatography Management System to
     the SQL Database

 Creating the Folder Structure for Data
The data storage model of the Dionex Chromatography Management System
consists of a hierarchical file system that is indexed by a relational database.
Before connecting to an SQL Datasource, define the location of the parent
folder of the file system. This folder does not need to be on the same computer
that is running the SQL server application, but keeping them on the same
computer makes administration, backup, and archiving easier.

Create a master shared folder for the file system. (This example has this folder
on the PC that is hosting the database.) Dionex recommends sharing it as an
administrator share that it is not visible in the network. The users need to have
Modify privileges only. Under this master folder, create a folder in which to
store the data. For this folder Modify privileges will be sufficient. Dionex
recommends appending the $ character to the folder name to prevent display
of the total path in the status bar and the window title. Example:
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Folder structure on the PC MySQLServer assuming drive C:

C:\CM_Data\Year2000$

For example, Year2000$ is a folder in which all data for the year 2000 will be
stored.

In this case, the data set path entered in the Connect Data Source dialog of
the Dionex Chromatography Management System will be  \\My SQL-
Server\CM_Data$\Year2000$.

For further information on how to create SQL data sources, see How
to ...: Actions in the Browser:

 Create the SQL Database via the SQL Enterprise Manager

 Connecting the Dionex Chromatography Management System to
     the SQL Database
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 Connecting the Dionex Chromatography Management
    System to the SQL Database
Log in to the Dionex Chromatography Management System with full
administrator privileges at the operating system and application levels. From
within Chromeleon, connect to the SQL database via the Datasources
command of the File menu. In the opening dialog box, press Connect and
from the driver list, choose SQL Server. If the instrument Server application
of the Dionex Chromatography Management System is running on the local
machine, and if the application needs to access the Datasource, be sure to
select the Common Data Source (Accessible by Chromeleon Server) check
box.

The next dialog prompts for the connection information to the SQL database:

Select the PC that is running the SQL Server application. Log in as
administrator to select the database that was created via the SQL Enterprise
Manager. Leave the Application Name as is (default: Chromeleon):
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In the next dialog, enter the name of the data source, as you want it to be
displayed in Chromeleon, and specify the data set path:

In the example, the datasource will appear in Chromeleon’s Browser with the
name All_Year_2000_Data.

The Data Set Path is the path to the shared folder containing the data folder
Year2000$, as created in the first step of this procedure. Dionex recommends
using the UNC naming convention, as shown in the example, so that
Chromeleon can find the location of the data automatically if the applications
are loaded at system start (boot time). A drive mapping is only applied if a user
logs on.
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After following the above steps, the new data source is automatically created
and configured with all tables except those related to Modification History,
which are only created when they are needed. For maximum flexibility, the
administrator should create these tables even if they will not be used
immediately. To create these tables, select the data source in the folder tree of
the Browser, select Properties in the File menu. Then select Enable
Modification History, and OK. All tables will now be available for the Normal
User. (If you do not currently want to maintain a Modification History for the
data source, return to the Properties dialog and de-select the check box.)

At this point, the administrative setup is complete. Use the Dismount command
of the context menu to disconnect the SQL data source, and re-connect as the
Normal User. Follow the same procedure as above, but use the Normal User’s
user name and password.

In the following dialog, the Data Source Name will be grayed out, because the
administrator assigned this name. In addition, the Data Set Path will default to
the path stored in the data source; do not change this entry.

The connection to the MS SQL Server database is finished. Now, data may be
copied from any other data source to the new data source. The example shows
several different data sources. On the top is the newly created MS SQL Server
data source, followed by a local Microsoft Access data source and a network-
based Oracle data source. They look all the same for the user.
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Servers and Network Datasources of the Dionex Chromatography
Management System
Users often want to store acquired data directly on a central database
somewhere in the network. In this case, the server application of the Dionex
Chromatography Management System on the local machine needs to have a
separate account that is known to the target machine that is hosting the
database. It is typically a domain account that is generic to all servers of the
Dionex Chromatography Management System in the net. This account must be
assigned in the operating system services (Windows NT and Windows 2000
Professional) to the Chromeleon Server service  The Dionex
Chromatography Management System under Windows 98 and Windows
NT/Windows 2000). This account must be made part of the Chromeleon
Operators Group on the operating system level.

For further information on how to create SQL datasources, see How
to ...: Actions in the Browser:

 Create the SQL Database via the SQL Enterprise Manager

 Create the Folder Structure for Data
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Handling Files, Datasources, and the Network
When working with your Dionex Chromatography Management System, you
will surely collect many data. To handle, store, and save them in the best
possible way, the Dionex Chromatography Management System offers
different possibilities:

 Locking Datasources on Removable Media
 Locking Datasources, Directories, and Sequences
 Repairing a Datasource  (ODBC Manager)
 Opening Protocol Data ("Audit Trails")
 Network Failure / Non-Availability
 Creating Backup Files
 Restoring Backup Files

 Locking Datasources on Removable Media
In addition to the hard disk of the local PC or a network PC, Datasources can
be installed on removable media, e.g. on diskette, ZIP or CD-ROM drives.
• Choose the Mount Datasource command from the File menu and select a

drive or search for the datasource via the Browse command.

The Dionex Chromatography Management System will automatically show the
Windows drive letters of all currently available removable media.
• If the Dionex Chromatography Management System finds an existing

datasource on the selected media, this datasource is automatically
"connected" and is displayed in the Browser as any other datasource.

• If the Dionex Chromatography Management System does not find a
datasource on the selected media, the user can install a new datasource
on this drive. The datasource will receive the name of the drive.

 Note: Datasources in the Microsoft Access database format can be
copied to the removable medium. Simply copy the DATA
directory of the local datasource of the respective subdirectory of
a network datasource to the corresponding removable medium.

 Caution: If a connection is established to a datasource on a removable
medium via the Mount Datasource command, the
corresponding medium (diskette, Zip disk, CD ROM) may not be
removed until the connection is correctly terminated via the
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context Dismount Datasource. Otherwise, the operating
system will crash! command.

 Locking Datasources, Directories, and Sequences
To protect data and results, the Dionex Chromatography Management System
offers the possibility to lock Datasources, directories, or sequences. If the
"Locked" status is enabled, it is not possible to modify the corresponding
object. This also applies to all objects below the locked object. If, for example,
a datasource is locked, all contained directories and sequences are also
locked. Locked items can be recognized in the Browser by the changed icon
(red lock).

To lock an object proceed as follows:
• Select the object in the Browser.

• Choose the Properties command via the context menu and activate the
Locked check box in the edit box.

Repeat these steps to undo the action.

 Note: Locking and sharing objects are subject to the  Access
Control and can only be performed by users with the
corresponding privilege.

Apart from locking datasources and directories via the Locked check box,
access can be controlled by adding them to or removing them from Access
Groups.
• Select the object in the Browser.

• Choose the Properties command via the context menu, define the Access
group assignment via the Add, and Remove buttons.

Accessing datasources and directories is possible only for users who are
members of an A-group listed in the Access Groups.

 Repairing Datasources (ODBC Manager)
Defective datasources can be repaired via the Datasource Manager dialog
box that is opened by the Datasources command of the File menu. Select the
defective datasource and press the Repair button. Your datasource will be
automatically repaired - as far as possible.
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Among other functions, the repair function is available via the ODBC Manager
as well. Normally no modifications are required in the ODBC Manager. Should
you need to perform changes, proceed as follows:

• Press the ODBC Mgr… button in the Datasource Manager to open the
Windows ODBC dialog box of the control panel.

 Caution: Modifications to the ODBC Manager should be performed by
experienced users only. Otherwise, re-installation of the Dionex
Chromatography Management System may be necessary. Loss
of data may result!

 Opening Protocol Data (Audit Trails)

From the Browser, protocol data, e.g. the  Protocol Data (Audit Trails) of
single days (  Daily Protocols) as well as of single samples (  Sample
Protocols) can be activated.

In the server Datasource, daily protocols are located in the AUDIT directory
under the corresponding Timebase. Double-clicking opens the daily
protocols.

To view a sample protocol, select the corresponding sample. Choose Open via
the context menu (right mouse click) and open the sample protocol via Audit
Trail. Alternatively, you can view sample protocols in the Report. Open the
sample by double-clicking and select the Audit Trail tab.

 Network Failure / Non-Availability

In case of a sudden network failure or crash of the network server
If the network fails during data acquisition, the acquisition will not be interrupted
even when being performed on a remote Server of the Dionex
Chromatography Management System. Later, the data acquired during the
network failure can be written back to the network datasource.

Wait until the network is available again. Stop the running Batch (or wait until
it is completed) and select NFP Recovery in the Batch menu. The server will
write all data that were temporarily stored to the local disc during the network
failure back to their proper locations on the network datasource. This procedure
is logged in the  Audit Trail as is the network failure.
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In some cases, the network recovery can fail due to problems of the ODBC or
the network driver. If so, restart the server of the Dionex Chromatography
Management System upon completion of the batch. In order to ensure that
Windows and all other applications work properly we recommend rebooting the
PC before.

 Note: The Network Failure Protection is available for Windows NT
and Windows 2000, only! It is disabled on Windows 98 because
these systems are unstable under network failure conditions.

During Backup / Non-Availability of the Network Database
In many companies/organizations, the Datasource / Database is not available
during the daily backup. In this case, however, it is known when the network
will not be available so that the Dionex Chromatography Management System
can be disconnected before.

Click the desired datasource or select the Properties command in the File or
context menu. On the Availability tab, enter the time for which the datasource
is not available. The time interval should start a few minutes before the backup
starts.

 Creating Backup Files
The Dionex Chromatography Management System offers its own backup
program that allows creating backup files including all linked objects.

Before starting the Backup, the objects to archive must be selected in the
Browser. All selection options of the Browser are supported. The backup

dialog is then opened via Export/Backup from the File menu. Backup copies
of the following objects can be created:
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When selecting... ... a backup copy is created of:
a directory all subdirectories and the included files, sequences, etc.
sequences all samples and the files included in the sequence (QNT file and

Program File (PGM File)).
individual samples the sequence information (name, directory, title, etc.), the

selected samples as well as the PGM File and QNT file used
by these samples.

other files the corresponding files.

When using the Query function in the Browser, the following options are
available:

When selecting... ... a backup copy is created of:
individual samples the sequence information (name, directory, title, etc.), the selected

samples as well as the PGM and QNT files used by these
samples.

sequences all samples contained in the Query of the corresponding
sequence.

The following linked objects are copied when creating the backup:

Object Link
sequence Preferred Report Definition file (RDF)
peak table calibration list for the calibration mode "fixed";

blank run sample for blank run subtract mode "fixed sample";
spectra library for Spectra Library Screening.

Query Preferred report definition file (RDF)
samples QNT file

PGM file

If a link refers to an object included in the list of selected objects, it is treated as
a normal object.
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Choose Backup to open the following dialog box:

A description of the individual fields is available in the Online Help only (see
Backup).

Before starting the backup, the required storage space is determined. In the
case of hard disks and network drives, the Dionex Chromatography
Management System checks whether sufficient storage capacity is available. If
there is not enough space, an error message appears allowing the user to
cancel the backup procedure.

If using removable media, the expected number of media is displayed. The
user is prompted to keep the media ready. If using data compression, the
number of actually required media may differ from the displayed number.

After that, the selected objects are stored. A dialog appears allowing to monitor
the procedure. A progress bar indicates the status. The bar corresponds to the
percentage of stored data already copied to the medium:
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If the destination is a removable medium, the user is prompted to change the
medium, as necessary.

To perform a backup, you must have the privilege PRIV_Backup (also refer to
Privilege groups) for all selected objects. The backup is indicated in the
History. The backup can be interrupted at any time by pressing the Cancel

button. In this case, the backup contains all objects stored up to this point.

If the original objects should be deleted after the backup, a dialog appears
where the user confirms the action. If the history mode is active, another dialog
for entering a history comment will be opened.

Backup files have the extension .cmb. For information on how to open and
restore backup files see How to ...: Actions in the Browser  Restoring
Backup Files.
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 Restoring Backup Files
Backup files that were created via the Backup function can be opened via the
Import / Restore command from the File menu of the Browser (also, see
Actions in the Browser  Creating Backup Files).

 Tip: Besides, backup files can also be opened in the Windows
Explorer by double-clicking the file name. Backup files are
identified by their extension *.cmb.

After opening the Restore dialog, select the backup file to be restored. The
Dionex Chromatography Management System recognizes whether the file is
stored on a removable medium, a hard disk, or a network.

If the backup file is stored on removable media, insert the first medium, as it
includes the contents list. Otherwise, an error message will be displayed.

The Dionex Chromatography Management System displays the contents list of
the backup file:
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A description of the individual fields is available in the Online Help only (see
Restore).

In addition to the objects, the stored Channels and linked objects are listed in
separate groups.

Select the channels and the links to restore from the items in these groups. By
default, all channels but no links will be restored.

Following this dialog, the selected objects are restored together with the raw
data files of the selected channels, the audit trails, and the history. A dialog box
appears similar to the Backup dialog. If the backup is located on several
removable media, the user is prompted to insert the next medium, as
necessary.
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If the directory of an object to restore does not exist, it will be created. Links are
always restored at the original location. The corresponding sequence and
datasource must exist. Missing directories will be created, as necessary.

If the destination object already exists, the user is prompted whether to
overwrite it. The following options are available: Yes, Yes to all, No, No to all,
and Cancel. Each restored object will receive a corresponding history entry.

To perform the action Restore, the user must have the privilege PRIV_Restore
for the destination directory. To overwrite an existing object, the privilege
PRIV_Copy is required in addition. The restoration can be interrupted at any
time by pressing the Cancel button.

 Exporting Files
The Dionex Chromatography Management System offers various alternatives
for exporting data (see  Data Export). To export data in the Browser
proceed as follows:
• Select Batch Report in the File menu to open the respective dialog box.

• Selecting the Export option opens the Export Wizard.
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• Under Location, use the  "..." button to define the position where to store
the data.

• Use the Directory formula field to automatically create additional folders
below the existing location folders in the Windows Explorer. In order to
facilitate finding your files we recommend you to use the same structure as
in the Browser. Use the {seq.path}\{seq.name}.seq formula to create the
same structure.

Use the {...} button to enter the formula if you do not know the syntax. For
the above example, use the Directory variable of the Sequence category.
Then enter a backslash (\) and select the Name variable of the same
category.

• You can enter a formula for the file name in the File name formula field.
As the individual files are normally created for the respective samples, the
entry {smp.name}, i.e. the sample name, will be appropriate provided
every sample has a specific name

Use the {...} button to enter the formula if you do not know the syntax. For
the above example, use the Sample Name variable of the Sample
category.

The default {smp.number;04} uses the number of the respective sample
for the file name. 04 indicates a four-digit number, i.e. file names such as
0001.txt or 0053.txt will be created.

• Define the export format in the bottom part of the dialog box.

• Press Next to proceed to the following page(s) of the Export Wizard where
you can define the options for the selected export format. For example,
define for the ASCII format the pages you want to export and select the
channel(s) if you want to export raw data together with your report.

 Tip: Before you export a Summary page, ensure in the Printer
Layout that a peak is selected in the individual columns. If
the setting is Selected Peak, no data will be exported as no
peak has been selected in the Browser.

• Press Finish to terminate the Export Wizard and start exporting by
pressing OK.

 Exporting Sequence Data in one Single File
Use the Summary page for exporting the data of a sequence in one single file.
First, define the columns of interest in the Printer Layout as follows:
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• Open the Properties column by double-clicking the headers of the
individual columns. Select the desired peak and save the report.

 Tip: If the setting is Selected Peak, no data will be exported as
this is done from the Browser where no peak can be
selected.

• Go to the Browser and proceed as described in the previous chapter
(  Exporting Files). Make the following settings:

• Use the export formats ASCII, Excel, and/or PDF.

• Enter {seq.name}, i.e. the sequence name, in the File name formula
field, thus generating one single file for the sequence.

• On the next page, just select Summary as the report page to be
exported.

• Press Finish to terminate the Export Wizard and start exporting by
pressing OK.

Signing Sequences Electronically
The  Electronic Signature is important for securing your data within the
scope of quality assurance and GLP. In order to sign sequences
electronically, the CmUser mode needs to be activated. In addition, the
logged-on user must have the signature Privileges (e.g. SignResults)
assigned. For further details, see the CmUser Online Help.

 Note: Electronic Signature is available only for user databases that
were created with a CmUser program version 6.10 or higher.
Update your database if an error message notifies you that
electronic signature will not be possible.

If these conditions are met, Sequences can be signed in three steps:
• Submit

• Review

• Approve

Depending on the sequence's signature status, the corresponding menu item
will be available in the context menu:
• Submit Results... (for unsigned samples)
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• Review Results... (for submitted samples) or

• Approve Results... (for reviewed samples)

Access to the respective commands is via the Sign Sequence option in the
File menu as well. Alternatively, the respective button on the standard

Toolbar can be used:

Depending on the sequence's signature status, the button has the
corresponding meaning. For further information see

 Individual Steps of the Electronic Signature
 Checking the Signature Status and Undo Signature
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 Individual Steps of the Electronic Signature

The first step of an  Electronic Signature is the Submit process. Click a
Sequence that has not yet been signed and select the Submit Results

command as described in the previous topic (for general information on
electronic signature support in the Dionex Chromatography Management
System, see  Signing Sequences Electronically).

Select the Report Definition file (RDF) to be used for displaying the sequence
as well as the channel for which to show the results. In the lower window part,
you can define the pages of the RDF file to be signed.

Selecting the RDF creates an SOR file (Signed Off Results file). Via the
selected report definition file, the results are written to the SOR file. Meanwhile,
the progress bar in the opening dialog box indicates the progress while the
different pages of the report are frozen for the individual samples. Then, the
Check Signed Results dialog box opens:
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This allows you to check the report to be signed. Use the arrow keys to toggle
between the different sequence samples. For each sample, the tabs for the
selected report pages are displayed. Pressing OK when you have terminated
your checks opens the Submit Signature dialog box opens in which the SOR
file is signed by entering the User ID and the signature password:
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In the comment field, you can note e.g., critical or doubtful points noticed during
the report creation.

With an open sequence, the SOR file is given below the other sequence files in
the upper right Browser section and can be opened by double-clicking

Having been signed and submitted the sequence can be reviewed via the
Review Results command. Again, the progress is indicated by a progress bar
in a dialog box. All files that are assigned to the sequence are reviewed
followed by a review of the individual samples:

(This process is completed much faster than with Submit so that the above
dialog box will be visible for a few seconds only, especially with short
sequences.) To approve a sequence proceed in the same way.
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 Checking the Signature Status and Undo Signature
The current signature status of a Sequence is given on the Signature tab on
the sequence's Properties dialog. Here, you can also indicate which users are
allowed to electronically sign this sequence (  Electronic Signature).

To check the sequence signature, use the Verify command in the File menu
under Sign Sequence or the respective button on the standard Toolbar.
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Hence, possibly tried manipulations of the signed sequence or errors in the
signature are identified in any case. To check the reports once again in such a
case, the signature must be removed by the Undo Signature command in the
File menu under Sign Sequence or via the button:

However, to do so, the user must have the UndoSignResults  Privilege
assigned. The corresponding SOR file will be deleted as well.

Performing a Query
The term Query refers to the search for data based on specific search
criteria. In the Dionex Chromatography Management System, you can search
for samples and the corresponding sequences based on freely selectable
parameters. Either you can use very detailed criteria to search for one specific
sample, or you can use criteria that are more general to search for a specific
series of samples with the same properties.

Proceed as follows to start a query:
• Change to the Browser and select the Query command in the context

menu or select New / Query (using the Wizard) in the File menu. Either
way, a Wizard opens and facilitates entering the required conditions.

• On the first Wizard page, define the Datasource in which to perform the
query. In addition, define whether to find certain Sequence properties
(Sequences) and/or sample properties (Samples), and/or other conditions
(Results).

• Define the individual conditions on the following pages. Only those pages
will open which refer to the properties selected on the first page.

Pressing Finish opens another dialog box, which offers another four tabs:
• Choose General to specify the datasource where to perform the search.

• Choose Native SQL to enter the SQL statement directly in the SQL syntax
of the corresponding ODBC driver (contains translated Dionex
Chromatography Management System statements).
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• Choose SQL to define the search statement in an entry dialog box.

• Choose Result Restrictions to limit the resulting sample list via further
result queries.

For details, also see

 Entering the Sample Query Using a Wizard
 Selecting Search Criteria

 Examples (Wizard)

 Specifying the Sample Query Using the Dialog Box
 Editing SQL Statements
 Examples (Dialog Box)
 Saving a Query

 Entering the Sample Query Using the Wizard
On the first Wizard page, define whether to perform the Query in the currently
open Datasource (Selected Datasource) or in a different one. If so, click the
respective option to open the combo box and select the desired datasource
from the list.

In addition, you can define the criteria types for the query:
• Sequences
• Samples
• Results (variables from the different report categories)

On the following pages, use Data Field to choose the variable whose property
you want to find. Enter an operator and define the value (also,
see  Selecting Search Criteria)

The combo box to the right of the respective line allows you to enter a logic
connective with another search property. Only after having entered AND or
OR, a second search property can be entered.

Press Finish to complete the Wizard and to open the New Query Properties
dialog box. This dialog box allows you to specify your query further (also, see

 Specifying the Sample Query Using the Dialog Box).
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 Selecting Search Criteria
The Query allows searching for samples and sequences using a variety of
sample or sequence properties. Enter the search criteria (see table) on the
pages Query Wizard: Sequences or Samples, respectively. To further restrict
the query, double-click the SQL dialog and enter the respective criteria in the
Field of the Edit Conditions sheet.

Designation Search Criterion
Sample Name ⇒Name
Sample Number ⇒No.
Sample Type ⇒Type
Sample Status ⇒Status
Sample Comment ⇒Comment
Sample Inject Position ⇒Pos.
Sample Replicate ID ⇒Replicate ID
Sample Inject Volume ⇒Inj. Vol.
Sample Inject Time ⇒Inj. Date/Time
Sample Dilution Factor ⇒Dil. Factor
Sample Weight ⇒Weight
Sample Amount ⇒ISTD Amount
Sample Raw ID Internal data system sample ID.
Sample User ID Sample ID assigned by the user
Sample Program Name ⇒Program used for sample processing
Sample Method Name ⇒Method used for sample evaluation
Sequence Name
Sequence Description ⇒Sequence
Sequence Preferred Channel
Sequence Preferred Report
Sequence Directory
Sequence Timebase Timebase
Sequence Creation Date
Sequence Creation Operator
Sequence Last Update
Sequence Last Update Operator
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These criteria can be divided in four different groups (1 - 4, see table below for
available groups):
• Text variables (e.g. Sample or Sequence Name, Sample ID, ...) (1),
• Numerical variables (e.g. Sample Number, Sample Position, ...) (2),
• Variables with specific values (Sample Type or Sample Status) (3), and
• Time variables (Sample Inject Time, Sequence Creation Date, ...) (4).

These search parameters must be further specified. Depending on the type,
the search criterion can be linked with a value via various operators. The
following operators are available:

Operator: Searches all samples... Group no.
= that are equal to the specified character string. 1, 2, 3, 4
< > that are not equal to the specified character string. 1, 2, 3, 4
> that are larger than the specified character string. 1, 2, 4
< that are smaller than the specified character string. 1, 2, 4
>= that are larger than or equal to the specified character

string
1, 2, 4

<= that are smaller than or equal to the specified
character string

1, 2, 4

contains: that contain the specified character string. 1
contains not: that do not contain the specified character string. 1
starts with: that start with the specified character string. 1
does not start with: that do not start with the specified character string. 1
ends with: that end with the specified character string. 1
does not end with: that do not end with the specified character string. 1
is like: that fulfill the specified wildcard condition. 1
is not like: that do not fulfill the specified wildcard condition. 1
is between: that are between two values. 1, 2, 4
is not between: that are not between two values. 1, 2, 4
during the previous: that were created during a selectable time before the

query.
4

is null in which the variable does not exists 1, 2, 3, 4
is not null in which the variable exists 1, 2, 3, 4

If the operators >, <, >=, or <= are used for text variables, the alphabetical
order is considered (e.g.: A<B).
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 Note: All SQL-time queries containing a relative reference (operator
during the previous in the Edit Condition window) are
recalculated for each query.

Wildcards ("placeholders") represent character strings. The following wildcards
are valid for text variables with the operator "is (not) like":

Wildcard Significance
% Any character string with 0 or more characters
_(underscore) Any single character
[ ] A single character within a specified range (e.g. [a-f]).
[^] Any character with the exception of the specified range.

As soon as the search conditions have been completed, pressing the Apply
button can start the query.

Further conditions can be entered in the Wizard on the Result Restrictions
page or in the Properties dialog box via the Edit Conditions page of the
Result Restrictions. Select a report variable (also, see ⇒Report Categories)
by pressing the "..." button. Logical operations can be used according to the
sample and sequence properties.

 Note: Depending on the number of samples resulting from the SQL
query, the execution of the result restriction may take some time.
After approx. 3 seconds, a window will indicate the status of the
result restriction (in % of the samples to test). The user can
cancel the query. As the result of the query, only the samples of
the SQL query that have "successfully passed" the result
restrictions so far will be listed.

 Examples (Wizard)
The following SQL query searches for all samples:
• With the sample type Matrix Blank and

• Whose comment starts with Charge 123456 or

• An injection date between 2/2/2000 and 3/2/2000:
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.

Use the following settings to restrict the Query to samples
• Containing an Anthracene peak or

• Containing more than 10 calibration points:

.

For further examples on restricting the query via the dialog box, see
 Examples (Dialog Box).
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 Specifying the Sample Query Using the Dialog Box
Having entered the Query properties using the Wizard, the query can be
specified further via the New Query Properties dialog box. In addition, this
dialog box allows editing a performed query later. In this case, the dialog box is
named Properties of Query "xyz". To access this dialog box, click the query
and select Properties in the context or File menu.

The dialog box offers the following four tabs:

• General tab: In addition to entering a query title, it is possible to specify the
datasource where the query is performed. If this field remains empty
(default), the datasource is used where the query itself is saved. The
settings Preferred RDF-File and Preferred Channel are used for opening
a sample or for starting a batch report.

• SQL tab: This tab allows you to edit the SQL condition(s) the samples must
fulfill. You can open an Edit Condition dialog box via the Edit/Insert
button, by double-clicking the left mouse button, or via the context menu.
This box allows you to add (Restrict/Expand Condition) or change SQL
conditions (Change Condition).

Via Field, you can select a search criterion. To restrict the criterion, SQL
operators are available (see How to ...: Actions in the Browser

 Selecting Search Criteria). The corresponding comparison value can
be defined in the edit field Value. For editing a search criterion, all
⇒Sequence and sample variables can be used.

• Native SQL tab: This tab dialog box translates the SQL statement into the
SQL syntax of the corresponding ODBC driver. As the default, this sheet is
"read only". It informs you about the SQL statement sent to the ODBC
driver. By selecting the Always use native SQL option, it is possible to edit
the SQL statement manually.

 Caution: If SQL conditions were edited, this "translated" SQL statement
will be used to perform the query.

• Result Restrictions tab: The list of samples found via the SQL query can
be further limited by result restrictions. Similar to entering the SQL query,
you can open the Edit Conditions dialog box by double-clicking the left
mouse button or via the context menu. Here, result conditions can be
edited. Result Restrictions generally limits the query to samples that
contain raw data.
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In the Formula field, you can select a report variable (also, see ⇒Report
Categories) via the "..." button. Again, SQL operators (see How to ...: Actions
in the Browser  Selecting Search Criteria) are supported. Enter the
reference value in the Value field.

• As soon as the search conditions have been completed, you can start the
search by pressing the Apply button.

 Editing SQL Statements
The Native SQL tab dialog box shows the SQL statement the Dionex
Chromatography Management System created from the database query
specified via the SQL tab dialog box.

Users with a good knowledge of the SQL database language can specify
further conditions for their Query. For this purpose, Always use native SQL
must be selected. The statement can then be modified or extended via the
keyboard.

 Caution: If you edited the SQL statement via the Native SQL tab, this
"translated" SQL statement will be executed whenever the query
is performed as long as this box is checked.

 Examples (Dialog Box)
The following SQL query searches for all samples of the current day:
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The SQL sheet will show the following:

Samples.smp_inject_time >= CURRENT_INTERVAL '0' DAY.

To restrict the search to the current day's standard samples instead of all
sample types, the SQL query must also include the following input:

The SQL sheet now shows the following:

Samples.smp_type = 'S'

AND Samples.smp_inject_time >= CURRENT_INTERVAL '0' DAY

To search for all samples in a ⇒Sequence named S7709, in which the peak
Benzene or a peak of the PAK (PAH) peak group was identified, first enter the
following:
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In addition, specify the following conditions in the Result Restrictions box:

Finally, enter the condition or PAK (PAH) in the Result Restrictions box:

The SQL sheet now shows:

Sequences.seq_name = 'S7709'

The Result Restrictions sheet indicates:

peak.name = 'Benzene'

OR peak.group = 'PAK'.

For examples on entering the query using the Wizard, see
 Examples (Wizard).
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 Saving a Query

Queries can be saved as a file in the datasource, similar to ⇒Sequences. For
this purpose, open the Query Wizard via the File menu or in the context
menu. After entering the conditions, press the OK button to save these
conditions as a query object under any file name.

In the Browser, the Query is indicated by the symbol: .

If the cursor is positioned on a query, the Dionex Chromatography
Management System acts as if displaying a sequence: If the query is located in
the left window section of the Browser, the sample query is immediately
executed. The result will be displayed in the right window section. If the query
is located in the right window section of the Browser, pressing Return or
double-clicking the file will execute the query.

A previously saved query can be edited via the Properties command from the
File menu (or via the context menu).

Performing the Chromeleon/PeakNet OQ
If the respective  Preconditions for the Chromeleon/PeakNet Operational
Qualification are met, the  Data System OQ can be performed manually or
automatically using the Wizard. For further information on the individual
steps, see the following pages:

 Performing the Chromeleon/PeakNet OQ Automatically
 Performing the Chromeleon/PeakNet OQ Manually

 Performing the Chromeleon/PeakNet OQ Automatically

For performing the  Operational Qualification of the Dionex
Chromatography Management System automatically using the Wizard, the
following steps must be taken:
1. Establish a connection to the Datasource on the Dionex Chromatography

Management System CD or to a copy thereof.

2. In the Client, select the menu item Chromeleon OQ or PeakNet OQ in the
Qualification menu. The Wizard opens and guides you through the OQ.
Press Next to proceed to the next step.
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3. Select the source directory of the sample sequence that holds the
Sequence CM_OQ.

4. Specify a data path and a sequence name for saving the results. Specify
whether the report shall be printed automatically upon termination of the
OQ.

5. Select Finish to start the OQ automatically. The following dialog box allows
you to monitor the progress:

6. While the OQ is running, the Dionex Chromatography Management
System is locked. This lock can be removed only by pressing Cancel in the
active window Chromeleon (or PeakNet) Operational Qualification.

7. If specified in step 5, the report will be printed automatically when the OQ is
finished.

8. The server is stopped and the configuration used before starting the OQ is
reloaded. Then the server starts again.

For information on how to perform the Data System OQ manually, see How
to ...: Actions in the Browser  Performing the Chromeleon/PeakNet OQ
Manually.

 Performing the Chromeleon/PeakNet OQ Manually

For performing the  Operational Qualification of the Dionex
Chromatography Management System manually, the following steps must
be taken:
1. Ensure that the Server of the Dionex Chromatography Management

System is running and no process is active.

2. Start the program module Server Configuration.

3. Save the actual configuration under a unique name.



Actions in the Browser 249

4. Load the CM_OQ.CFG configuration from the Bin subdirectory of the
Dionex Chromatography Management System directory.

5. Start the Client of the Dionex Chromatography Management System if it
is not yet running.

6. Close all windows except the Browser.

7. Establish a connection to the Datasource that holds the sequence
template.

8. Copy the sequence template.

9. Open the Control Panel of the copied Sequence and connect it to the
Timebase CM_OQ.

10. Open the batch list. If necessary, delete any sequences stored in the batch
list and add the copied sequence.

11. Start the Batch.

12. Ensure that no modifications are made in the Dionex Chromatography
Management System while the sequence is processed (duration: 25
minutes).

13. Upon termination of the sequence, print the report by selecting the menu
item Batch Report in the File menu of the Browser.

14. Start the program module Server Configuration.

15. Reload the configuration used before starting the OQ.

For information on how to perform the Data System OQ automatically, see
How to ...: Actions in the Browser  Performing the
Chromeleon/PeakNet OQ Automatically.

 System Wellness
System Wellness provides built-in diagnostic and calibration features that help
prevent unscheduled system shutdowns and assure reliable operation of
system devices. System Wellness support is provided for devices that are
connected via the Dionex DX-LAN.

For an overview of System Wellness features and a list of supported devices,
see  System Wellness Overview.
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System Wellness tasks are performed from the Browser. For details, see the
System Wellness section under How to ...: Actions in the Browser:

 Opening a Wellness Control Panel
 Viewing and Restoring Calibration Data
 Performing Device Calibrations
 Performing Device Diagnostics
 Entering Device Parameters

Also, see How to ...: Actions in the Server Configuration
  Enabling/Disabling System Wellness Functions

 Opening a Wellness Control Panel
Control Panels for performing System Wellness functions are provided for

various system configurations.

1. In the Browser under the local Datasource, open the Panels folder and
then open the Wellness sub-folder.

2. Double-click the panel name that corresponds to your Timebase
configuration.

3. The control panel opens and then the Dionex Chromatography
Management System attempts to connect to the timebase assigned to the
panel.

4. If an error message appears stating that the timebase was not found, close
the message and then select Connect to Timebase from the Control
menu. Select the timebase to be connected to the panel.

5. After communication is established with the timebase, the various
calibration and diagnostic controls on the panel are enabled.
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 Viewing and Restoring Calibration Data
Calibration data for a System Wellness supported device is displayed on the
Wellness Control Panel (see How to ...: Actions in the Browser

 Opening a Wellness Control Panel).
The Dionex Chromatography Management System stores three sets of
calibration data for each System Wellness supported device.
• Current is the data most recently sent (uploaded) from the device. It is the

data currently stored in the device memory.

• Previous is the data from the previous time calibration data was uploaded
from the device.

• Factory is the data obtained (uploaded) from the device when it was initially
configured in the System Configuration program (see How to ...: Actions
in the Server Configuration  Enabling and Disabling System
Wellness Functions).

The Wellness control panel displays the current data and the date the current
calibration function was performed. If the factory value is the current data, the
date field displays "---."
• To view previous or factory data or download calibration data from the

Dionex Chromatography Management System to the device, click the
Detail button.

A Calibration Detail dialog box appears that displays the three sets of
calibration data values and their corresponding dates. The dates indicate
when the values were uploaded from the device to the Dionex
Chromatography Management System.

• To download calibration data to the device, select Current, Previous, or
Factory from the list to the right of the Download button. Then, select
Download.

 Performing Device Calibrations
Wellness Control Panels, which are supplied with the Dionex
Chromatography Management System, display calibration data and provide
command buttons for performing device calibrations. After a calibration is
performed, the device uploads the new calibration data to the Dionex
Chromatography Management System.
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 Tip: Many calibrations require setup steps before the actual
calibration command is given. Before selecting a calibration
command button on a control panel, see the topics below for
details about the particular calibration task you are performing.

Devices Calibration Procedures
Pumps,
Detectors,
Autosamplers

 Leak Detector

Pumps  Flow Rate

 Pressure Transducer Offset

 Degas
Detectors  Wavelength (AD25/PDA-100)

 Conductivity Cell (CD20/25/25A, ED40/50/50A,
       IC20/25/25A)

 pH Reference Electrode (ED40/50/50A Amperometry
      Mode)

AS50
Autosampler  Inject Port Volume

 Calibrating the Leak Detector
When to Calibrate: After installing a new leak detector

If the leak detector diagnostic test fails
Every 6 months

Many System Wellness supported devices are equipped with leak detectors.
The calibration procedure for all of the sensors is the same.

1. Thoroughly dry the sensor.

2. Open the System Wellness Control Panel for the device (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).



Actions in the Browser 253

3. Under Calibration, leak detector, press the internal command button to
calibrate the sensor installed in the device itself. Press the external
command button to calibrate the sensor on a controlled device. For
example, for a pump, internal refers to the sensor in the pump and external
refers to the sensor in a chromatography oven controlled by the pump.

4. The device calibrates the sensor and uploads the new value to the Dionex
Chromatography Management System. The Dionex Chromatography
Management System stores this new calibration value as the current value.

 Calibrating the Pump Flow Rate
When to Calibrate: Every 6 months

Items Needed: Backpressure tubing to create 14 MPa ± 2 MPa (2000 psi ± 300 psi).
Use 0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715)
Deionized water
Tared beaker

1. Verify that there is about 14 MPa (2000 psi) of backpressure.

2 Pump deionized water at 1.0 mL/min.

3. Allow the pump to stabilize for at least 5 minutes.

4. Collect water into a tared beaker for exactly 5 minutes.

5. Open the System Wellness Control Panel for the pump (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

6. Enter the weight of the water into the weight entry field under flow rate and
press the Enter key. The Dionex Chromatography Management System
downloads the value to the pump and stores this calibration value as the
current value.
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 Calibrating the Pressure Transducer Offset
When to Calibrate: Every 6 months

1. Turn off the pump flow.

2. Open the waste valve.
• For GP40/50, IP20/25 pumps: The waste valve is on the pressure

transducer. To open the valve, turn the knob about two turns
counterclockwise.

• For GS50/IS25 pumps: The waste valve is on the secondary pump
head. To open the valve, turn the knob one-quarter to one-half turn
counterclockwise.

3. Open the System Wellness Control Panel for the pump (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

4. Press the offset command button under pressure transducer. The pump
calibrates the offset and uploads the new value to the Dionex
Chromatography Management System. The Dionex Chromatography
Management System stores this new offset as the current value.

5. Close the waste valve.

 Degas Calibration
When to Calibrate: Every 6 months

1. Open the System Wellness Control Panel for the pump (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

2 Select the degas command button. The pump performs the degas
calibration and uploads the new calibration value to the Dionex
Chromatography Management System. The Dionex Chromatography
Management System stores this new value as the current degas value.
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 Wavelength Calibration
Use this calibration procedure for the Dionex AD25 and PDA-100 detectors.
Wavelength calibration occurs automatically whenever the detector power is
turned on. In addition, manually run wavelength calibration at the following
times:

When to Calibrate: After a failed wavelength verification test

1. Verify that there is solvent flowing through the cell, the background
absorbance is low, and there are no bubbles in the light path.

2. Open the System Wellness Control Panel for the detector (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

3. Press the wavelength command button under Calibration. The detector
performs the wavelength calibration routine and uploads the results (Pass
or Fail) to the Dionex Chromatography Management System.

If wavelength calibration fails, see the troubleshooting section of the detector
operator's manual.

 Calibrating the Conductivity Cell
When to Calibrate: After installing a new cell (use Method A)

Every 6 months (use Method B)

Items Needed
(Method B Only):

1.0 mM KCl solution: Prepare by dissolving 0.07456 g of reagent grade
KCl in one liter of 18 megohm deionized water
Backpressure tubing to provide at least 7 MPa (1000 psi). Use
0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715)

Method A: For Calibrating New or Replacement Cells
1. Open the System Wellness Control Panel for the detector (see How

to ...: Actions in the Browser  Opening a Wellness Control Panel).
2. In the conductivity cell calibration entry field, type the cell calibration

constant (written on a tag on the conductivity cell's cable) and press the
Enter key. The Dionex Chromatography Management System downloads
the value to the detector and stores the value as the current cell calibration
constant.
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Method B: For Calibrating After Every 6 Months of Use
1. Disconnect the pump output line from the injection valve.
2. Connect the pump output line directly to the inlet of the DS3 or cell.
3. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.
4. Pump 1.0 mM KCl through the cell at 1.0 mL/min.
5. If using a DS3, set the DS3 temperature to the intended operating point and

allow it to reach this temperature.
6. Allow the conductivity to stabilize for about 5 minutes.
7. Open the System Wellness control panel for the detector (see How

to ...: Actions in the Browser  Opening a Wellness Control Panel).
8. Press the calibrate command button under conductivity cell. The detector

calibrates the cell and uploads a new cell calibration constant to the Dionex
Chromatography Management System. The Dionex Chromatography
Management System stores this value as the current cell calibration
constant.
After calibration, the conductivity reading should be 147.00 ± 2 µS/cm and
the cell calibration constant should be between 130 and 190. If this is not
the case, refer to the troubleshooting section of your detector operator's
manual.

9. Flush the KCl solution from the system by pumping deionized water through
the cell. When the conductivity drops to near zero, stop the pump.

10.Reconnect the pump to the injection valve and reconnect the line from the
suppressor to the cell inlet.

 Calibrating the pH Reference Electrode
When to Calibrate: Every 6 months

Items Needed: pH 7 buffer
A second buffer of known pH (usually a calibration buffer that most
closely matches the pH of the eluent used in your application)

1. Carefully remove the combination pH/Ag-Ag/Cl reference electrode from the
amperometry cell, making sure to leave the electrode leads connected to
the cell.

2. Place the electrode into a pH 7 buffer.

3. Wait for the pH reading to stabilize (about 1 minute).
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4. Open the System Wellness Control Panel for the detector (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

5. Press the pH 7 command button under pH electrode.

6. Remove the electrode from the pH buffer, rinse, and then dry it.

7. Place the electrode in the second buffer.

8. Wait for the pH reading to stabilize.

9. Enter the pH of the second buffer into the edit field above the 2nd buffer
command button.

10.Press the 2nd buffer command button.

 Entering the AS50 Inject Port Volume
The inject port volume is the volume of tubing between the AS50 inject port and
the injection valve. The AS50 uses this information to determine how much
fluid to push through the line in order to position the sample correctly in the
loop for precision injections.

When to enter a
new inject port
volume:

Only after installing a new needle seal assembly or after
recalibrating the inject port volume on an existing needle seal
assembly.

For detailed instructions on replacing a needle seal assembly or calibrating the
inject port, refer to the AS50 operator's manual.

1. Open the System Wellness Control Panel for the autosampler (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

2. In the Inject Port Volume field, enter the volume written on the tag on the
new needle seal assembly, or enter the volume determined during
recalibration of the inject port volume on an existing needle seal assembly.

3. Press the Enter key. The Dionex Chromatography Management System
downloads the value to the autosampler and stores this calibration value as
the current value.

 Performing Device Diagnostics
Wellness control panels, which are supplied with the Dionex Chromatography
Management System, display diagnostic test results and provide command
buttons for performing the tests.
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The following tests are available - see How to ...: Actions in the Browser:

 Leak Detector (for any device equipped with a leak detector)
 Wavelength Verification (for AD25 and PDA-100 detectors)

 Testing the Leak Detector
Many System Wellness supported devices are equipped with leak detectors.
The test procedure for all of the sensors is the same.

1. Thoroughly dry the sensor.

2. Open the System Wellness Control Panel for the device (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

3. Under Diagnostic Tests, leak detector, select the internal command
button to test the sensor installed in the device itself. Select external to test
the sensor on a controlled device. For example, for a pump, internal refers
to the sensor in the pump and external refers to the sensor in a
chromatography oven controlled by the pump.

4. The device tests the sensor and reports the results to the Dionex
Chromatography Management System. Possible test results are:
• Passed (Dry)

• Failed (Wet)

• Failed (Open circuit): The sensor may be disconnected. Check the
connection.

• Failed (Short circuit): The sensor may need replacing. Contact Dionex
for assistance.

• Failed (Out-of-calibration): Calibrate the sensor (see How
to ...: Actions in the Browser  Calibrating the Leak Detector) and
retest. If the test still fails, the sensor may need replacing. Contact
Dionex for assistance.

 Wavelength Verification
Use this procedure for the Dionex AD25 and PDA-100 detectors. The
Wavelength Verification test verifies the wavelength accuracy of the AD25 or
PDA-100 detectors. When this test is run, a holmium oxide filter is placed in the
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light path and measured wavelengths are compared to theoretical wavelengths
for holmium oxide.
1. Verify that there is solvent flowing through the cell, the background

absorbance is low, and there are no bubbles in the light path.
2. Open the System Wellness Control Panel for the detector (see How

to ...: Actions in the Browser  Opening a Wellness Control Panel).
3. Under Diagnostic Tests, wavelength verification, press the verify

command button. The detector runs the test and then reports the results to
the Dionex Chromatography Management System. The overall results
(Passed or Failed) are reported and the theoretical and measured values
for three peaks in the holmium oxide spectrum.

If the test fails, run the wavelength calibration (see How to ...: Actions in the
Browser  Wavelength Calibration) and then rerun the verification test.

 Entering Device Parameters
For some devices, System Wellness Control Panel include fields that let you
enter various device parameters.

 Applying a Sodium Correction (for ED40/ED50/ED50A
     Amperometry detectors)

 Applying a Sodium Correction
If you are using a NaCl reference electrode with an ED40, ED50, or ED50A
detector in amperometry mode, turn on the sodium correction parameter. This
adjusts the detector's signal response for the NaCl electrode, instead of for the
default AgCl reference electrode.

1. Open the System Wellness Control Panel for the detector (see How
to ...: Actions in the Browser  Opening a Wellness Control Panel).

2. Under Device Parameters, sodium correction, select On.
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Importing PeakNet (Release 4.5 Through 5.2)
Method Files

Overview
In order to use Method files from PeakNet 5 (PeakNet release 4.5 through 5.2)
with the Dionex Chromatography Management System, they must first be
imported into the Dionex Chromatography Management System.

When imported, the PeakNet 5 Method file is converted into a PGM File
and/or Quantification Method (QNT Method) of the Dionex Chromatography
Management System. Converted PGM files contain timed events and setup
parameters for all modules included in the original PeakNet 5 Method.
Converted QNT files contain component names, retention times, reference
peaks, tolerance, calibration options, groups, and level amounts for each
detector in the PeakNet 5 Method.

PeakNet 5 Methods from the following modules can be imported: AS50,
GP40/GP50, IP20/IP25, AD20, AD25, CD20, ED40, IC20, UI20, DX-120. For
Methods that were created with AI450 software, only the QNT portion of the
Method is converted.

Because of differences in the way that PeakNet 5 and the Dionex
Chromatography Management System function, some features available in a
PeakNet 5 Method file are not imported into the Dionex Chromatography
Management System. These include:
• Replicate calibration information

• CE Method parameters

• High/low limit values

• Outlier rejection

• Linear weighting options

In addition, the Dionex Chromatography Management System allows only a
single component table per injection, whereas PeakNet 5 allows one table per
detector. When the PeakNet 5 Method contains multiple detectors, the first
detector is converted entirely, that is, information about every component and
unknown peak is added to the peak table. Then, for the other detector(s), only
unique components and unique unknown groups, which were not in the first
detector's data, are added to the table. This means that any reference
component information for detectors other than the first may be lost.
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How To
1 In the Browser, select a Datasource folder (not a sequence name).

2 Select the Import/Restore command from the File menu and then select
PeakNet 5 and Method Files.

3 In the Import PeakNet 5 Method Files dialog box, navigate to the folder that
contains the PeakNet 5 Method file(s) to be imported. These files are
named with a .MET extension.

4 Select one or more of the Method files and click the Open button. The files
appear in the Selected files list.

5 To convert the PeakNet 5 Method into a PGM file for the Dionex
Chromatography Management System, select the Program box. The PGM
file is created in the folder shown next to the Program box. The default is
the datasource folder currently selected in the Browser. To choose a
different location, click the Browse button and select the desired location.

6 To convert the PeakNet 5 Method component table and calibration
parameters into a QNT method for the Dionex Chromatography
Management System, select the QNT box. The QNT file is created in the
folder shown next to the QNT box. The default is the datasource folder
currently selected in the Browser. To choose a different location, click the
Browse button and select the desired location.

7 Click the Import button. The selected PGM and/or QNT files are created.

The new files have the same name as the PeakNet 5 Method file, but with
PN5 appended and with PGM and QNT extensions. Once a Method file is
converted, the file name is removed from the Selected files list.

 Tip: If the QNT option is selected, but the PeakNet 5 Method does
not contain a detector module, an empty QNT method file is
created.

Also, see:  Importing PeakNet (Release 4.5 Through 5.2) Data Files
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Importing PeakNet (Release 4.5 Through 5.2)
Data Files

Overview
In order to use data files from PeakNet 5 (PeakNet release 4.5 through 5.2)
with the Dionex Chromatography Management System, they must first be
imported into the Dionex Chromatography Management System (Dionex CMS).

When the PeakNet 5 data file is imported, a Sequence for the Dionex
Chromatography Management System is created. The sequence includes the
raw data from the data file, the embedded PeakNet 5 Method (converted into

PGM File and Quantification Method (QNT Method) of the Dionex
Chromatography Management System), and additional information required to
complete the sequence. If multiple data files are selected for import, they are
grouped into one sequence.

If the PeakNet 5 data file contains multiple detectors, a separate sample line in
the sequence is created for each detector (up to four).

How To
1 In the Browser, select a Datasource folder (not a sequence name).

2 Select the Import/Restore command from the File menu and then select
PeakNet 5 and Data Files.

3 In the Import PeakNet 5 Data Files dialog box, navigate to the folder that
contains the PeakNet 5 data file(s) to be imported. These files are named
with a .DXD or .Dxx extension (where xx is 01 - 99).

4 Select one or more data files and click the Open button. The files appear in
the Selected files list.

5 The selected data files will be imported into the folder shown in the PeakNet
Folder box. The default is the datasource folder currently selected in the
Browser. To import the data file(s) into a different location, click the Browse
button and select the desired location.

6 In the Sequence Name box, enter a name for the sequence to be created
from the imported data files.

7 Click the Import button. The selected PeakNet 5 data files are imported into
the Dionex Chromatography Management System.

The following files are created:
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• One sequence, which contains a sample line for each PeakNet 5 data file
selected for import. If any of the data files contained data from multiple
detectors, separate sample lines are created for each detector's data.

• One PGM file and one QNT file for each sample in the sequence. The
PGM and QNT files are created from the PeakNet 5 Method embedded in
the PeakNet 5 data file.

The PGM and QNT files are named as follows: the Method file name from the
PeakNet 5 data file is used, followed by a three digit identifier, which
corresponds to the detector's position in the sequence, and then a pgm or qnt
extension.

Example
In the Import PeakNet 5 Data Files dialog box, three data files are selected for
import.

After importing, the following sequence is created. Notice that because the
Bioamine.d04 data file contained data from two detectors, two sample lines
were created in the sequence:



264 Actions in the Browser

The following PGM and QNT files were also created. These correspond to the
programs and methods listed in the sequence:

Also, see  Importing PeakNet (Release 4.5 Through 5.2) Method Files

PeakNet (Release 4.5 Through 5.2)
Translation Tables
See the following topics for how PeakNet (releases 4.5 through 5.2) setup and
timed event Method parameters are translated to PGM file commands of the
Dionex Chromatography Management System.

 AS50 Autosampler
 Pump Modules and Eluent Generator
 AD20 Detector
 AD25 Detector
 CD20 Detectors
 ED40 Detectors
 IC20 Systems
 DX-120 System
 UI20 Module

See the following topic for how PeakNet (release 4.5 through 5.2) component
table parameters are translated to QNT method parameters of the Dionex
Chromatography Management System.

 Detector Component Table Translation

 AS50 Autosampler Setup and Timed Event Parameter
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Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

TTL 1 (checked/unchecked) Sampler_TTL_1.State (=0v/5v) Setup & timed
portions

TTL 2 (checked/unchecked) Sampler_TTL_2.State (=0v/5v) Setup & timed
portions

Relay 1 (checked/unchecked) Sampler_Relay_1.State
(=Closed/Open)

Setup & timed
portions

Relay 2 (checked/unchecked) Sampler_Relay_2.State
(=Closed/Open)

Setup & timed
portions

CSV (A/B) ColumnValve.State(=Col_A/Col_B) Setup & timed
portions

Sample NeedleHeight NeedleHeight Setup portion
ColumnTemperature ColumnTemperature Setup portion
TrayTemperature TrayTemperature Setup portion
Cycle Time Cycle Setup portion
Valve (Load/Inject) Load/Inject

If Inject, command "Wait InjectState"
is added

Setup & timed
portions

Pipet function
(Source/Volume/Destination)

Pipet (SourceVial/Volume/
DestinationVial)

Setup portion

Mix function
(Vial/Volume/Cycles)

Mix
(SourceVial/Volume/NumberOfTime
s)

Setup portion

Flush function (Volume) FlushSP (Volume) Setup portion
Delay function (Delay Time) DelaySP (Time) Setup portion
Needle function (Height) SetNeedleHeight (Height) Setup portion
Dilute function
(Concentrate Source/
Concentrate Volume/
Diluent Source/
Diluent Volume/
Destination)

Dilute
(SourceVial/
ConcentrateVolume
SourceReservoir/ DiluentVolume/
DestinationVial)

Setup portion

Dispense function
(Source/Volume/Destination)

Dispense (SourceReservoir/Volume/
DestinationVial)

Setup portion

Wait function Wait (SamplePrep) Setup portion
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Wait for stable temperature
(checked/unchecked)

WaitForTemperature (=True/False) Setup portion
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In any case 2 commands are added:
1."Flush   Volume=100"
2."Wait    FlushState"

Setup portion

Syringe Speed always set to default
value = 3

Setup portion

CutSegmentVolume always set to
default value = 0

Setup portion

Output Labels Not converted
Comments Comments
Description Comments

 Pump and Eluent Generator Setup and Timed Event
Parameter Translation
Pump Modules Translation Table

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Oven Temperature Temperature Setup portion
High Pressure Limit Pressure.UpperLimit Setup portion
Low Pressure Limit Pressure.LowerLimit Setup portion
Eluent Label(A/B/C/D) (%A/%B/%C/%D).Equate Setup portion
Eluent percentage (B/C/D) %B/%C/%D Timed portion
Inject
(checked/unchecked)

InjectValve.State
(=InjectPosition/LoadPosition)

Setup & timed portions

Column
(checked/unchecked)

ColumnValve.State
(=Col_B/Col_A)

Setup & timed portions

TTL 1 (checked/unchecked) Pump_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2 (checked/unchecked) Pump_TTL_2.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

Pump_Relay_1.State
(=Closed/Open)

Setup & timed portions

Relay 2
(checked/unchecked)

Pump_Relay_2.State
(=Closed/Open)

Setup & timed portions

Flow Flow Setup & timed portions
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Eluent percentage (%A) Not converted Calculated from %B,
%C, and %D

Pump (On/Off) Not converted
Curve Curve
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Comment Comments
Piston Size Not converted Set in Server

Configuration instead
Pressure Units Not converted Set in Server

Configuration instead
Description Comments

Eluent Generator Translation Table
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Eluent Concentration Concentration Timed portion
TTL 1(checked/unchecked) EluentGenerator_TTL_1.State

(=0v/5v)
Timed portion

Offset Volume Not converted Set in Server
Configuration instead

Curve Curve
Eluent Label Not converted
TTL 1 Output Not converted

 AD20 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time UV_VIS_1.AcqOff

(at time=time of AcqOn + Time)
Timed portion

TTL 1(checked/unchecked) UV_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) UV_TTL_2.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

UV_Relay_1.State
(=Closed/Open)

Setup & timed portions

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Relay 2
(checked/unchecked)

UV_Relay_2.State
(=Closed/Open)

Setup & timed portions

Offset (checked) Autozero Setup & timed portions
Mark   (checked) UV_Analog_out.Mark Setup & timed portions
Range UV_Analog_out.Recorder_Range Setup & timed portions
Wavelength Wavelength Setup & timed portions



268 Actions in the Browser

Collection Begin (checked) UV_VIS_1.AcqOn Setup or timed portion
UV Lamp      (Off/Low/High) UV_Lamp      (=Off/Low/High)

If =Low/High, command
"Wait UV_Lamp_Ready" is added

Setup portion

Visible Lamp (Off/Low/High) Visible_Lamp (=Off/Low/High) Setup portion
Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted

 AD25 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time UV_VIS_1.AcqOff

(at time=time of AcqOn + Time)
Timed portion

TTL 1(checked/unchecked) UV_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) UV_TTL_2.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

UV_Relay_1.State
(=Closed/Open)

Setup & timed portions

Relay 2
(checked/unchecked)

UV_Relay_2.State
(=Closed/Open)

Setup & timed portions

Offset (checked) Autozero Setup & timed portions
Mark   (checked) UV_Analog_out.Mark Setup & timed portions
Range UV_Analog_out.Recorder_Range Setup & timed portions
Wavelength Wavelength Setup & timed portions
Collection Begin (checked) UV_VIS_1.AcqOn Setup or timed portion
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

UV Lamp      (On/Off) UV_Lamp      (=On/Off)
If =On, command
"Wait UV_Lamp_Ready" is added

Setup portion

Visible Lamp (On/Off) Visible_Lamp (=On/Off) Setup portion
Offset Level UV_Analog_out.Offset_Level Setup portion
Calibration
(Off/Zero/Full Scale)

Recorder_Calibration
(AU/Zero/Full_Scale)

Setup portion
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Polarity (Negative/Positive) UV_Analog_Out.Polarity
(=Negative/Positive)

Setup portion

Rise Time Rise_Time Setup portion
Comment Comments
Description Comments
Labels Not converted
Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted

 CD20 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time AcqOff

(at time=time of AcqOn + Time)
Timed portion

Range (µS) ECD_Analog_Out.Recorder_Rang
e

Setup & timed portions

TTL 1(checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

ECD_Relay_1.State
(=Closed/Open)

Setup & timed portions

Relay 2
(checked/unchecked)

ECD_Relay_2.State
(=Closed/Open)

Setup & timed portions

Offset (checked) Autozero Setup & timed portions
Mark   (checked) ECD_Analog_Out.Mark Setup & timed portions
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Temp. Comp. Temperature_Compensation Setup portion
Cell Temp. DS3_Temperature Setup portion
SRS Current
(Off/50/100/300/500 Ma)

SRS_Current
(=Off/50/100/300/500)

Setup portion

Collection Begin (checked) AcqOn Setup or timed portion
Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted
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 ED40 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time AcqOff

(at time=time of AcqOn + Time)
Timed portion

Range (µS) ECD_Analog_Out.Recorder_Range Setup & timed
portions

TTL 1(checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed
portions

TTL 2(checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed
portions

Relay 1
(checked/unchecked)

ECD_Relay_1.State (=Closed/Open) Setup & timed
portions

Relay 2
(checked/unchecked)

ECD_Relay_2.State (=Closed/Open) Setup & timed
portions

Offset (checked) Autozero Setup & timed
portions

Mark   (checked) ECD_Analog_Out.Mark Setup & timed
portions

Temp. Comp. Temperature_Compensation Setup portion.
Only for
ED40/ED50c
(conductivity)

Cell Temp. DS3_Temperature Setup portion.
Only for
ED40/ED50c

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

SRS Current
(Off/50/100/300/500 mA)

SRS_Current
(=Off/50/100/300/500)

Setup portion.
Only for
ED40/ED50c

Amperometry Cell (On/Off) Cell (=On/Off) Setup portion.
Only for
ED40/ED50d (DC
amperometry) &
ED40/ED50i
(integrated
amperometry)

Oven Temperature
(enabled)

Oven_Temperature Setup portion.
Only for
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ED40/ED50d &
ED40/ED50i

Voltage DC_Voltage Setup portion.
Only for
ED40/ED50d

Collection Begin (checked) AcqOn Setup or timed
portion

Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted

 IC20 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time ECD_1.AcqOff

(at time=time of AcqOn + Time)
Timed portion

High Pressure Limit Pressure.UpperLimit Setup portion
Low  Pressure Limit Pressure.LowerLimit Setup portion
SRS Current
(Off/50/100/300/500 Ma)

SRS_Current
(=Off/50/100/300/500)

Setup portion

Oven Temp. DS3_Temperature Setup portion
Temp. Comp. Temperature_Compensation Setup portion
PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Inject(checked/unchecked) Pump_InjectValve.State
(InjectPosition/LoadPosition)

Setup & timed portions

TTL 1(checked/unchecked) Pump_ECD_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) Pump_ECD_TTL_2.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

Pump_ECD_Relay_1.State
(=Closed/Open)

Setup & timed portions

Relay 2
(checked/unchecked)

Pump_ECD_Relay_2.State
(=Closed/Open)

Setup & timed portions

Offset (checked) Autozero Setup & timed portions

Mark   (checked) Mark Setup & timed portions
Flow Pump_ECD.Flow Timed portion
Range Recorder_Range Setup & timed portions



272 Actions in the Browser

Eluent (A/B) Pump_ColumnValve.State
(=Col_A/Col_B)

Setup & timed portions

Collection Begin (checked) ECD_1.AcqOn Setup or timed portion
Pressure Units Not converted Set in Server

Configuration instead
Piston Size Not converted Set in Server

Configuration instead
Pump (On/Off) Not converted
Comment Comments
Description Comments
Labels Not converted
Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted
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 DX-120 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate Data_Collection_Rate Setup portion
Time ECD_1.AcqOff

(at time=time of AcqOn + Time)
Timed portion

Pump (On/Off) Pump (=On/Off) Setup portion
Column (A/B) Column (=A/B)

Wait RinseComplete command
added

Setup portion
Only if System Mode is
Column

Pressure (psi/MPa) PressureUnit (=psi/MPa) Setup portion
SRS/Cell (On/Off) SRS (=On/Off) Setup portion
Eluent Pressure (On/Off) EluentPressure (=On/Off) Setup portion
Offset (checked) Autozero Setup & timed portions

Inject(checked/unchecked) Pump_InjectValve.State
(InjectPosition/LoadPosition)

Setup & timed portions

TTL 1(checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed portions
Controlled AC
(checked/unchecked)

ControlledAC (=On/Off) Setup & timed portions

Eluent (A/B) Eluent (=A/B) Setup & timed portions
Only if System Mode is
Eluent

Collection Begin (checked) ECD_1.AcqOn Setup or timed portion
System Mode Not converted
Comment Comments
TTL Output Labels Not converted
Plot Scales
(Minimum/Maximum)

Not converted

Detector Units Not converted
X-Y Data Not converted
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 UI20 Setup and Timed Event Parameter Translation

PeakNet (Release 4.5
Through 5.2) Method
Parameter

PGM Command of the Dionex
Chromatography Management
System Comments

Rate (A&B) Data_Collection_Rate Setup portion
Time (A&B) Channel_A.AcqOff for Channel A

Channel_B.AcqOff for Channel B
(at time=time of AcqOn + Time)

Timed portion

TTL 1(checked/unchecked) Interface_TTL_1.State (=0v/5v) Setup & timed portions
TTL 2(checked/unchecked) Interface_TTL_2.State (=0v/5v) Setup & timed portions
TTL 3(checked/unchecked) Interface_TTL_3.State (=0v/5v) Setup & timed portions
TTL 4(checked/unchecked) Interface_TTL_4.State (=0v/5v) Setup & timed portions
Relay 1
(checked/unchecked)

Interface_Relay_1.State
(=Closed/Open)

Setup & timed portions

Relay 2
(checked/unchecked)

Interface_Relay_2.State
(=Closed/Open)

Setup & timed portions

Full Scale Voltage (mV)
(10/100/1000/10000)

Full_Scale_Voltage
(0.011/ 0.110/ 1.100/ 11.000)

Setup portion

Collection Begin (checked) Channel_A.AcqOn for Channel A
Channel_B.AcqOn for Channel B

Setup or timed portion

Comment Comments
Labels Not converted
Plot Scales
(Minimum/Maximum)

Not converted

Units Not converted
X-Y Data Not converted
TTL Inputs Not converted
Trigger Not converted
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 Detector Component Table Parameter Translation

PeakNet Release 4.5
Through 5.2  (PN5)
Component Table
Parameter

QNT Method
Parameter of the
Dionex
Chromatography
Management System Comments

Component Name Peak Name
Retention Time Retention Time If peak Reference Component

column  = None then Retention Time
options are set to Absolute.
If peak Reference Component =
<Component> then Retention Time
options are set to Time Distance to
Reference Peak and Reference
Peak = <Component> is assigned

Tolerance Window If Tolerance = time then Window
options are set to Absolute and
Greatest.
If Tolerance = % then Window
options are set to Relative and
Greatest.

Reference Component Retention Time Options See Retention Time comments for
rules.

Internal Standard
Component

Standard If global PN5 calibration options =
External then all DDS Standard =
External
If global PN5 calibration options =
Internal then
- If Internal Standard Component =
Internal Standard then "Use this
peak as Internal Standard" option is
set.
- If Internal Standard Component =
<Component> then Internal Standard
is set and Associated ISTD Peak is
assigned.

Calibration Standards
Level [1...32] Amounts

Amount column for each
level

An amount column for each level
labeled Std1, Std2, … Stdn is
inserted where n = total levels. The
amounts for each peak in the table
are filled in.

Check Standards Level
[1...32] Amounts

Amount column for each
level

An amount column for each level
labeled CStd1, CStd2, … CStdn is
inserted where n = total levels.  The
amounts for each peak in the table
are filled in.
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PeakNet Release 4.5
Through 5.2  (PN5)
Component Table
Parameter

QNT Method
Parameter of the
Dionex
Chromatography
Management System Comments

Curve Fit Type Calibration Type If Cubic in PN5 then set to quadratic.
- PN5 Fit Linear/quadratic with Origin
= Force is Linear/quadratic in the
DDS.
- PN5 Fit Linear/quadratic with Origin
= Ignore is Linear/quadratic with
Offset in the DDS.
- PN5 Fit Linear/quadratic with Origin
= Include is Linear/quadratic with
Offset and Include point (0,0) options
in the DDS.
- All DDS are set to No Weights.
- No Average Response Factor in the
DDS so set to Linear.

Origin Calibration Type See Curve Fit Type for rules.
Calibrate By Calibrate By - Area or Height

- If Relative then set to Relative Area
for Identified Peaks Only.

Relative Response
Component

Response Factor Relative to Peak is set and correct
peak is assigned.

Relative Factor Response Factor Value for factor is assigned.
Groups Groups - For each peak in a group the DDS

group item is set to that name.
- For each time range in a group, the
range is added to Unidentified Peaks
list.

Standardization External/Internal See handling in Quantification
section above.

Calibration Standard
Volume

Reference Inject
Volume

Amount Units Dimension of Amounts
Replace Retention Time Use recently detected

retention times
checkbox is checked

Last Standard Options = Last Value

Low Limit Amount Not Available (N.A.)
High Limit Amount N.A.
Total Levels for
Calibration Standards

N.A.
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PeakNet Release 4.5
Through 5.2  (PN5)
Component Table
Parameter

QNT Method
Parameter of the
Dionex
Chromatography
Management System Comments

Total Levels for Check
Standards

N.A.

Replicates Table N.A. No replicate information will be
converted from PN5.

Replicates N.A.
Rejection of Outlier N.A.
Linear Weighting N.A.
Replace/Average
Response

N.A.

Sample Volume Default N.A.
Sample Weight N.A.
Dilution Factor N.A.
Internal Standard
Amount

N.A.

Unknown Response
Factor

N.A.

Response for Unknowns N.A.
CE Information N.A. If CE information is contained it will

not be converted to the DDS.
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Actions in the Control Panel
See the following topics for details on how to load a  Control Panel and how
to modify controls and the timebase assignment.

 Loading a Control Panel
 Connecting a Control Panel with a Timebase
 Modifying a Control Panel
 Modifying a Control
 Linking a Control to a Device
 Creating a Command Button
 Creating Hidden Windows

In addition, data acquisition can be simulated in a control panel and sample
and sequence information can be displayed:

 Using/Recording Demo Data

 Displaying Sample and Sequence Information

 Loading a Control Panel
Before processing a new unknown samples or operating a controllable
instrument, a Control Panel must be loaded, either manually or automatically:

Manually
• Choose the Open command from the File menu and search for files with

the extension *.pan. In the Open dialog box, choose the object type
Control Panel.

• Alternatively, you can search for the file directly in the Browser.

The Dionex Chromatography Management System includes various default
control panels that offer all standard functions required for operation. Normally,
you will find these in the Panels directory of the local Datasource.
• Select a control panel and open it by double-clicking its name.
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Each window must be connected with a Timebase. When opening the
window, the Dionex Chromatography Management System automatically
establishes a connection to the most recently used timebase. Usually, this
timebase was assigned during installation by the Dionex Service. Naturally,
each window can be connected with any other timebase (see How
to ...: Actions in the Control Panel  Connecting a Control Panel with a
Timebase).

Automatically
When starting the Dionex Chromatography Management System, the most
recent Workspace is loaded. If this view contains a control panel, it will also
be loaded.

If it is not possible to load a workspace, e.g. because no such view was
arranged by the user, the control panel must be opened manually.

 Connecting a Control Panel to a Timebase
When loading a Control Panel, it is automatically connected with the
previously stored Timebase. You can modify the timebase assignment any
time.
• Open a control panel and choose the Connect to Timebase command

from the Control menu.

On the left, the input dialog box shows the name of the current timebase, the
computer name of the corresponding Server and the communications
protocol. On the right, there is the icon for the local computer (My Computer).
If the computer is connected to a network, you will also find an icon for the
network neighborhood.
• Open the directory tree by clicking on the + character.
• If the server is started, all timebases of the local server are listed below My

Computer. If the server is not active, or if no server is installed, the
message The server is not running will be displayed.

• Below Network Neighborhood, you see all PCs currently connected to the
network. Open the directory tree below a computer name to see whether a
Dionex Chromatography Management System server is installed on this
computer. If the server is active, the names of the corresponding timebases
are visible. Otherwise, you will receive the message The server is not
running.

• Select the name of a timebase and complete the input by pressing OK.
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The Dionex Chromatography Management System now connects your control
panel to the corresponding timebase. If the action is successfully completed,
the connected instruments can be controlled via the controls in various colors.

Problems in Establishing a Connection
It depends on the selected network protocol whether a non-local server is
visible or can be accessed. The system requires several seconds to check
whether the selected protocol can be used or not! If no connection is
established to a specific timebase, this can be due to several reasons.
• First, check whether the corresponding server is running.

• If this is ensured, try another network protocol. The Dionex
Chromatography Management System can communicate via various
network protocols, e.g. IPX, TCP/IP, or NetBEUI.

 Caution: Communication between two stations is possible only if the same
(!) network protocol is installed and selected. Generally, it is
sufficient to install the corresponding Microsoft (IPX/SPX
compatible protocol; NetBEUI; TCP/IP) or Novell (Novell IPX
ODI Protocol) network protocols via Settings/Control
Panel/Network/Configuration. Which protocol is actually used
depends on the current network installation. Please contact your
network administrator. If a connection is to be established to a
Windows NT/Windows 2000 computer, this is usually possible
via the protocol Named Pipes.

• Sometimes it may happen that the required timebase exists (Server is
running) but that it is not displayed. If so, open the Connect to Timebase
dialog box again. This may also happen when linking two computers via an
ISDN connection. Usually, the reason is a slightly incorrect network
installation.

• If the IPX/SPX compatible protocol is used, the Activate NetBIOS with
IPX/SPX option should be used under Settings/Control
Panel/Network/Configuration/Properties/NetBIOS.

If it is still not possible to establish a connection, please contact Dionex
Service.
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Problems with Controlling Instruments
In addition to the control mode, the Dionex Chromatography Management
System offers the Monitor Only mode. If a user establishes a connection to a
timebase via a network, the user receives the monitor only status on this
timebase.

The monitor only status is also assigned, when a user attempts to access a
local timebase that us currently used by an external user.

• Deactivate the Monitor Only command in the Control menu to enable
complete control of the timebase.

 Modifying a Control Panel
Select the Control Panel you intend to modify (see How to ...: Actions in the
Control Panel  Loading a Control Panel).

Activating the Layout Mode
• Change to the Layout Mode by selecting it in the context menu.

Adding a Control
• Move the mouse cursor over the Layout Toolbar:

The quick info gives information on the Control where the mouse cursor
is situated.

• Select the desired control via a mouse click. The mouse cursor is now
"loaded" with the corresponding control.

• Position the mouse cursor to where you want to add the new control and
press the left mouse button.

Removing a Control
• Click the left mouse button on the control to be removed. The selected

control is marked by the control frame.

• Press the Delete key to remove the control.
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Modifying the Size and Position of Controls
• Select a control with the left mouse button and assign the desired size by

drawing the Control Frame.

• Select a control, position the mouse cursor on the control, and move it
while pressing the left mouse button. Select several controls by
simultaneously pressing the Shift key.

• Select the function Align (in the Edit menu) to align several controls. The
control frame of the control first selected is used as reference point and
reference size for the other controls.

For information on how to change control properties, see How to ...: Actions
in the Control Panel  Modifying a Control

 Modifying a Control

Online Mode
• Position the mouse cursor over the corresponding Control (= object) and

open the context menu (right mouse button).

• Open the edit box via the Properties option.

Layout Mode
• Click the object with the left mouse button.

• Press the right mouse button within the control frame and open the edit box
via Properties.

Dialog Box "Properties"

Depending on the selected control, the Properties dialog box contains different
tab dialog boxes with the following functions:

Name Function
1. General Determines the size and the text of the control
2. Link Establishes the connection to the device the properties of which shall be

displayed
3. Autosize Determines how the size of the control will change when the complete

panel is increased or decreased in size
4. Color Selects the color for the individual components of the control
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Name Function
5. Style Selects the shape of the control
6. Button Defines if additional Control Panel windows shall be opened via the

respective Command Button and if so which ones (also, see: How
to ...: Actions in the Control Panel  Creating Hidden Windows)

7. Command Enters the command/program to be executed when the Command
Button is pressed.

8. Axis/Decoration Determines the scaling of the axes and the display of the online signals
and the 3D plot

9. Signals Determines which signals shall be displayed using which offset
10. Chrom. Selects overlapping chromatograms in the signal plot
11. Device Selects the pump(s) for which the course of the gradient shall be

displayed
12. Timebase Connects to the selected Timebase

The individual tab dialog boxes are available for the following controls (links to
the respective topics in the Online Help only):

1 2 3 4 5 6 7 8 9 10 11 12

Form X X X X

Check Box X X X

Color Box X X X X

String Display X X X

Gauge Indicator X X X X X

Command Button X X X X

Online Signal Plot X X X X X X

Group Box X X X

Gauge/Slider X X X X X

Lamp X X X X X

Switch X X X X

Edit Field X X X X X

Audit Trail X X
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1 2 3 4 5 6 7 8 9 10 11 12

Gradient Display X X X X X

3D-Plot X X X X

Rack Display X X X

Online Mass Spectrum Plot X X X

For information on how to specify the property of a control, see How
to ...: Actions in the Control Panel  Linking a Control to a Device.

 Linking a Control to a Device
Controls that should display the status or parameters of an instrument must be
"linked" with this instrument.
• Place the mouse cursor over the Control and open the context menu

(right mouse button). Click the Properties and select the Link tab.
• In the field Object, select the destination of the link (e.g. an instrument, a

function (relay), a Channel or a system). In the field Object Properties
select the property or the quantity to be measured which is available for
this destination. Confirm your entry with OK to link the control to the
destination and the property.

Example
If you wish to use e.g. a color box to see whether your pump is connected to
the Dionex Chromatography Management System, select the following setting:

 Tip: Not every control is ideal for representing certain functions or
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parameters. Depending on the selected control, the
corresponding device functions are listed in the field Object
Properties.

 Note: The signal plot, the gradient profile, and the 3D-plot are not
linked via the Link dialog box. The parameters are selected
either via the Signals (signal plot) tab or via the Device (gradient
profile) tab or they cannot be modified (3D-plot).

 Creating a Command Button
A command button can be assigned a command or a sequence of commands.
The command or the program is then executed upon a key click. To create
command buttons, users must have the corresponding authorization.
• Place the mouse cursor over the corresponding button, open the context

menu, select Properties, and open the Command tab dialog box.
• In the list box, all commands to be executed are entered successively. The

syntax corresponds to the Program. Analogous to there, the syntax can
be checked by pressing the Check... button and the operation can be
tested via Try it now before programming is completed.

• You can also start a complete program, which was written previously, via a
Command Button. To do so, copy the full program text and insert it in the
Command tab dialog box. Another possibility is via the command
⇒Branch. Enter the program (+ location) that shall be started after the
command Branch:
Branch „CM_Seminar\\Programs\\Equilibration"

Using this button you could start e.g. program for the equilibration of the
column which is stored on the datasource CM_Seminar under the directory
Programs.

For further details, see Control  Program Syntax.
For practical tips, see How to …:

Actions in the PGM Editor  Creating a Program

Device Control  Extending a Program
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 Creating Hidden Windows
In some cases, a Control Panel has to fulfill so many different functions that
they cannot all fit in one window. In this case, a Command Button can be
created to open an additional window, which may then contain the remaining
controls. For example, the additional window can contain a large signal plot.
Please proceed as follows:
• First, create an additional window: Activate the Layout Mode and select

the command New Window from the menu Window.

• Add a signal plot to the new window, determine its size, and select the
desired properties via the corresponding dialog box (Properties).

• Click on the background of this window (i.e., beside the signal plot) and
from there, open the accompanying dialog box Properties.

• On the tab dialog box General, enter a name (e.g. Signal) and on the tab
dialog box Style deactivate the Initially Visible option.

• Now add a Command Button to the original window and open its
Properties.

• The tab dialog box Button indicates the names and headings for all
windows that belong to this button. Select the new window and activate
Show Form.

Using this control, you may now open the Signal plot.
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 Using/Recording Demo Data

Simulating Data Acquisition
Demo Mode lets you simulate data acquisition by loading a pre-recorded

demo file and then displaying the data from the demo file in the Control
Panel's signal plot. The demo file is "read back" as though the data were being
acquired in real time.
1. To select Demo Mode for a device, start the Server Configuration and

select the device under the Timebase.
2. Select Properties from the Edit or context menu.
3. For detectors, select Read under Demo Mode on the General tab page

and select an existing demo file from the Demo File Name drop-down list.
4. In addition, activate the Demo Mode for all other devices of the timebase on

the corresponding General tab pages.
5. To run the demo file, open the control panel for the device, connect to the

timebase, and then turn on data acquisition. The Data Acquisition dialog
box appears.

6. If the demo file contains more than one channel, select the desired
channel(s) and click OK. The demo file begins running. It runs continuously
(repeats) until data acquisition is turned off.

Recording Demo Data
1. To create a demo file for an installed detector, open the Properties dialog

box in the Server Configuration and select Write under Demo Mode on
the General tab page.

2. Enter a name for the demo file. If the device is connected via the Dionex
DX-LAN, select the Device ID under Communication.

3. To write the demo file, open the control panel for the device and turn on
data acquisition. The data acquired from the detector is recorded in the
demo file.

4. To stop recording data, turn off data acquisition. The demo file is then
complete. Alternatively, instead of starting and stopping data acquisition
manually, you can run a PGM File that turns acquisition on and off.

 Displaying Sample and Sequence Information
In a Control Panel, information that is specific to sequences and samples can
be displayed in addition to the current analysis and status values. The
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information can include the processed sample, the Sequence, the
Datasource, the sample status etc.

To display this type of information, a Control (alphanumeric display) is linked
to one of the following functions (Object Properties):

Comment Datasource Program
Name Sequence ProgramMoniker
Number SequencePath Moniker
Type SequenceMoniker ID

For details on how to change controls, see:

How to ...:  Actions in the Control Panel.
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Actions in the PGM Editor
The PGM editor is used for editing PGM files. It includes three views that can
be accessed via the corresponding icons in the left pane (the so-called shortcut
bar):

• Commands (for creating the program). For details, see How to …:
Actions in the PGM Editor  Creating a Program below.
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• Finnigan AQA (creating the MS method). For details on the MS instrument
method, see How to …: Actions Related to the aQa-MS  Creating a
Method for the aQa-MS.

• Post-acquisition steps (extraction and data smoothing steps after the
data acquisition). For information, see How to …: Actions in the PGM
Editor  Adding Post-Acquisition Steps.

For further details on the PGM Editor, see Basic Operation  PGM Editor.

Creating a Program
To create a Program, various start conditions and ⇒Control Commands must
be recorded precisely. Usually, program creation is via the Program Wizard
while editing is via the  PGM-Editor (Basic Operation topic). However,
creating the program directly in the PGM Editor is possible as well. . The
following minimum entries are required to receive a functioning program:

• Determination of recording signals and their parameters

• Determination of ⇒Flow rate and solvent composition (⇒%A, %B, %C, %D
- for controlled pumps, only)

• ⇒Inject command

• Start of data acquisition (⇒AcqOn/Off)

• End of data acquisition

• End of program (⇒End)

Ensure that all relevant parameters are defined in the program. For parameters
that are not explicitly defined, the Dionex Chromatography Management
System uses the settings of the last sequence.

We recommend creating programs using the  Program Wizard:

First, create the program automatically (see  Automatically Creating a
Program on the next page), and then edit the file manually (see  Manually
Creating a Program on the following page).
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With respect to GLP/GMP we also recommend to add comments to the
program on all chromatographic settings, e.g. column, detector, pumps, and, if
necessary, the sample components plus explanatory notes. However, this is
possible only when editing the file manually.

To see the structure of a simple program, see How to …: Actions in the PGM
Editor  Program Example

Experienced users of the data system GynkoSoft will find useful information
under How to :..: Actions in the PGM Editor:

 Differences from GynkoSoft
 GynkoSoft Translation Table

 Automatically Creating a Program

The basic structure of a Program can be created with the  Program
Wizard.
• Choose File / New and select Program File.
• Enter the required information in the corresponding edit field.
• Press F1 if you need further help.

At the end of the input procedure, the system creates a functioning program
based on your entries, without any requiring a special syntax or programming.

This program is a basic structure that can be modified or extended, as
described under How to ...: Actions in the PGM Editor  Manually
Creating a PGM File
For a simple example, see How to ...: Actions in the PGM Editor

 Program Example
For examples for the corresponding special programs, see How to ...: Actions
in the PGM Editor

 Creating an Emergency Program

 Creating a Power-Failure Program
For an overview of the numerous programming capabilities, see How to …:
Device Control   Extending a Program
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 Manually Creating a Program
The following steps describe how to manually modify and save a Program.
(Note: For information on how to create a new program, see Actions in the
PGM Editor  Automatically Creating a Program).

General
• Choose the File Open command and select an existing PGM file.

• Ensure that the server has been started via the Monitor Program.

• Connect the PGM file to a timebase by choosing the Connect to
Timebase command from the Control menu. Select the timebase that will
use the completed PGM file.

• Position the cursor on the place you wish to modify, or press Enter to
create a new program line.

Entering commands/status variables
• Press the F8 key to open the edit box facilitating input.

• Choose the instrument (in the following called Device) for which you want
to edit an instruction. A device can be any instrument of a timebase, but
also an installed channel, a relay, a remote input, or the system itself. A
device is represented by the  symbol. Click the preceding + character
to see details.

• Each device has its own commands ( ) and/or properties ( , , , ).

• As soon as you select a command or a property, further edit fields and a
short help text (Help) will appear in addition to the retention time field.

• Enter the retention time at which to execute the command.

• Assign the required value (e.g. a number) or a status (e.g. On) to the
command / property.

• Press OK to complete the input, press OK & Prev or OK & Next to change
the previous or the next program line.

• Repeat the input procedure until all commands are changed.
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Checks during command input
• During the entry, the Dionex Chromatography Management System checks

the commands from different angles (also, see Check Command):

Syntax check: Does the entry correspond to the formal rules of the PGM
language?

Semantics check: Does the PGM file make sense with regard to
chromatography?

• If an error is detected, the corresponding line is written in red. Check and
correct the entry. If necessary, repeat this procedure using the F8 input
box.

Adding comments
• Use a semicolon to start the comment. The complete line following the

semicolon is written in green to indicate that the Dionex Chromatography
Management System treats the text as comment.

• Save the result as a new PGM file (Save as).

  Note: Experienced users can enter these commands directly, i.e.
without opening the F8 edit box. However, this requires profound
knowledge of the  Program Syntax.

For a simple example of a PGM file and an overview of the available
programming possibilities, see How to ...: Actions in the PGM Editor

 Program Example
For examples for the corresponding special programs, see How to ...: Actions
in the PGM Editor

 Creating an Emergency Program

 Creating a Power-Failure Program
For an overview of the numerous programming capabilities, see How to ...:
Device Control

 Extending a Program
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 Program Example
A Program for a 20 minute chromatogram, at a flow rate of 1 ml/min, with the
components A (60%) and B (40%), the signals UV_VIS_1 (256nm), UV_VIS_2
(300nm) and a 3D-field that is recorded in the 200 to 360 nm range at a step of
0.5 seconds, could thus have the following appearance:

Pressure.LowerLimit = 5
Pressure.UpperLimit = 250
%A.Equate = "%A"
%B.Equate = "%B"
%C.Equate = "%C"

3DFIELD.MaxWavelength = 360.0
3DFIELD.MinWavelength = 200.0
3DFIELD.BunchWidth = 1.9
3DFIELD.Step = 0.5
3DFIELD.RefWavelength = 600.0
3DFIELD.RefBandwidth = 1.9

UV_VIS_1.Wavelength = 256
UV_VIS_1.Bandwidth = 1
UV_VIS_1.Step = 2
UV_VIS_1.Average = On
UV_VIS_1.RefWavelength = 600
UV_VIS_1.RefBandwidth = 1

UV_VIS_2.Wavelength = 300
UV_VIS_2.Bandwidth = 1
UV_VIS_2.Step = 2
UV_VIS_2.Average = On
UV_VIS_2.RefWavelength = 600
UV_VIS_2.RefBandwidth = 1

Flow = 1.000
%B = 60
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0.000 UV.Autozero
Inject
3DFIELD.AcqOn
UV_VIS_1.AcqOn
UV_VIS_2.AcqOn

20.000 3DFIELD.AcqOff
UV_VIS_1.AcqOff
UV_VIS_2.AcqOff

End

Notes:

• A program for processing a sample batch must contain the ⇒Inject,
⇒AcqOn/Off, and ⇒End commands.

• It is possible but not necessary to include the commands for controlling the
pump and the detector. Instead of entering the ⇒Flow rate, eluent
composition (⇒%A, %B, %C, %D), and signal parameters directly on the
instruments, these values can be set via the program, as shown in the
example. This is possible only for controllable chromatography instruments
connected to the data system via a RS232 interface.

• By definition, the injection time is t = 0.000. All commands that are to be
executed before the injection time, have the time entry of t < =0.000 (e.g.
detector lamp on command, here -10.000 min).

• The ⇒LampOn/Off command can be omitted if it is ensured that the lamp
was given enough time to reach operating temperature.

• Commands that are not listed but are automatically considered (e.g. ⇒Step
parameters of the UV_VIS_1 channel) are used with their default values or
the values that were last used (e.g. Step = 0.25). The decision that value is
considered depends on the respective device driver.

• In your programs, bear in mind that the instruments need a certain time to
execute the different processes. If you use an HP autosampler, for
example, the program files must be at least 2 min long to allow the

Autosampler sufficient time until the next injection.
For special PGM file examples, see How to ...: Actions in the PGM Editor

 Creating an Emergency Program

 Creating a Power-Failure Program
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 Creating an Emergency Program
If a Batch was aborted automatically due to a severe error, an Emergency
Program can be started. This action can be defined as a rule. This Program
can be executed automatically.

Open the Batch - <Timebase> dialog box via the Error Handling command of
the Batch menu. On the Error Handling tab, select the desired emergency
program in the Emergency Program section via the Browse button.

Example 1:
A failure of the detector lamp represents a serious error, as no data can be
recorded. However, this error should not immediately stop the flow. Instead, the
column should be reconditioned after the abortion of the batch. The following
emergency program can be used for this:

; Program: Emergency.PGM

Recondition column after abort.

0.000 Flow = 1

%A.Value = 0

%B.Value = 100

%C.Value = 0

10.000 Flow = 1

10.500 End
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Example 2:
A serious error occurs, e.g. when the Autosampler has a power failure. In this
case, the entire system should be stopped immediately to prevent further
damage. The emergency program Abort.PGM stops the pump flow and
switches off the detector lamp.

; Program: Abort.PGM

The detector lamp and the pump flow are switched off.

0.000 Flow = 0

Lamp = Off

0.500 End

Also, see:

How to ...: Actions in the PGM Editor  Creating a Power-Failure
Program

 Creating a Power-Failure Program
You can define how the Dionex Chromatography Management System shall
react after a power failure (see Power-Failure Protection). After booting the
server, run a power-failure program first.

Open the Batch <Timebase> dialog box via the Error Handling command in
the Batch menu. On the Error Handling tab, select the desired power-failure
program in the Power Failure Handling section via the Browse button.

If you do not have a power-failure program yet, create one for your respective
timebase. Please ensure that all instruments are reconnected to the Dionex
Chromatography Management System first. As very often self-tests have to be
performed, the ⇒Connect commands should be given 1-2 minutes before the
first ⇒Control Commands are sent to the instruments.

Example:
The following program example can be used e.g. for a Timebase which
contains an ASI-100 Autosampler, a UVD 340S Photodiode Array Detector,
and a P580 pump:
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-2.000 UV.Connect
Sampler.Connect
Pump.Connect

-1.500 Lamp = On

; After being switched on, the UVD 340S needs some time for spectra
; calibration. That is why this command as well needs to be given some
; minutes before starting the data acquisition.

 0.000 Flow = 0.300

 1.000 Flow = 1.000

End

Also, see:

How to ...: Actions in the PGM Editor  Creating an Emergency Program

 Differences from GynkoSoft
The following description is intended for experienced GynkoSoft users who
are interested in the modifications in the new Program.

General Information
If a command is intended for a specific instrument, this is no longer specified as
a parameter (Device, Signal,...), but the instrument is stated before the
command. Between the device name and the command, a period is inserted. In
GynkoSoft the syntax was:

0.000 Autozero Detector=UVD320S

The new syntax in the Dionex Chromatography Management System is:

0.000 UVD320S.Autozero

As before, the instrument can be omitted if no confusion is possible. If there are
several instruments for which the command could be valid, the instrument
MUST be explicitly specified.

The retention time can be omitted if it does not change. It must be specified for
the first command in a group of combined commands.
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Wherever numerical input is expected, a mathematical expression can be
entered, if required. This can include variables (parameters and values such as
signal value, pressure etc.) and the usual operators (+ - * /, brackets).

Wherever a logical value is expected, a logical expression can be entered with
the operators = <>, <, >, <=, >=, AND, OR, NOT. All relays, inputs, and further
status parameters can be used as logical variables.

Text, Names

Text parameters (for ⇒Protocol, ⇒Message, Equate) must be in quotation
marks. This does not apply to the names of devices, triggers, commands, etc.

Names can include the letters A-Z, numbers, percent characters, and
underscores. Some names had to be changed, as they contained invalid
characters (e.g. blanks, hyphens or minus signs).

Names can start with a number if no confusion with other numbers is possible
(valid name: 3DFIELD; invalid name: 1E2 as this could be interpreted as
exponential function).

Currently, commands and names cannot be abbreviated.

Variables
Whenever possible commands are replaced or completed by variables (or, as
in Online, Object Properties). Instead of the Lamp On and Lamp Off
commands, there is now the ⇒LampOn/Off variable that can assume the
values On and Off. The value of a variable is changed via Variable = Value
(e.g. Lamp = Off). The character =" can be omitted, i.e. Lamp Off is also valid.

Variables considerably improve the readability of a program, as several
variables are defined instead of entering a long command with numerous
parameters. The GynkoSoft command

... Signal Parameter, Signal=UV_Vis_1, Step=0.25, Average=On,
Wavelength=250, Bandwidth=0

reads in the Dionex Chromatography Management System:

... UV_Vis_1.Step 0.25

... UV_Vis_1.Average On

... UV_Vis_1.Wavelength 250

... UV_Vis_1.Bandwidth 0

The Sample Data (Name, ID, Comment, Program, and others) includes
variables that can be used in the program. There are four sets of sample
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variables (Sample, PrevSample, NextSample, PrevStandard) referring to the
current, the previous, the next, and the last standard sample. The entry is
similar to devices, e.g. Sample.Name.

In this sense, ⇒Position and ⇒Volume are not sample variables, but are
assigned to a sampler or a driver for manual injectors. The program can read
and change these variables. The modifications are re-entered in the sample
data record.

All data points recorded by the Dionex Chromatography Management System
(signal values, inputs, pressure, temperature...) are also available as variables,
but cannot be modified.

Some variables include several values (e.g. nominal and actual temperature).
Generally, the Dionex Chromatography Management System recognizes the
correct value. For the oven, the actual value is shown, but the nominal value is
changed. Changing this is theoretically possible by explicitly specifying the
value (separated by a period). The nominal temperature is thus
Temperature.Nominal, and the actual temperature is Temperature.Actual.
The following sub-variables are possible:

Actual Actual value
Nominal Nominal value (e.g. temperature)
UpperLimit Upper limit (e.g. pressure)
LowerLimit Lower limit (e.g. pressure)
Equate Name (e.g. %A)

Trigger

A ⇒Trigger can now actuate an entire list of commands. It is no longer
necessary to define several triggers with the same condition. EndTrigger must
mark the end of the list. The commands in the trigger list need not  have a time
definition.

Triggers must always have a name that may not coincide with the name of a
device or a command.

GynkoSoft has a fixed hysteresis of 5%. In the Dionex Chromatography
Management System, the hysteresis can be set for the trigger command with
the parameter hysteresis=x.

DELTA is no longer a trigger variable but can be assigned to any signal as a
property.

 Note: All commands, variables, and their spelling can be viewed via the
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Control menu and the Command command. Use this possibility
to see the syntax of a specific command.

 GynkoSoft Translation Table
The following table shows the translation of each GynkoSoft command in the
Dionex Chromatography Management System (Dionex CMS):

GynkoSoft Dionex CMS Comment
%B, Percent=x %B = x  (see ⇒%A, %B,

%C, %D)
%C, %D etc.

Abort Batch Not yet supported
Acquisition On Channelname.AcqOn

(see ⇒AcqOn/Off)
For each channel separately

Acquisition Off Acquisition Off To switch off all channels, or:
Channelname.AcqOff For an individual channel

Autozero, Detector = Name Name.Autozero
Branch
Column Temperature,
Temperature = x

⇒Temperature = x

Connect ⇒Connect Or with variables:
Connected=Connected

Continue ⇒Continue Or with variables:
HoldMode = Off

DELTA Signal name Signalname.Delta
Disconnect Disconnect Or with variables:

Connected=Disconnected
Dispense Position=x,
Volume=y, Duration=z

⇒Dispense ⇒Position=x,
⇒Volume=y, Duration=z

Equate %A = text %A.Equate = "text"
End Program ⇒End
Execute Device=Name,
Function=Func, ...

Name.Func ...

Flow Total, Flow = x ⇒Flow = x
Hold ⇒Hold (Or with variables: HoldMode

= On)
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GynkoSoft Dionex CMS Comment
Inject ⇒Inject
Lamp On Lamp = On (see ⇒Lamp

on/off)
"=" can be omitted...

Lamp Off Lamp = Off
Message text ⇒Message "text"
Pressure Limits, Lower Limit = x,
Upper Limit = y

Pressure.LowerLimit = x
Pressure.UpperLimit = y
(See ⇒Pressure Limits)

Two separate commands
required

Protocol text ⇒Protocol "text"
Relay On, Relay = r, Duration = x r.On Duration = x Or with variables:

r.Duration = x
r On

Relay Off, Relay = r, Duration = x r.Off Duration = x Or with variables:
r.Duration = x
r Off

Reset ⇒Reset
Segment, Volume = x Suck Position=100,

Volume=x
Position=100 means that the
air volume is drawn
(Command available for
GINA 50 only)

Signal Parameter, Signal = Name,
Parameter=x

Name.Parameter=x For each parameter a
separate line is required

Sound, Frequency=x, Duration=y ⇒Sound, Frequency=x,
Duration=y

Stop Flow ⇒StopFlow Or with variables:
StopMode = On

Suck Position=x, Volume=y,
Duration=z

⇒Draw Position=x,
Volume=y, Duration=z

Trigger Name=n, Cond=y, ...
Command

⇒Trigger n Condition=y,
...
Command
Further Commands
optional...
EndTrigger

See below

Trigger Off Trigger n, Condition = 0
EndTrigger

Must be entered separately
for each trigger

Wait, Input=Name Wait Name Apart from an input, the data
system can wait for any
condition (as trigger)
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Adding Post-Acquisition Steps
The Post-acquisition steps view of the PGM editor allows defining extraction
and data smoothing steps to be performed after data acquisition. These steps
can be performed either online after the data acquisition or offline outside of
chromatograms, UV spectra, and mass spectra.

Click the gray line to add a new post-acquisition step. In the opening dialog
box, select the desired step. The following options are available:
• Extract MS channel ( Mass Trace extraction - possible only after MS

data were acquired.)

• Extract optimum integration path (extraction of the optimum integration
path - possible only after a 3D-field was acquired)

• Extract UV channel (UV channel extraction - possible only after a 3D-field
was acquired)

• Smooth data (chromatogram Smoothing).

For example, the following steps can be added:

In step 1 and step 6, two UV channels are extracted at 254 and 220 nm,
respectively. The EXT254NM channel does not use compression; data that
were acquired at 254 nm are used only. For the EXT220NM, a range von
10 nm was selected, i.e., the wavelengths from 215 to 225 nm were used. In
addition, compression is used during channel extraction. Compression = 3
means that every third datapoint is saved only.
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In step 3 and step 4, two MS channels (MS_1 and MS_2) are extracted. The
first of these mass traces covers the mass range 49.0 to 51.0 amu while the
second once covers masses from 137.0 to 145.0 amu. For both channels, the
Gaussian algorithm is used for data smoothing. Seven points are used for data
smoothing when extracting the MS_N1 channel, while five points are used
when extracting the MS_N2 channel.

In step 2, the Optimum Integration Path is saved as OPTINT channel. In step
5, data smoothing is performed for this new channel using the Savitzky-Golay

Filter. Then, it is saved again as OPTINT_SG_009_001 channel. Filter size:
9 indicates that 9 input datapoints each were used for creating one output
datapoint.

Adding additional steps is via the bottom line or the Insert and Append Line
commands of the context menu.

The post-acquisition steps are performed by the server when data acquisition
of the last channel is terminated and before the System Suitability Test (SST)
is started. In case of network failure (see Network Failure Protection),
execution of the post-acquisition steps is delayed until the network source is
available again.
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Actions in the Chromatogram
The window shows the integrated chromatogram of a sample. Determining and
integrating the peak areas was performed automatically based on the
⇒Detection Parameters. If you want to change the detection parameters for
example because peaks are integrated that are too small or unimportant or
because the baseline does not meet your requirements, you can perform the
change graphically in the chromatogram:

 Defining Detection Parameters Graphically
This function allows defining the detection parameters according to your
requirements. In addition, the detection parameters are available on the
Detection tab of the ⇒QNT Editor (see: How to ...: Actions in the QNT Editor

 Defining Detection Parameters).

If, even then, the representation and/or evaluation of single samples do not
correspond to the expected result, the peak delimiters and the baseline can be
modified manually. It is also possible to display further chromatograms for
comparison. In addition, peaks can be assigned manually and a baseline for
the entire chromatogram (averaged baseline) can be defined. A data filter can
be applied, which smoothes the chromatogram and improves the reproducibility
of peak baselines. For details, see the topics below:

 Manual Re-Integration
 Manual Peak Assignment
 Performing a Chromatogram Comparison
 Performing Data Smoothing

Due to the heavy noise, we recommend performing background subtraction for
mass spectra. This can be defined in the chromatogram as well (see

 Subtracting MS Background Spectra).

For details on displaying a Report or a Spectra Plot, see How to ...:

 Actions in the UV Spectra and Mass Spectra
 Actions in the Report
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Defining Detection Parameters Graphically
Their graphical input considerably facilitates defining the ⇒Detection
Parameters. Proceed as follows:
• If no parameter is indicated in the chromatogram, click the Detection

Parameter Tool that is available via the context menu or the respective
symbol on the integration Toolbar.

• In the chromatogram, move exactly to the location where to enter a
parameter.

• In the context menu, select the Detection Parameter option.

• Here you can directly

Enable/disable to inhibit the integration (Insert Inhibit Integration On -
see How to ...: Actions in the QNT Editor  Inhibiting Peak
Integration),

Enable/disable the integration from valley to valley (Insert Valley to Valley
On),

Enable/disable negative peak integration (Insert Detect Negative Peaks
On), or

Insert a new baseline point (Insert Baseline Point) (for the latter, see How
to ...: Actions in the QNT Editor  Modifying the Baseline.

• Select Insert to insert another parameter.

• The Detection Parameter Tool allows moving the entered parameters to
the desired location in the chromatogram.

The following example corresponds to the table input under How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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In the chromatogram, a dotted vertical line at which the abbreviation for the
parameter and its respective value are given indicates the parameters. In the
illustration, see e.g. the values for the Rider Threshold (in short: RidThd), Rider
Skimming (RidSki) and Maximum Rider Ratio (RidRat) parameters at 1.000
min.

For another way to enter detection parameters graphically, select a
chromatogram area via the right mouse button. The opening context menu
offers the following possibilities:

• Set an averaged baseline (Set Averaged Baseline Start/End), - see How
to ...: Actions in the Chromatogram  Defining an Averaged Baseline

• Define the minimum peak area (Set Minimum Area)

• Define the minimum peak height (Set Minimum Height)

• Define the minimum peak width (Set Minimum Width) (for all Set
Minimum ... commands see How to ...: Actions in the QNT Editor

 Reducing the Number of Evaluated Peaks)
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• Define the peak recognition algorithm (Set Peak Slice & Sensitivity, see
How to ...: Actions in the QNT Editor  Modifying the Peak
Recognition Algorithm) or

• Select a range for the peak inhibition (Set Inhibit Integration Range)

 Note: You can undo the graphical input of detection parameters. Click
into one of the tables of the QNT editor and select the Undo
command of the Edit menu. (In the chromatogram itself, you can
only undo the modifications of the currently open chromatogram.)

Their graphical input enters the newly defined detection parameters to the
Detection tab of the ⇒QNT Editor. They will be used for all samples that are
evaluated using the QNT file of the current sample. Input of the detection
parameters is also possible directly on the Detection tab (see How to ...:
Actions in the QNT Editor  Defining Detection Parameters).

Manual Re-Integration
Manual Re-Integration includes all actions performed directly in the
chromatogram via mouse-click and the different tools on the integration

Toolbar. Thus, changes will always be performed in the current
chromatogram only. This includes the following topics:

 Moving Peak Delimiters
 Modifying the Baseline
 Inserting / Deleting a Peak
 Changing the Peak Type
 Defining an Averaged Baseline

Prerequisite
An integrated chromatogram can be recognized by the red baseline below the
peaks and by the peak delimiters on the left and right of the baseline
(= integration limit).
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 Caution: These elements must be displayed in the chromatogram (see
Decoration / Peak Decoration in the context menu).

For all manual re-integration actions, it is recommended to zoom the area in
which you want to perform modifications. Choose Automatic in the context
menu to mark each place in the chromatogram that you can modify manually.
The shape of the mouse cursor indicates which action is currently possible.

All modifications in the chromatogram can be undone as long as they are not
stored.

In the Edit menu, select the Delete Manipulations command.

 Moving Peak Delimiters
Near the blue peak delimiters, the mouse cursor changes its appearance (if the
Automatic Tool or the Delimiter Tool are selected). It symbolizes peak start
( ) and peak end ( ).

Press the left mouse button and move the mouse cursor to the new peak start
or peak end.

It is not possible to "run over" a peak delimiter. The peak delimiter would be
moved in the same direction. After positioning, the Dionex Chromatography
Management System draws a new baseline. The modified peak properties
Area, Width, Amount etc. are immediately updated and displayed in the
integration report.

Peak delimiters of negative peaks can also be moved. In this case, the
presentation of the mouse cursor is mirrored.

 Modifying the Baseline
If two peaks that are not completely separated in the chromatogram are to be
integrated individually, this is performed by dropping a perpendicular line from
the minimum between the two peaks to the baseline. The intersection with the
baseline is referred to as "baseline node" (a).
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a) b) c)

Baseline node

If the baseline should be drawn from peak end to peak end, activate the
⇒Valley to Valley detection parameter. The baseline node is automatically
moved towards the signal curve until it rests on the curve in the minimum
between two peaks (b).

Each baseline node can be moved along the perpendicular line and can be
freely positioned ("freely floating baseline node" (c)). If either state (a) or (b) is
approached, the mouse cursor automatically clicks into place. The shape of the
mouse cursor ( , ) indicates the currently performed action. Use the
Automatic Tool or the Delimiter Tool.
At the end of a baseline, freely floating baseline nodes can be generated (d, e).

e)d) f)

The system automatically makes a distinction between moving a peak delimiter
horizontally and a baseline node vertically depending on the direction in which
the mouse cursor is drawn.

Between two baseline nodes, the entire baseline can be moved in vertical
direction (f). The shape of the mouse cursor ( ) indicates whether the action is
possible.

 Note: Inserting freely floating baseline nodes was not possible with the
data system "GynkoSoft."
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 Inserting / Deleting Peaks

Inserting a Peak
In each free position of the chromatogram, and on the ascending and
descending flanks of a peak, a new peak (i.e. a baseline and two peak
delimiters) can be inserted later.

A small peak ( ) on the right side of the mouse cursor indicates the places
where this is possible. A warning sign ( ) indicates the places where this is not
possible.
• Open the context menu and select the Insert Peak Tool command. The

mouse cursor now indicates the places where a peak can or cannot be
inserted. Other actions (edit modes) are not possible at this point.

Deleting a Peak
If the mouse cursor is positioned over a peak, the peak can be deleted.
• Open the context menu and select the Delete command.

The peak delimiters and the baseline of the peak are removed.

 Changing the Peak Type
If the mouse cursor is positioned over a peak, the peak type can be changed.

• Open the context menu and select the Change to Main Peak or Change
to Rider command.

Use this function to change a main peak into a rider and vice versa. Single
peaks are always interpreted as main peaks and, therefore, cannot be
converted into rider peaks. The context menu indicates: Can't Change Peak
Type.

Whether a peak is classified as a main peak or a Rider depends in the
automatic classification exclusively on the ⇒Rider Threshold and ⇒Maximum
Rider Ratio parameters.

 Defining an Averaged Baseline
By means of two points, which can be entered in the chromatogram, you can
define a baseline for the entire chromatogram (= averaged baseline) as follows:
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• In the chromatogram, use the right mouse key to select an area at the
beginning of the chromatogram. The first ⇒Baseline Point shall be in the
middle of this area.

• In the context menu, select the Set Averaged Baseline Start command.

This sets the first baseline point. The x-value is the middle of the selected area
while the y-value is the averaged value of the signal values weighted by the
data rate. This first value will not be marked, as it is not sufficient for setting the
baseline. A second point is required as well.

 Note: If you exit the Dionex Chromatography Management System
without having entered the second point, the first point will be
deleted.

To enter the second point proceed as follows:
• In the chromatogram, use the right mouse key to select an area

somewhere at the end of the chromatogram. The second baseline point
shall be in the middle of this area.

• In the context menu, select the Set Averaged Baseline End command.

This action sets the second baseline point. The new baseline is drawn through
both points, which are marked by a red cross.

You can modify the averaged baseline later in two ways:

1. by selecting a new baseline point, which then replaces one of the former
ones.
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2. by means of the baseline tool on the Integration Toolbar. (See How
to ...: Actions in the Chromatogram  Modifying the Baseline)

Manual Peak Assignment
(Dialog box "Properties of Peak No. x")
If you have inserted a new peak, or wish to name existing or unidentified
peaks, or rename incorrectly identified peaks, you can do this in the
chromatogram either via the  QNT Editor or in a report.

• Click the respective peak and use the Peak Properties command in the
context menu to open the dialog box Properties of Peak No. x or double
click the peak.

• Enter the corresponding name under Component or select one of the
names listed in the combo box. Pressing <Return> or the lowest symbol
bottom inserts the peak into the peak table of the QNT method using the
retention time of the current chromatogram and the settings of the previous
peak (as far as sensible).
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• It is also possible to rename an identified peak by manually assigning it a
different name. Enter the new name or select one of the names listed in the
combo box and confirm your entry by pressing the first symbol button. Via
the additional symbol buttons, you can cancel this action or delete all
manual peak assignments (see quick info for the buttons). Manual peak
assignments of identified peaks are not transferred to the QNT method but
apply to the currently open chromatogram only.

You do not have to close the dialog box to continue working in the
chromatogram. <Return> accepts a new entry in the peak table of the QNT
editor (provided that the peak has not yet been assigned there). The dialog box
then indicates the values of the next peak to be assigned. The dialog box
remains open until explicitly closed or until the chromatogram is closed.

 Note: The manual peak assignments are saved in the Quantification
Method. However, manual peak assignments for identified peaks
are not included in the QNT method but are valid for the currently
open chromatogram only.
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Performing a Chromatogram Comparison
The Dionex Chromatography Management System allows comparing several
chromatograms. Different options are available for displaying different samples
or several Channels of the same sample. Comparing different channels of
different samples is possible as well. The samples / channels must be selected
and related to each other.

For details, see the following topics:

 Selecting the Samples and Channels
 Displaying Several Chromatograms
 Normalizing Chromatograms

 Selecting the Samples and Channels
Different alternatives are available to select samples and channels that are to
be displayed as Overlays:
• Display the chromatogram of a sample in an integration window by opening

the sample, e.g., by double-clicking its name in the Browser.

Select one or several samples of one ⇒Sequence in the Browser and drag
the sample(s) into an open integration window while pressing the left
mouse button. The action is indicated by a + sign on the mouse cursor.
After letting go the mouse button, the chromatogram of the sample(s) is
displayed. The same channel is used as for the reference sample.

Instead of selecting a sample in the Browser and dragging it into an open
integration window, you may also select the sample in the integration view
using the Add Overlay command of the File menu. The chromatogram of
the first sample will then be overlaid by the chromatogram of the selected
one.

Or:
• Select several samples in the Browser, open the context menu, and select

Compare. The submenu of this command offers a list of all recorded
channel types. After selecting a channel, the chromatograms of all samples
with raw data for this channel are compared.
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Or:
• Select a sample in the Browser, open the context menu, and select All

Channels to compare all channels of a sample in a separate window.
Pressing F4 key or the key combination Shift+F4 displays the channels of
all samples in a sequence successively.

If several samples are selected, all channels of the first selected sample
are displayed. By pressing the F4 key or the key combination Shift+F4, you
can browse through the selected samples.

Or:

• Click the Next/Previous Chromatogram icons ( / ) while pressing the
Ctrl key to insert the chromatogram of the next or previous sample.

Or:
• Perform a Query over several sequences or Datasources. Open the

context menu and select the Compare command. The submenu of this
command offers a list of all recorded channel types. After selecting a
channel, the chromatograms of all samples with raw data for this channel
are compared.

Or:

• Click the Next Channel icon ( ) while holding down the Ctrl key to insert
the next channel of the same sample.

• Click the Previous Channel icon ( ) while holding down the Ctrl key to
insert the previous channel of the same sample.

 Displaying Several Chromatograms
After adding an Overlay (= an additional chromatogram), you can define the
display arrangement for the two chromatograms. Proceed as follows:
• Select the Decoration... command in the context menu of the

chromatogram plot.

• In the Chromatogram Decoration dialog box, choose the Comparison
tab and define the chromatogram Arrangement:
The Overlay option allows displaying the overlay of the single
chromatograms in one single plot (see the left section of the screenshot
below).
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Use the Stack option to display the chromatograms one below the other in
different plots (see the right section of the screenshot below).

The Mixed option combines the Overlay and the Stack option.
Chromatograms of different detectors are displayed as single plots.

The Overlay view allows adding an additional signal axis (on the right) for the
overlaid chromatogram that was added last via the Overlay with right signal
axis command. This command, too, is available on the Comparison tab of the
Chromatogram Decoration dialog box. Thus, you can select a different signal
range for the chromatogram that was added last. The Stack view allows
individual scaling of the signal axis for each single chromatogram.

To offset the chromatograms in x- and/or y-direction in the Overlay view, use
the signal or time offset that can be set on the Comparison tab.

• Activate the Time checkbox to move the current chromatogram in the x-
direction.

• Activate the Signal checkbox to move the current chromatogram in the y-
direction.

The offset is specified in percent of the signal or time axis. A signal offset of 5%
shifts each of the following chromatograms upwards by 5%. Accordingly, a time
offset causes a percentage alteration in the x-direction. This results in a
"pseudo-3D" presentation.

 Normalizing Chromatograms
For a sensible comparison of different chromatograms, often a common
reference point is chosen for the overlaid chromatograms (see Overlay). The
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chromatograms are normalized. As the default, the ⇒Retention Time is used
for the normalization, i.e., all chromatograms are arranged so that their start
points match (t = 0).

Alternatively, chromatograms can use a common peak as their reference point.
• Choose the Decoration command of the context menu and open the

Comparison tab dialog box.
• Select the reference peak from the At Peak list box.
• Choose Shift if this is to be performed independently from the length of the

chromatogram.
• Choose Stretch if the chromatograms are to be stretched or compressed

in x-direction, so that there is a time scaling in all chromatograms. The
stretch 0 to 1min (or n min) has the same length for all chromatograms.

• Activate the Normalize Signal check box if the height of the desired
chromatogram peak should match in addition. Depending on how much the
reference peak must be stretched or compressed, all other peaks in the
chromatogram are also stretched or compressed. This enables amount
estimation for the same peaks from different chromatograms. This option is
not available in the Stack view.

Performing Data Smoothing
Data Smoothing can help improve the appearance of chromatograms and the
reproducibility of peak baselines by reducing noise through digital filtering.
Smoothing affects both, the display and the integration of the chromatogram.
When smoothing is completed, the new chromatogram is displayed overlaid on
the original chromatogram. The original data file is not altered and the
smoothed data is saved separately.

For chromatogram smoothing, proceed as follows:

1. Display the sample's chromatogram by double-clicking its name in the
Browser.

2. Right-click on a blank section of the chromatogram window and select
Smoothing from the menu. The Smoothing dialog box appears.

3. Select the Filter Type, Filter Size, and Iterations. See  Data
Smoothing for details.

4. To smooth all the samples in the sequence or Query, select the Apply to
all samples in the current sequence or query check box.

5. In the Smoothed Channel box, enter the name of the smoothed sample
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data that will be created. The suggested name is the current channel name,
followed by the type of filter (MA for Moving Average, OL for Olympic, and
SG for Savitzky-Golay), the filter size, and the number of iterations.

6. Click OK to start the smoothing.

For information on how to smooth MS chromatograms during mass trace
extraction, see How to ...: Actions Related to the aQa-MS   Extracting
Mass Traces Afterwards).

Subtracting MS Background Spectra
As Mass Spectra usually show heavier noise than UV spectra, we
recommend subtracting the background spectra:

Peak-Depending Background Subtraction
Select the Background Subtraction command in the context menu of the
chromatogram. Enable background subtraction via the Enable Background
Subtraction option and select Peak Dependent Range. Depending on the
peaks, the Dionex Chromatography Management system will automatically
determine two ranges for calculating the background and then subtract the
entire mass spectrum of these ranges. The MS tab of the ⇒QNT Editor allows
defining the number of mass spectra to be used for the two ranges (see How
to …: Actions in the QNT Editor  Processing Mass Spectra).

Fixed Background Subtraction for the Entire Chromatogram
At the beginning of the chromatogram, press the right mouse button and select
a baseline range for which to subtract the mass spectra. The corresponding
context menu opens. Select Set Background Subtraction Range 1 to use the
defined range as the first range for which to subtract the mass spectra from the
mass spectra of the single peaks and/or from the retention time spectrum.

 Note: Selecting Set Background Subtraction to Range 1
automatically activates the Fixed Background Ranges option of
the Background Subtraction command in the context menu.

In the same way, select a baseline range at the end of the chromatogram.
Select Set Background Subtraction Range 2 to define this range as the
second range for which to subtract mass spectra from the mass spectra of the
single peaks.
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 Note: Defining the second range is useful but not imperative, as
background subtraction can also be performed using the mass
spectra of the first range only.

The two defined ranges are marked by a horizontal line (in the same color as
the respective spectrum or blue if no spectrum is available) and labeled with
SB1 or SB2 (SB = subtracted background). The number of single mass spectra
that are averaged is given in parenthesis if the background subtraction range
was used:

 Note: Setting the two ranges for background subtraction of mass
spectra is possible in a UV channel as well. However, we
recommend setting the two ranges in the corresponding MS
channel, as only there the respective peaks will be visible.

The Clear Background Subtraction Ranges option allows removing the
previously defined ranges.

Effects
The settings made in the chromatogram are saved in the QNT file of the
current sample. They overwrite the settings on the MS tab of the QNT editor. It
makes no difference whether background subtraction is defined in the
Integration view or in the QNT Editor. Thus, your input affects all samples that
are evaluated using this QNT file.

 Tip: Ensure that no peak of another sample is within the retention
time used as Background Subtraction Range in Fixed mode.
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If you have defined two ranges, these ranges are averaged and the result is
subtracted from the mass spectrum that has been recorded between the two
ranges. The mass spectra of the two ranges are weighted based on the time
distance from where the respective mass spectrum was recorded, i.e., the
range that is nearer to the respective mass spectrum is considered more.

If a mass spectrum is not located between the two ranges, only the averaged
mass spectrum of the range next to the spectrum is subtracted.
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Actions in the UV Spectra and Mass
Spectra

The Spectra window is activated via the Show Spectra command in the View
menu or via the

button and allows representing UV spectra as well as their identification via a
spectra library.

The Mass Spectra window, which is very similar to the Spectra Plot window,
is activated correspondingly via the Show Mass Spectra command or the

button.

For details, see the following topics:

 Displaying a Peak Spectrum (UV or MS)
 Displaying and Overlaying Single (UV or MS) Spectra
 Match Factor, Difference Spectra, 1st /2nd Derivatives of UV Spectra
 Starting a UV Spectra Search

as well as

How to ...: Actions Related to the aQa-MS  Extracting Mass Traces
Afterwards

 Tip: The prerequisite for the spectra representation is the availability
of the corresponding raw data. It is obtained by recording a 3D-
field with a Photodiode Array Detector.
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 Displaying a Peak Spectrum (UV or MS)

• In the neighboring chromatogram window, select the peak of which you
want to view the UV / Mass Spectrum.

The spectrum of the peak is visible (note: if the corresponding raw data is not
available, an error message is displayed).

• Choose the Decorations.. command from the context menu of the (Mass)
Spectra window and determine the peak height at which to extract and
display spectra via Peak Spectra.

Depending on the settings, up to five spectra of the same peak are displayed in
different colors. Normally, the spectra are extracted at 10 and 50% peak height
from the ascending and the descending peak flanks and at the run time of the
peak. The representation of the spectrum is normalized. If the spectra largely
match, this can be a criterion for peak purity.

 Displaying and Overlaying Single (UV or MS) Spectra
In addition to peak spectra (= UV or Mass Spectrum in the peak maximum or
spectrum at a defined peak height), the Dionex Chromatography Management
System is capable of displaying any other spectrum of a chromatogram at the
time t.

Perform the following steps to extract any spectra of a chromatogram via a
mouse click.

• Activate the Spectra Tool command in the context menu or press the
corresponding icon on the Integration Toolbar (for details, see Integration
Toolbar in the Online Help).

• The changed mode is indicated by a spectra symbol that is added to the
mouse cursor.

• Click anywhere in the chromatogram to view the corresponding spectrum.
• Repeat the action while pressing the Shift key to overlay several spectra.
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Displaying Spectra of Different Samples
To objectively compare spectra of different samples, it is necessary to perform
a chromatogram comparison.

• Compare two chromatograms by displaying an additional chromatogram in
the Integration window (see  Chromatogram Comparison in the
chapter Integration).

• Activate the Spectra Tool command and select single spectra by clicking
various places in the chromatogram while pressing the Shift key.

 Note: UV spectra are overlaid in one window. MS spectra are displayed
one below the other to enhance the clearness of representation.
For a large enough representation, enlarge the upper section of
the entire window, if necessary.

 Match Factor, Difference Spectra, 1st/2nd Derivatives of
    UV Spectra
As soon as two or more spectra are represented via the Spectra Plot, the
similarity of the UV spectra becomes an issue.

The Match Factor can express the similarity, by forming difference spectra or
by representing the first or second derivative of a UV spectrum.

• Choose the Decorations command of the View or context menu and
activate the Show match checkbox on the Label tab. The Dionex
Chromatography Management System issues a value for each represented
spectrum, expressing the match degree relative to the main spectrum (0 =
no match; 1000 = perfect match).

• On the Analysis tab choose whether the difference spectrum or the first or
second derivative of a spectrum are displayed in a second window in
addition to the actual spectra.

In the case of the match factor and the difference spectrum, the question of
which UV spectrum is considered a main spectrum is especially important, as
this is the basis of comparison or the basis for all calculations.
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Usually, this is the peak spectrum extracted at the retention time. If there is no
peak spectrum, a distinction is made between two situations: If the UV spectra
were extracted individually from the chromatogram via spectra tool, the
spectrum that is first extracted is the main spectrum. If spectra are
automatically extracted at different peak heights, the spectrum with the "oldest"
retention time is considered the main spectrum. When representing difference
spectra, the Difference to ... entry indicates the basis of calculation.

 Starting a UV Spectra Search
To facilitate substance identification, the peak spectrum, which is displayed in
the Spectra Plot windows of the Integration or PPA method, can be
compared to the UV spectra of a spectra library.

Based on the available library, the Dionex Chromatography Management
System creates a spectra list sorted by the degree of similarity, the Hit List.
The number of possible hits can be limited via comprehensive search criteria.

• If the cursor is positioned in a spectra window, choose the Library Search
... command from the context menu to start the spectra search.

In the edit box, specify the library that should be searched. The following are
minimum entries required to receive a valid search result:

• In the field Spectra Library to be searched in ... choose a spectra library
(LIB file). If no LIB file is offered, press the Browse button to search for a
corresponding file.

• In the field ⇒Match Criterion, determine the mathematical method based
on which the original spectrum and the library spectrum are compared with
each other. The best search results are generally received with the setting
Least Squares.

• Press the OK button to start a spectra search.

 Note: To be able to compare UV spectra with each other, the spectrum
and the reference spectrum should be recorded under identical
conditions. For best results, compare spectra to your own
spectra library.



Actions in the UV Spectra and Mass Spectra 329

Result
A list of possible candidates will be displayed. The top spectrum has the
highest match value and the best similarity to the original spectrum.

Detailed Search
To accelerate the search and to receive very specific results, there are
numerous options:

• Normally, the Spectrum Derivative option is deactivated, i.e. comparing
spectra is based on the actual curve shape. If the 1´st Derivative option is
selected, the comparison of the two spectra is performed based on the first
derivative. This has the consequence that the curve characteristics will be
more significant (shoulders become real extremes), which allows a more
precise comparison. The drawback of this option is the reduction of the
signal to noise ratio, which causes sections with weaker signals to loose
significance.

• Select Hit Threshold and enter a value between 0 and 1000, e.g. 950.
Only the spectra with a match above 950 will be displayed. Spectra with a
lower match value will not be displayed. Spectra with a match value below
900 are usually spectra of other substances (if derivatives are not used for
the comparison). Exceptions to this are acceptable only if e.g. the signal to
noise ratio is low.

To ensure a precise search result, use the following options:

• Enter the number of relative extremes the spectrum should have (Number
of Relative Extrema). This option is useful to exclude spectra that are
similar but have an additional side maximum.

• Select Check Greatest Relative Maximum to use only spectra with the
greatest relative maximum at the same position. Choose Allowed
Deviation to define a tolerance range. The range should not be more than
10 nm. Otherwise, the criterion weakens.

• Via Retention Time Window, define a time window that includes the
retention time of the peak. Use this option to exclude substances with very
similar spectra, but which are eluted at very different retention times.
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Additional criteria are only required in special cases. However, they are useful
for searching large libraries containing numerous spectra of the same
substance, but extracted under different conditions (e.g. different solvents and
detectors, different users, different date etc.).

 Note: When creating your own spectra library, please enter information
in all fields, even in the fields that may seem unnecessary. In the
course of time and with a growing library, this may become a
major advantage.
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Actions in the Report
The Dionex Chromatography Management System offers numerous options to
work with reports. It is possible to use existing default reports or create special

Reports to meet individual requirements.

For details, see the following topics:

 Displaying a Report
 Defining the Contents of a Report
 Defining the Appearance of a Report
 Saving a Report
 Linking Report Variables
 Calculating the Peak Variable Amount
 Adding/Renaming a Worksheet
 Peak Summary
 Audit Trail (Sample Protocol)
 History
 MS Reports
 Other Special Reports

 Displaying a Report
In each of the six method windows (Integration / PPA / QNT Editor / Spectra /
Calibration Curve / Spectra Calibration), a numerical Report can be included.
• Choose the Report command from the View menu.

If you have not generated a report before, a default report will be opened. It
contains the worksheets Integration, Calibration, Peak Analysis, Summary,
and Audit. If you are working with a Photodiode Array Detector, it is
recommended to select the default report DEFLTDAD. This report contains the
additional worksheets Peak Purity and Lib Search.
• Via the tab in the lower left corner of the report, choose the worksheet to

change from one report type to the next.
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Each worksheet has a number of default variables that are an integral part of
the respective report type. In an integration report, this includes the columns
Ret.Time, Area, and ⇒Amount. A calibration report contains the columns
Offset (c0), Slope (c1), and Curve (c2) etc.

Without requiring additional input, these predefined report sheets are available
for various purposes.

 Defining the Contents of a Report
Via the Table command of the context menu or double-clicking a table column,
the contents of a ⇒Report Definition File can be changed.

• Choose Add / Insert Column to add a column with any content to the
report at the right or left of the current cursor position.

• Choose Fix Column to move the selected columns to the far left. Columns
of this type are permanently visible, even when scrolling.

• Choose Delete Column to delete one or several columns.

• Choose Column Properties to modify the column properties. Thus, the
current column contents (e.g. number of theoretical plates) can be replaced
by a different variable.

 Tip: Each column usually shows one report variable. However, it is
possible to link several report variables (see: How to ...: Actions
in the Report  Linking Report Variables). Mathematical and
statistical functions such as SUM, AVERAGE, etc. are only
available in the Report and the Printer Layout together with the

Report Publisher!

• Choose Table Properties to modify the properties of the entire report. Use
this command to sort the table in groups or remove peaks below a certain
area value.

 Defining the Appearance of a Report
The appearance of a report is modified via the Table menu. Choose Format /
...
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• Alignment to position the text horizontally and vertically within a cell or a
column.

• Font to determine the font type and size.

• Border to determine the location, the color, and the shape of the frame.

• Pattern to determine the color and the pattern of the cell background.

• Number Format to determine the format of the represented values.

• Autoformat to design the entire report by selecting a ready-made default
template. The Preview window shows the various formats.

 Saving a New Report Definition File

All modifications to a report can be saved in a ⇒Report Definition File.
• Choose Save Report Definition ... and enter the file name under which to

save the modifications.
• Overwrite the DEFAULT.RDF file to change the default settings for reports.

(Note: Overwriting the DEFAULT.RDF file is generally not necessary, as
the report definition file (RDF) you saved last will be used when you open a
report.)

 Linking Report Variables
Linking two or more report variables via the four basic arithmetic operations or
via powers allows you to generate user-defined report variables.

Use the formulas of the ⇒Report Categories to link individual variables.

Perform the following steps:
• Select a report column and choose the Add Column command from the

Table menu.
• In the Formula field of the edit box (Add Report Column), enter the

formulas you wish to link via mathematical operators.
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• Note that the variable names are not identical with their "formulas" (e.g.
peak height and peak.height). For the correct syntax, refer to ⇒Report
Categories. You can copy the syntax there by selecting the required
formula and pressing the key combination CTRL+C. Change to the edit box
again and insert the formula by pressing CTRL+V.

Example: If the peak height should be put in relation to the corresponding
⇒Amount, this can be expressed as follows:

peak.height / peak.amount
• Alternatively, expressions can be linked via the operators +, -, x, and ^ (for

powers)

• In the field Header, enter the desired column header.

• Press Customize to include newly defined variables in the report variables
list.

• Complete your input by pressing OK.

 Tip: Mathematical and statistical functions such as SUM, AVERAGE,
etc. are only available in the Report and in the Printer Layout
together with the Report Publisher!

 Calculating the Peak Variable "Amount"

If you wish to check the indicated ⇒Amount values, have a look at the
respective coefficients of the calibration function first. Then, add the columns
offset (c0), slope (c1), and curve (c2), which are all part of the category Peak
Calibration.

For the amount calculation of an unknown sample the inverse function f(y) of
the calibration function F(x) must be calculated. Calibration functions are
calculated as follows:
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Quadratic with offset: 
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 Note: For ambiguous inverse functions (two possible values for
quadratic with or without offset) always use the value which
comes "closest" to the X values of the respective calibration.

If it is not possible to calculate the expression (c1=0 for linear
with or without offset, the radiant < 0 for quadratic with or without
offset, or c0=0, or c2=0 for exponential), "n.a." is given as
amount.

 Adding/Renaming a Worksheet
You may add new worksheets with any contents and appearances to the
⇒Report Definition File.

• Choose the Insert Report command of the Table menu and determine the
type of report to be created.

Audit Trail Shows the  Audit Trail of the current sample.
Calibration History Shows all variables documenting the course of the calibration.
Calibration Report Shows all variables required for creating a calibration report.
Database Query Inserts any kind of database queries into the report. Enter the search

criteria in SQL code.
Detection Parameter
Report

Shows all Detection Parameters of the current sample.

History Report Shows all variables required for creating a History report.
Integration Report Shows all variables required for creating an integration report.
MS Instrument Info
Report

Shows information on the Mass Spectrometer.

MS Instrument
Method Report

Indicates the MS method.

MS Raw Report Shows the raw data of the current Mass Spectrum.
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MS Status Log Report Indicates the mass spectrometer settings.
MS Tune Data Report Indicates the tune data of the Xcalibur raw data file.
Peak Summary Shows all variables required for creating a peak summary.
Program Report Shows the Program for the current sample.
SST Report Lists all variables which are required for the representation of the

System Suitability Test.

• From the variables that are available on the right-hand side, click those you
wish to include in the new report. Pressing OK creates the desired
worksheet of the report.

• In the report, double-click the newly added tab to assign it a new name.

Saving
The contents and the appearance of a report are saved via the Save Report
Definition command.

 Tip: Please note that the appearance and the contents of this
(screen) report needs not to be identical with the actually printed
report, the Report Templates. The printout is defined exclusively
in the Printer Layout and enables printing independently of the
screen contents.

 Peak Summary

Use the Summary worksheet in the Report (see  Peak Summary Report)
to show certain results from all samples.

The required steps are described under How to ...: Actions in the Report:

 Displaying a Report and

 Adding/Renaming a Worksheet.

In contrast to the Integration and Calibration worksheets of the ⇒Report
Definition File that list the data of the peaks of one sample, the Summary
represents data of a specific peak from all samples (generally a ⇒Sequence).
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If you wish to show e.g. the amount of different peaks of all samples of a
sequence in a table, select the Amount variable of the Peak Result category
via the Column Properties command of the context menu and display the
value for Fixed Peak(s). The default setting shows the values for the currently
Selected Peak so that you can determine the peak for which to display the
data by clicking the peak in the above chromatogram.

The default Summary report contains several columns. In addition to the
sample name and the retention time, it also offers the columns Area, Height,
⇒Amount, Types, and Plates. As soon as a user selects a peak in the
chromatogram, the values of this peak are included in the Summary report. If
the selected peak is not contained in a sample, this line remains empty (n.a. =
not available).

Below the sample list, there are the lines Average and Relative Standard
Deviation. The average value of a column is calculated and displayed. The
relative standard deviation from this value is indicated in percent.

The user can modify the default Summary report at any time. However, it is
recommended to keep this report sheet. If another report is required, create an
additional Peak Summary report sheet with new column assignments.

 Note: Instead of a single sequence, the Summary report can also be
started based on a Query. Then, the Summary may include
different samples from different sequences.

 Audit Trail (Sample Protocol)

The  Sample Protocol (Audit Trail) can be included in a ⇒Report
Definition File as a worksheet. The sheet always shows the Audit Trail for the
currently selected sample.

• In the Day Time column, the time of a command or message is entered.

• The Ret.Time column indicates the corresponding retention time.

• The /Message column command shows the command itself, a message
text or an event.
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The contents of the worksheet can be included in other documents via Cut &
Paste. Printing the entire Audit Trail via the Printer Layout is possible as
well.

Using Audit Trail Variables in other Worksheets

Certain events (as performing a ⇒Trigger or changing the wavelength at a
specific time) can be included in any Report worksheet.
• Open the corresponding worksheet and choose the Column Properties

command from the context menu.

• Choose Audit Trail from the Categories list.

• Choose one of the Audit Trail variables from the Variables field. The
available selection depends on the events listed in the Audit Trail of the
sample.

• If you would like to display events that are not listed here (e.g. the system
pressure recorded via a Log command), this is possible via the Formula
field. In this case, the event variable is appended to the name AUDIT,
separated by a period (AUDIT.pressure). This output makes sense only if
these values were actually recorded!

• Confirm your input with OK.

Your report now includes an additional column with an Audit Trail variable.
Normally, the value for the corresponding peak at the retention time is entered
in each line. If there is no value at this time, the last recorded value is entered.
When forming a gradient, the data system calculates the corresponding values
(%A, %B, %C ...).

If you want to display a specific Audit Trail event for all peaks in a report at a
specific time, the Dionex Chromatography Management System offers the
following option:
• Choose the Column Properties command and choose an Audit Trail

variable.

• Press the Parameter... button.

You now have the possibility to specify a retention time. Confirming the action
with OK generates a report column with a fixed retention time. The
Wavelength audit trail variable displays the wavelength at the time t.
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 History
The History report is not part of a default report. So, use the Insert Report
command to add a history worksheet to a ⇒Report Definition File (see: How
to ...: Actions in the Report  Adding/Renaming a Worksheet).
By default, the sheet shows the history of the current sample. Use the Table
Properties command of the context menu to open the History Report
Properties dialog box where you can change the settings.

• On the History Objects tab, select the object for which to display history
entries.

• On the Time Restrictions tab, specify the time when the history entries to
be displayed must have been made.

• On the Operations tab, determine the changes to be displayed.

• On the Users tab, determine the user(s) whose changes shall be
displayed.

• On the Sorting tab, define the sorting order for the history entries.

• The Layout tab allows enabling the special layout mode for the history
report. This is possible only if detail columns are available. If detail columns
exist, a shortened history report is displayed when Design template mode
is enabled, thus, simplifying layout definition.

 MS Reports
Similar to the History report, the different MS reports are not part of the
default ⇒Report Definition Files. Use the Insert Report command to add them
as separate worksheets to a report definition file (see: How to ...: Actions in
the Report  Adding/Renaming a Worksheet):

• Select the MS Instrument Info Report to view information on the Mass
Spectrometer. If there is no MS data, the report just says: "No MS
Instrument Info found."

• The MS Instrument Method Report indicates the MS method. If there is
no MS data, the report just says: "No MS Instrument Method found."

• The MS Raw Report shows the raw data (mass, intensity, and relative
intensity) of the current Mass Spectrum. If there is no MS data, the report
just says:  "No MS Raw Data found."
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• The MS Status Log Report shows the mass spectrometer settings. If
there is no MS data, the report just says: "No MS Status Log found."

• Select the MS Tune Data Report to view the tune data of the Xcalibur
raw data file. If there is no MS data, the report just says: "No Tune Data
found."

 Note: If you do not have the MS Control option enabled on your PC,
the MS reports will not be displayed in the Insert Report dialog.

All MS reports comprise the default columns only; further
columns cannot be added.

 Other Special Reports
Similar to the History report and the MS reports, the following reports are not
part of the default ⇒Report Definition Files either. Use the Insert Report
command to add them as separate worksheets to a report definition file (see:
How to ...: Actions in the Report  Adding/Renaming a Worksheet):
• Select the Database Query report to integrate any kind of database query

in the report. Open the Table Properties in the context menu and specify
the datasource in which the query shall be performed. Use SQL
statements to define the properties for which the query shall be performed.

• The Detection Parameter Report indicates the ⇒Detection Parameters
used for the current sample.

• The Program Report indicates the Program of the current sample.

• The SST Report indicates the results of the System Suitability Test. The
default SST report columns are part of the ⇒System Suitability Test
category. They cannot be edited.

 Note: The Database Query report, the Detection Parameter Report,
and the Program Report comprise the default columns only.
Further columns cannot be added.
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Actions in the QNT Editor
The settings performed in the quantification window determine which
⇒Detection Parameters, and calibration and peak table parameters (see
⇒QNT Parameters) are used for evaluating a peak or an entire chromatogram.

As the peak table offers more columns than can be displayed clearly on the
screen, the columns are distributed to three tabs:

• Peak Table (general peak table)

• Amount Table (parameters to determine the amount)

• Peak Tracking (parameters for peak assignment via reference spectra)

• MS Tracking (parameters for peak assignment via Mass Spectra)

Use the Display Columns command in the View menu to select the columns
for the respective tab.

The QNT editor offers additional tabs to enter parameters:
• General (general settings)

• Detection (detection/detection parameters)

• Calibration

• Spectra Library Screening (spectra search parameters)

• SST ( System Suitability Test parameters)

• MS ( Mass Spectrometry parameters)

You can disable the display of any tab via the Select Sheets command from
the View menu. To rename a tab, simply double-click the tab in the QNT
Editor and enter a new name.
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For further details, see the following topics:

 Creating a Peak Table
 Defining Detection Parameters

 Combining Peaks
 Subtracting a Blank Run Sample

 Disabling Standard Samples

 Calibration
 Spectra Library Screening
 Defining the System Suitability Test
 Processing Mass Spectra

Creating a Peak Table
The peak table contains data for
• Peak identification
• Amount calculation

Specific peaks of a chromatogram are thus identified via a name (= identified).
The determined peak areas are converted in amount values (= Formula for
Amount Calculation). The peak table serves as the basis for each calibration,
as it contains the substance concentration of all standard samples. Input is
usually before the analysis start.

Use the command Display Column from the context or View menu to
determine which columns are displayed on the sheets. This option allows
adjusting the Peak Table, Amount Table, and Peak Tracking sheets to
individual requirements.

For further details, see the following topics:

 Identifying Peaks
 Identifying Peaks via Their UV Spectra (Peak Tracking)
 Identifying Peaks via Their Mass Spectra (MS Tracking)
 Defining Retention Times and Reference Peaks
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 Defining the Retention Index and the Kovats Index
 Entering Amount Values
 Selecting the Standard Method
 Selecting the Calibration Function

     (Columns: Cal. Type and Int. Type)
 Weighting and Averaging Calibration Points
 Defining the QNT Method for Several Detectors
 Entering Reference Spectra
 Autogenerating the Peak Table

Also, see How to ...: Actions in the Browser   Creating User-defined
Columns

 Identifying Peaks

(Columns: Peak Name, Retention Time, and Window)
Most frequently, peaks are identified via the retention time.
• Enter the names of all peaks to be identified in the ⇒Peak Name column,

line by line. Assign a nominal retention time to each peak by entering a
retention time value in the corresponding peak table column (= manually
creating a peak table). Or:

• Choose the  Autogenerate Peaktable command (Edit menu) to
automatically generate a peak table based on the current sample. In this
case, the system includes all peaks integrated (!) in the current sample into
the peak table. As peak name, a combination of sequence name and
consecutive number is assigned. The values to be entered in the
⇒Retention Time and ⇒Window columns, are determined again using the
individual peak's maxima. All other entries are replaced by default values
(= automatically creating a peak table).

If a peak is detected at the specified time in an unknown sample, the peak is
automatically assigned a name (fig. a).
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Identification is even possible when the retention time deviates or when
neighboring peaks are very close. For this, a tolerance range is defined via the
Window (fig. b) peak table parameter. If a peak is detected in this range, it is
identified even if the nominal and the actual retention time do not coincide
exactly (fig. c). If several peaks are detected within this range, the data system
identifies the greatest, the first, or the nearest peak to the retention time (fig. d),
depending on the extension of the Window parameter.

Tret (g)

Tret (n)

Tret (f)

Tret

a) b) c) d)

peak name window

set

actual

The Peak Window can be set for each peak after pressing the F8 key or
double-clicking the Window column. First, determine the window interpretation.
Selecting Absolute allows you to enter the window width in minutes. Select
Relative to define the window width in percent.

Peak Match allows selecting the peak identification criterion. If using a
Photodiode Array Detector, peak assignment is possible via the spectrum or

via the spectrum and the retention time. For details, see  Identifying Peaks
via Their UV Spectra (Peak Tracking)

The window width is indicated in industry minutes in the Window column of the
peak table (e.g. "0.25"), followed by the abbreviation for the selected window
interpretation and peak match option. To identify the largest peak within a 30
second window, the column must read: "0.25 AG" (0.25 min or 15 seconds to
the left and right of the retention time). Accordingly, "0.25 AN" would identify
the peak nearest to the nominal retention time.

 Note: The retention times and window values stated in the peak table
exclusively serve to identify a peak. For the retention time output
within a Report, the actual retention times (= retention time in
the peak maximum) are used.
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If the retention time of the same peak shifts from sample to
sample due to a column trend, the peak can leave the retention
time window at some point. Peak identification is no longer
possible in this case. However, the Dionex Chromatography
Management System offers a method to reliably identify peaks
even then. (See ⇒Use Recent Retention Time) The option is
activated via the General sheet of the QNT editor.

In addition to the identification via the nominal retention time, compounds can
be identified via their substance spectrum.

 Identifying Peaks Via Their UV Spectra (Peak Tracking)
The Dionex Chromatography Management System allows you to perform peak
tracking, i.e. identifying peaks via spectra comparison. In addition to the
Reference Spectrum column, there are further peak table columns to
influence spectra comparison. These are the columns Match Criterion, Check
Derivative, Min. WL, and Max. WL, Threshold, Rel. Max. Deviation, and
Check Extrema. The values entered in these columns have the same meaning
as described in the section How to ...: Actions in the QNT Editor  
Entering Criteria for the Spectra Library Screening.

 Tip: If neither the minimum (Min. WL) nor the maximum wavelength
(Max. WL) are set, the comparison is performed for the entire
wavelength range of the reference spectrum.

Peak tracking, i.e., identifying a peak by comparing spectra, can be activated
via the input in the Window column. In the corresponding F8 dialog box (press
the F8 key or double-click in the Window column), select one of the options
Spectrum or Spectrum and time of the group Peak Match.
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The algorithm for peak identification via a spectra comparison can be described
as follows: If (Peak Match) Spectrum or Spectrum and time is selected as
peak match criterion in the Window column of the peak table, peak tracking
uses the reference spectra in the corresponding column (in the case of
Spectrum and time limited to the specified time window). Peak tracking
generates a list of spectra sorted by the match factor (the peak hit list is not
shown here).

 Tip: Peak tracking is performed with the parameters (match criteria
etc.) entered for the peak in the peak table.

The peak hit list only includes peaks with a match factor above
the threshold that was entered for this peak.

An empty peak hit list indicates that no spectrum was found
fulfilling the match criteria. This could be due to a very high
threshold.

The peak hit list is calculated for all peaks in the peak table, for which peak
tracking was activated. After that, the peak hit lists are checked for multiple
hits. If the Check the best hits only option is activated, only the best hits are
compared for the individual peaks. In the case of multiple hits, the peak with
the highest match factor receives the name of the reference substance.

Using the match criterion Spectrum and time can usually prevent multiple hits.
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All other peaks in the peak table (i.e. without activated peak tracking) are
identified via the window assignment (First, Nearest, Greatest) as described
under  Identifying Peaks.

 Identifying Peaks via Their Mass Spectra (MS Tracking)

(Column: Mass peak x, MS threshold, MS filter conditions, and Check MS
ret. times)

Mass Spectra present a very reliable method for peak identification. For the
available parameters, see the MS Tracking tab.

Double-click the respective cell or press F8 to open the Mass spectrometry
conditions for ... dialog box:
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Peak identification via MS is enabled / disabled via the Check mass ratios
check box.

Under Mass Peak 1, enter the mass of the substance, which is expected at this
peak. If you expect fragmentation and can estimate the fragments, which are
expected, you can enter two of them with their expected intensities under Mass
Peak 2 and Mass Peak 3.

Use the MS Threshold option to filter the noise. A mass is detected in the
mass spectrum only if, compared to the Base Peak (largest peak),  its relative
intensity is higher than the threshold value.

The filter settings limit the mass spectra, which are used for peak identification.
This option is required if you modify the polarity and/or use a different
maximum voltage for ionization of the sample.

Via the Check retention time of mass spectra option, you can also use the
retention times of all masses for peak assignment. All retention times must be
within one scan.
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 Defining Retention Times and Reference Peaks

(Column: Retention Time)
The Retention Time column allows you to select reference peaks for relative
retention times and to determine how the ⇒Retention Time is to be interpreted
for the respective peak. Open the dialog box Retention Time for... for the
respective peaks by double-clicking or with F8 (within the Ret. Time column).

The display of the retention time (relative or absolute time) can be determined
individually for each peak on the tab Interpretation. Note that relative times
can be displayed either as difference or as percentage ratio to the retention
time of a reference peak.
The dialog box Reference peak allows you to define one (or several) of the
other peaks as reference peak. However, only peaks with absolute reference
times can be used as reference peaks. They are indicated with a light blue
background. Reference peaks cannot be deleted from a peak table.
The retention time is re-calculated automatically when the retention time
interpretation is changed or a different reference peak is selected.
Besides, the retention time can be entered directly in the entry field (page Peak
Table in the Ret. Time column) in the following manner:
[<Reference Peak>] <Ret. Time> [<Unit>]
You are free to choose the order in which the fields are entered.

If no name is entered for the reference peak, the time is interpreted as absolute
time.
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Either min or % can be selected as unit. If no entry is made, min is used. The
unit determines whether the time given is the difference (min) or the ratio (%)
to the time of the reference peak. For absolute times only min is permitted.

 Defining the Retention Index and the Kovats Index

(Columns: Ret. Index and Kovats Index)
If you wish to generate generally comparable retention times by means of
retention indexes you have to determine one or several marker peaks first in
the columns ⇒Ret. Index or ⇒Kovats Index.

Enter a value between 0 and 99.999. Each peak for which a value is entered is
used as marker. Incrementing values must be used, i.e. the value must be
either undefined or above the value used for the predecessor peak. The default
setting is "undefined."

This variable is used for calculating retention indexes or Kovats indexes,
respectively, which are used, mainly in GC, to correct retention time variations.
Therefore, the peak table should contain certain marker peaks, which usually
have the following RI or KI values, assigned:

Retention Index: 100, 200, 300, ...

Kovats Index: 100*number of carbon atoms of the alcane.

The RI or KI values of all other peaks remain empty; they are calculated by
means of interpolation.

The Duplicate Column command (select Columns in the context or Edit
menus) allows you to duplicate the column so that different values are possible
for the individual channels.

 Tip: As the Kovats index is calculated using the adjusted retention
times a ⇒Dead Time must be entered on the sheet General of
the QNT editor to enable the calculation.
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 Entering Amount Values (Amount Column)
Standard substances are labeled by user input in the Amount column.

• Search the peak table for the substance name of the standard
substance(s), or

• Enter the name and the retention time as described under How
to ...: Actions in the QNT Editor  Identifying Peaks.

• In this line, move to the first Amount column.

• Enter the amount value of the standard. This can be a concentration value
(recommended, e.g. µg/µl) or the absolute value (e.g. µg). If a standard is
available in different concentrations, the concentration of each vial must be
entered in a separate ⇒Amount column. E.g. two concentrations result in
two amount column entries:

However, if injection is performed several times from the same sample vial
(multiple injection), one amount value is sufficient. This applies even if a
different volume and thus a different amount are injected, because the data
system automatically considers this!

• Repeat the procedure for each substance that serves as a standard.

Inserting new Amount Columns
• From the Edit or the context menu, choose Columns..., and then New

Amount Column.... Open the dialog box Add Amount Column.

• Choose Add Standard(s) to open the dialog box Select Samples.

• Select a standard sample. By pressing OK, the sample is included in the
dialog box Add Amount Column.

• Press OK again to open the Amount column for the selected sample. You
can now generate further Amount columns in the same way. Press Close
to return to the peak table.
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 Selecting the Standard Method (Standard Column)
Via the Standard method, determine how to perform the calibration. Generally,
a distinction is made between a calibration based on an internal or an external
standard.

External standard means that the calibration is performed based on one or
several standard samples (this is the default).

Using an internal standard means adding a standard to the unknown sample.
This can be either before (External/Internal) or after (Internal) sample
preparation. Either the standard (= Internal Standard) can be added to all
samples or it can serve as a basis for a relative area calculation. In this case,
results are displayed only in relation to the amount or area of the internal
standard (for further details, see Calibration,  Standard Methods).

• In the Standard column, add the standard method for each peak to be
calibrated (external / internal/external Peak / internal Peak).

• For the last two options, at least one peak of the peak table is used as the
internal standard. This is achieved by assigning it the Make current Peak
to ISTD Peak: intern or Make current Peak to ISTD Peak:
internal/external option.

• Press the F8 key to enter the standard method assignment via an edit
dialog box.

 Selecting the Calibration Function (Columns: Cal.Type,
    Int. Type)

Via the Int. Type (⇒Integration Type) column, define how to evaluate the
individual peaks.

To do that, press the F8 key or double-click in the Int. Type column. The
following dialog box opens:
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In addition to Area, Height, and CE-Area, you can select the relative area or
the relative height as the reference for the evaluation (Integration Type).

If you select Area, all amount calculations refer to the area of one peak. This
Peak Area Integration is the default setting. The peak height integration is
only used in exceptional cases.

The relative height is either calculated relating to all peaks or all identified
peaks. ISTD peaks can be considered for the calculation of the total area
(height).

There are several peak table columns, which define the conversion of the
determined area values into the calculated amount values. A separate
calibration and integration type must be assigned to each calibrated peak in the
peak table.

Enter a calibration function in the Cal. Type column. Press the F8 key to
receive a list of available functions and options. Apart from few exceptions, the
calibration types Linear or Linear with Offset are used.
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The ⇒Calibration Type determines which Calibration Function is used for
deriving a valid amount/area assignment for a larger range from the calibration
points of the standard samples. For detailed information on linear and non-
linear calibration types, see  Calibration Types (Linear), or  Calibration
Types (Non-linear) in the Calibration section.

Via the calibration type, you can also define the weighting and averaging of
calibration values (see: How to ...: Actions in the QNT Editor   Weighting
and Averaging Calibration Points.

Either the calibration curve leads through the origin (e.g., with the Lin and
Quad calibration types) or the origin is not considered (e.g., with the LOff and
QOff calibration types). For calibration types with offset, the origin can be
treated as a calibration point via the Include point (0,0) for curve fitting
option. In this case, the calibration curve will not be forced through the origin,
but the origin will be considered nevertheless.

Normally, all other columns of the peak table can be used with the default
settings. Press the F1 key to view further information. Press F8 to open an edit
box.
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 Weighting and Averaging Calibration Points

Weighting
The Dionex Chromatography Management System generally weights
calibration points of higher concentrations more strongly than lower
concentrations, i.e. the course of the calibration curve is oriented towards the
calibration points of higher concentration. This makes sense as smaller
concentrations also cause a stronger dispersion of the determined area values,
which would distort the result beyond proportion.

To undo or even reverse this type of weighting, four additional weighting
functions have been introduced:

The weighting 1/Amount (or 1/response) virtually undoes the "normal"
weighting described above, i.e. low and high concentrations are weighted
similarly. The weighting 1/Amount² (or 1/response²) results in an over-
proportional weighting of smaller amounts.

By variation of the Number of Replicates, this weighting can be avoided.
Smaller concentrations are injected more frequently than larger concentrations,
more calibration points in the low concentration range support the calibration
curve. Outliers are then less relevant.

 Tip: The stronger weighting of higher concentrations is valid in all
Calibration Functions, with the exception of Point-to-Point.

Outliers can be explicitly "deactivated" by excluding a specific
standard sample from the calculation on the Calibration sheet of
the quantification method.

When calculating the calibration values Variance, Var.Coeff,
Std.Dev, Rel.Std.Dev, and Corr.Coeff, averaging is not
considered! Weighting only influences the course of the
calibration curve, the values are a measure for the quality of the
calibration.

Averaging
To determine the calibration curve, all available Calibration Points are
normally used. As dispersion is stronger for the lower calibration levels, many
users verify the results by using a large number of calibration points. The
calibration curve is thus determined by a larger number of points on the lower
than on the higher level.
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If all points of a Calibration Level are averaged before calculating the
calibration curve, and the subsequent calibration is performed based on these
average values only; the calibration curve is based on one point of each
calibration level only.

 Defining the QNT Method for Several Detectors
1. If two detectors are connected in series, the retention times are delayed
against each other. As the flow normally remains unchanged, the shift of the
retention times is constant. The ⇒Delay Time parameter enables you to take
this fact easily into consideration.

First, enter the name of the second detector under Detector Name on the
General tab of the QNT editor. Use the arrow to select the name from the list.
Then, enter the measured delay time.

2. For some applications, it might be necessary to modify the QNT method for
a second detector or another channel. Therefore, you cannot use the Delay
Time parameter when you are working with Flow Gradients

To avoid creating a second QNT method for such or similar applications, you
can duplicate the following columns and assign the duplicate to one or several
channels:

⇒Calibration Type

⇒Integration Type

⇒Kovats Index

⇒Left/Right Limit

⇒Peak Type

⇒Response Factor

⇒Retention Index

⇒Retention Time

⇒Window

To duplicate a column, select it in the peak table (in the amount table, or in
peak tracking) and select Columns, either in the context menu or in the edit
menu. Open the respective dialog box with Duplicate Column and define the
channel / the channels for the new column via Add Channel.
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If an individual peak is not detected in a channel, the respective cell in the
Retention Time column can be left empty. Thus, this channel will not identify
this peak. If you do not wish to include a peak into the report although it was
detected, just leave the Retention Time column empty.

In addition, you can define further detection parameters for the respective
channel/channels in the Channel column on the Detection tab. Also see How
to: ...: Actions in the QNT Editor   Defining Detection Parameters
(Detection).

 Entering Reference Spectra (Reference Spectrum
    Column)
You can enter a reference spectrum for each peak in the peak table of the QNT
editor:

Position the cursor in the Reference Spectrum column, press the F8 key or
double-click the left mouse button to access a dialog window that allows you to
select the reference spectrum of the peak. By pressing the Browse button, you
can load any samples or spectra libraries for selecting the reference spectrum.
If samples are loaded, a list of all peaks in the corresponding chromatogram is
displayed. For spectra libraries, the list shows the included spectra (see figure).
In the right window section, the selected reference spectrum is displayed. If the
relevant peak of the peak table is identified in the current chromatogram, the
spectrum is included as overlay. The corresponding match factor is shown in
the upper corner of the plot frame.
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After pressing the Select button, the selected reference spectrum is copied to
the corresponding line of the peak table.

Clipboard: Spectra can copied to the clipboard from the spectra plot window or
the spectra library using CTRL+C (or the Copy command from the Edit menu).
In the QNT editor, the copied spectrum can be inserted in the Reference
Spectra column as the reference spectrum via CTRL+V or the Paste
command from the Edit menu.

Copy Peak Spectra as Reference: If one or several lines are selected in the
Reference Spectrum column, the Copy Peak Spectra as Reference
command allows using the spectra of the current chromatogram as the
reference spectra from the Edit or context menu.

Overlay of the Reference Spectrum in the Spectra Plot
In the spectra plot, the current reference spectrum from the peak table can be
included as Overlay. To do this, place the cursor in the spectrum, open the
context menu, choose Decoration, and then choose the Peak Spectra tab. In
the lower section, click Reference Spectrum in corresponding peak table.
Press OK" to receive the spectrum from the Reference Spectrum column in
addition to the current one.
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 Autogenerating the Peak Table
To save the user from having to determine the retention time of each peak,
peak tables can be automatically created. Selecting the Autogenerate Peak
Table command, either in Edit menu or in the context menu does this.

The Dionex Chromatography Management System automatically generates a
peak table, entering the retention times of all detected peaks of the currently
open chromatogram as set times. The user need only complete the table by
entering component names and altering the default window and other values
as necessary. Peaks, which are not of interest, can be deleted from the table.
These will consequently be excluded from the report, provided the Including
all not detected peaks of the peak table parameter in the Integration Report
Properties (Table Properties command in the Edit or context menus) is
switched to OFF.

During automatic table generation, the variables described below are set as
follows:

Autogenerated Peak Table is entered as ⇒Comment.

The peak names (⇒Name) are constructed from the name of the QNT method,
e.g. . in the peak table Test, detected peaks will be assigned the names Test-
1, Test-2, Test-3, etc.

The ⇒Window values are entered as absolute values; they represent 1/3 of the
distance from the nearest peak.

No ⇒Group.

The ⇒Amount values and the ⇒Response Factor at set to 1.0.

The peak type (⇒Sample Type) is Auto (i.e., it is determined by the Dionex
Chromatography Management System).

When generating peak tables via Autogenerate Peak Table (Edit menu), it is
possible to use the results of the spectra library screening (type: Use spectra
library screening results) instead of enumerating all peaks in the
chromatogram (type Enumerate peaks of current chromatogram).
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In this case, library screening is performed based on the parameters entered in
the QNT file. All peaks for which at least one reference spectrum was found,
are included in the peak table with the name of the best hit.

The following options can also be used:
• Apply only to peaks with .... With this option, only peaks exceeding a

selectable absolute or relative area or height will be included in the peak
table.

• Apply only to peaks in current time interval: Click this button to include
only peaks in the currently displayed (e.g. zoomed) section of the
chromatogram.

• Copy reference spectrum from ...: This option simultaneously includes
the reference spectrum for each peak. Either the current peak spectrum
(from the displayed chromatogram) or the library spectrum of the best hit
from library screening can be used. For the latter, the Use spectra library
screening results autogeneration option must be selected in the upper
window section.
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• Enable peak tracking using peak match type ...: This option allows
activating peak tracking for each included peak. As with peak tracking (see
How to …: Actions in the QNT Editor  Peak Tracking), you can select
between Spectrum and Spectrum and time.

• Allow multiple best hits / Unique identification: The results of the
spectra library screening will produce a hit list of library spectra for each
peak in the chromatogram. If Unique Identification is selected, these hit
lists are handled as in Peak Tracking, i.e. multiple identical hits with smaller
match factors are eliminated. In the case of Allow multiple best hits, each
peak in the chromatogram is copied to the peak table with the best hit. If
the best hits are identical, this can result in identical entries in the peak
table. In this case, adding a number to the name (e.g. -2, -3) generates a
unique peak.

If you have generated a new peak table via Autogenerate Peak Table, a note
will be included automatically in the Comment column of the peak table:
• If you have selected Enumerate peaks of current chromatogram, the

comment is: Autogenerated.

• The corresponding comment for Use spectra library screening results is:
Autogenerated. Spectrum: Name of reference spectrum, Match: Match
factor.

 Tip: The Use spectra library screening results option automatically
enters the settings made on the Spectra Library Screening tab
in the peak table (Peak Tracking tab).

Defining Detection Parameters
The detection parameters define how to integrate the chromatograms, which
are evaluated with the respective QNT method, where to suppress peaks, how
to recognize peak start and peak end, etc. This enables the user in many ways
to define the integration and to minimize the re-integration effort for individual
chromatograms.

You can either enter the detection parameters in the table on the Detection tab
or define them graphically in the chromatogram.
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In order to enter the parameters in the table on the Detection tab of the QNT
editor, express the desired conditions via the columns Parameter Name and
Parameter. They influence the integration of all chromatograms to which the
respective QNT method applies. There are 22 different parameters, which can
assume a new value at any time and whenever desired. Only the value, which
was defined, last will take effect, however, only for the time of the
chromatogram. The parameters are then reset to their default values. If a
parameter assumes a new value at a specified time (Retention Time column),
this is called an Event. You do not have to enter these events in chronological
order. They will be sorted automatically when being saved. The Channel
column allows you to define whether this applies to an individual channel only
or to all channels (default) of a sample.

Each detection parameter has a default value assigned. Thus, in general about
90% of all chromatograms are automatically integrated correctly by the system.
However, for critical applications (e.g. wavelength switching) the user can
influence the baseline or the peak type (e.g., rider or main peak) or switch off
the detection for defined periods.

Many parameters can only assume the values ON or OFF. They are called
switches. All other parameters are called variables. Parameter tables can
include up to 100 lines. For an example on how to enter detection parameters
in the table of the Detection tab, see the following illustration:

In many cases it may be easier to enter the detection parameters graphically in
the chromatogram (see How to ...: Actions in the
Chromatogram  Defining Detection Parameters Graphically
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In addition, the QNT editor offers further detection parameters. The following
sections describe how to edit the default values together with the respective
possibilities and advantages. Use the detection parameters for:

 Reducing the Number of Evaluated Peaks
 Excluding Certain Peaks
 Inhibiting Peak Integration
 Modifying the Baseline
 Modifying the Peak Recognition Algorithm
 Defining the Peak Start/End
 Defining Rider Peaks
 Defining the Area for PPA

 Reducing the Number of Evaluated Peaks
To limit the integration report to a manageable size, only the most important,
i.e., normally the largest peaks should be included in the evaluation. Define
either the ⇒Minimum Height or the ⇒Minimum Area. Proceed as follows (the
following example refers to the minimum peak height):

• Open a QNT file (select Open in File menu) and click the Detection tab.

• Look at the chromatogram and determine the minimum peak height to be
evaluated. You may also click the smallest peak to be integrated. Then
open the corresponding Peak Properties via the context menu. The dialog
box then indicates the width, height, and area of the peak.

• Enter the name of the parameter to modify, e.g. the ⇒Minimum Height in
the Parameter Name column of the quantification method.

• Assign the smallest possible signal value (e.g. in mAU) as the new
parameter value in the Parameter Value column.

• In the Time column, determine from which time (relative to injection time)
the parameter becomes valid.

• Alternatively, you can open an edit dialog box (press the F8 key) to enter
the parameter name, value, and time.

All peaks with an area smaller than the indicated %-value will not be displayed.
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As the parameters affect peak recognition and thus the baseline, you must
consider a tolerance of approx. 5% to ensure that all desired peaks are
recognized.

Another way to define, e.g., the minimum area, is to graphically define the
corresponding parameter. Proceed, e.g., as follows:
• In the chromatogram, find the smallest peak just no longer to be displayed.

• Enlarge this peak to be clearly visible.

• In the chromatogram, use the right mouse button to select an area whose
area is a slightly smaller than that of the selected peak.

• In the context menu, select the Set Minimum Area command.

This action enters the selected area as minimum area together with the time of
its left edge into the QNT method. Enter the 0.000 as time into the Detection
tab or move the parameter in the chromatogram with the Detection Parameter
Tool so that the minimum area is valid for the entire chromatogram.
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 Note: You can undo the graphical input of detection parameters. Click
into one of the tables of the QNT editor and select the Undo
command of the Edit menu. (In the chromatogram itself, you can
only undo the modifications of the currently open chromatogram.)

 Tip: If you just want to make the report clearer, proceed as follows:

• Select any cell in the report (integration tab) and choose
Table Properties from the Table menu.

• Select the Reject peaks with smaller area than ...% check
box and specify below which size not to include a peak in the
report.

 Excluding Certain Peaks

Spikes
Sometimes, very narrow peaks (so-called "Spikes") occur in chromatograms
due to, e.g., air bubbles in the HPLC system. In such a case, the problem (e.g.
the air bubbles in the HPLC system) should be solved first, of course. However,
to use the chromatogram, nevertheless, the identification of these narrow
peaks can be suppressed with the QNT method.

Select the ⇒Minimum Width parameter to define the minimum width for the
peaks to be integrated. Proceed as when entering the minimum height (see

 Reducing the Number of Evaluated Peaks).

Peaks above the Detector Maximum
Sometimes peaks occur whose absorption maximum is above the detector
maximum so that integration does not make sense. You can then include these
peaks as unidentified peaks into the peak table by using the ⇒Maximum Peak
Height parameter.

Broad Peaks
If an unusually broad peak occurs in the chromatogram, it may be from a
previous sample. Use the ⇒Maximum Width parameter to define this peak as
being unidentified.
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 Inhibiting Peak Integration

The ⇒Inhibit Integration parameter can be activated at the time t1 and can be
deactivated at the time t2. The peaks within the time window t1 - t2 are not
integrated. Whether this applies to all channels or to only one channel is
specified via the Channel column.

To prevent the integration of all peaks in the range from 0 to 1.0min (especially
the injection peak), the following input is necessary in the quantification
method.

Peaks detected in this time span will not be integrated and will not be included
in an integration report.

 Modifying the Baseline
Modifying the baseline can be necessary especially for non-resolved peaks.
The baseline is normally defined via a mathematical procedure. For calculating
the individual peak areas, a perpendicular is dropped to the baseline from each
local minimum (standard).

If you think the integration is started too early or the peak end is delayed, a
better peak start or peak end can be forced by inserting a baseline point
(⇒Baseline Point detection parameter).

If a series of non-resolved peaks can be recognized on an "absorption mound,"
e.g. due to an increased solvent absorption, the baseline can be forced from
minimum to minimum using the ⇒Valley to Valley detection parameter.

Move baseline point Valley toValleyDefault
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If single peaks are piled on a recognizable "absorption mound," these are
integrated individually. To be able to integrate the entire area, the baseline can
be fixed. The parameter ⇒Lock Baseline extrapolates the baseline horizontally
to the intersection with the signal curve. The Global Minimum option searches
for the absolute minimum in the direction of the peak end or until the next Lock
Baseline. Both parameters deactivate the Valley to Valley option!

Lock Baseline -
current level

Default Lock Baseline -
global minimum

 Tip: In all of these actions, the classification criterion Peak Type of
the peak table has priority! For a peak of the type Baseline-
Main-Baseline, the peak limits always have baseline contact!

 Modifying the Peak Recognition Algorithm
Whether signal variations are interpreted as peaks or not, is usually set
automatically. Manual modification of this "recognition sensitivity" is possible
via the combination of the ⇒Peak Slice and ⇒Sensitivity detection parameters.
Changing the parameters is required, for example, in chromatograms with
unusually wide (many minutes) or very narrow (< 0.1sec) peaks.

Another way to define the peak recognition algorithm is to define both
parameters graphically. Proceed as follows:
• Enlarge a baseline section so that the noise is clearly visible.

• In the chromatogram, use the right mouse button to select an area from
which the baseline runs out neither at the top nor at the bottom.

• In the context menu, select the Set Peak Slice & Sensitivity command.
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The width of the selected area is entered into the QNT method as peak slice
and the height is entered as sensitivity at the time of the left edge of the area.
Enter 0.000 as time onto the Detection tab or move the parameters in the
chromatogram with the Detection Parameter Tool so that this peak
recognition algorithm applies to the entire chromatogram.

 Note: You can undo the graphical input of detection parameters. Click
into one of the tables of the QNT editor and select the Undo
command of the Edit menu. (In the chromatogram itself, you can
only undo the modifications of the currently open chromatogram.)

The peak recognition algorithm considers signal variations only beyond the
adjusted sensitivity values. Peaks below this threshold are interpreted as noise.

Both parameters affect peak recognition only, not integration! The area
calculation (integration) is not affected.
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 Defining Peak Start / Peak End
Depending on the chromatogram type, the peak start or the peak end can be
detected too early or too late. There are several ways to prevent this:

If, in your opinion, the integration is started too early or if the peak end is
delayed too much, use the Fronting Sensitivity Factor parameter for the peak
start and the ⇒Tailing Sensitivity Factor for the peak end. The entered value
multiplied with the left or right peak width determines the peak start or the peak
end. Depending on the chromatogram type different values may make sense.
Therefore, you should try which value is best for your chromatograms. Often,
the value 2 is an appropriate starting point for finding the best Fronting/Tailing
Sensitivity Factor.

You can also set a new ⇒Baseline Point to force the peak to start later or to
end earlier.

 Caution: However, when setting a baseline point keep in mind that this
point will be valid for all chromatograms, which are evaluated
with the respective QNT method. If in one of these
chromatograms a peak maximum occurs by coincidence at the
time of your hard entered baseline point, the peak maximum will
be defined as base point and the peak will not be detected.

To correct too late a peak start or too early a peak end (the latter can occur,
e.g., with heavy baseline noise), proceed as follows:

1. In recorded chromatograms: Select a higher ⇒Peak Slice (= about 20% of
the smallest peak width) and, in addition, a higher ⇒Sensitivity, if
necessary.

2. For samples that have not been processed yet: In the program file, change
the data acquisition ⇒Step. Select the step so that only about 20 data
points are recorded for the smallest peak.
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 Defining Rider Peaks

The detection parameters ⇒Rider Threshold and ⇒Maximum Rider Ratio
allow you to define which peaks shall be detected as Rider Peaks and which
shall be detected as main peaks. The following applies:

The smaller the rider threshold, the smaller the peaks that can be detected as
rider peaks. (Peaks below the rider threshold are always regarded as main
peaks. For peaks above the rider threshold, the Maximum Rider Ratio defines
whether a peak is a rider peak or a main peak.) The larger the maximum rider
ratio, the larger the peaks that can be defined as rider peaks.

 Tip: When defining rider peaks with these parameters please keep in
mind that the same peak may be detected in two different
chromatograms as main peak and as rider peak. This would
result in considerable deviations, e.g. in the calibration. To
prevent this, select the peak type Rider (or Main) for the
respective peak in the peak table. Thus, the peak is a rider peak,
if possible (or always a main peak).

In addition, you can define how to skim rider peaks by using the ⇒Rider
Skimming parameter. With the two options Tangential at lower peak end and
Tangential at both peak ends the peak is skimmed by a tangent. Usually,
there is hardly any difference between the results of the two options.

With the Exponential option, the course of the baseline is approximated by an
exponential function, i.e., the peak is skimmed by the exponential function. This
option clearly distinguishes from the two others. In most of the cases,
Exponential maps the actual baseline course very accurate. With this option,
the rider peak will usually receive a more realistic larger area. A sufficient
number of data points must be available to ensure that this option can be used.
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 Defining the Area for PPA
When using Photodiode Array Detectors and recording 3D-Fields, you may
check the peak purity with the Peak Purity Index (PPI).

Define the most expressive area of you spectrum by means of the ⇒Peak
Purity Start/End Wavelength parameters and limit the examination to this area
only.

The detection limit becomes especially apparent with very small peaks. The
influence (i.e., noise, drift and limits of the measuring method) on the peak
spectrum is strongly developed at the peak start and peak end because, in
these areas, the concentration of the peak substance in the flow cell is very
low. Setting the ⇒Peak Purity Threshold parameter allows you to reduce the
influence on the PPI and the match factor and, thus, to prevent that
contaminated substances are indicated falsely. The PP threshold value defines
the percentage of the peak height starting as of which the spectra will be
considered for the respective purity examination.

If you work close to the detection limit, use higher PP threshold values to
reduce the influence of the detection limit on the purity examinations. If you are
mainly interested in the purity of large peaks, use lower PP threshold values to
examine the purity over the largest possible area of the peaks.

Grouping Peaks
If you are interested in the sum parameters for two or more peaks, you can 1.
define these peaks as a peak group (that is treated as one single peak) or 2.
define them as a group of peaks.

1. If the peaks lie close together and are not baseline separated (e.g. with
overloaded columns), define the peak group start and the peak group end
via the  ⇒Peak Group Start/End parameters on the Detection tab. The
baseline will then be drawn from the start of the peak group to its end.
Such a peak group is treated as one single peak.

2. If you wish to define a peak group in which the peaks do not necessarily
succeed one another (e.g., to determine the amount/concentration of an
entire class of substances), several steps must be taken:
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• Identified peaks: Use the Column and Display Column commands of
the context menu to insert the ⇒Group column into the peak table if the
column is not yet displayed. For those peaks that should belong to this
group, type the desired group name into this column.

• Unidentified peaks: Under Unidentified peaks on the General tab,
define the time for which this group shall be valid in case of unidentified
peaks. The baseline will be drawn as for individual peaks.

• Add the Group Amount column to the Report and the Printer Layout.
This column shows the desired ⇒Amount value. In the report, open the
dialog box Insert/Add Report Column via the Insert Column or Add
Column commands of the context menu. Choose the Peak Results
category and select Group Amount as variable.

 Tip: If the selected calibration type is e.g. LOff instead of Lin, the
value in the Group Amount column will not be identical to the
sum of the amount values of the individual peaks even if the
group includes all peaks of the chromatogram.

Subtracting a Blank Run Sample
The section Blank Run & Matrix Blank on the General sheet of the QNT
editor allows the user to consider absorption values of a Blank Run Sample,
a Matrix Blank Sample or any other sample ( Blank Run Subtraction).

• Select No Blank Run Subtraction if no correction is to be performed.

If the absorption values of a specific sample are to be considered in the sample
evaluation, determine which sample is to be used as Blank Run Sample.

• Select Subtract Recent Blank Run Sample in Corresponding Sequence
if a processed Blank Run Sample (sample type: Blank) of the current
sequence is to be used.

• Select Subtract a Fixed Sample to perform the correction with a specific
Blank Run Sample. Choose Browse to search for the sample.
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When subtracting a blank run sample, the chromatogram of the blank
sample is subtracted point by point from the current chromatogram. If the
current sample is a standard sample, the difference between the two
chromatograms is used for the calibration.

 Tip: Although sample types other than "blank" can be subtracted as
well, this usually does not make sense because often-negative
peaks would occur in the resulting chromatogram.

• Enable Matrix Blank Subtraction activates the subtraction of matrix blank
samples. Contrary to the other options, the resulting peak areas or peak
heights are subtracted.

Disabling Standard Samples
On the Calibration tab, different calibration information is given and, in
addition, you can define the standard sample to be used.

Click the box in the Enabled column to open the dialog box Disable (Enable)
Standard xyz and define whether or not the respective standard sample shall
be used for calibration purposes. You can exclude the respective standard from
the calibration for all peaks and all channels (default) or for the selected peak
and/or channel only. For further information on how to use this option, see the
following examples:

The standard sample was contaminated
Exclude the entire standard from the calibration. Keep the default setting:
Disable the standard for All Peaks and All Channels.

By mistake, too much of a substance was added to the standard
In this case, do not exclude the entire standard from the calibration, but disable
the calibration for this substance, instead. Click on the peak and select
Selected Peaks and All Channels in the Disable (Enable) Standard xyz
dialog box.
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Contamination in the standard that, however, is detected in one channel
only
In this case, too, you do not need to exclude the entire standard from the
calibration. Select the channel that detects the contamination and choose All
Peaks and Selected Channel in the Disable (Enable) Standard xyz dialog
box.

For information on calibration, also see: How to ...: Actions in the QNT Editor
 Calibration

Calibration
The following examples (see topics below) give a detailed description of both,
the theory and the practical use of the available calibration possibilities. The
first examples describe different applications

 Introduction and Example: 1 Standard and 1 Substance
     (Mode: Total)

 Several Standards with Several Substances Each (Mode: Total)
 Multiple-Point Calibration Using 1 Single Standard (Mode: Total)
 Calibrating Using Standards of an Old Sequence (Mode: Fixed)
 Calibrating Unstable Substances (Mode: Bracketed)
 No Pure Substance Available - Known Extinction Coefficient

     (Response Factor)

For a detailed description of the different ⇒Calibration Modes and the
calibration with different types of ⇒Standards including calibration curve
calculation see the examples below:

 External Calibration (Mode: Total)
 External Calibration (Mode: Additional)
 External Calibration (Mode: Group)
 External Calibration (Mode: Bracketed)
 External Calibration (Mode: Fixed)
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 Internal / External Calibration
 Internal Calibration
 Calibration with Variable Internal or Internal/External Standard

 Note: Please note that the procedure is described for the Total mode.
All other examples point out the differences of the individual
calibration modes, only.

For information on validation, see the following topics:

 Entering the Concentration/Amount of the Validation Sample
 Validating the Calibration Curve

 Note: To apply an existing calibration to a new sequence consisting of
one or several Unknown samples, use the ⇒Calibration Mode
Fixed. Always perform the calibration manually (Calibrate). The
Auto-Recalibrate option is not available.

 Introduction and Example: 1 Standard and 1 Substance
Most calibrations in HPLC and IC are performed using external standard
samples. In the simplest case, the accompanying peak area for a known
amount of a substance in one standard sample only is determined. From the
ratio of amount and peak area, the data system calculates the slope (c1) of the

Calibration Function (in this case only linear without offset is possible). By
means of this slope, the data system calculates the ⇒Amount value of this
substance in unknown samples.

Short Example:
The amount of substance A shall be determined in two samples (Sample 1 and
Sample 2). A standard sample (Standard) is available. For each samples a
sampler injects an injection volume of 20 µl each. The samples are located at
the sampler positions 1 (standard), 2, and 3 (unknown samples), respectively.
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Sample List

In the  Browser (see Basic Operation section), create the following
sequence using the Sequence Wizard

 Note: For detailed information on how to create a sample list, see
How to ...: Actions in the Browser  Creating a Sample
List (Sequence Table).

QNT Method / General Tab

The standard sample contains substance A in a concentration of 12 mg/l. A
linear calibration curve (calibration type: Lin) that runs through the origin shall
be created for substance A. After processing this sequence, the QNT method
must be created for performing the calibration. In the General tab dialog box of
the ⇒QNT Editor, enter the unit for all further entries under ⇒Dimension of
Amounts (in this case "mg/l"). Keep the ⇒Calibration Mode setting Total under
Global Calibration Settings.

QNT Method / Peak Table Tab

Do not change the defaults in the Standard (External) and ⇒Calibration Type
(Lin) columns on the Peak Table tab either. The Dionex Chromatography
Management System automatically creates a "default" amount column. If, as in
this case, only one standard sample is available, this can be kept as well. Enter
the concentration in the amount column:

 Note: If more than one substance is available in the samples, append a
new line to the table via the Lines > Append Line commands of
the context menu and enter the corresponding concentration in
the respective cell of the Amount column.
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The Dionex Chromatography Management System calculates automatically the
amount for the two unknown samples. Afterwards, you can view the results in
the report on the Integration page:

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Several Standards with Several Substances Each
Usually calibrations are performed using several standards that very often
contain more than once substance to be calibrated. In the simplest case, these
are two standard samples containing two substances each, allowing you to
determine not only the slope but also the offset and/or curvature of the
calibration curve (depending on the number of acquired data points).

Example:
The amount of the substances A and B shall be determined in two samples
(Sample 1 and Sample 2). Two standard samples (Standard 1 and Standard 2)
which both contain substance A and substance B are available. For each
sample, an injection volume of 20 µl is injected by an autosampler. The
samples are located at the sampler positions 1 and 2 (Standard 1 and
Standard 2) and 3 and 4 (unknown samples).

Sample List

The sequence appears as follows (also, see How to ...: Actions in the
Browser  Creating a Sample List (Sequence Table)):
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QNT Method / Peak Table Tab

The concentration of e.g. substance A in Standard 1 is 10.2 mg/l and of
substance B 20.1 mg/l. Standard 2 contains 30.5 mg/l of substance A and
49.7 mg/l of substance B. Thus, for the calibration the following peak table
must be created in the ⇒QNT Editor:

Remove the default ⇒Amount column and add new amount columns (one for
each standard) for this example:
• Select Columns... in the Edit or context menu and then Remove Amount

Column. Click on the indicated Default column and confirm with OK. The
amount column is deleted and a warning is issued that the amount columns
for your standards are missing.

• Open the Add Amount Column tab dialog box again via Columns... and
New Amount Column.... Select Add Standard(s) to open the Select
Samples dialog box.

• Select a standard. Press OK to enter this sample into the Add Amount
Column dialog box.

• Pressing OK again creates the amount column for the selected sample.
You may now create further amount columns in the same way. Close
returns you to your peak table where you can now enter the corresponding
values.

 Note: If one of the substances is not available in the standard sample,
the respective cell in the Amount column will be left empty.

If you are using several standards for calibration, you can select a ⇒Calibration
Type other than Lin (linear without offset), if necessary.

Based on these settings, the Dionex Chromatography Management System
automatically calculates the concentrations of substance A and substance B in
the two unknown samples.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.
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 Multiple-Point Calibration Using 1 Single Standard
If you want to perform a multiple-point calibration (see Single-Point and
Multiple-Point Calibration) using only one standard sample, you can inject
different injection volumes (= quasi Dilution Series).

Sample List

For example, if you inject 10, 20, and 40 µl of one single standard, the sample
list will appear as follows:

For the Dionex Chromatography Management System, each injection is an
individual sample. To distinguish between different injections made from the
same standard sample vial, you may append the sample number and the
injection number (see example above).

QNT Method / General Tab

The standard sample contains e.g. 10 ml/l Uracil. As all injections of such a
dilution series are made from the same sample vial with the same
concentration, you cannot represent the concentration in the calibration curve.
Instead, enter the actually injected amount in the ⇒Amount column and
choose a dimension of amount as unit. Thus, in the General tab dialog box of
the ⇒QNT Editor, choose ng as Dimension of amounts.

QNT Method / Peak Table Tab

As in the introduction example (see:  Introduction and Example), you do
not need to change the default amount column setting on the Peak Table tab.

If, as in the example below, the calibration line does not run through the origin,
you can select Linear with Offset (= LOff) as ⇒Calibration Type.
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These settings will then result in the following calibration line:

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Calibrating Using Standards of an Old Sequence
Calibration standards are often quite expensive. Thus, if the calibration curve
remains constant for weeks or months, the standards of a sequence can be
used for calibration for several weeks before the calibration constancy needs to
be checked again.

Sample List

In this case, the new sequence will neither contain standards nor Validation
Samples but unknown samples only (perhaps plus Blank Run Samples
and/or Matrix Blank Samples).

QNT Method / General Tab

Under Global Calibration Settings, set the ⇒Calibration Mode Fixed:
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In Fixed mode, manual calibration is possible only, i.e., after adding standards
on the Calibration sheet (see below) press the Calibrate button on the
General sheet to include the newly entered standards in the calibration.

QNT Method / Calibration Tab

With the calibration mode Fixed being selected, the Calibration table is empty
at first. Use the Append Standard command of the context menu to add the
desired standard(s). This command opens the Browse dialog box for selection
of the desired standard sample from any sequence:

The Calibration sheet then contains the desired standards:
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Having entered all standards, press the Calibrate button on the General sheet
to perform the calibration with those standards. Following each change (e.g.,
excluding a standard by disabling the Enabled checkbox or correcting the
injection volume in the sample list) you have to press the Calibrate button
again!

 Note: If you later edit the name of the sequence from which the
standards were added or the name of the directory that houses
the sequence, the reference becomes invalid. Then, you have to
add the standards again on the Calibration sheet.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Calibrating Unstable Substance
If you want to calibrate unstable substances, the concentration in the samples
that are analyzed later, may be considerably lower than the concentration in
those samples that are analyzed first although originally the concentration was
the same. The instability of the substance makes calibrating more difficult. The
Dionex Chromatography Management System offers two possible solutions:
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Sample List

In order to allow for the instability of substances every now and then one or
several standard samples are added to a series of unknown samples. The
sequence will appear e.g. as follows:

QNT Method / General Tab

The bracketed calibration illustrated in the above figure has been achieved via
the ⇒Calibration Mode Bracketed (set under Global Calibration Settings).
The four less decayed standards 1-4 (from positions 1, 2, 5, and 6) are used for
calibrating the less decayed unknown samples (samples 1 and 2 from positions
3 and 4). Calibrating the higher decayed samples 3 and 4 from positions 7 and
8 is via the more decayed standards 3-6 (from positions 5, 6, 9, and 10). The
calibration curve shows the corresponding Calibration Points, only.

For details on the mode Bracketed, see  External Calibration (Mode:
Bracketed).

 Tip: Knowing the half-life of an unstable substance (this is especially
true with radioactive substances) offers you a clever way to
calculate the chromatogram as it would be without the decay.
Record all chromatograms in this special channel via a Virtual
Channel Driver as if the substance would not decay. For a
program example, see How to ...: Device Control  Program
Examples for Virtual Channels. Having recorded these

Virtual Signals, perform the calibration as described in the
above examples for stable substances.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.
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 No Pure Substance Available - Known Extinction
    Coefficient
If you wish to quantify substance A although the pure substance A is not
available, calibration can be performed nevertheless provided the ratio of the
extinction coefficient to the extinction coefficient of a different substance B is
known. First, create the corresponding sample list following the description
under  Several Standards with Several Substances Each.

Then, create the ⇒Amount columns for your standards. As the pure substance
A is not available and thus is not contained in the standards, the cells for
substance A remain empty in the amount table:

The decisive entry is the entry made in the ⇒Response Factor column. This
column allows using the calibration of substance B for substance A. Double-
click the selected cell (see above) to open the Response Factor for
Substance A dialog box and enter the factor of the extinction coefficient at the
measuring wavelength between the two substances:

SubstB

ASubst

CoeffExt
CoeffExt

FactspRe
.
.

.. .=

Set the interpretation to "Relative to Peak" and select substance B:
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The resulting calibration curve is 75% of the Calibration Function of
substance B. No calibration points are indicated in the calibration curve as no
points were acquired for substance A:

 Note: The calibration type that was entered in the peak table for
substance A is not relevant. Although, Lin (without offset) was
entered in the above example the calibration curve does not lead
through the origin as LOff (linear with Offset) has been selected
as calibration type for substance B.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Mode: "Total"
If more than only one standard sample exists, the calibration coefficients c0
(offset), c1 (slope), and c2 (curvature) can be calculated via the ratio between
amount and peak area using the selected Calibration Function. The resulting
values are entered in the Formula for Amount Calculation, together with the
area values of the substance of an unknown sample. As the result, the data
system provides the ⇒Amount value of substance A in the unknown sample.

Example:
In two samples (I,II), the concentration of substances A and B should be
determined. One standard solution (STD 1) is available. It contains A in a
concentration of 12 mg/l and B in a concentration of 17 mg/l. For A and B, a
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linear calibration curve through the zero point (calibration type: linear) is
created with two calibration points each. As only one standard solution is
available, two different volumes (10 and 20 µl) must be injected ( Dilution
Series). Two Calibration Points are resulting. The sampler injects a volume of
10 µl. The standard and analysis samples occupy the sampler positions 1 or 2,
and 3, respectively.

a) User Input

Sample List

For how to proceed and what you must note, see How to ...: Actions in the
Browser  Creating a Sample List (Sequence Table).
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QNT Method / "Peak Table" Sheet

Regarding this example, note the following:

• In the Standard column, choose the standard method External via the
F8 edit box. And:

• As only one standard concentration (STD 1) is available for calibrating
substances A and B, exactly one amount value is entered in the Amount
column of the peak table. The same applies if several sample list entries
are generated by analyzing the same standard several times (two in this
case). If the same injection volume is used for these, a 1-point calibration
with several replicates is performed. If the injection volume is varied (10
and 20 µl), this is a multiple-point calibration, i.e. 2-point calibration, a
special case of the Dilution Series ("concentration series"). The Dionex
Chromatography Management System automatically calculates the
amount value of the second calibration point (double injection volume).

If, however, two separate standards with different concentrations are
available (two vials, different sampler positions), two amount values should
be entered in the peak table. In this case, the data system cannot simply
calculate the concentration by considering the injection volume from the
concentration of the other standard.

All other entries in the peak table are based on the criteria described under
How to ...: Actions in the QNT Editor  Creating a Peak Table.
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QNT Method / "General" Sheet
As all samples (here samples I and II) are calibrated with the same standard
samples, the user selects the ⇒Calibration Mode Total.

QNT Method / "Calibration" Sheet
This sheet shows all standard samples (of a sequence) that are used for
calibrating the current sample.

Press F4 or SHIFT+F4 to successively open all samples of a sequence. For
each sample, the standard samples that are used for calibrating the sample
are shown.

If you notice that an error occurred during the analysis of the standard
sample, you can remove this standard. This is via the Enable column on the
Calibration sheet in the QNT editor. Only the standard samples labeled X
are included in the calibration.

b) Analysis Structure
Injection is four times. During the first run, the first calibration point of the
calibration curves of the substances A and B is determined on the basis of
the determined area values. In the second run, the second point is
determined accordingly. Run three serves to determine the area values of the
substances A and B of sample I. Correspondingly, in the fourth run, the area
values of A and B of sample II are determined.
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The following area values are resulting:

Name Area Subst. A Area Subst. B
STD 1 (first run) 150 200
STD 2 (second run) 300 400
Sample I 175 150
Sample II 95 180

c) Calculation of Missing Amount Values (of the second standard
    sample)

To perform the required calibration of each substance via two calibration
points, two more area values must be determined after the first run.

This could be done with another standard solution of a different
concentration. As no other standard solution is available, the second injection
is again from the standard sample of known concentration. In this case,
however, a different (the double) volume is injected. Thus, the double amount
of the first run reaches the column. From the single amount value of the peak
table (Amount(Peak Table)), the missing amount can be calculated
considering the new volume.

FactorDil
WghtSmp

VolInj
VolInj

AmountAmount
Amountunknown

Amountunknown
TabPeak .

.*
..

.
*)( −=

Evaluation of the formula (with ⇒Weight (sample weight) and ⇒Dil. Factor
(dilution factor) = 1) results in the following amount values:

Amount (peak table) Calculation of the second amount
A = 12.000 12 x (20/10) = 24
B = 17.000 17 x (20/10) = 34

d) Calculation of the Calibration Coefficients
From the area values of the standard samples and the corresponding amount
values, the four value pairs can be determined. The intersection of each
value pair represents a calibration point. Based on the selected calibration
type (in the example:  Calibration Type (Linear)), the Dionex
Chromatography Management System calculates the optimum course of the
calibration curve, i.e. tempts to find a course with four calibration points on or
near the curve. If the course of the curve is established, the corresponding
calibration coefficients (c0, c1, c2) can be calculated.
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Substance y/x-value pair c1
A
A
B
B

12/150
24/300
17/200
34/400

0.08
0.08
0.085
0.085

With a linear course through the zero point, the calibration curve can be
described by one single coefficient (c1). C1 expresses the slope of the curve.
If all calibration points are located exactly on the calibration line, the resulting
calibration coefficient c1 is the direct y/x-quotient of each value pair.
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If the calibration points are not located exactly on one line, the data system
calculates an optimized, approximate c1 value for each substance from the

Calibration Function.

If a different  Calibration Type (Non-Linear) is used, the data system also
calculates the remaining calibration coefficients (c0 and c2).

e) Amount Calculation
If the calibration coefficients of a substance A are known, each area value
from an unknown sample for substance A can be converted into an amount
value by inserting the values in the calibration function. When inserting this
value into the Formula for Amount Calculation, the actual amount value will
result.
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When performing this for the peak areas of the substances A and B in
samples I and II (the correction factors of the formula for amount calculation
are assumed with 1.0), the following amount values are calculated:

Sample Calculation Amount. A Amount B
I 175 x 0.08 14.00
I 150 x 0.085 12.75
II 95 x 0.08 7.60
II 180 x 0.085 15.30

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Mode: "Additional"

The following example illustrates the difference between the ⇒Calibration
Modes Total and Additional.
Independently from the standard method, this mode determines which standard
samples are used for evaluating a specific unknown sample. The position of
the unknown sample in the sample list is decisive here.

Extending the Example: External Calibration / Mode: "Total"
After two unknown samples, two standard samples are injected again. An
alternating list of two standard samples, two unknown samples, two standard
samples etc. is resulting. All other settings are maintained, i.e., a two-point
calibration is performed. The calibration is verified by additional replicates.
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a) User Input:

Sample List

QNT Method / "Peak Table" Sheet

QNT Method / "General" Sheet
If the user selects the Additional mode, each unknown sample is evaluated
based on the standard samples analyzed so far.
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This means:

As before, samples I and II are evaluated via a two-point calibration.
However, four analyzed standard samples are available for the samples III
and IV. The result is a two-point calibration with two replicates each. Finally,
the samples V and VI are evaluated via a two-point calibration with three
replicates each.

QNT Method / "Calibration" Sheet
The sheet shows all standard samples (of one sequence) that can be used
for calibrating the current sample.

Via F4 or SHIFT+F4, the samples are successively opened. For each
sample, the standard samples are shown based on which the sample is
currently calibrated.

Two standard samples are displayed for the samples I and II, four standard
samples are displayed for the samples III and IV, and six standard samples
are displayed for the samples V and VI six standard samples (see figure).

If the user notices that an error occurred when analyzing the standard
sample, the standard can be "excluded." This is performed via the Enable
column on the Calibration sheet of the QNT editor. Only the standard
samples labeled X are evaluated for the calibration.
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b) Evaluation:
Evaluation is analogous to the example with external calibration (mode:
Total). The only difference is:

Creating the calibration curve for different samples is created based on a
different number of replicates.

This can affect the calculated calibration coefficients and thus the result, but
does not necessarily do so. Normally this type of calibration is used to adapt
to changed column conditions. Thus, it is possible that after a number of
samples, a specific substance cannot be eluted 100 percent from the column.
As this will also be the case with the standard substance, the result is
automatically corrected.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Mode: "Group"

The ⇒Calibration Mode Group completes the modes Total and Additional.
The mode is used when there are time-dependent modifications during the
analysis, e.g. decomposition of the analyzed substance.

Again, the mode is described using the example of the Additional mode
(sample list of alternating sample pairs (2 standards / 2 samples / 2 standards
etc.)).
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a) User Input:

Sample List

QNT Method / "Peak Table" Sheet

QNT Method / "General" Sheet
If the user selects the Group mode, each sample is evaluated based on the
immediately previous standard sample in the sample list.

QNT Method / "Calibration" Sheet
This sheet indicates all standard samples (of a sequence) that are used for
calibrating the current sample.

Press F4 or SHIFT+F4 to successively open each sample of a sequence. For
each sample, the standard samples forming the basis for calibration are
shown.
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In the example, this means that in the Group mode the standard samples
from the lines 1 and 2 are shown for the samples I and II. For the samples III
and IV, the standard samples from lines 5 and 6, and for the samples V and
VI, the standard samples from lines 9 and 10 are displayed.

b) Evaluation:
Evaluation is analogous to the examples with the external calibration (modes:
Total and Additional). The only difference is that the calibration curve is
constantly updated without considering the previously analyzed standard
samples.

For the example, this means:

Evaluation of the samples I and II is via two-point calibration of the standard
samples in the lines no. 1 and 2.

In contrast to Additional, the samples III and IV are also evaluated via two-
point calibration. However, only the standard samples STD 1 from lines no. 5
and 6 are used.

Correspondingly, the samples V and VI are evaluated via the standard
samples STD 1 in the lines no. 9 and no. 10.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Mode: "Bracketed"

In a bracketed calibration, a standard sample is included in a series of
unknown samples so that modifications, e.g. column or detector drift, can also
be considered in the calibration function. Amount calculation of an unknown
sample is always via the calibration coefficients of the surrounding standard
samples.
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New Example
The concentration of substance A is to be determined in four samples (I-IV).
Two standard solutions (STD 1, STD 2) of the substance A with different
concentrations (50 and 100 ng/µl) are available for external calibration. At the
beginning, after the second and after the fourth sample, a two-point calibration
is to be performed. To receive more results that are exact, a bracketed
calibration is performed. The basis for calibrating the samples I and II is
provided by the standards STD 1 and STD 2 from lines no. 1, 2, 5, and 6, while
the samples III and IV are calibrated on the basis of the standards no. 5, 6, 9,
and 10.

a) User Input:

Sample List

QNT Method / "Peak Table" Sheet

The external calibration (Standard = External) is performed via two standard
samples (sampler positions 10 and 11) of different concentrations. In contrast
to the Total, Additional, and Group examples, two different ⇒Amount
values must be entered in the corresponding amount columns [1] and [2] of
the peak table.
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QNT Method / "General" Sheet

If the user chooses the ⇒⇒⇒⇒Calibration Mode Bracketed, each sample is
evaluated based on the surrounding standard samples in the sample list.

QNT Method / "Calibration" Sheet

This sheet shows all standard samples (of a sequence) that are used for
calibrating the current sample.

Via F4 or SHIFT+F4, each sample of a sequence can be opened
successively. For each sample, the standard samples used for calibrating will
be displayed.

For the samples I and II, the display is as follows:

For the samples III and IV, the sheet will look as follows:

Note that the standards in line 5 and 6 are determined only once.
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b) Analysis Structure:
Injection is eight times. The following area values are determined:

Name Area substance A
STD 1 (conc.1) 218
STD 2 (conc.2) 439
Sample I 167
Sample II 152
STD 1 (conc.1) 224
STD 2 (conc.2) 442
Sample III 283
Sample IV 305
STD 1 (conc.1) 219
STD 2 (conc.2) 441

c) Calculation of the Calibration Coefficients
From the determined area values of the standard samples and the amount
values from the peak table, the value pairs of the six calibration points can be
listed. Note that, depending on the standard (STD 1 or STD 2), the amount
value is once taken from the peak table column Amount [1] and once from the
column Amount[2].

No. Substance y/x-value pair y/x c1 (K1) c1 (K2)
1 STD 1 (conc.1) 50/218 0.2294 0.2267
2 STD 2 (conc.2) 100/439 0.2278 0.2267
5 STD 1 (conc.1) 50/224 0.2232 0.2267 0.2261
6 STD 2 (conc.2) 100/442 0.2262 0.2267 0.2261
9 STD 1 (conc.1) 50/219 0.2283 0.2261
10 STD 2 (conc.2) 100/441 0.2268 0.2261

If all calibration points would be used simultaneously, a two-point calibration
with three replicates of the same calibration level would result.

As the amount determination of samples I and II or III and IV is only according
to the surrounding standard samples, this means that there are two calibrations
for substance A instead of one. Each one is a two-point calibration with two
replicates each. Therefore, Dionex Chromatography Management System
calculates two different sets of calibration coefficients.
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If, as in the previous examples, a linear calibration function without offset is
assumed, the Dionex Chromatography Management System determines two
different c1-values. One value (K1) is calculated for the numbers 1, 2, 5, and 6,
and another value (K2) is calculated for the numbers 5, 6, 9, and 10.

d) Amount Calculation
If the calibration coefficients of a substance A are known, the amount of
substance A contained in each sample can be calculated by inserting the peak
areas determined from the unknown samples in the calibration function. By
inserting this value in the Formula for Amount Calculation, the actual amount
value will result.

If this is performed for the determined peak areas of substance A in the
samples I and II (taking account of K1), the following amount values are
calculated (the correction factors of the formula for amount calculation are
assumed to be 1.0):

Sample Calculation Amount A
I 167 x 0.2267 37.86
II 152 x 0.2267 34.46

For the samples III and IV, there is the following result (taking account of K2):

Sample Calculation Amount A
III 283 x 0.2261 63.99
IV 305 x 0.2261 68.96

 Tip: Calculation of the amount values is continuously, i.e. after
analyzing an unknown sample, values are calculated based on
the standard samples calculated so far!

Calculation of the area values of samples I and II is performed depending on
the current processing status, first with one, then with two, three and finally with
four standard samples. The same applies to the samples III and IV that are
evaluated based on the standard samples in the lines 5,6,9, and 10 of the
sample list.
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If, for example, a Report is generated after each sample, it will only include
the results from the samples analyzed so far. The result may differ from the
result. Therefore, the results of a calibration with the Bracketed mode should
be printed after completing all standard samples.

In the "Bracketed" ⇒Calibration Mode, processing of all standard samples
should be completed before printing the results.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

 Mode: "Fixed"

Calibration based on the Fixed ⇒Calibration Mode allows using any desired
standard samples of an existing calibration for determining current unknown
samples.

 Caution: Always perform the calibration manually (Calibrate). The Auto-
Recalibrate option is not available.

a) User Input:

Sample List

Only unknown samples are entered.

If the sample list is generated via the Sequence Wizard, decide whether to
refer to an existing QNT file (which is recommended) or whether to leave out
this information. When closing the Wizard, the Dionex Chromatography
Management System recognizes that the sequence does not contain any
standard samples and copies the QNT file with the entire information to the
sequence directory. The Fixed mode is selected at the same time.

If no QNT file is defined in the Sequence Wizard, its name must be entered in
the Method column of the sample list after creating one.
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QNT Method / "Peak Table" Sheet

If an existing QNT file is copied, a peak table already exists. Change it
according to your requirements.

If, however, a new, i.e. empty QNT file is used, a new peak table must also
be created. Only entering the ⇒Amount value is not necessary, as calibration
is based on an existing calibration.

QNT Method / "General" Sheet
If an existing QNT file is copied in which the calibration mode Fixed is
selected, changing to this mode is automatic.

If a new QNT file was generated, select the Fixed mode. Determine the
standard samples to be used for calibration on the Calibration sheet.

QNT Method / "Calibration" Sheet
If a QNT file was copied, this sheet lists all standard samples to which the
QNT-File originally referred.

With each newly created QNT file, no standard samples are listed. Choose
the Insert Standard or Append Standard commands of the context menu to
insert the standard samples to be used for calibration and to evaluate the
current samples according to their results.

The standard samples listed here always apply to all samples of a sequence.
Press F4 or SHIFT+F4 to display the same, maximum number of standard
samples.

b) Analysis and Evaluation
Performing the analysis and the evaluation of the individual samples is
analogous to the previous examples.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.
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 Internal/External Calibration
In a calibration with the internal/external method, the external calibration is
corrected by an Internal Standard (= ISTD):

The exact quantity of an internal standard is added to each standard sample
and each unknown sample so that the internal standard has the same
concentration in each vial. The internal standard and the substance to be
determined are calibrated via known standard solutions, i.e. the Calibration
Coefficients are determined from the ⇒Amount values of the standard sample
and the corresponding peak area values via the Calibration Function. Thus,
the amounts of all substances (including the ISTD) can be determined. As the
concentration of the internal standard is identical in all samples, the same ISTD
amount should result.

If this is not the case, an error occurred in the chromatography system (sample
preparation, injection, carry-over etc.). The deviation of the actual ISTD amount
from the nominal ISTD indicates the extent of the error. It can be assumed that
the values of the remaining contents of the sample deviate in the same way,
i.e., they are incorrect. A correction by the set/actual deviation of the internal
standard supplies the actual values.

Example:
In two patient samples, the concentration of alanine and glycine is to be
determined. One standard sample is available. The internal standard norvaline
is added to all three sample vials, so that a final concentration of 10 mmol/l is
reached. During the subsequent pre-column derivatization, 10 µl sample +
20 µl OPA reagent + 20 µl stop reagent are pipetted together. A constant
concentration of 2 mmol/l is added from the norvaline. The chromatographic
separation follows the derivatization of the amino acids in OPA derivatives. 10
and 20 µl of the standard solution ( Dilution Series) and 10 µl of each sample
(sampler position 2 and 3) are injected.

a) User Input:

Sample List
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QNT Method / "Peak Table" Sheet

As the calibration of alanine and glycine is performed with only one (STD 1)
standard concentration (same sampler position in the sample list), only one
amount value is be entered for each peak.

Proceed as follows to define the Internal Standard:

• In the Norvaline line, select the Standard column and open the F8 edit
box.

• Choose Use this peak as internal Standard and thus define norvaline
as the Internal Standard.

The correct assignment is indicated by the light yellow background of the line
as well as by the ISTD: Internal entry.

• In the Alanine line change to the Standard column and open the F8 edit
box again.

• Choose the Internal/External option. In the field Associated ISTD Peak,
select the standard substance serving as Internal/External Standard
(here: norvaline).

• Repeat this operation for each peak that should be calibrated based on
the Internal/External method (here: glycine).

After completing the input, the following occurs: In the Standard column,
alanine and glycine are labeled Int/Ext Norvaline. In addition, norvaline is
labeled as the internal standard for an Internal/External calibration. The
description ISTD: Internal is changed to ISTD: Int/Ext and the yellow
coloring of the norvaline line is intensified.

 Note: After a color changes from light yellow to dark yellow, there are
two possible colors more. If the retention time is expressed
depending on a selected reference peak (see ⇒Retention Time),
a light blue background highlights this reference peak. If this
reference peak is also used as the internal standard peak, the
corresponding line is displayed in green (blue + yellow = green).
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QNT Method / "General" Sheet
The mode Total is selected. This ensures that the calibration of all samples
(Samples I and II) is performed based on all standard samples (STD 1).

QNT Method / "Calibration" Sheet
The sheet shows all standard samples (of a sequence) that are used for
calibrating the current sample.

Via F4 or SHIFT+F4, successively open each sample of a sequence. For
each sample, the standard samples currently used for calibrating the sample
are shown.

Due to the selected mode, samples I and II have the following appearance:

In the Standard column, the internal standard is labeled ISTD Peak: Int/Ext.
All other peaks receive the label Internal/external Peak .... Proceed as
follows:

If you discover that an error occurred during the analysis of a standard
sample, this standard can be excluded from the above list. This is by
disabling the corresponding sample in the Enabled column on the
Calibration sheet in the QNT Editor. Only selected samples only are
included in the calibration.

b) Analysis Structure:
Injection is four times. During the first run, the first calibration point of the
calibration curve is determined, and during the second run, the second point
is determined. Run three serves to determine the concentration of alanine
and glycine in sample I. Correspondingly, in the fourth run, the concentration
of alanine and glycine in sample II are determined.
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The data system determines the following area values:

Name Area Alanine Area Glycine Area Norvaline
STD 1 (first run) 55 80 40
STD 1 (second run) 110 160 80
Sample I 45 75 39
Sample II 80 150 41

The determined area values of the internal standard norvaline reflect (except
for minor inaccuracies) the ratio of the injected volumes (amounts).

c) Calculation of Missing Amount Values
The second calibration point is determined by injecting different volumes of
the same standard sample. The data system calculates the missing amount
value directly via the following formula:

Amount Am
Inj Vol
Inj Vol

Smp Wght
Dil FactorPeak Tab

unknownAmount

known Amount
= −. *

. .
. .

*
.
.( .)

With the ⇒Dil. Factor (dilution factor) and the ⇒Weight (sample weight)  = 1,
the result is as follows:

Peak Name Calculation Amount [2]
Alanine 50 x (20/10) = 100
Glycine 50 x (20/10) = 100
Norvaline 20 x (20/10) = 40

d) Calibration Points
From the known (Amount 1) or calculated (Amount 2) amount values and the
determined area values of the standard samples, the value pairs of the
individual calibration points can be established:

Substance Area value Amount value [1] Amount value [2]
Alanine 45 50
Alanine 90 100
Glycine 80 50
Glycine 160 100
Norvaline 40 20
Norvaline 80 40
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The data system determines all calibration coefficients, depending on the
selected calibration function.

e) Calculation of the Calibration Coefficients
A linear calibration curve through the zero point (calibration type Linear) can
already be described by one calibration coefficient (c1). If the example is
chosen so that the calibration point in each calibration curve are located
exactly on a straight line (e.g. in an exact measurement), c1 results as the
y/x-quotient of each value pair (= slope of the calibration curve).

Substance y/x-Value pair c1
Alanine 50/45 1.111
Alanine 100/90 1.111
Glycine 50/80 0.625
Glycine 100/160 0.625
Norvaline 20/40 0.500
Norvaline 40/80 0.500

If the calibration points are not located exactly on one line, the data system
calculates an optimized c1 approximate value for each substance. If a
different calibration type were selected, the data system would also calculate
the remaining calibration coefficients (c0 and c2) according to the calibration
function.

f) Amount Calculation: Internal Standard in the Unknown Samples
If the area values of the internal standards from samples I and II are known,
the amount of the internal standard (norvaline) can be determined in the two
samples via the calibration coefficient c1 (here = 0.5) established for the
calibration curve of the norvaline.

Sample Calculation Amount (ISTD)
I 39 x 0.5 19.50
II 41 x 0.5 20.50

The ratio between the (nominal) amount value entered in the peak table and
the ⇒ISTD Amount (Amount of the Internal Standard) of the internal standard
in the corresponding sample is referred to as ISTD factor.

)(

.)(

SampleISTD

TabPeakISTD

Amount
Amount

FactorISTD −=−
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The following values are resulting:

Sample Calculation ISTD Factor
I 20 / 19.5 = 1.026
II 20 / 20.5 = 0.976

The result states that an error was made by 1.026 (sample 1) or 0.976
(sample 1). As the actual amounts of alanine and glycine deviate (in all
probability) by 2.6 / 2.4% from the "real" values. They are corrected by this
amount as follows.

g) Amount Calculation: Alanine and Glycine
Calculation of the amount values of glycine and alanine is via the Formula
for Amount Calculation. In contrast to an external calibration, the term ISTD
Factor is now unequal 0, i.e., the results are corrected by the calculated
ISTD factor.

Sample Calculation (Area x c1 x ISTD Fact. =) Amount
I 45 x 1.111 x 1.026 = 51.30 (Alanine)
I 90 x 0.625 x 1.026 = 54.90 (Glycine)
II 80 x 1.111 x 0.976 = 86.75 (Alanine)
II 160 x 0.625 x 0.976 = 97.60 (Glycine)

The alanine or glycine amount values corrected by the norvaline deviation
are resulting.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.
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 Internal Calibration
In the pure internal standard method, calibrating is via the Internal Standard,
only. Calculation is with area and amount ratios instead of absolute areas and
amounts. In the Formula for Amount Calculation

n

n
pppp WghtSmp

FactDilFactISTDFactspxaAmount
.

..*.*..Re*)( −=

the ratio of the peak area to the peak area of the Internal standard (x(p rel.)) is
used instead of the peak area (xp) for this purpose.
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Instead of an ⇒Amount (Amount p), the result is the ratio to the internal
standard (Amount p rel).
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If the result is multiplied with the amount of the internal standard, the amounts
of the sample substances to be determined are resulting.

Example
In a clinic lab, prepared urine samples of two patients are examined for the
catechol level. Adrenaline and dopamine are to be determined. Two standard
solutions of different concentrations are available (STD 1: 50 ng/µl each; STD
2: 100 ng/µl adrenaline/dopamine each). To check the precise dosing of the
sampler, catechol is added. The internal standard method is selected. 20 µl of
each sample and each sample is mixed with 20 µl of the catechol solution. As
the concentration of the added catechol solution is 10ng per µl, each vial
(40 µl) contains 10 x 20 = 200 ng catechol. This means that exactly
200/4 = 50 ng catechol is injected with each 10 µl injection.
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a) User Input

Sample List

In contrast to the examples in the external and internal/external calibration,
the second calibration point is not determined via the modified injection
volume but via a second standard sample with the double concentration. As
a result, two different sampler positions are used (1 and 2).

QNT Method / "Peak Table" Sheet

As the calibration of adrenaline and dopamine is performed with two standard
concentrations (STD 1, STD 2, different autosampler position in the sample
list), two amount values are entered for each peak.

Then, the Internal Standard is labeled. Proceed as follows:

• Select the Standard column in the Catechol line and open the F8 edit
box.

• Choose Use this peak as internal Standard and thus define catechol
as Internal Standard.

The yellow coloring of the line and the ISTD: Internal entry indicate the
correct assignment.

• Change to the Standard column in the Adrenaline line and open the F8
edit box again.

• Choose the Internal option and select the standard substance serving as
Internal Standard (here catechol) in the field Associated ISTD Peak.

• Perform this operation for each peak that should be calibrated with the
Internal method (here dopamine).



Actions in the QNT Editor 411

After completing the input, the following occurs: In the Standard column,
alanine, and dopamine are labeled Internal Catechol. In addition, catechol is
indicated as the internal standard by a darker shade of yellow.

 Note: After the color changes from light yellow to dark yellow, two more
colors are possible. If the retention time is expressed depending
on a selected reference peak (see ⇒Retention Time), a light blue
background highlights this reference peak. If this reference peak
is also used as the internal standard peak, the corresponding line
is displayed in green (blue + yellow = green).

QNT Method / "General" Sheet
The mode Total is selected. This ensures that the calibration of all samples
(Sample I and II) is performed based on all standard samples (STD 1, STD
2).

QNT Method / "Calibration" Sheet
This sheet shows all standard samples (of a sequence) that are inserted for
calibrating the current sample.

Via F4 or SHIFT+F4, each sample of a sequence can be opened
successively. For each sample, the current standard samples for calibrating
the sample are indicated.

Due to the selected mode, sample I and II appear as follows:

If you discover that an error occurred during the analysis of the standard
sample, this standard can be excluded from the above list. This is by
disabling the corresponding sample in the Enabled column on the
Calibration sheet in the QNT Editor. Only selected samples are included in
the calibration.

b) Analysis Structure
Injection is four times. During the first run, the first calibration point of the
adrenaline and dopamine calibration curve is determined via STD 1, and
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during the second run the second point is determined accordingly via STD 2.
Run three serves to determine the concentration of adrenaline and dopamine
in sample I. Correspondingly, in the fourth run, the concentrations of
adrenaline and dopamine in sample II are determined. In addition, the area of
the added catechol is determined in each run.

The data system determines the following area values:

Name Area Adrenaline Area Dopamine Area Catechol
STD 1 125 200 250
STD 2 250 400 250
Sample I 223 150 245
Sample II 178 380 255

The area values determined for catechol reflect the ratio of the injected
volume or amounts (except for minor inaccuracies).

c) Calculation of  (Amount p, rel). and x (p, rel)
The Area (Peak) to Area (ISTD) ratio results in x (p, rel):

ISTD

p
prel Area

Area
x =)(

Substance Area Area (ISTD) x (p, rel)
Adrenaline (STD 1) 125 250 0.5
Adrenaline (STD 2) 250 250 1.0
Dopamine (STD 1) 200 50 0.8
Dopamine (STD 2) 400 1.6

The Amount (Peak) to Amount (ISTD) ratio results in (Amount p, rel).

ISTD

Peak
relp Amount

AmountAmount =),(

Substance Amount Amount (ISTD) Amount (p, rel)
Adrenaline (STD 1) 50 50 1.0
Adrenaline (STD 2) 100 50 2.0
Dopamine (STD 1) 50 50 1.0
Dopamine (STD 2) 100 50 2.0
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d) Calculation of the Calibration Coefficients
A linear calibration curve through the zero point (calibration type Linear) can
already be described by one calibration coefficient (c1). If the example is
chosen so that the calibration point in each calibration curve are located
exactly on a straight line (e.g. in an exact measurement), c1 results as the
y/x-quotient of each value pair Amount p rel to x p rel:

Substance Amount (p rel) / x (p rel) c1
Adrenaline 1.0/0.5 2.000
Adrenaline 2.0/1.0 2.000
Dopamine 1.0/0.8 1.250
Dopamine 2.0/1.6 1.250

If the calibration points are not located exactly on one line, the data system
calculates an optimized c1 approximate value for each substance.

If a different calibration type is selected, the data system calculates the
corresponding calibration coefficients (c0, c1, and c2).

e) Amount Calculation
Via the Formula for Amount Calculation, the relative amount (=relative to
the amount of the ISTD) of the sample contents adrenaline and dopamine
can be calculated from the known c1 and from the ratio peak area (sample)
to peak area (ISTD). If the correction factors ⇒Dil. Factor (dilution factor) and
⇒Weight (sample weight) are assumed to be 1, the following Amount /
Amount ISTD values result:

Sample I Calculation: Amount /Amount ISTD
Adrenaline 2.000 x (223/245) = 1.820
Dopamine 1.250 x (150/245) = 0.765

Sample II Calculation: Amount /Amount ISTD
Adrenaline 2.000 x (178/255) = 1.396
Dopamine 1.250 x (380/255) = 1.863
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By multiplication with the amount values of the internal standard, the actual
amount values for adrenaline and dopamine in the analysis samples can be
calculated.

Sample I Calculation: Amount
Adrenaline 1.820 x 50 = 91.00 [ng]
Dopamine 0.765 x 50 = 38.25 [ng]

Sample II Calculation: Amount
Adrenaline 1.396 x 50 = 69.80 [ng]
Dopamine 1.863 x 50 = 93.15 [ng]

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to...: Actions in the QNT
Editor  Calibration.

 Calibration with Variable Internal or Internal/External
    Standard
The method itself or the properties of the Internal Standard make it
sometimes impossible to add exactly the same amount of the ISTD. To solve
this problem, the Dionex Chromatography Management System offers the use
sample amount as reference (Variable) option (see F8 box of the Standard
column in the peak table).

In this case (Internal/External or Internal), the amount of the internal standard
is not entered in the ⇒Amount column of the peak table (not possible at this
point), but in the ISTD Amount column of the sample list. For each sample, it is
thus possible to enter the amount of internal standard separately.
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a) User Input

Sample List

The amount of internal standard is now entered directly in the Amount
column of the sample list.

QNT Method / "Peak Table" Sheet

Except the substance serving as internal standard, all amount values are
entered as before. Then, the Internal Standard is selected as follows:

• In the Catechol" line, select the Standard column and open the F8 edit
box.

• Choose Use this peak as internal standard and thus mark Catechol as
the internal standard.

• Select Use sample amount as reference (Variable Internal Standard)
to use a variable internal standard.

The correct assignment is indicated by the yellow coloring of the line and by
the entry ISTD: Var. Internal. The corresponding Amount column fields are
set to 1.

All other QNT file entries are performed as before.
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b) Evaluation
Evaluation is analogous to the corresponding evaluation without variable
internal standard. However, slightly different calibration and evaluation
formulas are used.

For a detailed description of the differences between standard methods, see
 Evaluation with Various Standard Methods in the Calibration section.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to...: Actions in the QNT
Editor  Calibration.

 Entering the Concentration/Amount of the Validation
    Sample

Validation Samples are used to check the calibration. They correspond to
standard samples in as much as the amount of analyte is known. However,
they are not used to determine the calibration curve but only to validate the
calibration.

The known concentration (or amounts) of the different analytes in the validation
samples is entered in the QNT editor. Please note the following difference:

1. Validation Sample = Standard Sample
All individual concentrations/amounts corresponds to the
concentrations/amounts of a standard sample that has already been used for
the calibration curve, especially if the validation sample is injected from a vial
containing standard sample.

In this case, an ⇒Amount column for the corresponding standard sample is
already available in the QNT editor. If you wish to use this column for a
validation sample, proceed as follows:
• On the Amount Table tab, place the cursor in the Amount column of the

corresponding standard sample.

• Select the Columns option in the context menu (right mouse click) and
Amount Column Properties... to open the Amount Column Properties
dialog box.
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• Press Add Standard(s)... to open the Select Sample(s) dialog box.

• Select Validation samples to list the available validation samples in the
right window. Select the desired validation sample(s) from the list.

• Press Ok to accept the selection and press Ok once again in the Amount
Column Properties dialog box.

All amount values of the respective standard sample now also apply to the
validation sample(s).

2. Validation Sample ≠  Standard Sample
Using a validation sample whose composition is different from all standard
samples (if only in its concentration of amount of one analyte) requires a
separate Amount column for this validation sample. Proceed as follows:
• In the QNT editor, go to the Amount Table tab.

• Select the Columns option in the context menu. Select New Amount
Column... to open the Add Amount Column dialog and proceed as
described under Validation Sample = Standard Sample above.

In this way, a separate column was created for your validation sample. If this
column shall be valid for other validation samples or for standard samples,
proceed as described under Validation Sample = Standard Sample.

For information on how to use the validation sample for checking the calibration
curve, see  Validating the Calibration Curve.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.
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 Validating the Calibration Curve
If you wish to check the calibration using the respective values of the

Validation Samples (perhaps of the standard sample as well) you have to
compare the expected concentration or amount values to the
measured/calculated values either numerically by means of the Amount
Deviation report variable or visually by means of the calibration function.

1. Numerically, by means of the Amount Deviation report variable:
The determined (actual) area values are converted to concentration or amount
values by means of the Calibration Function and compared to the expected
(nominal) values of the ⇒Amount table.
• Add a new column to a report or a Printer Layout page or change the

assignment of an existing column as described under How to ...: Actions
in the Report  Defining the Contents of a Report.

• Select the Amount Deviation variable in the ⇒Peak Results report
category. Use the Parameter button to define whether the result of the
variance comparison shall be expressed as absolute amount value or as
deviation in percent (Relative in % of the expected Amount).

2. Visually, by means of the Calibration Curve
For checking the calibration curve visually, the validation samples can be
displayed (specially marked) in the curve:
• Select the Decoration command in the context menu of the calibration

curve (the Properties Calibration Plot command in the Printer Layout,
respectively).

• Select the Draw validation sample points checkbox on the Options tab.

 Note: Even if this action is performed in the QNT editor these
validation samples will not be considered for the calibration. If,
nevertheless, you wish to use a validation sample as standard
sample later and consider it for calculating the calibration curve,
set its ⇒Type (Sample Type) to Standard in the sample list of
the Browser.
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In addition, the confidence region can be made visible in the calibration curve.
Selecting the Draw upper and lower confidence limit checkbox on the
Options tab and defining the desired confidence region allows you to check
whether your validation and standard samples are within the corresponding
confidence interval.

For information on how to enter the concentration/amount, see How
to ...: Actions in the QNT Editor  Entering the Concentration/Amount of
the Validation Sample.

For an overview on the different calibration possibilities offered by your Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Calibration.

Spectra Library Screening
The Spectra Library Screening sheet of the QNT Editor allows you to search
spectra libraries for reference spectra. The spectra search is also possible from
the spectra plot, as described in How to ...: Actions in the UV Spectra and
Mass Spectra  Starting a UV Spectra Search.

For further information, see the following topics:

 Entering Criteria for the Spectra Library Screening
 Starting Library Screening and Viewing Results
 Integrating Screening Results in Reports and Peak Labels
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 Entering Criteria for the Spectra Library Screening
Enter the criteria for a spectra library search on the Spectra Library
Screening (= SLS) sheet of the QNT editor:

• Select a spectra library (LIB file) from the field Spectra Library to be
searched in .... If the required LIB file is not included, press the Browse
button to search for the file.

• In the Match Criterion field, select the method (see ⇒Match Criterion)
used for comparing the original spectrum and the library. The best search
results are usually received via the setting Least Square.

• In the Hit Threshold field, enter a Match Factor between 0 and 1000,
e.g. 950. Only spectra with a match value above 950 will be shown.
Spectra with less similarity will not be included. Unless derivatives of
spectra are compared with each other, reference spectra with a match
value below 900 are usually spectra of other substances. Exceptions to this
rule are only acceptable, if the signal to noise ratio is low.

 Note: To be able to compare UV spectra, the spectrum and the
reference spectrum should be recorded under identical
conditions. For best results, create your own library of spectra
you recorded yourself.
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Additional conditions are possible to perform a more exact search:

Usually, the Use Spectrum Derivative option is deactivated, i.e. the
comparison of spectra is based on their actual curve. If the 1st derivative
option is selected, the comparison of two spectra is based on the first
derivative. As a result, the curve characteristics increase (shoulders become
extrema), allowing a more exact comparison of extrema. However, the signal to
noise ratio will considerably decrease; and sections with lower signals will be
less significant.

Restrict Wavelength Range allows you to limit the spectra comparison to the
relevant spectral range.

Select Check Greatest Rel. Max. to use only spectra with the greatest relative
maximum at the same position. Select Allowed Deviation to specify a
tolerance range. The range should not exceed 10 nm, otherwise the criterion
will lose significance.

Click the field Maximum Retention Time Deviation to determine the
maximum retention time deviation of the reference spectrum in percent. This
prevents including substances with very similar spectra that are eluted at
different retention times.

If you select Check Number of Relative Extrema, the Dionex
Chromatography Management System checks the number of relative extrema
of the reference spectrum. This option allows excluding spectra that are very
similar but show an additional maximum.

Select Maximum Retention Index Deviation: or Maximum Kovats Index
Deviation: to include only those spectra in the comparison for which the
retention index or, respectively, the ⇒Kovats Index is identical with the index of
the sample substance. The respective tolerances are defined in the right field.

 Caution: If noise is very strong, noise peaks can be considered extrema.
In this case, it is recommended to deactivate Check Number of
Relative Extrema.

On the right side of the window, you can further restrict the resulting library
spectra. Open the dialog box Restrict Library Search with Add. Via Field
Name, you can then select type of parameter to be determined from the
following search criteria:
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Solvent Composition Detector Serial Number
Control Program Timebase
Substance Name Sequence Name
Unique ID Sample Name
Comment Extract Operator
Detector Name

These items can be linked (partly) via the following operators (Conditions) with
a freely selectable value:

Operator Restricts the search to spectra with parameters that
is equal to: fulfill the specified condition.
starts with: start with the entered string.
does not start with: do not start with the entered string.
ends with: end with the entered string.
does not end with: do not end with the entered string.
contains: contain the entered string.
does not contain: do not contain the entered string.

 Note: If you want to search all libraries in a directory, simply enter the
character * as the file name. The wildcard characters (known
from MSDOS) * and ? are valid. Example: LIB::\CMDATA\LIB\D*
searches all libraries starting with the letter D in the directory LIB
of the datasource CMDATA.

 Starting Library Screening and Viewing the Results
Press the Apply button to use the entered search parameters. This command
starts the library search for each peak in the current chromatogram.

The spectra plot is displayed in addition to the chromatogram. The reference
spectrum (hit) with the corresponding match criterion will be shown. The
displayed spectrum is the reference spectrum of the selected peak. You can
view the search results for the other substances by clicking the corresponding
peaks in the chromatogram.

If more than one library spectrum fulfills the entered criteria, you can view the
other hits. Place the cursor on the spectrum, open the context menu, and open
the Spectra Decoration sheet. The Peak Spectra tab allows you to enter the
number of reference spectra to overlay:
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In this example, you will receive a list of three reference spectra. The first
spectrum has the highest match value and thus the greatest similarity to the
original spectrum.

 Inserting Screening Results in Reports and Peak Labels
If you save the search parameters in the QNT file, the results of the Spectra
Library Screening can be used for the peak label or in report tables or
templates ( Printer Layout).

Inserting Screening Results in Report Definition Files

To view the screening results in the report, the report category Peak Purity
offers the following variables:

Number of SLS Hits calculates the number of library screening hits for a peak.
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SLS Hit opens the ⇒Hit Spectrum report category that includes all variables of
the corresponding library spectrum:

Designation Description
Substance Name
Match Factor Match Factor
Library Name Name of the spectra library
Library Record Opens the ⇒Spectra Library category
Number of rel. Extrema
Solvents
Comment Comment
Sequence Name
Sequence Header Record
Sample Name
Sample Record Branches to the ⇒Sample category
Acquisition Time Acquisition date and time
Timebase Timebase
Program PGM File
Sample Rate
Retention Time ⇒Retention Time
Lambda Min. Minimum wavelength
Lambda Max. Maximum wavelength
Lambda Range Wavelength range
Lambda Resolution Spectral wavelength resolution
Detector Name
Detector Serial Nr.
Extract Time Time when the sample was added to the library
Extract Operator User who added the sample to the library
Retention Index Linear ⇒Retention Index
Kovats Index ⇒Kovats Index

The Formula field shows a short version of your selection, e.g.
peak.hitSpec(1).name for the spectra name of the best hit. The digit indicates
the hit: 1 is the best, 2 is the second best hit, etc.
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Including Screening Results in the Peak Label
To include the screening results in the chromatogram, perform the following
steps:
• Position the cursor in the chromatogram.

• Select Chromatogram Decoration from the context menu.

• On the Peak Label tab of the Chromatogram Decoration dialog box,
press {...} to reach the Insert Variable into Peak Label Formula dialog
box. From the category Peak Purity, you can choose the Number of SLS
Hits and SLS Hit variables (see Report above).

Example
To label each peak in the chromatogram with the name of the best hit and the
corresponding match factor, perform the following steps:
• From the category Peak Purity, choose Substance Name under SLS Hit.

• In the Formula field, enter " - " after the formula, then click Match Factor
under SLS Hit.

• Press OK. You will receive the following "Formula input on the Peak Label
sheet of the Chromatogram Decoration dialog box:
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 Tip: If you have saved the search parameters in the QNT file, it is
sufficient to activate Spectra library screening results, e.g. in
the spectra plot. Just open the context menu and select the
option via Spectra Decoration and Peak Spectra. In this case,
you do not need to open the Spectra Library Screening dialog
and press Apply.

Defining the System Suitability Test
The SST tab (see System Suitability Test (SST)) of the ⇒QNT Editor allows
you to check your system's performance for individual samples. Any number of
tests (limited only by the capacity of your computer) is possible. Each single
test is given in an individual line. Use the arrow key ↓ to append additional lines
to the bottom line. This action automatically opens the SST Wizard that guides
you through the process of entering the SST conditions.
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 Tip: If you want to perform a System Suitability Test, ensure to enter
the QNT file into the sample list before starting the analysis.
Otherwise, the Batch cannot be aborted in case of Fail Action
- Abort Batch because the SST will not yet be performed during
the batch run!

For further information, see

 Inserting a New SST: SST Wizard
 Modifying the System Suitability Test
 Inserting SST Results in the Printer Layout

 Inserting a New SST: SST Wizard
The SST Wizard supports you in inserting a new System Suitability Test
(SST). Double-click a cell or press F8 to open the SST Wizard. The Wizard
opens automatically via the Append Line and Insert Line commands of the
context menu or via the ↓ key (note: to open the SST Wizard via the ↓ key, the
cursor must be placed in the bottom line).

The SST Wizard includes the following pages:
• Start

• Sample Condition

• Test Condition

• Aggregated (optional)

• Peak & Channel Condition (optional)

• N.A. & Fail Action
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Start
On the Start page, you can choose from a list of predefined tests:

All predefined values on the following pages depend on the selection made
here.

The special entry <Copy Previous Test> copies the previous test. If the test is
the first within a list (i.e., there is no previous test), the test that was previously
at this position will be copied.

As no other conditions are required, the Wizard can be terminated here.
Pressing Next proceeds you to the following Wizard pages where you can
check and, if necessary, modify the predefined conditions.



Actions in the QNT Editor 429

Sample Condition
Here you can modify the sample conditions. There are five possible choices:

Apply on all Samples performs the test for each sample. Select Sample Type
to perform the test for a certain sample type only. Under Sample/Vail
Number(s) define the sample numbers for which to perform the test (e.g.
5,17;4-6;13,11). With Sample Property being selected, the test is performed
for samples with the specified property only. The property is entered below.
The User defined condition option is for advanced users and allows you to
enter any kind of formula in the report format. The test is then performed for
samples only for which this condition is true.
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Test Condition
This Wizard page allows you to enter the basic conditions for the SST:

First, enter a unique name under Test Name before specifying the Test
Condition. Use the Browse button "..." to select the desired variable in the
report variable dialog. Via the Compare Operator, the selected variable is then
compared with the Compare Value. The Compare Value can either be a value
or a report variable / formula. Check the Use aggregation box to aggregate
the test conditions over several samples and to open the Aggregate page.

Aggregate
This page of the SST Wizard serves to define the function, sample(s), and
condition for sample aggregation. (For further details, see Aggregate in the
Online Help).
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Peak & Channel
This page is optional and opens only if the test condition requires a peak or
channel to be entered. (For further details, see Peak & Channel in the Online
Help).

N.A. & Fail Action
Define the test result if the test condition cannot be checked (N.A.) and decide
whether the server shall abort the batch if the test condition is not fulfilled (Fail
Action).

 Modifying the System Suitability Test
Double-click a cell or press F8 to modify an existing System Suitability Test
(SST). The following tabs are available in the opening SST Properties dialog:
• Sample Condition
• Test Condition
• Aggregate
• Peak & Channel Condition
• N.A. & Fail Action
The tabs correspond to the individual SST Wizard pages. For further details,
see How to ...: Actions in the QNT Editor  Inserting a New SST: SST
Wizard

 Inserting SST Results in the Printer Layout
If you save the SST parameters in the QNT file, the results of the System
Suitability Test (SST) can be used for the peak labels or as individual variables
in the Printer Layout  (not in tables).
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In the Printer Layout:
The Report category System Suitability Test allows you to view the SST
results in the printer layout. The following variables are available:

Variable Description
Number Number of the SST
Name Name of the SST
Sample Condition Sample Condition for the SST
Test Condition
Aggregate Aggregate function
Operator
Value
Channel
Peak
N.A. User-defined test result if checking of the

condition is not possible
Fail Action
Aggregated Samples
Sample Condition Results
Test Results
Aggregated Sample List
Aggregated Sample Result List
Result of Test Condition or Aggregate
Result of Compare Value

The Formula field indicates your selection in short, e.g., sst.test_condition for
the test condition.

Processing Mass Spectra
Mass Spectra have a relatively high noise level. Therefore, they must be

processed before being used further. The Dionex Chromatography
Management System uses the following algorithm:
• First, the spectrum of the peak maximum is determined by averaging

several spectra on both ends.

• Then, the background spectra of both peak ends are determined.
Averaging several spectra also does this.
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• The background peak spectrum (normally at the peak maximum) is then
determined via linear interpolation of these two background spectra and is
finally subtracted from the single spectrum (normally of the peak
maximum).

The MS tab of the ⇒QNT Editor allows you to specify how to form mass
spectra from individual spectra. Check the Enabled box to activate spectrum
enhancement:

Under Peak Spectrum Bunch, indicate the number of single spectra that shall
be aggregated to the spectrum at the peak maximum. It is possible to average
max. 99 single spectra. For symmetry reasons, odd numbers can be entered
only.

Activate Peak Dependent Background Subtraction to allow automatic
background subtraction for each peak individually.

Use the Left/Right Region Bunch fields to select up to 99 single spectra each
for forming the two background spectra. Zero and even numbers are permitted
as well.

The Fixed Background Subtraction Ranges option allows defining two fixed
ranges for the entire chromatogram that are then used for background
subtraction. Usually it makes sense to set one range at the beginning and the
other one at the end of the chromatogram.
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Press Apply to accept the settings and calculate the resulting mass spectrum.
With enabled view, the newly calculated mass spectrum will be displayed at
once.

 Note: Defining the background subtraction manually in the
chromatogram affects the settings on the MS tab. Setting
Background Subtraction e.g. to Fixed Background Ranges in
the context menu of the chromatogram activates the
corresponding option on the MS tab of the QNT editor.
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Actions in the Calibration Curve
The Calibration Curve window displays the Calibration Curve calculated
from the Calibration Points. The Calibration tab of the Report allows you to
view the calibration data of the peaks of the current chromatogram.

If, in the Calibration settings in the QNT Editor, a single standard was
excluded from the calculations (Enabled column), the corresponding
calibration point is red. Calibration points of this type will not be used for
calculating the calibration curve for which they were disabled. The display color
of the calibration points of the current sample is purple.

In the Calibration Curve, the Disable Standard command of the context
menu allows you to exclude standards, completely or in part, from the
calibration. The Disable (Enable) Standard xyz dialog box opens for the
selected calibration point. (This point refers to the selected peak in the current
chromatogram. Double-clicking a different calibration point allows you to select
a different standard.) Define whether the corresponding standard sample shall
be used for calibration purposes. You can exclude the respective standard from
the calibration for all peaks and all channels (default) or for the selected peak
and/or channel only. (Also, see How to ...: Actions in the QNT Editor

 Disabling Standard Samples).

In addition, the following options are available:

• From the context menu, choose Next Peak / Prev.Peak to view the
calibration curve of the next/previous peak.

• Choose Decoration to change the caption, color, and axes.
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Actions in the Printer Layout
The Printer Layout allows preparing your data for the printout. It is part of the
⇒Report Definition File (= RDF). To assist you in preparing the first printout
and in creating your own report definition files (also called report templates in
the following), the Dionex Chromatography Management System offers some
default RDF templates.

To printout further data that is not included in the default report definition files,
the Dionex Chromatography Management System offers the possibility to
create individual worksheets via the Printer Layout window. These
worksheets can be combined and saved as a report template. The results of
sample processing can thus be printed in a number of layouts.

For further information, see the topics below:

 Creating a Worksheet
 Inserting a Chromatogram
 Inserting a Table
 Inserting Individual Variables
 Inserting Text
 Saving/Loading a Report Template
 Specifying the Printout
 Printing the Results of a Single Sample
 Printing the Results of a Sequence / Sample Batch
 Setting Print Area / Print Title(s)
 Saving the Contents of a Report Template

Users who have the Report Publisher add-on product installed can use the
following additional features:

How to ...: Actions in the Printer Layout
 Entering User-defined Formulas
 Entering User-defined Formulas (Practice-oriented Example)
 Creating Charts
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For assistance to change the page format and to create headers and footers,
see How to ...: Actions in the Printer Layout:

 Changing the Page Format
 Notes on the Page Setup

 Creating a Worksheet
The worksheet represents an area that is unlimited in horizontal and vertical
direction, but is divided in "n" printed pages. By inserting chromatograms,
tables, diagrams, or other elements, certain areas are reserved on the
worksheet. When printing one or several samples, the areas are "filled" with the
values of the current sample.

To create your own worksheet, proceed as follows:
• Choose the Insert Sheet command in the Edit menu to insert an additional

worksheet, or

• Select an existing worksheet and change it according to your requirements.

 Inserting a Chromatogram
• Choose the Insert Chromatogram command to insert a chromatogram.

• Draw a rectangular frame of any size using the now visible + mouse.
Reserve this area to display the chromatogram of the current sample.

• Click the area to select it.

• The frame can now be moved, reduced or enlarged in size.

• Choose the Properties command in the context menu to format the
chromatogram (caption, axes, font size, etc.).

• Press the F4 or Shift+F4 key to view the chromatogram of the next or
previous sample and to check whether the selected settings are
appropriate for all chromatograms.
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 Inserting a Table

• Choose the Insert CHROMELEON Report Table command to include a
table.

 Caution: If the worksheet already contains a report table, insert the new
table above or below the existing one. It is currently not possible
to insert several report tables next to each other.

• Choose a method to pre-select the columns to print. On the right-hand
section of the edit dialog box, the names of the columns are displayed.

• Select the columns that are to be part of the printed column. Press and
hold the Ctrl key to select several columns simultaneously.

• Choose OK to complete the procedure and to insert the table in the
worksheet.

• Select a column header and choose the Properties Report Column...
command from the context menu to determine the header, the dimension,
and the format of the column or of the column values.

• Select a single cell, an area or the entire table to modify the appearance of
the table via the Format menu (font size and type, frame, color etc.).

• Select a column or a row to delete it (Delete Row(s)/Column(s)) or to
insert additional rows or columns in front of the selected area (Insert
Row(s)/Column(s)).

Inserting a "Total" Row
Proceed as follows to insert a Total row at the end of the table:

• Copy any cell from another Total row (e.g. from another Printer Layout
table or from an integration report).

• Select the cells of the new table where the sum of all cell values of the
column should appear.

• Choose the Insert command.
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Creating the correct cell reference
The sum value in the Total row must receive the correct cell reference. This is
especially important, if the new table is longer than the table from which the
sum value was copied.

• Activate the Layout Mode (View menu) to display the edit line.

• Select the first sum cell value of the Total row. In the edit line, the
corresponding formula (e.g. =SUM(C10:C22)) will appear.

• Use the mouse cursor to select the cell range in parentheses in the edit line
(e.g. C10:C22).

• Then select the actual cell range within the table or enter the cell range in
the edit line via the keyboard.

• Press Enter.

The sum cell value is recalculated based on the new cell range. Then perform
the individual steps for the remaining sum cell values.

 Note: It is not possible to move or copy an entire table. Only the current
contents (=values) can be copied to the clipboard, not the
underlying variables! Moving individual columns is not possible.
Insert a new column where required and delete the column that
is no longer needed.

 Inserting Individual Variables
At the start of a printout or as an addition to a table or a chromatogram it may
be necessary to include general data, e.g. the sequence name, the
corresponding Datasource, the user name, etc.
• Select a single cell and choose the Insert CHROMELEON Report

Variable command.

• Via an edit dialog box, you can now select a single variable from different
categories.

• Choose OK to complete the procedure and to include the variable in the
previously selected cell area.

• Select the cell to modify the appearance of the variable via the Format
menu.
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 Note: Cells containing an underlying Dionex Chromatography
Management System variable can be recognized by the formula
name that is displayed on the status bar (e.g. peak.height)
whenever the cell is selected. If the selected cell contains text
information, the status bar will remain empty.

 Inserting Text
Text can be positioned in any cell of the worksheet. The size of the cell limits
the available space. Note the following:
• As long as the following cells in the same row are not used, no line breaks

are inserted when text is entered in the first column of a worksheet.

• Activate the check box Word Wrap (see Format / Alignment) to insert a
line break.

• Text will always be covered if graphics, e.g. chromatograms are included in
the worksheet.

 Saving / Loading a Report Template

The Printer Layout of a report template (⇒Report Definition File) can contain
one or several worksheets. Saving or loading a report template always saves
or loads all worksheets that are included in the Printer Layout. Saving a single
worksheet is possible only if the report template contains only one worksheet.

• Choose the Save Report Definition command from the context menu to
save the report template and the contained worksheets under one name.

• Choose the Load Report Definition command from the context menu to
open an existing report template.

 Tip: In addition, a report template contains various settings of the
screen report such as window size, type, and number of columns
in a report, axis captions, etc.

 Specifying the Printout
Before you can printout your data, define the printer to be used. In addition,
define the headers and footers, margins, etc. via the Print dialog or the Page
Setup. Use the Print Setup and Page Setup commands of the File menu.
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The Print Setup and Page Setup settings are stored separately for each
worksheet in a report template (Integration, Calibration, Peak Analysis,
Summary, etc.). Select the desired settings for each worksheet separately.

• Choose the Print Setup command of the File menu to determine the
printer, the paper size, and the format (portrait or landscape). Having made
these settings, a message box allows specifying whether to use these
settings for either the current worksheet or all worksheets of the printer
layout of the current report definition file (RDF).

 Tip: The Print Setup settings selected here apply only to the report
definition file of the current sequence. They do not affect the
default settings for Windows. In addition, changing the default
printer, paper size, and format in Windows will not affect the
settings selected here.

• Choose the Page Setup command of the File menu to determine the
appearance of the headers and footers, the size of the margins, the
alignment etc. Here you can also set a grid, determine whether column
headers are displayed and whether the printout should be in black and
white or in color. For further information, see How to ...: Actions in the
Printer Layout  Notes on the Page Setup.

 Tip: Due to technical reasons, direct help information for the Print
Setup and Page Setup dialog boxes is not available.

Also, see: How to ...: Actions in the Printer Layout:

 Saving/Loading a Report Template

 Saving the Contents of a Report Template
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 Printing the Results of a Single Sample
The results of single samples can be printed from either the printer layout or
the screen report (integration plot).

For each printout, the pages of the Printer Layout that are saved in the
⇒Report Definition File are used as template. The results of a single sample or
a sequence (see the next topic  Printing the Results of a Sequence /
Sample Batch) are output in the defined way. However, the report templates
and worksheets define the appearance of the printout, not its contents.

You have to specify which of the worksheets that were created in the printer
layout shall be printed. Different alternatives and windows are available for
doing this.

Printer Layout
The Batch Setup command of the File menu allows specifying the worksheets
to be printed. The Batch Setup dialog box opens:

Make the corresponding settings on the Print Sheets tab of this dialog box.
The Sheets field lists the available worksheets. Define which pages shall be
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printed and under which conditions. Use the Conditions… button to specify
these conditions, i.e., you can define for which samples to print a page. For
example, it would be sensible to printout a summary report for the last sample
of sequence only.

Report (Screen Report)
To print the results of the currently open sample from the screen report, use the
Print command of the File menu.

In the dialog box, select the worksheet to be printed. The sheet will always be
printed with the results that are currently displayed on the screen provided they
are included in the defined view. For example, the current mass spectrum will
be printed only if a mass spectrum is part of the selected worksheet.

 Tip: In the printer layout, you can select peak spectra only. Use the
report if you want to print the retention time spectra. Select the
desired spectrum on the screen and select a worksheet to be
printed that includes a spectrum.

 Printing the Results of a Sequence / Sample Batch
You may also print the results of an entire sequence, a Query or a Batch. If
not already done, you have to specify which of the worksheets that were
created in the Printer Layout shall be printed. Different alternatives and
windows are available for doing this.
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Browser
After you clicked a Sequence or a sample in the Browser, open the Batch
Report dialog box via the Batch Report command of the File menu. Select the
desired report template in the Use Report Definition list box (via the arrow) or
via the "…" button.

The Select sheets to be printed field shows the worksheets that were defined
in the printer layout of the report template. Specify which pages shall be
printed. Define under which conditions they shall be printed via the
Conditions… button. Pressing OK then prints the entire sequence or the
selected samples of a query. Select all samples of a query by clicking the No.
field at the top left of the sample list to print the entire query.
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Printing the Results Directly after Data Acquisition: Control Panel
To print the results directly after data acquisition, you can open the Reporting
dialog box via the Reporting command of the Batch menu:

The Print/Export Report option opens the above dialog box (that is displayed
in the Browser section) once again. Proceed as described above. The window
on the tab indicates the printer, report definition file (RDF), and channel to be
used for the printout. In addition, you can specify whether to print each sample
separately and directly after the data acquisition or all samples when the batch
is finished.

 Tip: The settings made in the Browser or from the control panel are
saved in the report definition file of the current sequence. They
apply to all sequences that use this report definition file. They will
also be used for these sequences as default for the worksheets
to be signed by means of Electronic Signature.

Also, see the previous topic:

 Printing the Results of a Single Sample
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 Setting Print Area and Print Title(s)
If you want to print a defined area of a Printer Layout page, proceed as
follows:
• Select the desired area with the left mouse button.
• Select the Set Print Area command via the Printing option of the Format

menu.
• Deselecting the set print area is via the Release Print Area command of

the Printing option in the Format menu. The set print area is indicated in
parenthesis behind the command.

When printing a table that exceeds one page you can have the titles printed not
only on the first page but on all following pages as well:
• Select the complete lines via the left mouse button. .
• Select the Set Print Titles command via the Printing option of the Format

menu.
• Selecting the Release Print Titles command of the same option allows

deselecting the set print titles. These set print title area is indicated in
parenthesis behind the command.

 Saving the Contents of a Report Template
For the report data of the current sample, the Dionex Chromatography
Management System offers various formats for saving the data.
• Choose the Save as... command from the File menu to start saving the

data.
• Select the Excel ... (*.xls) file format to convert data into the Excel format

and to save as a separate file. In addition to the values of a table, it is of
course possible to include graphics and diagrams. If the Printer Layout of
the ⇒Report Definition File contains several worksheets, this division will
be maintained in the Excel file. Please note that different file types will be
available depending on the Excel version (4 or 5 or 7).

• Select the file type HTML (*.htm) to save the data as a HTML page.
Graphics and diagrams cannot be represented.

• Select the file type Tabbed Text (*.txt) to save data in pure text format.
The contents of individual report columns are separated by a tab stop.
Graphics and diagrams cannot be represented.
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 Entering User-defined Formulas

 Tip: The options described below require the Report Publisher add-
on product.

Creating user-defined formulas is analog to the Microsoft Excel spreadsheet.
The following description is intended for users who are not familiar with
entering formulas:

Example 1:
Let's assume that a table containing two columns (A and B) and three lines (1
to 3) is extended by one column (C), for which there is no Dionex
Chromatography Management System report variable. Thus, e.g. the quotient
of the cell contents of columns A and B can be included in column C.

To enter a formula in a cell, the corresponding cell must be selected first. In this
example, select the cell C1. Now enter the equals sign. The entire input can be
seen in the edit line above the worksheet (here indicated by blue print).

C1 =
A B C

1 12 5
2 17 10
3 13 20
4

Select the cell A1, enter a division sign (slash), select the cell B1, and complete
your input by pressing ENTER. The edit line now shows the formula
(C1=A1/B1) and the cell C1 shows the result of the operation (2.4). The cursor
moves to cell C2.

C1 =A1/B1
A B C

1 12 5 2.4
2 17 10
3 13 20
4
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Proceed in the same way to output the respective results in the cells C2 and
C3. Clicking the cell C1 again, grabbing the selection frame on the lower right
corner, and dragging it to the required cells (C2, C3) can facilitate this
procedure. For calculating the cell values, the Dionex Chromatography
Management System uses the previously entered formula and automatically
creates the correct reference, line by line.

C1 =A1/B1
A B C

1 12 5 2.4
2 17 10 1.7
3 13 20 0.65
4

Example 1 (continued)
To form the sum of the cells of column C in the field C4, proceed as follows:

Select the cell C4 and enter an equals sign. Enter the SUM command required
for adding cell values (see SUM in the Report Publisher Online Help). Then
enter a bracket sign.

C4 =SUM(
A B C

1 12 5 2.4
2 17 10 1.7
3 13 20 0.65
4

Now select all cells (C1, C2, C3) of which you want to add the values. Close
the bracket after the last cell. Press the ENTER key to complete your input.

C4 =SUM(C1:C3)
A B C

1 12 5 2.4
2 17 10 1.7
3 13 20 0.65
4 4.75
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In addition to the SUM command, numerous other functions are entered in the
same way. Thus, you can form the average (see AVERAGE in the Report
Publisher Online Help), express conditions (see IF, True, FALSE in the Report
Publisher Online Help), create logical operations (see AND, OR in the Report
Publisher Online Help), or enter time values (see TIME, DATE, DAY, YEAR in
the Report Publisher Online Help).

 Tip: For an alphabetically sorted list of the available formulas, see
the Additional Functions topic.

Example 1 (continued)
As a further possibility, calculating with "fixed references" is enabled. In
contrast to variable value pairs described above (A1/B1, A2/B2, A3/B3), the
quotient is now formed of a variable and a fixed value (A1/C4, A2/C4, A3/C4).
In this example, output is in column D.

Proceed as described above to create the first cell reference (D1).

D1 =A1/C4
A B C D

1 12 5 2.4 2.5263
2 17 10 1.7
3 13 20 0.65
4 4.75

Now extend the formula by adding two $ signs and thus convert a variable
reference into a fixed cell reference.

D1 =A1/$C$4
A B C D

1 12 5 2.4 2.5263
2 17 10 1.7
3 13 20 0.65
4 4.75

If you copy the formula now, the reference to cell C4 will be retained. The fields
to be calculated (D2 and D3) can then be calculated by simultaneously
selecting the cells D1, D2, and D3.
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D1 =A1/$C$4
A B C D

1 12 5 2.4 2.5263
2 17 10 1.7 3.5790
3 13 20 0.65 2.3768
4 4.75

For a practice-oriented example, see How to ... Actions in the Printer Layout
 Entering User-defined Formulas (Practice-oriented Example).

 Entering User-defined Formulas (Practice-oriented
    Example)
If you use samples with Internal Standard but wish to calculate the
percentage values of the different substances in the sample (without internal
standard), please proceed as follows:

1. Insert the Standard Method variable of the Peak Table category into a
column that you do not need (in the example below "H").

2. a) Select a different column which is not required. Open the dialog box with
F8 and delete the entry in the field Formula. Afterwards delete the entries in
the column (except the last line).

2. b) Enter the formula =IF(H29="ISTD Internal ";"ISTD";E29), e.g. in field F29
(Caution: Do not omit the space following Internal"!), and copy it to the
following lines.

3. a) Select another column which you do not need either. Open the dialog box
with F8 and delete the entry for the field Formula. Afterwards delete the entries
in the column (except the last line).

3. b) Enter the formula =F30/F36*100 in field G30 and copy it to the following
lines of the original substances of the sample. Excel will now place the formula
=F31/F37*100 in cell G31, etc. that you should finally correct to =F31/F36*100,
etc.
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 Creating Charts

 Tip: The add-on product Report Publisher is required for performing
the options described in this section.

The CHART Wizard facilitates creating charts. Perform the steps described
below:

• Select the columns and rows that you would like to present in a chart.

• Choose the Insert ... Charts command from the context menu. The mouse
cursor will change its shape to a small + sign.

• Press the left mouse button and draw a rectangle frame of the size
required for the chart.

• Follow the steps of the CHART Wizard to determine the style, the layout,
and the axes of the chart.

• As soon as you have completed the information for the individual steps,
press the FINISH button to close the CHART Wizard.

The completed (raw) chart will be displayed in the previously drawn frame. If
required, you can perform various changes. You can alter the line width, the
color, and pattern of lines, areas, or captions; you can smooth curves or
change the chart type. You can also change the size and the position of the
entire chart.
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• Click individual chart elements to select them. Now double-click the
element to change it. Get familiar with the numerous options the Dionex
Chromatography Management System offers in various dialog boxes.

• Select the chart frame to reposition or resize the entire chart.

 Changing the Page Format
In the Printer Layout, the page format can be changed as follows:

Define the printer settings
• Select the Print Setup command in the File menu.

• Define the paper size in the Print Settings dialog box. Use the arrow of the
combo box to select the desired size. The size is used for all pages of the
respective printout but is accepted as default.

 Tip: The settings are only valid for the report definition file of the
current sequence. They do not overwrite the default Windows
settings. Any change of the default printer, paper size, or format
that is made under Windows does not affect the settings made
here.

Directly printing in the desired format:
• Select the Print command of the File menu.

• Click Properties to open the corresponding dialog box.

• Select the desired paper size in the lower selection box.

 Notes on the Page Setup
Headers and footers are printed at the upper and lower page margins. They
are defined in the dialog box Page Setup that can be selected in the File
menu.

Headers and footers can contain text and specific format codes. The syntax for
entering is compatible to Microsoft Excel. The numerous possibilities include:
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&L Left-aligns the characters that follow
&C Centers the characters that follow
&R Right-aligns the characters that follow
&A Prints the current sheet name
&D Prints the current date
&T Prints the current time
&F Prints the ⇒Report Definition File
&P Prints the page number
&P+number Prints the page number plus number
&& Prints an ampersand
&N Prints the total number of pages in the document

The following font codes must precede other inputs. Otherwise, they will be
ignored. After each alignment code (&L, &C, and &R), the font can be changed.

&B Bold
&I Italic
&U Underline
&S Strikeout
&"fontname" Use the specified font
&nn Use the specified font size

When entering headers and footers longer than one line, note that the
alignment codes (&L,&C,&R) must be column-oriented. First, enter all left-
aligned rows, then all centered rows and then all right-aligned rows. Press Ctrl-
Enter to separate rows.

In addition to the above pre-defined variables, you can enter the variables of
the Dionex Chromatography Management System. These are given in braces.

Example:
&L&BSequence: {seq.name}, No. {smp.number} of {seq.nSamples}<Ctrl-
Enter>Timebase: {seq.timebase}&RDate: &D<Ctrl-Enter>Time: &T
This example produces the following header or footer (<Ctrl-Enter> is not
visible!)
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Sequence: AMINO, No. 1 of 99 Date: 11.10.96
Timebase: SYS1 Time: 2:04 PM

In principle, any variable of the Dionex Chromatography Management System
can be included in the header. However, generally only sample and sequence
variables make sense. The formulas of Dionex Chromatography Management
System variables are identical with the ones generated in the dialog box for
entering report variables. The number of decimal places for numerical variables
can be entered after the formula, separated by ";" (default: 0). Example:
{smp.inject_volume;2}. Time entries cannot be formatted.

 Note: All worksheets of the Printer Layout that are selected for the
printing are considered one single print job, i.e., page numbering
is consecutive for all worksheets.
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Actions in the Peak Purity Analysis
(PPA) Window

The  PPA (Peak Purity Analysis) window displays the 3D-Field of a
sample, provided there is a corresponding raw data file. This is the case if the
channel 3DFIELD was selected for Data Acquisition.

The 3D-field in the lower right-hand window section has cross-wires. With the
mouse, the axes can be moved separately or together. The spectrum or
chromatogram extracted along the current y and x-axis will be displayed on the
left or above the 3D-field.

• Move the y-axis of the cross-wires to successively view all spectra of the
current chromatogram.

• Move the x-axis of the cross-wires to view the appearance of a
chromatogram at different wavelengths.

• The status bar shows the retention time, wavelength value, and signal
height of the current cross wire position.

Apart from this simple spectra and chromatogram selection, use this method to
perform the following operations (see topics below):

 Analyzing Peak Purity
 Selecting the Optimum Integration Path
 Extracting Spectra, Chromatograms, and 3D-Fields

Analyzing Peak Purity
Peak purity can be evaluated using the following methods (see topics below):

 Visual Check
 PPI and PPI Match Factor
 Normalized Spectra Overlay
 Peak Inhibition via Virtual Channels
 Multiple Ratio
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 Visual Check of Iso-Line Plot
The Visual Check of the Iso Line Plot is a simple method to evaluate peak
purity. High peak purity is indicated by:
• All recognizable absorption

maxima are located
vertically below one
another in direction of the
wavelength axis.

• The maxima are separated
so that the surrounding iso
lines do not touch (no
overlapping).

• Pure peaks have (local)
symmetry or an idealized
ellipse shape in the
maximum.

 PPI and PPI Match Factor
In the chromatogram window of the PPA method, curves for the PPI (Peak
Purity Index) and the Peak Purity Match Factor can be displayed:

• Double-click within the window and select the options Draw PPI and Draw
Match from the tab dialog box Chromatogram Plot.

The peak purity index is represented by a purple curve, and the match factor is
indicated by a green curve. A distinctive rectangular shape is one criterion (of
many) for peak purity. The exact match value at the current mouse cursor
position is shown on the status bar. The ideal value is 1000 and requires
approx. 80% of the available window height.

PPI, match value, and the corresponding standard deviation (RSD) can be
included in a report. The report variables are in the category Peak Purity.

The smaller the standard deviation, the more critical the quality of the
rectangular curve should be judged, i.e., the better the two spectra will match in
various points of a peak.
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 Normalized Spectra Overlay
In a normalized spectra overlay, single spectra of the spectra recorded for the
peak are extracted and are compared with each other. Usually, extraction is at
the run time of the peak and at a specific peak height in the ascending and
descending flank of the peak, e.g. in 10 and 50% of the peak height.
Comparing spectra, which are normalized (!) by the same method, in the
spectra window is an indication of the peak purity.

The better the spectra match, the higher the possibility that the peak is pure.
The following are indications for the impurity of a peak:
• The number of relative maxima and minima of two spectra does not match
• The relative maxima are clearly offset against each other
• The height of the relative maxima strongly deviates

However, please note the following:
• Especially near peak limits, spectra have an increased noise level due to

the normalization procedure. This applies in particular to the UV range.
• Despite baseline correction, the detector drift cannot be compensated

completely in the case of very long peaks.
• The spectra shape depends on the solution, i.e. the spectra of a peak can

only be compared if the mixing ratio was constant during detection.
• It is possible only to compare spectra with the (complete!) absorption in the

dynamic validity range of the Lambert Beer Law. If the peak maximum
including the baseline spectrum is considerably above 1 AU, caution is
called for.

 Tip: The normalized spectra overlay via peak height is currently only
possible in the  Spectra Plot. Within the PPA method, the
"animated" extraction of spectra is possible. Pressing the CTRL
key in the 3D-field extracts the current spectrum. If the y-axis of
the cross-wires is moved simultaneously, all spectra existing for
this range are displayed in the spectra window. The extraction
period is indicated in the chromatogram by a different color. This
process can be repeated (e.g. for different retention times within
the peak width). If the CTRL key is released between the
individual extractions, the spectra extracted per range are
represented in a separate color.
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 Peak Inhibition via Virtual Channels

If two overlapping peaks have different spectra s1(λ) and s2(λ) the following
equitation is true when the area below the baseline is ignored:

A(λ, t) = s1(λ)*c1(t) + s2(λ)*c2(t) (1).

c1 and c2 stand for the time-dependant concentrations of the corresponding
components in the flow cell. Then, two wavelengths  λ1 and λ2 are selected
and the following signal is created:

d(t) = A(λ1, t) - K*A(λ2, t) = c1(t)[s1(λ1) - K*s1(λ2)] + c2(t)[s2(λ1) -
         K*s2(λ2)]. (2),

The c2 term disappears provided the appropriate expression was selected for
K, i.e.

K = s2(λ1) / s2(λ2) (3)

This is the channel ratio of the second peak. It can be read off the height ratio
of the two peaks if they do not overlap completely. In order to be able to use
this approach, the channel ratio of the first peak

K’ = s1(λ1) / s1(λ2)(4)

must be different from K. If not, the first term in equation (2) will disappear as
well. Select wavelengths λ1 and λ2 in such a way that the difference between
K and K’, i.e.

∆K = K - K’ (5)

is the maximum difference. The best way to determine the appropriate
wavelengths is to do so in the PPA Window. After this, the virtual channel d(t)
can be defined. Of course, it is possible to inhibit the first peak in the same
way.

If you know the wavelengths for which ∆K is max. before you acquire the
chromatogram, the two channels e.g. UV_VIS_1 and UV_VIS_2 can be
adjusted to those wavelengths and the following Program may be used:



Actions in the Peak Purity Analysis (PPA) Window 461

 

As already mentioned in the comment line of the program, the following
equation is true for this example:

K  =  0.3.

 Multiple Ratio
Each channel extracted from a 3D-field can be used for performing the ratio
test. Especially suited are chromatograms in the range of spectral minima or
maxima. If the ratio condition is met, this can indicate, but does not prove peak
purity. Performing the test with a larger number of channels does not change
this fact.

Selecting the Optimum Integration Path
The Dionex Chromatography Management System is capable of calculating the

Optimum Integration Path within a 3D-field. The calculation is performed
automatically. The result can be displayed in the 3D-field window of the PPA
method.

• Double-click within the window and select the Draw Opt-Int-Path option in
the tab dialog box Iso/3D-Plot.
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A green line in the 3D-field indicates the integration path. Similar to
chromatograms, it can be saved as a separate channel with variable
wavelength.

• Choose the Extract: Opt. Int. Path to file command from the View or
context menu and determine the name under which the path is saved as a
separate channel.

• Select the Extract from all samples of current sequence or query option,
if the path should be extracted for all samples of the underlying sequence or
query. The shape of the path is identical for all samples!

If the path should serve as a basis for a Wavelength Switch in future
samples, the switch times and the selected wavelength values must be entered
in a program with exact time specifications. This can also be performed by
automatically inserting the data.

• Choose Extract: Opt.Int.Path to clipboard from the View or context menu
to copy the data to the clipboard.

• Select the Name of the channel, for which the wavelength is automatically
switched in the future.

• Enter a value for the Bandwidth if several chromatograms should be
averaged to one. The bandwidth determines the range of the path. All
sections of a chromatogram within this range are averaged to one
chromatogram.

• Open a PGM File and insert the data at the beginning of the program
(Commands view) via the Paste command.

The resulting PGM file could have the following appearance:

0.000 UV_VIS_1.Bandwidth = 0

UV_VIS_1.Wavelength = 210

3.320 UV_VIS_1.Wavelength = 210

4.830 UV_VIS_1.Wavelength = 206

6.100 UV_VIS_1.Wavelength = 272

8.100 UV_VIS_1.Wavelength = 262

9.660 UV_VIS_1.Wavelength = 278

10.480 UV_VIS_1.Wavelength = 250

• Enter further commands in the program to complete it. Sort it according to
ascending retention times.
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Extracting Spectra, Chromatograms, and 3D-
Fields

Spectra

Each spectrum extracted from a 3D-field in the method PPA or the  Spectra
Plot window can be copied (Copy) to the Windows clipboard. The spectrum
can then be inserted in a  Spectra Library via the Paste command. Perform
the following steps:

• Choose the Extract: Spectrum to clipboard command from the View or
context menu to copy the current spectrum from the 3D-field of the method
PPA to the Windows clipboard.

• Open an existing Spectra Library. Choose the command by opening the
corresponding LIB file via the Browser, or

• Create a new library via the File/New/Spectra Library command.

• Choose the Paste Spectra command to save the spectrum and the data in
the library.

Chromatograms
In the method PPA, the chromatogram of any wavelength can be extracted
from an opened 3D-field.

• Choose Extract: Chromatogram to file from the View or context menu to
save the current chromatogram as a separate channel.

• Choose the wavelength and the bandwidth at which to extract the
chromatogram.

The Dionex Chromatography Management System will suggest a name for the
extracted chromatogram, considering the wavelength. Of course, any other
name can also be used. The chromatogram is saved in addition to the raw data
of the existing 3D-field. Simultaneously, the extracted chromatogram is opened
via the method Integration to give the user an overview of the saved data.
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In addition, the Extract: Chromatogram to file command offers a special
option. Instead of saving one single chromatogram, another chromatogram of
the same wavelength can be extracted and saved from all samples of the
underlying sequence or query. Activate Extract from all samples of current
sequence or query. Especially in this case, automatically naming the
extracted chromatogram (see above) is very useful.

3D-Field Data
The Export 3DFIELD command enables including and displaying the current
3D-field raw data in other applications, e.g. Microsoft Excel. Data is converted
into a general ASCII format.

• After executing the Export 3DFIELD command, change to the other
application and insert the data via the Paste command. Apart from the pure
raw data, additional sample and sequence information is transferred to the
application.

 Tip: In the GynkoSoft chromatography data system, the
GSRAWASC.EXE user program enabled this option.
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Actions Related to the aQa-MS
The Dionex Chromatography Management System allows acquiring MS data
via the Finnigan aQa Mass Spectrometer. However, before mass spectra
acquisition and processing, several conditions must be fulfilled. For a detailed
description on these conditions and possible actions with these data, see:

 Installing MS Components
 Defining the Number of MS Channels
 Number of Required MS Channels - Examples
 Creating an MS Program and Sequence
 Creating a Method for the aQa-MS
 Acquiring MS Data in MCA Mode
 Extracting Mass Traces Online
 Extracting Mass Traces Afterwards
 Showing Mass Spectra
 Reprocessing Mass Spectra
 Defining Further QNT Settings for MS

 Installing MS Components

Conditions
The complete Xcalibur (= XC) system (REV 1.2) must be installed on every
computer (also pure Remote Clients of the Dionex Chromatography
Management System) that must be able to access MS data. Thus, the
minimum system requirements for an LC/MS system are as follows:
• 400 MHz PII CPU
• 128 MB RAM
• 10 GB hard disc
• 1024 x 768 x 16 screen resolution



466 Actions Related to the aQa-MS

Individual Steps
Installing the software requires the following steps:
• Run SETUP.EXE of the XC core system and install it to the local hard disk.

Install the default components:

You are then prompted to restart your PC. However, installing Xcalibur
under the Dionex Chromatography Management System does not require
rebooting your PC now.

Execute SETUP.EXE of the XC aQa VI driver. This is also required for pure
clients of the Dionex Chromatography Management System that should be
able to access the XC / aQa method files (METH files).
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Upon being prompted by the system, reboot your PC.
• You can now start the CM setup. During the installation process the CM

setup will ask you:

• Answer this question with Yes if you want to control an aQa with this server
installation. Answer with No for every other installation type (Remote
Client, LC/IC Servers without an aQa).

If your answer is Yes, the Dionex Chromatography Management System
setup checks whether an XC installation exists. If a complete XC
installation is not found (XC core + XC aQa), the setup will abort.

• To be able to control an aQa Mass Spectrometer, ensure that the aQa
driver of the Dionex Chromatography Management System is installed in
the  Server Configuration.
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You do not need to change any of the default settings except if you want to
operate the instrument in Demo Mode.

 Tip: For installation details, see Controlling and Installing Third-
Party Instruments  FINNIGAN aQa-Mass Spectrometer.
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 Defining the Number of MS Channels

The Installed Channels tab in the  Server Configuration allows limiting the
number of channels. A maximum of 69 channels (default setting) can be
defined and displayed during data acquisition in the Control Panel.

Limiting the number of channels is possible as well.

 Tip: Bear in mind that data will be lost if more channels are defined in
the program than can be recorded according to the Server
Configuration settings.

A distinction is made between channels for individual ions (= SIM channels),
channels for the total ions (= TIC channels), and TICF channels (= Total Ion
Chromatogram Full scan). SIM channels are recorded in Selected ion
monitoring (= SIM) mode, while Full-Scan mode is required for TICF
channels. In full-scan mode, you can extract Mass Traces online during data
acquisition (see  Extracting Mass Traces Online). These Online Mass
Extract Channels (OMECs) are designated MS_01 to MS_32.

Each mass that is recorded in the aQa method in Selected ion monitoring
(= SIM) mode requires its own channel. See  Number of Required MS
Channels - Examples for three illustrating examples.

If you notice after data acquisition that a channel is missing, you can extract
separate Mass Traces (this may be mass ranges as well) from the Mass
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Spectrum and save them as new channels (see How to ...: Actions Related
to the aQa-MS  Extracting Mass Traces Afterwards).

 Number of Required MS Channels - Examples
The examples below illustrate the number of channels that are required for the
different types of acquisition.

The first example requires two SIM channels plus the TIC channel:

The SIM1 channel records the chromatogram at a mass of 100, the SIM2
channel records the same chromatogram at a mass of 200.

The second example requires six SIM channels and the TIC channel:
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The channel assignment is as follows:

SIM_01: Mass 100, positive voltage, 100V,

SIM_02: Mass 100, negative voltage, -80V,

SIM_03: Mass 200, positive voltage, 100V,

SIM_04: Mass 200, negative voltage, -100V,

SIM_05: Mass 300, positive voltage, 100V,

SIM_06: Mass 300, positive voltage, 80V.
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The third example requires three TICF channels and the TIC channel:

The channel assignment is as follows:

TICF1: positive voltage, 100V

TICF2: positive voltage, 200V

TICF3: negative voltage, -100V.

If you notice after data acquisition that a channel is missing, you can extract
separate Mass Traces (this may be mass ranges as well) from the Mass
Spectrum and save them as new channels (see How to ...: Actions Related
to the aQa-MS  Extracting Mass Traces Afterwards).
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 Creating an MS Program and Sequence
As manual data acquisition is not available for the aQa Mass Spectrometer,
you need to prepare a sequence before data acquisition can be started. Thus,
a control file ( PGM File) is required.

Program Wizard (PGM Editor: Commands)

Create a new PGM file using the  Program Wizard (see Control
(Programmed) section). If you have an aQa mass spectrometer installed on
the current timebase, you can specify the data acquisition using the MS
channel on the Acquisition Options page. This opens the page for MS
specific parameters.

This page allows setting the parameters that are required for Mass Trace
processing (= MS chromatogram). The Range parameter is the scaling factor
for the online display of mass traces in the respective panel (e.g., Range = 5
allows a maximum value of 100.000 = (1 E+5) counts in the online display).
However, the stored data are not affected. The Smoothing parameter allows
selecting the smoothing filter for smoothing MS chromatograms.

Under Points, define the number of data points to be used for smoothing.
Select the number of datapoints such that the width of the smoothing filter
approximately equals the peak's half width. For example, the following program
will be created:
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The Wizard-generated PGM file provides no ⇒AcqOn/Off (Data Acquisition
On/Off) commands for the aQa channels. The channels that are needed for
mass trace acquisition depend on the contents of the MS method.

The Program Wizard automatically generates the wait MS.ready command
before the inject command. This is synchronization is required between the
aQa mass spectrometer and the Dionex Chromatography Management
System. If you want to create your own PGM files manually, always add the
wait MS.ready command before the inject command.

If you want to use Blank Run Samples, ensure that the inject mode is set to
Inject. Otherwise, the aQa mass spectrometer will not start data acquisition as
no injection signal is received.
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Example:
Wait MS.Ready
Inject Blank=Inject

On the last page of the Program Wizard, select the Review the program in a
new window option. This selection automatically opens the PGM editor as
soon as the new PGM file is saved. The PGM editor allows defining the aQa
mass spectrometer settings for the PGM file. Select the Finnigan AQA view
via the respective icon in the left editor section. For information on how to
create a method for the aQa mass spectrometer, see  Creating a Method
for the aQa-MS.

Sequence
Then, create a sequence for your HPLC- or IC system

a) Using the Sequence Wizard:

Enter the created PGM file under step 4.

b) From a previous sequence:

Copy the PGM file to a new sequence and enter the PGM file into the
sample list.

 Tip: Ensure that the Operation property of the aQa mass
spectrometer is in On state. Otherwise, the gas flow and the
probe heating are switched off and data acquisition cannot be
started.

Then start data acquisition as usual (see How to ...: Device Control
 Starting Data Acquisition). The current mass spectrum can be displayed

in the Control Panel.

 Creating a Method for the aQa-MS
The Finnigan AQA view of the PGM editor allows creating a new method for
the aQa Mass Spectrometer. Open this view via the respective icon in the left
PGM editor section. The view is part of Xcalibur and serves to specify the
method used by the aQa mass spectrometer.

As ionization mode, select Electrospray or APCI (chemical ionization at
ambient pressure) on the Ionization Mode tab.
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On the Analysis tab, set the sensitivity of the mass spectrometer via the
detector voltage. Via Advanced (from tune file), load a previously specified
tune file or directly perform fine-tuning of the mass spectrometer via the
Tune… button.

 Caution: When using the Xcalibur method editor in the Dionex
Chromatography Management System, the Other detectors
section is irrelevant. Do not use this section for data acquisition
with other detectors (e.g. UV detectors)! In this case, perform
data acquisition as usual.

On the Acquisition tab, enter the aQa-specific signal parameters for Mass
Spectra acquisition:
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Select the data acquisition mode first: Full-Scan to acquire the entire mass
spectrum for each analyte or SIM to obtain MS chromatogram at a defined
mass.

In Full-Scan mode, the Simultaneous acquisitions tab allows setting the
polarity and maximum voltage at the aQa-MS for four single channels ( TICF
channels). Under Acquisition rate, specify the rate for data acquisition; under
Mass spectrum, specify the mass range for which to perform data acquisition.

 Tip: This view of the PGM editor is part of Xcalibur. Thus, you can
open the Xcalibur help via either the Help menu or the Help
button. The Xcalibur help provides detailed information on mass
spectra acquisition.

 Acquiring MS Data in MCA Mode
The MCA (= Multi-Channel Analysis) mode allows calibrating the aQa Mass
Spectrometer and analyzing pure, low-concentration solutions of substances.
Usually, the solution in question is provided to the mass spectrometer via
infusion.

The MCA mode summarizes all Mass Spectra of the single scans. Only the
resulting mass spectra (up to four) are saved when the analysis is finished.

 Caution: The MCA mode does not allow recording and showing mass
spectra at a defined time of the chromatogram. Therefore, the
MCA mode is not suitable for chromatographic analyses!

Data acquisition in MCA mode is as follows:
• Create a PGM file using the  Program Wizard (see Control

(Programmed) section).
• Ensure that the PGM file includes an Inject command even if you do not

use an autosampler. Otherwise, the data acquisition cannot be started.
• In the QNT editor, open the Acquisition tab of the Finnigan aQa window.

Under Mass spectrum, select MCA as Peak format.
• Save the PGM file and close the PGM editor.
• Enter the PGM file in your sequence and start the sequence in a batch.

The Xcalibur window below opens automatically when data acquisition is
started:
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The status bar indicates the time that passed since the data acquisition was
started. At the top left and right, the results of the last two scans are given.

As soon as the data acquisition is finished, you can view the results in the
report of the Dionex Chromatography Management System. To view the results
click the line at the highest retention time in the Chromatogram Plot using the
Spectra Tool. This action opens the following view:
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The "chromatogram" in the left pane contains one datapoint only that is at the
highest retention time. To illustrate the summing up of the entire acquisition
period, it shows one line in the height of the entire counts of all summed up
mass spectra. In addition, only one single (entire) mass spectrum is displayed
in the right window section.

 Tip: As MCA mass spectra are formally retention time spectra, they
cannot be inserted in the Printer Layout. Therefore, for printing
mass spectra the Print command of the File menu is available.
In the opening dialog box, select the desired Printer Layout page
that contains the mass spectrum.

 Extracting Mass Traces Online
It is possible to extract Mass Traces (MS chromatograms) and save them as
additional channels. This is possible online during data acquisition but can be
done later as well (see  Extracting Mass Traces Afterwards).

In the  Server Configuration, define the required number of Online Mass
Extract Channels on the Installed Channels tab. (Up to 32 channels can be
defined.) These channel are automatically named MS_01 to MS_32.

Create a PGM File for data acquisition in Full Scan mode using the
 Program Wizard (Control (Programmed) section). Afterwards define the

following parameters for the each single MS channel:
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Parameter Min. Max. Default Usage
FilterIndex 0: NoFilter n: TICF_n

(n = number of the
TICF channel
configured in the Server
Configuration)

0 Selects the filter for extraction.
The filter indexes correspond to
the four filters that can be
defined in the aQa method.
0 = NoFilter means that the

TIC channel is used.
MinMass 2.0 amu 1636.0 amu Minimum mass of interval that

will be extracted.
MaxMass 2.0 amu 1636.0 amu Maximum mass of interval that

will be extracted.

As these parameters cannot be set using the Program Wizard, proceed as
follows:
• Open the PGM File.
• Open the Commands dialog box via Command in the Control menu.
• Select your Mass Spectrometer (listed by the name defined in the Server

Configuration).
• Open the mass channel to be extracted (e.g. MS_01).
• Specify the individual parameters:



Actions Related to the aQa-MS 481

Use the Upper/Lower Limit parameters to specify the signal limits.

The corresponding section in the Program could look as follows:
MS_01.MinMass = 149.5

MS_01.MaxMass = 150.5

MS_01.FilterIndex = 1

You can view these channels in the Control Panel online during data
acquisition.

 Extracting Mass Traces Afterwards
If you did not extract a Mass Trace online during data acquisition, you can do
this afterwards as well (see  Extracting Mass Traces Online). Place the
mouse cursor in the respective Mass Spectrum either of the Integration
window or in the ⇒QNT Editor. Select Extract Mass Trace/Range from the
context menu to open the following dialog box:

First, enter the name for the new channel. Then, select the desired filter and
mass range as well as the Smoothing type for the MS chromatograms and
the number of data points to be used. Pressing Extract makes the new
channel available for chromatogram representation.

If you know already before the data acquisition which channels you will need,
you can omit this step and record the required channels right from the
beginning (see: How to ...: Actions Related to the aQa-MS  Defining the
Number of MS Channels) or extract them as described above.
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 Showing Mass Spectra
The Mass Spectra view can be added to almost all windows of the Dionex
Chromatography Management System (Integration, ⇒QNT Editor, Printer
Layout) provided Xcalibur is installed. Enable the mass spectra view via the

button or the Show Mass Spectra command of the View menu. A mass
spectrum can be added to the Printer Layout via the Mass Spectra Plot
option of the Insert command in the View or context menus.

The appearance of the shown mass spectra may be quite different. It depends
on the MS instrument method that was used. For details, see How to …:
Actions Related to the aQa-MS  Creating a Method for the aQa-MS. For
information on the parameters that should be used in this method to receive a
certain mass spectrum, see the Xcalibur help.

In the captions of the single mass spectra plots, the peak name (if the mass
spectrum of a peak is given) plus the retention time of the mass spectrum is
given on the left. On the right, the acquisition mode is given: Full ms indicates

Full-Scan mode; SIM ms indicates SIM mode.

In the caption of full-scan mass spectra, the entire mass range is given in
parenthesis on the right. The fragmentation voltage that is given in front of the
mode is important as well.
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With mass spectra that were acquired in SIM mode, no entire mass spectra are
available. These SIM mass spectra are extracted from single mass traces so
that the resulting SIM mass spectrum usually shows gaps between the single
traces. In the caption, the single mass ranges are given together with the
corresponding fragmentation voltage behind the respective mass range
(following a @ sign) on the right.

To set the MS specific parameters of the view proceed as follows: Place the
cursor on the mass spectrum and right click to open the context menu. Select
the Decoration option and make the desired settings on the MS Filter tab:

 Reprocessing Mass Spectra
Mass Spectra usually include more details than UV spectra. Normally,

however, they suffer from heavier noise. Especially with low signal intensity,
they are considerably affected by the background spectrum. In order to use the
information of mass spectra in the best possible way, reprocessing should be
performed.
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The Dionex Chromatography Management System offers two alternatives:

Spectra Bunching
To reduce mass spectra noise, you can bunch several single mass spectra to
one entire mass spectrum. Spectra bunching can be performed both, for peak
spectra and retention time spectra.

The MS tab of the ⇒QNT Editor allows bunching several single spectra to the
left and the right of the chromatogram peak together with the peak maximum
spectrum to one entire peak spectrum.

In the chromatogram, define the range for which to display the entire retention
time spectrum. Use the Spectra Tool to select the desired range while
pressing the left mouse button. You can perform this in a UV channel as well.

Subtracting Background Mass Spectra
Subtracting the background of mass spectra allows eliminating the influence of
the background on the mass spectra. The background mass spectrum to be
subtracted can be defined either for the entire chromatogram or automatically
by the Dionex Chromatography Management System for each single peak.

The corresponding setting is made on the MS tab of the ⇒QNT Editor or in the
chromatogram. The settings made in the chromatogram are saved to the QNT
file of the current sample as well. Thus, your input affects all samples that are
evaluated using this QNT file.

For details, see How to…:

Actions in the QNT Editor  Processing Mass Spectra

Actions in the Chromatogram  Subtracting MS Background Spectra
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Tracking the Effects of Background Subtraction
You can track the effects of spectra subtraction directly in the mass spectra
plot:
• Open the mass spectrum Decoration via the context menu and select

Peak Spectra tab.

• Under Background Subtraction Overlay, select Background Spectrum
to view the subtracted background mass spectrum in addition to the peak
and retention time spectra.

• In addition, use Original Spectra to view the respective mass spectrum
without subtraction.

 Defining Further QNT Settings for MS

Handling the Retention Time Delay as against a second detector
Use the Delay Time option on the General tab to take the retention time
difference into account that is due to the time needed by the substances to
travel from the first detector to the aQa Mass Spectrometer.

For details, see How to ...: Actions in the QNT Editor   Defining the QNT
Method for Several Detectors in the Creating a Peak Table section.

Defining Peaks via Mass Spectra
For peak identification via mass spectra, use the six MS columns:
• Mass Peak 1 (as well as Mass Peak 2 and Mass Peak 3)

• MS threshold

• MS filter conditions

• Check MS retention times

For details, see How to ...: Actions in the QNT Editor  Identifying Peaks
via Their Mass Spectra (MS Tracking) Detectors in the Creating a Peak
Table section.
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Actions in the Server Configuration
Dionex Service connects, installs, and configures chromatography
components, as well as installs the software of the Dionex Chromatography
Management System.

If you need to modify the current installation, you will find useful information in
the topics below:

 Changing the Server Configuration
 Selecting the Copy Protection Location and Entering the Key Code
 Updating Moduleware

Before you connect new chromatography components to the data system or
install additional PC plug-in boards and Sharable Devices, see the
information in the topics below:

 Adding Timebases / Instruments
 Installing a Sharable Device

If devices are connected to the Dionex Chromatography Management System
via the DX-LAN, certain built-in diagnostic and calibration ("System
Wellness") functions are provided. These functions are enabled and disabled
from the Server Configuration. See the following topic for details:

 Enabling/Disabling System Wellness Functions

 Changing the Server Configuration

Starting the "Server Configuration" Program
To start the Server Configuration, select Server Configuration from the
Start/Programs menu on the task bar. For example, for CHROMELEON,
choose Start/ Programs/ Chromeleon/ Server Configuration.

 Caution: Modifications to the server configuration are only possible if the
corresponding Server was started before! Normally, this is
done automatically when starting the computer on which the
server is installed.
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Configuring the Server
Double-click the name of the server whose configuration you want to extend or
change. Then enter the Key Code and the type of  Software Protection.

Adding Components
Select the name of the server of which you want to extend the configuration.
Click the + character in front of the server name to view its current
configuration.

Select via the Edit menu or in the context menu:

• Add Timebase to install a Timebase on the server. Enter the name of
the timebase in the Edit box.

• Add Sharable Device to install components that can be assigned to
several timebases. This includes e.g. PC plug-in boards as the A/D
Converter or the Pump Control Board.

• Add Device to add further chromatography instruments to a timebase.
Select the instrument from the list. Only one instrument can be added at a
time.

 Note: When the timebase is created, a corresponding folder is also
created in the Browser. This folder has the same name as the
timebase and contains a default Sequence table and a folder for

 Protocol Data files for the timebase.

Configuring Components
Click the component to configure and select the item Properties from the
context menu. Each configurable component has one or several tab dialog
boxes for alternative settings.

Refer to context-sensitive online help for information on possible settings.
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Deleting Components
Click the component to delete and select the item Delete from the context
menu.

 Note: When deleting a timebase, all instruments installed below this
timebase are also deleted. The same applies to deleting single
hardware components or the complete hardware. If you select a
server and choose Delete, the components and the installation
file CMSERVER.CFG are deleted.

Copying or Moving Components
Each selected component can be copied to the clipboard via the Copy
command and can be inserted in a different place via Paste. It is also possible
to Cut single components. Alternatively, both actions can be performed via
Drag & Drop.

Access Control for Servers and Timebases
The Dionex Chromatography Management System not only allows restricting
the  Access Control for Datasources, directories, and sequences (see
How to ...: Actions in the Browser  Locking Datasources, Directories,
and Sequences), but also for servers and timebases.
• Select a server and choose the Properties command (or double-click) to

change the server settings.
• Select a timebase and choose the Properties command (or double-click)

to change the timebase settings.

 Note: Server and timebase can be accessed independently of each
other. However, a timebase can only receive the rights of the
corresponding server, i.e. operations prohibited on the server
(e.g. Monitoring) are automatically prohibited on the underlying
timebase.

• From the right list box (List of All Groups) on the Access Control tab,
choose the Access Groups that should receive access to the server or
the timebase. Then, move the selected A-groups to the left list box via Add
(Access Groups). Each user who is a member of one of the selected A-
groups, can now access the server or the timebase (provided the user has
the control privilege).
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When you press the Remove button, the members of the corresponding A-
group will no longer be able to access to the server or the timebase.

Under Allow Remote you will find options for controlling the remote operation,
i.e. network access to a server or a timebase from a different PC. These
options apply exclusively to the access via a network connection!

• Select Monitoring to enable other users to monitor the server or timebase.

• Select Control to enable other users to perform control access to the entire
server or a specific timebase.

• Select Data Acquisition to enable other users to start the Data
Acquisition on a specific timebase.

• Select Batch Control to enable other users to start Batch Processing on
a specific timebase.

 Note: Activating an option is possible only on a timebase if the
corresponding operation is also permitted on the corresponding
server!

Saving the "Server Configuration"

Each modification to the Server Configuration, e.g. adding, moving, deleting,
or configuring single components, can be saved. There are two possibilities:

• Save Installation (Name) saves the current server configuration as a new
configuration directly on the server.

• Save as saves the current server configuration with a freely selectable
name (extension CFG) in any directory. The file CMSERVER.CFG is not
overwritten and is still valid! Configuration files saved with this method are
"personal" server configuration files. These enable the user to quickly
change from one installation environment to another by simply loading the
file.
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Loading the Personal Server Configuration to a Server ("Import")
To use a personal server configuration as the valid server configuration
CMSERVER.CFG, perform the following steps:

• Start the Server Configuration.

• Activate the server, for which the personal server configuration is to be
valid.

• Select the Import... function from the File menu and specify the name and
the directory of the personal server configuration. The configuration is
loaded to the server.

• Select Save to save the personal server configuration under the name
CSERVER.CFG. The previous file with this name is overwritten with the
contents of the personal configuration. All changes are indicated in the file
tree of the Server Configuration or when opening the corresponding tab
dialog boxes.

Check Configuration
After installing and configuring new components, the current server
configuration should be checked.

Choose the Check Configuration command from the Server menu to start the
check.

The Dionex Chromatography Management System shows the result in a
separate dialog box. If no errors or conflicts occur, the current server
configuration can be saved.

If the system issues one or several warnings, it is up to the user whether to
change the current configuration or not.

If the system issues an error message, the cause must be found and remedied.
Only then can optimum operation be ensured.

Installation Configuration Report
The configuration report contains information on the server itself (e.g. name,
key code, copy protection, access groups) as well as the connected timebases
(name, access groups). In addition, the report lists the settings of the
instruments assigned to an instrument.
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Thus, it is possible to see whether and if so, which channels of a detector are
used and the corresponding settings (Offset, Factor, ..), the Sharable
Devices the configuration contains, etc.

• Choose the Create Report command from the Server menu to generate a
report.

• Press the Save button to store the report in the CMINST.LOG file. The old
file is then renamed to CMINST.OLD. Caution: The report is always saved
to the BIN directory of the server!

• Press the Print button to copy the report to the Notepad text editor and to
print it from there. After creating the report, it is also contained in the
Windows clipboard and can be inserted in other applications.

The report is also available via the Windows clipboard.

 Selecting the Copy Protection Location and Entering the
    Key Code
Depending on whether you want to enter the software protection location and
the Key Code for a server PC or for a client PC, perform the following steps:
• In the case of the client PC, select Preferences in the File menu of the

Dionex Chromatography Management System client. The License tab of
the Preferences dialog box allows you to select the copy protection
location and to enter the key code as described below.

• In the case of a server PC, open the Server Configuration by clicking
Server Configuration. Double-click the appropriate server name to access
the General tab. The options described below are only possible if the
corresponding Chromatography Server was previously started!
Generally, this is performed automatically when starting the computer on
which the server was installed. If this is not the case, start the Dionex
Chromatography Management System via the Monitor Program.

Selecting the Software Protection Location
Specify whether your system is protected via PAL, Dongle, or License
Server. If applicable, proceed as follows to enter the location of the PAL plug-in
board:
• Click the Hardprotect option if a separate PAL plug-in board protects your

system.
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• Click one of the options Dionex A/D Converter, UVD340S/170S Interface,
or Pump Control Board; if the PAL is located on the corresponding
Dionex A/D board, the UVD340S/170S interface board or the pump control
board.

• Click the Dongle option, if your system is protected by a dongle on the
parallel PC interface.

• Select License Server if your license was generated by a license server.
The edit field for the key code will be disabled. Clicking the Browse button
"..." on the right of the License Server opens another dialog for selecting
the computer on which the license server of your Dionex Chromatography
Management System is running.

Entering the Key Code
The key code is also entered via the Properties or License dialog box. Enter
the 12-digit key code in the corresponding field.

 Updating Moduleware
To install new versions of Moduleware on modules connected to the DX-
LAN:

1 Insert the CD containing the new Moduleware version into the CD drive.

2 Start the Server Configuration program by selecting Server
Configuration from the Start/Programs menu on the task bar. For
example, for PeakNet, choose Start/ Programs/ PeakNet/ Server
Configuration.

3 Select Dionex DX-LAN Card under Sharable Devices and select
Properties from the Edit or context menu.

4 Select the Update Moduleware tab. The names of the currently connected
modules, their DX-LAN ID numbers, and current Moduleware versions are
displayed.

5 Click the Select button.
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6 Select the file containing the new Moduleware version and click OK. The
selected file appears in the Moduleware File box.

7 Select the name of the module to be updated from the list of modules; click
the Update button. Repeat this step to update additional modules of the
same type.

 Tip: Make certain the Moduleware matches the module type before
updating. Downloading the wrong type of Moduleware can
corrupt the module's memory.

The new Moduleware version is downloaded to the selected
module. The new version number will appear in the list. For some
modules, for example, the AD25 detector, the module’s BIOS is
also included in the Moduleware file and is updated at the same
time as the Moduleware.

 Adding Timebases / Instruments

Connection via Serial Interface
The Dionex Chromatography Management System is capable of integrating a
large number of different chromatography instruments into the existing
chromatography system. The prerequisite for this is that the instrument and the
data system must be connected via an RS232 interface and that the
appropriate device Driver must be available for the instrument. If this is the
case, the new instrument is configured via the Server Configuration of the
Dionex Chromatography Management System (see How to ...:Actions in the
Server Configuration  Changing the Server Configuration).

Connection via the A/D Converter
Instruments delivering analog Signals are connected to the A/D Converter
via an A/D converter cable. If, for example, you want to record a signal via
channel 1, you connect the positive pole (+) of the instrument with the wire
"high" of channel 1. Accordingly, connect the negative pole (-) with "low" and
the A/D converter ground wire (GND) with the instrument ground.

The connector bar (DIN 41612) of the A/D Converter (3 rows - a/b/c - each for
32 input pins) allows connecting a maximum of four A/D converter cables.
Between the connectors, one row of pins is left free.
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Via each cable (A/B/C/D), four analog signals (1/2/3/4) and two times two
digital signals (5/6/7/8) can be recorded. Two Remote Inputs Dig.Inp1/2 use
one ground connection (gnd).

Now, start the Server Configuration to install/configure the Sharable Device
Dionex AD Converter. The channels of the A/D converter are then available
for installing instruments with analog signal output.

Connection via a DX-LAN Card
The Dionex Chromatography Management System can control multiple
chromatography instruments via a DX-LAN. Each instrument and the PC on
which the Dionex Chromatography Management System is installed must be
equipped with a DX-LAN interface card, connected with DX-LAN cables, and
have the appropriate device driver installed. (For details, see  Installing the
DX-LAN-Card.)

After the DX-LAN is connected, start the Server Configuration and add the
DX-LAN card to the server configuration as a Sharable Device (For details,
see  Adding the DX LAN Card to the Server Configuration.) Then, add
the DX-LAN devices to one or more timebases.



496 Actions in the Server Configuration

Connection via the Dionex UCI-100 Universal Chromatography Interface
To control chromatography instruments via the Dionex Chromatography
Management System, a  Dionex Universal Chromatography Interface
(UCI-100) can be installed between the Dionex Chromatography Management
System and the respective instrument to be controlled. Data transmission is via
the USB interface. An Ethernet interface will also be available in future. In
addition, the appropriate drivers must be installed and the UCI-100 Universal
Interface included in the Server Configuration as a Sharable Device.

For installation information, see  Installing the Dionex Universal
Chromatography Interface (UCI-100).

 Installing a Sharable Device
For PC plug-in boards, switch off the PC, open the cover, and select an
appropriate slot. Configure the PC board, as described in the operating
instructions and insert it in the PC.

Start the Server Configuration, select the required sharable device, and
initialize it, as described in the user manual. For detailed installation notes, see
the following topics:

 Installing the A/D Converter
 Installing the 12-Bit-DAC-Board
 Installing the 16-Bit-DAC-Board
 Installing the Pump Control Board
 Installing the Dionex 16-fold Relay Board
 Installing the Serial Interface Board
 Installing the Dionex DX-LAN Card

 Tip: Ensure that the space between the  A/D Converter and the
PC boards is sufficient, as PC boards radiate strong
electromagnetic fields due to high-frequency digital currents.

For detailed information on the UCI-100 Universal Chromatography Interface,
see  Installing Dionex Universal Chromatography Interface (UCI-100).
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 Enabling and Disabling System Wellness Functions
When a System Wellness supported device is added to a timebase in the
Server Configuration, two additional tab pages, Calibration and Diagnostics,
are included in the Properties dialog box for the device. These tab pages let
you enable or disable individual calibration and/or diagnostic functions. By
default, all calibration and diagnostic functions are enabled.

 Tip: For a list of System Wellness supported devices, see
 System Wellness Overview.

Follow the steps below to disable calibration and/or diagnostic functions for a
device or enable functions that are currently disabled.

1. Start the Server Configuration.

2. Under the Timebase, select the device for which you want to disable or
enable the calibration and/or diagnostic functions.

3. Select Properties from the Edit or context menu and select the Calibration
or Diagnostics tab.

4. Enable or disable individual calibration or diagnostics functions by clicking
the Activate box next to each function in the list. To enable or disable all
calibration or diagnostics functions, right-click and select the Activate All or
Deactivate All command from the context menu.
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Device Control

Extending a Program
In addition to the standard commands of the Program, which are easily
created with the  Program Wizard (see Control (Programmed) section),
the Dionex Chromatography Management System offers a number of
additional ⇒Control Commands. The functions and the syntax of these
commands are described in the respective control topics below.

 Control - Pumps
 Control - Autosamplers
 Control - Detectors
 Control - Fraction Collector
 Control - IC, GC, and Temperature
 Control - Special Commands, Relays, and Others

• Transfer the structure and syntax of the commands that you want to use to
your program file.

• Via Cut & Paste, each command can be inserted directly from Online Help
at the appropriate position in the standard program.

• Specify the time when to execute each command.

• Save the result of your input as a PGM file.
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Control - Pumps
The following commands are available for pump control.

For the "simple" commands, see  Pump Commands
For further details, see:

  Setting the Flow Rate

  Determining the Solvent Composition

  Determining a Gradient

 Determining Pressure and Pressure Limits

 Starting/Stopping the Pump Flow

 Holding the Pump Flow

In addition, see the following information on

 Recording the Pump Pressure

 Setting the Automatic Pre-Compression Control

 Viewing Leak Sensor and Workload Status.

 Pump Commands
A pump can be controlled as follows:

Hold / Continue Gradient

0.000 HoldMode = On / Off

Alternatively, the following short command is valid:

0.000 ⇒Hold or

0.000 ⇒Continue
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Stop Pump Flow/Gradient

0.000 StopMode = On  or

0.000 ⇒StopFlow

Determining ⇒⇒⇒⇒Pressure Limits

0.000 Pressure.LowerLimit = Value[bar]

0.000 Pressure.UpperLimit = Value[bar]

Generating a Flow or % Gradient
The flow or solvent value determined for the time t is continually adjusted to the
following flow or solvent command. If the two values coincide, the flow or
solvent value is kept at a specific level (see ramp profile 0 to 1), if they differ
from each other, the value is modified. The difference between the two time
values corresponds to the length of the ramp (see ramp profile 1 to 2min).

0.000

1.000

2.000

3.000

%B.Value

%B.Value

%B.Value

%B.Value

= 20

= 20

= 50

= 50

Ramp Profile

 Tip: Dionex GP40/GP50, IP20/IP25, IC20/IC25/IC25A, GS50, and
IS25 pumps do not deliver flow gradient ramps. Instead,
changing the flow rate between one time value and the next,
results in an immediate change in the flow rate (step change).

To determine a sharp increase, two different values must be defined at the
same time. The start and end values must be entered at the exact times (see
rectangle profile at the time t=1min).
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Rectangle Profile

By combining the just mentioned possibilities, any multi-step gradient profile
can be realized, e.g.:
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0.000
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Multi-Step Profile

Instead of the arbitrarily selected quantity %B used in these examples, any
other solvent (see ⇒%A, %B, %C, %D) or the flow rate can be changed.

Creating a Non-Linear Gradient Ramp (Dionex GP40/GP50/GS50 pumps
only)
A Curve command instructs the pump to apply the selected curve number
when adjusting the solvent composition between two retention times. In the
example below, the Curve = 8 command at 2 min creates a concave ramp
between 1 and 2 min.

Consecutive commands with identical solvent compositions generate an
isocratic segment, regardless of the curve number selected (see 0 to 1 min and
2 to 3 min below).
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1.000

2.000

3.000

%B.Value

%B.Value

%B.Value

Curve

%B.Value

= 20

= 20
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= 8
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Non-Linear Ramp Profile

t
20
50

%B

 Setting the Flow Rate

For non-controlled pumps, the ⇒Flow rate is set directly on the instrument
(also, see the Operating Instructions of the instrument).

For controlled pumps, the flow rate can be set via the corresponding controls
on the  Control Panel (slider, edit field, or button):

• To set a higher or lower flow rate, use the mouse to move the gauge slider
in the desired direction.

• Enter the desired flow rate value in the edit field via the keyboard. Confirm
your input by pressing Enter (Return).

• Click a button to execute the assigned function.
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• Alternatively, choose the Flow command from the Control menu.

Including the Flow command in the Program is also possible (see How to ...:
Actions in the PGM Editor  Creating a Program). Example:

0.000 Pump.Flow = Value[ml/min%] ;HPLC/IC pump

0.000 InjectorB.flow = Value[ml/min%] ;GC HP5890

Several Flow commands result in a Flow Gradient. For a description on how
to enter gradients, see How to ...: Device Control  Determining a
Gradient.

 Determining the Solvent Composition

Manually

For non-controlled pumps, solvent composition (see ⇒%A, %B, %C, %D) is
set directly on the instrument (also, see the Operating Instructions of the
instrument).

For controlled pumps, the data system features the appropriate controls
(sliders, edit fields, switches, etc.). Depending on the control panel layout, the
values for %B, %C, and %D can either be set via a slider or via an edit field.

• Use the mouse to move the slider of a gauge in the desired direction.

• Enter a value in an edit field via the keyboard, then press Enter (Return).

• Select the ⇒Flow command (from the Control menu) to determine a How
to ...: Device Control  Determining a Gradient.
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Programmed
By entering the commands

t=.... %B.Value = Value[%]

t=.... %C.Value = Value[%]

t=.... %D.Value = Value[%]

in the Program, the solvent composition can be changed via the program. If
the command is entered several times for at least one component, the result is
a % Gradient.

For details, see How to ...: Actions in the PGM Editor  Creating a
Program

 Determining a Gradient
You can determine the gradient in two ways, either manually from the panel or
via a program:

Manual Input
For each installed instrument for which a gradient is determined, the device-
specific settings can be changed in tab dialog boxes. Currently, ⇒Flow and

% gradients can be entered for HPLC and IC pumps; and temperature,
pressure, and flow gradients can be specified for gas chromatographs. The
different gradients can be run either as ramps (in IC, also, see Gradient
Curves) or as Step Gradients.

• Choose the Flow command from the Control menu or use the shortcut
Ctrl+F.

• On the Gradient tab (for HPLC/IC or GC and Column1/2 for gas
chromatographs), select the desired gradient.
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Programmed Input

The easiest way to create a new program is by using the  Program Wizard
(see Control (Programmed) section). Open the Wizard via New in the File
menu and select Program File.

HPLC/IC Selecting Multi-Step Gradient on the Pump Options tab opens the tab dialog
box Flow Gradient Options, which corresponds to the Gradient tab during
manual input.

GC On the GC Options tab (or the Front/Back Inlet Options tabs), select
Ramped Temperature to program a temperature gradient. In the same way,
flow and pressure gradients can be determined on the tabs Column1 and
Column2 via the options Ramped Flow and Ramped Pressure.

Entering "Basic points"

HPLC/IC
• In the Retention column, enter the time (relative to the injection time) of

the desired modification.
• In the Flow column, enter the new value for the flow rate.
• In the %B, %C, and/or %D columns, enter the new value for the delivered

solvent composition. %A is the difference between the total of the entered
values and 100%.

• For Dionex pumps GP40, GP50, and GS50 only: Enter a value in the
Curve column to determine whether the pump delivers a linear or Curved
Gradient. Curve 5 (the default) is linear; curves 1 - 4 are convex upward
and curves 6 - 9 are concave upward.

• Press the Insert Line button to append another line to the table. After
appending the first new line, further lines are appended automatically, as
necessary. The option can be switched on and off via the Autom. Append
New Lines command of the context menu.

• Press the Delete Line button to remove unnecessary lines from the table.
• Red coloring of the corresponding cell marks each wrong entry. Invalid

entries must be corrected immediately.
• Superfluous information can be deleted from a previously selected area by

pressing the Clean Up button.
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• Missing values between two or more time values can be calculated via the
Interpolate button. The values are automatically added to the table.

• Select the Fill Column command in the context menu to fill the cells in the
column with the currently selected value. Only the cells below the selected
value are filled.

In a graphical representation, each flow and solvent value of the value table is
represented as a point. By interpolation between the basic points of a column,
an area gradient profile is created. The solvent areas are represented in their
caption color; the flow rate is displayed as a narrow line.

Direct Input into a Program
Knowing the syntax of Programs, you can directly determine the gradient in
the program. By entering the ⇒%A, %B, %C, %D, ⇒Flow, and Temp.
commands in the program, solvent composition, flow rate, and temperature can
be modified at a precise time. The gradient profile results from the change in
value of a certain quantity at the time t.

 Tip: The Dionex GP40/GP50, IP20/IP25, IC20/IC25/IC25A, GS50,
and IS25 pumps do not deliver flow gradient ramps. Instead,
changing the flow rate between one time value and the next,
results in an immediate change in the flow rate (step change).

Example: The three different profiles are realized via the respective
commands listed below the profiles.

Rectangle Profile Ramp Profile Multi-Step Profile

0.000 %B.Value = 20 0.000 %B.Value = 20 0.000 %B.Value = 20

1.000 %B.Value = 20 1.000 %B.Value = 20 0.500 %B.Value = 20

1.000 %B.Value = 40 2.000 %B.Value = 50 1.500 %B.Value = 40

2.000 %B.Value = 40 2.000 %B.Value = 40

2.000 %B.Value = 20 2.000 %B.Value = 30

2.500 %B.Value = 30

2.500 %B.Value = 20

For a rectangle profile, indicate exactly how long the specific solvent
composition is valid. If the composition is changed at the same time as another
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percent command is defined, the change in solvent composition is executed
immediately. The solvent percentage achieved is then maintained until
replaced by another command.

To realize an increase over a longer period, the start value and end value must
be specified with the precise time. The difference between the two time values
corresponds to the duration of the increase (see ramp profile).

By combining the above-mentioned possibilities, any multi-step gradient profile
can be realized.

For details on entering basic points in GC, see  Determining a Gradient
(GC).

 Determining Pressure and Pressure Limits
Pressure
Determining the operating pressure is only possible for gas chromatographs.
The control realizing the setting depends on the layout of the currently used
control panel.

• Determine the pressure via the corresponding slider or enter the value in
the edit field via the keyboard.

Pressure Limits
Some device drivers offer the possibility to determine the upper and lower
pressure limits.

• Enter the corresponding value in the edit field using the keyboard, or

• Position the slider for the upper and lower pressure limits with the mouse
cursor. Assign different colors to the controlling sliders (see How
to ...: Actions in the Control Panel  Modifying a Control) so that they
indicate whether a pressure limit is exceeded or whether it is within the
selected limits.
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When defined ⇒Pressure Limits (e.g. of an HPLC pump) are exceeded, the
Dionex Chromatography Management System automatically switches off the
flow, issues an error message and stops the sample batch, as necessary. In
addition, all operations are logged in the Audit Trail.

Pressure limits can be determined by entering the following commands in the
Program:

0.000 X.Pressure.LowerLimit =Value[bar]

0.000 X.Pressure.UpperLimit =Value[bar]

where X refers to the name of the instrument defined in the Server
Configuration.

 Starting/Stopping the Pump Flow
• Execute the ⇒StopFlow command to stop the pump flow and the

Gradient formation. During a running batch, Batch Processing is
stopped.

• Perform the ⇒Continue command to continue the pump flow, a running
gradient program, or batch processing.

 Tip: The ⇒Hold command only interrupts gradient formation and
automatic batch processing, but not the pump flow.

 Holding the Pump Flow
• Use the ⇒Hold command to interrupt the Gradient formation or a running

batch. During a running batch, Batch Processing is stopped.

In the Hold mode, the pump delivers with constant flow rate and solvent
composition, until a stop or a ⇒Continue command is entered.
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 Recording the Pump Pressure
To check whether signal variations are related to pressure variations, i.e.,
whether the pump causes those variations, we recommend recording the pump
pressure as an additional signal.

Hardware Configuration
To be able to display the pump pressure an analog pressure output must be
available on your pump. In addition, an A/D Converter or an UCI-100
Universal Chromatography Interface is required. Connect the pressure output
of your pump to one of the free A/D board channels.

Server Configuration
Add an Integrator Driver to the devices of the corresponding timebase. Name
the unassigned signal e.g. Pump_Pressure and press Change.
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Select the channel to which the pressure output of your pump is connected as
AD Port. Enter under Factor how many bar correspond to an output voltage of
1 mV. For example, enter 0.5 bar/mV for the Dionex P580 pump or 5 bar/mV
for the Dionex M480 pump.

Now, data can be recorded for the Pump_Pressure channel. Data acquisition
can be defined as well in the PGM File or by means of the ⇒AcqOn Control
command in the Control Panel.

Panel
• Being in the signal plot of your panel select the Signals command in the

context menu.

• Select the desired signal under Available Signals (i.e., for the above
example select Pressure).

• When starting the data acquisition, select the channel Pump_Pressure
and define the ⇒Step (see How to ...: Device Control  Starting Data
Acquisition).

 Setting the Automatic Pre-Compression Control
With the automatic pre-compression control offered by the Dionex pump P 580,
it is possible to consider the varying compressibility of different solvents.
Automatic pre-compression control can also be used for unknown solvents.

With low-pressure gradients and isocratic pumps, pre-compression control is
fully automatic. Choose the Commands option from the Control menu. Select
the solvent and assign the solvent type Automatic.

The high-pressure gradient pumps must "learn" the automatic pre-compression
control. Choose the Commands option from the Control menu. Then select
the solvent. Assign the solvent type Custom. Set the flow to 100% of this
solvent. Choose the pump Learn command. Wait at least 10 minutes (flow
1ml/min). Choose the corresponding pump Freeze command to save the
optimum pre-compression setting. For detailed description, see the P580
Operating Instructions.

Change the flow to 100% of the next solvent. To set the pre-compression
control, proceed as described above.
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 Viewing Leak Sensor and Workload Status
The Dionex pump P 580 allows display of the status of the leak sensor. In
addition, you can view the Cumulated Workload.

To create the corresponding controls, proceed as described in the following
sections under How to ...: Actions in the Control Panel:

 Modifying a Control Panel
 Modifying a Control
 Linking a Control to a Device

Choose Commands... from the Control menu. Under Pump, select Leak to
view the status of the leak sensor. Click Cumulated WorkLoad to display the
total workload [in mega joule, MJ] of the pump.

Control - Autosamplers
Depending on the Autosampler type different commands are available. For
an overview on the individual commands that are available for the different
Dionex autosamplers, see:

 Autosampler Commands (GINA 50)

 Autosampler Commands (ASI-100 / ASI-100T)
 Autosampler Commands (AS50)

The following pages provide details on:

 Injecting a Sample

 Setting Up Remote Injection

 Defining Sample Preparation Steps (AS50)

 Opening the AS50 Door during Operation

 Monitoring the Status of the AS50
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 Autosampler Commands (GINA 50)

Suck (see ⇒⇒⇒⇒Draw) / ⇒⇒⇒⇒Dispense  Sample

0.000 Suck Position = Value, Volume = Value [µl],
Duration = Value [sec]

0.000 Dispense Position = Value, Volume = Value [µl],
Duration = Value [sec]

 Note: In the case of the Dionex Autosampler GINA 50, the
corresponding operations can be synchronized with the data
system via a remote input and the Suck and Dispense
commands. The device automatically reports the completion of
each operation to the data system. In the Program, the wait
command Sucked must be inserted. All following commands are
executed only after the sampler confirmed the execution of the
Suck command, i.e., after the sample has been drawn. The
program performs this independently of the time required by the
sampler for the suck and dispenses processes. This is shown in
the following example:

0.000 Suck Position = 20, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Suck Position = 21, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Dispense Position = , Volume = 60, Duration = 0

0.000 Wait Sucked

0.000 ⇒Inject

Description of the program part: First, the Autosampler GINA 50 draws 30 µl
solution from ⇒Position 20 and, upon completion, 30 µl solution from position
21. The entire drawn volume is dispensed in the current vial (current = last
position if no other position is specified). Then, the injection volume, which has
been specified in the sample list, is drawn and injected from there.

Short command syntax:

0.000 Suck 20, 30, 0

0.000 Wait Sucked

0.000 Suck 21, 30, 0

0.000 Wait Sucked

0.000 Dispense Position = , Volume = 60, Duration = 0

0.000 Wait Sucked

0.000 Inject
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Relative Sample Location
The Dionex Autosampler GINA 50 is capable of executing the suck and the
dispense commands relative to a certain sample position. The
Position+Location is entered in the field Position of the Suck or Dispense
commands. In the program this is expressed as follows:

0.000 Suck Position = 20, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Suck Position = Position+10, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Dispense Position = Position+20, Volume = 60, Duration = 0

0.000 Wait Sucked

Description of the program part: The autosampler takes 30 µl solution from
position 20, moves 10 positions from the current position in the sample list, and
takes 30 µl solution from there. Then, the 60-µl solution is dispensed into a vial
that is located 20 positions from the current sample vial.

Air Segment
For the Dionex Autosampler GINA 50, the input position = 100 means an
imaginary Air Vial from which a certain air volume can be sucked as a
separating segment, e.g.

0.000 Suck Position = 20, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Suck Position = 100, Volume = 30, Duration = 0

0.000 Wait Sucked

0.000 Suck Position = 21, Volume = 30, Duration = 0

0.000 Wait Sucked

Description of the program part: After 30 µl solution is sucked from position 20,
30 µl air is sucked before another 30 µl solution is sucked from position 21.
Thus, the two solutions encounter each other.

 Note: The Segment command should only be given in combination
with the Dispense command, as otherwise the sucked air
volume is also injected.
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Dispense in Needle Seat
Entering position 101 in a Dispense command enables dispensing the volume
contained in the needle into the needle seat of the Autosampler and thus into
the waste container.

0.000 Dispense Position = 101, Volume = 60, Duration = 0

Wash Injection Loop

The ⇒Wash command allows rinsing  the injection loop of the Autosampler
GINA 50 with the solvent. This corresponds to the normal solvent flow during
the Inject command.

0.000 DEVICENAME.Wash  or

0.000 Wash

Lift/Lower Sample Needle

The ⇒NeedleUp command enables the lifting of the sample needle. When
lifting the needle, a running Wash process is automatically interrupted, i.e. the
solvent no longer flows through the injection loop but directly from the pump to
the column.

0.000 NeedleUp

To lower the needle again the Wash command must be executed. Only then
will the solvent flow continue through the sample loop (for details see

Autosampler).

0.000 Wash

The combination of the two commands prevents crystallization of substances in
the sample loop.

For an overview on the individual commands for the GINA 50 or GINA 160
samplers, see:  Dionex Autosamplers GINA 50 and GINA 160.
Also, see:  Autosampler Commands (ASI-100 / ASI-100 T).
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 Autosampler Commands (ASI-100 / ASI-100T)
Many commands of the Dionex Autosampler ASI-100/ASI-100T (ASI-100T =
with temperature control) are similar to those of the GINA 50 (see

 Autosampler Commands (GINA 50). However, there are some important
differences, which are described below:

Sample Positions
The sample vials are situated in three different segments, which are
distinguished by color. Within the segments, the vials are situated in different
rows. Thus, the sample ⇒Positions are indicated as follows:

Letters according to their color describes the individual segments: R, G, or B
(indicating the red, green, and blue segment, respectively). The different rows
are described from the outer to the inner row: A, B, C, or D. The individual
positions within the respective rows are numbered counterclockwise. The
position RA1, for example, is in the outer row of the red segment (also, see the
ASI-100/ASI-100T Operating Instructions).

Autosampler Configuration
Specify the device configuration before starting the actual program. It is
important to define the sample positions for the reagents and the wash liquid.
These positions are valid throughout the entire running time of the program:

0.000 Sampler.ReagentAVial BB1
0.000 Sampler.ReagentBVial BC1
0.000 Sampler.ReagentCVial BA1
0.000 Sampler.WashVial G99
0.000 Sampler.MixVial R99

The following commands define the number of draw and dispense actions (for
the Mix command):

0.000 Sampler.MixRepeat 3

⇒⇒⇒⇒Draw / ⇒⇒⇒⇒Dispense Sample / Mix
Specify which volume shall be drawn or dispensed (or drawn and dispensed for
the Mix command) from which vial (depending on the selected option, see
below) before issuing the respective commands:
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0.000 MixSubject option (see below)
0.000 MixVolume value [µL]
0.000 Draw

0.000 MixSubject option (see below)
0.000 MixVolume value [µL]
0.000 Dispense

The following options are available for the MixSubject command:
Option Description
MixVial actual mixing vial position
Sample_Vial vial for the actual sample  in the sample list (actual

Sampler.Position value)
WashVial vial containing the wash liquid (actual

Sampler.WashVial value)
Air air (with the Draw command) and needle port (with the

Dispense command), respectively
ReagentA (B, C or D) Reagents A (B, C, or  D) (actual Sampler.ReagentAVial

value)

With the Dionex Autosampler ASI-100/ASI-100T, some commands must be
synchronized with the data system, i.e., the sampler automatically reports the
completion of the respective operation to the data system. In addition, the wait
condition Sampler.Ready must be included in the Program. The following
commands are executed only after confirmation by the sampler that the
command has been executed. This applies to the Draw, Dispense, Mix, Test
commands, and ⇒Wash and is illustrated below:

0.000 MixSubject Sample_Vial
0.000 MixVolume 30
0.000 Draw
0.000 Wait Sampler.Ready
0.000 MixSubject ReagentA
0.000 MixVolume 30
0.000 Draw
0.000 Wait Sampler.Ready
0.000 MixSubject MixVial
0.000 MixVolume 60
0.000 Dispense
0.000 Wait Sampler.Ready
0.000 ⇒Inject Position = MixVial

Description of the program part: First, the Autosampler ASI-100/ASI-100T
draws 30 µl solution of the current sample, and, upon completion, 30 µl solution
of reagent A. The entire drawn volume is dispensed into the MixVial. Then, the
injection volume, which has been specified in the sample list, is drawn and
injected from this position.
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Air Segment
Define the MixSubject as Air to draw an air segment. Use, for example, the
following program part to draw two samples separated by an air segment to
prevent early mixing in the needle and to ensure that an exactly defined
reaction time is met.

0.000 MixSubject ReagentA
0.000 MixVolume 100
0.000 Draw
0.000 Wait Sampler.Ready
0.000 MixSubject Air
0.000 MixVolume 5
0.000 Draw
0.000 Wait Sampler.Ready
0.000 MixSubject Sample_Vial
0.000 MixVolume 100
0.000 Draw
0.000 Wait Sampler.Ready
0.000 MixSubject MixVial
0.000 MixVolume 205
0.000 Dispense
0.000 Wait Sampler.Ready

Description of the program part: After drawing 100 µl of reagent A, 5 µl of air is
drawn before 100 µl of sample is drawn from the vial. Thus, the two solutions
encounter each other in the mixing vial only.

Relative Sample Location
1. Different rings: The Dionex Autosampler ASI-100/ASI-100T can execute
commands relative to a certain sample position. The Position + relative entry is
entered in the field Position of the Draw or Dispense commands. In the
program, this is expressed as follows:

0.000 MixSubject Sample_Vial
0.000 MixVolume 30
0.000 Draw
0.000 Wait Sampler.Ready
0.000 Position Position + RB1 - RA1
0.000 MixSubject Sample_Vial
0.000 MixVolume 30
0.000 Draw
0.000 Wait Sampler.Ready
0.000 Position Position + RC1 - RB1
0.000 MixSubject Sample_Vial
0.000 MixVolume 60
0.000 Dispense
0.000 Wait Sampler.Ready
0.000 Inject Volume=30
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Description of the program part: The autosampler draws 30 µl solution from the
actual sample vial, moves to the respective position in the RB ring, and draws
30 µl solution from this position as well. Then, the 60 µl solution is dispensed
into the vial at the respective position in the RC ring. If the current sample is
situated, e.g., at position RA3, another 30 µl would be drawn from position
RB3, and the entire volume of 60 µl would be dispensed at position RC3. After
that, 30 µl are injected from position RC3.

 Note: To complete things, the MixSubject command is repeated with
the argument Sample_Vial in the above program part. This is not
requested as the data system maintains the latest setting. The
second command (= MixVolume) could be omitted as well as it
only repeats the argument "30."

2. Different segments: You can also place the samples to be derivated into
the red segment, for example, and execute the mixing process with a reagent
in the corresponding sample vial in the green segment using the following
commands:

0.000 Sampler.MixVial Position + GA1 - RA1
0.000 MixSubject MixVial
0.000 Mix

The first line specifies that the corresponding vial in the green segment be used
as a mixing vial for a sample in the red segment. For example, if you wish to
process the sample at RB5, mixing takes place at position GB5.

3. Incrementing the positions: Another way is to increment the positions. Use
the following example to define a position 5 after the current position for
MixSubject:

0.000 Sampler.MixVial Position + 10
0.000 MixSubject MixVial
0.000 Mix

For example, if you wish to process the sample from position RB3, mixing will
take place here in RB8.
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Wash Needle
With the Wash command, the needle of the Autosampler ASI-100/ASI-100T
can be rinsed with the wash liquid. The wash volume is drawn and dispensed
into the needle seat.

0.000 WashVolume value [µL]
0.000 Wash

For an overview on the individual commands for the ASI-100/ASI-100T
sampler, see  Dionex Autosamplers ASI-100/ASI-100T

Also, see the  Autosampler Commands (AS50).

 Autosampler Commands (AS50)

Flush the Inject Port
The Flush and Wait commands must be in the order shown and they must
occur before any other Autosampler commands, or after all other
autosampler commands.

Flush Volume = Value [µl]

Wait FlushState

Autosampler Options
All AS50 autosampler option commands must be grouped together in the

Program. Place them at the beginning of the program, before t = 0.000.You
do not need to specify event times for the AS50 option commands.

Devicename.NeedleHeight = Value [mm]

Devicename.CutSegmentVolume = Value [µl]

Devicename.SyringeSpeed = Value

Devicename.ColumnTemperature = Off / Value [°C]
Devicename.TrayTemperature = Off / Value [°C]
Devicename.Cycle = Value

Sample Prep
All AS50 autosampler sample prep commands (Dispense, Dilute,
SetNeedleHeight, DelaySP, FlushSP, Mix, and Pipet) must be grouped
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together in the program. Place them at the beginning of the program, after the
AS50 option commands and before t=0.000. You do not need to specify event
times for the sample prep commands. Include a Wait SamplePrep command
after the sample prep commands to allow them to be completed before
injection.

In the example below, 20µl is pipetted from vial 1 and delivered to vial 10.
200µl is dispensed from reservoir A into vial 10. The contents of vial 10 is then
mixed by drawing in and then expelling 100µl of the vial contents. The mixing
cycle is repeated 5 times.

 Note: Due to lack of space, commands are shown on two lines.
Normally, one command must be entered on one line.

Sampler.Pipet Volume = 20.0, SourceVial = 1,
DestinationVial = 10

Sampler.Dispense Volume = 200.0, SourceReservoir =
Reservoir_A, DestinationVial = 10

Sampler.Mix SourceVial = 10, NumberOfTimes = 5,
Volume = 100.0

Wait SamplePrep

Relative Vial Location
In the sample preparation commands, a vial location can be specified either as
an absolute position or as a relative position. In relative positioning, the
CurrentVial is the current sample vial position, specified in the sample list in the
Sequence. In the example below, 20µl of liquid is pipetted from the current
sample vial and then expelled into the vial, 1 position past the current vial.

Sampler.Pipet Volume = 20.0, SourceVial = CurrentVial,
DestinationVial = CurrentVial+1

Cycle Time
Cycle time controls the time between injections. When a cycle time is specified,
the autosampler delays sample injection until the specified time has elapsed
since the previous injection. This is accomplished with the Wait
CycleTimeState command. When running a batch, the Wait CycleTimeState
command in the first PGM file in the batch is ignored.

The following example sets a cycle time of 30 minutes.

Cycle =30

0.000 Sampler.Load
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Wait CycleTimeState

Sampler.Inject

Priming the Liquid Lines
The Prime command is used to prime the flush reservoir line to the sampling
valve and the sample transfer line. In addition, if the sample prep option is
installed, the Prime command is used to prime the lines from each installed
reagent reservoir. The following example uses the prep syringe to prime the
line to reservoir A with 2000µl.

0.000 Sampler.Prime Volume=2000, PrimeReservoir=Reservoir_A,
PrimeSyringe=Prep

For an overview on the individual commands for the AS50 sampler, see
 Dionex Autosampler AS50.

 Injecting a Sample
Depending on the laboratory equipment, injection is performed
• Manually

• Via Autosampler or

• Automatically (the injection is programmed).

How much of a substance is injected (⇒Volume) and from which Autosampler
⇒Position is determined by the user via the corresponding control on the
control panel or via the Inject edit box of the Control menu.

Then the user executes the ⇒Inject command.

Reporting the end of the injection process to the data system completes
successful injection. In the case of a hand-operated valve, this is via a contact
closure relay. Modern autosamplers automatically send the message via the
serial interface or DX-LAN. After that, the retention time is started.

Hand-operated valve (manual injection):
The sample is injected via a µl-syringe into the needle seat of the hand-
operated valve. In this way, it reaches the sample loop (Load). By switching
the valve (Inject), the solvent flow is directed to the sample loop, and the
sample enters the high-pressure circuit of the system. If correctly connected
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(via a Remote Input), switching the hand-operated valve triggers the Inject
signal and thus the timer. Very exact operation is possible if the injected
volume corresponds to the sample loop size. Then, the sample loop is
completely filled. When switching the valve, the exact volume of the sample
loop is injected without any loss.

Autosampler (manual injection):
Operation can be via the input panel of the instrument or via the PC. The more
convenient method via the PC is only possible if the autosampler is connected
with the data system via an RS232 interface or the DX-LAN.
• Choose the ⇒Inject command (Control menu) and determine the

⇒Volume and the Autosampler position for the injection.

• If your control panel offers the corresponding controls, the parameters
Volume and Position can be entered directly via an edit box.

The time required by the Autosampler to inject the sample can be indicated
optically. For this, a color area or a lamp must be linked with the object property
Inject Wait (for details, see How to ...: Actions in the Control
Panel  Linking a Control to a Device). In a controlled system, the pump is
placed in ⇒Hold status during injection.

Automatic injection:
• Enter the Inject command at the time t = 0.000 in the Program.

If the command is executed by an autosampler that is controlled by the Dionex
Chromatography Management System, the sampler sends a signal back to the
data system when injection is completed. The timer is then started.
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When injecting via a hand-operated valve or an autosampler that is not
controlled by the Dionex Chromatography Management System, the data
system waits for a signal before it starts the timer. For example, with a hand-
operated valve, the signal is given after switching the valve from Load to
Inject, i.e., the execution of a program is delayed until injection is actually
performed. This type of automatic injection requires connection of a remote
input or remote start device via remote inputs (TTL or relay) and configuration
of a remote inject device. See How to ...: Device Control  Setting Up
Remote Injection.

 Caution: As an Inject signal is not specified, there can only be one
injection unit per timebase, i.e., either a hand-operated valve or
an autosampler is installed.

 Setting Up Remote Injection
If the injection valve is not directly controlled by the Dionex Chromatography
Management System, a Remote Inputs (remote start) device can be set up to
signal the data system when injection has occurred. The setup procedure
consists of connecting the remote input device via TTL or relay, configuring a
remote inject device in the Timebase, and adding an ⇒Inject command to the

Program.

 Tip: For the UI20, remote injection can be triggered by the remote
input or by pressing the Run button on the UI20 front panel. For
the DX-120, remote injection can only be triggered by the remote
input. The Load/Inject button on the DX-120 front panel is
disabled during remote control.

Connect the Remote Input Device (TTL or Relay Connections)
In order for the remote input (remote start) device to signal when injection has
occurred, its remote input must be connected via TTL or relay to the injection
valve or to another device, for example, an Autosampler. When injection
occurs, the injection valve or autosampler sends a signal to the remote input
device. The remote input device in turn signals the Dionex Chromatography
Management System that injection has occurred.
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Example Connections: AS40 and DX-120

 Tip: For detailed TTL and relay connection instructions, refer to the
operator's manual for each device.

The following connections allow completely automated control of the AS40 and
DX-120.

1. Connect the Relay Control Ready Out pin on the AS40 rear panel to the
Inject TTL Input pin on the DX-120 rear panel.

2. Connect the Ready Out Ground pin on the AS40 to the TTL Inputs
Ground pin on the DX-120.

3. Connect the Load pin on the AS40 to the TTL 1 Out pin on the DX-120.

4. Connect the Load Ground pin on the AS40 to the TTL Outputs Ground
pin on the DX-120.

Configure a Remote Inject Device
1. Open the Server Configuration.

2. Select the timebase under which the remote input device is configured.

3. Select Add Device from the Edit or context menu.

4. Select Remote Inject from the list of device drivers and click OK. The
Properties dialog box for the Remote Inject device appears.
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5. The default device name is InjectValve. You can keep the default name or
enter a different one.

6. From the Inject Port drop-down list, select the remote input device that was
connected through TTL or relay. Click OK.

Add an Inject Command to the Program

Add the following command to the PGM file. (If you use the  Program
Wizard (see Control (Programmed) section), the command is added
automatically.)

0.000 Inject

When the Dionex Chromatography Management System executes the
program, it runs the commands that occur before the Inject command and then
waits for the signal from the remote input device. A message in the audit trail is
displayed: "Wait for inject response on remote start." When the inject signal
occurs, program execution resumes.

Example PGM File: AS40 and DX-120

Data_Collection_Rate 5.00

Pump = On

SRS = On

EluentPressure = On

Column = A

ECD_TTL_1.State = 5v Note 1
Wait RinseComplete Note 2

-0.100 ECD_TTL_1.State = 0v Note 3

0.000 ECD.Autozero Note 4
Inject Note 5
ECD_1.AcqOn

10.000 ECD_1.AcqOff

End
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Notes:

1. TTL Out 1 turned off.

2. The TTL_1 5v and TTL_1 0 v commands must be separated by one or more
commands or they must occur at different times in the program.

3. TTL Out 1 turned on. AS40 Load Cycle starts.

4. Program execution waits until inject signal is received.

5. AS40 Ready Out signals the DX-120 Inject TTL Input. Injection occurs.
Program execution resumes.

 Defining Sample Preparation Steps (AS50)
AS50 Autosampler sample preparation steps are part of a PGM File and
can be defined using the  Program Wizard (see below and the Control
(Programmed) section) or entered manually into the program (see How to …:
Actions in the PGM Editor  Manually Creating a Program).

Perform the following functions from the AS50 Sample Prep Options dialog box
in the Program Wizard.

Defining a New Sample Preparation Step
1 Select a Sample Prep Function from the Function list.

The parameters for the selected function appear.

2 Select the desired parameter values.

3 Click the Insert button to add the step to the list.

The new step is added above the currently selected step (if any).

Changing an Existing Step
1 Select the step in the list.

2 Make the required changes, for example, select a new function and enter
the function’s parameters, or change the parameters for the current
function.

3 Click the Enter button.

 Tip: To delete a step, select it, and click the Delete button.



Device Control 527

 Opening the AS50 Door during Operation
Normally, the AS50 Autosampler door must remain closed while the AS50 is
running a batch. If the door is opened inadvertently, the sampling arm stops
immediately and the batch is aborted. There are certain times during operation,
however, when the autosampler is not busy, and it is safe to open the door.
The Dionex Chromatography Management System monitors operation and
informs you when you can open the door without aborting the batch.

First, press the Door button on the AS50 front panel. If the AS50 is busy, a
message in the Audit Trail window informs you that it is currently not safe to
open the door.

When the AS50 is not busy, a message informs you that it is now safe to open
the door. A timer then begins counting down the time remaining in which it is
safe to have the door open. It continues counting down after the door is
opened. The door must be closed again before the timer reaches zero, or the
batch will be aborted.

If after pressing the Door button, you decide you do not want to open the door,
you can allow the timer to expire or press any button on the AS50’s front panel
to reset the timer to zero.

 Note: To display the timer on the control panel, place a string display,
gauge slider, or gauge indicator Control on the control panel
(see Layout Toolbar). Then, link the control to the object
property, DoorSafetyTime. For details, see How to ...: Actions
in the Control Panel  Linking a Control to a Device.

 Monitoring the Status of the AS50
The status of the AS50 Autosampler can be displayed on the Control Panel.
To do this, place a string display Control on the control panel (see Layout
Toolbar). Then, link the control via the Link tab dialog box to the sampler
object property, Status.
The control then displays the action currently being performed by the
autosampler, for example, Idle, Preparing to run, Injecting, and so on.

Control - Detectors
Depending on the detector type different commands are available. For an
overview on the individual commands that are available for the different Dionex
UV and PDA detectors, see
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 Detector Commands

The following pages provide details on:

 Starting Data Acquisition
 Defining Signals, Signal Parameters, Axis Decoration, etc.
 Modifying Signal Parameters (Overview)
 Modifying the Signal Parameters of an UVD Channel
 Modifying the Signal Parameters of a 3D-Field
 Determining Wavelength Switching
 Defining a Waveform
 Defining Step and Average
 Switching Polarity

In addition, see the following pages for details on:

 Viewing or Resetting the Lamp Age

 Detector Commands

Modifying Signal Parameters

0.000 Channelname.Average =On / Off

0.000 Channelname.Bandwidth =Value

0.000 Channelname.Wavelength =Value

0.000 Channelname.Step =0.25 / Value [sec]

 Caution: Select the ⇒Step in such a way that 20 to 50 data points are
placed on the narrowest relevant peak in your chromatogram. If
you acquire more data points, this will use unnecessary disc
capacity and the integration might become incorrect, especially
with heavier baseline noise. This may also happen when using
the Step Auto.

 Note: To realize Wavelength Switching, a new wavelength is defined
for a channel at the switch time.
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Switching Detector ⇒⇒⇒⇒Lamp On/Off

0.000 Devicename.Lamp =On / Off

Switching Detector Lamps On/Off (AD20 Detector)

0.000 Devicename.UV_Lamp =Low / High / Off

0.000 Devicename.Visible_Lamp =Low / High / Off

Switching Detector Lamps On/Off (AD25 and PDA-100 Detector)

0.000 Devicename.UV_Lamp =On / Off

0.000 Devicename.Visible_Lamp =On / Off

Turning the Amperometry Cell On/Off (ED40/ED50/ED50A Detector in
Amperometry Mode)

0.000 Devicename.Cell =On / Off

Selecting the Electrode (ED40/ED50/ED50A Detector in Amperometry
Mode)

0.000 Devicename.Electrode =pH / AgCL

 Starting Data Acquisition
• Press the ⇒AcqOn/Off button on the toolbar and determine the channels to

record via the automatically displayed dialog box.

• Press the button again to stop data acquisition.

Alternatively, the command can be performed via the Control menu or the
corresponding button on the Desktop. Each signal (channel) selected during
the start of data acquisition is stored in a separate raw data file.
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• Open the context menu within the signal plot to influence the
representation of the signals (Autoscale, Autozero, Replot from Beginning,
Chromatogram Overlay) or the type of the recorded data (signal
parameters) via the context menu.

 Defining Signals, Signal Parameters, Axis Decoration
    etc.
Open the context menu within a signal plot and select:

• Signals to determine the signals to be displayed.

• Axis/Decoration to display axis decoration, units, timebase names, signal
parameters, a grid, the signal value, or the retention time.

• Chrom. Overlay to display a comparable chromatogram.

Press F1 for context-sensitive help.

 Modifying Signal Parameters (Overview)

Manually / directly:
• Move the mouse cursor to the signal plot of a control panel.

• Open the context menu within a signal plot and select Signal Parameters.

• Select the tab of the signal / channel for which you want to change the
parameters. Signals of different types have different Signal Parameters.

• MS parameters are not available in this dialog box. Define them in a
separate METH file.



Device Control 531

Programmed / indirectly:
In controlled systems, the parameters can be activated/deactivated during
chromatogram run time at exact times.
• Choose Command ... in the Control menu, select the signal to modify and

define its signal parameters - or
• Enter the corresponding command in a Program that is executed in

automatic Batch Processing.

For an example for modifying signal parameters, see

How to ...: Device Control  Determining Wavelength Switching.

 Modifying the Signal Parameters of an UVD Channel
Modifying one or several signal parameters allows improving the signals
provided by the detector. You can change the following signal parameters for
your UV Detector:

Signal Param. Description Comment
⇒Wavelength Changes the recorded

wavelength.
Note the possibilities for wavelength
switching (see How to ...: Device
Control  Determining Wavelength
Switching).

⇒Bandwidth Changes the bandwidth with
which the signal is recorded.

If necessary, increase the bandwidth to
improve the Signal to Noise Ratio.

⇒RefBandwidth
(Reference
Bandwidth)

Changes the reference
bandwidth.

If necessary, increase the bandwidth to
improve the signal to noise ratio.

Signal Value indicates the current
value of a Signal
Upper/LowerLimit allows
defining the signal acquisition
limits.

If signal acquisition limits are exceeded
or fallen below, the running batch is
stopped and the emergency program is
started.

Delta Difference between the current
signal value and the signal
value one second before.

The value cannot be changed.

Retention Shows the current retention
time (no modification possible).

MaxAutoStep Input of the maximum step
width with the setting auto.

The highest possible value is the
default: 5.1 s.

⇒Step Changes the step. Select the step such that the narrowest
peak contains approx. 20 datapoints

⇒Average Averaging. Use this parameter to improve the
signal to noise ratio.
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  Modifying the Signal Parameters of a 3D-Field
By changing various signal parameters of a Photodiode Array Detector, the
size, and quality of a 3D-Field can be improved. There are the following
possibilities:

Signal Param. Description Comment
MaxWavelength
MinWavelength

Determines the upper/lower
limit of the 3D-field.

Use these parameters to limit the size of
the 3D-field to the essential section.

⇒RefWavelength
(Reference
Wavelength)

Changes the reference
wavelength.

If necessary, increase the bandwidth to
improve the Signal to Noise Ratio.

⇒RefBandwidth
(Reference
Bandwidth)

Changes the reference
bandwidth.

If necessary, increase the bandwidth to
improve the signal to noise ratio.

⇒BunchWidth Shows the current value of
the bunch width.

Increasing the value improves the signal
to noise ratio. However, the resolution
decreases.

⇒Step Changes the step. Select the step such that the narrowest
peak contains approx. 20 datapoints

Retention Shows the current retention
time.

The value cannot be modified.

 Determining Wavelength Switching
Wavelength Switching is realized by time-precise modification of the

⇒Wavelength (UV detector) or Emission, and Excitation (fluorescence
detector) signal parameters.
• For each wavelength switch, enter the time, the channel and the new

parameter value in the Program, e.g. for the channel of a fluorescence
detector:

10.000 UV_VIS1.Wavelength = 280 nm

10.000 UV_VIS2.Wavelength = 320 nm

or

10.000 Emission.ExWavelength = 240 nm

10.000 Emission.EmWavelength = 295 nm
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 Displaying the Signal Parameters of a Mass Channel
Different channel types are available for Mass Spectrometers:

TICF channels (TICF_01 to TICF_4: data acquisition in Full-Scan mode)

SIM channels (SIM_01 to SIM_32: data acquisition in SIM mode)

TIC channel (total of all TICF or SIM channels)

MS_01 to MS_32 channels (data acquisition in full-scan mode)

Almost no parameters for mass spectrometer channels can be changed from
the Control Panel. The following parameters for the channels of a mass
spectrometer can be displayed:

Signal Param. Description Comment
Min/MaxMass Limits of the mass range that

is acquired in this mass
channel.

SIM channels cannot be changed.
MS channels MS_01 to
MS_32: Enter the lower /
upper mass range limit.

FilterIndex Number of the Filter of the
Finnigan aQa method
(METH-File).

With MS_01 to MS_32 channels only:
Select the number of the desired filter
(1-4):

Polarity Ionization polarity of the mass
spectrometer.

The value cannot be changed.

Source Voltage Voltage of the ion source of
the mass spectrometer.

The value cannot be changed.

Filter Filter of the Finnigan aQa
method (METH file).

The value cannot be changed.

Delta Difference between the
current signal value and the
signal value one second
before.

The value cannot be changed.

Retention Indicates the current retention
time.

The value cannot be changed.

Signal Value indicates the current
value of a Signal.
Upper/LowerLimit allows
defining the signal acquisition
limits.

If signal acquisition limits are exceeded or
fallen below, the running batch is stopped
and the emergency program is started.
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  Defining a Waveform
A Waveform must be defined when a Dionex electrochemical detector is
used in Integrated Amperometry Mode. Waveform definitions are part of a

Program and can be defined using the  Program Wizard (see below and
the Control (Programmed) section) or entered manually into the program (see
How to ...: Actions in the PGM Editor  Manually Creating a Program).

Selecting a Standard Waveform from the Program Wizard
1 In the Waveform Options dialog box of the Program Wizard, click the

Waveform button.

A list of standard waveforms appears.

2 Select a waveform from the list and click OK.

The selected waveform’s time, potential, and integration settings replace
any waveform settings already in the waveform table. After completing the
Program Wizard, the waveform can be modified in the resulting program.

Defining a Custom Waveform from the Program Wizard

Perform the following steps from the Waveform Options dialog box in the
Program Wizard:

1 In the Time (Sec) box, type or select the time to begin the first waveform
step.

2 In the Potential (V) box, type or select the potential to apply between the
reference and working electrode.

3 In the Integration box, select an Integration option: Begin starts
integration at this step, End stops integration, No-Change keeps the setting
selected in the previous step.

 Tip: Each waveform must have at least one integration period.
Integration periods cannot begin or end at Time 0 or at the last
step in the waveform, and they cannot overlap.
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4 Press the Enter button.

The step is added to the waveform table.

5 Repeat the above steps for each subsequent step in the waveform to create
the potential vs. time plot.

 Tips: To delete a step, select it in the waveform table, and press the
Delete button.

To edit an existing step, select it in the waveform table, change
the time, potential, and/or integration settings and press the
Enter button.

  Defining Step and Average

The time interval between two recorded data points is referred to as ⇒Step.

The smaller the selected step, the more data points will be recorded, thus
(generally) ensuring a more precise result. As this increases required storage
capacity, we recommend a good compromise between the required information
and the capacity.

For intelligent minimization of the required storage capacity, the individual
instruments (e.g. Dionex detectors) offer the setting Step = Auto. Generally,
however, a fixed step should be selected, as an automatic step may result in a
faulty integration.

In combination with the ⇒Average parameter, the step can optimize the signal
to noise ratio. See the following example:

Example: A detector delivers 100 values per channel (A and B) and per
second. For channel A, the setting Step = 0.1; Average = ON is
selected, and for channel B Step = Auto; Average = ON.
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Channel A:
A step of 0.1 corresponds to a sampling rate of 10 values/s. This means that
out of the 100 values that are available, only every tenth value is stored. If the
Average signal parameter is ON, the values recorded per step are averaged.
From 10 values, one average value is formed and is stored. For channel A, one
signal value per second is stored.

Channel B:
Step = Auto means that the Dionex Chromatography Management System
decides depending on events, how many values should be recorded per
second. As a different number of values is recorded at different times, a varying
number of values is averaged in the final value.

 Tip: Only use Step = Auto for fast sample chromatograms for which
you do not know the peak width to be expected. For a precise
and reproducible analysis, a fixed step should be used.

 Switching Polarity
In some cases, components appear as negative peaks instead of positive.

In this case, the sign can be changed via the Polarity (+/-) switch.

 Viewing or Resetting the Lamp Age
The PDA-100 detector allows you to view the number of hours the UV and
visible lamps have been on. In addition, the lamp age can be reset to 0, if new
lamps are installed.

The lamp age commands are available from the Command dialog box. Select
Command... from the Control menu. Under UV, select UVLampAge or
VisibleLampAge. The total number of hours the lamp has been on is
displayed. The number of hours can also be changed from this dialog box.

The UV and Visible lamp ages can also be displayed on the Control Panel.
To do this, place a string display Control on the control panel (see Layout
Toolbar). Via the Link tab dialog box, then link the control to the UV object
property: UVLampAge for the UV lamp or VisibleLampAge for the visible
lamp.

For details, see:
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 Modifying a Control Panel
 Modifying a Control
 Linking a Control to a Device

 Controlling a Suppressor
The commands used for controlling a Suppressor differ, depending on the
model of conductivity detector used and the type of suppressor installed:

Detector Model Supported Suppressor(s)
CD20, CD25, ED40, ED50, IC20, and IC25 SRS
CD25A, ED50A, and IC25A SRS, AES

Controlling an SRS with a CD20, CD25, ED40, ED50, IC20, or IC25
Detector
Use the following command to set the current applied to the SRS suppressor.

SRS_Current =Off, 50, 100, 300, 500 (mA)

Controlling an SRS with a CD25A, ED50A, or IC25A Detector
Use the following commands to select the SRS suppressor and the current
applied to it.

Suppressor_Type =SRS

Suppressor_Current =0...500 (mA)

Controlling an AES (CD25A, ED50A, or IC25A Detector Only)
Use the following commands to select the AES suppressor, the eluent
concentration, and the current applied to the AES. For details on setting the
AES current, see How to ...: Device Control  Setting Atlas Suppressor
Currents.

Suppressor_Type =AAES, CAES

AAES_CO3 =0.0...12.5 (mM)

AAES_HCO3 =0.0...25 (mM)

AAES_OH =0.0...25 (mM)

CAES_H2SO4 =0.0...12.5 (mM)

CAES_MSA =0.0...25 (mM)

Suppressor_Current =0...150 (mA)
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 Setting Atlas Suppressor Currents
Atlas Electrolytic Suppressors have a maximum suppression capacity of
25 mN eluent at 1.0 ml/min, which is equivalent to 12.5 mM sodium carbonate
for anion separations or 25 mM methanesulfonic acid (MSA) for cation
separations at 1.0 mL/min.

For optimal suppressor performance, it is important to use the recommended
suppressor currents for the target applications. The Program Wizard of the
Dionex Chromatography Management System (see Control (Programmed)

 Program Wizard) guides you in setting the recommended current for the
Atlas Electrolytic Suppressor. The Wizard supplies a recommended current
based on the eluent concentration and flow rate settings (see the following
table). The Dionex Chromatography Management System automatically enters
the recommended current into the Program and applies that current to the
Atlas Electrolytic Suppressor.

 Tip: For gradient separations, use the highest eluent concentration in
the gradient when you enter the eluent concentration in the
Wizard.

Examples of Recommended Operating Currents for Atlas Electrolytic
Suppressors:
Column Eluent Flow Rate

(ml/min)
Current
(mA)

4-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 2.00 36
2-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 0.50 9
4-mm AS9-HC 9.0 mM Na2CO3 1.00 60
2-mm AS9-HC 9.0 mM Na2CO3 0.25 15
4-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 1.20 32
2-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 0.30 8
3-mm AS14A 8.0 mM Na2CO3/1.0 mM NaHCO3 0.5 28
4-mm CS12A 22 mM MSA 1.00 72
3-mm CS12A-5 µm 20 mM MSA 0.50 32
2-mm CS12A 22 mM MSA 0.25 18

For other column and eluent conditions, the recommended current for the Atlas
electrolytic suppressors can be calculated using the following equation:

min)/()]([)*min*(67.12)( mlrateflowmNeluentmlmNmAmACurrent ×××=
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For anion separations:

)]([)]([)]([2)]([ 3
2
3 mMOHmMHCOmMCOmNeluent −−− ++×=

For cation separations:

)]([)]([2)]([ 42 mMMSAmMSOHmNeluent +×=

(Where: [ ] enclosing an ion or eluent indicate concentration.)

 Caution: To ensure the optimal performance of the Atlas Electrolytic
Suppressors, avoid applying excess current to the suppressors.
Excess operation currents lead to excess heat generation, which
can reduce the suppressor lifetime and cause higher
chromatographic baseline noise. The following table lists the
maximum operating currents for the Atlas Electrolytic
Suppressors under various column diameter and flow rate
conditions.

Maximum Operating Currents for the Atlas Electrolytic Suppressors:
Separation Column Flow Rate (ml/min) Maximum Current (mA)
2-mm column 0.25 to 0.50   30
3-mm column 0.50 to 1.00   50
4-mm column 1.00 to 2.00 100

Once the recommended suppressor current is determined, turn on the pump
flow and apply the current to the suppressor.
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Control - Fraction Collection
Depending on the device type, different commands are available for Fraction
Collector control. We recommend installing the Fraction Collection
Automation (= FCA) driver in addition to the respective device driver (see

 Setting up Fraction Collection). The FCA driver allows creating a
standard Program and  Setting the Peak Detection Parameters. In
addition, it provides information on the  Checking the Fraction Collection
Status.

For further information, see:

 Recognizing the Peak Start, Peak Maximum, and Peak End

 Defining the Reactions to Certain Events

 Setting the Fraction Collection Options

 Fraction Collection - Program Example

 Setting up Fraction Collection
Similar to automating sample injection by means of autosamplers, fraction
collectors can be used to automate collecting the fractions after the detector.
Controlling Fraction Collectors can be exclusively via ⇒Trigger commands as
well, however, this is rather complex. Below please find some useful hints to
facilitate fraction collection:

Server Configuration
Add a Fraction Collection Automation (= FCA) driver under the respective
timebase (via Add Device) and install the Device Driver of the respective
fraction collector as usual.

Now, the fraction collector can be easily controlled. Define how to collect the
fractions in the Program Wizard (see Control (Programmed)  Program
Wizard) or via the control commands under Fraction Collection in the

Control Panel.
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Program Wizard
The Program Wizard assists the user in creating a Program for fraction
collection control. The Fraction Collection Options page allows enabling
fraction collection according to the individual peaks and specifying the basic
parameters needed for fraction collection. On the Peak Detection Options
page, specify the peak detection algorithm via the fraction collection
parameters (see  Setting the Peak Detection Parameters).

Default Program Example
If you do not have saved a FractionCollectionTemplate.pgm yet, the Program
Wizard creates the default program that is given below (for fraction collection
control only):

DelayVolume = 0
PumpDevice = "Pump"
TubeMaxVolume = 0
TotalNumberInstalled = 100
CollectOutsidePeaks = Yes
TubeWrapping = Yes
BaselineOffset = 0.000
BaselineDrift = 0.000

;********************************************************************
;*Definition of triggers for fraction collection starts here.
;********************************************************************
; Definition copied from template PGM::DS\DIR\FractionCollectionTemplate

Trigger PeakStart PeakStartDetected
EndTrigger
Trigger PeakMax PeakMaxDetected
EndTrigger
Trigger TubeChange PeakTubeChange
EndTrigger
Trigger PeakEnd PeakEndDetected
EndTrigger

;********************************************************************
;* Definition of triggers for fraction collection ends here.
;********************************************************************

DetectionChannel = "UV_VIS_1"
PeakStartSlope = 2.000
PeakStartThreshold = 10000.00
PeakMaxSlope = -5.000
PeakEndSlope = -4.000
PeakEndThreshold = -10000.00
ThresholdNoPeakEnd = 10000.000

0.000 PeakRecognition = Yes

10.000 PeakRecognition = No
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Edit the trigger blocks (Trigger PeakStart, PeakMax, TubeChange and/or
PeakEnd) according to your type of fraction collector (see ⇒Trigger. For a
detailed program example, see  Fraction Collection - Program Example).
Save the trigger blocks (given in blue writing) as
FractionCollectionTemplate.pgm at the position that is indicated in your default
program above the trigger blocks (in the above example: DS\DIR\). Your new
trigger blocks will then be used as template for all future fraction collection
programs.

For an overview on the available fraction collection topics, see:

 Control - Fraction Collection

 Setting the Peak Detection Parameters
The Fraction Collection Automation (= FCA) driver provides the following
parameters that are available independently of the installed Fraction
Collector:

Parameter Min. Max. Default Functionality
DetectionChannel n/a n/a UV_VIS_1 Name of the signal channel used for

peak detection (this may be a
Virtual Signal as well.).

PeakStartSlope 0.000 1e10 2.000 Slope that must be exceeded so that
the peak start can be recognized.

PeakStartThreshold -1e10 1e10 10000.00 Signal threshold value that must be
exceeded so that the peak start can
be recognized.

PeakMaxSlope -1e10 1e10 -5.000 Slope that must be fallen below so
that the peak maximum can be
recognized.

PeakEndSlope -1e10 0.000 -4.000 Slope that must be exceeded so that
the peak end can be recognized.

PeakEndThreshold -1e10 1e10 -10000.00 Signal threshold value that must be
fallen below so that the peak end can
be recognized.

ThresholdNoPeakEnd -1e10 1e10 10000 Signal threshold value that must be
fallen below so that the peak end can
be recognized.

PeakRecognition 0:No 1:Yes 1 Peak recognition will be performed
only if the variable is set to Yes.
Note: Peaks already detected will
trigger related events after the delay
time even if PeakRecognition is No at
that time.
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Parameter Min. Max. Default Functionality
BaselineDrift -1e10 1e10 0 Slope of the baseline.

The Fraction Collection Automation
driver subtracts BaselineOffset +
∆t*BaselineDrift from the signal value
(current signal value - (BaselineOffset
+ ∆t*BaselineDrift)) before comparing
with the specified thresholds.
∆t is set to 0 whenever BaselineDrift
changes.
Baseline Offset is then set to the
current value of the correction term to
match continuously.

BaselineOffset -1e10 1e10 0 Offset of the baseline.
The Fraction Collection Automation
driver subtracts BaselineOffset +
∆t*BaselineDrift from the signal value
before (current signal value -
(BaselineOffset + ∆t*BaselineDrift))
comparing with the specified
thresholds.
∆t is set to 0 whenever BaselineDrift
changes.

These properties cannot be changed during a peak (i.e., while PeakOn is Yes).
Any attempted change will produce a warning (Parameter cannot be changed
until the current peak has ended. New value will be assigned at peak end). The
change will become effective as soon as the current peak ends.

In addition to these parameters, different variable indicate the

 Checking the Peak Detection Status
For an overview on the available fraction collection topics, see:

 Control - Fraction Collection
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 Checking the Fraction Collection Status
The Fraction Collection Automation (= FAC) driver provides the following status
variables that are available independently of the installed Fraction Collector:

Status Variable Min. Max. Default Functionality
PeakStartDetected 0:No 1:Yes 0 Yes when the peak start is recognized.

When the peak end is recognized, the
variable is reset to No.
Changes are delayed by the Delay Time.
The variable is read-only.

PeakMaxDetected 0:No 1:Yes 0 Yes when the peak maximum is
recognized. When the peak end is
recognized, the variable is reset to No.
(Delayed; read-only)

PeakEndDetected 0:No 1:Yes 0 Yes when the peak end is recognized.
When a new peak start is recognized, the
variable is reset to No.
(Delayed; read-only)

PeakOn 0:No 1:Yes 0 Yes when a peak start or a peak
maximum is recognized.
(Not delayed!)

FractionOn 0:No 1:Yes 0 Yes while a fraction is collected.
(Similar to PeakOn, but appropriately
delayed!)

PeakTubeChange 0:No 1:Yes 0 Yes when a full tube is recognized.
Resets to No automatically.
(Delayed; read-only)

Except for the PeakOn and FractionOn variables, these status variables
cannot be changed. The PeakOn and FractionOn variables support e.g.
creating Virtual Signals:

Peak_On.Type = Digital
Peak_On.Formula Formula = PeakOn*100
Fraction_On.Type = Digital
Fraction_On.Formula Formula = FractionOn*80

The defined channels can be used to check either online in the Control Panel
or upon termination of the data acquisition whether the fractions are collected
correctly.
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In addition to these status variables, different parameters are available for
fraction collection:

 Setting the Peak Detection Parameters
For an overview on the available fraction collection topics, see:

 Control - Fraction Collection

 Recognizing the Peak Start, Peak Maximum, and
    Peak End
To ensure that the Fraction Collector fills the desired tube, the peak start,
peak maximum, and peak end must be correctly recognized.

Peak Start
The prerequisites for recognizing the peak start (and hence the beginning of a
fraction) are as follows:
• No peak start has been recognized so far.

• Peak detection is enabled via the PeakRecognition property.

• The signal of the detection channel is greater than the signal that is defined
via PeakStartThreshold.

• The signal change is greater than the slope that is defined via
PeakStartSlope.

• Data acquisition on the selected channel is not yet terminated.

• The run itself is not terminated yet

• The condition is fulfilled for at least 1 second.

The PeakStartThreshold and PeakStartSlope variables influence the peak
recognition sensitivity.

The PeakStartSlope variable can be changed within broad limits. The higher
the value, the later the peak start is recognized. If PeakStartThreshold is
exceeded by the detector signal, the peak is recognized only if the slope
threshold value is exceeded as well.
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The Dionex Chromatography Management System remembers a peak start so
that a peak maximum may be recognized next. The peak maximum recognition
requires a detected peak start.

Peak Max Recognition
The peak maximum is recognized only if:
• A peak start has been recognized.

• No peak maximum has yet been recognized.

• The signal change, expressed as slope, is less than the signal slope
defined by the PeakMaxSlope.

• The condition is fulfilled for at least 1 second.

The peak maximum detection depends on whether a peak start is detected. If
no peak is recognized, no maximum can be recognized either. The
PeakMaxSlope variable is defined as negative slope value as it applies to the
tailing side of the peak. The closer the value is to zero, the closer to the peak
maximum the PeakMaxRecognition ⇒Trigger will be executed.

The Dionex Chromatography Management System remembers a peak
maximum so that a peak end may be recognized next. The peak end
recognition requires a detected peak maximum (unless one of the end-run
conditions apply).

Peak End Recognition
A peak end (and hence the end of a fraction) is recognized if:
• The signal change, expressed as slope, is greater than the signal slope

defined by the PeakEndSlope and

• The signal of the detection channel is less than the signal defined by
TresholdNoPeakEnd and

• A peak maximum has been recognized

OR:
• The signal of the detection channel is less than the signal defined by

PeakEndThreshold and

• A peak maximum has been recognized
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OR:
• A peak start has been recognized and

• The data acquisition on the signal channel is terminated

AND:
• The condition is fulfilled for at least 1 second.

The first group of conditions checks whether the signal is below the signal
maximum, which is defined by the ThresholdNoPeakEnd variable. With
heavily overloaded detector signals, there is a lot of signal noise so that a peak
end/start would be recognized several times in the top of the peak that could
also be formed like a plateau. To inhibit this set the ThresholdNoPeakEnd
variable to a value below this level. If the value is set to the maximum for the
detector signal, this part of the condition will always be true so that this check
will be disabled. The PeakEndSlope setting allows delaying the peak end.

The second group of conditions uses the signal height criterion. If the signal
value falls below ThresholdPeakEnd, the peak is terminated in any case.

The third group of conditions terminates the current peak in case the data
acquisition is switched off.

For further information, see:

 Defining the Reactions to Certain Events
For an overview on the available fraction collection topics, see:

 Control - Fraction Collection

 Defining the Reactions to Certain Events
As described above, peak start, peak maximum, and peak end are recognized
if certain conditions are fulfilled (see  Recognizing Peak Start, Peak
Maximum, and Peak End). If one of these events occurs, the Dionex
Chromatography Management System issues certain commands to the

Fraction Collector. These commands can be defined in the Program. In the
respective ⇒Trigger block, you can define device-specific actions for your
fraction collector.
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Event Condition Action
PeakStartDetected A peak start "arrives" at the

switching valve/ tube.
Switch to next fraction.*
Switch to collect.

PeakMaxDetected A peak maximum "arrives at
the switching valve/ tube.

Usually no action.

PeakEndDetected A peak end "arrives" at the
switching valve/ tube.

Switch to waste.
Switch to next fraction.*

PeakTubeChange The tube is filled to the limit. Switch to next fraction.

* Switching to the next fraction is needed only once. It might depend on the type of
hardware whether this is better at the peak start or at the peak end.

The events are generated with a delay that takes the volume between the
detector and the switching valve or tube into account. The following parameters
are available:

Parameter Min. Max. Default Function
DelayVolume 0 µl 5000 µl 0 Volume between the detector and the

switching valve or tube.
Also useful with flow gradient.

PumpDevice Pump Pump used to convert between flow and time.

 Note: The Fraction Collection Automation (= FCA) driver calculates
the delay time between the detector and the switching valve or
tube by integrating the flow of the respective pump device.

The driver is capable of tracking several peaks in the capillary between the
detector and the fraction collector as it internally maintains a queue of peak
recognition events.

 Tip: Do not change DelayVolume and/or PumpDevice while
collecting fractions. Usually this does not make sense either.
Performing such a change in the program, e.g. when a part of
the peak is in the capillary between the detector and the fraction
collector, will lead to unexpected results.

For further information, see:

 Recognizing the Peak Start, Peak Maximum, and Peak End
For an overview on the available fraction collection topics, see:

 Control - Fraction Collection
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 Setting the Fraction Collection Parameters
The following variables allow specifying the tube of the Fraction Collector that
is currently used for collection:

Variable Min. Max. Default Function
TubePosition 0 9999

Rack
dependent

1 Tube position used for the
current fraction. May be set
as start value (only at
negative retention times),
otherwise updated by the
driver.
Ready Check will issue a
warning if the value is not 1 at
batch start.

TubeStartPosition 0 9999
Rack
dependent

1 Tube position where the
current fraction has been
collected at peak start (read
only).

TubeMaxPosition 0 9999
Rack
dependent

1 Tube position where the
current fraction has been
collected at the time of the
peak maximum (read only).
May be different from
TubeStartPosition if e.g. the
tube volume is smaller than
the fraction volume.

TubeEndPosition 0 9999
Rack
dependent

1 Tube position where the
current fraction has been
collected at the time of the
peak end (read only).
May be different from
TubeStartPosition and
TubeMaxPosition if e.g. the
tube volume is smaller than
the fraction volume.

TubeMaxVolume 0 ml 1000 ml 0 (Disabled) The maximum volume to be
filled in one tube. When this
volume is collected, the next
tube will be used.

 Tip:
Set the TubeMaxVolume to 0
to disable automatic switching
to the next tube.

TubeFilling 0 ml 1000 ml 0 Volume collected so far in the
current tube (read only - not
delayed).
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Variable Min. Max. Default Function
TotalNumberInstalled 0 9999 100 Number of tubes available in

the rack. Exceeding the set
number resets it to 1 if the
TubeWrapping option is
enabled. Otherwise, the batch
is aborted.

 Tip:
The wrap around is logged in
the audit trail as warning.

TubeWrapping 0 (No) 1 (Yes) No Resets TubePosition to 1
when TubePosition exceeds
TotalNumberInstalled.

CollectOutside 0 (No) 1 (Yes) No Specifies whether to collect
fractions outside peaks as
well. The device will switch to
a new tube at each peak start
or peak end or when the
current tube is filled. When
CollectOutside is set to No
the eluent outside the peak is
directed to the waste after the
detector.

For an overview on the available fraction collection topics, see:

 Control - Fraction Collection

 Fraction Collection - Program Example
A Program for a timebase including Fraction Collector might look as follows:

-0.300 Flow = 1.000
%B = 10
UV_VIS_1.Step = 0.50
UV_VIS_1.Average = On
UV_VIS_1.MaxAutoStep = 1.0

; delay volume between detector output and switching valve or tube:
DelayVolume = 1000
PumpDevice = "Pump"

; maximum filling volume of a tube in uL:
TubeMaxVolume = 8000

; maximum number of installed fraction tubes:
TotalNumberInstalled = 240
CollectOutsidePeaks = No
TubeWrapping = No
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BaselineOffset = 0.000
BaselineDrift = 0.000

;********************************************************************
;* Definition of triggers for fraction collection starts here
;********************************************************************
; Definition copied from template PGM::DS\FractionCollectionTemplate
Trigger PeakStart PeakStartDetected

Z.Nominal = Z.Nominal
; moves the needle to the upper zero position
Collect.On
; switches the collection valve to "Collect" (= on)

EndTrigger

Trigger TubeChange PeakTubeChange
Collect.Off
; switches off the fraction collector valve
Tube = TubePosition
; selects the next tube
Z.Nominal = Z.Nominal
; moves the needle to the upper zero position
Collect.On
; switches the collection valve to "Collect" (= on)

EndTrigger

Trigger PeakEnd PeakEndDetcted
Collect.Off
; switches off the collection valve

EndTrigger
;********************************************************************
;* Definition of triggers for fraction collection ends here
;********************************************************************

; conditions for online peak recognition at peak start
DetectionChannel = "UV_VIS_1"
PeakStartSlope = 2.000
;slope at the start of a peak
PeakStartThreshold = 80.00
;minimum signal height at the start of a peak
PeakMaxSlope = -4.000
;slope after the maximum of a peak
PeakEndSlope = -4.000
;slope at at the end of a peak
PeakEndThreshold = 50.00
;maximum signal height at the end of a peak
ThresholdNoPeakEnd = 2000
;signal mst be less than this threshold value
;before a new peak start is recognized in a peak group

; separation start with injection
-0.100 Autozero.On Duration=1.00
0.000 Wait Ready

Sampler.Inject
1_UV_VIS.AcqOn
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; start of the separation gradient program
Flow = 30.000
%B = 10.0

10.000 %B = 90
13.000 %B = 90

13.000 1_UV_VIS.AcqOff

; regeneration and equilibration phase of the gradient program
15.000 Flow = 30.0

%B = 90

16.000 %B = 10
End

For an overview on the available fraction collection topics, see:

 Control - Fraction Collection

Control - IC, GC, and Temperature
For the control commands for the DX-120 see:

 Controlling a DX-120 Ion Chromatograph

The following pages provide details on:

 Controlling the Eluent Generator Concentration
 Monitoring the Eluent Generator Cartridge Lifetime
 Monitoring the DX-120 Operating Status.

For information on the flow and pressure control, which is an important aspect
of gas chromatographs, see  Flow/Pressure Control for Gas
Chromatographs as well as  Determining a Gradient (GC).
In addition, some instruments allow temperature control. For general
information, see:

 Temperature Control (On/off)

 Controlling the Temperature
For information on controlling the column thermostat ST585, see

 Controlling the Column Temperature
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 Controlling a DX-120 Ion Chromatograph
The following commands are available for controlling DX-120 operating
functions:

Controlled AC Switches the AC power outlet on the DX-120 rear panel on and off. This
provides on off control of an external accessory connected to the outlet.
See the DX-120 operator’s manual for cabling instructions.

Column/Eluent If the DX-120 is in Column Mode, the Column command sets the flow
path to column A or column B. If the DX-120 is in Eluent Mode, the
Eluent command selects the eluent reservoir (A or B). Note: These
commands are active only if the DX-120 is equipped with the dual-
column option.

Data Collection
Rate

Sets the Data Collection Rate of the detector.

Eluent Pressure Turns the pressure to the eluent reservoir(s) on and off.

Pressure Unit Selects the units of pressure to use (psi or MPa).

Pump Turns the pump on and off.

SRS Turns the current supplied to the Self-Regenerating Suppressor (SRS)
on and off.

These commands can be included in a Program, executed directly from the
Commands dialog box (select Command from the Control menu), or linked to
a Control on the control panel.

To link a command to a control, place an edit box or switch control on the
control panel (see Layout Toolbar). Then, link the control to the desired
object property. For example, to turn the DX-120 pump on and off from the
control panel, link the Pump object property to a switch control.

For details, see How to ...: Actions in the Control Panel  Linking a
Control to a Device.
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The corresponding commands in the program are as follows:

0.000 ControlledAC =On/Off

0.000 Column =A/B

; Only for a DX-120 equipped with
the dual-column option.

0.000 Data_Collection_Rate =Value [Hz]

0.000 Eluent =A/B

; Only for a DX-120 equipped with
the dual-column option.

0.000 EluentPressure =On/Off

0.000 PressureUnit =psi/MPa

0.000 Pump =On/Off

0.000 SRS =On/Off

 Controlling the Eluent Generator Concentration
The EG40 Eluent Generator can generate eluent concentrations from 0.0 to
100 mM, in 0.1 mM increments. The maximum concentration (X) depends on
the pump flow rate and is calculated as:

0.1 to X mM at 1.0 to 3.0 ml/min

Where X mM = 100/Flow Rate in ml/min

The concentration can be set manually or controlled via a Program.

Manually Setting the Eluent Generator Concentration
1. Open the control panel for the Timebase. For example, if the timebase is

configured with a GP50 pump, EG40 eluent generator, and CD25 detector,
open the Dionex_Pump_EG40_Conductivity_Detector panel.

2. Move the Concentration slider to select the desired value or enter the
value into the edit field.

-or-

Enter the concentration from the Command dialog box. To do this, select
Command... from the Control menu. Under Pump and EluentGenerator,
select the Concentration command.
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Programming the Eluent Generator Concentration
Commands for setting the eluent concentration can be added to a program
(see  Control (Programmed)).

You can use the  Program Wizard to enter the concentration command(s).
With the Wizard, you can enter a single concentration value for the entire
analysis or program a ramp or multi-step gradient, in which the generated
concentration of eluent changes over time. When completing the Wizard, click
the Help button to see details about the eluent generator and gradient options.

 Monitoring the Eluent Generator Cartridge Lifetime
The Dionex Chromatography Management System monitors the lifetime status
of the EluGen cartridge currently being used by the EG40 eluent generator and
displays the information in the  Server Configuration of the Dionex
Chromatography Management System.

To view the cartridge lifetime status information:

1 In the Server Configuration, select the pump to which the eluent generator
is connected.

2 Select Properties from the Edit menu and then select the Eluent
Generator tab.

The Remaining Lifetime is the percentage of ions remaining in the cartridge.
The ion percentage is counted down in 1% increments. At 10%, the Dionex
Chromatography Management System logs a warning each time the cartridge
is used. At 0%, the Dionex Chromatography Management System displays a
message that the ion count is depleted and the cartridge must be replaced
before continuing operation.

The Expiration Date is 2 years from the date of manufacture. One month
before expiration, the Dionex Chromatography Management System logs a
warning each time the cartridge is used. Although you can continue operation
with the cartridge after the expiration date, performance will be impaired until a
new cartridge is installed.
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 Note: The EluGen cartridge status information can be displayed on the
control panel. To do this, place a string display Control on the
control panel (see Layout Toolbar). Then, link the control via
the Link tab dialog box to the object property,
CartridgeExpirationDate. Use the same procedure for the
object property, CartridgeRemainingLifeTime. For details, see
How to ...: Actions in the Control Panel  Linking a Control
to a Device.

The Cartridge Number and Cartridge Type properties can also
be displayed on the control panel.

 Monitoring the DX-120 Operating Status
You can monitor the status of many DX-120 operating functions from the
control panel. For example, the control panel can include Controls that
display the current DS4 temperature set point and status, the current flow rate,
and the SRS status.

To add the corresponding controls to the control panel and link the desired
status functions, proceed as described in the following sections under How
to ...: Actions in the Control Panel

 Modifying a Control Panel
 Modifying a Control
 Linking a Control to a Device

The following DX-120 functions can be monitored from the front panel.

DX-120 Function Description

Column
Configuration

Indicates whether the DX-120 is configured with a single- or dual-column
set.

DS4 Status Indicates whether the current DS4 temperature is under, at (ready), or
over the temperature set point.

DS4 Temperature Displays the current DS4 temperature set point.

Flow Rate Displays the pump flow rate.

Full Scale Indicates the microSiemens output (100 or 1000) of a full-scale detector
response.
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DX-120 Function Description
Pressure Displays the current pump pressure transducer reading.

SRS Status Indicates the status of the SRS, not installed, off, or the selected
operating current (if on).

System Mode Indicates whether the DX-120 is in Column Mode or Eluent Mode.

 Tip: The Dionex Chromatography Management System reports the
status of the above DX-120 functions only. Except for the system
mode, values for these functions are selected with DIP-switches
on the DX-120. Refer to the DX-120 operator’s manual for
details. The system mode is selected in the DX-120 Properties
dialog box (Mode tab page) in the Server Configuration.

For functions that can be controlled by the Dionex
Chromatography Management System, see  Controlling a
DX-120 Ion Chromatograph.

 Determining a Gradient (GC)
For basic information on determining a gradient, see How to ...: Device
Control  Determining a Gradient.
To enter basic points proceed as follows:

• First, select the initial temperature in the Init line.

• Then, in the Iso Time column, enter for how long this temperature is
maintained.

• In the next line, select the ramp (Rate in °C/min) to be used to change the
temperature, as well as, in the Temperature column, select the temperature
that the GC should reach with this first ramp. Then, in the ISO Time column,
enter for how long this temperature is maintained.

Program up to six temperature ramps in this way.

In the same way, temperature gradients for inlets are defined on the tabs
FrontInlet or BackInlet. Currently this is possible for PTV and Cool on
Column inlets.
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In the same way, flow, and pressure gradients can be determined on the tabs
Column1 and Column2. Select in the checkbox Type: Ramped ... whether a
flow gradient (Flow) or a pressure gradient (Pressure) shall be programmed.
The gradient will then be displayed in the color indicated at the top right.

 Flow/Pressure Control for Gas Chromatographs
Gas chromatographs offer the possibility to operate at a constant gas flow or at
a constant pressure. It is possible to switch from one mode to the other.

Two mutual switches are assigned the property FlowMode. Setting the flow
and the pressure is in the corresponding mode via a separate control (gauge or
edit field).

 Temperature Control (On/Off)
If a Control (e.g. a switch) in a control panel is assigned the property
TempCtrl (see How to ...: Actions in the Control Panel  Linking a
Control to a Device), temperature control for the corresponding instrument
can be switched on and off. The actual temperature setting is performed via an
additional control (see How to ...: Device Control  Controlling the
Temperature).

Instruments providing temperature control are e.g. column ovens, coolable
autosamplers (Dionex GINA 50T), specific detectors, or gas chromatographs
(HP5890).

Switching on the temperature control is also possible via a Program. The
corresponding command syntax is:

0.000 X.TempCtrl=On or

0.000 X.TempCtrl=Off

Where X is the name under which the corresponding instrument was created in
the Server Configuration program, e.g.

0.000 GC.TempCtrl=On or

0.000 sampler.TempCtrl=On

 Controlling the Temperature
Instruments offering temperature control, e.g. column ovens, coolable
autosamplers (Dionex GINA 50T), electrochemical detectors (Antec DECADE)
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or gas chromatographs (HP5890), can be operated directly from the Dionex
Chromatography Management System if the corresponding device driver
supports this function. The prerequisite is that the  Temperature Control
(On/Off) (How to ...: Device Control) option of the instrument has been
activated via the switch.

Then the temperature of the instrument can be controlled via a corresponding
Control (gauge or edit field) of the Control Panel.

 Note: For this purpose, the control is assigned the property
Temperature. For details, see How to ...: Actions in the
Control Panel   Linking a Control to a Device

Manual Cooling
• Move the slider with the mouse to the desired temperature value.

• Enter the nominal temperature in an edit field.

• A slider can have an additional gauge for the upper and lower temperature
limits. The Dionex Chromatography Management System monitors the set
temperature range.

• Move the mouse cursor over the gauge to view the exact value of the set
temperature.

If an instrument reports that the set temperature value was actually reached
(Ready), this can be indicated via an LED integrated in the control panel (see
How to: ...:  Ready Signal).
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Programmed Cooling
In the Program, the temperature of an instrument can be adjusted as follows:

0.000 TempCtrl = On/Off

; This command activates and
deactivates the temperature
control.

0.000 X.Temperature = Value[°C]

; This command sets the nominal
temperature. X corresponds to
name of the instrument as defined
in the "Server Configuration"
program.

0.000 X.Temperature.UpperLimit = Value[°C]

0.000 X.Temperature.LowerLimit = Value[°C]

; These commands define the upper
and lower limit. The limits are
monitored by the data system.

0.000 Wait SampleTempOK (or
similar)

; The Wait command delays all
further operations on the
instrument until there is a
feedback as soon as the nominal
temperature is actually reached.

 Controlling the Column Temperature
The Dionex Column Oven STH-585 allows controlling the column temperature
in the range between 5°C and 85°C.

Depending on the type of Control (see Layout Toolbar), the current
temperature can be given (alphanumeric display), a new temperature value can
be set (edit field), or an upper and/or a lower temperature limit can be
determined (gauge slider). For details on changing controls, see How to ...:

 Actions in the Control Panel.
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Controlling the column temperature is also possible within the Program. The
corresponding commands are:

0.000 ColumnOven.Temperature               = Value[°C]

; This command determines the
nominal temperature.

0.000 ColumnOven.Temperature.UpperLimit    = Value[°C]

0.000 ColumnOven.Temperature.LowerLimit    = Value[°C]

; These commands determine the
upper and lower limits. The
limits are monitored by the data
system.

Control - Special Commands, Relays, and
Others
In addition, the Dionex Chromatography Management System makes some
special commands available (see the following pages):

 Virtual Channel Commands
 Trigger Commands
 Mixed Commands

For information on relays, see

 Relay and Remote Input Commands

 Switching a Relay
For additional general hints on controlling instruments, see

 Device Successfully Connected

 Ready Signal
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 Virtual Channel Commands

Changing the Sampling Step for Data Acquisition

0.000 VirtualChannel_01.SamplingStep = Value [sec]

Default setting: SamplingStep = 0.1 sec. The input must be between 0.01 and
10 seconds.

 Note: The SamplingStep defines the time step after which the virtual
channel driver (= VCD) re-evaluates the expressions assigned to
the channels. Only after re-evaluation will changes to the terms
in the expression take effect on the virtual channel signal.
Choosing a small sampling step allows recording changes more
precisely. However, this will increase the workload of the
processor and will slow down your computer.

Changing the Time Lag Threshold

0.000 VirtualChannel_01.LagThreshold = Value [sec]

Default setting: LagThreshold = 0.01 s. The value should be between 0.001
and 100 seconds.

 Note: The Virtual Channel Driver (VCD) keeps the channel time
deviation (number of generated data points multiplied by the
SamplingStep) from the actually passed time as small as
possible. Comparing the two values performs this task. If the
difference exceeds or falls below the time interval defined by
LagThreshold, an additional data point is interpolated or a data
point is omitted to approximate the channel time to the real time.
With a larger interval, less data is falsified, but the time deviation
increases (especially in the case of very long data acquisition
periods!).

All channels of a Virtual Channel Driver have the same sampling and
monitoring rate. Differing sampling and monitoring rates can only be defined if
two or more Virtual Channel Drivers are installed.
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Changing the Channel Type
To optimize signal recording, the VCD offers the possibility to assign each
virtual channel a type. Three types are currently defined (see  Installing the
Virtual Channel Driver: Channel Types:

0.000 VirtualChannel_01.Type = Analog, Digital or Fixed

Analog Suitable for expressions that are composed of
other analog signals.

e.g.: UV_VIS_1/UV_VIS_2

Digital Suitable for digital expressions. P580Relay_1.State AND
P580Relay_2.State

Fixed Suitable for expressions that change slowly. Pump.%A

The type selection affects the settings of Step, MaxAutoStep, and Average of
the corresponding signal as well as the selection of appropriate raw data
compression. In the case of the standard compressor, these three parameters
have the same significance as with normal signal channels. For the step
compressor, the values have no significance as this compressor always uses a
fixed step of 0.01s. The default values are as follows:

Step MaxAutoStep Average Compression
Analog Auto 5.1s On Standard compressor
Digital Fixed, 0.01s Special compressor for step

signals
Fixed Fixed, 0.01s 5.1s Off Standard compressor

In the case of analog or fixed channels, the values for Step, MaxAutoStep,
and Average can be changed after selecting the type. In the case of a fixed
channel, it makes sense to set the step rate identical to the SamplingStep.
This ensures that the compressor will only record the originally sampled data
points.

Use the Formula command to specify the expression to record. The same
expressions as for ⇒Trigger conditions are possible, i.e., arithmetic and logical
links. The expression must be numeric. During the program execution, the last
calculated value of the expression is stated in the property FormulaCur
(changes after each SamplingStep). FormulaMin and FormulaMax define the
minimum and maximum values resulting from the expression.
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Similar to other signal channels, the current (or interpolated) signal value can
be viewed via the property Value (changes every 0.01s)

The property Equate allows to enter a user-defined name for the virtual
channel during the analysis. This name can be included in the Audit Trail via
the system command Log.

During data acquisition, it is not possible to change the properties Step,
MaxAutoStep, Average, Formula, and Type. The FormulaMin,
FormulaMax, and FormulaCur properties indicate the status.

 Program Examples for Virtual Channels

Sum of two channels (Analog Signals)
The sum of two UV channels should be recorded as a virtual channel. As this
steady signal is likely to change frequently, the virtual channel should have the
type analog. Using the default settings, this channel is recorded as precisely as
the two UV channels:

0.000 Pressure.LowerLimit = 0

Pressure.UpperLimit = 400

Inject

VirtualChannel_01.Formula UV_VIS_1+UV_VIS_2

VirtualChannel_01.Type = Analog

UV_VIS_1.AcqOn

UV_VIS_2.AcqOn

VirtualChannel_01.AcqOn

2.000 UV_VIS_1.AcqOff

UV_VIS_2.AcqOff

VirtualChannel_01.AcqOff
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Relay Status (Digital Signals)
The status of a relay should be recorded as a virtual channel. For this rectangle
signal, using the virtual channel of the type digital is recommended:
0.000 Pressure.LowerLimit = 0

Pressure.UpperLimit = 400

Inject

VirtualChannel_01.Formula P580_Relay1.State

VirtualChannel_01.Type = Digital

VirtualChannel_01.AcqOn

0.000 P580_Relay1.On

0.100 P580_Relay1.Off

0.200 P580_Relay1.On

0.300 P580_Relay1.Off

0.400 P580_Relay1.On

0.500 P580_Relay1.Off

0.600 P580_Relay1.On

0.700 P580_Relay1.Off

0.800 P580_Relay1.On

0.900 P580_Relay1.Off

1.000 P580_Relay1.Off

1.000 VirtualChannel_01.AcqOff

Recording a Gradient (Slow Signals)
The currently set gradient should be recorded as a virtual channel. As this
steady signal is unlikely to change frequently, a virtual channel of the type
Fixed is recommended. It is sufficient to record the current value once per
second:
0.000 Pressure.LowerLimit = 0

Pressure.UpperLimit = 400

Inject

Flow = 10

%B = 100

VirtualChannel_01.Formula Pump.%B

VirtualChannel_01.Type = Fixed

VirtualChannel_01.Step = 1

VirtualChannel_01.AcqOn

0.500 %B = 100

1.000 %B = 50

1.500 %B = 50

2.000 %B = 0

2.000 VirtualChannel_01.AcqOff
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Correcting a signal from a radioactive substance:
To determine the concentration of a radioactive substance, the decay of the
substance must be taken into account and the signal corrected accordingly.
The VCD allows you to solve this problem as follows:

In the example below
• The half-life is t½ min

• The run time of the chromatogram is tl min

• The uncorrected signal (UV_VIS_1) is between - 10.000 and 10.000 mAU,

0.000 Pressure.LowerLimit = 0

Pressure.UpperLimit = 400

Inject

VirtualChannel_01.Formula UV_VIS_1 / 2.718**

(-0.69314718* System.Retention /t½)

VirtualChannel_01.FormulaMin = -10000 / 2.718**

(-0.69314718* tl /t½)

VirtualChannel_01.FormulaMax = 10000 / 2.718**

(-0.69314718* tl /t½)

VirtualChannel_01.Type = Analog

UV_VIS_1.AcqOn

VirtualChannel_01.AcqOn

tl UV_VIS_1.AcqOff

VirtualChannel_01.AcqOff

In each case, enter into the program the actual half-life instead of t½. In
addition, enter the actual run time of your program with three decimal points for
tl.
When the program is modified accordingly, the virtual channel records the
signal that would be measured by the detector if the radioactive decay were
stopped with the injection into the chromatography system. The decay that
occurred before the injection will not be corrected.

 Note: If you know the signal area to be expected for your
chromatogram (in the example for the channel UV_VIS_1) you
may enter this value instead of -10,000 and 10,000 for
calculating FormulaMin/Max to map your chromatogram more
precisely.
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 Trigger Commands

 Note: The trigger name must be unique, i.e. no triggers by the same
name can be used, nor device, relay or signal names that were
already assigned. The same trigger can initiate any number of
reactions. The reactions of the trigger list are not supplied with
time information. The trigger must always be completed by an
EndTrigger command, e.g.:

0.000 Trigger <NAME> Condition= [Value](Operator)[Value]
,OperatorValue,True=Value[sec]
,Delay=Value[sec],Limit=Number

Reaction 1 =Value/Status

... ...

Reaction n =Value/Status

EndTrigger

If a trigger condition consists of several values, operators can combine them.
Available operators are +, -, *, /, AND, OR, NOT. The Trigger condition is
fulfilled if the corresponding value is reached, not reached, or exceeded. This is
indicated by the operators <, >, <=, >=, = and <>. Any dependence on various
values can be realized via parentheses.

If the value is preceded by the name DELTA, the slope, i.e. the first derivation,
is processed as the trigger condition. Remote input signals or relay states can
also be processed.

 Note: Due to lack of space, line breaks are inserted here. Normally,
one command must be entered in one line. For a detailed
description of the Trigger command, see ⇒Trigger in the
Reference Manual section.

Example 1: Peak Recognition via Absolute Value

0.000 Trigger EXAMPLE1 UV_VIS_1>100,True=1,Delay=5,Limit=4

Sound File="TEST.WAV"

... ...

RELAYNAME =On

EndTrigger
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Description: The trigger with the Trigger Name EXAMPLE1 monitors the
channel UV_VIS_1. If the signal exceeds the value 100 for more than 1 second
((Trigger-) True), the Audio file TEST.WAV is played after a (Trigger-) Delay of
5 seconds (if no sound card is installed in the PC, there is a short Beep
instead). At the same time, the relay RELAYNAME is switched on.

The entire process, i.e., exceeding the signal value 100 of channel UV_VIS_1
with a subsequent reaction, is limited to 4 times (Limit=4). If the condition
(Trigger-) Limit is not entered, the process is always repeated, as soon as...

Example 2: Peak Recognition via Slope

0.000 Trigger EXAMPLE2 UV_VIS_1.DELTA>1

Sound File="TEST.WAV"

EndTrigger

Description: The trigger EXAMPLE2 monitors the channel UV_VIS_1. At a
slope value (DELTA) above 1, the Audio file TEST.WAV is played. If no sound
card is installed in the PC, there is a short beep instead.

Example 3: AND, OR, NOT

0.000 Trigger EXAMPLE3 ((UV_VIS_1>100) AND (UV_VIS_2>100) OR
(UV_VIS_3>200)) AND NOT REMOTE1

Sound File="TEST.WAV"

EndTrigger

Description: The EXAMPLE3 trigger monitors the UV_VIS_1, UV_VIS_2, and
UV_VIS_3 channels as well as the REMOTE1 remote input. If the channels 1
and 2 simultaneously (AND) exceed the value 100, or (OR) if the channel
UV_VIS_3 exceeds the value 200 and if the remote input REMOTE1 delivers
no signal (AND NOT) at the same time, the TEST.WAV Audio file is played
(without a sound card, there is a short beep instead).

Example 4: Further parameters that can be triggered

0.000 Trigger EXAMPLE4 Pressure.LowerLimit<20 OR
Pressure.UpperLimit>300 OR
Temperature>60

AbortBatch

EndTrigger

Description: The trigger EXAMPLE4 monitors the pump pressure and the
temperature of the column oven. If the pressure falls below 20 bar or exceeds
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300 bar, or if temperature exceeds 60°C, the running sample batch is aborted
(Abort Batch).

Example 5: Fraction Collector FoxiJr.

FoxiJr.Valve = Off ; switches the valve of the
Fraction Collector  to the "Waste"

position

0.000 Trigger PEAKSTART FoxiJr.Valve = 0 AND

UV_VIS_1.Delta >1, True = 2

FoxiJr.Valve = On ; switches the valve to the
"Collect" position

EndTrigger

Trigger TUBEFULL FoxiJr.Valve = 1,True = 60

Protocol "Tube full"

FoxiJr.Valve = Off

EndTrigger

Trigger PEAKEND FoxiJr.Valve = 1 AND

UV_VIS_1.Delta > -1,

True = 2, Delay = 5

FoxiJr.Valve = Off ; switches the valve to the "waste"
position

FoxiJr.Tube = FoxiJr.Tube +1

EndTrigger

Description: The PEAKSTART trigger causes the valve to switch to the Collect
position if the valve is previously in the Waste position and if the slope of the
UV_VIS_1 channel exceeds the value 1 for more than 2 seconds (True). After
60 seconds, the trigger TUBEFULL ensures that the collection container does
not overflow. The valve is switched again (back to the Waste position). For
larger collection containers, the time can be adjusted as needed. If the signal is
below the slope value -1 for more than 2 seconds, and if the valve is still in the
Collect position, this is interpreted as the end of the peak. After a delay of 5
seconds, the valve is switched to the Waste position. Simultaneously, the x/y-
arm of the fraction collector is moved by one position (FoxiJr.Tube =
FoxiJr.Tube +1).
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Also, see

 Controlling Fraction Collection

 Fraction Collection - Program Example

 Mixed Commands

Produce Sound

0.000 Sound File="TEST.WAV"

For details, see ⇒Sound command.

Temperature Regulation for Column Oven

0.000 Temperature.Nominal =Value [°C] (nominal value)

In combination with a ⇒Trigger condition, the actual value can also be
inquired:

0.000 Trigger OVENTEST Condition=Temperature>50[°C]

Sound File="TEST.WAV"

EndTrigger

Description: The trigger OVENTEST monitors the current oven temperature.
Each time, the temperature exceeds 50 °C, the Audio file TEST.WAV is played.
If the PC has no sound card, there is a short beep.

Comments, Protocol and Message Texts

; Comment Text...

0.000 Protocol "Text ..."

0.000 Message "Text ..."

 Note: Comments can be added to any program instruction via " ; ".
They can easily be recognized by their green color. Protocol and
message texts must be indicated by quotation marks ("Text...")!
Both are included in the Audit Trail. While the ⇒Protocol
command serves for documentation purposes only, the
⇒Message text appears on the screen. Continuation of the
program is only possible after confirming with the Enter key.
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Example 6: Delayed Execution of the Inject Command ("Wait")

0.000 Acquisition =On

0.000 Wait UV_VIS_1 < 10

0.000 Inject

Description: Program execution is delayed until the absorption on channel
UV_VIS_1 is below 10 mAU. As soon as this is the case, injection is started.

The Wait command is also required for Suck and Dispense operations of the
Dionex Autosamplers GINA 50 and GINA160 (see How to ...: Device Control

 Control - Autosamplers).

 Relay and Remote Input Commands

Activate / Deactivate Relays

0.000 RELAYNAME.State =On / Off

Alternatively, the following short command is valid:

0.000 RELAYNAME.On

0.000 RELAYNAME.Off

Activate / Deactivate Relay for a specific duration

0.000 RELAYNAME.On =Value[sec]

0.000 RELAYNAME.Duration =Value[sec]

Alternatively, the following short command is valid:

0.000 RELAYNAME.On Duration= Value[sec]  or

0.000 RELAYNAME.Off Duration= Value[sec]
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 Switching a Relay
Every Relay can be integrated as a simple switch in the control panel
interface. The two switch settings correspond to the relay states On and Off. In
addition, Controls in the Control Panel are linked to State. Each relay can
be executed with a time relay, using the Duration parameter.

If a 3-way-valve is integrated in the fluidics at the detector output, two switch
states can be controlled via an internal device relay (e.g. the Dionex Pump
M480).

• In the Server Configuration, double-click the respective instrument to
open its Property dialog box and choose Relays.

• Activate a currently free device relay and choose OK.

• Save the new Server Configuration.

• In the control panel, any switch can be linked to the new relay function
(Object=Relayname, Object Property=State). See How to ...: Actions in
the Control Panel  Linking a Control to a Device.

• If necessary, create an additional control, e.g. an edit field (see Layout
Toolbar), to set the on/off duration of the valve.

In the Program the switch procedure of a relay can be realized via the
following commands:

0.000 RELAYNAME.State =On/Off

0.000 RELAYNAME.Duration =Value[sec]

 Device Successfully Connected
Many devices automatically inform the Dionex Chromatography Management
System of their current status, i.e. they communicate whether they were
successfully integrated in a system or not.

This signal can be made visible on the Control Panel, e.g. via an LED or color
area integrated in the control panel (see Layout Toolbar).
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• Link the corresponding Control via the Link tab dialog box to the object
property Connected (for details, see How to ...: Actions in the Control
Panel   Linking a Control to a Device).

If the LED or the color area is active, the device was successfully integrated
into the system. In this state, it can be operated from the PC via the data
system.

 Ready Signal
If an instrument supplies a feedback (Ready signal) when reaching a nominal
(set) value, this can be indicated via the corresponding Control on the control
panel (LED or color box).

Ready signals are sent by column ovens, coolable autosamplers,
electrochemical detectors (Antec DECADE), or gas chromatographs (HP5890;
FISONS 8000).

With the coolable Dionex Autosampler GINA 50T, the SampleTempOK signal
is sent instead of the Ready signal.

Using Keyboard Shortcuts
Many operations, especially in Online Control, can be performed via shortcuts.

Action Where Reaction
General Esc or

right mouse
button

Aborts Drag/Move

F1
F2

Opens the context-sensitive help;
activates the Edit mode

Alt+Enter Browser +
Control Panels

Opens the respective Properties

Ctrl + Tab Toggles between open windows
Ctrl Signal plot in the

Report and in the
QNT Editor

For zooming (changes the
cursors to the zoom cursor)

Edit Ctrl. + X
Ctrl. + C
Ctrl. + V
F9

Cut
Copy
Paste
Fills the column / selected cell(s)
with the first value of the selection
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Action Where Reaction
Control Ctrl. + F

Ctrl. + I
Ctrl. + Break
Pause
Ctrl. + A
Ctrl. + B

Flow Command
Inject
Pump Stop
Hold Mode
Data Acquisition On
Edit Batch

Signal plot Double-click... - Overview window
- Time axis
- Signal axis
- Plot range
(- otherwise:...)

Unzoom
Auto Plot Speed
Autoscale
Signals...
Axis/Decoration

Shift - when Zooming Retains scale ratio between
signal and value axis (i.e., the
shape of chromatograms is
maintained)

Gauge/Slider Ctrl.-key Press when
dragging

Toggles the Snap To Scale
option

Command
Button

Click Pressed button Indicates running program. Stops
program upon confirmation.

Edit Field Tab/Enter Sends the new value
Esc Aborts entry

Layout Mode Alt+Click In selected panel Draws selection frame within the
panel

Alt+Drag: Temporarily toggles the Snap To
Grid option

ESC Deselect all
Arrow keys Drag selection pixel by pixel
Shift +
Arrow keys

Increase/reduce selection pixel by
pixel

Shift +
Select

Extend Selection

Ctrl+Select Highlight selected control (the
highlighted control is used in
Align...)

Ctrl+Drag Copies controls
Double click In the Online Signal

Plot of the panel
Opens Properties...
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Installation Instructions
Installation Instructions
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Introduction
The Dionex Chromatography Management System allows connecting the most
diverse HPLC instruments and gas chromatographs.

Upgrading the server PC by installing additional PC plug-in boards may be
necessary, e.g. when the number of serial PC ports is not sufficient. However,
you can also use the UCI-100 Universal Chromatography Interface. For a
detailed description on the installation and configuration procedures for the
additional plug-in boards that are available from Dionex and for the UCI-100,
see  Installing PC Plug-in Boards / Interfaces.

In addition to Dionex instruments, the Dionex Chromatography Management
System supports controlling a number of instruments from other manufacturers
(= third-party instruments). For a list of the supported instruments and
information on their installation, see  Installing and Controlling Third-Party
Instruments. Nevertheless, knowing the corresponding device manual is
required!

 Tip: As not all instruments provide optimum suitability for direct
control, it is possible that not all functions offered by the
instrument can be supported!

Enabling third-party instrument control is via three steps:

 Establishing a Serial Connection between the Server PC and the
     Third-Party Instrument

 Switching the Third-Party Instrument to Remote Operation
 Installing the Appropriate Device Driver in the Dionex Server

    Configuration

The last topic also applies to some of the Sharable Devices (e.g.  A/D
Converter,  Pump Control Board, and  Dionex Universal
Chromatography Interface (UCI-100)!

 Establishing a Serial Connection Between the Server PC
    and the Third-Party Instrument
For direct control, the third-party instrument must have a serial port. This port is
then connected to the serial PC port (COM port) via a serial interface cable.
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If the cable for a specific instrument has a special pin assignment, this will be
described in detail under  Cable and Pin Assignments.

 Switching the Third-Party Instrument to Remote
    Operation

The  Installing and Controlling Third-Party Instruments section usually
provides information on the required steps for setting DIP-switches and
jumpers, command input via the instrument keypad, or setting the
communication parameters on the instrument. If you do not find specific
information in the section on your instrument, you can use the default settings.

 Installing the Appropriate Device Driver in the Dionex
    Server Configuration
Proceed as follows to load a third-party device driver:
• Start the server that should control the third-party instrument.

• Start the Server Configuration program of the Dionex Chromatography
Management System.

• Click the required server in the Server Configuration and expand the
installation tree structure by clicking the + sign.

 Note: If this is not possible and the server is labeled with a red Stop
sign, there is no connection between the server and the Server
Configuration. In this case, choose the Connect to Remote
Computer command in the Server menu.
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• Click the timebase to which to assign the third-party instrument.

• Choose Add Device... via the Edit menu or the context menu.

• Choose the required instrument from the list of supported instruments.

 Note: If the desired third-party instrument is not included in the list, the
required device driver cannot be found in the BIN directory of
your Dionex Chromatography Management System installation.
Please ask the Dionex Service for the appropriate device driver.

• Click OK.

• A dialog box with several tabs for configuring the selected instrument
appears.

• Via the General tab, define the instrument name to appear in the Dionex
Chromatography Management System (Device name), and also the port
and the communications parameters (baud rate, data bits, stop bits, parity)
to be used. These parameter settings must correspond to the settings on
the instrument itself!

• All other configuration options depend on the functionality offered by the
third-party instrument. Detectors have a Signal tab for selecting various
channels, pumps, and autosamplers usually offer the possibility to choose
from several pump or rack types.

Press the F1 key or the Help button to view instrument and type-specific
information on the available settings.
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Installing PC Plug-In Boards / Interfaces
The Dionex Chromatography Management System supports several PC plug-in
boards and interfaces, which are mainly operated as Sharable Devices. For
information on how to install the different PC plug-in boards and interfaces, see
the following pages:

1. PC plug-in boards and interfaces with separate drivers that can be installed
as Sharable Devices:

 A/D Converter ("16 Chl. A/D Converter")

 Universal Chromatography Interface ("UCI-100 Interface")

 Pump Control Board

 16-Relays Boards ME63 (ISA) and ME630 (PCI)

 Digital I/O-Boards ME14 (ISA) and ME1400 (PCI)

 16-Bit DAC Board "DAC340" ("PDA DA Converter (16 Bit)")

 12-Bit DAC Board ("Pump DA Converter")

 DX-LAN ("LAN Card")

2. PC plug-in boards without separate drivers that cannot be installed as
Sharable Devices:

 M68 - PC Interface Board for the UVD 340

 Serial ISA Interface Board

 Serial PCI Interface Board (Vscom)

 Serial PCI Interface Board (Equinox)
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Installing the A/D Converter ("16 Chl. A/D Converter")

In the following, we assume that you already have removed the  A/D
Converter from your computer. Place the new A/D Converter on a clean and
dry surface, with the modules pointing upward. See the figure below for a
schematic representation.

Position the board as indicated in the figure, using the block with the eight
switches for setting the I/O-address as a guideline. Proper installation is in
three steps:

 Selecting an I/O-Address
 Setting the Base Address
 Selecting an Appropriate Slot

 Caution: Use a ballpoint pen to set the switch. Do not use a pencil, as
graphite particles could cause a short circuit in the switch.

The board is then ready for recording and processing analog or digital signals.

Also, see:

 Pin Assignment on the A/D Board Connector and Cable Connection
 Shielded Cables
 Analog Inputs
 Remote Inputs

In the Edit menu of the Server Configuration, select the driver Dionex A/D
Converter via Add Sharable Devices ( Server Configuration). Establish
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and assign the port address and the channels on the General page (link
available in the Online Help only).

 Selecting the I/O-Address
The A/D Converter is fitted with a 8-fold DIP-switch. Setting the switch
determines which I/O-address (port address) in the PC’s address space is used
for controlling the A/D board. The default setting can be used in most cases.

Should the default address collide with that of an additional board (e.g. a
network interface board), you must set a new address. This procedure is
described in the following. If an address modification is not necessary, skip this
section and continue with the section: Selecting an appropriate slot.

Also, see:  Setting the Base Address

 Setting the Base Address
On MS-DOS computers, up to 1024 I/O-addresses are available (represented
by 10 binary digits (Bits)). Among these 1024 addresses, sufficient I/O-
addresses are available for the A/D Converter, even if your computer
contains other boards. The board requires four consecutive I/O-addresses.
From 10 bits, only the higher eight bits must be coded via the switches. With
the switch block, the first (=base address) of the four required addresses is set.
The following table shows the allocation of the eight switches to the binary
digits.

Digit Switch Default Meaning
1 - - Not coded
2 - - Not coded
3 1 OFF 4-digit
4 2 ON 8-digit
5 3 OFF 16-digit
6 4 ON 32-digit
7 5 ON 64-digit
8 6 ON 128-digit
9 7 OFF 256-digit

10 8 OFF 512-digit

An open switch (OFF) corresponds to a binary 1; a closed switch (ON)
corresponds to a binary 0. The default setting on the A/D board corresponds to
the following base address:
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4 + 16 + 256 + 512 = 788 (decimal) = 314H (hexadecimal).
If you use the default settings, the A/D board uses the I/O-addresses 788, 789,
790, and 791 (decimal) or 314H, 315H, 316H, and 317H (hexadecimal) of the
I/O-address range of your PC. Any other board in the PC may not use these
addresses. If another board (e.g. a network interface board) already uses one
of the addresses, a different address must be set. Try one of the following
settings:

Base Address Switch
hex: 300H (dec: 768) 1 2 3 4 5 6 7 8

ON ON ON ON ON ON OFF OFF
hex: 310H (dec: 784) 1 2 3 4 5 6 7 8

ON ON OFF ON ON ON OFF OFF
hex: 320H (dec: 800) 1 2 3 4 5 6 7 8

ON ON ON OFF ON ON OFF OFF
hex: 330H (dec: 816) 1 2 3 4 5 6 7 8

ON ON OFF OFF ON ON OFF OFF
hex: 340H (dec: 832) 1 2 3 4 5 6 7 8

ON ON ON ON OFF ON OFF OFF
hex: 360H (dec: 864) 1 2 3 4 5 6 7 8

ON ON ON OFF OFF ON OFF OFF

If your technical documents do not specify whether another board already uses
the address on the A/D board, it is within your responsibility to use the
presetting and to proceed with the following steps:

 Caution: An I/O-address conflict usually has no serious consequences.
Nevertheless, a short circuit on the bus resulting from an
address conflict may destroy components on one of the two
boards. This is especially true for very cheap or old boards.

After setting the switches, you can install the board in your computer.

 Tip: Make a note of the current base I/O-address setting of the A/D
board, as it is required for configuring the A/D board driver in the
Server Configuration.
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 Selecting an Appropriate Slot
The A/D Converter is a highly sensitive board that allows measuring voltages
in the microvolt range. However, some of the available PC boards may
interfere with the A/D board, as they radiate highly electromagnetic fields due
to digital currents with high frequency. When starting the device driver for the
A/D board, a message appears stating that the self-test was not successful. It
is therefore recommended to select a slot that is as far away as possible from
these strongly radiating boards. When you have selected a convenient slot,
proceed as follows:

Remove the power and other cables, and open the computer! Refer to the
Installation manual for your computer.

Select a free 8-bit- (short) or 16-bit-slot (long) in your computer.

Remove the cover plate on the back end of the slot. Keep the screw for later
use. Now remove the protective cover.

 Caution: By static charging, modules on the A/D board may be destroyed.
The risk of suffering static charging is especially high when the
floor is of a well insulating material (e.g. most carpets). The risk
is even higher when the air is very dry (e.g. in the winter when
the heating is on) and when wearing well insulating shoes (e.g.
shoes with rubber or plastic soles). In these cases, persons can
be charged with high electric voltages when walking around.
Electronic components could be damaged if touched. Divert
static charging by touching the grounded computer housing with
your hand before touching electronic components or the A/D
Converter. Before standing up and walking around, discharge
yourself in the same way before touching electronic components.

Align the A/D board exactly above the selected slot. Ensure that the board
slides into the guide rails with the end opposite to the connector. Insert the
board until it catches. If it touches the bottom, ensure that the gilded board
connector points directly to the PC slot connector (slightly tilt the board to the
sides, as necessary). Then, carefully insert the board.

Now, fasten the metal plate of the A/D board as tight as the cover plate was
before.

After you have replaced the computer housing, you can connect the analog
and remote (digital) inputs of the board to your system.

 Pin Assignment on the A/D Converter Connector / Cable
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    Connection
The A/D Converter is fitted with a commonly used DIN 41612 connector (DIN
= German Industry Standard). It has three vertical columns each comprising 32
contacts. The distance between the contacts is 0.1 inch. Viewing the contact
pins of the connector from the rear of the computer, the right column is column
a, the middle one column b, and the left column is c. The upper contact
corresponds to contact 1, the lower to contact 32.

c1 Channel 1 High
c2 GND
...
...
c15 Channel 8 High
c16 GND
c17 Channel 16
High
c18 GND
...
...
c31 Channel 9 High
c32 GND

b1 Channel 1 Dig. Inp.
b2 GND
...
...
b15 Channel 8 Dig.Inp.
b16 GND
b17 Channel 16
Dig.Inp.
b18 GND
...
...
b31 Channel 9 Dig.Inp.
b32 GND

a1 Channel 1 Low
a2 GND
...
...
a15 Channel 8 Low
a16 GND
a17 Channel 16
Low
a18 GND
...
...
a31 Channel 9 Low
a32 GND

Connect the connector with the cables pointing downwards to the
corresponding position:

As the positions are not defined, connect a single cable to the top position (i.e.
from channel 1 to 4). If required, additional cables can be connected below.
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 Analog Inputs
The analog inputs of the A/D Converter are designed for an input voltage of -
10 up to +10V. Most chromatographic detectors yield a maximum voltage at
their integrator outputs, of 1V or 2V nominally. The input range of the A/D
board, therefore, is not utilized fully. Due to its automatic signal amplification,
however, it yields highly resolved measuring values.

Since the inputs of the A/D board are designed as differential inputs, ripple
voltage, as caused by the fields of the electric power supply, is inhibited, i.e.,
input signals are not connected between Ground (GND) and High at the A/D
board connector, but between High and Low. However, the potential at the high
input as well as at the low input must remain between -10V and +10V at any
time with relation to ground. In order to ensure that the ground of the signal
source (HPLC detector) and the ground of the A/D board have a continuous
level of good quality, it is necessary to have a separate ground line between
the ground connection at the signal source and the GND connection at the
A/D converter. In case a detector has several channels that are to be
connected to the A/D board, it is not necessary to have a separate ground line
for each of these channels. The correct connection of the high and low line is
sufficient for further channels. However, if a further detector is to be connected
to the A/D board, the ground of this detector must be connected to the ground
of the A/D board via a separate ground line.

 Shielded Cables
When using shielded cables, the shield may only be connected to one end of
the cable. If the signal source output is grounded, as is the case with most
HPLC instruments, the shield ought to be connected to the ground of the HPLC
instrument. The cables delivered by Dionex are screened. We recommend
using only these.

 Remote Inputs
In order to enable a reaction to external events (such as sample injection), the

A/D Converter is supplied with remote (digital) inputs. These remote inputs
are designed for an input voltage between 0 and +5V (TTL level). If a higher
voltage is applied, this may cause a malfunction of the microprocessor on the
A/D board, damage to the input elements for the digital signals, or more serious
damage.

Without an externally connected voltage source, internal board resistors keep
the remote input level at +5V (pull-up resistance). Therefore, it is possible to
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use a contact closure relay, without an additional voltage source. This closure
has to be between GND and the respective remote input. Once the relay is
shut, the digital voltage is grounded. The relay itself is under a low current of
about 1mA. In case the signal source itself is active, i.e. emitting voltage, the
polarization of the remote input must be correct: The ground of the signal
source must be connected to the ground of the A/D board and the digital output
of the signal source must be connected to the remote input of the A/D board.

Installing the Universal Chromatography Interface ("UCI-
100 Interface")

The instrument is connected to the power supply via a primary clocked
standard power unit offering a "wide range" input (auto-sensing) so no
adjustment is required to select the voltage according to country-specific
requirements.

The UCI 100 Universal Chromatography Interface is equipped with eight
analog inputs, 8 (digital) Remote Inputs, eight digital outputs (relay outputs),
plus BCD inputs for the sample position. Additionally, four RS232 ports are
available.

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! WINDOWS NT4 computers do not support USB. Thus,
if LAN connections are required, additional Equinox boards must
be used for instrument control via RS232. We recommend using
a peer-to-peer connection for analog data acquisition via LAN
(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC - see

 Connecting the UCI-100 via a Peer-to-Peer Connection
under WINDOWS NT4).

 Tip: Controlling GILSON instrumentation via the RS232 ports of the
 Dionex Universal Chromatography Interface (UCI-100) is

not supported. Connect the GSIOC adapter to the multi-serial
PCI interface board (Equinox) instead.

In addition to their analog inputs, the eight analog connectors provide one
digital output (potential-free relay contact) and one digital input each.

Via the eight digital inputs, the data system is informed on external events such
as the injection of a sample. They are distributed to the individual analog
connectors but are also available all together in one separate socket.
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The relay outputs allow potential-free switching of external signals. The sample
position is available in the commonly used BCD format. Control of external
devices such as pumps, detectors, and autosamplers is via the RS232 ports.
Data transmission between the UCI-100 Universal Chromatography Interface
and the Dionex Chromatography Management System is via either the inbuilt
USB interface or LAN interface (Ethernet).

For detailed information on the pin assignments of the analog, digital, and BCD
inputs as well as the RS232 ports, see  Pin Assignments. The USB and
Ethernet interfaces correspond to their respective standards.

 Caution: Wrong polarity (remote inputs) and input voltages outside the
valid range can cause damage to the unit.

See the following sections for information on hardware installation and
installation under Windows:

 Hardware Installation

 Installation under Windows
To use the UCI-100 under the Dionex Chromatography Management System,
the Dionex UCI-100 Universal Chromatography Interface must be installed
via Add Sharable Devices in the Server Configuration program. For
details, see  Adding the UCI-100 to the Server Configuration.

For operating the UCI-100 Universal Chromatography Interface in the network,
you have to configure an IP address as well as the corresponding subnet
mask. For further details, see

 Configuring the UCI-100 for Network Operation (CMIPUTIL)
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 Pin Assignments
For information on the pin assignment of the individual connectors, see the
tables below:

RS232 Ports
The pin assignment for the 9-pin D-SUB connector (male) is indicated in the
table below. The pin numbers correspond to the numbers given on the
connector.
Pin Signal Name Signal Level Remark
   1 DTR
   2 RX RS232
   3 TX RS232
   4 DCD
   5 GND GND
   6 Not used
   7 CTS RS232
   8 RTS RS232
   9 Not used

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! WINDOWS NT4 computers do not support USB. Thus,
if LAN connections are required, additional Equinox boards must
be used for instrument control via RS232. We recommend using
a peer-to-peer connection for analog data acquisition via LAN
(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC - see

 Connecting the UCI-100 via a Peer-to-Peer Connection
under WINDOWS NT4).

Digital Inputs

The pin assignment for the 9-pin D-SUB connector (female) is indicated in the
table below. The pin numbers correspond to the numbers given on the socket.
Pin Signal Name Signal Level
   1 Digital Input 1 TTL
   2 Digital Input 2 TTL
   3 Digital Input 3 TTL
   4 Digital Input 4 TTL
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Pin Signal Name Signal Level
   5 Digital Input 5 TTL
   6 Digital Input 6 TTL
   7 Digital Input 7 TTL
   8 Digital Input 8 TTL
   9 Digital Ground GND

BCD Input
The pin assignment for the 25-pin D-SUB connector (female) is indicated in the
table below. The pin numbers correspond to the numbers given on the socket.
If the marked wire of a flat ribbon is connected to pin no. 1 of the female
connector, the numbering within the flat ribbon will be as follows:
Pin Wire Signal Name Signal Level
     1      1 BCD-1A TTL
     2      3 BCD-1B TTL
     3      5 BCD-1C TTL
     4      7 BCD-1D TTL
     5      9 GND GND
     6    11 BCD-2A TTL
     7    13 BCD-2B TTL
     8    15 BCD-2C TTL
     9    17 BCD-2D TTL
   10    19 GND GND
   11    21 GND GND
   12    23 GND GND
   13    25 GND GND
   14      2 BCD-3A TTL
   15      4 BCD-3B TTL
   16      6 BCD-3C TTL
   17      8 BCD-3D TTL
   18    10 GND GND
   19    12 BCD-4A TTL
   20    14 BCD-4B TTL
   21    16 BCD-4C TTL
   22    18 BCD-4D TTL
   23    20 GND GND
   24    22 GND GND
   25    24 GND GND
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 Tip: Internal device resistors keep the levels of the digital and the
BCD inputs at + 5 V (pull-up resistance). Therefore, it is possible
to use a contact closure relay, without an additional voltage
source. This closure has to be between GND and the respective
digital or BCD input. Once the relay is shut, the digital voltage is
grounded.

The relay itself is under a low current of about 50 µA. In case the
signal source itself is active, i.e. emitting voltage, ensure the
correct polarization of the digital input (BCD input, respectively).
The ground of the signal source must be connected to the
ground of the UCI-100 Universal Chromatography Interface
and the digital output (BCD output, respectively) of the signal
source must be connected to the digital inputs (BCD output,
respectively), of the UCI-100 Universal Chromatography
Interface.

Analog Inputs

The range of the 6-pin analog input is as follows:
Range

Analog LOW ↔ Analog HIGH ± 10 V
Digital Input ↔ Digital GND 0 or +5 V
Digital Out (GND) ↔ Digital Output Turn-on voltage: 100V

switching current: 0,5 A
limiting value of mean on-state current: 1,0 A
rupturing capacity: 10 W/10 VA
forward resistance: max. 150 mOhm
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 Tip: If the UCI-100 Universal Chromatography Interface is connected
to the server of the Dionex Chromatography Management
System via LAN, the equipment grounding of the UCI-100 is
potential free (contrary to a USB connection). With some
detectors, this may affect the analog signal quality. To connect
the equipment grounding of the UCI-100 to the detector
grounding, use the (green) Digital GND wire of the signal cable
and connect it to the corresponding connection to ground of the
detector.

 Hardware Installation
First, connect the instrument to the mains using the power unit, which is
included in the shipment.

Via the two supplied signal cables one analog and one digital signal each can
be sent to the UCI-100 Universal Chromatography Interface. In addition, one
of the eight relay contacts can be connected to an external device. Plug the 6-
pin signal cable connector into one of the inputs on the instrument' rear panel.
Note the wire labels when connecting the individual wires to the desired
components. The ground wire can be connected to the corresponding detector
connector in order to avoid errors in measuring. Additional signal cables (part
no. 8911.0001) are available from Dionex on request. Use the cable labeling
set, which is included in the shipment of the UCI-100 Universal
Chromatography Interface to label the connected signal cables as required.

 Tip: The serial interface of the UCI-100 corresponds to the serial
interface of commercially available PCs. Thus, the same cables
that are used for the connection to the PC can be used for
instrument connection as well. (For details see the operating
instructions for the respective instruments; in case of third-party
instruments, see  Installing and Controlling Third-Party
Instruments). Note that the UCI-100 provides a 9-pin interface
so that a respective adapter might be required.

When using the Digital Input and BCD Input connections see the respective
tables for information on the required pin  Pin Assignments.
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 Tip: The USB connection to the PC or USB hub must not exceed
5 m. Longer connections are possible via a special USB
extension cable (Dionex part no. 8911.0004). Up to five of these
extension cables may be connected in series. Due to system
reasons, the total connection length must not exceed 30 m.

 Installation under Windows

USB Installation
The UCI-100 Universal Chromatography Interface offers the possibility to
exchange data with the server of the Dionex Chromatography Management
System via USB (Universal Serial Bus - that is available on almost all PCs).
This kind of data exchange requires the corresponding USB installation under
Windows. The installation procedure described below refers to Windows 98.
Installing the instrument under Windows 2000 may be slightly different.

Connect the device to the mains and establish the USB connection between
your PC and the UCI-100 Universal Chromatography Interface. As soon as the
USB cable is plugged in, a message appears on the screen saying that the
driver information is loaded. Afterwards, the Hardware Wizard guides you
through installation process. Press Next to confirm the message that the
wizard is searches for new drivers for the UCI-100. On the next page, click the
recommended procedure Search for the best driver for your device and
press Next to proceed to the next page.

If the Dionex Chromatography Management System is already installed on
your PC, the driver will be located in the \Chromel\bin directory by default
(starting with version 6.10). Specify this directory and proceed to the next
wizard page by pressing Next. On this page, the previously selected driver
position is displayed once again. Confirm with Next to continue the installation.

 Tip: In case an error message appears stating that the file
UCI100.SYS could not be found, confirm with OK to repeat the
copy run. The driver will be installed correctly nevertheless.
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Upon termination of the installation procedure, the last wizard page states that
the software has been installed correctly. Press Finish to terminate the
installation. The USB LED on the instrument's front panel illuminates as soon
as the installation is finished correctly.

 Tip: If the USB connection to the UCI-100 Universal Chromatography
Interface is established again, you do not have to repeat the
above installation procedure as your computer will already know
the UCI-100 and the corresponding driver.

LAN Installation
We generally recommend connecting the UCI-100 via USB (Universal Serial
Bus) to the server PC of the Dionex Chromatography Management System. If
this should not be possible (e.g. Windows NT4 does not support USB), a
network connection (LAN) can be used for the communication between the
UCI-100 and the server of the Dionex Chromatography Management System
instead.

To ensure robust communication between the UCI-100 and the server of the
Dionex Chromatography Management System with a LAN connection we
recommend a private network between the UCI-100 and the server PC of the
Dionex Chromatography Management System (a so-called "Peer-to-peer
connection). This type of connection requires a second network card to be
installed in the server PC of the Dionex Chromatography Management System.
For details on how to connect the UCI-100 Universal Chromatography Interface
using a Peer-to-Peer connection under Window NT4, see  Connecting the
UCI-100 via a Peer-to-Peer Connection under WINDOWS NT4).

Dionex will not be able give warranty as to the operation of the UCI-100 in the
Office LAN as the load of the Office LAN is a decisive factor. Overload of the
Office LAN may result in timeouts and data losses and thus disturb the
automatic operation of the Dionex Chromatography Management System.
Therefore, we advise against operating the UCI-100 in the Office LAN.

 Tip: For an Ethernet connection to be established to the UCI-100
Universal Chromatography Interface, assignment of an IP
address and the corresponding subnet mask to the instrument is
required in the CMIPUTIL configuration tool (see:

 Configuring the UCI-100 for Network Operation
(CMIPUTIL)).

 Connecting the UCI-100 via a Peer-to-Peer Connection
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    under WINDOWS NT4
Connection of the UCI-100 Universal Chromatography Interface under
WINDOWS NT4 can be via LAN only. Using a Peer-to-Peer connection
between the UCI-100 and the server of the Dionex Chromatography
Management System allows building up an independent network. This ensures
trouble-free operation even if all analog channels and RS232 channels are
used.

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! WINDOWS NT4 computers do not support USB. Thus,
if LAN connections are required, additional Equinox boards must
be used for instrument control via RS232. We recommend using
a peer-to-peer connection for analog data acquisition via LAN
(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC.)

The connection between the server PC and the UCI-100 is via a so-called
"cross-over" cable, i.e., a special network cable with crossed over data lines.
Usually, these lines are marked by colors (red, yellow) to distinguish the cable
from standard network cables. Thus, the structure of the peer-to-peer
connection is as follows:
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Alternatively, a hub (10Mbit) can be used with standard network cables:

Network Interface Card (NIC)
A LAN connection between the UCI-100 and the server of the Dionex
Chromatography Management System, which is independent from the office
LAN, requires the installation of a second network interface card  (NIC, in the
operating system = adapter) in the server PC of the Dionex Chromatography
Management System. Install the card according to the manufacturer's
instruction via Start => Settings => Control Panel => Network => Adapters =>
Add).
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Configuring the network adapter (here [2] 3Com EtherLink XL NIC (3C905B-
TX)) is on the Bindings tab. First, check via all protocols under Show
Bindings for whether the TCP/IP protocol is installed. Install the TCP/IP
protocol, if necessary:

Then, select all adapters under Show Bindings for and deactivate all
protocols for the peer-to-peer connection except the TCP/IP protocol:
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As the TCP/IP protocol is used for the peer-to-peer card, an IP address and a
subnet mask are required for the second network adapter. Adjust the properties
of the TCP/IP protocol via Start => Settings => Control Panel => Network =>
Protocols. Select TCP/IP protocol, right-click and select Properties... .

 Caution: In the Adapter field, select the network interface card for the
peer-to-peer connection. The settings for the office LAN network
interface card must not be changed.

 Caution: For the peer-to-peer adapter, deactivate all other network
protocols and services (see above).

The network adapter for the peer-to-peer connection must have a fixed IP
address assigned (i.e., the address must not be assigned by a DHCP server).
Select the address in a range which is not considered for Internet routing and
can be freely used for local networks.
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IP Range1: 192.168.yyy.xxx
Subnet mask: 255.255.255.0

xxx and yyy are freely selectable between 1 and 254

IP Range2: 172.zzz.yyy.xxx
Subnet mask: 255.255.255.0

zzz is freely selectable between 16 and 31
xxx and yyy are freely selectable between 1 and 254

(Also, see RFC1918)

Do not enter a gateway address as no gateway is available within a peer-to-
peer network and the above addresses cannot be routed. Communication
between the UCI-100 and the server of the Dionex Chromatography
Management System is always direct.
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When selecting the IP address of the network adapter of the server PC ensure
as well that, with the above subnet mask (255.255.255.0), only its last digit
differs from the IP address of the UCI-100. Otherwise, the UCI-100 cannot be
addressed.

 Tip: Do not use identical IP address within a network. Example:

UCI-100: IP address 192.168.60.51

Subnet mask 255

Server: IP address 192.168.60.50

Subnet mask 255.255.255.0

 Tip: Use neither 0 nor 255 as last numbers in IP addresses.

Checking the selected settings is via three commands, which are entered on
DOS level:

Ipconfig /all

to list the configuration of all network interface cards,
route print

to check whether you can address the UCI-100 with the network interface card
used for the peer-to-peer connection, and

ping 192.168.60.51

to check the connection to the UCI-100 with the IP address 192.168.60.51.

Configuring the UCI-100
Assign the UCI-100 Universal Chromatography Interface an IP address,
gateway address, and subnet mask via the CMIPUTIL program (see:

 Configuring the UCI-100 for Network Operation (CMIPUTIL)). The
address to be set depends on the address assigned to the network adapter in
the server PC that is used for the peer-to-peer connection.

Network Interface Card UCI-100
IP address 192.168.yyy.xxx 192.168.yyy.aaa
Subnet mask 255.255.255.0 255.255.255.0
Gateway 192.168.yyy.aaa
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 Tip: See the information above for selecting xxx and yyy. For the
UCI-100, select the same number for yyy as for the network
adapter. aaa is freely selectable between 1 and 254. However, it
must be different from the address set for the network adapter.
For a peer-to-peer connection, the gateway address of the UCI-
100 must be identical to its IP address.

 Configuring the UCI-100 for Network Operation
    (CMIPUTIL)
In order to be able to operate the UCI-100 Universal Chromatography
Interface within a network, an IP address plus the corresponding subnet mask
must be configured. The responsible network administrator determines and
programs these parameters by means of the CMIPUTIL configuration tool.
Valid and reserved IP addresses are to be used only.

 Tip: Only the responsible network administrator is able to ensure that
an IP address is assigned only once and that IP address, subnet
mask, and gateway address match correctly. Otherwise, the
network connection to the UCI-100 might not be established or
the communication between other participants in the network
might be disturbed.

Programming and changing the parameters is possible only while no data are
transferred between the UCI-100 and the server of the Dionex Chromatography
Management System. Stop the server via Start/Programs/Chromeleon (or
PeakNet)/Server Monitor.

In addition, the PC on which the CMIPUTIL configuration program is running
must be connected to the same subnet as the UCI-100 to be programmed.

Via the CMIPUTIL tool, UCI-100 modules with firmware version 2.0 or higher
(LAN support) can be programmed. Besides, the TCP/IP protocol must be
available on your computer.

 Tip: To take advantage of the network capabilities of the UCI-100
Universal Chromatography Interface if you are using a module
with a firmware version < 2.0, first download the latest firmware
via USB to the module (see General in the Online Help), and
then configure the module as described below.

• Copy the CMIPUTIL.exe program from the supplied driver disk or the CD
to a separate directory on your computer.

• Double click the program to start the configuration tool
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The Module Information window lists all modules, which are active within
the network together with their IP address, serial number (S/N), server
name (the name or IP address of that server is given with which data are
currently exchanged), gateway address, subnet mask, and Ethernet
address. The IP address for modules, which are not yet configured, is
0.0.0.0 or 255.255.255.255.

• Select the module to be configured by its serial number.

• In the Available IP Addresses window, select the IP address to be
assigned to the UCI-100. If it is not listed, click Add/Remove to enter the
desired address.

• Enter the required subnet mask and the gateway address in the respective
fields.

• Having made the necessary entries, assign them to the module by clicking
Assign.

• Exit the program. After about 1 second, the instrument will be displayed
with the new parameters.

• Checking the settings is via the Query button.

Based on the assigned IP address the module can then communicate with the
server of the Dionex Chromatography Management System in the LAN.

 Tip: The TCP/IP protocol, which is known from the Internet, is used
for the Ethernet communication between the UCI-100 Universal
Chromatography Interface and the Dionex Chromatography
Management System. The network traffic depends on the
amount of raw data to be transported (number of active analog
channels).

 Tip: As operating the UCI-100 Universal Chromatography Interface
via an Ethernet connection in case of high network traffic may
lead to transmission failures the raw data are temporarily stored
in the UCI-100. However, the available memory capacity is
limited as it depends on the amount of raw data to be
transported.

If the network failure exceeds the buffer time, analog data may
be lost.

If you notice these effects, we recommend you to establish an
USB connection between the UCI-100 and the server of the
Dionex Chromatography Management System. As the USB bus
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is capable of performing real-time operations, overloading effects
will not occur. If a USB connection cannot be established, act
appropriately to avoid interruptions of the network
communication between the server of the Dionex
Chromatography Management System and the UCI-100.

Recommendations for Network Operation
Due to the system and contrary to USB connections, Ethernet-LAN
connections have limited real-time capabilities, only. Data transmission can be
performed only when any other connected user does not use the network. In
order to take full advantage of the real-time capabilities of the UCI-100
Universal Chromatography Interface ensure to select a peer-to-peer connection
(see  Connecting the UCI-100 via a Peer-to-Peer Connection under
WINDOWS NT4). This ensures that other participants in the network do not
delay the server communication.

Furthermore, make sure that the injection signal of the autosampler and the
corresponding analog detector signals are connected to the same UCI-100.
The result is that possible delays in the server communication do not influence
the chronological relation of these signals.

Operating the UCI-100 via a router (gateway) is possible in principle, but does
not make sense.

 Tip: Dionex will not be able to give warranty as to the operation of the
UCI-100 in the Office LAN as the load of the Office LAN is a
decisive factor. Overload of the Office LAN may result in
timeouts and data losses and thus disturb the automatic
operation of the Dionex Chromatography Management System.
Therefore, we advise against operating the UCI-100 in the Office
LAN.
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 Adding the UCI-100 to the Server Configuration
Before adding the UCI-100 Universal Chromatography Interface to the
Server Configuration, connect the interface to the data system computer or
an Ethernet-LAN via the USB or LAN connection on the instrument's rear
panel.

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! WINDOWS NT4 computers do not support USB. Thus,
if LAN connections are required, additional Equinox boards must
be used for instrument control via RS232. We recommend using
a peer-to-peer connection for analog data acquisition via LAN
(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC - see

 Connecting the UCI-100 via a Peer-to-Peer Connection
under WINDOWS NT4).

1. Start the Server Monitor program by selecting Server Monitor from the
Start/Programs menu on the task bar. For example, for Chromeleon, select
Start/ Programs/ Chromeleon/ Server Monitor.

2 Click the Start button to start the server.

3. Click the Close button to close the Server Monitor program window. The
Server Monitor icon appears on the task bar.

 Tip: Clicking the Quit Monitor button, quits (exits) the Server Monitor
program, but it does not stop the server. To stop the server, click
the Stop button.

4. Start the Server Configuration by selecting Server Configuration from
the Start/Programs menu on the task bar. For example, for Chromeleon,
select Start/ Programs/Chromeleon/ Server Configuration.

5. If necessary, click the + character beside the server name to show the items
under the server.

6. Select Sharable Devices in the left window section. Then choose Add
Sharable Device from the Edit menu (or right-click).

7. Select Dionex UCI-100 Interface from the list and click OK. The UCI-100
will be installed and shown under Sharable Devices in the left window
section.

8. The Dionex UCI-100 Interface properties dialog box appears. Pressing
Browse provides information on all UCI-100 interfaces which are available



606 Installing PC Plug-In Boards / Interfaces

via Ethernet (TCP/IP) or USB - with their respective serial number (= S/N).
All UCI-100 modules, which are available via USB, appear with a USB
prefix and their respective Ethernet addresses. If a listed UCI-100 is already
connected to a server of the Dionex Chromatography Management System,
the server name is displayed in the Server Name column. If an UCI-100 is
available for connection to your server, the column shows 0.0.0.0 or is
empty (for further details, see General in the Online Help).

9. Select the desired UCI-100 Universal Chromatography Interface and
confirm your selection by pressing Enter (or double-click). Clicking OK
establishes the connection to the instrument and the corresponding
Connect message including the firmware version is displayed in the Audit
Trail.

To use the UCI-100 analog inputs with the Dionex Chromatography
Management System, the Integrator Driver (or the respective device driver for
a third-party analog detector) must be added to the timebase and configured
correspondingly (in the Server Configuration via Add Devices in the context
menu of the respective timebase). Installing and accessing the remote inputs,
BCD inputs, and relay outputs is via installing the Shared Relays and Inputs
Driver (INPREL.CDD) (as well in the Server Configuration under Add Devices
in the context menu of the respective timebase). For controlling a device via an
RS232 port, ensure that the corresponding serial communication port is
assigned in the device's configuration (select the Properties of the respective
device in the Server Configuration).
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Adding more than one UCI-100 Interfaces to the Server Configuration
If you already have a UCI-100 Universal Chromatography Interface installed
and wish to add another one to your server configuration as described above, a
message appears informing you that a driver of this type has already been
installed:

Answer the question whether to load an instance with Yes and proceed as
described under items 8 and 9 above. Upon completion of the installation the
newly installed UCI-100 Interface is shown in the server configuration together
with its respective instance number.

One Dionex Chromatography Management System server can control up to
four UCI-100s.
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Installing the Pump Control Board

Before installing the  Pump Control Board, connect the second slot sheet
(attached) to the board. The board can be operated with an 8-bit or 16-bit slot.
Ensure protection against electrostatic charge. Install the board only while the
computer is switched off.

The figure illustrates the elements of the pump control board that are relevant
for installation. Installation requires the following steps:

 Selecting an I/O-Address
 Pulse Width and Frequency Modulation
  Pump Connection and Pin Assignment

 Caution: Use a ballpoint pen to set the switch. Do not use a pencil, as
graphite particles could cause a short circuit in the switch.

Operation of the pump control board under the Dionex Chromatography
Management System requires its installation in the Server Configuration
program. Select the Dionex Pump Control Board driver under Sharable
Devices and assign the port address on the General page (link available in the
Online Help only).

Via the pump control board, three frequency-controlled pumps can be
controlled. Install the Pump Control Board Pump(s) device driver via Add
Device under the corresponding timebase.

In addition, four relays and four inputs can be established. Install the Shared
Relays and Inputs (INPREL.CDD) driver under Add Device to establish and
assign relays and remote inputs.
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 Selecting the I/O-Address on the Pump Control Board
On the pump control board, there is a pin field containing four pins named JP1.
By setting the jumpers, the pump control I/O-address can be configured.

The pump control board requires 13 consecutive I/O-addresses. 350H is the
default address. The following figure illustrates the I/O-addresses
corresponding to the jumpers.

300H 310H 340H 350H (Default)

 Pulse Width and Frequency Modulation
For each of the two pump types, the pump control board can be appropriately
configured. Use the pin field marked JP3 for pump 1, the pin field marked JP2
for pump 2 and the pin field marked JP4 for pump 3. Configure the pin field as
follows:

Pulse width modulation Frequency modulation (default)

 Caution: Pump control via pulse width modulation is rare nowadays. The
Dionex Chromatography Management System therefore does
not support this mode.

 Pump Connection and Pin Assignment
The relay output of the pump control board can be connected to the outside via
a 25-pin SUB-D connector. Four remote inputs (I1 - I4) and four additional
relays (R1 - R4) are available. The pin assignment is shown in the illustration
below:
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I 4 ...1    R 4 ...1
The maximum switching potential of the relays is 100 V with a contact rating of
10 W. Ensure not to exceed a max. current of 0.5 A. To enable a reaction to
external events (e.g. inject signal), the relay board offers four remote inputs,
which are released when a relay closing contact (e.g. of the autosampler)
grounds the corresponding input signal.

The relay connections are situated on the 25 Sub-D socket of the separate slot
sheet. A connecting cable with ribbon cable is part of the accessories.

Description Connector
Pin

Ribbon
Cable No.

Relay 1, normal open 1 1
Relay 1, common 14 2
Relay 1, normal closed 2 3
Relay 2, normal open 15 4
Relay 2, common 3 5
Relay 2, normal closed 16 6
Relay 3, normal open 4 7
Relay 3, common 17 8
Relay 3, normal closed 5 9
Relay 4, normal open 18 10
Relay 4, common 6 11
Relay 4, normal closed 19 12
Remote Input 1 7 13
GND 20 14
Remote Input 2 8 15
GND 21 16
Remote Input 3 9 17
GND 22 18
Remote Input 4 10 19
GND 23 20
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Installing the 16-Relays Boards ME63 (ISA) and ME630
(PCI)

The M63 and M630 relay boards supply 16 relays plus 4 remote inputs (ME63)
or 8 remote inputs (ME630). These are Sharable Devices, i.e. all relays and
remote inputs can be used independently of timebases.

Before you install the PCI board under the Dionex Chromatography
Management System, install the respective Meilhaus hardware drivers first.
The current drivers as well as a setup program for installing the drivers are
available on the supplied Meilhaus CD-ROM. This is not required for the ME63
ISA board.

Install the ISA board in an 8- or 16-bit ISA slot (for the PCI board use the PCI
slot instead) while the computer is switched off. Ensure protection against
electrostatic discharge!

The relay contacts of the board are located on a 37-pin (ISA board) or 78-pin
(PCI board) Sub-D connector (included in the delivery) on the PC. (The pre-
configured cables are included in the delivery.)

 Selecting an I/O-Address (ME63/ISA)
 Pin Assignment on the 37-pin Sub-D Connector (ME63/ISA)

To use the board under the Dionex Chromatography Management System, the
Dionex 16 Relays ISA Board (ME63) must be installed under Sharable
Devices in the Server Configuration. To install the respective PCI board,
install the Dionex 16 Relays PCI Board (ME630) driver instead.

Installing and assigning relays and remote inputs are via installing the device
driver Shared Relays and Inputs (INPREL.CDD) under Add Devices.

 Selecting the I/O-Address (ME63/ISA)
The DIP-switch block (Dual Inline Package) on the pump control board allows
configuring the I/O-address of the relay board.

Starting from the base address, the relay board requires four addresses, but no
interrupts. The I/O-base address is set to 300H (default) and should only be
modified if there are address conflicts with other Sharable Devices, e.g. with
the pump control board.

The following table shows the assignment of the eight switches to the binary
digits.
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Switch Default Function
1 ON 8-digit
2 ON 16-digit
3 ON 32-digit
4 ON 64-digit
5 ON 128-digit
6 OFF 256-digit
7 OFF 512-digit
8 ON 1024-digit

An open switch (OFF) corresponds to a binary 1 and a closed switch (ON)
corresponds to a binary 0. According to the table, the presetting on the relay
board corresponds to the following base address:

256 + 512 = 768 (decimal) = 300H (hexadecimal).

Also, see:
 Installing the 16 Relays Boards ME63 (ISA) and ME630 (PCI)
 Pin Assignment on the 37-pin Sub-D Connector (ME63/ISA)

 Pin Assignment on the 37-Pin Sub-D Connector
    (ME63/ISA)
The following connector assignment is used:

Pin Function Pin Function
1 Reserved 20 Relay 9 A
2 Relay 1 A 21 Relay 9 B
3 Relay 1 B 22 Relay 10 A
4 Relay 2 A 23 Relay 10 B
5 Relay 2 B 24 Relay 11 A
6 Relay 3 A 25 Relay 11 B
7 Relay 3 B 26 Relay 12 A
8 Relay 4 A 27 Relay 12 B
9 Relay 4 B 28 Relay 13 A

10 Relay 5 A 29 Relay 13 B
11 Relay 5 B 30 Relay 14 A



Installing PC Plug-In Boards / Interfaces 613

Pin Function Pin Function
12 Relay 6 A 31 Relay 14 B
13 Relay 6 B 32 Relay 15 A
14 Relay 7 A 33 Relay 15 B
15 Relay 7 B 34 Relay 16 A
16 Relay 8 A 35 Relay 16 B
17 Relay 8 B 36 Reserved
18 Reserved 37 Ground
19 Reserved

For further details, see the Meilhaus manual.

Also, see:
 Installing the 16-Relays Boards ME63 (ISA) and ME630 (PCI)
 Selecting the I/O-Address (ME63/ISA)

Installing the Digital I/O-Boards ME14 (ISA) and ME1400
(PCI)

The digital I/O-boards support 24 digital inputs and outputs, respectively, on
TTL level. In the Dionex Chromatography Management System, these 24
channels of the board are alternatively configured as digital inputs or outputs.
On the PC bus, 16 successive I/O-addresses are required.

With the ME14 ISA board, set the board's base address via the DIP-switches.
This procedure is not required for the ME1400 PCI board. For operating the
PCI board, install the Meilhaus hardware drivers first. The current drivers as
well as the Setup Program for installing the drivers are available on the
attached Meilhaus CD-ROM. This step is not required for the ME14 ISA board.

Install the ISA board in an 8 or 16 bit ISA (for the PCI board use the PCI slot
instead) while the computer is switched off. Ensure sufficient protection against
electrostatic discharge!

The digital inputs of the board are located on a 37-pin (ME14) or 78-pin
(ME1400) sub-D connector (included in the delivery) on the PC. For information
on the pin assignment, see the Meilhaus manuals.

 Note: The connectors on the ME14 and ME1400 filler brackets are
different. Therefore, cables, which are suitable for the ME14,
cannot be used with the ME1400.
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Also, see:  Selecting an I/O-Address (ME14/ISA)

To use the board with the Dionex Chromatography Management System, the
Dionex Digital I/O-ISA Board (ME14) or Dionex Digital I/O-PIC Board
(ME1400) driver must be installed in the Server Configuration under

Sharable Devices. The ME14IO24.CDD or ME1400.CDD driver is required.

With the ISA board, the I/O-basic address must be entered into the driver
configuration. With the PCI board, the PCI board number must be indicated.
For information on the numbering of the PCI slots of your PC, please see your
PC Mainboard manual. If you know the slot number, install the board using this
number. If you do not know the slot number, enter any number and install the
board. In the Audit Trail, a message informs you that no PCI board has been
found in the indicated slot and it states the number of the slot where a PCI
board is available. Re-install the board using this number.

On the Port Configuration page, define whether to use the ports as outputs or
as inputs. The port type can be changed only if any other device in your
configuration does currently not use it.

Installing and accessing the remote inputs or outputs is via installing the
Shared Relays and Inputs driver (INPREL.CDD) under Add Devices.

 Selecting the I/O-Address (ME14/ISA)
On the digital I/O-board ME14, there is a DIP-switch block (dual inline package)
for configuring the I/O-address of the board. The default setting is 300H
(standard). To avoid conflicts with other Dionex boards, we recommend
changing the setting to 340H.

The following table shows the assignment of the six switches to the binary
digits.

Switch Setting Function
1 OFF 512
2 OFF 256
3 ON 128
4 OFF 64
5 ON 32
6 ON 16

An open switch (OFF) corresponds to a binary 1, a closed switch (ON) to a
binary 0. According to the table, the setting on the board corresponds to the
following base address:
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64 + 256 + 512 = 832 (decimal) = 340H (hexadecimal).

Also, see:  Installing the Digital I/O-Board ME14 (ISA) or ME1400 (PCI)

Installing the 16-Bit DAC-Board "DAC340" ("PDA DA
Converter (16 Bit)")

The Dionex 16-bit DAC-board converts digital signals from the Dionex
detectors UVD 340S, UVD 170S, UVD 320S, and UVD 160S into analog
signals.

The board has four independent 16-bit analog outputs, i.e. up to four detector
channels can be output in analog form. The output voltage range (-10V to
+10V) is constant and has a resolution of approx. 0.3mV.

For the installation of the board, a 16-Bit ISA-slot, and 40 free hex I/O-
addresses are required. The following steps must be performed:

 Selecting the I/O-Address
 Setting Interrupts, Wait States, Jumpers
 Connecting the Analog Outputs

To operate the board under the Dionex Chromatography Management System,
it must be installed in the Server Configuration program. Select the driver
Dionex PDA DA Converter (16 Bit) under Sharable Devices. Assign the port
address on the General page (link available in the Online Help only).

 Caution: Use a ballpoint pen to set the switches. Do not use a pencil, as
graphite particles could cause a short circuit in the switch.

To avoid conflicts, use the default settings whenever possible.

 Selecting the I/O-Address
The default value for the I/O-base address of the board is 280hex. The board
thus uses the range from 280hex to 2Bfhex, which is available in most PCs.
This does not affect the default settings of other Dionex boards (A/D Converter,
UVD340 board, and pump control board).

If the base address must be changed, do this in steps of 40hex via the DIP-
Switch SW1. Other possible I/O-addresses are 240hex and 380hex. The
addresses are coded as follows:



616 Installing PC Plug-In Boards / Interfaces

Switch Addressbit2 240hex 280hex 380hex
8 6 OFF OFF OFF
7 7 ON ON OFF
6 8 ON OFF OFF
5 9 OFF ON ON
4 10 ON ON ON
3 11 ON ON ON
2 12 ON ON ON
1 13 ON ON ON

 Setting Interrupts, Wait States, and Jumpers
Setting the PC-IRQ is via the jumper block (JP3). It is located on the lower rim
of the board below the red DIP-switch element. As the board is operated
without interrupt in the Dionex Chromatography Management System, no
additional alterations are required.

The jumper JP2 (on the left rim of the board) serves to set additional wait
states. The default setting (1 wait state) is usually sufficient. Should there be
problems with the board (e.g. spikes, no signal), a larger number of wait states
can be set. The function of the jumpers is indicated directly on the board.

Do not change the settings of any other jumpers (JP1, 6-13) on the board.
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 Connecting the Analog Outputs
After inserting and configuring the 16-Bit DAC board, four analog outputs can
be used on the PC, via the two-row 50-pin board output. Use the ribbon cable
supplied with the board.

The 16-bit analog outputs are
the pins with the names Chan
16, 17, 18, and 19 on the
component side of the board. If
the pins on the board output are
counted from left to right and
from top to bottom, these are the
pins 33, 35, 37, and 39 located
directly below each other on the
left row. The corresponding
analog ground is also located
directly below (pin 41).

1 2

CH16 = 33
CH17 = 35
CH18 = 37
CH19 = 39
Gnd = 41 50

 Caution: Always use the analog ground (Pin 41), not the digital ground
(pin 44)!

Installing the 12-Bit DAC-Board
("Pump DA Converter")

In addition to the  Pump Control Board (frequency/pulse width control), the
Dionex 12-Bit DAC board enables the voltage-controlled operation of two
HPLC pumps. The board can be operated in an 8-bit slot or a 16-bit slot. The
computer must be switched off before installing or removing the board.

The pumps are connected with the 25-pin Sub-D output of the board via the
supplied 2 x 3pin connecting cable. Each line (Pump1 and Pump2) has three
wires (gnd/signal bipolar/signal unipolar). The wires correspond to pins 1, 17,
and 23, or 1, 18, and 24 of the Sub-D connector. (The numbering is from top to
bottom and from left to right, i.e. pin 1 is on the top left, pin 2 is directly below,
etc.)

If the connectors GND and bipolar (pin 1 and 17, or 23) are used for
controlling a pump, the output voltage varies depending on the jumper settings
D/A or D/A1 between -5/-10 and +5/+10V.
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If the connections GND and unipolar are used for controlling a pump (pin 1
and 18, or 24), the output voltage varies depending on the jumper setting D/A0
or D/A1 between 0 and +5/+10V.

 Caution: We recommend using the unipolar output for controlling a pump,
as only this guarantees 0V at the output when switching on the
computer. Otherwise, the active -5 or -10V can trigger an
immediate reaction of the pump (e.g. maximum delivery).

After inserting the board, the following settings must be performed or verified:

 Selecting the I/O-Address
 Jumper Settings, Wait States

 Caution: Use a ballpoint pen to set the switches. Do not use a pencil, as
graphite particles could cause a short circuit in the switch.

To avoid conflicts, use the default settings whenever possible.

To operate the board under the Dionex Chromatography Management System,
it must be installed in the Server Configuration program. Select the driver
Dionex Pump DA Converter (12 Bit) under Sharable Devices. Assign the
port address on the General page (link available in the Online Help only).

The device driver supplies the channels Pump_DAC_CHL1 and
Pump_DAC_CHL2 for a pump controlled via DA-channel. If the device driver
for a voltage-controlled pump (DAC pump(s)) is installed below a specific
timebase (DAC-pump), an assignment and control of the individual flow
components (%A, %B) can be performed via the DA-channels. The Online
Help provides support on the special DAC page in the Server Configuration:
DAC Flow A/B (link available in the Online Help only).

 Tip: If attempting to install the DAC Pump device driver first, the
Dionex Chromatography Management System will automatically
install the required driver Dionex Pump DA Converter (12 Bit)
first so that only the board must be installed then.

 Selecting the I/O-Address
The I/O-address is set via the DIP-switch element on the lower left corner of
the board. The default value for the I/O-base address of the board is 300hex
and usually it is not necessary to change it.
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If the board is used in addition to a Dionex pump control board, it is
recommended to change the address (e.g. 350hex). To avoid conflicts, check
the address setting if a network card is used.

The addresses are coded as follows:

Digit Switch Default setting (300hex) Function
1 Not coded
2 Not coded
3 2 ON 4-digit
4 3 ON 8-digit
5 4 ON 16-digit
6 5 ON 32-digit
7 6 ON 64-digit
8 7 ON 128-digit
9 8 OFF 256-digit
10 9 OFF 512-digit

An open switch (OFF or DOWN) corresponds to a binary 1, and a closed
switch (ON or UP) corresponds to a binary 0. At the base address 300hex, the
switches 8 and 9 are open. The resulting decimal value is 512 + 256 = 768. To
set the base address 350hex (=848 decimal), the switches 6 and 4 must be
opened in addition (512 + 256 + 64 + 16 = 848), etc.

 Jumper Settings, Wait States
On the upper right corner of the board, there is a jumper block labeled D/A0
and D/A1. It serves to select the required output voltage on the bipolar and
unipolar outputs. If a jumper connects both pins of the setting 5, the voltage
range is limited to 5V. If the corresponding jumper is set to 10, the maximum
output voltage is 10V or -10V. The settings of the block labeled D/A0 are valid
for the first; the settings of the block D/A1 are valid for the second channel.

D/A0 D/A1

5 10 X 5 10 X

In the above example, the 5V setting was chosen twice, i.e. channel 1 and
channel 2 supply voltage in the -5 to +5V range via the bipolar output (pins 17
and 23) and voltage in the 0 to +5V range via the unipolar outputs (pins 18 and
24).
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The setting X serves to adjust the dynamic range. The voltage applied at the
pin 16 or 22 of the Sub-D connector defines the maximum voltage range of
both channels. The smaller the selected voltage, the smaller the steps between
neighboring values, enabling a more exact pump flow setting.

On the lower right corner of the board, there is the wait state jumper. Set the
jumper to ON, if no wait state is required. Usually the selected presetting (ON)
must not be changed.

Installing the DX-LAN Card

In order to support instruments via DX-LAN, the PC on which the Dionex
Chromatography Management System is installed must have a DX-LAN
Computer Interface Card installed.

 Tip: Windows 95, Windows 98, Windows 2000, or Windows NT must
be installed before the DX-LAN card is installed in order for the
card to be set up correctly.

Complete the following steps to install the card:

 Install the DX-LAN Card in the Computer
 Connect the DX-LAN Network
 Install the DX-LAN Card Driver
 Adding the DX-LAN Card to the Server Configuration
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 Identifying the DX-LAN Card Type
The following  types of DX-LAN cards are supported:
• ISA Plug-and-Play card (P/N 052351)

• PCI Plug-and-Play card (P/N 052350)

• PCI Plug-and-Play card for 10BASE-T only (P/N 056908)

To determine the type of card you have, check the card's part number and the
figure below.

 Installing the DX-LAN Card in the Computer

      Important: To prevent electrostatic discharge from damaging the
card's electronic components, use an electrostatic
grounding strap during the installation. If one is not
available, do the following: before removing the card
from its anti-static bag, touch the computer's metal
frame to discharge any static electricity from your body.

 Tip: If you are not sure which model of card you have, see
 Identifying the DX-LAN Card Type.
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1. Turn off the computer and disconnect its power cord.

2. Remove the computer cover.

3. Locate an empty expansion slot into which the DX-LAN card will fit. Use
the type of slot appropriate for the card (either PCI or ISA). If several slots
are empty, leave as much space as possible around each installed card to
ensure adequate air circulation.

4. A metal filler bracket covers the rear panel opening for the selected
expansion slot. Unscrew and remove the bracket; save the screw.

5. Carefully slide the DX-LAN card into the slot, aligning the card's metal
mounting bracket with the expansion slot opening on the rear panel.

6. Align the card's bottom edge connectors with the connectors on the
motherboard. Firmly push the card into the motherboard connectors until
the card is fully seated.

7. Replace the computer cover and any cables you removed.

Connecting the DX-LAN Network

The DX-LAN network consists of a PC and at least one additional DX-LAN-
equipped device; for example, a DX-600 module, UI20 Universal Interface, or
DX-120 Ion Chromatograph. Each device to be connected must have a DX-
LAN interface card installed. When the card is installed, a BNC or RJ45
(telephone style) connector extends from the opening in the rear panel of the
device.

DX-LAN network connections vary depending on the type of network being
installed: 10BASE-T or BNC.

10BASE-T DX-LAN Network Connections
Follow these instructions when at least one of the devices on the network is
equipped with a 10BASE-T (RJ-45) DX-LAN connector.

1. Plug a 10BASE-T DX-LAN cable (P/N 960279) into a 10BASE-T port on the
front panel of the "combo" 10BASE-T Ethernet hub (P/N 056910). If
connecting to port 8, set the Normal/Uplink push button to Normal.

2. Connect the other end of the 10BASE-T cable into the 10BASE-T DX-LAN
connector on the rear panel of a 10BASE-T-equipped device, for example,
the PeakNet 6 workstation.

3. Repeat Steps 1 and 2 for the remaining 10BASE-T-equipped devices.



Installing PC Plug-In Boards / Interfaces 623

4. If the network includes any BNC devices, follow the directions below to
connect the BNC DX-LAN network.

   Important: The 10BASE-T DX-LAN cable is a Category 5 unshielded
twisted-pair cable. Do not substitute a cable of an
inferior grade. Failure to use the correct cable will cause
a device to lose communication with the host computer.

   Important: When using 10BASE-T cabling, you must install a hub. If
you simply plug the 10BASE-T cable from a device into
the connector on the computer’s DX-LAN card, the
connection will not work.

 Tips: Select normal, not uplink for port 8.

The PeakNet6 Workstation can be connected to any port.

A terminator plug must be installed at each end of a BNC device network.
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BNC DX-LAN Network Connections
1. Attach a BNC tee connector (P/N 921914) to the BNC connector on each

device and on the BNC port on the rear panel of the "combo" 10BASE-T
Ethernet hub (P/N 056910) if used.

Note the two small locking pins protruding from either side of the BNC
connector; twist the tee onto the BNC connector until the locking pins are
fully engaged in the slots on the tee connector. Pull firmly on the tee
connector to verify that it cannot move.

2 Connect a coaxial DX-LAN cable (3 ft, P/N 960406; 6 ft, P/N 960404; 12 ft,
P/N 960405) to the first device.

a. Slide the metal sleeve on the end of the DX-LAN cable over the BNC tee
connector.

b. Twist the metal sleeve onto the tee connector until the locking pins on
the tee are fully engaged.

c. Pull on the end of the cable to verify that it cannot move.

   Important: The coaxial DX-LAN cable is a 50-ohm coaxial
impedance cable. (Fifty-ohm cables are imprinted with
"RG-58U.") Do not substitute an inferior cable, such as a
75-ohm television coaxial cable. Failure to use the
correct cable or to lock it into place on the BNC tee
connector will cause the device(s) to lose
communication with the Dionex Chromatography
Management System.

3. Plug the free end of the coaxial DX-LAN cable into one of the following:
• The BNC connector on another device, or

• The BNC connector on the rear panel of the "combo" 10BASE-T
Ethernet hub (P/N 056910).

4. Repeat Steps 2 and 3 for each device to be connected.

5. Install 50-ohm terminator resistor plugs (P/N 921034) in the BNC tee
connectors at each end of the DX-LAN network.
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 Tips: Link the devices in a single line in any order.
The PeakNet6 Workstation can be anywhere in the network.
A terminator plug must be installed at each end of the network.

Installing the DX-LAN Card Driver

The DX-LAN card driver installation depends on the version of Windows
installed on your computer.

 Windows 95B
 Windows 98
 Windows 2000
 Windows NT

 Windows 95B
1. After installing the DX-LAN Plug-and-Play card in the computer and

cabling the DX-LAN network, turn on the computer.

When Windows starts, it will detect the new card and the Update Device
Driver Wizard will appear.

2. If Windows asks for a driver disk, insert the disk provided in the card’s
installation kit into an available disk drive (A or B).

3. Click Next.
Windows will find the driver for the card you installed.
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4. Click Finish.

5. A Network information box informs you that you must provide computer and
workgroup names. Click OK.

6. Enter names for the computer and the workgroup. The computer description
is optional. Click Close.

7. When prompted, insert the Windows 95B CD-ROM and click OK.

8. If prompted to insert the driver disk, click OK and then enter the diskette
drive letter.

9. After restarting the computer, open the Control Panel and double-click the
Network icon.

The Network dialog box appears.

10.Double-click the entry for the card you installed.

The Properties dialog box for the adapter appears.
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11.Select the Bindings tab.

As an example, the Bindings tab for the 3Com EtherLink III ISA adapter is
shown below:

12.Deselect all protocols except NetBEUI.

13.Click OK to close the dialog box, and click OK again to close the Network
dialog box.

14.Restart the computer.
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 Windows 98
1. After installing the DX-LAN Plug-and-Play card in the computer and

cabling the DX-LAN network, turn on the computer.

When Windows 98 starts, it will detect the new card and begins installing
the driver.

2. When prompted, insert the Windows 98 CD-ROM and click OK.

3. When the installation is complete, restart the computer.

4. Open the Control Panel and double-click the Network icon.

The Network dialog box appears.

5. Select the entry for the card you installed and click Add.

6. Select Protocol and click Add.

The Select Network Protocol dialog box appears.
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7. Select Microsoft.
8. Under Network Protocols, select NetBEUI.
9. Click OK.

You will be returned to the Network dialog box.

10.Double-click the entry for the card you installed.

The Properties dialog box for the adapter appears.

11.Select the Bindings tab.

As an example, the Bindings tab for the 3Com EtherLink III ISA adapter is
shown below.
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12.Clear all protocols except NetBEUI.

13.Click OK to close the dialog box, and click OK again to close the Network
dialog box.

14.Restart the computer.

 Installing the DX-LAN Card Driver: Windows 2000
1. After installing the DX-LAN Plug-and-Play card in the computer and

cabling the DX-LAN network, turn on the computer.

When Windows 2000 starts, it detects the new card and automatically
installs the driver.

2 When Windows 2000 has completed starting, click the Start button and
select Settings>Network and Dial-up Connections.

The Network and Dial-up Connections dialog box appears. The contents of
the dialog box vary depending on what network cards were previously
installed on the computer. In the following example, two LAN cards are
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installed. The first LAN connection is for the company’s network. The
second connection is for the DX-LAN.

3 Double-click the icon for the DX-LAN connection (LAN Connection 2 in the
example above). The following dialog box appears:
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4 Click the Properties button. The DX-LAN card Properties dialog box
appears.

5 In the Components checked... list, clear all check boxes, except for the
NetBEUI Protocol box.

6 Click OK to close the dialog box.
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 Windows NT

   Important: In order to install the DX-LAN card driver, you must be
logged onto NT with administrator privileges. If
necessary, ask the Windows NT administrator to grant
you administrator privileges temporarily.

1. After installing the DX-LAN Plug-and-Play card in the computer and
cabling the DX-LAN network, turn on the computer.

2. Open the Control Panel and double-click the Network icon.

If the Network dialog box appears, go on to Step 3.

If the Network Configuration message box appears, go to  Installing
Windows NT Networking and the Plug-and-Play Driver.

3. In the Network dialog box, select the Adapters tab.

4. Click the Add button.

The Select Network Adapter dialog box appears and displays a list of
network adapters.

5. Click the Have Disk button.

6. The Insert Disk dialog box appears. The default disk drive is A. If your disk
drive is B, select the B drive.

7. Dionex provides a disk with drivers in the Dionex Chromatography
Management System installation kit. Insert the disk into the drive and click
OK.

8. In the list of network adapters, select the entry for the adapter you installed
and click OK.

9. When Windows NT has finished copying the required files, select the
Bindings tab.
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10.In the Show Bindings for box, select All Adapters.

11.In the list of adapters, double-click the entry for the adapter you installed, to
display a list of protocols for the adapter.

12.Disable all protocol entries except NetBEUI. To do so, select each entry and
click the Disable button.

13.Click OK to close the dialog box.

14.When the system asks to restart Windows now, click Yes.

Installing Windows NT Networking and the Plug-and-
Play Driver

 Tip: Complete the steps below if the Network Configuration message
box appears after you double-click the Network icon in the
Control Panel. This indicates that Windows NT Networking has
not been installed on your computer.
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1. Click Yes to install Windows NT Networking now.

The Network Setup Wizard appears.

2. Accept the default setting, Wired to the network, and click Next.
3. Click the Select from list button.

The Select Network Adapter dialog box appears.

4. Click the Have Disk button.

5. The Insert Disk dialog box appears. The default disk drive is A. If your disk
drive is B, select the B drive.

6. Dionex provides a disk with drivers. Insert the disk into the drive and click
OK.

7. The Select OEM Option dialog box appears. Select the entry for the adapter
you installed and click OK.

The selected adapter will appear in the Networks Adapter list in the Network
Setup Wizard.

8. Click Next.
9. The Network Protocols list appears. Select the NetBEUI protocol and

deselect all others.

10.Continue following the Network Setup Wizard. Accept default settings for all
the remaining steps.

11.When prompted, insert the Windows NT CD-ROM, enter the CD-ROM drive
letter, and click OK.

12.When the dialog box appears informing you there is more than one
hardware bus, accept the default settings and click OK.

13.Continue following the Network Setup Wizard; when finished, click Yes to
restart the computer.

Adding the DX-LAN Card to the Server Configuration

Before adding the card to the Server Configuration, connect the DX-LAN
card and devices via DX-LAN cables (see  Connecting the DX-LAN
Network), and install the card driver (see  Installing the DX-LAN Card
Driver).
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1. Turn on the power to all devices (detector, pump, etc.) connected to the DX-
LAN network.

2. Start the Server Monitor program by selecting Server Monitor from the
Start/Programs menu on the task bar. For example, for PeakNet, select
Start/ Programs/ PeakNet/ Server Monitor.

3 Click the Start button to start the server.
4. Click the Close button to close the Server Monitor program window. The

Server Monitor icon appears on the taskbar.

 Tip: Clicking the Quit Monitor button, quits (exits) the Server Monitor
program, but it does not stop the server. To stop the server, click
the Stop button.

5. Start the Server Configuration by selecting Server Configuration from
the Start/Programs menu on the task bar. For example, for PeakNet,
choose Start/ Programs/ PeakNet/ Server Configuration.

6. If necessary, click the + character beside the server name to show the items
under the server.

7. Select Sharable Devices and then select Add Sharable Device from the
Edit menu (or right-click).

8. Select Dionex LAN Card from the list and click OK.
9. The Dionex LAN card properties dialog box appears, displaying the name of

the DX-LAN card and all other network cards installed in the computer.
There are two methods for binding to the DX-LAN card: automatic and
manual.
Automatic Binding
Click the Automatic Binding button (do not first select an adapter in the
Network Adapters list) to have the Dionex Chromatography Management
System search for the DX-LAN card. When the DX-LAN card is found, the
Dionex Chromatography Management System binds to it and then
establishes communication with the DX-LAN devices(s) installed on the
network.

During automatic binding, the Dionex Chromatography Management
System sends commands to all installed network adapters until it finds the
DX-LAN card. It is possible for this process to affect communication with the
network(s) associated with the other network adapter(s). A message
warning you of this appears when you click the Automatic Binding button.
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For most adapters, the commands sent from the Dionex Chromatography
Management System do not cause a problem and you can click Yes to
continue. If however, you do not want the Dionex Chromatography
Management System to communicate with other adapters, click the No
button and use the manual binding procedure instead.

Manual Binding
Select the DX-LAN card in the Network Adapters list and click the Bind to
DX-LAN button. The Dionex Chromatography Management System binds
to the DX-LAN card and then establishes communication with the DX-LAN
device(s) installed on the network.

 Tips: During manual binding, the Dionex Chromatography
Management System only sends commands to the adapter
selected in the list.

Once the DX-LAN card is successfully bound (either
automatically or manually), the Dionex Chromatography
Management System never sends commands to another
network adapter.

10.When binding is complete, the Active DX-LAN box displays the name of the
DX-LAN card. Click OK to close the Dionex LAN Card dialog box.

The devices connected to the DX-LAN network can now be added to a
timebase (see How to ...: Actions in the Server Configuration  Changing
the Server Configuration).
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Installing the M68 PC Interface Board for the PDA

The M68 PC interface board serves to receive the digital signals of the Dionex
UVD 340S and UVD 170S detectors.

Address Settings on the M68 Board

For the selection of the I/O-base address, the board is fitted with a DIP-switch
(dual inline package). The board occupies four addresses, starting at the
selected base value that is factory set to 318H. Normally, this value needs not
to be changed, unless operating in combination with network and/or other
interface boards. Then, the address settings of all PC boards should be
checked before installation.

 Caution: Ensure that the PC is switched off and the power cord
disconnected before installing the board.

 Caution The interface board must be protected against electrostatic
charge at all times. Should you encounter mechanical problems
when installing the M68 board into your computer, contact your
Dionex representative.

 Tip: The board can be inserted in an 8-bit or 16-bit slot.



Installing PC Plug-In Boards / Interfaces 639

An open switch (OFF) indicates a binary 1, a closed switch (ON) a binary 0. On
the right, the binary values are converted into hexadecimal values. The
selected value can be determined by adding the value. Therefore, the default
setting of the UVD 170S/340S interface board has the following base address:

8 + 10 + 100 + 200 = 318H (hexadecimal).

Installing the Serial ISA Interface Board

 Note: In addition to the ISA interface boards described here,
Dionex also offers a PCI bus board. One 4-fold and one 8-
fold version is available. As PCI-boards are currently more
expensive than conventional boards and since they do not
offer decisive advantages, they are recommended only if
there are no free ISA slots or interrupt addresses in the PC.
For detailed information, please contact the Dionex Service.

The ISA serial interface board available from Dionex offers four serial 16-byte
FIFO interfaces. The interfaces S1 and S2 are directly accessible after
inserting the board; S3 and S4 must be connected with the outside via the
supplied cable. Please ensure the correct pin assignment (the red line must be
connected to pin 1).
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16C550

16C550

16C550

16C550

S4
S4

S1

S3

S2

JP 1
JP 2

JP 11

JP 14

JP 15

JP 3
JP 4

JP 5
JP 6

JP 7

SW 1

JP 10

ON
OFF

JP 8

S3

S2

S1

1 2 3 4 5

1 2 3

1 2 3

1 1

Each physical interface corresponds to a logical interface that is configured via
different address combinations (I/O-address). Each logical interface can be
assigned to one of a maximum of eight available interrupts.

• I/O-addresses are selected on the board via the DIP-switch SW 1.

• The interrupt assignment is via the interrupt jumper fields JP 2, JP 4, JP 6,
and JP8.

• Interrupt through switching to the ISA-bus of the PC is via the interrupt
enable jumper field JP 10.

• Via the jumpers JP 11 to JP 14, the transfer rate of the four physical
interfaces S1 to S4 is set.

• The JP 15 jumpers can move up the address space by 1k (1/2 = 0 ... 3FFh
(default), 2/3 = 400 ... 7FFh).

The board enables baud rates of up to 460 kbaud. The baud rate can be set
separately for each interface.

Interrupt sharing is also possible, i.e. an interrupt can be shared by several
logical interfaces.

 Caution: This applies only to Windows 98, not to Windows NT 4.0/
Windows 2000! If more interrupts are required under Windows
NT 4.0/Windows 2000, use the PCI 8-fold RS232 interface board
available from Dionex. This board does not require an additional
IRQ assignment.

 Caution: This board is not a plug and play board. The board must be
installed under Windows 98 or Windows NT/Windows 2000 (see
below)!
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These boards are usually installed and configured by the Dionex Service. If this
is not the case or if it is necessary to change the current settings, you will find
the required information on the 4-fold interface board below the following
topics.

 Selecting the I/O-Address
 Interrupt Assignment
 Interrupt Through-Switching
 Setting the Baud Rate
 Installation under Windows

 Caution: Use a ballpoint pen to set the switches. Do not use a pencil, as
graphite particles could cause a short circuit in the switch.

To avoid conflicts, use the default settings whenever possible.

 Selecting the I/O-Address
The interface board is fitted with a DIP-switch marked SW1. Assigning ON and
OFF states to the positions 1 to 5 determines the I/O-addresses of the logical
interfaces in the DOS or UNIX mode.

The address is set via the switches of positions 1 to 3. Changing from DOS
mode to the UNIX mode is via the positions 4 and 5 (DOS: 4=ON, 5=OFF;
UNIX: 4=OFF, 5=ON).

In the DOS mode (4=ON, 5=OFF), the address of the logical interface can be
changed as follows (bold: default).

1 2 3 S1 S2 S3 S4
ON ON ON 3F8h (COM 1) 2F8h (COM 2) 3E8h (COM 3) 2E8h (COM 4)
OFF ON ON 2F8h (COM 2) 3E8h (COM 3) 2E8h (COM 4) 2F0h (COM 5)
ON OFF ON 3E8h (COM 3) 2E8h (COM 4) 2F0h (COM 5) 3E0h (COM 6)
OFF OFF ON 2F0h (COM 5) 3E0h (COM 6) 2E0h (COM 7) 260h (COM 8)
ON ON OFF 3F8h (COM 1) 2F8h (COM 2) 3E8h (COM 3) 2E0h (COM 7)
OFF ON OFF 2F8h (COM 2) 3E8h (COM 3) 2E0h (COM 7) 2F0h (COM 5)
ON OFF OFF 3E8h (COM 3) 2E0h (COM 7) 2F0h (COM 5) 3E0h (COM 6)
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 Interrupt Assignment
After addressing the logical interfaces (see: Selecting the I/O-Address), the
physical interfaces (COM1 to COM 8) are assigned to the logical interfaces by
allocating interrupts.

This is achieved by setting the jumpers JP 1, JP 3, JP 5, JP 7, and JP 2, JP 4,
JP 6, JP 8. The board should have the following default settings:

Jumper fields
S1 to S4

3 4 5 9

10 12
11 15

2 4

1 3
S IRQ

3 4 5 9

10 12
11 15

2 4

1 3
S IRQ

3 4 5 9

10 12
11 15

2 4

1 3
S IRQ

3 4 5 9

10 12
11 15

2 4

1 3
S IRQ

Physical: S1 S2 S3 S4
Logical: COM3 COM4 COM5 COM6

Interrupt: IRQ5 IRQ10 IRQ11 IRQ12

Under Microsoft Windows, the ports COM3 to COM6 are available to connect
various HPLC instruments. COM1 and COM2 should be reserved for other
functions (e.g. serial mouse port at COM1).

 Interrupt Through-Switching
Each adjusted interrupt of the serial interface must be switched through to the
ISA bus via the JP 10 interrupt enable jumper field. Through switching is only
possible for interrupts that were previously assigned to an interface (see:
Interrupt Assignment).

The default settings for I/O-addressing and the interrupt assignment determine
how the positions 5, 10, 11, and 12 must be connected to switch through the
interrupts 5, 10, 11, and 12.

Interrupt enable jumper field JP 10



Installing PC Plug-In Boards / Interfaces 643

 Setting the Baud Rate
For each interface, a separate baud rate can be determined. The settings are
via the baud rate multipliers JP 11 to JP 14. The positions 1, 2, and 3
correspond to the simple, double, and fourfold basic frequency (1.8432 MHz,
3.686 MHz, and 7.372 MHz).

 Caution: The Dionex Chromatography Management System only uses the
basic frequency. For correct operation, the jumpers 11 to 14
must always be set to position 1! If this is not the case, serious
conflicts in data transfer occur. Incorrect control and loss of data
will result.

 Installation under Windows

Windows 98

• Click the Start button, move to Settings, and select Control Panel.

• Double-click Add New Hardware and follow the instructions on the screen.

• Do not search for new hardware (No).

• Double-click the hardware type Ports (COM & LPT).

• Select Standard Port Type / Communications Port.

• Click Next to install the corresponding driver.

Windows 98 now confirms that the installation is completed. You are prompted
to restart the computer.

• Do not restart your computer at this point!

So far, Windows 98 only installed one interface, i.e. one (1) COM port! If you
want to use several ports of the serial interface car, you have to repeat the
entire procedure several times. The maximum is four times.

• Change to Control Panel / System.

• Open the tab dialog box Device Manager.

• Double-click Ports (COM & LPT).



644 Installing PC Plug-In Boards / Interfaces

Double-click the last COM port in the list (when there are four additional ports
installed, this is usually COM6, as the ports COM1 and COM2 are part of the
standard installation).

• Open the tab dialog box Resources.

• Under Setting based on select Basic Configuration 8.

• Click Input/Output Range.

• Select Change Setting.

• In the Value field, enter the I/O-range (I/O-address) set on the board.

• Click OK.

• Click Interrupt Request.

• Select Change Setting.

• In the Value field, enter the interrupt value that is set on the board.

• Click OK twice.

• Repeat the entire procedure for each additional interface (e.g. COM5,
COM4, and COM3).

• The port settings (baud rate, data bits, etc.) of the now correctly configured
interfaces must not be set here. These settings are performed in the
Dionex Chromatography Management System.

Now the installation of the interface board under Windows 98 is complete.
Close the Control Panel and restart the computer, so that the new settings
become effective.

Windows NT / Windows 2000
The installation of serial interfaces under Windows NT/Windows 2000 is
considerably easier than under Windows 98.

• Click the Start button, move to Settings, and select the item Control
Panel.

• Double-click Ports.

• Via the Add button, enter the required COM ports.
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• Select Settings and Advanced to enter the interrupts and I/O-addresses
that are set on each board via jumpers.

• Complete the procedure with OK and restart the computer.

It is not necessary to enter the port settings (baud rate, data bits, etc.) of the
now correctly configured interfaces in Windows NT/Windows 2000. This is
performed in the Dionex Chromatography Management System.

Installing the Serial PCI Interface Board (VScom)

Installing the Board
• Switch off the PC and disconnect the power cord.

• Remove the PC housing and find a free PCI slot. Carefully insert the board
into the free PCI bus slot.

• Replace the PC housing, reconnect the power cord, and switch on the PC.

Depending on the environment (Windows 98 or Windows NT/Windows 2000),
see the topics below for installation instructions:

 Installing the VScom Board under Windows NT/Windows 2000
 Installing the VScom Board under Windows 98

Also, see:  Installing the Serial PCI-Interface Board (Equinox)

Should problems arise during the installation, see  Troubleshooting for
possible solutions.

 Installing the VScom Board under Windows
    NT/Windows 2000

Device Driver Installation
To install the VScom board under Windows NT, insert the PCI board, and then
start the program DrvConf.exe from the supplied diskette. DrvConf will
recognize the new VScom PCI board and the already installed ports.
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• As soon as the installation of the new board is complete, the configuration
window will be displayed.

• Use this window to select the required board and change the configuration
of individual ports. The following settings are possible below Port Settings:

Name: Choose the COM port assignment. Supported settings are COM5 to COM255.
COM1 to COM4 are assigned to specific addresses and cannot be selected.

Address: The addresses for ports of the boards VScom 400 PCI and VScom 800 PCI are
automatically assigned by the BIOS (setting PCI Automatic) and cannot be
changed.

IRQ: The interrupt of the board is assigned by the PCI BIOS and cannot be changed
(PCI Automatic).

UART: The port is supplied with an UART of this type. Usually, it is not possible to
change this parameter. It is recognized by the program and is only displayed.

 Caution: For operating the PCI board with the Dionex Chromatography
Management System, enter Low (up to 115 kbps) as the
Speed Mode and choose Overspeed: 1 in the configuration
window.

• After you have completed all settings, confirm them by pressing OK. The
configuration program DrvConf.exe will then use these settings for the
VSCom PCI board, copy the required device driver software and restart the
system.

• After the restart, the ports of the new VScom PCI board are available in the
system. You can now access the board under Windows NT.

Should problems arise during the installation, see  Troubleshooting for
possible solutions.

 Installing the VScom Board under Windows 98

Device Driver Installation
When you install the VScom board under Windows 98, the following message
will appear on the screen as soon as you have inserted the PCI board and after
you have started Windows:
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"New hardware component detected:

PCI Network Controller

Select the device driver for the new hardware component"

Proceed as follows:

• Insert the supplied diskette into the floppy drive.

• Select: Device driver on Hardware manufacturer diskette.

• Windows 98 then prompts you for the path. Normally A:\ is suggested. If
this is your floppy drive, simply click OK.

• Windows 98 then copies and installs the device driver software for the
VScom PCI board. After that, the software for the port device driver will be
installed. The following message will appear on your screen: New
hardware component detected and VScom PCI Port #1. Simply click OK
when Windows 98 prompts you for the device driver diskette. Finally, all
ports of the VScom PCI board will be installed.

• Windows 98 then continues the normal boot procedure.

At this point, you can check whether the installation was performed
successfully. Check whether VScom xxxPCI Controller is entered below
Multi-function boards in the Device Manager (xxx = VScom Model number).
To open the device manager, click START > SETTINGS > CONTROL PANEL
> SYSTEM > DEVICE MANAGER.

Port Setting: Speed and Assignment
To set the parameters for each port, choose the Properties of the VScom
xxxPCI Controller (from Multi-function boards in the Device Manager). On
the Advanced tab, you can set the speed and the assignment of the ports.



648 Installing PC Plug-In Boards / Interfaces

 Caution: For operating the PCI board via the Dionex Chromatography
Management System, enter Low (up to 115 kbps) on this sheet.

On the same sheet, you can change the names of the COM ports. Double-click
the name you wish to change. The window Change Port Name will appear.
Possible settings are: COM1 to COM99.

If you have configured the remaining port names automatically in ascending
order, choose the Automatically renumber succeeding ports option. All
previously assigned COM port names will be ignored and will be replaced with
the next free name

Should problems occur during the installation process, see
 Troubleshooting for possible solutions.
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 Troubleshooting
1. Use a Different PCI Slot
With some of those boards, problems might occur during the installation
process. If the board driver does not recognize the board, it should be installed
into the nearest PCI slot to the main board. Then, it should be possible to install
the board without further difficulties.

2. BIOS Reset
You may as well reset the BIOS. Depending on your PC, this is done under
either Reset PCI Configuration or Reset Plug & Play Configuration. For
DELL PCs please proceed as follows:
• When booting the PC, press the F2 key to change to the BIOS Setup.

• Activate the LEDs Num Lock, Caps Lock, and Scroll Lock on the
keyboard with the corresponding keys

• Enter ALT-E and ALT-F afterwards.

Installing the Serial PCI Interface Board (Equinox)

The Equinox boards are identical except for their components. Both boards
have no jumpers and no DIP-switches. The boards both have a 78-pin output
to which an additional cable is connected providing four (eight) serial
interfaces. As soon as the board is installed, the COM port assignment and
each single port are tested with a utility program supplied by Equinox.

Installing the Board
• Switch off the PC and disconnect the power cord.

• Remove the PC housing and find a free PCI slot. Carefully insert the board.

• Replace the PC housing, reconnect the power cable, and switch on the PC.
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As PCI interface boards are Plug and Play boards, Windows 98 will attempt to
install the inserted board.

• If this is the case, cancel the Windows 98 installation procedure.

• Instead, insert the supplied Equinox CD into your CD-ROM drive. Following
the autostart of the CD, decide whether to perform the Windows
NT/Windows 2000 or the Windows 98 installation.

 Installing the Equinox Board (Board Version 3.32) under
     Windows NT/2000

 Installing the Equinox Board (Board Version 2.30) under
     Windows 98
Also, see:  Installing the Serial Interface Board (VScom)

 Installing the Equinox Board (Version 3.32) under
    Windows NT/Windows 2000
After selecting the Windows NT / Windows 2000 installation on the Equinox
CD, choose the link Equinox SST Driver Windows NT 4.0, Windows NT
3.51, or Windows 2000.

To perform the software installation, follow the instructions of the automatically
displayed help text.

In contrast to Windows 98, the assignment of the COM port names and the
installation of the logical COM ports are performed automatically under
Windows NT/Windows 2000. Simply specify the port name with which to start
(we recommend COM 11) and the number of ports to install (4 or 8).

Finally, test the ports as described under  Installing the Equinox Board
under Windows 98 (Board Version 2.30) under Functional Test.

 Installing the Equinox Board (Version 2.30) under
    Windows 98
After selecting the Windows 98 installation on the Equinox CD, choose the link
Finish Win98 Installation and follow the instructions of the Software Wizard.
After restarting Windows 98, the software installation of the board is completed.
After that, the COM ports must be configured.
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COM Port Assignment and Port Test
As soon as the software installation of the board is completed, the Equinox
Utilities will be available in the start menu. Open the submenu and choose
Equinox Configuration. The following window will appear.

If the board functions correctly, the Quick Status will indicate the status
Operational. If this is not the case, detailed information is available via the
Status option. NOTE: If the board is not recognized correctly, you may have to
use a different PCI slot.

Installing further logical COM ports
Via the COM option, choose the Add Logical COM ... command to assign
each port a specific COM port designation.
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Via Available COM, choose a COM number and then press Create. Perform
this four times for the 4-fold board, and eight times for the 8-fold board. NOTE:
Start with COM 11. You will thus prevent overwriting an existing COM port
assignment (e.g. COM1 = mouse port)!

In the field COMs Present, the designations COM11 to COM14 (4-fold board)
or COM11 to COM18 (8-fold board) are displayed. Save the settings using the
Save command.

If error messages appear (e.g. Can’t save to registry), you can ignore them at
this point. So far, they have not impaired the functionality of the board.

Connecting logical COM Ports with the Physical Channels
Via Mapping, choose the Map Port command. You will see the following
dialog:

The list box Port Name shows all previously installed logical COM ports (e.g.
COM11 to COM18). Via Map, the logical ports can be assigned physical
channels (by pressing the button four or eight times). The result of these
mappings is displayed in the list box Current Mappings. Save these settings
via Save. Any error messages can be ignored.

After restarting Windows 98, the additional four or eight COM ports should be
available.

Functional Test
The Eqnloop utility serves to test the functionality of the ports. Via Equinox
Utilities, choose the Equinox Eqnloop command. In the Loopback dialog of
the Ports menu, specify the number of the first COM port (number 11 in these
instructions) under First. Via the Count command, specify the number of COM
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ports that should be tested (4 or 8). You will see the following dialog. Start the
test via the Start command in the Run menu.

As soon as you plug the included 25-pin loop-back connector in one of the
ports, you will see a constantly changing value in the Rcv column. This is an
indication for the optimum functionality. Repeat the test with all ports.
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Installing the License Server
The optionally available License Server of the Dionex Chromatography
Management System (Dionex CMS) can be installed on any network PC
fulfilling the following conditions:
• The operating system is Windows 98, Windows NT 4.0, or Windows 2000.
• LAN connection is via TCP/IP or IPX/SPX

Standalone
Copy the distribution files (17 in total) to any directory of your choice.

 Note: If you do not see all 17 files in the Windows Explorer, make the
missing ones visible via the View menu. Select Options to open
the corresponding dialog box and select the Show All Files
option.

The default path is C:\Program Files\Softron\Chromeleon License Server.
Copy the CmLicSrv.ini license file that is shipped with the program to this
directory. Your licenses of the will be available via the network provided the
CmLicSrv.ini file is available in the above-mentioned directory.

To install the License Server, call the CmLicMon License Server Monitor once
from the command line (DOS box) via the " /install" parameter (observe the
space in front of the slash). Select Start > Run and browse for the
CmLicMon.exe file in the opening dialog box. Pressing Open automatically
writes the following entry into the Run box (if the CmLicMon.exe file was
copied to the above default directory)

"C:\Program Files\Dionex\Chromeleon License Server\CmLicMon.exe"

 Tip: The entry is given in quotation marks if spaces are used in the
directory names. If no spaces are used, the quotation marks will
be omitted, as they are not required.

Following the above entry, enter /install.

 Note: Do not forget to enter the space in front of the slash!

Pressing OK executes the call.
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Under Windows NT/Windows 2000, administrator privileges are required to
perform this step.
Optionally, a link to the CmLicMon monitor program can be included in the
Autostart directory. This will automatically start the monitor program whenever
the system boots.
If you wish to start the License Server automatically as well upon booting your
computer, open the monitor program and click Start License Server at
System Start.

A configuration file for the License Server is supplied together with the
distribution. However, this file needs to be adapted to local requirements.
Replace the computer names PC_XX in the [Servers] section of the file
CmLicSrv.ini by the names actually used in your network (e.g. ALPHA,
BRAVO...). This is to assign serial number/ Key Code pairs to the servers of
the Dionex Chromatography Management System:
[License Server]
Serial Number = 4711
Key Code = 112233-445566
Pal Location = 5

[Servers]
ALPHA: 1/111111-111111
BRAVO: 2/222222-222222
CHARLIE: 3/333333-333333
DELTA: 4/444444-444444
ECHO: 5/555555-555555
FOXTROT: 6/666666-666666

[Clients]

Max Clients = 10

[Checksum]
Checksum = 0x00005E77

 Tip: If you have a hard-protect installed (i.e., the entry in the INI file
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is: Pal location = 1), an I/O address must be specified. Enter the
line "Pal Address = 0x030f". Depending on the jumper settings
on the hard-protect, other available options are: 0x031f, 0x032f,
and 0x033f. If the "Pal Address =" line is missing in the INI file,
0x030f is the default. Do not modify any other settings!

License Server and Dionex CMS Server installed on one PC
Install the Dionex Chromatography Management System (Dionex CMS) on
your PC. The default path is c:\chromel\bin. Copy the CmLicMon.exe and
CmLicSrv.ini files (both shipped together with the program) to this directory as
well.

To install the license server service of the Dionex Chromatography
Management System, start the CmLicMon License Server Monitor from the
command line (DOS box) via the /install parameter:

C:\Chromel\Bin>cmlicmon /install
Under Windows NT, administrator rights are required for this step.

Proceed with the installation as described under Standalone.

If problems occur during the installation of the license server, see
 Troubleshooting (License Server) for possible remedial actions.

Troubleshooting (License Server)

• The license server of the Dionex Chromatography Management
System does not start

Under Windows 98
Start the CmLicSrv program by selecting the /console option in the DOS
command line.
C:\Program Files\Dionex\Chromeleon License
Server>cmlicsrv /console

Following a list showing all network protocols that are available for RPC,
the CmLicSrv.ini configuration file is displayed. Was the file found and
completely processed? Did you modify entries in the file apart from the
computer names? If Listening for Clients is not displayed at the end of
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the file, the License _Server cannot be initialized. Repeat the installation
with cmlicmon /install, using administrator rights, if necessary.

Under Windows NT
First, check the Event Viewer of your system:

Start -> Programs-> Administrative Tools (Common) -> Event Viewer -
> Log-> Application
CmLic Srv logs the server start and indicates possible errors. If the
information given in the Event Viewer is not sufficient, you can activate
extended output.

Start the CmLicSrv program via the Control Panel and not via the license
server monitor.

Start -> Settings -> Control Panel-> Services
Enter /console as startup parameter and start the Chromeleon License
Server service by pressing the Start button. Among others, all detected
entries of the CmLicSrv.ini license file, possible errors, and all connection
attempts of the Chromeleon (or PeakNet) servers and Chromeleon (or
PeakNet) clients are logged.

• The License Server of the Dionex Chromatography Management
System remains in the Demo Mode

Check whether the supplied hardware protection module (dongle or hard
protect) is correctly installed. The serial numbers of the module and in the
[License Server] section of CmLicSrv.ini must be identical.

Check whether the Pal Location entry in the [License Server] section of
CmLicSrv.ini has been changed. "5" is the correct entry for dongles
while "1" corresponds to hard-protects.

• The Server of the Dionex Chromatography Management System
remains in the Demo Mode

In the server configuration of the Dionex Chromatography Management
System, ensure that the computer name for the license server is correct.
Check whether the correct RPC protocol is used. Also check whether the
PC on which the license server is installed can be accessed via the
network, e.g. for a TCP/IP network with ping servername or by opening
a network share in the Windows Explorer. Check whether a line for the
server of the Dionex Chromatography Management System is provided in
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CmLicSrv.ini and ensure that the computer name is spelled correctly
in the [Servers] section.

• The Server of the Dionex Chromatography Management System
starts, however, the device drivers complain that a device control
feature is missing when loading

The starting sequence for the two server services, the Chromeleon (or
PeakNet) Driver and the Chromeleon (or PeakNet) Server, is not correct.
Uninstall the services via the Server Monitor of the Dionex
Chromatography Management System: C:\Chromel\Bin>cmmon
/deinstall. Restart the computer and reinstall the services via the
Server Monitor of the Dionex Chromatography Management System:

C:\Chromel\Bin>cmmon /install

• The Client of the Dionex Chromatography Management System
remains in Demo Mode

In the client of the Dionex Chromatography Management System, ensure
that the computer name for the license server is correct.

Check whether the correct RPC protocol is used.

Also check whether the PC on which the license server is installed can be
accessed via the network, e.g. for a TCP/IP network with ping
servername or by opening a network share in the Windows Explorer.

Check in the License Server Monitor report of the Dionex Chromatography
Management System whether all licenses for the clients were used. Restart
the license server, if necessary.

• Network Failure

In normal circumstances, a network failure does not cause any damage.
Both, the Server and the Client of the Dionex Chromatography
Management System Server save the license information locally for up to 7
days. Normally the user can continue working during this period even if the
License Server cannot be accessed. Only after this period, the server of
the Dionex Chromatography Management System shuts down and the
client runs in demo mode.

If the connection to the License Server of the Dionex Chromatography
Management System is disrupted during active operation or if the
connection is not available when the system is started, this is logged in the
daily audit trail. In this case, a dialog box is displayed in the Client
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indicating the remaining time. In addition, it is also logged into the audit trail
when the connection to the CMLS is available again. The two audit trail
warnings look as follows:

09:40:46 Warning: Chromeleon Server failed to retrieve a license from the
license server CCHROMEL! Your local license will expire in 167 hours.

09:41:16 Chromeleon Server succeeded to retrieve a license from the
license server CCHROMEL! Your local license has been updated.

• Could not create "Chromeleon Operators" group - No mapping
between account names and security IDs was done

During the installation of CmLicSrv on an NT Backup Domain Controller the
error Could not create "Chromeleon Operators" group - No mapping
between account names and security IDs was done (8b2) might occur
when calling in CmLicMon.exe /install. Remedial action: Create the group
via the NT User Manager before running CmLicMon.exe /install.

Also, see:  Installing the License Server
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Installating the Virtual Channel Driver
(VCD)

The Virtual Channel Driver (VCD) of the Dionex Chromatography
Management System is a standard device driver of the Dionex
Chromatography Management System that must be assigned to a timebase in
the Server Configuration of Dionex Chromatography Management System. As
standard, 16 virtual channels are available. If more virtual channels are
required, several instances of the driver are possible:

If necessary, the standard channel names (VirtualChannel_XX) can be
changed in the Signals configuration dialog after the installation:
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This terminates the installation.

Also, see

 Installing the Virtual Channel Driver: Configuration

 Installing the Virtual Channel Driver: Channel Configuration

 Installing the Virtual Channel Driver: Channel Types

 Configuration
The Virtual Channel Driver (VCD) offers the two properties SamplingStep and
LagThreshold, which apply to all channels.

SamplingStep defines the time interval after which the VCD re-evaluates the
expressions that are assigned to the channels. Only then, the signal of the
virtual channel will be influenced by the modified terms in the expression. The
smaller the interval, the more precise the recording of the modifications, yet the
higher the workload of the processor.

Neither Windows 32 nor Windows NT/2000 are real-time operating systems.
Therefore, a precise sampling rate cannot be ensured by a pure software
solution such as the VCD. By comparing the two values, the VCD tries,
however, to keep the channel time deviation (= number of generated data
points multiplied by the SamplingStep) as small as possible against the time
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that actually passed. If this difference exceeds or falls below the time interval
defined by LagThreshold, an additional data point will be interpolated or a data
point will be omitted respectively to bring the channel time up to the real time
again. The longer the interval, the fewer data will be falsified, yet the longer the
time deviation (especially with long acquisition times!).

Internally, a 100Hz signal is generated from the signal that was recorded with
the data rate previously defined via SamplingStep. Then, the 100Hz signal is
forwarded to the compressor. For digital channels, the last calculated value is
repeated sufficiently often; in other cases, the last three calculated values are
parabolically interpolated.

Also, see:

 Installing the Virtual Channel Driver: Installation

 Installing the Virtual Channel Driver: Channel Configuration

 Installing the Virtual Channel Driver: Channel Types

 Channel Configuration
The Virtual Channel Driver (VCD) of the Dionex Chromatography
Management System needs to know the expressions to be recorded. They are
specified directly in the Program (for information on the syntax please refer
to: How to ...: Device Control  Virtual Channel Commands).

For optimizing the signal recording, each virtual channel must have a type
assigned. At present, three types are defined:

Analog Suitable for expressions consisting of other
analog signals

UV_VIS_1/UV_VIS_2

Digital Suitable for digital expressions P580Relay_1.State AND
P580Relay_2.State

Fixed Suitable for expressions that change slowly Pump.%A

The selected type affects the settings of Step, MaxAutoStep, and Average of
the respective signal as well as the selection of appropriate raw data
compression. With the standard compressor of the Dionex Chromatography
Management System, the meaning of these three parameters is the same as
with normal signal channels. With the step compressor, they are irrelevant as
this compressor type always uses a fixed step of 0,01s for sampling.
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The following values are default:

Step MaxAutoStep Average Compression
Analog Auto 5.1s On Standard compressor of the Dionex

Chromatography Management
System

Digital Fixed, 0.01s Special compressor for step signals
Fixed Fixed, 0.01s 5.1s Off Standard compressor of the Dionex

Chromatography Management
System

For analog and fixed channels, the values for Step, MaxAutoStep, and Average
can be changed after setting the type. For fixed channels, identical settings for
the step rate and the SamplingStep are recommended to ensure that the
compressor only records the originally sampled datapoints.

Use the Formula commands to specify the expression to be recorded. All
expressions that are available in the condition of a BeginTrigger command can
be used, i.e., arithmetic and logical operations. However, the expression must
be numerical. While the program is executed, the property FormulaCur states
the last calculated value of the expression (which is different after each
SamplingStep.) The resulting minimum and maximum values of the expression
are indicated in FormulaMin and FormulaMax respectively.

Similar to other signal channels, the property Value allows viewing the current
(perhaps interpolated) signal value (changes every 0.01s).

The Equate property allows you to assign the virtual channel an additional
user-defined name during the program run. You can use Log system command
to write this to the Audit Trail.

During data acquisition, it is not possible to change the Step, MaxAutoStep,
Average, Formula, and Type properties. The FormulaMin, FormulaMax2,
and 2FormulaCur properties are read-only.

Also, see:

 Installing the Virtual Channel Driver: Installation

 Installing the Virtual Channel Driver: Configuration

 Installing the Virtual Channel Driver: Channel Types

 Schematic of the Channel Types
For a better understanding and to avoid artifacts please find below the
schematic representation of different signal conversions:
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Also, see:

 Installing the Virtual Channel Driver: Installation

 Installing the Virtual Channel Driver: Configuration

 Installing the Virtual Channel Driver: Channel Configuration
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Installing and Controlling Third-Party
Instruments

In addition to the Dionex Device Drivers, the Dionex Chromatography
Management System offers numerous drivers for controlling third-party
instruments. These instruments are not part of the Dionex product range.
Support is available for instruments from the following manufacturers:

ABI (see  APPLIED BIOSYSTEMS)
 AGILENT (formerly HP)

AMERSHAM PHARMACIA BIOTECH (see  PHARMACIA)
 ANTEC
 APPLIED BIOSYSTEMS
 BERTHOLD
 BIO-RAD
 CTC ANALYTICS
 Dostmann

 ESA
 FINNIGAN

 FISONS
 GILSON

HEWLETT PACKARD (see  Agilent)
 ISCO
 JASCO
 KNAUER
 KONTRON
 KRATOS

LKB (see  PHARMACIA)
 MERCK HITACHI
 NELSON Interfaces
 PHARMACIA
 RAININ/VARIAN (Pumps)
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 SOMA
 THERMOQUEST
 TSP
 VARIAN (GC)

In addition, a  Generic Device Driver is available which assists you in
developing your own device driver.

 Note: As programming device drivers for third-party instruments
requires a considerable effort and as not all instruments are
designed for direct control, support may be limited to certain
functions.

For information on cables, pin assignments, and Dionex part numbers (if
available), see  Cables and Pin Assignments in the appendix of these
Installation Instructions.

 AGILENT (formerly HP)
The Dionex Chromatography Management System supports controlling the
following Agilent (formerly HP) instruments:

• HPLC Systems  HP1050 and  HP1100 (see as well  Hints on
HP1100),

• Gas Chromatographs  HP5890 and  HP6890 as well as

• GC Autosampler  HP7673 and  Autosampler for HP6890 + Controller
Box HP G1512.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 AGILENT (formerly HP): HP1050 - Overview

Device Type: HPLC System

Device Drivers: HP79852 Gradient Pump: HP1050 Gradient Pump
(supports three eluents and two relays) (tested) for
firmware version 3.2)

HP79855 Autosampler: HP1050 Autosampler
(supports two relays) (tested for firmware version 4.2)

Supported
Hardware
Options:

HP79852 Gradient Pump
HP79855 Autosampler

What is required?

License: Extended Device Control

Connection: Null modem cable (Dionex part no.: 8914.0103A (25-
pin to 9-pin) or 8914.0129 (9-pin to 9-pin), for details
see  Null Modem Cable) in the appendix of these
Installation Instructions.

Control Panel: HP1050S.pan

Further Information

For information on how to install the HP1050 HPLC system, see  Agilent
(formerly HP): HP1050 - Installation.

For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).
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 AGILENT (formerly HP): HP1050 - Installation

Hardware Installation

Device Settings Having switched on the instrument and upon
completion of the initialization, perform the following
steps according to the Agilent Operating Instructions
to enter the device settings:

• Press the <CTRL> key: Date & Time appears.

• Press the <Next> key: Configuration appears.

• Press the <Enter> key.

• Press the <Next> key until Communication
appears.

• Press the <Enter> key: Interface appears.

• Press the <Right> key.

• Press the <Next> key until Serial appears.

• Press the <Enter> key.

• Press the <Next> key until Serial Mode appears.

• Press the <Right> key.

• Press the <Next> key until A appears. (This sets
the communication parameters as follows: 7 Data
Bits, Even Parity, and 2 Stop Bits).

• Press the <Enter> key.

• After the <Next> key, Baudrate: 9600 appears.

• Press the <Next> key and select XON/XOFF: Off
(disabled).

To be able to execute flow ramps with the 1050
gradient pump, ensure that the Remote Mode is set
to Local:
• Press the <CTRL> key: Date & Time appears.
• Press the <Next> key: Configuration appears.
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Device Settings
(Cont'd)

• Press the <Enter> key.
• Press the <Next> key until Remote appears.
• Press the <Right> key.
• Press the <Next> key until Local appears.
• Press the <Enter> key.

Restrictions: To ensure smooth handling of sample injections, a
minimum time of 2 minutes is required between two
injections. This is checked with the ReadyCheck of
each program. If the time remains under 2 minutes, an
error message will be displayed.

Software Installation

Install the HP 1050 HPLC System Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the HP1050 Gradient Pump under the desired timebase (via the Add
Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port.

On the Solvents tab, specify the number and names of the eluents that are
delivered by the pump.

On the Relays tab, check a box to enable or disable the corresponding
relay.

You do not need to change the presetting on the Error Levels tab.



672 Installing and Controlling Third-Party Instruments

5. Add the HP1050 Autosampler under the same timebase.

6. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port.

On the Rack tab, check the rack used.

On the Relays tab, check a box to enable or disable the corresponding
relay.

You do not need to change the presetting on the Error Levels tab.

7. To control the HP1050 HPLC system connect the HP1050S control panel
in the client of your Dionex Chromatography Management System to the
corresponding timebase.

Application
Nothing particular known.

Troubleshooting
Nothing particular known.

Further Information

For an overview on the HP1050 HPLC system, see  Agilent (formerly HP):
HP1050 - Overview.

 Note: The Dionex device drivers for HP1050 have been tested
successfully with the following firmware versions:
HP1050 GP rev 3.2 and HP1050 S rev 4.2. 
Should you have problems with firmware versions lower than the
ones indicated, a firmware update might help.

For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).
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 AGILENT (formerly HP): HP1100 - Overview

Device Type: HPLC system

Device Driver: HP 1100 HPLC System
Supported
Hardware
Options:

• HP1100 LC Diode Array Detector (tested for
firmware version A.03.61)

• Variable Wavelength Detector (VWD - firmware
version A.03.80)

• Pump:
High-pressure gradient pump, optionally with
solvent selection valves (Solvent Selection Valves,
FW: A.03.60),
Low-pressure gradient pump (A.01.06) or
Isocratic pump

• Degasser
• Sample thermostat (A.03.61)
• Injection unit (A.03.61)
• Column compartment with column thermostat

(optionally) + column switching valve (A.03.60).

What is required?

License: Extended Device Control
PDA License (for HP1100 LC Diode Array Detector)

Connection: IEEE cable
CAN cable for each module
(The cables are available via Agilent only.)

Hardware
Prerequisites:

IEEE board in the server PC of the Dionex
Chromatography Management System
(The board is available via Agilent or NI only.)

Control Panel: HP1100.pan

Further Information

For information on how to install the HP1100 HPLC system, see  Agilent
(formerly HP): HP1100 - Installation.
For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).
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 AGILENT (formerly HP): HP1100 - Installation

Hardware Installation

Device
Connection:

The device driver communication with the HPLC
system is via IEEE. Therefore, an IEEE board must be
installed in the server PC of the Dionex
Chromatography Management System. The PC is
connected to the HPLC system via an IEEE cable. If
the system includes a photodiode array detector, we
recommend connecting the PDA directly to the PC via
the IEEE cable. All other modules are then connected
to the PDA via CAN cables.

Device Settings: In addition, a corresponding VISA library must be
installed. The library is shipped as part of the IEEE
board package and is available from manufacturer.
After installation, run the I/O configuration application
once to configure the library.

Communication with the HPLC System HP1100 is
possible both, via Agilent IEEE boards or IEEE boards
from National Instruments (NI). For information, see:

Agilent (formerly HP):

 HP1100 - Installing and Configuring the HP
IEEE Board and the VISA Library

 HP1100 - Installing and Configuring the NI IEEE
Board and the VISA Library

Restrictions: Not known.

Software Installation

Install the HP 1100 HPLC System Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. First, turn on all HP1100 modules.

2. Start the server of the Dionex Chromatography Management System.

3. Start the Server Configuration of the Dionex Chromatography
Management System.
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4. Add the HP1100 HPLC System under the desired timebase (via the Add
Device command of the context menu).

5. The following settings are required on the different tabs (the links are
available in the Online Help only):

You do not need to change the settings on the General tab.

On the Components tab, select the installed devices as well as an HPIB
address and press Scan CAN.

On the Options tab, specify the options installed.

On the Solvents tab, specify the number and names of the eluents that are
delivered by the pump.

On the Rack and Syringe tab, specify the used rack and syringe.

You do not need to change channel assignment of the Signals tab.

You do not need to change the presetting on the Error Levels tab.

6. Turn off the detector and turn it on again. Wait approx. 15 s until the
firmware is active again.

7. In the Server Configuration, press OK in the HP1100 HPLC System dialog
box. The server configures and automatically reconnects all HP1100
modules.

8. To control the HP1100 HPLC system connect the HP1100 control panel in
the client of your Dionex Chromatography Management System to the
corresponding timebase.

Application

Hints for installing several HP1100 systems via one IEEE board
If you plan to connect more than one HP1100 system to the IEEE interface all
individual modules must have different HPIB addresses, i.e., all addresses
must be listed in the Show Devices dialog box. This is especially important
with the modules of the different HP1100 systems that are connected via IEEE
cables to the IEEE board.

If two HP1100 systems are connected to the IEEE board via their detectors, the
detector of the first system might get e.g. the HPIB address 26 and the detector
of the second system the HPIB address 27.
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Troubleshooting
Nothing particular known.

Further Information

For an overview on the HP1100 HPLC system, see  Agilent (formerly HP):
HP1100 - Overview.

For more information on the HP1100 HPLC system, see  Hints on
Programs for the HP1100 HPLC System.

For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).

 AGILENT (formerly HP): HP1100 - Installing and
    Configuring the HP IEEE Board and the VISA Library

HP-PCI (HP 82350A) and HP-ISA (HP 82341C)
The I/O configuration attempts to find all installed interfaces suitable for VISA
communication:
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Highlight your IEEE board (hp8234x) in the list of configured interfaces and
click Edit.

Ensure that the VISA interface name starts with GPIB, as shown. Also ensure
that the bus address does not conflict with the HPIB address(es) you plan to
use for your module(s) Generally, 30 is a suitable default value. Enable the
System Controller checkbox and click Edit VISA Config....
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Ensure that the Identify devices at run-time checkbox is disabled and use
the Add Device button to manually add the HPIB address you will be using for
your module(s). For information on the default HPIB address of each module
see the corresponding Agilent manuals.

 Caution: If you plan to connect more than one HP1100 system to one
IEEE interface, ensure that all modules use different HPIB
addresses and that all addresses are listed here! This is
especially important when using IEEE cables to connect the
modules to the IEEE board.

Close all dialogs with OK. You may be asked to reboot your system.
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We recommend using the following IEEE cards:
• HP 82350A (PCI-IEEE) Rev. B

• HP 82341C (ISA-IEEE)

together with the following VISA library:
• HP E2094H VISA 1.1 Rev H.01.02.

 Tip: The HPIB board 82335 is not compatible with the Dionex
Chromatography Management System.

For information on the respective HPLC system, see  Agilent (formerly HP)
HP1100 - Overview.

For information on how to install NI-IEEE boards and the VISA library, see
Agilent (formerly HP):  Agilent (formerly HP): HP1100 - Installing and
Configuring the NI-IEEE Board and the VISA Library.

 AGILENT (formerly HP): HP1100 - Installing and
    Configuring the NI IEEE Board and the VISA Library

NI-PCI (GPIB and GPIB+)
Instead of the Agilent IEEE boards IEEE boards from National Instruments (NI)
can be installed:

Insert the supplied CD. The setup program (CD:\AutoRun.exe) starts
automatically. Select Install NI-488.2 Software for Windows and follow the
instructions of the installation wizard. You can manage without the
Development Files and Samples component. If the installation wizard
prompts you, uninstall any existing installation first.

Having installed the board in the PC, another wizard guides you through the
configuration steps:
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Configure the GPIB0 board according to the installed board type:
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No additional settings are required. The second step checks the installation:

After the successful test

you can exit the Getting Started Wizard. Right click Measurement &
Automation\Instruments and Interfaces to open the context menu and select
Scan for Instruments. Then, the HP1100 modules that are connected to the
IEEE bus must be listed:
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For information on the respective HPLC system, see  Agilent (formerly HP):
HP1100 - Overview.

For information on how to install the HP IEEE boards and the VISA Library, see
Agilent (formerly HP):  Agilent (formerly HP): HP1100 - Installing and
Configuring the HP IEEE board and the VISA library.

 AGILENT (formerly HP): Hints on Programs for the
    HP1100 HPLC System

Hints on Program development for the HP1100 HPLC system
• Flow ramps (commands: ⇒Flow, ⇒%A, %B, %C, %D) cannot be

executed manually at negative times (t < 0) or in programs without an
Inject command. (The HP1100 pumps do not support this.)

• The ⇒Inject command and all sample preparation commands are only
accepted at the time t = 0. The HP1100 Autosampler executes these
commands as a block during the transition from Prerun to Run following a
possibly specified UV.Autozero command.

• Interpretation of the Inject command with explicit sample preparation: If
sample preparation commands are specified the position of the required
inject command among these commands is irrelevant. The actual inject
occurs either explicitly via the Valve ValvePosition=MainpassOnStart
command or automatically at the end of the sample preparation if the
command is not given.
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• Changes of the parameter of the 3D-field may result in an automatic
autozero of the PDA. During the execution of the autozero (see Property
UV.NotReadyCauses(Prepare)) no further command must be given that
would result in another autozero. If necessary, this can be achieved via the
command Wait UV.Ready. During the execution of the autozero no Run
must be started. Therefore, the Program Wizard adds a Wait UV.Ready
before the Inject command.

Hints on manual program creation
Programs for the HP1100 that were developed manually should include a
⇒Wait command before the Inject command for each module:

0.000 UV.Autozero

Wait UV.Ready and ColumnComp.Ready and
Sampler.Ready and Pump.Ready

Inject

3DFIELD.AcqOn

UV_VIS_1.AcqOn

UV_VIS_2.AcqOn

UV_VIS_3.AcqOn

UV_VIS_4.AcqOn

UV_VIS_5.AcqOn

(These commands are automatically inserted if the Program Wizard is used).

 Note: Generally, a time should be given at the beginning of a program
(pump and detector presetting, e.g. at the time "-1.000") thus
defining a time for each command.

For further information on how to install the HP1100 HPLC system, see
 Agilent (formerly HP): HP1100 - Installation.



684 Installing and Controlling Third-Party Instruments

 AGILENT (formerly HP): HP5890 - Overview

Device Type: Gas chromatograph

Device Driver: HP 5890 Gas Chromatograph
Supported
Hardware
Options:

• Up to two injectors (optionally with oven)

• Up to two detectors (optionally with oven):
Flame Ionization Detector (FID)
Thermal Conductivity Detector (TCD)
Nitrogen Phosphorus Detector (NPD)
Flame Photometric Detector" (FPD)
Electron Capture Detector (ECD)

• Oven (column thermostat)

• Auxiliary Heater (additional oven)

• Electronic Pressure Programming

• Purge A and Purge B valves

• 4 valves of the HP5890 series II

What is required?

License: Device Control

Connection: Special RS232 cable (also, see  HP5890: RS232
Cable in the appendix of these Installation
Instructions)

(The cable is not available from Dionex; it has be
ordered from Agilent and modified!)

Hardware
Prerequisites:

Data acquisition requires an A/D converter, e.g. a
UCI-100 Interface, a Dionex UI20 (Dionex part no.

46017), or any other A/D converter that is supported
by the Dionex Chromatography Management System,
e.g. PE Nelson Boxes including the corresponding
signal cables.

Interface Board:

Series I (serial numbers below 2443A-003099):
Interface board - Agilent part no. 19254A-001
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Hardware
Prerequisites:
(Cont'd)

Series II (serial numbers above 2443A-003099):
Interface board - Agilent part no. 19254A or 19242-
60030A

 Caution: Do not use the combined HP-IB/RS232
Interface Boards (Agilent part no.
19257), which are also available from
Agilent.

Usually, the interface board is not part of the default
GC equipment. It is installed instead of the INET port.
Installation, however, is possible in instruments only
that have one of the following EPROM versions:

HP5890 GC Series I: 05890-80150 or higher

HP5890 GC Series II: 05890-80300 or 80320

Serial Interface Board
Serial interface board with 4 COM ports
Dionex part no. 5906.2094 or

Serial interface board with 8 COM ports
Dionex part no. 5906.2095 or

Serial interface board with 8 COM ports
Dionex part no. 5906.2096

Control Panels: HP5890.pan or
HP5890 one Detector.pan

Further Information

For information on how to install the HP5890 GC, see  Agilent (formerly
HP): HP5890 - Installation.

For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).
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 AGILENT (formerly HP): HP5890 - Installation

Hardware Installation

RS232 Board
Installation:

First, switch off the GC and disconnect the unit from
the mains. Then, remove the right side control panel
on the right of the GC. You can now access the GC
motherboard.

Draw the INET board (if there is one) out of the slot
and replace it by the appropriate interface board. A
symmetrical connector is used for the serial cable.
The connector is located in the housing recess on the
top right below the cover (where the INET port was
previously located). As the connector is symmetrical,
the socket of the connecting cable can be placed
either way. The relevant pins on the 25-pin MinD
connector will always be correctly connected.
• Connect the analog cable (Agilent part no. 05890-

60780) to the selected channel of the UCI-100
(e.g. Signal 1 = Detector 1; Signal 2 = Detector 2).

 Tip: A separate cable is required for each
detector!

Device
Connection:

Connect the RS232 cable (12-pin connector) to the
HP RS232 board.

Then connect the 25-pin female connector to the
serial COM port cable of the PC.

Device Settings: After closing and switching on the instrument, the
baud rate is set to 9600 baud on the instrument. To do
this, press CLEAR on the GC keyboard, and then
press the "." key. The display will show CALIB AND
TEST [0-9]. Press 3 and Enter. The display should
show CONFIGURE NETWORK. Enter 1 and press
ENTER. This sets the baud rate to 9600 baud. The
setting becomes effective after resetting the
instrument ("CLEAR,"."," "5," "ENTER").
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Device Settings:
(Cont'd)

When using the HP7673 autosampler, the two
instruments are usually connected via an additional
cable. Remove this cable at both ends.

It is now possible to use the new Agilent autosampler
(of the HP6890 system). For details, see
Autosampler Series 6890.

Restrictions: Not known.

Software Installation
Settings required under Windows 98 (not NT/2000!)
The parameters of the serial port need to be changed. The receive buffer must
be set to Low. Proceed as follows:

Open the Control Panel via Start and Settings. Select System and the
Device Manager dialog tab. Open the Properties of the respective COM port.
On the Port Settings dialog tab, click Advanced and set the receive buffer as
low as possible.

Server Configuration
For information on how to install the HP5890 GC in the Server Configuration,
see  HP5890 - Server Configuration.

Application
Entering a Temperature Gradient
Entering a temperature gradient is either directly (via the Flow command from
the Control menu; GC-tab) or via a PGM file.

Under the Dionex Chromatography Management System, a temperature profile
is possible with a maximum of three ascents or descents (the HP5890 GC
cannot store more steps!). The maximum temperature change (ascent) is 70°C
per minute.

When entering a temperature gradient in the Program, the so-called "base
point philosophy" is used (similar to entering a flow or percent gradient in
HPLC). Each Temperature command serves as a base point for the gradient
program. Understandably, no gradient is executed before the Inject command.
Temperature gradients can only begin after the Inject command. If the program
does not contain an Inject command, this does not apply.

Temperature Settings



688 Installing and Controlling Third-Party Instruments

Temperature control of the injector, oven, and detector can be activated and
deactivated via the following commands:

0.00 InjectorA.TempCtrl = On or = Off

0.00 InjectorB.TempCtrl = On or = Off

0.00 GC.TempCtrl = On or = Off

0.00 DetectorA.TempCtrl = On or = Off

0.00 DetectorB.TempCtrl = On or = Off

To set the temperature of a single module e.g. to 80°C, the following command
must be entered:

0.00 InjectorA.Temperature = 80

0.00 InjectorB.Temperature = 80

0.00 GC.Temperature = 80

0.00 DetectorA.Temperature = 80

0.00 DetectorB.Temperature = 80

The temperature of the injector system and the detector should always be
approx. 15 - 20°C above the current oven temperature. Reaching the nominal
temperature on the instrument can take some time. Please note that the oven
heats faster than the injector and the detector system. As soon as the
temperature is reached, the GC sends a Ready signal. Only after this, injection
is possible via the autosampler.

Example:
The following program waits until the nominal temperature of 150°C is reached,
before the ⇒Inject command is executed:

 0.000 GC.Temperature = 150

 Wait GC.Ready

 Inject

 ...... ..............

 Caution: After receiving the nominal temperature value from the Dionex
Chromatography Management System, the instrument
implements the desired value as fast as possible. If the value is
"almost" reached, the Equilibration Time passes until the
instrument sends the confirmation message to the Dionex
Chromatography Management System. The duration of this time
interval can be set via the Equilibration Time parameter in the
Dionex Chromatography Management System.
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Troubleshooting
Should you have special questions, please contact the Dionex Service.

Further Information

For an overview on the HP5890 GC, see  Agilent (formerly HP): HP5890 -
Overview.

For information on how to install the HP5890 without controlled autosampler,
see  Agilent (formerly HP): HP5890 - without Autosampler.
For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).

 AGILENT (formerly HP): HP5890 - Server Configuration

Server Configuration Settings

Install the HP 5890 Gas Chromatograph Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the HP 5890 Gas Chromatograph under the desired timebase (via
the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):
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You do not need to change settings on the General tab.

On the Components tab, select the installed devices.

On the Oven tab, set the limits for the controllable temperature range.

On the Injector tab, you can set up the temperature control for the injector
oven.

On the Detector tab, specify the installed detector and its temperature
control.

The Aux tab allows you to set up the temperature control for the Auxiliary
Device.
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Open the Signal Configuration dialog box from the Signals tab by double-
clicking the respective channel.
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Assign a channel to the signal and name the signal in the Signal Name
field according to the selected detector type.

Remove all unavailable relays on the Relays tab:

You do not need to change the presetting on the Error Levels tab.

5. To control the HP5890 GC connect the HP5890 control panel or (in case of
just one detector) the HP5890 one Detector control panel in the client of
your Dionex Chromatography Management System to the corresponding
timebase.

Further Information

For an overview on the HP5890 Gas Chromatograph, see  Agilent
(formerly HP): HP5890 - Overview.

For information on how to install the HP5890 Gas Chromatograph, see
 Agilent (formerly HP): HP5890 - Installation.
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 AGILENT (formerly HP): HP5890 - without Autosampler
If there is no controlled autosampler available, the Inject Response has to be
read from a remote input or a "remote start" of the A/D converter into the
Dionex Chromatography Management System to start the sample.

No autosampler installed
In order to be able to synchronize the Inject Response with the program start at
the GC and the data acquisition at the Dionex Chromatography Management
System, use the remote start cable of the HP5890 (Agilent part no. 05890-
061080).

• To start data acquisition at an Inject Response, connect pins 7 and 8 to the
Remote Input of the Dionex Chromatography Management System. (This

relay is potential-free. Therefore, the polarity is not relevant if there is only
one remote input of the Dionex Chromatography Management System
connected.

• Install the Remote Inject driver in the  Server Configuration.

• Assign a remote input to the inject port of the Remote Inject:
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• Connect pins 7 and 8 of the transmission cable with the cables of the digital
input.

• The Dionex Chromatography Management System recognizes in the Inject
command line of a program file whether the state of the Remote Inject
changes and starts data acquisition as soon as the Run button is pressed
on the GC.

• Further functions of the transmission cable can be connected, if requested.

Non-controlled autosampler installed
With non-controlled autosamplers, such as Headspace Injectors, connect the
Inject Marker output of the autosampler to the remote input of the Dionex
Chromatography Management System at Remote Inject instead of the remote
start cable (polarity!).

The remote start cable of the HP5890 GC is not required!

For information on how to install the HP5890 gas chromatograph, see
 Agilent (formerly HP): HP5890.
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 AGILENT (formerly HP): CIS3
When operated under the Dionex Chromatography Management System the
CIS3 Injection System has to be controlled via relays and inputs, as there is not
separate driver available.

Hardware
To control the CIS3, one relay and one remote input are required. These are
made available via
• A 4 channel relay board (Dionex part no. 5919.000) or
• A 16 channel relay board (Dionex part no. 5919.010) and
• A remote input of the Dionex A/D board

Wiring

Connector 1
(CIS)

Signal
Name

Color Connector 2
HP5890 (used
by CM Relay &
Inputs)

Signal Name Relay or inputs
used by CM

1 Start Input Yellow 8 (removed) Start Output Relay (CIS_Start)
2 Not used
3 Ready

Output 0
Brown 12 (removed) GND Input (CIS_Ready)

4 Ready
Input

Gray 6 (removed) Ready Output Not used

5 2, 5, 7
connected
(removed)

Not used

6 Not used
7 GND Green 4 (removed) GND Relay (CIS_Start)
8 Ready

Output 1
Pink 11 (removed) GND Input (CIS_Ready)

• Cut the 12-pin connector at the line (see figure) to connect the relays and
inputs.
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• Connect the relay (CIS_Start) with CIS cable pins 1 (yellow) and 7 (green).
The polarity is not relevant.

• Connect the relay (CIS_Ready) with CIS cable pins 2 (brown) and 8 (pink).
The polarity is not relevant.

• Affix the cable with shrinking tube or something similar.

Settings in the Dionex Chromatography Management System
• Install relay (CIS_Start) in the  Server Configuration;

Function: The relay has two functions for the CIS3: First, it loads the
internal CIS3 program into its memory. Second, it starts the CIS3 program.

• Install Digital Input (CIS_Ready) in the Server Configuration;
Function: Setting the Wait for Ready signal for the Dionex
Chromatography Management System to pause the HP7673 sampler until
the initial condition of the CIS3 is reached.

• In addition, add the corresponding commands to your Program.

Program
The Wait CIS_Ready and CIS_Start settings must be used at the beginning of
the program.

-0.100 Wait CIS_Ready = 0
;waits until the CIS cooled down to the initial settings
-0.050 CIS_Start.On  Duration = 1.000
;starts the CIS cycle

0.000 Inject

;The CIS_Start command must be given in the PGM file in the line after
the Inject command:

CIS_Start.On Duration = 1.000
;starts the CIS temperature program

FID.AcqOn
;depends on the detector used (in this case: FID)

0.500 FID.AcqOff
;depends on the detector used (in this case: FID)

end

Further Information

For an overview on the HP5890 Gas Chromatograph, see  Agilent
(formerly HP): HP5890 - Overview.
For information on how to install the HP5890 Gas Chromatograph, see

 Agilent (formerly HP): HP5890 - Installation.



Installing and Controlling Third-Party Instruments 697

 AGILENT (formerly HP): HP6890 - Overview
Device Type: Gas chromatograph

Device Driver: HP 6890 Gas Chromatograph
Supported
Hardware
Options:

• Up to 2 Inlets
Options:
- Purged Packed EPC
- Cool On-Column EPC
- Split/Splitless EPC
- Purged Packed
- Cool On-Column
- Split/Splitless
- ACI
- manual ACI
- PTV
- Gerstel PTV
- <other PTV>
- PCM
- Gerstel CIS3
- <JIB>
- Volatiles
- Unknown/Other

• Column Oven

• Sampler optionally with
- up to 2 injectors (with 5 µl, 10 µl, 5 nl, or 10 nl)
- Tray
- Bar Code Reader

• Up to 2 Detectors (optionally with oven):
Flame Ionization Detector (FID)
Thermal Conductivity Detector (TCD)
Electron Capture Detector (ECD)
Nitrogen Phosphorus Detector (NPD)
Flame Photometric Detector (FPD)
micro Electron Capture Detector (µ-ECD)

• 8 valves
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What is required?

License: Device Control

Connection: RS232 null modem cable (Dionex part no.
8914.0103A also, see  Null Modem Cable (RS232)

 HP6890: A/D Cable
Hardware
Prerequisites:

Data acquisition requires an A/D converter, e.g. a
UCI-100 Interface, a Dionex UI20 (Dionex part no.

46017) or any other A/D converter which is supported
by the Dionex Chromatography Management System,
e.g. PE Nelson Boxes including the corresponding
signal cables.

Interface Board:

Series I (serial numbers below 2443A-003099):
Interface board - Agilent part no. 19254A-001

Series II (serial numbers above 2443A-003099):
Interface board - Agilent part no. 19254A or 19242-
60030A

 Caution: Do not use the combined HP-IB/RS232
Interface Boards (Agilent part no.
19257), which are also available from
Agilent!

Usually, the interface board is not part of the default
GC equipment. It is installed instead of the INET port.
Installation, however, is possible in instruments only
that have one of the following EPROM versions:

HP5890 GC Series I: 05890-80150 or higher

HP5890 GC Series II: 05890-80300 or higher

Serial Interface Board
Serial interface board with 4 COM ports
Dionex part no. 5906.2094 or
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Hardware
Prerequisites:
(Cont'd)

Serial interface board with 8 COM ports
Dionex part no. 5906.2095 or

Serial interface board with 16 COM ports
Dionex part no. 5906.2096

Control Panels: HP6890.pan or
HP6890 Single Injector.pan

Further Information

For information on how to install the HP6890 GC, see  Agilent (formerly
HP): HP6890 - Installation.

For information on how to install the HP6890 GC with the HP1512 Controller
Box, see  Agilent (formerly HP:) Autosampler for HP6890 + Controller-
Box HP G1512.

For an overview on the different HP instruments for which Dionex device
drivers are available, see  Agilent (formerly HP).

 AGILENT (formerly HP): HP6890 - Installation

Hardware Installation

Device
Connection:

RS232 null modem cable (Dionex part no.
8914.0103A; also, see  Null Modem Cable
(RS232) in the appendix of these Installation
Instructions).

The PC must be connected to the Modem port
(RS232C) of the gas chromatograph (Site
Preparation and Installation Manual, page 44, No. 4
in the illustration).

Device Settings: (Also, see the Site Preparation and Installation
Manual supplied with the GC.)

1. Press the [Options] key.

2. Use the arrow keys to select the line
Communication
(< on the right margin).
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Device Settings:
(Cont'd)

3. Press the [Enter] key.

4. The first five settings must correspond to the
device driver settings (see the General tab of the
instrument in the  Server Configuration of the
Dionex Chromatography Management System.
Caution: The order of the settings is different
here! Please note that End of command must be
set to LF.

The communication settings must be as follows:

Baud rate 9600
Handshake XonXoff
Parity None
Data bits 8
Stop bits 1
End of command LF

To change the settings, move the < selection to the
line to edit, and then press Mode/Type. Now, move
the < to the required value and press the [Enter]
key.

Restrictions: Not known.

Software Installation

Install the HP 6890 Gas Chromatograph Device Driver in the  Server
Configuration of the Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the HP 6890 Gas Chromatograph under the desired timebase (via
the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only).

On the General tab, select a free COM port.
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On the Options tab, specify the limits for the controllable temperature range
of the column oven. In addition, enable the EPC (Electronic Pneumatic
Control) option if you are using an electronic pneumatic control unit.

The Front/Back Inlet tab allows you to set up the temperature control for
the Inlet.

 Tip: The Programmable Temperature Vaporizing Inlet (PTV) is
available in various variants from Agilent (OEM version) or the
manufacturer, Gerstel, (under the name of Cooled Injection
System CIS). Ensure that the correct variant is selected during
the installation.

The Volatile Interface is currently not supported.

On the Sampler tab, indicate the installed autosampler components:
Tray, Bar Code Reader, Front/Back Injector + syringe type.

On the Front/Back Detector tab, specify the installed detector(s) and
its/their temperature control.

Open the Signal Configuration dialog box from the Signals tab by
double-clicking the respective channel. Assign a channel to the signal and
name the signal in the Signal Name field according to the selected
detector type.

On the Relays tab, remove all relays that are not used.

You do not need to change the presetting on the Error Levels tab.

5. To control the HP6890 GC connect the HP6890 control panel or (in case of
just one injector) the HP6890 Single Injector control panel in the client of
your Dionex Chromatography Management System to the corresponding
timebase.

Application

Notes on the Device Driver:

General
Experienced HP6890 users should be able to control the instrument without
any problems. In the Dionex Chromatography Management System, short
descriptions of the GC commands are available in the corresponding
Command dialog box or the Properties/Link box.
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In the Dionex Chromatography Management System, pressure is always stated
in bar. Selecting a different pressure unit is not supported. For further
information, please contact the Dionex Service.

Column
It is possible to enter column dimensions and connections. However, entering
the calibration is currently not possible. If column dimensions are not defined,
certain commands cannot be executed (e.g.: Velocity, MakeupMode =
Combined, etc.).

It is not recommended to enter the column dimensions and connections in a
sample program. However, the parameters should be included in the Audit Trail
via the Log command.

Valves
Special valve types (Multiposition, Gas Sampling) are currently not supported.
For further information, please contact the Dionex Service.

Aux
Aux are currently not supported. For further information, please contact the
Dionex Service.

Sampler
The extended capabilities of the HP7683 sampler (e.g. solvent prewashes) are
now supported. These were not supported with the model 7673.

When connecting the instrument for the first time, some (or many) error
messages may appear starting with Error log at. These are previous errors
recorded by the sampler. You can simply ignore them. Future versions will
show new errors only.

Barcode Reader: If UseBCR= On, the barcode of the sample is read during the
Inject command and is logged in the Audit Trail.

Application

Entering a Temperature Gradient
Entering a temperature gradient is performed either directly (Flow command
from the Control menu; GC-tab) or via a PGM File.
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For the HP6890, a temperature profile can be entered with a maximum of six
ascents or descents (the HP6890 GC cannot store more steps!). The maximum
temperature change (ascent) is up to 120°C per minute, depending on the
oven type.

Gradients are entered in the Program Wizard or online in the typical format for
GC applications (the starting and end temperatures are entered as well as the
modification rate). In the program, however, the so-called "base point
philosophy" is used (similar to entering a flow or percent gradient in HPLC).
Each temperature command serves as base point of the gradient program.
The Wizard automatically converts the entered rates into the base point
representation.

However, no gradient is executed before the Inject command. Temperature
gradients can only begin after the Inject command. If the program does not
contain an Inject command, this does not apply.

Temperature Setting Commands
Temperature control of the oven, the two inlets and the two detectors can be
activated and deactivated via the following commands:

0.000 FrontInlet.TempCtrl=On Or = Off

0.000 BackInlet.TempCtrl=On Or = Off

0.000 GC.TempCtrl=On Or = Off

0.000 FrontDetector.TempCtrl=On Or = Off

0.000 BackDetector.TempCtrl=On Or = Off

To set the temperature of an individual module to 80°C, use the following
command:

0.000 FrontInlet.Temperature = 80

0.000 BackInlet.Temperature = 80

0.000 GC.Temperature = 80

0.000 FrontDetector.Temperature = 80

0.000 BackDetector.Temperature = 80

Reaching the nominal temperature on the instrument can take some time.
Please note that the oven heats faster than the injector and the detector
system. As soon as the nominal temperature is reached, the GC sends a
Ready signal. Only after this, injection is possible via the autosampler.
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Example:
The following program waits until the nominal temperature 150°C is reached,
before the Inject command is executed:

 0.000 GC.Temperature = 150

 Wait GC.Ready

 Inject

 ...... ..............

 Caution: After receiving the nominal temperature value from the Dionex
Chromatography Management System, the instrument
implements the desired value as fast as possible. When the
value is "almost" reached, the Equilibration Time passes until
the instrument sends the confirmation message to the Dionex
Chromatography Management System. The duration of this time
interval can be set via the Equilibration Time parameter in the
Dionex Chromatography Management System.

Troubleshooting
Should you have special questions, contact the Dionex Service.

Further Information

For an overview on the HP6890 GC, see  Agilent (formerly HP): HP6890 -
Overview.

For information on how to install the autosampler for the HP6890 GC with the
HP1512 Controller Box, see  Agilent (formerly HP): Autosampler for the
HP6890 + Controller-Box HP G1512.

For an overview on the different HP devices for Dionex device drivers are
available, see  Agilent (formerly HP).
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 AGILENT (formerly HP): GC-Autosampler - Flow Chart
The following chart describes the device drivers required for the respective
applications:

For information on how to install the different autosamplers, see:

GC Autosampler  HP7673 and  Agilent (formerly HP): Autosampler for
HP6890 + Controller Box HP G1512
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 AGILENT (formerly HP): Autosampler for HP6890 +
    Controller Box HP G1512
Autosamplers of the GC Series HP 6890 (Controller Box HPG1512)
Instead of the Autosampler 7673 (for installation information on the HP7673
see  Agilent (formerly HP): HP7673), which is no longer available since mid
1997, Agilent now supplies the autosampler of the HP6890 series and a
corresponding controller box. The controller box (HPG1512) is capable of
emulating the HP7673 controller box in standalone operation. The controller
box of the system already contains all required plug-in cards, so that no
conversion is possible. The DIP-switches on the rear panel of the box must be
set as follows.

Left DIP-switch: set all switches to 0, except the switch at the far right to 1.

Right DIP-switch: set all switches to 0.

After setting the switches, the controller box must be switched off and on again.

Connecting the Cables
• Use a serial standard interface cable (25-pin to 9-pin; Dionex part no.

8914.0103A) to connect the RS232 output of the controller board to the
serial interface of the server PC.

• Connect the 9-pin end with the 9-pin to 25-pin extension cable (part no.
8914.0110).

• Finally, connect the 25-pin connector of the extension cable with the serial
COM port cable of the PC.

The Controller Box of the HP6890 (HPG1512) behaves as the box of the
HP7673. Nevertheless, the HP 6890 Gas Chromatogram Device Driver can
be used for controlling the autosampler. In the  Server Configuration under
Sampler, select the Automatic Liquid Sampler Installed option and select
the specification according to your installation.

 Caution: If you use an Agilent autosampler, the program files must be at
least 2 min. long to allow the autosampler sufficient time until
the next injection.



Installing and Controlling Third-Party Instruments 707

For a flow chart on the different HP autosamplers, see  Agilent (formerly
HP): GC Autosamplers - Flow Chart

For information on how to install the HP7673, see  Agilent (formerly HP):
HP7673 - Overview.

Further installation information is available for the following Agilent devices:

HPLC Systems  Agilent (formerly HP): HP1050 and  Agilent (formerly
HP): HP1100 - Overview

Gas Chromatographs  Agilent (formerly HP): HP5890 and  Agilent
(formerly HP): HP6890 - Overview.

 AGILENT (formerly HP): HP7673
Controlling the HP7673 GC Autosampler requires the following hardware:

From Agilent:
• RS232-C-board for COMM Agilent part no.: 18594-60080

• Firmware version 80305 or higher

 Tip: For the HP6890 Controller Box HPG1512, no RS232 board is
required!

From Dionex:
RS232 cable ( Null Modem Cable) DX part no.: 8914.0103A

(25-pin - 9-pin, not 9-pin - 9-pin!)

Installation
The autosampler HP7673 corresponding to the Gas Chromatograph HP5890
consists of three parts: a controller (controller box and boards), a sample tray,
and the injection unit with two injectors. As the injection unit has its own turret,
the sample tray is not required. However, the Dionex Chromatography
Management System currently supports this instrument only with the tray!

For operating the autosampler, the controller box is first fitted with the RS232-C
board (Agilent part no.: 18594-60080). Connect the RS232 cable to the COMM
position.
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Insert the board in the COMM slot. Configure the board via the W1 baud rate
jumper (9600 baud, 8 data bits, no parity, and 1 stop bit).

Then, the tray board (Agilent part no. 18594-60075) required for connecting the
sample tray is inserted.

Finally, install a controller board (also, see the Installing the Controller
chapter in the HP7673 Automatic Sampler Operating Manual). Choose
either the HPIB board (18594-60110) or the standalone controller board
(Agilent part no. 18594-60060).

• The HPIB-controller enables HPIB and RS232 communication. With the
Dionex Chromatography Management System, only the RS232
communication is used. The communications parameters (8 data bits, no
parity, 1 stop bit) must be set via the 5-fold DIP-switch.

• Set the required baud rate via the DIP-switches on the RS232 board:

DIP-switch 1 2 3 4 5
1 0 1 0 0

Or On Off On Off Off

• On the rear of the standalone controller, there is a (9-pin) SUB-D connector
labeled Test. Ensure that the firmware is version 80305 or higher. The
corresponding EPROM is shipped with the serial interface board (60080).

If you do not have the RS232-C Board or the Controller Board, you can order
the missing board later. However, it may be preferable to purchase a new
Controller Box Agilent G1512 (see below) instead.

Connecting the Cables
• Connect the injector and the controller box via the appropriate Agilent

connecting cable.

• Connect the sample tray to the tray board.

• Use a serial standard interface cable (25-pin to 9-pin; Dionex part no.
8914.0103A) to connect the RS-232 output of the RS232 board to the
serial interface of the server PC.

• Connect the 25-pin end to the RS232 output of the Controller Box.
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• Connect the 9-pin end with the 9-pin to 25-pin extension cable (Dionex part
no. 8914.0110).

• Finally, connect the 25-pin connector of the extension cable with the serial
COM port cable of the PC.

Dionex Device Driver
Operating the autosampler requires the HP7673A.CDD device driver. As soon
as this driver is located in the BIN directory, install the
HP 7673A GC Autosampler device driver in the  Server Configuration of
the Dionex Chromatography Management System.

 Note: In contrast to controlling the autosampler HP7673 via the
GynkoSoft data system, only a single device driver is required in
the Dionex Chromatography Management System!

Please determine which controller board (standalone or HPIB) is used for
controlling the autosampler HP7673. You can recognize the standalone board
by the test connector and the HPIB board by the HPIB connector protected by
a red cover when unused.

Also, define the injection system of the (front-/rear injector), the syringe size,
and the injector inlet.

For information on how to install the HP7673 in the Server Configuration, see
 HP7673 - Server Configuration.

For a flow chart, regarding the different HP autosamplers, see  Agilent
(formerly HP): GC Autosampler - Flow Chart.
For information on how to install the Controller Box which is available since
1997 instead of the HP7673, see  Autosampler for HP6890 + Controller
Box HP G1512A.
Further installation information is available for the following Agilent devices:

HPLC systems  Agilent (formerly HP): HP1050 - Overview and  Agilent
(formerly HP): HP1100 - Installation.

Gas Chromatographs  Agilent (formerly HP): HP5890 - Overview and
 Agilent (formerly HP): HP6890 - Overview.
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 AGILENT (formerly HP): HP7673 - Server Configuration

Settings in the  Server Configuration:

Select the HP Sampler 7673 and assign a free COM port on the General tab:

There are two versions of controller types available. For the HP7673 select the
HPIB protocol if the operation of the autosampler is not possible with the
standalone protocol. The HP6890 Controller Box must always be installed as
standalone controller.
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Finally, install all available components.

For information on how to install the HP7673 autosampler, see  Agilent
(formerly HP): HP7673
Further installation information is available for the following Agilent devices:

HPLC Systems  Agilent (formerly HP): HP1050 - Overview and  Agilent
(formerly HP): HP1100 - Overview

Gas Chromatographs  Agilent (formerly HP): HP5890 - Overview and
 Agilent (formerly HP): HP6890 - Overview.
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 ANTEC
If the electrochemical detector ANTEC DECADE is connected to the HPLC
system via an RS232 interface, a 9-pin standard Null Modem Cable and a
mouse adapter (9-pin -> 25-pin), it can be operated directly from any the client
of the Dionex Chromatography Management System.

 Note: Alternatively, a 9/25-pin cable  (Dionex part no. 8914.0122 for a
25-pin port or Dionex part no. 8914.0138 for a 9-pin port) can be
used for the connection with the following pin assignment:

Antec Decade PC
25-pin Sub-D Connector 25-pin

Sub-D Connector
9-pin

Sub-D Connector
(UCI-100)

2 ------------ 3 2
3 ------------ 2 3
7 ------------ 7 5

4, 5, and 20 internally
connected

In addition to the correct installation and configuration of the detector via the
Server Configuration, correct serial communication is only possible if the
instrument is switched to remote operation. Perform the following steps:

• Switch the detector on and wait until the main screen is displayed.
Detectors with the RS232 option (only these can be controlled by the
Dionex Chromatography Management System), the instrument display
shows on the lower right: RS232.

• Press the RS232 (F5) button on the instrument.

The detector is now in remote operation and can be controlled via the data
system. All functions of the detector that are otherwise performed on the
instrument or via the Dialogue software are now available under the Dionex
Chromatography Management System. A distinction is made between the

DC Mode, the PULSE Mode, and the SCAN Mode.

• Open the ANTEC.pan control panel to operate the detector.

• Activate the switch Connect to start the detector.

• As soon as the remote operation is ensured, setting the parameters can be
continued in the usual way.
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• Details on the individual parameters can be accessed directly in the control
panel via the F1 key. However, this requires basic knowledge in operating
the detector. For further information, see the detector manual.

In contrast to the parameters, the measuring data is not communicated via the
RS232 interface. For the data communication, the detector must be connected
to the A/D Converter via the outputs Rec. and/or Int..
The integrator output (Int.) supplies an analog signal that is not manipulated
and that accurately indicates the state of the working electrode. In contrast, the
recorder output (Rec.) supplies a smoothed, electronically processed signal.

Please note that both outputs can be used in DC mode, but only the recorder
output in PULSE mode and SCAN mode.

The Online Help illustrates the four Server Configuration pages on this
detector type: General, Signals, Relays, and Error Levels.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 APPLIED BIOSYSTEMS
For controlling the ABI 785A UV detector (identical with Perkin Elmer 785A),
the connecting cable (Dionex part. no. 8914.0119 for a 25-pin port or Dionex
part no. 8914.0137 for a 9-pin port) must have the following pin assignment:

ABI 785A PC
Serial A

9-pin Sub-D (male) 25-pin Sub-D (female) 9-pin Sub-D (female)
9 ------------ 2 3
5 ------------ 3 2
1 ------------ 7 5

The communications parameters must be set as follows: 9600 Baud, 8 Data
bits, No Parity, 1 Stop bit, No Handshake.
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Set the correct baud rate on the instrument itself. From the instrument's startup
display, perform the following steps:
• Press More (F4 key).

• Press Util (F2).

• Press More (F4).

• Use the arrow keys to move the cursor to the BAUD parameter.

• Use the Prev. and Next keys to select the value 9600.

• Press Done (F4).

• Press Exit (F1).

This brings you back to the startup display.

As special parameters, the Rise Time as well as Scan and SetRelays (the
latter are, however, not included in the ABI785A.PAN control panel) are
available.

The Online Help illustrates the three Server Configuration pages on this
detector type: ABI_785A_UV-VIS_Detector, Generic, and Error Levels.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 BERTHOLD
The Dionex Chromatography Management System is capable of controlling the
BERTHOLD LB 507A and LB 509 Radioactivity Detectors. Select the
Berthold_LB_507_509 Device Driver in the Server Configuration. Ensure
that the LB507AB.GEN driver is available in the BIN directory and that the
radioactivity detector is connected to the PC via a special cable (see below).

 Note: Before connecting the radioactivity detector to the Dionex
Chromatography Management System, perform a reset at the
device (see device manual).
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Pin Assignment of the RS232 Connecting Cable
(Dionex part no. 8914.0114 for a 25-pin port or Dionex part no. 8914.0135 for a
9-pin port)

LB 507 A/LB 509 PC
25-pin Sub-D Connector

(female)
25-pin

Sub-D Connector (female)
9-pin

Sub-D Connector
(female)

1 = Shield 1 = Shield
2 ------------ 3 2
3 ------------ 2 3
5 ------------ 4 7
7 ------------ 7 5

6, 8, 20 internally connected 4, 5 internally connected 7, 8 internally
connected

 Note: The model Berthold LB 508 has a completely different (binary)
control protocol. Controlling this instrument is currently not
possible via the Dionex Chromatography Management System.

Pin Assignment of the Rate-Meter Connector (Analog Output of the
Detectors)

Pin Direction Function
1 Out Analog1 lo
2 Out Analog1 hi
3 Out Analog2 lo
4 Out Analog2 hi
5 Out High lumin.
6 - GND
7 - -
8 - -
9 Out +15V

The Online Help illustrates the three Server Configuration pages on this
detector type: Berthold_LB_507_509, Generic, and Error Levels.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 BIO-RAD
To control the BIO-RAD AS 100 Autosampler, select the BIO_RAD AS 100
Device Driver in the Server Configuration. Ensure that the bras100.cdd driver
is available in the BIN directory.

Dionex Chromatography Management System - Options
Operating the Dionex Chromatography Management System requires the
Extended Device Control Feature (  Options of the Dionex
Chromatography Management System). Select About CHROMELEON (link
available in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether this option is
available.

Connection
A standard Null Modem Cable with all lines connected (the assignment of the
Dionex null modem cable is slightly different!) as well as a gender changer from
female to male and a 9-pin to 25-pin adapter are required for the AS 100 side.

AS 100 PC
25-pin Sub-D connector

(male)
9-pin Sub-D connector

(female)
1 = ground
2 TXD ------------------ RXD 2
3 RXD ------------------ TXD 3
4 RTS ------------------ RTS 8
5 CTS ------------------ RTS 7
6 DSR DTR 4
7 GND ------------------ GND 5
20 DTR DSR 6

Control via the Dionex Chromatography Management System
Controlling the AS 100 requires version 6.01 (or higher) of the Dionex
Chromatography Management System. Before an injection is possible, the
Activity Code string of the sampler must be "STOP". In addition, the
ReadForInject property must be true (= 1). Otherwise, a flush command must
be executed, i.e., a flush command is required between two injection
commands!
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Example for a typical AS 100 Program

-0.1 Flow = 1.000

Sampler.Temperature.Nominal = 5

; make sure that the sampler becomes ready for inject

Sampler.Flush

 0.000 ; wait until sampler becomes ready for inject

Wait  Sampler.ReadyForInject

UV.Autozero

Inject

UV_VIS_1.AcqOn

10.000 UV_VIS_1.AcqOff

End

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 CTC ANALYTICS

CTC ANALYTICS A200S (GC Autosampler; identical with Fisons A200S)
The design of the GC Autosampler A200S corresponds to the A200S from
Fisons. Both instruments can be controlled via the Dionex Chromatography
Management System. For this, select the CTC_A200S_Sampler Device
Driver in the Server Configuration. Ensure that the CTCA200S.GEN driver
required for both instruments is available in the BIN directory and that the PC
and the autosampler are connected via a serial connecting cable.

Please note, however, that instead of a so-called "null modem cable" a
Modem Cable (Dionex part no. 8914.0128 for a 25-pin port or Dionex part no.

8914.0144 for a 9-pin port) is used. Pins 2, 3, and GND are supported only.
The sampler requires a 25-pin male connector on its side.

For controlling these two instruments, it is necessary to set the Start Signal
Source parameter to Remote on the instrument. For details, see the Manual
supplied with the instrument.
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The Online Help describes the special page for this autosampler in the Server
Configuration (Sampler).

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 DOSTMANN
Controlling the Dostmann P550 Temperature Measuring Device is via the
Dostmann Thermometer P550 Device Driver.

To connect the thermometer to the PC, connect the PC adapter cable (included
in shipment) to the socket that branches off the power unit cable. Connect the
PC adapter cable to a free serial port of your PC.

The thermometer digitally transmits the temperature data to the data system.
To enable recording of data, a virtual channel must be installed. Install a

Virtual Channel Driver in the  Server Configuration; also, see to  VCD:
Installation.

For further installation information, see the general operating instructions:
Connecting the Dionex Column Thermostat PQ Kit to CHROMELEON.

 ESA

ESA CouloChem II (Electrochemical Detector)
If the ESA CouloChem II electrochemical detector) is connected to the HPLC
system via an RS232 interface, it can be operated directly from any Client of
the Dionex Chromatography Management System.

The instrument is connected via a serial RS232 cable (for the Dionex part nos.,
see Null Modem Cable). The pin assignment must be as follows:

ESA CouloChem II PC
COMx (25-pin) COMx (9-pin)

2 ---------------- 2 3
3 ---------------- 3 2
5 ---------------- 7 5

Internal: Internal:
4 - 5 7 - 8
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The interface parameters must be set as follows:

Baud rate: 4800
Data bits: 7
Stop bits: 1
Parity: EVEN
Handshake: NONE

In addition to the correct installation and configuration of the detector via the
Server Configuration (ESA CouloChem II ECD Device Driver), the
instrument itself must be switched to remote operation. Perform the following
steps:

• Switch on the detector. After the detector self-test is completed press the
MODE key and then the arrow key  until the text SYSTEM MENUS is
shown on the display.

• Press ENTER until the text ENTER REMOTE COMMUNICATIONS MODE
appears. Renewed pressing the ENTER key activates the remote mode.

The detector can now be remote controlled via the data system. All setting and
analysis parameters of the DC Mode and the PULSE Mode are supported.
There is a separate control panel for each mode.

All parameters of the DC mode can be set via the ESA_DC.pan control panel.
In the window ESA_PULSE.pan all parameters of the mode PULSE can be
reached.
• Open one of the two windows to operate the detector.

• Activate the switch Connect. You will now be notified that it is necessary to
activate the remote mode on the instrument. If there is a serious error (e.g.
power failure), this switch is deactivated. For the user this means that the
ESA detector must be switched manually to remote operation again.
Otherwise, it would be in an undefined start state. This is necessary
because the ESA detector is not capable of reporting its status to the data
system.

• As soon as the remote operation is ensured, setting the parameters can be
continued in the usual way.

• Details on the individual parameters can be accessed directly in the control
panel via the F1 key. However, this requires basic knowledge of how to
operate the detector. For further information, see the detector manual.
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In contrast to the parameters, the analysis data is not transferred via the
RS232 interface. It is recorded via the A/D Converter and is then forwarded
to the system.

The Online Help illustrates the three Server Configuration pages on this
detector type: General, Signals, and Error Levels.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments

 FINNIGAN: aQa Mass Spectrometer
Controlling the aQa Mass Spectrometer requires the following files:

FinMsAqa.cdd (for CmDriver.exe),

FinMsAqaX.cds (for CmServer.exe),

a message DLL (messages.dll), and

a configuration module (TspCfg.cdc).

The demo.raw file allows demo data creation.

Instrument Installation
aQa data acquisition cannot be started by the Xcalibur software interfaces.
Therefore, it is required to connect the Inject-Output-Signal of the LC

Autosampler to the Finnigan aQa User Interface IN1 digital input (use the
black and red wires of the 3 wire cable that is shipped with the aQa mass
spectrometer).

For information on the software installation required for data acquisition, see
How to ...: Actions Related to the aQa-MS  Installing MS Components.

 Tip: The aQa mass spectrometer can be contacted via the TDAT
board. If you are using a DELL PC, ensure to reserve the IRQ5
in the BIOS for this ISA board. In addition, also reserve DMA 1
and 0x300-0x307 as I/O address, if required by your BIOS.

TIC and SIM Channel Device Properties and Commands
These channels are standard data channels with the following properties:
Property Min Max Purpose
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MinMass 2.00 1636.00 Read only Minimum mass recorded in this
trace. (SIM channels only)

MaxMass 2.00 1636.00 Read only Maximum mass recorded in this
trace. (SIM channels only)

Polarity Negative Positive Read only Polarity
SourceVoltage 0 V 200 V Read only aQa max voltage. (SIM

channels only)
SourceVoltage 0 V 200 V Read only aQa max voltage range.

(TIC/TICF channels only)
Filter n/a n/a Read only Filter string as used in Finnigan

aQa method.

 Tip: No data compression is supported. Thus, neither the Step
command, nor the MaxAutoStop or Average commands can be
set. Manual data acquisition is not possible either. In addition,
acquisition is started at time 0.000 and stopped at program end
for all channels that deliver data according to an aQa method
file. These channels appear neither in the Program Wizard nor in
the control panel.

MS Device Properties and Commands
Property Min Max Default Purpose
Ready Ready=1,

Busy=0
Read only Indicates whether the

spectrometer is busy or
idle.

Operation On=1, Off=2,
Standby=3

Off Indicates whether the
spectrometer is busy or
idle.

Status n/a Read only Indicates the
spectrometer's operational
status.

Range 1
(for exp(1)
Counts)

10
(for exp(10)
Counts)

Scaling range used for
online signal plot during
data acquisition. (Can be
set only before data
acquisition starts.)

Smoothing None=-1,
Gaussian=0,
Boxcar=1

None Smoothing algorithm.
Note: This parameter is
used by Xcalibur raw data
extraction during online and
post-run channel extraction.
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Property Min Max Default Purpose
SmoothingPoints 3, 5, 7, 9,

11, 13, 15
3 Number of data points used

for smoothing.
Note: This parameter is
used by Xcalibur raw data
extraction during online and
post-run channel extraction.

HardwareVersion n/a Read only The mass spectrometer's
hardware version.
Note: This value is
available only after the first
raw data acquisition.

FirmwareVersion n/a Read only The spectrometer's
firmware version.
Note: This value is
available only after the first
raw data acquisition.

Command Purpose
Connect Connects the device
Disconnect Disconnects the device
Reset Resets the device to the defaults

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 FISONS
The following Fisons instruments can be controlled:

 Fisons Gas Chromatograph 8000
 Fisons Autosamplers AS800 and A200S (for the latter, also see  CTC

ANALYTICS).

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 FISONS: Gas Chromatograph 8000 - Overview

Device Type: Gas chromatograph

Device Driver: Fisons 8000 Gas Chromatograph
Supported
Hardware
Options:

Fisons 8000 gas chromatographs or Mega 2 GC with:
Electrometer EL800
Digital Flow and Pressure Controller (DFPC) with up
to 2 injectors
and up to 7 valves.

What is required?

License: Device Control

Connection: RS232 cable (for details, see  Fisons GC: Cable
8914.0126 / 8914.0142 in the appendix of these
Installation Instructions)

Hardware
Prerequisites:

Data acquisition requires an A/D converter, e.g. a
UCI-100 Interface with the corresponding signal

cables

Free RS232 port

Software
Prerequisites:

• FisCfg.cdc configuration module

• Message.dll

Control Panels: Fis8000A.pan or
Fis8000B.pan or
Fis8000C.pan

Further Information
For information on how to install the Fisons 8000 Gas Chromatograph, see

 Fisons: Gas Chromatograph 8000 - Installation.

For an overview on the different Fisons instruments for which Dionex device
drivers are available, see  Fisons.
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 FISONS: Gas Chromatograph 8000 - Installation

Hardware Installation

Device
Connection:

Device Connection is via an RS232 cable (for details,
see  Fisons GC: Cable 8914.0126 / 8914.0142 in
the appendix of these Installation Instructions)

Device Settings: Communication is via the following interface
parameters: 9600 baud, 8 data bits, No parity, 1 stop
bit. The baud rate has to be set at the instrument as
well. Proceed as follows:

Simultaneously pressing the keys <SB TIME - PROG
RESET - ACTUAL TEMP> sets the value to 9600
baud.

Restrictions: Not known.

Software Installation

Install the Fisons 8000 Gas Chromatograph Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Fisons 8000 Gas Chromatograph under the desired timebase
(via the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port.

On the Components tab, enter the installed components. In addition,
specify the maximum flow rate of the injector(s).

The Oven & Zones tab allows you to set up the temperature control for the
oven as well as three temperature-controlled heating zones for the GC.
Two channels and two injectors are available.
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Open the Signal Configuration dialog box by double-clicking the
respective channel on the Signals tab. Assign a channel to the signal and
name the signal in the Signal Name field according to the selected detector
type.

On the Relays tab, remove all relays that are not used.

You do not need to change the presetting on the Error Levels tab.

5. To control the Fisons GC connect one of the Fis8000A, Fis8000B, or
Fis8000C control panels in the client of your Dionex Chromatography
Management System to the corresponding timebase.

Application
The Fisons 8000 Gas Chromatograph Device Driver allows controlling the
oven temperature of the Fisons 8000 gas chromatograph and the Mega 2 GCs.

In addition, you can record the signals of two channels (GC_1, GC_2) and
address up to seven valves. Controlling the temperature of up to three so-
called "heating zones" (additional temperature-controlled modules that are
externally controlled) is possible as well.

If the Fisons 8000 is supplied with the Digital Flow and Pressure Controller
(DFPC), the Flow and Pressure can be controlled as well.

Further Information

For an overview on the Fisons Gas Chromatograph, see  Fisons: Gas
Chromatograph 8000 - Overview.

For an overview on the Fisons instruments for which Dionex device drivers are
available, see  Fisons.

Also, see:

 Fisons Autosamplers AS800 and AS200S (the latter corresponds to the
CTC A200S, see  CTC ANALYTICS)
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 FISONS: AS800 GC Autosampler- Overview

Device Type: GC Autosampler

Device Driver: FisonsAS800_Sampler
Supported
Hardware
Options:

What is required?

License: Device Control

Connection: RS232 cable (for details, see  Fisons AS: Cable
8914.0127 / 8914.0143 in the appendix of these
Installation Instructions)

Hardware
Prerequisites:

Data acquisition requires an A/D converter, e.g. a
UCI-100 Interface with the corresponding signal

cables

Free RS232 port

Software
Prerequisites:

• FisCfg.cdc configuration module

• Message.dll

Control Panel: FISAS800.pan

Further Information
For information on how to install the Fisons AS800 GC Autosampler, see

 Fisons: Autosampler - Installation.

For an overview on the different Fisons instruments for which Dionex device
drivers are available, see  Fisons.
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 FISONS: AS800 GC Autosampler- Installation

Hardware Installation

Device
Connection:

The Fisons GC autosamplers are connected to the
Fisons 8000 gas chromatograph via a 37-pin
connecting cable. When the injection is completed,
the GC sampler sends the signal to the GC, which in
turn sends it to the Dionex Chromatography
Management System via a relay. The pins 12 and 24
of the GC AUX connector are used. Connect the
signal and GND lines of a remote input to these.

GC Fisons 8000 Remote Input
AUX Connector                                   (e.g. A/D Board)           
(25-pin; Sub-D, female) (9-pin, Sub-D, male)

12 ----------- Signal
24 ----------- GND (0V)

In the Server Configuration, specify the remote input
that is used by the Fisons AS800 sampler under
Inject Port on the Sampler tab!

Device Settings: The following communications parameters must be
used: 9600 Baud, 8 Data Bits, No Parity, 1 Stop Bit,
Rts/Cts handshake.

Some Fisons AS800 GC samplers are set by the
manufacturer to a baud rate that is not suitable for the

Device Drivers of the Dionex Chromatography
Management System.

When switching on the sampler, press the Meth and
Seq keys simultaneously to check the baud rate
setting. The following information will be displayed:

AS800 SET UP: b9600

ACT INJ SMP SYR MAN

The value given to the top right is the baud rate
setting. This information may not be available in
previous firmware versions. If so, press EXIT to leave
the setup menu.
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Device Settings:
(Cont'd)

If the baud rate is not set to 9600, move the cursor to
the baud rate field using the key < (arrow to the left).
Set the new baud rate with the up and down arrow
keys and leave the setup menu by pressing EXIT.

Restrictions: Not known.

Software Installation

Install the Fisons AS800 Sampler Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System

3. Add the FisonsAS800_Sampler under the desired timebase (via the Add
Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the FisonsAS800_Sampler tab, have the Demo Mode switched off.

On the Sampler tab, select a free inject port.

You do not need to change the presetting on the Error Levels tab.

5. To control the Fisons autosampler connect the FISAS800 control panel in
the client of your Dionex Chromatography Management System to the
corresponding timebase.

Application
The Online Help offers information on Commands and Parameters of the
Fisons AS800.

After the Connect command, the parameter values are initially unknown to the
Dionex Chromatography Management System (blank fields in the AS800
control panel). You should enter meaningful values before injection. Use one of
the Method A/B/C/D buttons on the control panel or specify them in the sample
program (also, see How to ...: Actions in the PGM Editor  Creating a
Program).
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A sensible starting point might be this:
; Assuming a standard 10 µl syringe.

; Injection Volume should be 1.0 µL.

PreInjCleanVol = 10.0

PreInjCleanCycA = 3

CleanCycles = 1

PostInjCleanCycC = 0

; PostInjCleanVol = 10.0

PullUpCount = 6

PullUpDelayTime = 2.0

AirVolume = 3.0

FillingVolume = 5.0

AspirationSpeed = 100

InjectionSpeed = 100

PreInjDelayTime = 1

PostInjDelayTime = 2

Troubleshooting

 Note: If an error occurs during operation (e.g. excessive sample
volume), the error is displayed on the instrument only. To
continue the analysis, you must confirm the error message
directly at the sampler (by pressing the Enter key). This is
possible after unlocking the sampler keyboard in the Dionex
Chromatography Management System. Use either the
Disconnect command or the KeyboardUnlocked command.
Better yet: Disconnect the sampler, turn it off and on again, wait
until it is ready, and reconnect.

Error Description Remedial Action
Missing vial The sampler display shows:

End Sample

Total Injections 0

In addition, the Dionex
Chromatography
Management System waits
forever for an inject response.

Abort the batch.
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Error Description Remedial Action
Bad vial After some retries, the

sampler display shows
something like this:
PLG NDL INJ TUR CNTR

--- BSY --- ---   *

This happens quite easily if
the vials are not perfectly
crimped.

Disconnect the sampler, press
EXIT (on the sampler's
keyboard). When prompted
whether to pause, continue, or
abort the sample, choose Abort.
Abort the batch and reconnect.

Illegal parameter (e.g.
Volume/
Position > Max or Air +
Sample Volume > Max)

The sampler displays an error
message.

Disconnect the sampler. Press
sampler key, as necessary.

Continuous beep and
display cleared

Severe damage may occur
(destroyed syringe, vials etc.)!

Turn off the sampler
immediately!

Strange behavior of any
other kind

Disconnect the sampler, turn it off
and on again, wait until it is
ready, and reconnect.

Further Information

For an overview on the Fisons Autosampler, see  Fisons: AS800 GC
Autosampler - Overview.

The Fisons AS200S Autosampler corresponds to the CTC A200S sampler; see
 CTC ANALYTICS

For information on how to install the Fisons AS800 Autosampler, see
 Fisons: Autosampler - Installation.

For an overview on the different Fisons instruments for which Dionex device
drivers are available, see:

 Fisons

 Fisons 8000 Gas Chromatograph
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 GILSON
The following Gilson instruments are currently supported:

 Gilson UV Detectors 116, 117, and 118
 Gilson Fraction Collector 201/202 and 206
 Gilson Liquid Handler 215
 Gilson Autosamplers 235 and 235p
 Gilson Autosamplers 231, 232 Bio, and 234
 Gilson XL-Series (Autosamplers 221XL, 222XL, 231XL,

     232XL, 233XL)
 Gilson Pumps 302, 303
 Gilson Pumps 305, 306, 307
 Gilson Valves

 Gilson Autosampler 231XL (Old Device Driver)

 Caution: Under the Dionex Chromatography Management System, the
GSIOC bus available from Gilson is used exclusively for
combining several pumps in a high-pressure gradient system. All
other instruments (e.g. Autosampler and Detectors) are
controlled individually via separate serial interfaces. All
instruments (except those with serial interface) must therefore be
connected via an original Gilson cable (GSIOC adapter Model
605) to a PC interface. The adapter is shipped with the baud
rate set to 19200 Baud. For controlling specific instruments
via the Dionex Chromatography Management System (i.e.,
in case of specific drivers (see setting on the tab "General"
of the corresponding instrument properties)), it is necessary
to set the baud rate to 9600 Baud. To do this, open the
connector housing. Resolder the cable from land A to land B (for
details, see the Gilson 605 RS232 Adapter and GSIOC
Protocol - USER'S GUIDE).

 Tip: Always connect Gilson instruments requiring a GSIOC cable to
the multi-serial 8-fold PCI interface board (Equinox 8-RS232
Multi-COM card, Dionex part no. 5906.2095) as communication
problems might occur with other RS232 ports (e.g. with the COM
ports of the PC or the  Dionex Universal Chromatography
Interface (UCI-100)).
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The power supply of the GSIOC adapter (type 605) is directly via
the RS232 interface. The RS232 ports of the UCI-100
Universal Chromatography Interface, however, are not designed
for this.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 GILSON: UV Detectors 116, 117, and 118 - Overview

Device Type: UV116 two-channel UV detector or
UV117/118 single channel UV detector

Device Driver: Gilson 116 UV Detector / Gilson 117 UV Detector
(use the latter one for the UV117 and the UV118
detector, respectively)

Supported
Hardware
Options:

The only difference between these two detectors is
the wavelength range: UV117 up to 380 nm, UV118
up to 700 nm.

What is required?

License: Device Control

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)
The cable is not available from Dionex!

Hardware
Prerequisites:

Multi-serial 8-fold PCI interface board (Equinox 8-
RS232 Multi-COM board, Dionex part no. 5906.2095)
Free RS232 port

Control Panel: UVD170-2.pan

Further Information
For information on how to install the Gilson UV detectors 116, 117, and 118,
see  Gilson: UV Detectors 116, 117, and 118 - Installation.

For on overview on the different Gilson instruments for which Dionex device
drivers are available  Gilson.
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 GILSON: UV Detectors 116, 117, and 118 - Installation

Hardware Installation

Device
Connection:

 Caution:

Controlling the Gilson 116, 117, and 118 UV detectors
via the RS232 interfaces of the PC (COM ports) or the

UCI-100 Universal Chromatography Interface is not
supported. The power supply of the GSIOC adapter
(type 605) is directly via the RS232 interface. The
RS232 ports of the UCI-100 Universal
Chromatography Interface, however, are not designed
for this. Connect the adapter to the multi-serial 8-fold
PCI interface board (Equinox 8-RS232 Multi-COM
card, Dionex part no. 5906.2095) instead.

 Caution:

The GSIOC adapter 605 is shipped with the baud rate
set to 19200 Baud. For controlling the Gilson 116,
117, and 118 detectors via the Dionex
Chromatography Management System, it is necessary
to set the baud rate to 9600 Baud. To do this, open
the connector housing. Resolder the cable from land
A to land B (for details see the Gilson 605 RS232
Adapter and GSIOC Protocol - USER'S GUIDE).

Device Settings: Data transfer is performed at 9600 baud. Please
check the baud rate setting on the detector. If
necessary, change it to 9600.

This is possible in the Setup editing mode of the
instrument. Press the <prep> key until Set Baud Rate
appears in the display. Enter the correct value.

The GSIOC address is also set in this mode. Press
the <prep> key until unit id code is displayed. Enter
the GSIOC address. The default value is 16. The
value entered here must correspond to the value in
the Server Configuration (configuration of the Gilson
UV Detector).

Restrictions: Not known.
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Software Installation
Install the Gilson 116 UV Detector (or Gilson 117 UV Detector) Device
Driver in the  Server Configuration of your Dionex Chromatography
Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 116 UV Detector (or Gilson 117 UV Detector, respectively)
under the desired timebase (via the Add Device command of the context
menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.
(The address is given on the rear panel. It can be changed as described
above - see Device Settings.)

Open the Signal Configuration dialog box by double-clicking the
respective channel on the Signals tab. Assign a channel to the signal and
name the signal in the Signal Name field according to the selected
detector type.

You do not need to change the presetting on the Error Levels tab.

5. To control the Gilson UV detectors connect the UVD170-2 control panel in
the client of your Dionex Chromatography Management System to the
corresponding timebase (if necessary, remove those components that are
not required from the control panel).

Application

 Note: For consistency reasons, the UV-detector parameters Peak
Width and Sensitivity are called Response and Range in the
Dionex Chromatography Management System.

Further Information

For an overview on the Gilson UV detectors, see  Gilson: UV Detectors
116, 117, and 118 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Fraction Collectors 201/202 and 206 - Overview

Device Type: Fraction collector with up to 120 positions

Device Driver: Gilson 201/202 Fraction Collector or
Gilson 206 Fraction Collector

Supported
Hardware
Options:

With the Fraction Collector 206:
• 3 relays

• 2 inputs

What is required?

License: Device Control

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)

The cable is not available from Dionex!

Hardware
Prerequisites:

Multi-serial 8-fold PCI interface board (Equinox 8-
RS232 Multi-COM board, Dionex part no. 5906.2095)

Free RS232 port

Control Panel: GIL201.pan

Further Information
For information on how to install the Gilson fraction collectors, see

 Gilson: Fraction Collectors 201/202 - Installation

 Gilson Fraction Collector 206 - Installation
For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Fraction Collectors 201/202 - Installation

Hardware Installation

Device
Connection:

GSIOC RS232 adapter cable 605 (see  Gilson:
GSIOC Cable)

The cable is not available from Dionex!

 Caution:

Controlling the Gilson 201/202 fraction collectors via
the RS232 interfaces of the PC (COM ports) or the

UCI-100 Universal Chromatography Interface is not
supported. The power supply of the GSIOC adapter
(type 605) is directly via the RS232 interface. The
RS232 ports of the UCI-100 Universal
Chromatography Interface, however, are not designed
for this. Connect the adapter to the multi-serial 8-fold
PCI interface board (Equinox 8-RS232 Multi-COM
card, Dionex part no. 5906.2095) instead.

 Caution:

The GSIOC adapter 605 is shipped with the baud rate
set to 19200 Baud. For controlling the Gilson 201/202
faction collectors via the Dionex Chromatography
Management System, it is necessary to set the baud
rate to 9600 Baud. To do this, open the connector
housing. Resolder the cable from land A to land B (for
details see the Gilson 605 RS232 Adapter and GSIOC
Protocol - USER'S GUIDE).

Device Settings: Setting the Manual Mode and Defining the Rack
Code
Perform the following steps to define the program with
the file number 1.
Display Press Key

RESET
FILE NUMBER .... DELETE
WHICH NUMBER 1

ENTER
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Device Settings:
(Cont'd)

Any existing program with the file number 1 will be
deleted. This may take a few seconds. If this program
does not exist, the screen will show DOES NOT
EXIST.

In both cases, pressing the following keys allows
creating the new program 1. As the Rack Code, select
the currently used type (e.g. 10).

Display Press Key
FILE NUMBER 1

ENTER
SELECT MODE MAN.
MANUAL MODE ENTER
RACK CODE 10
RACK CODE 10 ENTER
DELAY 0.00 ENTER
READY-HIT ADV.

The READY-HIT ADV. display and the lit MAN. LED
indicate that the instrument is in manual mode and is
ready to operate.

Enter the File Number just defined on the instrument
(here: 1) and the Rack Code under Rack Type and
Program File (link available in the Online Help only) in
the  Server Configuration of the Dionex
Chromatography Management System.

Restrictions: Not known.

Software Installation

Install the Gilson 201/202 Fraction Collector Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 201/202 Fraction Collector under the desired timebase
(via the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):
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On the General tab, select a free COM port and enter the GSIOC address.
(The address is given on the rear panel. It can be changed as described
above - see Device Settings.)

On the Rack Type and Program File tab, enter the numbers of the desired
rack types and files.

You do not need to change the presetting on the Error Levels tab.

To control the Gilson 201/202 fraction collectors connect the GIL201 control
panel in the client of your Dionex Chromatography Management System to the
corresponding timebase.

Application
After switching the instrument on, the model name and then the number of the
current program is displayed on the instrument screen (e.g. FILE NUMBER 3).

 Caution: The Connect command can only be performed in the Dionex
Chromatography Management System if the instrument is set to
the Manual mode. The READY-HIT ADV. display and the active
MAN. LED indicate that the instrument is currently in the Manual
mode and ready to operate. If this is not the case, the error
message Gilson 201/202 program ... is not a manual program
is entered in the Audit Trail. Connecting the instrument to the
Dionex Chromatography Management System is not possible
then!

The following rack types are available

Rack Code 0 80 vials
Rack Code 1 80 test tubes (13 x 100 mm; 9 ml)
Rack Code 2 119 test tubes (6 x 50 mm; 1 ml)
Rack Code 4 80 test tubes (12 x 100 mm; 8 ml)
Rack Code 7 Holder for micro titer boards
Rack Code 8 120 vials (6 x 32 mm; 0,6 ml)
Rack Code 9 120 vials (7 x 40 mm; 1,4 ml)
Rack Code 10 27 funnels with outlet tube
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Rack Code 20 108 test tubes (10 x 100 mm)
Rack Code 21 60 test tubes (13 x 100 mm; 9 ml)
Rack Code 22 44 test tubes (18 x 180 mm)
Rack Code 23 44 mini vials (17 x 65 mm; 8ml)
Rack Code 24 14 scintilution vials (28 x 60 mm; 20ml)
Rack Code 28 108 test tubes (10 x 75 mm; 3,5 ml)
Rack Code 29 60 test tubes (13 x 75 mm; 5 ml)

Further Information

For an overview on the Gilson fraction collectors, see  Gilson: Fraction
Collectors 201/202 and 206 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Fraction Collector 206 - Installation

Hardware Installation

Device
Connection:

GSIOC RS232 adapter cable 605 (see  Gilson:
GSIOC Cable)

The cable is not available from Dionex!

 Caution:

Controlling the Gilson 206 fraction collector via the
RS232 interfaces of the PC (COM ports) or the UCI-
100 Universal Chromatography Interface is not
supported. The power supply of the GSIOC adapter
(type 605) is directly via the RS232 interface. The
RS232 ports of the UCI-100 Universal
Chromatography Interface, however, are not designed
for this. Connect the adapter to the multi-serial 8-fold
PCI interface board (Equinox 8-RS232 Multi-COM
card, Dionex part no. 5906.2095) instead.
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Device
Connection:
(Cont'd)

 Note:

Contrary to the Fraction Collectors 201 and 202, the
Gilson Fraction Collector 206 uses a baud rate of
19200 Baud. Therefore, do not modify the 605 cable!

Device Settings:

Restrictions: Not known.

Software Installation

Install the Gilson 206 Fraction Collector Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 206 Fraction Collector under the desired timebase (via
the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.
(The address is given on the rear panel.)

On the Rack tab, enter the number of the installed rack type.

On the Relays tab, remove all relays that are not used.

On the Inputs tab, remove all inputs that are not available.

You do not need to change the presetting on the Error Levels tab.

To control the Gilson 206 fraction collector connect the GIL201 control panel in
the client of your Dionex Chromatography Management System to the
corresponding time

Application
After switching the instrument on, the model name and then the number of the
current program is displayed on the instrument screen (e.g. FILE NUMBER 3).
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 Caution: The Connect command can be performed in the Dionex
Chromatography Management System only if the instrument is
set to the Manual mode. The READY-HIT ADV. display and the
active MAN. LED indicate that the instrument is currently in the
Manual mode and ready to operate. If this is not the case, the
error message Gilson 201/202 program ... is not a manual
program is entered in the Audit Trail. Connecting the instrument
to the Dionex Chromatography Management System is not
possible then!

Further Information

For an overview on the Gilson fraction collectors, see  Gilson: Fraction
Collectors 201/202 and 206 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Liquid Handler 215 - Overview
Device Type: Liquid handler with x positions

Device Driver: Gilson Liquid Handler 215
Supported
Hardware
Options:

• 2 Gilson 819 inject ports
• 3 relays
• 2 inputs

What is required?

License: Extended Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection:  Modem Cable (1:1 RS Cable): 8914.0128 or
8914.0144 (for details, see the appendix of these
Installation Instructions)

Hardware
Prerequisites:

Free RS232 port (COM1 or COM2, because the
included Gilson configuration software supports
COM1 and COM2 only)
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Further Information

For an overview on how to install the Gilson liquid handler, see  Gilson:
Liquid Handler 215 - Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Liquid Handler 215 - Installation

Hardware Installation

Device
Connection:

Connection to the PC is via a  Modem Cable (1:1
RS Cable): 8914.0128 or 8914.0144 (for details, see
the appendix of these Installation Instructions)

The Gilson 819 inject port is connected to the liquid
handler via a GSIOC cable from Gilson (see

 Gilson: GSIOC Cable). If there is a second Gilson
819, use another GSIOC cable on the corresponding
free connector of the first GSIOC cable.

Device Settings: The SW-2 (baud rate/mode selector) switch on the
instrument's rear panel must be set to position 6
(19200 Baud, GSIOC Master).

Restrictions: Not known.

Software Installation

Install the Gilson 215 Liquid Handler Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 215 Liquid Handler under the desired timebase (via the
Add Device command of the context menu).
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4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.
(The address is given on the rear panel. It can be changed as described
above - see Device Settings. When selecting the COM ports, please note
that the included Gilson configuration software supports COM1 and COM2
only.)

On the Sampler tab, enter the name of the installed tray, the syringe
volume, and the maximum syringe speed. The driver checks the last two
entries that are based on the configuration and corrects them, if necessary.

On the Inject Port tab, enter the GSIOC address of the respective inject
port, the loop volume, and the home coordinates of the injection needle.
(Ensure correct input of the loop volume and the coordinates!)

On the Relays tab, remove all relays that are not used. On the Inputs
tab, remove all inputs that are not available.

You do not need to change the presetting on the Error Levels tab.

Application
Configuring the Liquid Handler
Use the Gilson 709 software to configure the Liquid Handler.

 Caution: The Gilson software (except the Tray editor) is currently
supported under Windows 98 only, and not under Windows
NT/Windows 2000! The Gilson software removes the used COM
port from the system, so that the Dionex Chromatography
Management System cannot access the port!

These problems can be solved as follows:
• Switch to another COM port after completing the configuration.

• Uninstall the Gilson software after the configuration.

• Install both, Windows 98 and NT/2000 on the PC (caution: install Windows
98 first!). Then, install the Gilson software under Windows 98 (only), and
install the Dionex Chromatography Management System under Windows
NT/2000.

• Gilson supplies a GSIOC.SYS driver for Windows NT/2000. However, this
driver must be installed manually. With this driver, the Gilson software runs
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under Windows NT/Windows 2000 as well. After uninstalling this driver and
booting the PC, the Dionex Chromatography Management System can be
started.

Configure the Liquid Handler with the 215Setup program. Check especially the
coordinates of the wash station and write down the coordinates of the injection
port.

Use the TrayEdit program to define the tray layout. Specify the zone names
and the vial numbering. The vials from which to inject should be located in the
first zone. Assign a zone name, e.g. Samples.

You can define further zones, e.g. for fraction collection or sample preparation.
Please note that the driver for zone names supports the letters A-Z (no special
characters), numbers, and the characters %, and _, only. If you enter other
characters in the tray editor, these will be replaced by _.

The file name should not exceed nine characters (+ .gty). Save the resulting
file in the folder Chromel\bin, e.g., \Chromel\bin\gil215.gty.

Further Information

For an overview on the Gilson liquid handler, see  Gilson: Liquid Handler
215 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Autosamplers 235 and 235p - Overview

Device Type: Autosampler with up to 384 positions

Device Driver: Gilson 235 Autoinjector
Supported
Hardware
Options:

• 5 relays

• 4 inputs

What is required?

License: Extended Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection:  Modem Cable (1:1 RS Cable): 8914.0128 or
8914.0144 (for details, see the appendix of these
Installation Instructions)

Hardware
Prerequisites:

Free RS232 port

Further Information
For an overview on how to install the Gilson autosamplers 235 and 235p, see

 Gilson: Autosamplers 235 and 235p - Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Autosamplers 235 and 235p - Installation

Hardware Installation

Device
Connection:

Connection to the PC is via a  Modem Cable (1:1
RS Cable): 8914.0128 or 8914.0144 (for details, see
the appendix of these Installation Instructions)

Normally, the Peltier cooling of the 235p sampler is
connected to relay 3 so that it can be switched on and
off via the software. We recommend keeping this
setting and naming relay 3 in the Dionex
Chromatography Management System accordingly.

Device Settings: The SW-2 (baud rate/mode selector) switch on the
instrument's rear panel must be set to position 6
(19200 Baud, GSIOC Master).

Restrictions: Not known.

Software Installation

Install the Gilson 235 Autoinjector Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 235 Autoinjector under the desired timebase (via the Add
Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.
(The address is given on the rear panel. It can be changed as described
above - see Device Settings. When selecting the COM ports, please note
that it may be possible that the Gilson tray editor, which is required for
configuring special sample trays, and the included Gilson sampler
configuration software blocks COM1 and COM2.)

On the Sampler tab, enter the name of the installed tray file. The pull down
box lists all tray files (max. 9 characters) that are available in the
Chromel\Bin directory. If the tray file is located in a different directory,
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enter the whole path. In addition, you can specify the syringe volume, the
maximum syringe speed, and the loop volume. Selecting the syringe
volume from the selection list automatically sets the corresponding
maximum syringe speed.

On the Relays tab, remove all relays that are not used.

On the Inputs tab, remove all inputs that are not available.

You do not need to change the presetting on the Error Levels tab.

Application
Configuring the Sample Tray
As the sampler can access any coordinates almost every sample tray including
homemade trays can be used. To ensure this flexibility, the driver takes the
dimensions and coordinates of the vials from the tray file.

Dionex supplies some tray files for the most commonly used sample racks:

Tray File Rack Code Vial Type
235_350 350 96-hole micro titer, flat
235_350s 350 384-hole micro titer, flat
235_351 351 96-hole micro titer, deep
235_352 352 2 ml
235_353 353 0.7 ml
235_354 354 96-hole micro titer, cooled, flat (235p)
235_354s 354 384-hole micro titer, cooled, flat (235p)

If you use a different rack or if special requirements must be fulfilled, you must
generate a tray file yourself. For this purpose, use the Tray Editor from the
Gilson Software 709. You can also use the editor to modify existing tray files, if
you wish to number the vials in a different order or reserve special vial
positions, e.g. for specific applications, by assigning separate zone names.

The program allows you to define the layout of the sample rack and to
determine zone names and vial numbering. The vials to be used for injection
should be placed in the first zone. Name this zone e.g. samples.

 Tip: With the Inject command, the samples always have to be in the
first zone. (The zone number does not influence their actual
position.)

Additional zones, e.g. for fractionating or sample preparation, can be defined.
Please note that the driver only admits the characters A-Z (no umlaut, accents,
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ß ...), %,  _, and numbers to be used in zone names. Other characters entered
in the tray editor will be replaced by _.

Save the result, e.g. under \Chromel\bin\MyTray.gty.

Tray Files
For this device driver, various standard tray files are already available (see
below). Insert your rack into the sampler so that the first sample is at the front
left. If the corresponding Gilson program is available on your computer, you
can freely program different sample distributions by yourself.

235_350.gty, 235_351.gty, 235_353.gty and 235_354.gty :
(The table lines of the track files indicate the position numbers in the respective
rack line).

373 374 ... 384
... ... ... ...
301 302 ... 312
289 290 ... 300

277 278 ... 288
... ... ... ...
205 206 ... 216
193 194 ... 204

181 182 ... 192
... ... ... ...
109 110 ... 120
97 98 ... 108

85 86 ... 96
... ... ... ...
13 14 ... 24
1 2 ... 12

235_352.gty:
185 186 ... 192
... ... ... ...
9 10 ... 16
1 2 ... 8

 Tip: If you change the syringe, communicate the new syringe volume
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to the sampler. You can do this in the  Server Configuration.

In addition, the coordinates for waste, rinse station, and injection port can be
changed for specific applications.

 Caution: Usually, the default values should be used. Re-adjust the
sampler, if these positions are not hit exactly.

Further Information

For an overview on the Gilson autosamplers 235 and 235p, see  Gilson
Autosampler 235 - Overview.

For an overview on the different Gilson instruments for which device drivers are
available, see  Gilson.

 GILSON: Autosamplers 231, 232 Bio, and 234 - Overview

Device Type: Autosampler with up to x positions

Device Driver: Gilson 231 Autosampler,
Gilson 232 Bio Autosampler, and
Gilson 234 Autoinjector, respectively

Supported
Hardware
Options:

What is required?

License: Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)

The cable is not available from Dionex!
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Hardware
Prerequisites:

Free RS232 port

Control Panels: GIL231.pan
GIL232.pan

Further Information
For an overview on how to install the Gilson autosamplers 235 and 235p, see

 Gilson: Autosamplers 231/ 232 Bio, and 234 - Installation.

For an overview on the different Gilson instruments for which device drivers are
available, see  Gilson.

 GILSON: Autosamplers 231, 232 Bio, and 234 -
    Installation

Hardware Installation

Device
Connection:

GSIOC RS232 adapter cable 605 (see  Gilson:
GSIOC Cable)

The cable is not available from Dionex!

 Caution:

Controlling the Gilson autosamplers 231, 232 Bio, and
234 via the RS232 interfaces of the PC (COM ports)
or the UCI-100 Universal Chromatography Interface
is not supported. The power supply of the GSIOC
adapter (type 605) is directly via the RS232 interface.
The RS232 ports of the UCI-100 Universal
Chromatography Interface, however, are not designed
for this. Connect the adapter to the multi-serial 8-fold
PCI interface board (Equinox 8-RS232 Multi-COM
card, Dionex part no. 5906.2095) instead.

 Caution:

The GSIOC adapter 605 is shipped with the baud rate
set to 19200 Baud. For controlling the Gilson
autosamplers 231 and 232 via the Dionex
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Device
Connection:
(Cont'd)

Chromatography Management System, it is necessary
to set the baud rate to 9600 Baud. To do this, open
the connector housing. Resolder the cable from land
A to land B (for details see the Gilson 605 RS232
Adapter and GSIOC Protocol - USER'S GUIDE).

 Note:

Contrary to the autosamplers 231 and 232 Bio, the
Gilson Autosampler 234 uses a baud rate of 19200
Baud. Therefore, do not modify the 605 cable!

Device Settings:
Restrictions: Not known.

Software Installation
Install the Gilson 231 Autosampler (or Gilson 232 Bio Autosampler or Gilson
234 Autoinjector) Device Driver in the  Server Configuration of your
Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 231 Autosampler (or Gilson 232 Bio Autosampler or
Gilson 234 Autoinjector) under the desired timebase (via the Add Device
command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.

For the 231/232 Bio autosamplers:

On the respective rack tab ( Rack for the 231 autosampler, Rack tab for
the 232 Bio autosampler), select the code number of the installed default
rack. Select None of these to specify the maximum number of samples
first. Manually enter the number in the INI-File that is selected on the INI
File tab.
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For the 234 autosampler:

On the Sampler tab, enter the name of the installed tray file. The pull down
box lists all tray files (max. 9 characters) that are available in the
Chromel\Bin directory. If the tray file is located in a different directory,
enter the whole path. In addition, you can specify the syringe volume, the
maximum syringe speed, and the loop volume. Selecting the syringe
volume from the selection list automatically sets the corresponding
maximum syringe speed.

On the Relays tab, remove all relays that are not used.

On the Inputs tab, remove all inputs that are not available.

You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson autosampler connect the GIL231 or GIL232
control panel in the client of your Dionex Chromatography Management
System to the corresponding time

Application
Before controlling these Autosamplers via the Dionex Chromatography
Management System, some information must be transferred to the instruments.
As usual with Gilson instruments, this is by downloading a basic (INI) file.
Please note the instructions in your Autosampler Manual. The name of the INI
File must be included in the device configuration (INI tab) in the Server
Configuration of the Dionex Chromatography Management System.

For the Gilson 231, the rack types 0, 2, 7, 8, and 10 are supported. For the
Gilson 232 Bio, the rack types 30, 31, 32, 33, and 34 are supported. For both
instruments, any other rack type can be defined. In this case, the correct rack
must be entered manually in the INI File.

For an example INI File similar to a BASIC program, see Installing and
Controlling Third-Party Instruments  Gilson INI File.

In addition, the autosampler's GSIOC address must be entered in the Server
Configuration (General tab dialog box). The default address is 10. This value
must correspond to the value set on the instrument.
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Tray Files
For these Gilson device drivers, various standard tray files are already
available. Insert your rack into the sampler so that the first sample is at the
front left. If the corresponding Gilson program is available on your computer,
you can freely program different sample distributions by yourself.

234_036.gty:
(The table lines of the track files indicate the position numbers in the respective
rack line).

C ... 1 8 … 107
... 2 9 … 108

B B ... 3 10 … 109
B B ... 4 11 … 110
B B ... ... ... ... ...
B B ... 7 14 … 113

C ... A A A …
... A A A …

1 5 ... A A A …
2 6 ... A A A …
3 7 ... ... ... ... ...
4 8 ... A A A …

For example, "normal" samples may be given under A, standard samples
under B, and the wash solution under C.

Further Information
For an overview on the Gilson autosamplers 231, 232 Bio, and 234, see

 Gilson: Autosamplers 231/ 232 Bio, and 234 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Autosamplers XL Series (221XL, 222XL, 231XL,
    232XL, 233XL) - Overview

Device Type: Autosampler with up to x positions

Device Driver: Gilson XL Series (Extended)
(Do not confuse with the Gilson 231 Autosampler
and the Gilson 231 XL Autosampler device drivers!)

Supported
Hardware
Options:

• Syringe module (dilutor) 402
• Inject port
• Switching valve
• 8 relays
• 5 inputs

What is required?

License: Extended Device Control
Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: Connection to the PC is via a  Modem Cable (1:1
RS Cable): 8914.0128 or 8914.0144 (for details, see
the appendix of these Installation Instructions)

For the Gilson 402 syringe module (syringe pump,
dilutor): GSIOC RS232 adapter cable 605 (for details,
see  Gilson: GSIOC Cable in the appendix of these
Installation Instructions - the cable is not available
from Dionex).

Hardware
Prerequisites:

Free RS232 port

Control Panel: GIL231XL.pan

Further Information
For an overview on how to install the Gilson autosamplers of the XL series, see

 Gilson: Autosamplers XL Series - Installation.

For an overview on the different Gilson instruments for which Dionex
Chromatography Management System are available, see  Gilson.
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 GILSON: Autosamplers XL Series (221XL, 222XL, 231XL,
    232XL, 233XL) - Installation

Hardware Installation

Device
Connection:

 Caution:

Before connecting the autosampler to the PC, remove
the supplied keypad. Do not connect the autosampler
with the keypad and the PC at the same time!

Connection to the PC is via a  Modem Cable (1:1
RS Cable): 8914.0128 or 8914.0144 (for details, see
the appendix of these Installation Instructions)

Using a simple 9-pin Gilson RS232 cable as 1:1 RS
cable is possible as well. The Gilson 402 syringe
module (Syringe Pump, Dilutor) is connected to the
autosampler via a GSIOC cable from Gilson (for
details, see  Gilson: GSIOC Cable in the appendix
of these Installation Instructions - the cable is not
available from Dionex).

Device Settings: The DIP-switches should show the factory-set
presetting:

Autosampler:
Dip-Switch 1 2 3 4 5 6 7 8
Top x x x x x
Bottom x x x

Dilutor 402:
Dip-Switch left right

1 x
2 x
3 x
4 x
5 x
6 x
7 x
8 x

Restrictions: Not known.



756 Installing and Controlling Third-Party Instruments

Software Installation

Install the Gilson XL Series (Extended) Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson XL Series (Extended) under the desired timebase (via the
Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.

On the Geometry tab, select the tray file according to your tray. You can
modify the file at the desired position by selecting the Custom option via
the arrow under Drain, Rinse, or Work Area Size.

On the Dilutor 402 tab, enter the desired parameters for the 402 syringe
module.

On the Inject Port / Switching Valve tab, specify the settings of the
respective motorized switching valve.

On the Relays tab, remove all relays that are not used.

On the Inputs tab, remove all inputs that are not available.

You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson autosampler connect the GIL231XL control
panel or any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding time

Application
Tray Files
For this device driver, various standard tray files are already available. Insert
your rack into the sampler so that the first sample is at the front left. If the
corresponding Gilson program is available on your computer, you can freely
program different sample distributions by yourself.
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231XL00.gty:
(The table lines of the track files indicate the position numbers in the respective
rack line).

1 6 ... 76
2 7 ... 77
... ... ... ...
5 10 ... 80

231XL07.gty:
1 9 ... 89
2 10 ... 90
... ... ... ...
8 16 ... 96

231XL08.gty:
1 6 ... 115
2 7 ... 116
... ... ... ...
5 10 ... 120

231XL10.gty:
1 2 ... 13

27 26 ... 15 14

Differences from Gilson 215
Due to the differing wash principle, the XL series offers the two parameters
InnerWashVolume and OuterWashVolume instead of the WashVolume
parameters. In addition, the MoveToRinse command offers the MoveToDrain
option.

If two syringes are installed, the additional Syringe, RightSuckedVolume, and
RightDilutorValve are available.

 Caution: The Z-axis of the XL-series points down, the Z-axis of the 215
points up. To position the needle 2 cm above the vial floor, enter
Z = TubeBottom - 20  (instead of Z = TubeBottom + 20 as with
the 215), otherwise the needle is driven into the vial floor!

To allow lifting the needle via the same command, both systems support the
NeedleUp command.
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Differences from the Device Driver Gil231XL.CDD
The "old" device driver Gil231XL.CDD required additional hardware and
software (Gilson 606 RS converter, Gilson software GYNK_231.EXE). Its
capabilities are mainly limited to the sample position and sample number input.
The actual injection must be defined via the Gilson software on the keypad. For
compatibility, this device driver is still included.

The "new" device driver GilXLExt.CDD requires no additional hardware or
software. (Exception: for defining special sample trays, the Gilson Tray editor is
used). All capabilities of the autosampler are supported directly by the device
driver.

To update an existing installation of the Dionex Chromatography Management
System to the new device driver, proceed as follows:
• Ensure that the Extended Device Control license is available for your

system.

• Uninstall the previous device driver.

• Remove the control unit (keypad), the RS232 converter 606, and the null
modem cable to the PC.

• Connect the autosampler directly to the PC using a 1:1 RS cable (not a null
modem cable).

• Install the new device driver as described above.

• Convert the injection methods of the Gilson software into the Program of
the Dionex Chromatography Management System (must be performed
manually).

Further Information

For an overview the Gilson autosamplers of the XL series, see  Gilson:
Autosamplers XL Series - Overview.

We do not recommend using the old device driver, however, it is possible. For
details, see  Gilson Autosampler 231XL, 232XL, 233XL (Old Device
Driver)
For an overview on the different Gilson instruments for Dionex device drivers
are available, see  Gilson.
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 GILSON: Autosamplers 231XL, 232XL, 233XL (Old
    Device Driver) - Overview

We recommend operating these Autosamplers with the new  Gilson
Autosamplers XL-Series (221XL, 222XL, 231XL, 232XL, 233XL device driver
(Gilson XL Series (Extended)). Their capabilities are mainly limited to the
sample position and sample number input. The actual injection must be defined
via the Gilson software on the keypad. For compatibility, this device driver is
still included.

Device Type: Autosampler

Device Driver: Gilson 231 XL Autosampler
(Do not confuse with the Gilson 231 Autosampler
and the Gilson XL Series (Extended) device drivers!)

Supported
Hardware
Options:

What is required?

License: Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: Gilson GSIOC bus cable (no Gilson GSIOC RS232
adapter cable 605!) - The cable is not available from
Dionex.

 Null Modem Cable (RS232-Kabel): 8914.0129 or
8914.0103A (for details, see the appendix of these
Installation Instructions)

Hardware
Prerequisites:

RS232 converter box 606

Free RS232 port

Software
Prerequisites:

Gilson software GYNK_231.EXE

Control Panel: GIL231XL.pan
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Further Information
For an overview on how to install the Gilson 231 XL, 232XL, and 233XL
autosamplers (old device driver), see  Gilson: Autosamplers 231XL,
232XL, 233, XL (Old Device Driver) - Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Autosamplers 231XL, 232XL, 233XL (Old
    Device Driver) - Installation

Hardware Installation

Device
Connection:

Connecting the autosampler to the converter box is
via the Gilson RS232 cable. The PC connection of the
box is via the  Null Modem Cable (RS232 Cable -
Dionex part nos. 8914.0129 or 8914.0103A - for
details, see the appendix of these Installation
Instructions).

Device Settings: As soon as the individual components are connected
via the corresponding cables, the software of the
system can be configured. Use the control unit to load
the program GYNK_231.EXE (version 3.15 or higher)
and then perform the programming.

Restrictions: Not known.

Software Installation

Install the Gilson 231 XL Autosampler Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 231 XL Autosampler under the desired timebase (via the
Add Device command of the context menu).
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4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.

You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson autosampler connect the GIL231XL control
panel or any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding time

Further Information
For an overview on Gilson autosamplers of the XL series with the new device
driver, see  Gilson: Autosamplers XL Series (221XL, 222XL, 231XL,
232XL, 233XL) - Overview.

For an overview on the Gilson 231 XL, 232XL, and 233XL autosamplers with
the old device driver, see  Gilson: Autosampler 231XL, 232XL, 233XL (Old
Device Driver) - Overview. However, using the old device driver is not
recommended.

For further details, see  Gilson: Sample Preparation Systems.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Pumps 302, 303 - Overview

Device Type: Pumps

Device Driver: Gilson 302 Pump
Supported
Hardware
Options:

Up to three Gilson 302/303 pumps

What is required?

License: Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)

The cable is not available from Dionex!

Hardware
Prerequisites:

Multi-serial, 8-fold PCI interface board (Equinox 8-
RS232 Multi-Com board, Dionex part no. 5906.2095)

Free RS232 port

Control Panel: GIL306Gradient.pan

Further Information

For an overview on how to install the Gilson 302/303 pumps, see  Gilson:
Pumps 302/303 - Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Pumps 302, 303 - Installation

Hardware Installation

Device
Connection:

The device driver supports up to 3 Gilson pumps of
the type 302/303. If several Gilson pumps are
combined in a high-pressure gradient system,
connection is via the GSIOC bus. The bus cable is
connected via the original Gilson GSIOC RS232
adapter cable 605 (for details, see  Gilson: GSIOC
Cable in the appendix of these Installation
Instructions) with a serial PC interface. The bus cable
can connect up to four pumps.

 Caution:

Controlling the Gilson pumps 302/303 via the RS232
interfaces of the PC (COM ports) or the UCI-100
Universal Chromatography Interface is not supported.
The power supply of the GSIOC adapter (type 605) is
directly via the RS232 interface. The RS232 ports of
the UCI-100 Universal Chromatography Interface,
however, are not designed for this. Connect the
adapter to the multi-serial 8-fold PCI interface board
(Equinox 8-RS232 Multi-COM card, Dionex part no.
5906.2095) instead.

Device Settings: Each pump has its own GSIOC address (0 to 63). The
address is set via a DIP-switch. This switch is located
inside the pump on the back of the front panel.

Restrictions: Not known.

Software Installation

Install the Gilson 302 Pump Device Driver in the  Server Configuration
of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 302 Pump under the desired timebase (via the Add
Device command of the context menu).
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4. The following settings are required on the different tabs (the links are
available in the Online Help only):
On the General tab, select a free COM port and enter the GSIOC address.
The GSIOC and Head Types tab allows defining the GSIOC addresses for
the Gilson pump as well as the pump head types that are used.
You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson pump connect the GIL306Gradient control
panel or any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding time

Further Information

For an overview on Gilson pumps 302/303, see  Gilson Pumps 302/303 -
Overview.
For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Pumps 305, 306, 307 - Overview

Device Type: Pumps

Device Driver: Gilson 305/306/307 Pump
Supported
Hardware
Options:

Up to three Gilson 305/306/307 pumps

What is required?

License: Device Control
Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)
The cable is not available from Dionex!

Hardware
Prerequisites:

Multi-serial, 8-fold PCI interface board (Equinox 8-
RS232 Multi-Com board, Dionex part no. 5906.2095)
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Free RS232 port

Control Panel: GIL306Gradient.pan

Further Information
For an overview on how to install the Gilson 305/306/307 pumps, see

 Gilson: Pumps 305/306/307 - Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON: Pumps 305, 306, 307 - Installation

Hardware Installation

Device
Connection:

The device driver supports up to 3 Gilson pumps of
the type 305/306/307. The pumps are connected to
the GSIOC bus via the GSIOC from Controller
connector. The bus is connected to the serial PC port
via the original GSIOC RS232 adapter cable 605 (for
details, see  Gilson: GSIOC Cable in the appendix
of these Installation Instructions) with a serial PC
interface.

 Caution:

Controlling the Gilson pumps 3057306/307 via the
RS232 interfaces of the PC (COM ports) or the UCI-
100 Universal Chromatography Interface is not
supported. The power supply of the GSIOC adapter
(type 605) is directly via the RS232 interface. The
RS232 ports of the UCI-100 Universal
Chromatography Interface, however, are not designed
for this. Connect the adapter to the multi-serial 8-fold
PCI interface board (Equinox 8-RS232 Multi-COM
card, Dionex part no. 5906.2095) instead.

Device Settings: Each pump must have a unique GSIOC address
assigned. This address must be entered on the
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instrument and in the Server Configuration of the
Dionex Chromatography Management System. For
the models 305 and 307, the following procedure is
required:
• Press <Menu>.

• Press <I/O>.

• Press <Next> until GSIOC Unit ID: appears.

• Enter the ID and press <Enter>.

• Press <Quit>.

For the model 306, the ID is set via a DIP-switch on
the rear of the instrument (the switches 1-6
correspond to 1-bit 0, 2-bit 1, etc.). Use switches 7
and 8 to set the baud rate (9600 Baud = 7/off and
8/on; 19200 Baud = 7/on and 8/off).

Restrictions: Not known.

Software Installation

Install the Gilson 305/306/307 Pump Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson 305/306/307 Pump under the desired timebase (via the
Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.

The GSIOC and Head Types tab allows defining the GSIOC addresses for
the Gilson pump as well as the pump head types that are used.

You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson pump connect the GIL306Gradient control
panel or any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding time
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Application
Set the following communications parameters: 9600 Baud, 8 Bit, 2 Stop, Even
Parity, and no Handshake. Use the same cabling for gradients and for
operating two or three pumps. All pumps must be connected to the same
GSIOC bus. A master/slave connection via the GSIOC to Slave Pump
connector (model 305) is not possible!

The Dionex Chromatography Management System performs pressure
monitoring. Therefore, do not enter pressure limits on these pumps! If the
pressure is below the lower limit, the pump will stop after 60 seconds. The
Refill Time and Compressibility pump parameters are supported as well.

Further Information

For an overview on the Gilson 305/306/307 pumps, see  Gilson: Pumps
305/306/307 - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Valves (817, 819, UVSM) - Overview

Device Type: Valves

Device Driver: Gilson Valve Module
Supported
Hardware
Options:

• Gilson 817: up to 8 valve positions
• Gilson 819: up to 2 valve positions
• UVSM: up to 8 valve positions
• ValveMate: up to 8 valve positions

What is required?

License: Device Control
Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: 817, 819, and UVSM:
GSIOC RS232 adapter cable 605 (for details, see

 Gilson: GSIOC Cable in the appendix of these
Installation Instructions)
The cable is not available from Dionex!

ValveMate:

 Modem Cable (1:1 RS Cable): 8914.0128 or
8914.0144 (for details, see the appendix of these
Installation Instructions)

Hardware
Prerequisites:

Multi-serial, 8-fold PCI interface board (Equinox 8-
RS232 Multi-Com board, Dionex part no. 5906.2095)

Free RS232 port

Control Panel: GIL231XL.pan

Further Information

For an overview on how to install the Gilson valves,  GILSON: Valves -
Installation.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON: Valves (817, 819, UVSM) - Installation

Hardware Installation

Device
Connection:

The ValveMate can be connected with Modem
Cable (Dionex part no. 8914.0128 for a 25-pin port or
Dionex part no. 8914.0144 for a 9-pin port, no null
modem cable!). The Gilson 817, 819, and UVSM
valves are connected from the GSIOC port to the PC
via a Gilson adapter cable 605.

 Caution:

Controlling the Gilson valves via the RS232 interfaces
of the PC (COM ports) or the UCI-100 Universal
Chromatography Interface is not supported. The
power supply of the GSIOC adapter (type 605) is
directly via the RS232 interface. The RS232 ports of
the UCI-100 Universal Chromatography Interface,
however, are not designed for this. Connect the
adapter to the multi-serial 8-fold PCI interface board
(Equinox 8-RS232 Multi-COM card, Dionex part no.
5906.2095) instead.

 Note:

Contrary to most other Gilson devices, the Gilson
valves use a baud rate of 19200 Baud. Therefore, do
not modify the 605 cable!

Restrictions: Not known.

Software Installation

Install the Gilson Valve Module Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Gilson Valve Module under the desired timebase (via the Add
Device command of the context menu).
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4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port and enter the GSIOC address.

On the Valve tab, determine the options of the installed Gilson valve. Four
different naming schemes are available for identifying the valve positions.
The Custom setting is intended for the Dionex Service (for defining their
own scheme).

You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson valve connect the GIL231XL control panel or
any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding timebase.

Application
The valve type 819 is an injection valve that is usually used with the Gilson 215
Liquid Handler only. In this case, the GilValve.CCD driver is not required, as
the Gilson 215 driver supports up to two 819-injection valves.

While the valve type 819 supports two valve positions only, the other types
support two to eight valve positions.

Further Information

For an overview on the Gilson valves, see  Gilson valves - Overview.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 GILSON Sample Preparation Systems (Old Device
    Driver)
We recommend to operate the Gilson Sample Preparation Systems with the
new  Gilson Autosampler 231XL, 232XL, 233XL device driver (Gilson XL
Series (Extended). If using the old Gilson 231 XL Autosampler Device
Driver nevertheless, note the following requirements:

System Requirements
Gilson • Autosampler 231 XL, 232 XL or 233 XL

• Dilutor 402, ...
• XL control unit (display and keyboard)
• Gilson RS232 converter box 606
• Gilson GSIOC connecting cable
• Null modem connecting cable
• Gilson interface software GYNK_231.EXE version 3.15

or higher

Dionex • PC with COMx
• CHROMELEON from version 3.10
• Gilson 231 XL Autosampler device driver

Connecting the Sample Preparation System

Connection Cable Converter Box (channel A) - COMx
GSIOC Converter

(25-pin MinD, female)
COMx

(25-pin MinD, female)
COMx

(9-pin MinD, female)
3 -------------- 2 3
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2 -------------- 3 2
7 -------------- 7 5

Internal: 4 - 5 Internal: 7 - 8

Starting the Sample Preparation System
As soon as the sample preparation system has been connected as shown
above, the software configuration of the system must be defined. To be on the
safe side, you should make a backup copy of the Gilson system diskette to
your PC, using the DISKCOPY command.

Then insert the copied diskette into the drive on the side of the control unit.
Switch on all Gilson system components! The control unit loads the operating
system and the device driver software GYNK_231 from the diskette. After the
usual prompts for the date and time, the program is in the main menu shown
below.

----GILSON GYNK_231 3.15—Default.XCP----

 231XL: 10/1230    RACKS:0   ZONES:0

 DIL :

 MP3 :

 HPP :

 M506:            M606 :

---------NO PROGRAM------MEM:83416-------

  FILE   CONFIG  EDITOR   RUN    MANUAL

In the title line, the name of the control software (GYNK_231) and the version
number appears (version 3.15 or higher). The name of the current method file
is also specified. This file contains all parameters. Below that, the screen lists
all system components with their GSIOC addresses. In addition, you can see
the number of the currently installed racks and zones.
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Configuring the Sample Preparation System
Pressing the function key <CONFIG> allows you to change from the main
menu to the configuration menu.

----UNIT----Gynk_231/CONFIG--------------

  XYZ-ROBOT   231B V1.11       to ID: 10

---------ADD-/DEL-UNIT = <ENTER> --------

 ZDRIVE   RINSE    TRAY    VALVES    QUIT

For the operation via the Dionex Chromatography Management System, the
system component IFACE 606 must be set up.

----CONFIG/=====UNIT====================

               HPPUMP      < free >

               IFACE 506   < free >

               IFACE 606   < free >

               M819-Nr.1   < free >

               M819-Nr.2   < free >

----ENTER===============================

                INIT     REMOVE    QUIT

After pressing ENTER and selecting IFACE 606 with the arrow keys, the
component is set up with INIT. Choose the preset Unit-Id 61 by pressing OK.
Now the following menu appears:

----CONFIG/UNITA/IFACE 606==============

========================================

   CONFIG-A  CONFIG-B  CHAR        QUIT
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As the channel A is the default in many communications routines, the
communication should be configured via the channel A. Via CONF-A, choose
the configuration screen for channel A. Enter the values listed below:

----CONFIG/UNITA/IFACE 606/CONFIG-A=====

Baudrate    : < 9600 >

Parity      :   NONE

Data bits   :      8

Stop bits   :      1

Handshake   :   NONE

===========INPUT: CURSOR <- / ->========

   RESET                     OK    ABORT

Finally, you should check the presetting of the communications protocol under
the menu CHAR in CONFIG/UNITS/IFACE 606. It should appear as follows:

----CONFIG/UNITA/IFACE 606/CHAR=========

CH.A Char START   :   /

     Char END     : BSlsh

CH.B Char START   :   /

     Char END     : BSlsh

========SELECTION: CURSOR <- / ->========

   RESET                     OK    ABORT

This completes the configuration of the IFACE 606. Quit the menu via QUIT.
Choose QUIT again to terminate the component configuration. You will be
prompted to save the changes.

The following screen will appear:

----ABIMED GYNK_231  3.15==DEFAULT.XCP==

231XL: 10/1230   RACKS: 0    ZONES: 0

DIL  :  0/1000

MP3  :

HPP  :

M506 :           M606: 61

=========NO PROGRAM===MEM: 80872========

  FILE   CONFIG   EDITOR   RUN   MANUAL
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Now, the sample tray types and the sample zones must be set up. By pressing
CONFIG again, you will return to the selection of the components previously
set up.

----UNIT----Gynk_231/CONFIG--------------

  XYZ-ROBOT   231B V1.11      to ID: 10

  DILUTOR 1   402S V2.21      to ID:  0

  INTERFACE   606  V1.0       to ID: 61

---------ADD-/DEL-UNIT = <ENTER> --------

 ZDRIVE   RINSE    TRAY    VALVES    QUIT

After selecting XYZ-ROBOT, further configuration is via TRAY.

----Gynk_231/CONFIG/XYZ-ROBOT/TRAY------

=========================MEM: 79280 ====

         RACKS  ZONES  CHECK       QUIT

After the sample rack has been specified under the menu item RACKS, you
can divide the rack in several ZONES. For a rack of the type 0 with a capacity
of 80 samples, the division could be as follows:

=T  ZoneName   ===Vials=== ? SUM  Rack==

    SAMPLE_A      1-40     P 40   1-1

    RESULT_A  41   -80     P 40   1-1

===Racks:1===Vials:80===================

 APPEND   INSERT  DELETE  RUN-?    QUIT

The Dionex device driver supports two standard zone names, SAMPLE_A, and
RESULT_A. Other source zones cannot be used for the sample extraction!
This means that all inject samples of a batch run must be placed in one of the
two sample zones!
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The zones each contain 40 sample positions, numbered from 1 to 40 in a
Sample file. In the above example, the sample 1 of the zone RESULT_A has
the position 41. Of course, it is possible to set up and assign more zones on
the rack (see selection list under the menu item APPEND or INSERT) to meet
to individual requirements.

 Caution: Samples to inject must always be located in SAMPLE_A or
RESULT_A. The parameter ? (see top line of display) must be
set to P. This is achieved by repeatedly pressing RUN-? until P
appears on the display.

Which source zone is used for the injection, is stated in the
corresponding Gilson method file, the contents and significance
of which is described below.

 Caution: Under the Dionex Chromatography Management System the
selected source zone must also be specified. This is by setting
the corresponding properties. The default setting is SAMPLE_A.

The configuration settings required for the operation via the Dionex
Chromatography Management System are now completed. After repeatedly
pressing QUIT and saving the operation, the main screen appears again.

----ABIMED GYNK_231  3.15==DEFAULT.XCP==

231XL: 10/1230   RACKS: 1    ZONES: 2

DIL  :  0/1000

MP3  :

HPP  :

M506 :           M606: 61

=======NO PROGRAM=====MEM: 78824========

  FILE   CONFIG   EDITOR   RUN   MANUAL

Creating the Standard Task for Operating the Gilson Sample Preparation
System with the Dionex Chromatography Management System
The two required minimum tasks for operating the Gilson 231 XL
Autosampler device driver are described below.

Program for Method Selection
To access various injection methods (sub programs) from the Dionex
Chromatography Management System, the following main program must be
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created (for notes on using the editor refer to the Gilson user manual for the
Xtray software!).

=========GYNK_231-EDITOR================

1 DoMethod606

< PRG-End >

======================MEM: 77072========

  CLIP   INSERT   DELETE   PARAM   QUIT

When inserting DoMethod606, only the communications channel must be set
in the 606 Interface. Press CONFIG and set the 606-Channel parameter to A.

The main program is responsible for starting one of a maximum of 10 possible
injection methods. The Dionex Chromatography Management System sends
the name of a sub program to the main program. DoMethod606 loads the sub
program that then controls sample processing. The sub program is active as
long as the user explicitly selects another sample preparation method (sub
program). Thus, the active sub program is interrupted. The sample preparation
program returns to the DoMethod606 task and receives the name of the
sample preparation method from the Dionex Chromatography Management
System. DoMethod606 is quit only after choosing the Disconnect command of
the Dionex Chromatography Management System.

The main program consists of a DoMethod606 call. It is up to the user to start
other tasks before and after DoMethod606. Ensure that DoMethod606 is
running while the Dionex Chromatography Management System controls the
sample preparation system.

The main program can be saved under any file name (extension XCP).
Proceed as follows:

From the main menu, choose the FILE menu item. In the subsequently
appearing selection menu, choose SAVE.
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=============FILE:DEFAULT.XCP==========

for DoMethod-Tasks (.XSP-File)

Tasklist without configuration:

LOAD=<1>  SAVE=<2>  LIST=<3>

======================MEM: 78768========

  LOAD   SAVE   LIST   LOCK   QUIT

 Caution: For saving a main program (XCP files), use the function SAVE
(F3). Via SAVE = <2> (key 2), "sub programs" are generated
with the extension XSP! See below for further information.

Injection Methods (Sub Programs)
In the Dionex Chromatography Management System, the injection method is
selected via a property. As soon as this property is set in a PGM File or in the
Online, DoMethod606 (in the main program) starts the corresponding sub
program, the name of which must be 1.XSP, 2.XCP ... 10.XSP in the file
directory of the sample preparation system!

The minimum sub program appears as follows:

=========GYNK_231-EDITOR================

1 SendConf606

2 BeginLoop

3 InjectK606 RESULT_A

4 EndLoop

< PRG-End >

======================MEM: 76536========

  CLIP   INSERT   DELETE   PARAM   QUIT

It consists of two further tasks:

The task SendConfig606 sends the parameter limits for the current sample
preparation system to the Dionex Chromatography Management System at the
beginning of the sub program. Thus, the Dionex Chromatography Management
System can check the limits for the sample position and the injection volume.
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The InjectK606 task within the loop <BeginLoop 1> ..... <EndLoop>. It receives
the sample position and the injection volume from the Dionex Chromatography
Management System. The loop is passed until the user replaces the old sub
program by loading the new injection method.

The following steps are required for creating a sub-program:
• Start the editor.

• Delete the existing program.

• Insert the task SendConf606. Set the 606-Channel parameter to A.

• Insert BeginLoop.

• Insert the task InjectK606. Set the parameters of this task via the following
screen.

=========Task-3/InjectK606/PARAM========

========================================

  TCONF  INJPAR1  INJPAR2  ->PAR2   QUIT

The following parameters must be set:
TCONF ‘Sourcezone’ to ‘SAMPLE_A’ or

‘RESULT_A’
INJPAR1 ‘606-Channel' to ‘A’
‘Command - Echo’ to ‘AN’

Configure the other parameters as described in the documentation for the
Gilson Sample Preparation System Software.

• Insert EndLoop
Before InjectK606, the user can insert any tasks for sample preparation in the
Begin... End loop. The InjectK606 task can be included only once in the loop.

When closing the editor the user is prompted whether changes should be
saved immediately. It is important to select Do not save here. Otherwise, the
"main program" will be overwritten. The "sub-program" must be saved via the
File menu.

=============FILE:DEFAULT.XCP==========
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for DoMethod-Tasks (.XSP-File)

Task list without configuration:

LOAD=<1>  SAVE=<2>  LIST=<3>

======================MEM: 78768========

  LOAD   SAVE   LIST   LOCK   QUIT

After selecting the key <2>, choose New to save the "sub-program" under a
new name (1.XSP to 10.XSP).

For information on the different loading and saving functions of the main and
sub tasks, see the following paragraph.

Notes on Using the Editor of the Sample Preparation System
Before its extension for the Dionex Chromatography Management System, the
sample preparation system recognized only task files with the extension XCP.
With the introduction of sub programs, there are now XSP files the names of
which are not correctly displayed in the title lines of the menu displays. After
loading an XSP2 File in the File menu (function 1), it is no longer possible to
determine the name of the file currently in the editor, as the name of the last
loaded XCP file is displayed. It is therefore necessary to consider the file type
of the last opened file. Otherwise, saving a file may generate (not serious) or
overwrite (serious) a file of another type!

Notes on the Operation via the Dionex Chromatography Management
System
Before the Dionex Chromatography Management System is started, the main
task must be activated on the Sample Preparation System.

Starting the Main Task
Perform the following steps:
• Use the Load function to load the main task in the File menu.

• Return to the main menu with Quit and press Run.

• Confirm all following prompts by <ENTER>.
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• Press Ok. The program should now be ready to start. Decide whether to
activate the audit of the sample preparation system or not.

• Then activate the program by pressing Start. In the display, the prompt of
the method file name appears through the Method606 task.

Now, the sample preparation system is ready to receive the method name and
other commands via RS232 from the PC of the Dionex Chromatography
Management System.

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.

 GILSON INI File (Example)
The following example describes the structure of an INI File typical for Gilson

Autosampler. Select the INI File on the INI File tab (link available in the
Online Help only). See the Comment section for a description of the individual
lines.

Section Comment

[Gilson-231]
SamplerID = 10 GSIOC sampler address
DilutorID = 0 GSIOC address
Syringe   = 500 Dilutor syringe volume
RackCode  = 0 Rack code (to identify rack)
TriggerInject = 1 Determines which change from load to inject position will be

interpreted as inject response

[Inject]
1       INJECT 1 Rheodyne in inject position
2       RACK CODE 0 Rack code = 0
3       C0 = 1 Number of samples = 1
4       INPUT C1/1 Start position enquiry
5       IF C0 + C1 > 81 Safety condition
6       GOTO 3
7       INPUT C2/31 Get inject volume
8       B3 = 1 B3 = variable for y coordinate



782 Installing and Controlling Third-Party Instruments

Section Comment
9       FOR A = 1/5 Calculus of Y-(B3) and
10      B = C1 - 16 X-(C1) coordinates of sample position
11      IF B < 1
12      GO TO 16
13      C1 = C1 - 16
14      B3 = B3 + 1
15      NEXT A
16      C9 =1 Variable for program start
17      C = 0 Set sample counter to 0
18      RINSE Wash syringe needle outside
19      DISP. 0/500/9
20      TUBE 0/0 Wash needle inside
21      DISP. 0/500/4 Wash inject port
22      FOR B = B3/5 Y- direction on rack
23      FOR A = C1/16 X- direction on rack
24      C = C + 1 Increment sample counter
25      PRINT C/1 Display sample number
26      IF C > C0 Reset condition
27      HOME
28      TUBE A/B Go to position A/B
29      HEIGHT Move needle to maximum elevation
30      WAIT 2 Wait 2/100 min.
31      IF C9 = 1 Variable for program start
32      GO TO 34
33      WAIT /3/0 Wait for address 3 to reach state 0
34      ASPIR 0/5/1 Draw 5 µl air
35      HEIGHT 0 Move needle to lowest position
36      ASPIR 0/C2 + 15/1 Draw inject volume + 15 µl
37      WAIT 2 Wait 2/100 min.
38      TUBE 0/0 Inject position
39      DISP 0/15/1 Wash dead volume with 15 µl sample solvent
40      WAIT 2 Wait 2/100 min.
41      INJECT 0 Move Rheodyne valve to load position
42      DISP 0/C2/1 Load sample volume to loop
43      WAIT 2 Wait 2/100 min.
44      INJECT 1 Rheodyne to inject position
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Section Comment
45      AUXIL 7/1 Start integrator
; 45      AUXIL 1/1 Command for device no. 203 994 and 203 995
46      WAIT 5 5/100 min. waiting time
47      AUXIL 7/0 Reset integrator start signal
; 47      AUXIL 1/1 Command for device No. 203 994 and 203 995
48      C9 = 2 Program continuation variable
49      DISP 0/500/9 Wash
50      RINSE
51      DISP 0/500/9
52      NEXT A Next sample in X- direction
53      C1 = 1 Set X coordinate for next sample row
54      NEXT B Next row
56      HOME
*** END OF INJECT
PROGRAM

[Prog-0]
[Prog-1]
[Prog-2]
[Prog-3]
[Prog-4]
[Prog-5]
[Prog-6]
[Prog-7]
[Prog-8]
[Prog-9]

For an overview on the different Gilson instruments for which Dionex device
drivers are available, see  Gilson.
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 ISCO

FoxiJr Fraction Collector
Connecting the ISCO FoxiJr Fraction Collector to the Dionex
Chromatography Management System is via a serial Modem Cable (Dionex
part no. 8914.0128 for a 25-pin port or Dionex part no. 8914.0144 for a 9-pin
port) that must connect the following pins:

ISCO FoxiJr PC
25-pin (male) 25-pin (female) 9-pin (female)

8 (cable shield) 1  (cable shield)
3 ---------------- 3 2
2 ---------------- 2 3
7 ---------------- 7 5

As soon as a physical connection is established, the instrument and software
installation can be started in the Server Configuration.

• Switch the instrument on and press the soft-key button B (Config) until the
mode Serial control = Off appears in the display.

• Use the Select keys (C / D) to switch the mode on.

• Press the Enter key (E).

• Then set the baud rate via the Select keys (C / D) to 9600 baud. Press
Enter.

Perform the software installation of the instrument in the  Server
Configuration of the Dionex Chromatography Management System by using
the ISCO_Foxi_Jr_Fraction_Collector Device Driver.

You now have the possibility to control the instrument via the
⇒Connect/Disconnect, Tube (= position of the collection container) and Valve
(= switching between Collect and Waste) commands.

ISCO Foxi200 (Fraction Collector)
Controlling the ISCO Foxi 200 Fraction Collector under the Dionex
Chromatography Management System requires the ISCO Foxi 200 Fraction
Collector Device Driver.
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Connecting the fraction collector is via a standard Modem Cable (Dionex part
no. 8914.0128 for a 25-pin port or Dionex part no. 8914.0144 for a 9-pin port,
no null modem cable!).

Please ensure that the baud rate is set to 9600. For information on setting the
baud rate, see your Foxi200 manual.

Each Foxi200 has a unit ID (1 .. 7). Each ID can be controlled with the Dionex
Chromatography Management System. The Dionex Chromatography
Management System scans for all unit Ids during connect.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 JASCO
The following JASCO instruments can be controlled:

 JASCO Autosamplers 950 and 1555

 JASCO Detectors 970/975 (UV) and 920 (Fluorescence)

 JASCO Pump 980 (LPG/HPG)

 Tip: Controlling JASCO instruments requires the Extended Device
Control  Option. Select About CHROMELEON (link available
in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 JASCO Autosamplers 950 and 1555

JASCO 950 and 1555 (Autosamplers)
Controlling the JASCO 950 and JASCO 1555 Autosamplers requires the Jasco
950/1555_Sampler Device Driver to be installed in the  Server
Configuration.

The Autosamplers are controlled via a serial interface cable (Dionex part no.
8914.0113 for a 25-pin port or Dionex part no. 8914.0134 for a 9-pin port) with
the following pin assignment:

JASCO PC
25-pin (female) 9-pin (female

2 ----------- 3 2
3 ----------- 2 3
7 ----------- 7 4

Internal: Internal Internal:
4 --- 5 4 --- 5 7 --- 8
6 --- 20

Set the jumpers on the control board of the serial interface of the JASCO
device (directly at the 25-pin serial female connector) as follows (very often the
factory default setting is different!):

Otherwise, serial control will not be possible. As soon as there is a physical
connection, the instrument and the software can be installed in the Server
Configuration. Interface parameters: 4800 baud; 8 data bits; no parity; 2 stop
bits; handshake XON.

For an overview on the different JASCO instruments for which Dionex device
drivers are available, see  JASCO.
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 JASCO Detectors 970/975 (UV) and 920 (Fluorescence)

Data Acquisition via the UCI-100 Universal Chromatography Interface
Data acquisition via an UCI-100 Universal Chromatography Interface
additionally requires connecting the green wire (digital GND) of the UCI-100
analog cable to the REC/GND terminal of the JASCO UV detectors (or the
REG/G terminal of the fluorescence detector, respectively.) In addition, the
ground the UCI-100 analog cable to the detector housing (do not confuse with
the REG/GND terminal - the shield ground, i.e. the knurled nut at the housing,
is called GND as well.)

JASCO 970/975 (UV Detectors)
Controlling the JASCO 970 and 975 UV detectors under the Dionex
Chromatography Management System requires the
Jasco970_UV_VIS_Detector or Jasco975_UV_VIS_Detector device driver,
respectively.

The required cable is a Dionex cable (Dionex part no. 8914.0113 for the 25-pin
connection or Dionex part no. 8914.0134 for the 9-pin connection - for
information on the pin assignment see  JASCO Autosamplers 950 and
1555)

For information on the interface parameters, see the JASCO 950 Autosampler

JASCO 920 (Fluorescence Detector)
Controlling the JASCO 920 Fluorescence Detector under the Dionex
Chromatography Management System requires the
Jasco920_Fluorescence_Detector device driver.

For information on the serial interface cable and the interface parameters, see
the JASCO Autosampler 950.

For an overview on the different JASCO instruments for which Dionex device
drivers are available, see  JASCO.
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 JASCO Pump 980
Controlling the JASCO 980 pump under the Dionex Chromatography
Management System requires the Jasco980 Pump device driver.

 Tip: Controlling the pump requires firmware version 2.60 or higher.

Connection of the Jasco 980 pump to the Dionex Chromatography
Management System is via an RS 232 cable. That is why installation of an RS
232 module in the pump is required. A Dionex cable (Dionex part no.
8914.0113 for a 25-pin port or 8914.0134 for a 9-pin port) is used for the
connection. For details on the pin assignment, see  JASCO Autosamplers
950 and 1555.

The JASCO 980 pump is suitable for both, Low Pressure Gradients (LPG) and
High Pressure Gradients (HPG):

LPG: Controlling a pump with the Dionex Chromatography Management
System. The pump controls the solvent mixer, which is connected to the
pump's Low Pressure Grad. output.

HPG: Controlling pump 1 with the Dionex Chromatography Management
System. The pump controls additional pumps via LC-Net connections.

 Tip: The setting whether the pump is operated as high pressure or
low-pressure gradient pump has to be made directly at the pump
(SHIFT 5 on the keypad).

 Note: Due to the extremely slow communication between the Dionex
Chromatography Management System and the pump, the
execution of the flow command is delayed for several seconds.
This can be compensated only by a correspondingly
programmed method.

When the lower pressure limit is fallen below, the pump is
switched off only after approx. two minutes as the tolerance time
of the pump is correspondingly long.

For an overview on the different JASCO instruments for which Dionex device
drivers are available, see  JASCO.
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 KNAUER
The Knauer UV Detector 2600 is connected via a standard RS232 cable
( Null Modem Cable with 9-pin male connector on the instrument's side;
Dionex part no. 8914.0103A for a 25-pin port or 8914.0129 for a 9-pin port).
From the 2 RS232 ports on the instrument's rear panel use port 1.

Configure the instrument within the setup as described below:

1. Place the cursor in the Setup Menu using the "arrow keys."

2. Press the "arrow down" key seven times.

3. The Control Menu is displayed.

4. Press the "arrow right" key once and then the "arrow down" key until RS232
is displayed. Further options are KNAUER.NET, RS-485 and analog.

5. Press the "arrow right" key again to set the baud rate.

6. Press the "arrow down" key until 9600 baud is displayed.

7. Pressing the "arrow right" key once again and then the "arrow left" key
returns you finally to the main status menu.

Install the detector in the  Server Configuration using the
Knauer_UV_Detector_2600 Device Driver.

 Note: The detector has two analog outputs for two wavelengths to
be acquired simultaneously. As with the  KONTRON
Detector 430, an oscillating grating is used. The wavelength
is 190 - 740 nm. By entering a wavelength of 0 nm, channels
can be switched off. Thus, the oscillation of the grating is
eliminated and the signal quality considerably enhanced. To
enable an entry of 0 nm, the wavelength range offered by the
Dionex device driver is between 0 nm to 740 nm. When
values between 1 nm and 189 nm are entered, an error
message is indicated in the audit trail. The message is
displayed only at the running time and not yet during the
Ready Check.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 KONTRON
Kontron instruments are connected via a special RS connecting cable (Dionex
part no. 8914.0112 for a 25-pin connection or Dionex part no. 8914.0133 for a
9-pin connection). The pins of the Kontron diode connector (5-pin) must be
connected to the pins of the 25-pin Sub-D-connector or 9-pin Sub-D connector
as shown below:

KONTRON PC (25-pin)

1
5

2

3
4 1. CTS

2. GND
3. RxD
4. RTS
5. TxD

Kontron diode connector

1
2
3
5

-----------
-----------
-----------
-----------

4
7
2
3

Internal:
5 --- 6 --- 20

KONTRON PC (9-pin)
1
2
3
5

-----------
-----------
-----------
-----------

7
5
3
2

Internal:
4 --- 6 --- 8

The baud rate set on the unit must correspond to the baud rate specified in the
Dionex device driver. Normally, the baud rate is 4800 bit/sec.

 Caution: Upon power-up of the PC it may happen that incorrect
characters are generated which the KONTRON instruments
cannot handle. An error message is displayed and must be
reset. Proceed as follows:

1. First, start your PC.

2. Wait until the booting is finished.

3. Start your instruments after booting.

4. Finally, start the server application.

If you are using the KONTRON Autosampler 360, it may
happen that due to those incorrect characters the sample
position from the previous sample is taken as position for the
current sample etc.
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KONTRON Autosamplers 360/560 and 460
A separate Device Driver is supplied for each instrument type (driver name:
Kontron 360/560 Autosampler or Kontron 460 Autosampler).

 Caution: If you are using the KONTRON Autosampler 360/560, it may
happen that due to those incorrect characters described above
the sample position from the previous sample is taken as
position for the current sample etc. Therefore, proceed as
described above when switching on your PC and your
instruments.

 Note: Some functions of the Autosampler 460 require the Extended
Device Control  Option. Select About CHROMELEON (link
available in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.

The Online Help assists you in establishing the Syringe Type Kontron360 and
the Syringe Type Kontron460 in the  Server Configuration. In addition, the
Online Help describes the general settings (General) as well as the Error
Levels.

KONTRON Autosampler 465

The Dionex Chromatography Management System supports the following
additional commands of the Kontron Autosampler 465 enabling pre-column
derivatization:

Command Comment

StartPosition Return to the start position

GetReagent Draw a reagent from a defined position

Mix Mixing

AddReagentAndMix Add reagent and mix with sample

AirSegment Draw air segment

 Tip: Using these commands requires the Extended Device Control
 Option. Select About CHROMELEON (link available in the

Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.
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Parameter Comment

Position Sample position

ReagentPosition Reagent position

ReagentVolume Reagent volume to be used

AirVolume Air volume drawn after the syringe
needle has been raised from the vial

MixingVolume Mixing volume

KONTRON Pumps 322/325 (52X) and 420/422
There is a common device driver (Kontron Pumps 32X and 52X) for the
Kontron gradient pumps 322 (high-pressure) and 325 (low-pressure). For the
pump type 322, the number of solvents must be reduced from three (default) to
two.

KONTRON Gradient Former 425
Controlling the KONTRON Gradient Former 425 requires the Kontron 425
Gradient Former device driver.

The Online Help supports you in setting the Solvents and the Heads in
 Server Configuration: Solvents and Pump Heads. In addition, the Online

Help describes the general settings (General) as well as the Error Levels.

KONTRON Detectors 430/535 and 432 (332)
A separate device driver (Kontron Detector 430, Kontron Detector 432, and
Kontron Detector 535) is available for each detector type. The models 430
and 535 differ only in the Filter property, which the type 535 additionally offers.
Via the settings Passive, Active and Automatic the signal can be filtered.
Controlling the detector type 332 requires the same device driver as the
detector 432.

KONTRON Fluorescence Detector SFM 25
The SFM 25 is connected via a special RS232C cable (Dionex part no.
8914.0125 for a 25-pin connection or Dionex part no. 8914.0141 for a 9-pin
connection) with the following pin assignment:
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KONTRON SFM25 PC
(25-pin) (9-pin)

2
3
4
5
6
7
8
20

Internal 4 --- 5

-----------
-----------
-----------
-----------
-----------
-----------
-----------
-----------

2
3
1

7
5
4
6

Internal: 7 --- 8

The Autoblank (zero value) and Calibrate (maximum value) commands of the
Kontron SFM25 allow adjusting the range factor in the Dionex Chromatography
Management System.

Install the instrument in the installation program (=  Server Configuration)
via the Kontron_SFM25_Fluorescence_Detector device driver.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 KRATOS
Controlling the Kratos UV Detector Spectroflow 783 under the Dionex
Chromatography Management System requires the Kratos Spectroflow 783
UV Detector Device Driver.

The instrument is connected to the server PC via a special RS connecting
cable (Dionex part no. 8914.0116 for a 25-pin connection or Dionex part no.
8914.0136 for a 9-pin connection).
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The pin assignment is as follows:

KRATOS Spectroflow PC
(9-pin SUB-D connector) (25-pin) (9-pin)

1 ---------------- 7 5
3 ---------------- 2 3
4 ---------------- 3 2

Internal: Internal:
4 --- 5 7 --- 8

For connecting the instrument, use the 9-pin port labeled SERIAL A on the rear
of the instrument.

For optimum operation via the RS232 port, the Baud Rate (9600 baud) and
Response Delay (4/60 sec) parameters must be set on the instrument (see
Detector manual).

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 MERCK HITACHI
Various Merck HPLC pumps and several Merck Autosamplers can be
controlled:

1. MERCK HITACHI Pumps

 L6200/L6210 (Device Driver: Merck Hitachi L6200/L6210 Pump)

(Also, see  MERCK HITACHI: Pumps - Program Example)

 L6250 (Device Driver: Merck Hitachi L6250 Pump

 L7100 (Device Driver: Merck Hitachi L7100 Pump)

2. MERCK HITACHI Autosamplers

 AS2000 (Device Driver: Merck Hitachi AS2000 Autosampler)

 AS4000 (Device Driver: Merck Hitachi AS4000 Autosampler)

 L7250 (Device Driver: Merck Hitachi L7250 Autosampler (controlled via
RS232) and Merck Hitachi L7200/L7250 AS (D-Line) (controlled via D-Line))

 L7200 (Device Driver: Merck Hitachi L7200/L7250 AS (D-Line))
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 Settings and Commands for the Different Autosamplers

3. MERCK HITACHI UV-VIS Detector

 L4250 (Device Driver: Merck Hitachi L4250 Detector)

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 MERCK HITACHI: Pumps L6200/L6210 and L6250

MERCK HITACHI L6200 and L6210 (HPLC Pumps)
The Dionex Chromatography Management System provides the Merck Hitachi
L6200/L6210 Pump Device Driver as common driver with all-important
functions for the MERCK HITACHI L6200 and L6210 pumps. Please note the
following:

• The connection is via a special serial RS232 cable (Dionex part no.
8914.0111 for a 25-pin connection or Dionex part no. 8914.0132 for a 9-pin
connection) that must connect the following pins ( Null Modem Cable):

MERCK HITACHI L62xx
Pumps PC (25-pin) PC (9-pin)

2 ---------- 3 3
3 ---------- 2 2
7 --------- 7 7

Internal: Internal: Internal:
4 connected to 5 5 connected to 4 7 connected to 8
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• In addition, the switch on the back of the unit must be switched to the
Remote position. Switch 1 on the horizontal board inside must have the
following settings:

Switch 1 1 2 3 4 5 6

Off On On On Off Off

• Switching from high-pressure to low-pressure gradient is performed on the
instrument itself. For the high-pressure gradient, a L6000 pump (slave
pump) must be connected to the Hitachi I/O-bus. The Dionex
Chromatography Management System is not capable of checking this!

• For the pump type L6210 (inert pump), a pressure limit of 145bar must be
entered in the  Server Configuration. Otherwise, the pump ignores all
flow commands. The maximum pressure of the L6200 pump is 400bar.

In addition, the Online Help offers support for setting the Limits and Solvents
in the Server Configuration program: Pump Heads and Limits and Solvents.
Besides, the Online Help describes the general settings (General) as well as
the Error Levels.

MERCK HITACHI HPLC Pump L6250
Controlling the MERCK HITACHI HPLC Pump L6250 under the Dionex
Chromatography Management System requires the Merck Hitachi L6250
Pump device driver. To start the pump, please note the following:

The connection is established via the same pin assignment, which is valid for
the L6200 pump. In addition, the settings of switch 1 are the same as for the
L6200 pump.

For optimum performance, set the upper pressure limit to 147 bar.

In addition, the Online Help offers support for setting the Limits and Solvents
in the  Server Configuration: Pump Heads and Limits and Solvents.
Besides, the Online Help describes the general settings (General) as well as
the Error Levels.

For a program example for Merck Hitachi pumps, see  MERCK HITACHI:
Pumps - Program Example
For information on installing the Merck Hitachi Pump L7100, see:

 MERCK HITACHI Pumps: L7100
For information on installing the Merck Hitachi Autosamplers, see:
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 MERCK HITACHI Autosampler: AS2000/AS4000

 MERCK HITACHI Autosampler: L7250

 MERCK HITACHI Autosampler: L7200.

For information on how to install the UV-VIS detector L4250, see  MERCK
HITACHI UV-VIS Detector L4250
For an overview on Merck Hitachi instruments for which Dionex device drivers
are available, see:

 MERCK HITACHI

 MERCK HITACHI: Pumps - Program Example
To avoid overloading the Merck pumps with too fast a sequence of commands,
allow for at least 0.1 min between the individual commands. For a program
example for the L6200 pump, see below:

-0.100 Pressure.LowerLimit = 0

Pressure.UpperLimit = 400

%A.Equate = "%A"

%B.Equate = "%B"

%C.Equate = "%C"

;******* Detector commands: ****************

UV_VIS_1.Mode = UV

UV_VIS_1.Range = 0.200

UV_VIS_1.Response = 1.0

UV_VIS_1.Step = Auto

UV_VIS_1.Average = On

UV_VIS_1.Wavelength = 260

 0.000 UV_VIS_1.Autozero

Flow = 1.000

%B = 10

%C = 0

Inject

UV_VIS_1.AcqOn

Flow = 1.000

%B = 10

%C = 0

;The gradient starts after 0.1 minutes to avoid overload the pump with
too fast a sequence of commands:
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0.100 %B = 10

10.000 %B = 90

15.000 %B = 90

16.000 %B = 10

30.000 UV_VIS_1.AcqOff

Flow = 1.000

%B = 10

%C = 0

End

For information on installing the Merck Hitachi pumps (L6200/L6210 and
L6250), see  MERCK HITACHI Pumps.

 MERCK HITACHI: Pump L7100
Controlling the MERCK HITACHI L7100 pump under the Dionex
Chromatography Management System requires the Merck Hitachi L7100
Pump (D-Line) Device Driver.

 Tip: Controlling this instrument requires the Extended Device
Control  Option. Select About CHROMELEON (link available
in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.

In addition, please note the following:

The HPLC pump L7100 must be connected to a D-line converter via a D-line
cable. Use the upper D-line socket of the L7100 (label RELAY BOX), only this
socket of the D-line converter has current supply. The D-line converter itself is
connected via a conventional null modem cable (for the Dionex part nos., see

Null Modem Cable) with a free COM port of the controlling PC.
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D-Line Converter PC (25-pin) PC (9-pin)
2 ---------------- 2 3
3 ---------------- 3 2
5 ---------------- 7 5

The driver uses the default settings of the D-line converter for the serial
communication: 4800 Baud, 8N1. To check: this setting is currently used if the
DIP-switch settings on the board inside the D-line converter are as follows:

Switch 1 1 2 3 4 5 6

Off Off On On On Off

Notes:
• To operate the pump L7100 in stand-alone mode, without D-line

connection: Press the Utility key while switching the pump on. Use the
displayed menus to remove D-line operation from the configuration. See
also the manual for the L7100.

• The D-line converter does not support the Disconnect command. After
successfully connecting the pump (the display changes from D-LINE
SYSTEM IS NOT READY to the flow display), the D-line system cannot be
de-initialized. Pump.Disconnect only stops the pump and sets the status
of Pump.Connected to disconnected.

• The pump L7100 does not support locking the keyboard. Even during
control via the D-line and the Dionex Chromatography Management
System, it would be possible to perform all actions directly via the pump.
However, this is not recommended during controlled operation. If the driver
detects keyboard operation, a corresponding warning is included in the
Audit Trail.

• Occasionally, there are deviations between the values indicated on the
display of the pump and the values of the corresponding properties of the
Dionex Chromatography Management System. These deviations are due
to the pump's firmware. Sometimes, the firmware does not supply the
displayed value for status requests via D-line. However, the deviations are
negligible rounding errors.
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• The Extended Device Control feature is required for the L7100 device
driver.

In addition, the Online Help offers support for setting the Limits and Solvents
in the  Server Configuration: Pump Heads and Limits and Solvents.
Besides, the Online Help describes the general settings (General) as well as
the Error Levels.

For information on installing other Merck Hitachi pumps (L6200/L6210 and
L6250), see:

 MERCK HITACHI Pumps: L6200/L6210 and L6250).
For information on installing the MERCK HITACHI Autosamplers, see:

 MERCK HITACHI Autosampler AS2000/AS4000

 MERCK HITACHI Autosampler 7250

 MERCK HITACHI Autosampler L7200

For information on how to install the UV-VIS detector L4250, see  MERCK
HITACHI UV-VIS Detector 4250
For an overview on the different MERCK HITACHI instruments for which
Dionex device drivers are available, see:

 MERCK HITACHI

 MERCK HITACHI: Autosamplers AS4000 and AS2000
Controlling the Merck Hitachi Autosamplers AS4000 and AS2000 requires
the Merck Hitachi AS4000 Autosampler or Merck Hitachi AS2000
Autosampler Device Driver.

Control is via the special serial RS232 interface cable (Dionex part no.
8914.0111 for the 25-pin port or Dionex part no. 8914.0132 for the 9-pin port)
which is described in detail under  MERCK HITACHI Pumps: L6200/L6210
and L6250).

 Caution: For information on the communication via serial interface, see
the appropriate Autosampler Manual. Especially note the
settings of the 6-fold communications DIP-switch on the rear of
the instrument.
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The following settings are required for the AS4000/AS2000 for the COM mode
(serial communication):

Switch 1 2 3 4 5 6
Off On On Off Off Off

Communication is enabled with the following parameters: 4800 baud, 7 data
bits, even parity bit, and 2 stop bits.

Differences between AS 4000 and AS2000
The two autosamplers AS4000 and AS2000 only differ in three parameters:

Parameter AS2000 AS4000
Sample number 100 200
Dilutor number 2 1
Syringe size (µl) 500 5000

The Online Help illustrates the two Server Configuration pages on these
autosamplers: General and Error Levels.

For information on installing other Merck Hitachi autosamplers, see:

 MERCK HITACHI: Autosampler L7250

 MERCK HITACHI: Autosampler L7200.

For information on installing Merck Hitachi pumps, see:

 MERCK HITACHI: Pumps L6200/L6210 and L6250

 MERCK HITACHI: Pump L7100

For information on how to install the UV-VIS detector L4250, see  MERCK
HITACHI UV-VIS Detector L4250
For an overview on the different MERCK HITACHI instruments for which
Dionex device drivers are available, see  MERCK HITACHI.
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 MERCK HITACHI: AS4000 - Program Example
To avoid stressing the Merck Autosamplers with a fast succession of
commands, allow at least for 0.1 min between the individual commands. A
program example for the AS4000 could look as follows:

;******* Pump Commands: ****************

Pressure.LowerLimit = 2

Pressure.UpperLimit = 200

%A.Equate = "Water"

%A.Type = Automatic

;******* Detector Commands: ****************

UV_VIS_1.Wavelength = 254

UV_VIS_1.Bandwidth = 1

UV_VIS_1.Step = 0.20

UV_VIS_1.Average = On

UV_VIS_1.RefWavelength = 600

UV_VIS_1.RefBandwidth = 1

Flow = 0.300

;******* Autosampler Commands: ****************

;(Allow for at least 0.1 min between the individual commands to avoid
stressing the autosampler with a rapid succession of commands)

-2.100 Home

Wash

-1.600 LeadVolume = 30.0

-1.550 RearVolume = 30.0

-1.500 Height Z = 0.0, NeedleSpeed = Fast

Aspirate DilutorNumber = 1, SyringePos = 5.0, PlungerSpeed =
VeryFast

;Aspirate 5 µl air

GotoTube RackCode = 1, TubeNumber = Position

;Go to the sample vial

Aspirate DilutorNumber = 1, SyringePos = LeadVolume + Volume +
RearVolume, PlungerSpeed = VeryFast

;Aspirate sample from sample vial
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Height Z = 0.0, NeedleSpeed = Fast

Aspirate DilutorNumber = 1, SyringePos = 5.0, PlungerSpeed =
VeryFast

;Aspirate 5 µl air

-1.000 GotoWashPort

;Wash outside of needle

-0.500 GotoInjectPort

Dispense DilutorNumber = 1, SyringePos = 5.0 + LeadVolume +
14.9, PlungerSpeed = VeryFast

;Dispense air + leadVolume + dead volume

GotoValvePos ValvePos = Load

Dispense DilutorNumber = 1, SyringePos = Volume, PlungerSpeed =
VeryFast

;Dispense injection volume

Syringe = -1

0.000 UV.Autozero

Inject

UV_VIS_1.AcqOn

;do not execute another program, Inject switches the valve only

GotoWashPort

Home

8.000 UV_VIS_1.AcqOff

End

 MERCK HITACHI: Autosampler L7250
Controlling the Merck Hitachi Autosampler L7250 requires the Merck Hitachi
L7250 Autosampler Device Driver.

 Tip: Some functions of this instrument require the Extended Device
Control  Option. Select About CHROMELEON (link available
in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.

Instrument connection is via a special serial RS232 cable (Dionex part no.
8914.0111 for the 25-pin port or Dionex part no. 8914.0132 for the 9-pin port).
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The following pins must be connected:

MERCK HITACHI L 7250 PC
(9-pin

Sub-D female)
(25-pin,

Sub-D female)
(9-pin,

Sub-D female)
2 ---------------- 2 3
3 ---------------- 3 2
5 ---------------- 7 5

Internal: Internal: Internal:
7 - 8 4 - 5 7 - 8

Choose the following communications settings, as described in the Instruction
Manual, Advanced Operation:

• Switch the instrument off.

• Press UTILITY and simultaneously switch the instrument on.

• Set the following parameters:

Baud rate: 4800
Data bits: 7
Parity: Even
Stop bits: 2
Termination: CR

• Switch the instrument off.

 Caution: In contrast to the AS 4000, only dilutor 1 is supported. For the
Move Needle command, there are different maximum values (x
= 156, y = 156, z = 57).

The Online Help provides information on the two Server Configuration pages
for these autosamplers: General and Error Levels.

For information on installing other Merck Hitachi autosamplers, see:

 MERCK HITACHI: Autosampler AS2000/AS4000

 MERCK HITACHI: Autosampler L7200.

For information on installing Merck Hitachi pumps, see:

 MERCK HITACHI: Pumps L6200/L6210 and L6250

 MERCK HITACHI: Pumps L7100
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For information on how to install the UV-VIS detector L4250, see  MERCK
HITACHI UV-VIS Detector L4250
For an overview on the different MERCK HITACHI instruments for which
Dionex device drivers are available, see  MERCK HITACHI.

 MERCK HITACHI: Autosampler L7200
Controlling the Merck Hitachi Autosampler L7200 requires the Merck Hitachi
L7200/L7250 AS (D-Line) Device Driver.

 Tip: Controlling this instrument requires the Extended Device
Control  Option. Select About CHROMELEON (link available
in the Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check whether
this option is available.

Instrument connection is via a special serial RS232 cable (Dionex part no.
8914.0111 for the 25-pin port or Dionex part no. 8914.0132 for the 9-pin port)
and a D-Line converter (for details about D-Line cabling and communication
setup please see  MERCK HITACHI: Pumps L7100
Due to limitations in the D-Line command set, only the following basic
operations are supported:
• Connect (see: ⇒Connect/Disconnect)

• Disconnect (disconnects sampler from the Dionex Chromatography
Management System but does not disconnect sampler from D-Line control)

• ⇒Inject (with the Vial Number and Sample Volume parameters)

• Sampler busy

 Note: The Merck Hitachi L7200/L7250 AS(D-Line) device driver can
also be used to control a L7250 Autosampler that is connected
to a D-Line system. However, controlling L7250 autosamplers
via RS232 (see above) is preferred.

In addition, the Online Help offers support regarding the two  Server
Configuration pages: Rack and Syringe. Besides, the Online Help describes
the general settings (General tab) as well as the Error Levels.
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For information on installing other Merck Hitachi autosamplers, see:

 MERCK HITACHI Autosampler AS2000/AS4000

 MERCK HITACHI Autosampler: L7250.

For information on installing Merck Hitachi pumps, see:

 MERCK HITACHI: Pumps L6200/L6210 and L6250

 MERCK HITACHI: Pumps L7100

For information on how to install the UV-VIS detector L4250, see  MERCK
HITACHI UV-VIS Detector L4250
For an overview on the different MERCK HITACHI instruments for which
Dionex device drivers are available, see  MERCK HITACHI.

 MERCK HITACHI: Settings and Commands for the
    Different Autosamplers

Supported Autosampler
For Autosampler … …controlled via… …use device driver
AS2000 RS232 Merck Hitachi AS2000 Autosampler
AS4000 RS232 Merck Hitachi AS4000 Autosampler
L7250 RS232 Merck Hitachi L7250 Autosampler
L7250 D-Line Merck Hitachi L7200/L7250 AS (D-Line)*
L7200 D-Line Merck Hitachi L7200/L7250 AS (D-Line)

* The Merck Hitachi L7200/L7250 AS (D-Line) device driver requires the
Extended Device Control  Option.



Installing and Controlling Third-Party Instruments 807

Supported Device Properties
AS2000 AS4000 L7250 L7200

InjectPortWashs 0-20 0-20 0-20 0-20³
InjectPortWashSpee
d

1 (Low) ...
5 (High)

1 (Low) ...
5 (High)

1 (Low) ...
5 (High)

1 (Low) ...
5 (High)3

NeedleWashs 1-20 1-20 1-20 1-20³
NeedleWashSpeed 1 (Low) ...

5 (High)
1 (Low) ...
5 (High)

1 (Low) ...
5 (High)

1 (Low) ...
5 (High)³

WasteVolume Not supported Not supported 0-4000.0 µl 0-4000.0 µl²
WashVolume 10.0-100.0 µl 10.0-1000.0 µl 10.0-1000.0 µl
LeadVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl²
RearVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl²
FeedVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl²
DeadVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl
Syringe 0-100.0 µl 0-1000.0 µl 0-1000.0 µl
InjectionMethod 0 (Compatibility)

1 (Cut)
2  (All)

0 (Compatibil.)
1 (Cut)
2 (All)

0 (Compatibil.)
1 (Cut)
3 (FullLoop)

1 (Cut) ...
3 (FullLoop)²

SyringeSpeed 1 (Low) ...
5 (High)

1 (Low) ...
5 (High)

1 (Low) ...
5 (High)

NeedleDownSpeed 1 (Slow) ...
2 (Fast)

1 (Slow) ...
2 (Fast)

1 (Slow) ...
2 (Fast)

1 (Slow) ...
2 (Fast)

VolSyringe 1 (100µl) -
2 (500 µl)

1 (100 µl) -
5 (5000 µl)

1 (100 µl) -
5 (5000 µl)

Not supported

PumpPlungerWash Not supported Not supported 0 (No) or
1 (Yes)

0 (No) or
1 (Yes)³

VolOptionalSyringe Not supported 1 (100 µl) -
5 (5000 µl)

Not supported Not supported

NumberOfDilutors Not supported 1 or 2 Not supported Not supported
Dilutor Not supported 1 or 2 Not supported Not supported
RackCode 1 - 16 1 - 16 1 - 16 Not supported
⇒Volume 1 - 500.0 µl 1 - 5000.0 µl 1 - 5000.0 µl 1 - 500.0 µl
⇒Position 1 - 100 1 - 200 1 - 200 1 - 200

²  If one of these properties is set, all other settings that are marked with ² are
set, too. Check the parameters sent to the autosampler with extra care.

³ If one of these properties is set, all other settings that are marked with ³ are
set, too. Check the parameters sent to the autosampler with extra care.

Supported Device Commands
AS2000 AS4000 L7250 L7200
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⇒Connect (/Disc.) Supported Supported Supported Supported
Disconnect Supported Supported Supported Not supported
Aspirate (see
⇒Draw)

0 - 500.0 µl,
Speed

Dilutor, 0 -
5000.0 µl, Speed

0 - 5000.0 µl,
Speed

Not supported

⇒Dispense 0 - 500.0 µl,
Speed

Dilutor, 0-
5000.0 µl, Speed

0-5000.0 µl,
Speed

Not supported

GotoTube 1 - 100,
RackCode

1 - 200,
RackCode

1 - 200,
RackCode

Not supported

GotoWashPort Supported Supported Supported Not supported
GotoInjectPort Supported Supported Supported Not supported
MoveNeedle X:0-163.0 mm

Y:0-68.0 mm
Z:0-38.0 mm

X:0-244.0 mm
Y:0-163.0 mm
Z:0-57.0 mm

X:0-156.0 mm
Y:0-156.0 mm
Z:0-57.0 mm

Not supported

Height Z:0-38.0 mm Z:0-57.0 mm Z:0-57.0 mm Not supported
GotoSyringePos 0 - 500.0 µl,

Speed
Dilutor, 0-
5000.0 µl, Speed

0 - 5000.0 µl,
Speed

Not supported

GotoSValvePos 0 (Bottle) or
1 (Needle)

Dilutor, 0 (Bottle)
or 1 (Needle)

0 (Bottle) or
1 (Needle)

Not supported

GotoValvePos 0 (Inject) or
1 (Load)

0 (Inject) or
1 (Load)

0 (Inject) or
1 (Load)

Not supported

Home Supported Supported Supported Not supported
Reset Supported Supported Supported Supported
Wash Supported Supported Supported Not supported
WashPumpPlunger Not supported Not supported Supported* Not supported
Inject Supported -

see below
Supported -
see below

Supported -
see below

Supported

Wash_X Supported -
see below

Not supported Supported -
see below

Not supported

WashDil_X Not supported Supported -
see below

Not supported Not supported

GotoOpValvePos Not supported Not supported 0 (Inject) or
1 (Load)*

Not supported

* Executing these properties requires the Extended Device Control
 Option.



Installing and Controlling Third-Party Instruments 809

Inject Programs:
AS2000
AS4000
L7250

Depending on the current value of the Syringe device property, three different
programs are internally executed during processing an ⇒Inject command. For
AS2000 and L7250 the dilutor property always equals 1.
Syringe>0 GotoSyringePos SyringePos=0

Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoSValvePosSValvePos=Bottle
Dilutor=<current value of property Dilutor>

GotoSyringePos SyringePos=<current value of property
Syringe>
Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoTube TubeNumber=<current value of property
Position>
RackCode=<current value of property
RackCode>

Aspirate AspirateVol=<current value of property Volume>
Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoInjectPort
GotoValvePos ValvePos=Load
GotoSyringePos SyringePos=0

Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoValvePos ValvePos=Inject
Syringe=0 GotoTube TubeNumber=<current value of property

Position>
RackCode=<current value of property
RackCode>

Aspirate AspirateVol=<current value of property
Volume>
Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoInjectPort
GotoValvePos ValvePos=Load
GotoSyringePos SyringePos=0

Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoValvePos ValvePos=Inject
Syringe<0 GotoValvePos ValvePos=Inject

L7200 Based on the current parameter settings, the autosampler performs an injection.
The Inject command transmits the vial number and the sample volume only.
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Wash Programs:
AS2000
AS4000
L7250

This is the program that is run when the extended wash command (Wash_X
resp. WashDil_X) is executed. For AS2000 and L7250 the dilutor property
always equals 1.
GotoWashPort
GotoSValvePosSValvePos=Bottle

Dilutor=<current value of property Dilutor>
GotoSyringePos SyringePos=<current value of property Syringe>

Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoSValvePosSValvePos=Needle
Dilutor=<current value of property Dilutor>

GotoSyringePos SyringePos=0
Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoInjectPort
GotoSValvePosSvalvePos=Bottle

Dilutor=<current value of property Dilutor>
GotoSyringePos SyringePos=<current value of property Syringe>

Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

GotoSValvePosSValvePos=Needle
Dilutor=<current value of property Dilutor>

GotoSyringePos SyringePos=0
Speed=<current value of property Speed>
Dilutor=<current value of property Dilutor>

L7200 not supported

For details on how to install the different autosampler types, see the following
topics:

 AS2000

 AS4000

 L7250

 L7200
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 MERCK HITACHI: UV-VIS Detector L4250
Controlling the Merck Hitachi UV-VIS Detector L4250 requires the Merck
Hitachi L4250 Detector Device Driver.

Instrument connection is via a special serial RS232 cable (Dionex part no.
8914.0111 for the 25-pin port or Dionex part no. 8914.0132 for the 9-pin port)
that must connect the following pins:

MERCK HITACHI L4250 PC
(25-pin male) (25-pin female) (9-polig female)

2 ---------------- 3 3
3 ---------------- 2 2
5 ---------------- 5 5

internal internal: internal:
4 connected to 5 5 connected to 4 7 connected to 8

The PAN-RS232C switch on the back of the unit must be switched to the
RS232C position. DIP-switch 2 (labeled Mode) must have the following
settings:

Switch 1 1 2 3 4 5 6
Off (down) On (up) On On Off Off

For further information on the Server Configuration, see General, UV_VIS_X,
and Error Levels in the Online Help.

For information on installing other Merck Hitachi autosamplers, see:

 MERCK HITACHI Autosampler AS2000/AS4000

 MERCK HITACHI Autosampler: L7250.

For information on installing Merck Hitachi pumps, see:

 MERCK HITACHI: Pumps L6200/L6210 and L6250

 MERCK HITACHI: Pumps L7100
For an overview on the different MERCK HITACHI instruments for which
Dionex device drivers are available, see  MERCK HITACHI.
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 NELSON Interfaces
The Dionex Chromatography Management System offers two Device Drivers
to control different Nelson boxes:

The Nelson 941 Interfaces driver supports the PE Nelson Interfaces Type 941
and 901 or 902 (NCI 900).

The Nelson 950/960/970 driver supports the PE Nelson Interfaces Types 950,
960, and 970.

 Caution: At present, no drivers are available for the type 940 and all
previous types (with 700 or 800 numbers). In addition, no driver
is available for the Perkin Elmer Analytical Interface. (For the
exact type name, see the instrument's rear panel.)

For details on the Nelson device drivers, see the following topics:

 NELSON Interfaces: Pin Assignment

 NELSON Interfaces: Device Driver Configuration

 NELSON Interfaces: Properties

 NELSON Interfaces: Data Acquisition Restrictions

 NELSON Interfaces: Differences from Conventional Nelson
    Box Installations
For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 NELSON Interfaces: Pin Assignment

RS Cable
The pin assignment of the serial cable varies for the different types.

The type 941 is fitted with a 25-pin male connector:

PC Nelson 941
25-pin connector 9-pin connector (Alternative) 25-pin connector

1 Ground 1
3 2 2
2 3 3
7 5 7

This is a standard null modem cable (for the Dionex part nos. see: Null
Modem Cable).

The types 950, 960, and 970 are fitted with a 25-pin female connector.

The cable must connect the pins 1, 2, 3, 4, 5, and 7 of this connector with the
same pins of the 25-pin male connector on the PC (i.e. not crossed, with
hardware handshake).

PC Nelson 950 - 970
25-pin connector 9-pin connector (Alternative) 25-pin connector

1 Ground 1
2 3 2
3 2 3
4 7 4
5 8 5
7 5 7

This is a modem cable (for the Dionex part nos., see Modem Cable).

For the serial interface, the type 901 is fitted with an RJ45 connector:

PC Nelson 941
25-pin connector 9-pin connector (Alternative) RJ45 connector

2 3 6
3 2 3
7 5 4-5

Set the DIP-switches 6 and 7 to ON, all other DIP-switches to OFF.
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The Nelson Box 901 is a one-channel version. Therefore, do not install the
second channel, which is provided by the driver. As standard, the Nelson Box
901 has two relays only (Ready and Relay #1) but the 941 driver also knows
relays 2-7, which, however, are optionally available only.

Start, Stop, Ready
The start input is intended for the sampler start signal (inject response).
Normally, the assignment of the previous installation (e.g. ACCESS*CHROM)
can be used.

The stop input is intended for the stop signal to terminate the data acquisition.
As the Dionex Chromatography Management System does not support this
option, any connected cable should be removed.

The Ready output informs the instruments that the box and the data system are
ready for injection and for data acquisition. Under the Dionex Chromatography
Management System, this signal is activated with the Inject command and is
deactivated as soon as the inject response is returned. If possible, this cable
should be connected. Exception: If a separate Dionex device driver controls the
sampler, the sampler should not be connected to the Ready output. The
reason for this is that the sampler may not inject, since the Ready line is not
cleared.

Channels A-B and Relays 1-7
Normally, the assignment of the previous installation can be used.

Rack/Vial Port
The Dionex Chromatography Management System uses this port to read the
sample position. For the assignment, see the manual for the box. Please note
that the pin assignment is as follows. Left row from top to bottom: 1 to 8; right
row: 9 to 15. Normally, the assignment of the previous installation can be used.

For the Nelson Box 901, the rack/vial port is optionally available, only.

For further information on the Nelson Interfaces, see:

 NELSON Interfaces
 NELSON Interfaces: Device Driver Configuration
 NELSON Interfaces: Properties
 NELSON Interfaces: Data Acquisition Restrictions
 NELSON Interfaces: Differences from Conventional Nelson Box

     Installations
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 NELSON Interfaces: Device Driver Configuration
In the default configuration (set only the COM port, use all other presetting), the
device driver supplies all functions for a non-controlled timebase. The Remote
Inject and the Integrator are virtually integrated. Installing a serial sampler or
detector device driver is also possible. In this case, the included device drivers
must be deactivated to clear the corresponding ports for the other device
drivers.

Integrated "Remote Inject"
The integrated Remote Inject device driver is configured on the Remote Inject
tab.

If Read Sample Position from Rack & Vial Port is selected, the sample
position is read from the port (RVP) immediately after injection. The following
options are available:
• Select Invert Inputs if the meaning of True and False is inverted (e.g., if

position 1 is read as 4094 (= 3FFEh)).

• Mask should only be changed if further signals not related to the sampler
position are connected to the RVP (this is a Hex number that is linked via
and to the value read by the RVP).

• Set Encoding to binary if the sampler performs binary coding of the
sampler position (This is not common, otherwise position 16 is read as 10).

Using a Different Sampler Device Driver
If a different sampler device driver is used, the integrated Remote Inject driver
should be deactivated. In this case, the start input of the box is available as
RemoteStart port for other drivers using a digital Inject Response. This port
should then be used instead of an AD board input. The Inject command of the
sampler activates the ready line of the box, as with the integrated Remote
Inject.
For device drivers using a serial Inject Response (no Inject Response port
can be set here - this applies to most sampler device drivers), the Inject
command of the sampler does not activate the ready line.
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Integrated Channels

When configuring the integrated channels (on the Signals tab), the  Server
Configuration of the Dionex Chromatography Management System
theoretically allows assigning different ports to these channels. However, this is
not possible: there is a fixed connection between the channels and the
corresponding ports of the Nelson box.

Using a different Detector Device Driver
If a different detector device driver should be used for one or both channels,
the integrated channel must be deactivated (Signals tab). The Nelson driver
supplies the channel as the port Channel_A or Channnel_B. For the detector
driver, this port can be used instead of an AD board port.

For further information on the Nelson Interfaces, see:

 NELSON Interfaces

 NELSON Interfaces: Pin Assignment

 NELSON Interfaces: Properties

 NELSON Interfaces: Data Acquisition Restrictions

 NELSON Interfaces: Differences from Conventional Nelson Box
     Installations

 NELSON Interfaces: Properties

VoltageRange
This value specifies the voltage range of the A/D converter (maximum signal).
Any voltage exceeding this value is cut (by the box). The lamp Over Range of
the box will light up.

This parameter directly affects the signal resolution.

Channels
Indicates on which channels the box records data. Usually, the channels are
set automatically; this setting should not be changed.
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SamplingStep
This is the actual interval the box uses for data recording. If possible, this
interval is set automatically to correspond to the STEP of the channels. This
setting will produce the best results.

With the setting SamplingStep < 0.1 s, the signal resolution will decrease.

For further information on the Nelson Interfaces, please also refer to:

 NELSON Interfaces

 NELSON Interfaces: Pin Assignment

 NELSON Interfaces: Device Driver Configuration

 NELSON Interfaces: Data Acquisition Restrictions

 NELSON Interfaces: Differences from Conventional Nelson Box
     Installations

 NELSON Interfaces:  Data Acquisition Restrictions

General
It is not possible to change the data acquisition parameters of the box during
data acquisition.

For optimum synchronization of the Inject Response and the data acquisition
start, the data acquisition should be started immediately after injection (the
digital Inject Response should be used).

Data Acquisition on two Channels
Although the type 941 offers two channels, data acquisition is possible only on
one channel. Simultaneous data acquisition on both channels is not possible.

With the types 950-970, simultaneous data acquisition is possible on both
channels.

It is not possible to independently control data acquisition on the two channels,
as the box has only one A/D converter that is alternately switched to the two
channels (Multiplexing).
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This is why both channels can only be switched on and off simultaneously.
Both channels are recorded with the same VoltageRange and SamplingStep.
As the maximum sampling rate of the A/D converter is only 100 Hz, the
SamplingStep must be set to multiples of 0.02s.

Releasing the Start/Stop Keys and Inputs

 Caution: By pressing the Start key while holding down the Stop key, it is
possible to release the Start/Stop keys on the instrument.
However, this will lead to errors the device driver is unable to
prevent.

For further information on the Nelson Interfaces, see:

 NELSON Interfaces

 NELSON Interfaces: Pin Assignment

 NELSON Interfaces: Device Driver Configuration

 NELSON Interfaces: Properties

 NELSON Interfaces: Differences from Conventional Nelson Box
     Installations

 NELSON Interfaces: Differences from Conventional
    NELSON Box Installations

Sequence Processing and Buffer Action
Conventional Nelson data systems (e.g. ACCESS*CHROM) allow recording
entire sequences with the box as long as there is sufficient buffer space. Then
the data is transferred to the data system.

The Dionex Chromatography Management System reads the data immediately,
so that virtually no buffer action is required. The buffer only temporarily stores
data during delays in data transfer (usually less than one second).

In the Dionex Chromatography Management System, it is necessary to first
define the sequences, i.e. the number and run time of the samples. Recording
data is only possible if the Dionex Chromatography Management System is
ready. The Dionex Chromatography Management System uses the ready relay
to indicate the ready status.
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Using the Stop Input
Operators working with conventional Nelson Box Installations are used to
define the end of data acquisition via the stop input of the box. The Dionex
Chromatography Management System does not support this. The end time
must be explicitly defined in the Program.

Why is the Box not "Ready"?
As mentioned above, the Dionex Chromatography Management System uses
the ready relay to indicate the ready status. The ready relay is switched on
during the Inject command. Otherwise, it is switched off.

How can you prevent loss of data when the Dionex Chromatography
Management System does not use the buffers as no data because the
program does not expect any data?
Use the Ready output of the box. Most samplers are fitted with a suitable input
(Ready, Remote Start, etc.).

For further information on the Nelson Interfaces, see:

 NELSON Interfaces

 NELSON Interfaces: Pin Assignment

 NELSON Interfaces: Device Driver Configuration

 NELSON Interfaces: Properties

 NELSON Interfaces: Data Acquisition Restrictions
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 PHARMACIA

PHARMACIA LKB2150 HPLC Pump
The LKB2150 Pump Device Driver of the Dionex Chromatography
Management System supports controlling up to three pumps. Each pump must
be connected to a separate serial port and is addressed using the following
(fixed) communications parameters.

Baudrate: 9600
Data bits: 8
Stop bits: 2
Parity: Odd
Handshake: None

The upper 6-pin socket Remote on the back of the instrument is connected as
follows with the 9-pin / 25-pin serial connector.

Back of instrument 25-pin Serial port 9-pin Serial port
Pin 1: GND -------------- 7 5
Pin 2: not used
Pin 3: Flow pulse out
Pin 4: Stop in/out
Pin 5: Remote in
Pin 6: Serial in --------------- 2 3
Internal: 1---5

By connecting the pins 1 - 5 on the pump connector, the pump is immediately
switched to Remote operation after it is switched on!
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PHARMACIA Fraction Collector LKB2211 SuperRac
These instructions describe the required steps to operate the LKB Superray
2211 Fraction Collector under the Dionex Chromatography Management
System.

The following requirements must be fulfilled:
• The Dionex Chromatography Management System computer must have 6

free relay channels, e.g. on the Dionex 16 Relays Card. In the  Server
Configuration, these relays are installed under Sharable Devices.

• The connecting cable must connect the relay contacts and 25-pin Sub-D-
connector ‘Ext. Input - Output’ on the rear of the instruments (see example
for details).

• Before the installation in the Dionex Chromatography Management
System, the user must correctly initialize the fraction collector.

Initialization
To initialize the fraction collector, the following steps must be performed after
switching the instrument on or after a Reset:
• Select type of the used sample rack (type A to E).

• Determine the fraction size. For operation under the Dionex
Chromatography Management System, time control must be selected.

• Determine the time interval. Normally, the time interval determines the
duration for which the fraction collector stays above a container. When
using with the Dionex Chromatography Management System, the data
system determines the switching time to the next container. The user must
therefore ensure that the entered time interval is larger than the total
analysis time.

• Enter the number of fractions. Define the minimum number of collector
containers belonging to one fraction loop. The user must ensure that a
sufficient number of containers is reserved for a sample.

For further details, see the Instruction Manual LKB 2211-010 SuperRac.

Assigning Control Functions
Control functions are assigned to specific relays via Server Configuration of
the Dionex Chromatography Management System using the Relays tab dialog
box of the LKB2211 driver. The following functions are available:
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Function: Description:
Start_Loop Starts a sample loop. If a fraction collector moves to the first collecting

container (Tube 1) in the sample loop. The status of the fraction collector
changes from Rdy to RUN.

Step Moves the fraction collector to the next container within the sample loop.
Return_Loop Moves the fraction collector to the start position of the sample loop. The

status of the fraction collector is Rdy.
Return Moves the fraction collector to the start position of the sample loop 0. The

status of the fraction collector is Rdy.
New_Loop Moves the fraction collector to the next sample loop. The status of the

fraction collector is Rdy.
Waste_Valve With this relay, the flow can be diverted from the collection containers to the

waste container.

Dionex Connecting Cable
The cable connects the Ext.Input-Output output of the LKB2211 with the
output of the Dionex 16 relays board. The cable has a 25-pin Sub-D-connector
and a 37-pin Sub-D-connector (see the pin assignment below).

To actuate a control function, the respective control input is connected with the
ground output (Pin #7) for duration of approx. 1s. The only exception to this is
the valve control input. Here, the solvent is directed to the waste container as
long as the valve control input is connected with the ground, i.e. the valve has
the status On. To avoid interferences, all TTL control inputs of the instrument
must be connected with the +5V output using 3KOhm Pull Up resistors.

The connection illustrated here for pin 9 must also be installed for the pins 10,
11, 12, 13, and 24 of the LKB connector.

 Note: It is recommended to control the fraction collector LKB2211 only
via a completely assembled and tested connecting cable. The
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entire connection for the 16-relay board is available from Dionex
as a kit.

Example: Pin Assignment when using a Dionex 16 Relays Board
The relays 1 to 6 of the Dionex 16 relays board are used with the function
assignment described below. The following pins of the relay board connector
(37pin Sub-D-connector) must be connected with the pins of the LKB connector
(25pin Sub-D-connector). For a description of the LKB connector, refer to the
Instruction Manual LKB 2211-010 SuperRac.

Relay # Function Pin # Relay Board Connector Pin # LKB-Connector
1 Return 2 9
2 Step 4 10
3 Return_Loop 6 11
4 Start_Loop 8 12
5 New_Loop 10 13
6 Waste_Valve 12 24

3 7
5 7
7 7
9 7

11 7
13 7

In addition, the Online Help offers support regarding the special  Server
Configuration page on LKB SuperRacs: Relays.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 RAININ / VARIAN Pumps: SD-1, SD-200/SD-300, and
    ProStar 215 - Overview
Device Type: Pumps

Device Driver: Rainin/Varian SD-1-Pump or. Rainin/Varian SD-
200/SD-300-Pump (use the latter one for the ProStar
215 pump)

Supported
Hardware
Options:

Up to three Gilson 302/303 pumps

What is required?

License: Device Control

Select About CHROMELEON (link available in the
Online Help only) in the Help menu of the Dionex
Chromatography Management System client to check
whether this option is available.

Connection: GSIOC RS232 adapter cable 605 (for details, see
 Gilson: GSIOC Cable in the appendix of these

Installation Instructions)

The cable is not available from Dionex!

Hardware
Prerequisites:

Multi-serial, 8-fold PCI interface board (Equinox 8-
RS232 Multi-Com board, Dionex part no. 5906.2095)

Free RS232 port

Control Panel: GIL306Gradient.pan

Further Information
For an overview on how to install the Rainin/Varian pumps, see

 Rainin/Varian Pumps: SD-1, SD-200/SD-300, and ProStar 215 -
Installation.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 RAININ / VARIAN Pumps: SD-1, SD-200/SD-300, and
    ProStar 215 - Installation

Hardware Installation

Device
Connection:

The device driver supports up to 3 pumps of the type
SD-1, SD-200/300, or ProStar 215. The Rainin pumps
use the same kind of SIOC bus as the  Gilson:
Pumps 302/303 - Overview. Therefore, a
RS232/SIOC adapter is required (e.g. the Gilson
GSIOC RS232 adapter cable 605 - for details, see

 Gilson: GSIOC Cable in the appendix of these
Installation Instructions) to connect the PC to the first
pump.

 Caution:

As the adapter is shipped with a default baud rate of
19200 Baud, the baud rate must be set to 9600 baud
to operate the SD-200/SD-300 or ProStar (see
settings on the General page) pumps under the
Dionex Chromatography Management System. Open
the connector housing and resolder the cable from
land A to land B (for details see 605 RS232 Adapter
and GSIOC Protocol - USER's GUIDE).

Contrary to the other Rainin/Varian pumps the SD-1
driver communicates at a baud rate of 19200 Baud.
Therefore, do not modify 605 cable when using the
SD-1 pump!

 Caution:

Controlling the pumps via the RS232 interfaces of the
PC (COM ports) or the UCI-100 Universal
Chromatography Interface is not supported. The
power supply of the GSIOC adapter (type 605) is
directly via the RS232 interface. The RS232 ports of
the UCI-100 Universal Chromatography Interface,
however, are not designed for this. Connect the
adapter to the multi-serial 8-fold PCI interface board
(Equinox 8-RS232 Multi-COM card, Dionex part no.
5906.2095) instead.
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Device
Connection:
(Cont'd)

If several pumps are used in a high-pressure gradient
system, the second pump can be connected to the
first one with a GSIOC cable and the third pump can
be connected to the second.

Device Settings: Each pump has its own SIOC address (0 to 63). The
address is set via a DIP-switch. This switch is located
inside the pump on the back of the front panel.

Restrictions: Not known.

Software Installation
Install the Rainin/Varian SD-1-Pump (Rainin/Varian SD-200/SD-300-Pump,
respectively) Device Driver in the  Server Configuration of your Dionex
Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.
2. Start the Server Configuration of the Dionex Chromatography

Management System.
3. Add the Rainin/Varian SD-1-Pump or the Rainin/Varian SD-200/SD-300-

Pump under the desired timebase (via the Add Device command of the
context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):
On the General tab, select a free COM port and enter the GSIOC address.
The GSIOC and Head Types tab allows defining the SIOC addresses for
the pump as well as the pump head types that are used.
You do not need to change the presetting on the Error Levels tab.

5. To control the installed Gilson pump connect the GIL306Gradient control
panel or any especially developed control panel in the client of your Dionex
Chromatography Management System to the corresponding time

Further Information

For an overview on the Rainin/Varian pumps, see  Rainin/Varian Pumps:
SD-1, SD-200/SD-300, and ProStar 215 - Overview.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 SOMA

Soma 3710

For controlling the UV Detector Soma 3710, please note the following pin
assignment for the RS232 cable:

Soma 3710 PC
25-pin Sub-D (female) 9-pin Sub-D (male)

2 (RXD) ------------ 2
3 (TXD) ------------ 3
7 (GND) ------------ 5

( Null Modem Cable without handshake plus GenderChanger)

The communication parameters must be as follows: 9600 baud, 8 data bits, no
parity, 1 stop bit, and no handshake.

Before connecting, set the device manually into the Remote state. Press the
key Remote until the green lamp Remote lights up at the detector. The
detector will remember this state when being switched off.

For devices with firmware version up to 1.78 use the driver Soma_UV-
VIS_Detector_S-3710_178 Device Driver. For devices with firmware version
1.79 and higher, the Soma_UV-VIS_Detector_S-3710_New driver will be
available.

In addition, the Online Help offers support regarding the special  Server
Configuration page on the Soma UVD: UV.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.
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 THERMOQUEST
The following ThermoQuest instruments can be controlled:

 THERMOQUEST: Trace GC

 THERMOQUEST: AS2000 GC Autosampler

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 THERMOQUEST: Trace GC - Overview
Device Type Gas chromatograph

Device Driver: Thermoquest Trace Gas Chromatograph
Supported
Hardware
Options:

• Up to 2 Inlets
Options:
- Purged Packed Column Injector (PPKD)
- Split/Splitless Injector (SSL)

• Column Oven
- High-temperature column oven
- Nitrogen cooling
- Carbon dioxide cooling

• Up to 2 Detectors (optionally with oven):
- Flame Ionization Detector (FID)
- Thermal Conductivity Detector (TCD)

• Electronic pressure/flow control
- Column and inlet: DPFC (Digital Pressure Flow
Control)
- Detector: DGFC (Digital Gas Flow Control)
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What is required?

License: Extended Device Control

Connection:  ThermoQuest Trace GC: Cable 8914.0148 /
    8914.0149

 ThermoQuest AS2000 / Trace GC: Cable (for
details, see the appendix of these Installation
Instructions)
A/D cable for data transmission (depending on the
A/D converter used).

Hardware
Prerequisites:

Data acquisition requires an A/D converter, e.g. a
UCI-100 Interface, a Dionex UI20 (Dionex part no.

46017) or any other A/D converter which is supported
by the Dionex Chromatography Management System,
e.g. PE Nelson Boxes including the corresponding
signal cables.

Serial Interface Board
Multi-serial 8-fold PCI interface board (Equinox 8-
RS232 Multi-COM board, Dionex part no. 5906.2095)

Software
Prerequisites:

• FisCfg.cdc configuration module

• Message.dll

Control Panel: TraceGC_AS.pan

Further Information
For information on how to install the ThermoQuest Trace GC, see

 THERMOQUEST: Trace GC - Installation.

For an overview on the different ThermoQuest instruments for which Dionex
device drivers are available, see  THERMOQUEST.
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 THERMOQUEST: Trace GC - Installation

Hardware Installation

Device
Connection:

 THERMOQUEST Trace GC: Cable 8914.0148 /
8914.0149 / 8914.0149 (for details, see the appendix
of these Installation Instructions)

A special cable (  THERMOQUEST AS2000 / Trace
GC: Cable - for details, see the appendix of these
Installation Instructions) is used to connect the
ThermoQuest Trace GC with the ThermoQuest
AS2000 autosampler.

In addition, an A/D cable is required for data
acquisition (depending on the A/D converter used -
e.g. UCI-100 Interface).

Device Settings: (Also, see the Installation Instructions supplied with
the instrument.)

The communication settings must be as follows:
Baud rate 38400

Handshake Rts/Cts

Parity None

Data bits 8

Stop bits 1

PrepRun Timeout
Since the GC can only be started when it is in Ready
To Inject mode it is recommended to set the
PrepRun Timeout long enough to ensure that the
injection takes place within this time. The PrepRun
Timeout can be set at the GC keyboard [Config]
[Oven] [PR Timeout].

Setting Property Values to 'Infinite'
The properties StopPurgeTime, PurgeTime,
SecCoolingTime, SVEDuration, and
StopAuxPurgeTime can be set to infinite. This is
done manually via the GC keypad. Proceed as
follows:
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Device Settings:
(Cont'd)

• Disconnect the Dionex Chromatography
Management System from the GC.

• Make the desired settings.

• Reconnect the Dionex Chromatography
Management System to the GC.

Restrictions: Not known.

Software Installation
Install the THERMOQUEST Trace Gas Chromatograph Device Driver in the

 Server Configuration of the Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the ThermoQuest Trace Gas Chromatograph under the desired
timebase (via the Add Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the General tab, select a free COM port.

On the Options tab, specify the limits for the controllable temperature range
of the column oven. In addition, select the cooling system used. If installed,
also select the electronic flow/pressure control for the column/inlet and/or
the high-temperature oven option.

The Right/Left Inlet tab allows you to set up the type and the temperature
control for the Inlet.
On the Right/Left Detector tab, specify the installed detector(s) and its/their
temperature and gas controls.

Open the Signal Configuration dialog box from the Signals tab by double-
clicking the respective channel. Assign a channel to the signal and name
the signal in the Signal Name field according to the selected detector type.

You do not need to change the presetting on the Error Levels tab.
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5. To control the ThermoQuest Trace GC use the TraceGC_AS control panel
in the client of your Dionex Chromatography Management System, modify
the control panel according to your needs, and connect it to the
corresponding timebase.

Application

Notes on the Device Driver:

General
The ThermoQuest Trace GC uses a packet oriented, binary data format to
communicate with the PC via the RS-232 interface. When the GC receives a
command, it switches into the remote mode and locks the keypad. If no further
communication takes place, the GC switches back into the local mode after 30
seconds

The GC will not start the communication by itself; it will only respond to
commands and requests sent by the Dionex Chromatography Management
System.

Experienced users should be able to control the instrument without any
problems. In the Dionex Chromatography Management System, short
descriptions of the GC commands are available in the corresponding
Command dialog box or the Properties/Link box.

In the Dionex Chromatography Management System, pressure is always stated
in bar. Selecting a different pressure unit is not supported. For further
information, please contact the Dionex Service.

Sampler
Using the AS2000 autosampler with the GC: If a sample vial is missing at the
position specified in the sequence, the sampler treats this as a Blank Run
Sample (refer to the AS2000 manual page 118). However, the sequence will
not be stopped.

If the GC is waiting for an inject response from the autosampler and suddenly
becomes Not Ready due to gas supply or flow problems, an error message is
issued and the sequence is stopped.
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Entering a Temperature Gradient
Entering a temperature gradient is via a Program.

For the ThermoQuest Trace GC, a temperature profile can be entered with a
maximum of six ascents or descents. The maximum temperature change
(ascent) is up to 120°C per minute, depending on the oven type.

Gradients are entered in the Program Wizard in the typical format for GC
applications (the starting and end temperatures are entered as well as the
modification rate). In the program, however, the so-called "base point
philosophy" is used (similar to entering a flow or percent gradient in HPLC).
Each temperature command serves as base point of the gradient program.
The Wizard automatically converts the entered rates into the base point
representation.

An Inject command is indispensable. No gradient is executed before the Inject
command. Thus, temperature gradients can only begin after the Inject
command

Temperature Setting
Reaching the nominal temperature on the instrument can take some time.
Please note that the oven heats faster than the injector and the detector
system. As soon as the nominal temperature is reached, the GC sends a
Ready signal. Only after this, injection is possible via the autosampler.

Example:
The following program waits until the nominal temperature 150°C is reached,
before the Inject command is executed:

 0.000 GC.Temperature = 150

 Wait GC.Ready

 Inject

 ...... ..............

 Caution: After receiving the nominal temperature value from the Dionex
Chromatography Management System, the instrument
implements the desired value as fast as possible. When the
value is "almost" reached, the Equilibration Time passes until
the instrument sends the confirmation message to the Dionex
Chromatography Management System. The duration of this time
interval can be set via the Equilibration Time parameter in the
Dionex Chromatography Management System.
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Troubleshooting
Should you have special questions, contact the Dionex Service.

Further Information

For an overview on the ThermoQuest Trace GC, see  THERMOQUEST:
Trace Gas GC - Overview.

For an overview on the different ThermoQuest instruments for which Dionex
device drivers are available, see  THERMOQUEST.

 THERMOQUEST: AS2000 GC Autosampler - Overview
Device Type: GC autosampler

Device Driver: Thermoquest_AS2000
Supported
Hardware
Options:

What is required?

License: Device Control

Connection: RS232 cable (see  Fisons AS: Cable 8914.0127 /
8914.0143)

Hardware
Prerequisites:

Data Acquisition requires an A/D converter, e.g. an
UCI-100 Interface with the corresponding signal

cables.

Free RS232 port

Software
Prerequisites:

• FisCfg.cdc configuration module

• Message.dll

Control Panel: FISAS800

Further Information
For information on how to install the ThermoQuest AS2000 GC autosampler,
see  THERMOQUEST: AS2000 GC Autosampler - Installation.
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For an overview on the different ThermoQuest instruments for which Dionex
device drivers are available, see  THERMOQUEST.

 ThermoQuest: AS2000 GC Autosampler - Installation

Hardware Installation

Device
Connection:

The ThermoQuest AS2000 GC autosamplers is
connected to the ThermoQuest Trace GC via a
special signal cable (for details, see

 THERMOQUEST AS2000 / Trace GC: Cable in
the appendix of these Installation Instructions). When
the injection is completed, the GC sampler sends the
signal to the GC, which in turn sends it to the Dionex
Chromatography Management System.

In the Server Configuration, specify the remote input
(GC_INJECTOR) that is used by the ThermoQuest
AS2000 sampler under Inject Port on the Sampler
tab!

Device Settings:

Device Settings:
(Cont'd)

The following communications parameters must be
used: 9600 Baud, 8 Data Bits, No Parity, 1 Stop Bit,
Rts/Cts handshake.

Some THERMOQUEST AS2000 GC autosamplers
are set by the manufacturer to a baud rate that is not
suitable for the Device Drivers of the Dionex
Chromatography Management System.

When switching on the sampler, press the Meth and
Seq keys simultaneously to check the baud rate
setting. The following information will be displayed:

AS2000 SET UP: b9600

ACT INJ SMP SYR MAN

The value given to the top right is the baud rate
setting. This information may not be available in
previous firmware versions. If so, press EXIT to leave
the setup menu.

If the baud rate is not set to 9600, move the cursor to
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the baud rate field using the key < (arrow to the left).
Set the new baud rate with the up and down arrow
keys and leave the setup menu by pressing EXIT.

Restrictions: Not known.

Software Installation

Install the Thermoquest_AS2000 Device Driver in the  Server
Configuration of your Dionex Chromatography Management System.

1. Start the server of the Dionex Chromatography Management System.

2. Start the Server Configuration of the Dionex Chromatography
Management System.

3. Add the Thermoquest_AS2000 under the desired timebase (via the Add
Device command of the context menu).

4. The following settings are required on the different tabs (the links are
available in the Online Help only):

On the Thermoquest_AS2000 tab, have the Demo Mode switched off.

On the Sampler tab, select a free inject port.

You do not need to change the presetting on the Error Levels tab.

5. To control the ThermoQuest AS2000 GC autosampler connect the
FISAS800 control panel in the client of your Dionex Chromatography
Management System to the corresponding timebase.

Application
The Online Help offers information on the Commands and Parameters of the
Fisons AS800/ThermoQuest AS200.

After the Connect command, the parameter values are initially unknown to the
Dionex Chromatography Management System (blank fields in the FISAS800
control panel). You should enter meaningful values before injection.
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Use one of the Method A/B/C/D buttons on the control panel or specify them in
the sample program (also, see: How to ...: Actions in the PGM Editor

 Creating a Program). A reasonable starting point might be this:

; Assuming a standard 10 µl syringe.

; Injection Volume should be 1.0 µL.

PreInjCleanVol = 10.0

PreInjCleanCycA = 3

CleanCycles = 1

PostInjCleanCycC = 0

; PostInjCleanVol = 10.0

PullUpCount = 6

PullUpDelayTime = 2.0

AirVolume = 3.0

FillingVolume = 5.0

AspirationSpeed = 100

InjectionSpeed = 100

PreInjDelayTime = 1

PostInjDelayTime = 2

Troubleshooting

 Note: If an error occurs during operation (e.g. excessive sample
volume), the error is displayed on the instrument only. To
continue the analysis, you must confirm the error message
directly at the sampler (by pressing the Enter key). This is
possible after unlocking the sampler keyboard in the Dionex
Chromatography Management System. Use either the
Disconnect command or the KeyboardUnlocked command.
Better yet: Disconnect the sampler, turn it off and on again, wait
until it is ready, and reconnect.

Error Description Remedial Action
Missing vial The sampler display shows:

End Sample

Total Injections 0

In addition, the Dionex
Chromatography
Management System waits
forever for an inject response.

The current sample is treated
Blank Run Sample.
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Error Description Remedial Action
Bad vial After some retries, the

sampler display shows
something like this:
PLG NDL INJ TUR CNTR

--- BSY --- ---   *

This happens quite easily if
the vials are not perfectly
crimped.

Disconnect the sampler, press
EXIT (on the sampler's
keyboard). When prompted
whether to pause, continue, or
abort the sample, choose Abort.
Abort the batch and reconnect.

Illegal parameter (e.g.
Volume/
Position > Max or Air +
Sample Volume > Max)

The sampler displays an error
message.

Disconnect the sampler. Press
sampler key, as necessary.

Continuous beep and
display cleared

Severe damage may occur
(destroyed syringe, vials etc.)!

Turn off the sampler
immediately!

Strange behavior of any
other kind

Disconnect the sampler, turn it off
and on again, wait until it is
ready, and reconnect.

Further Information
For an overview on the ThermoQuest AS2000 GC autosampler, see

 THERMOQUEST: AS2000 GC Autosampler - Overview.

For an overview on the different ThermoQuest instruments for which Dionex
device drivers are available, see  THERMOQUEST.
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 TSP
The following TSP instruments can be controlled:

• Autosamplers  AS3500 / AS3000 - Overview

• Pumps  P2000 and P4000

• UV-Detectors:

 UV1000

 UV2000/Linear 205

 UV3000/Linear 206

 Tip: Data acquisition with the TSP UV detectors requires a UCI100
Interface (or an A/D Converter or a Nelson-Interface,
respectively) including the respective signal cables.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 TSP: AS3500 / AS3000 Autosamplers - Overview

Device Type: Autosampler with x positions

Device Driver: TSP AS3000/AS3500 Autosamplers
Supported
Hardware
Options:

Cooler (rack cooling)

Oven (rack heating)

Prep Kit (sample preparation option)
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What is required?

License: Device Control

Connection: RS232 cable (Dionex part no.: 45789 (cable AI450 to
AS3500); for details, see  TSP/Linear: Cable
45789 (Cable AI450 to AS3500) in the appendix of
these Installation Instructions.

Hardware
Prerequisites:

Free RS232 port

Further Information
For information on how to install the TSP AS3500/AS3000 Autosamplers, see

 TSP AS3500 / AS3000 Autosampler- Installation.
For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.

 TSP: AS3500 / AS3000 Autosamplers - Installation

Hardware Installation

Device Settings: a) For menu option Input Polarity
Pump Ready Active = HI
Inj Hold Active = LO

b) For menu option Output Polarity
Set all to LO.

 Note: If Inj. Hold Active is set to HI, data
acquisition cannot be started.

Restrictions: Not known.
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Software Installation
Install the TSP AS3000/AS3500 Autosamplers Device Driver in the

 Server Configuration (the following links are available in the Online Help
only):

Select the RS232 port on the General tab.

On the Installed Options tab, turn on and off the control of the option(s) installed
for the AS3500 autosampler.

You do not need to change the presetting on the Error Levels tab.

Application
Nothing particular known

Troubleshooting
Why can't you start the data acquisition?
Is Inj Hold Active set to LO? If not, data acquisition cannot start.

Further Information

For an overview on the TSP AS3500/AS3000 Autosamplers, see  TSP
AS3500 / AS3000 Autosamplers - Overview.

For an overview on the different TSP instruments for which Dionex device
drivers are available, see  TSP.
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 TSP: P2000 and P4000 Pumps - Overview

Device Types: P2000: binary low-pressure gradient pump
P4000: quaternary low-pressure gradient pump

Device Drivers: P2000: TSP P2000 Pump
P4000: TSP P4000 Pump

Supported
Hardware
Options:

Pump head
• Type10 (max. 10.00 ml/min)

• Type30 (max. 30.00 ml/min)

• Type90 (max. 90.00 ml/min)

What is required?

License: Extended Device Control

Connection: RS232 cable (Dionex part no.: 45789 (cable AI450 to
AS3500); for details, see  TSP/Linear: Cable
45789 (Cable AI450 to AS3500) in the appendix of
these Installation Instructions.

Hardware
Prerequisites:

Free RS232 port.

Further Information

For information on how to the TSP P2000 and P4000 pumps, see  TSP:
P2000 and P4000 Pumps - Installation.
For an overview on the different TSP instruments for which Dionex device
drivers are available, see  TSP.
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 TSP: P2000 and P4000 Pumps - Installation

Hardware Installation

Device Settings None.

Restrictions: Not known.

Software Installation
Install the TSP P2000 Pump or TSP P4000 Pump Device Driver in the

 Server Configuration (the following links are available in the Online Help
only):

Select the RS232 port on the General tab.

On the Head Types & Limits sheet, select your pump head:
• Type10 (max. 10.00 ml/min)
• Type30 (max. 30.00 ml/min)
• Type90 (max. 90.00 ml/min)
Specify the flow and pressure limits (max. 414 bar).

On the Solvents sheet, specify the number and names of the eluents that are
delivered by the pump.

You do not need to change the presetting on the Error Levels tab.

Application
The P2000 pump allows programming linear gradients with up to 9 steps. With
P4000 pumps, up to 39 steps can be programmed. The driver does not support
non-linear gradients.

Commands and Properties
The pump driver supports the following commands and properties:

Properties Min Max Default Purpose
HeadType N/a N/a N/a Indicates the installed pump

head
PumpStatus N/a N/a N/a Indicates the pump status
Ready NotReady Ready N/a Indicates whether the pump is

ready
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 Note: The Hold command cannot be performed during program
execution. If the command is given nevertheless, a warning is
displayed.

Troubleshooting
Nothing particular known.

Further Information

For an overview on the TSP P2000 and P4000 pumps, see  TSP P2000 and
P4000 Pumps - Overview.

For an overview on the different TSP instruments for which Dionex device
drivers are available, see  TSP.

 TSP: UV1000 Detector - Overview

Device Type: Single channel UV detector

Device Driver: TSP UV1000 Detector
Supported
Hardware
Options:

No special options.

What is required?

License: Extended Device Control

Connection: RS232 cable (Dionex part no.: 45789 (cable AI450 to
AS3500); for details, see  TSP/Linear: Cable
45789 (Cable AI450 to AS3500) in the appendix of
these Installation Instructions.

Hardware
Prerequisites:

For data acquisition: A/D converter, e.g. an UCI-
100-Interface with the corresponding signal cables.

Fee RS232 port

Software
Prerequisites:

• TspCfg.cdc configuration module
• Message.dll
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Further Information

For information on how to install the TSP UV1000 Detector, see  TSP:
UV1000 Detector - Installation.

For an overview on the different TSP instruments for which Dionex device
drivers are available, see  TSP.

 TSP: UV1000 Detector - Installation

Hardware Installation

Device Settings: None.

Restrictions: Not known.

Software Installation

Install the TSP UV1000 Detector Device Driver in the  Server
Configuration (the following links are available in the Online Help only):

On the General tab, select the RS232 port.

On the Installed Lamps sheet, select the installed lamps.

On the Signals sheet, specify the channel for analog signal acquisition.

You do not need to change the presetting on the Error Levels tab.

Application

Commands and Properties
The detector driver supports the following commands and properties:

Property Min Max Default Purpose
ZeroOnLambda
Change

Off On Off Select whether the detector performs
an autozero every time the wavelength
is changed.

AvailableLamps None UV & VIS
lamp

UV-lamp
only

Indicates which lamps are available
(read only).

Range 0.0005
AUFS

3.0000
AUFS

1.0000
AUFS

Amplifying factor for the output signal.
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Property Min Max Default Purpose
Wavelength 190 nm 800 nm 254 nm Wavelength at which the detector

measures the signal:
UV lamp: 190 - 380 nm
VIS lamp: 366 - 800 nm
Both lamps: 190 - 800 nm

Response 0.0 5.0 1.0 Time constant. Denotes the time
needed by the detector to reach 98%
full scale.

Command Purpose
UV_LampOn Switches the deuterium lamp on
UV_LampOff Switches the deuterium lamp off
Visible_LampOn Switches the tungsten lamp on
Visible_LampOff Switches the tungsten lamp off

 Note: After a Reset command it takes 90 s until the detector is ready
to execute further commands.

Troubleshooting
Why is a command not executed?
Have 90 s passed since the last reset? Otherwise, the command cannot be
executed because the detector is not yet ready.

Why can't you start the data acquisition?
Is an AS3500 or an AS3000 sampler installed for which Inj Hold Active has
been set to HI? Set this option to LO as otherwise the data acquisition cannot
start.

Further Information

For an overview on the TSP UV10000 detector, see  TSP: UV1000 Detector
- Overview.

For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.
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 TSP: UV2000 / Linear UV205 Detector - Overview

Device Type: Two-channel UV

Device Driver: TSP UV2000/UVIS205 Detector
Supported
Hardware
Options:

No special options.

What is required?

License: Extended Device Control

Connection: RS232 cable (Dionex part no.: 45789 (cable AI450 to
AS3500); for details, see  TSP/Linear: Cable
45789 (Cable AI450 to AS3500) in the appendix of
these Installation Instructions.

Hardware
Prerequisites:

For data acquisition: A/D converter, e.g. an UCI-100
Interface with the corresponding signal cables.

Free RS232 port.

Software
Prerequisites:

Nothing particular known.

Further Information
For information on how to install the TSP UV2000 detector (the Linear UV205
Detector, respectively), see  TSP: UV2000 / Linear UV205 Detector -
Installation.

For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.



848 Installing and Controlling Third-Party Instruments

 TSP: UV2000 / Linear UV205 Detector - Installation

Hardware Installation

Device Settings: None.

Restrictions: Not known

Software Installation

Install the TSP UV2000/UVIS205 Detector Device Driver in the  Server
Configuration (the following links are available in the Online Help only):

On the General tab, select the RS232 port.

On the Signals sheet, specify the channels for analog signal acquisition.

You do not need to change the presetting on the Error Levels tab.

Application

Commands and Properties
The detector driver supports the following commands and properties:
Property Min Max Default Purpose
DetectionMode - - - Sets the wavelength mode:

Single Mode: 190 - 800 nm
(only one detector channel is used)
Dual1 Mode: 190 ... 450 nm
Dual2 Mode: 366 ... 800 nm

Response 0.0 5.0 1.0 Time constant. Indicates the time needed
by the detector to reach 98% full scale.

Property Purpose
UV_LampOn Switches the deuterium lamp on
UV_LampOff Switches the deuterium lamp off
Visible_LampOn Switches the tungsten lamp on
Visible_LampOff Switches the tungsten lamp off
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Channel-specific Commands and Properties
a) Common to both channels
Property Min Max Default Purpose
Range 0.0005 AUFS 3.0000 AUFS 1.0000 AUFS Amplifier gain for the output

signal
Wavelength 190 nm 800 nm 254 nm Wavelength at which the

detector measures the signal.
Legal range: see
DetectionMode.

Troubleshooting
Why can't you start the data acquisition?
Is an AS3500 or an AS300 sampler installed for which Inj Hold Active has
been set to HI? Set this option to LO as otherwise the data acquisition cannot
start.

Further Information

For an overview on the TSP UV2000/Linear UV205 detector, see  TSP:
UV2000 / Linear UV205 Detector - Overview.

For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.

 TSP: UV3000 / Linear UV206 Detector - Overview

Device Type: Four-channel UV detector

Device Driver: TSP UV3000/UVIS206 Detector
Supported
Hardware
Options:

No special options.

What is required?
License: Extended Device Control

Connection:  Null Modem Cable (RS232): Dionex part no.
8914.0103A -RS cable (9-pin female to 25-pin female)

Adapter: Dionex part no. 8914.0118 - Adapter (25pol.
Sub-D, male-male)
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Hardware
Prerequisites:

For data acquisition: A/D converter, e.g. an UCI-100
Interface with the corresponding signal cables.

Free RS232 port.

Software
Prerequisites

Nothing particular known.

Further Information
For information on how to install the TSP UV3000 detector (the Linear 206
detector, respectively), see  TSP: UV3000 / Linear UV206 Detector -
Installation.

For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.

 TSP: UV3000 / Linear UV206 Detector - Installation

Hardware Installation

Device
Connection:

Connection to the PC is via the RS232 connection.
The detector is connected to the RS232 connector via
a special  Null Modem Cable (RS232 - for details,
see the appendix of these Installation Instructions).

Device Settings: None.

Restrictions: Not known.

Software Installation

Install the TSP UV3000/UVIS206 Detector Device Driver in the  Server
Configuration (the following links are available in the Online Help only):

On the General tab, select the RS232 port.

On the Signals sheet, specify the channels for analog signal acquisition.

You do not need to change the presetting on the Error Levels tab.
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Application

Commands and Properties
The detector driver supports the following commands and properties:

Property Min Max Default Purpose
Visible_Lamp Off On N/a Switches the tungsten lamp on and off

(λ = 366 - 800 nm)
UV_Lamp Off On N/a Switches the deuterium lamp on and off

(λ = 190 - 365 nm)
Visible_Lamp_
Intensity

Intensity_
low

Intensity_
OK

N/a Indicates whether the tungsten lamp
intensity is too low (read only)

UV_Lamp_
Intensity

Intensity_
low

Intensity_
OK

N/a Indicates whether the deuterium lamp
intensity is too low (read only)

Connected Discon-
nected

Connec-
ted

N/a Indicates whether the detector is
connected.

Channel-specific Commands and Properties

Property Min Max Default Purpose
Range 0.0005 AUFS 5.0000 AUFS 1.0000 AUFS Amplifying factor for the

output signal.
Response 0.0 9.9 1.0 Time constant. Indicates the

time needed by the detector
to reach 98% full scale..

Wavelength 190 nm 800 nm 254 nm Wavelength at which the
detector measures the signal.
Legal range: See
DetectionMode

 Note: Due to the extensive communication during the execution of the
Connect command it may take up to 1 min until the instrument is
finally connected. The corresponding message is logged in the
audit trail.

Troubleshooting
Why can't you start the data acquisition?
Is an AS3500 or an AS300 sampler installed for which Inj Hold Active has
been set to HI? Set this option to LO as otherwise the data acquisition cannot
start.



852 Installing and Controlling Third-Party Instruments

Why doesn't the UV detector respond?
Due to the extensive communication during connecting the device (following
the Connect command), it may take up to 1 min until the device finally
responds. The respective message is logged in the Audit Trail.

Further Information

For an overview on the TSP UV3000/Linear UV206 detector, see  TSP:
UV3000 / Linear UV206 - Overview.

For an overview on the TSP instruments for which Dionex device drivers are
available, see  TSP.

 VARIAN (GC)
Controlling the Varian 3400 Gas Chromatograph requires the Varian 3400 Gas
Chromatograph Device Driver and the VarCfg.cdc device configuration file.

Dionex Chromatography Management System  -  Option
Operating the Dionex Chromatography Management System requires the
Extended Device Control Feature (  Options of the Dionex
Chromatography Management System).

Components
The following components can be controlled:

• Column oven

• Gas flow controller

• Gas pressure controller

• Two detectors

• Auxiliary heater

• Varian 8100/8200 autosamplers

• Split / splitless Varian 1077 Injector
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The following detectors are supported:

• Flame Ionization Detector (FID)

• Thermal Conductivity Detector (TCD)

• Thermion Specific Detector (TSD)

Connection
The serial computer port is connected to the Varian GC interface cable (Varian
part no. 03-919939-00 Rev 3) via a special 9-pin serial cable (Dionex part no.
8914.0145; for details, see  Varian: Cable 8914.0145 in the appendix of
these Installation Instructions).

The following communication parameters are used: 9600 baud, 7 data bits, 1
stop bit, even parity, and no protocol.

Setting Properties:
Properties can only be set if the GC is not in Sample, Run, or RunEnd mode.
If a property is set nevertheless, its execution will be postponed until the GC is
no longer in one of the modes described above. A message will be issued in
the audit trail.

 Tip: A blank run in a sample sequence can lead to several Can’t set
property error messages at the beginning of the next sample.
These messages can be ignored.

After an Inject command, column oven temperature gradients, Acquisition
On/Off, Delta, Average and Step are the only commands and properties that
can be set. Therefore, define all properties that are required for the method
before the Inject command. A Reset command can always be sent.

In case of a program with an isocratic column oven temperature, define the
desired temperature before and after the Inject command and again at the final
program time. Otherwise, the runtime calculation will not be correct.

Example:

0.000 GC.Temperature = 100
Wait GC.Ready
Inject
GC.Temperature = 100

30.000 GC.Temperature = 100
End
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Entering a Temperature Gradient:
Temperature gradients can be defined for the column oven heater, only.

Entering a temperature gradient is either directly (Flow command from the
Control menu) or via a Program.

Under the Dionex Chromatography Management System, a temperature profile
is possible with a maximum of four ascents. The maximum temperature change
is 50°C per minute. No descending temperature profiles are possible. The GC
will return to the initial temperature when the gradient is completed.

For an overview on manufacturers whose instruments can be controlled via the
Dionex Chromatography Management System, see  Installing and
Controlling Third-Party Instruments.

 GENERIC DEVICE DRIVER ‘GENERIC SERIAL DEVICE’
The generic Device Driver enables the user to control instruments that are
not supported by a separate device driver of the Dionex Chromatography
Management System. The generic driver serves to create the required
command strings for controlling an instrument. These strings are then
integrated as commands in the user interface of the Dionex Chromatography
Management System. This procedure only supports limited bi-directional
control. The device driver is able to respond to the strings sent by the
instrument, but requesting and evaluating instrument status messages is not
possible.

Serial control is usually via command strings. In addition to the abbreviations
identifying functions, it is possible to include current parameter values and
control characters. Control characters are entered in pointed brackets <>, as
there are no printable characters to represent them. Control characters define
text formatting in lengthy command strings. For controlling serial instruments,
they are used to introduce and complete command sequences.

A typical example for a command string controlling the UV wavelength in a
detector is WAVELENGTH=254<CR><LF>. In this example, the abbreviation
for the required function is WAVELENGTH, the current wavelength value is
254 nm, and the control characters completing the command sequence are
<CR><LF>. <CR> represents the control character Carriage Return and <LF>
represents Line Feed. In ASCII code, these characters correspond to the
decimal values <CR>=0D and <LF>=0A.
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Short Description of the Installation Steps
To send the command string mentioned above with the generic driver to the
detector, the following steps are required in Server Configuration of the
Dionex Chromatography Management System to create the definition file for
this detector:

• Choose Definition files... from the Edit menu to open a dialog box listing
all generic device drivers. Press New... to define a new generic device
driver. The program then generates the basic structure of a generic device
driver with the name New Generic Device.

• Specify the device name on the Driver/Definition dialog box. The name
specified here serves to identify the new device driver. No other device
driver should have the same name. This new name will be used as the
default name during installation.

• Specify a file name on the Driver/Definition dialog box. After saving the
configuration on the server, a file with this name is generated with the
default extension GEN (do not enter this extension!). If a file with the same
name already exists, the file extension of the older file is automatically
changed to BAK, and the new file is saved. The GEN files store the entire
instrument-specific user input.

• Create a new device.

• Set the parameters for the serial communication format on the
Device/Definition sheet.

• Create all commands and properties.

• Save the definition.

The installation of the newly created device driver is identical to conventional
device drivers of the Dionex Chromatography Management System. The user
can install the new driver by double-clicking its name. After setting the required
values for the instrument on the configuration dialog boxes, the instrument can
be controlled according to the user definitions.

Structure of a Generic Device Driver
The task of the device driver is to control one or several devices via one or
several serial interfaces. The term "device" does not necessarily refer to a
physical instrument (e.g.: a detector), but the logical summary of properties and
functions (e.g.: wavelength and bandwidth of a detector channel). As a result,
the strings sent to an instrument are composed of device properties.
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The Dionex Chromatography Management System supports several devices
with an additional functionality. Currently, three device types are available for
generic device drivers:

• Inject Device (e.g.: for Autosamplers),

• Channel Device (e.g.: for the detector channels), and

• Standard Device (no special properties).

Communication via the serial port always requires a device. As instruments
generally have one serial port, but are divided in several devices, one of the
devices is assigned the serial interface; the other devices have no separate
port, but are linked to the special device. Devices without their own serial I/O
properly reflect the connect status of the device that performs the serial I/O.

To asynchronously received strings, generic device driver can respond with
error messages or other messages. As it is not possible to assign these to a
specific device, it is assumed that the device assigned to the serial port is the
cause of the error or the message.

The dialog box Definition file shows the tree structure of a generic device
driver:
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The New..., Edit..., and Delete commands can be selected for the items in the
tree structure. New... creates an appropriate default entry and opens a dialog
box for selecting the settings.

Device Driver Settings in the "Driver/Definition" Dialog Box
The device name defined here serves to identify the driver during the
installation. This name is used as the default during installation.

 Caution: No other device driver should have the same name,
otherwise there would be two identical entries in the drivers
list.

The definition of the driver is always saved to the BIN directory of the
installation of the Dionex Chromatography Management System. The device
name is used as the file name. The file automatically receives the extension
GEN. If there is already a file with this name, the extension of the older file is
automatically changed to BAK, and the new definition is saved. The GEN files
contain the entire information entered when defining the driver. From this
directory, the file can be copied to the BIN directory of any other server of the
Dionex Chromatography Management System. Device drivers that were
generated inadvertently or for test purposes can be removed from the BIN
directory by deleting the corresponding GEN files.

Defining a Device in the "Device/Definition" Dialog Box
Defining a new device driver starts with creating a new device.

• Choose Devices or a previously created device from the definition tree
structure.

• Click New....

• Click the required device type in the dialog box Select device type. You
can choose between the types Standard Device, Inject Device, and
Channel Device. The significance of these types is described further
below.

A new device of this type will be created using default settings. The dialog box
for editing the properties will be opened.

The device name will appear as entered in the Dionex Chromatography
Management System. This name must be unique within the device driver.
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This dialog box also serves to define handling and properties of the serial port.
The device has no serial interface, uses its own serial interface, or uses the
interface of another device. In the first case, the device will not be able to
communicate with the instrument - it only serves to define variables in
programs. If the device uses its own interfaces, the corresponding properties
(baud rate, parity etc.) must be entered. If the device communicates via an
interface of another device, the corresponding device name must be entered
here.

Defining Commands and Properties
To define new properties and functions within a driver, it is very important to
realize the difference between functions and properties. The difference is
explained below.

A property is a single numerical value that can be read and written under the
Dionex Chromatography Management System. If a property value is modified,
the driver sends the corresponding serial command to the instrument. As a
variable component, this command usually contains the new numerical value of
the property. However, the command can also access the numerical values of
other device properties. The property is assigned the new numerical value only
if the serial command was performed correctly.

A command can only be activated. During activation, its parameters are set.
The parameters cannot be read, but are placeholders for the current numerical
values during activation. Activation causes the driver to send a serial command
to the instrument. Usually, this command contains the numerical values of the
parameters as a variable component. The command can also access the
numerical values of the device properties.

Generally, creating functions with parameters should be avoided. It is
recommended to use properties or functions without parameters instead. Only
these can be represented as controls in the user interface of the Dionex
Chromatography Management System. However, if the intention is to explicitly
point out that values should only be changed together, it is useful to create a
function with several parameters. In addition, generic device drivers cannot
read current values from the instrument. Properties that can be changed via the
Dionex Chromatography Management System and by the instrument itself
should therefore be set via a function with a parameter. This is to prevent that a
property can have a different value under the Dionex Chromatography
Management System than the actually set value on the instrument.

Using the generic serial device, the user can create any number of properties
and functions. Each property can be linked with any appropriate control on the
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user interface. After each modification of the control contents, a corresponding
command is sent to the instrument.

Defining Properties in the "Property/Definition" Dialog Box
It is recommended to create separate properties for values that can be set
independently (e.g. Gain and Response).

• From the Definition tree structure, select the item Properties or an
existing property.

• Click New.

A new property with default settings is created, and the dialog box for editing
the property is opened. This dialog box offers various options. The most
important one is Name.

• Enter the name for the new property (e.g. Gain). The name must be unique
within the device.
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• Determine the format in which the corresponding numerical parameter is
displayed on user interface of the Dionex Chromatography Management
System.

• Choose an appropriate number format from the Type field (an integer in
our example).

• Under Unit, enter the unit for the number value. Min and Max determine
the available value range. For an amplification factor, the lower limit could
be 1 and the upper value could be the corresponding maximum
amplification. The Dionex Chromatography Management System does not
support any input outside this range.

• The Step parameter is not considered for the moment (value = 0)
(described below).

• Number of Digits should also be 0 for an integer.

• Audit level indicates the priority with which messages regarding this
property are displayed.

• Via the fields Command Offset and Command Factor, the sent value can
be multiplied by a factor and assigned an offset. With the offset 10 and the
factor 2, the value 100 is changed to the value (100 x 2) + 10 = 210.

Defining Serial Commands of Properties in the "Property/Command
Sequence" Dialog Box
When changing the current value of a property, the device driver not only
sends a serial command, but an entire commands sequence. The value
assignment is considered completed only if all commands of the sequence
were performed correctly. A serial command is repeated until the maximum
number of retries is reached.
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• Flush receive queue defines whether the driver receive queue should be
cleared before sending the first character.

• Error level timeout indicates the priority of the error if no positive reply is
received within a specified time.

• If the reply is negative, the error level specified under Error level neg. ack.
will be returned.

• The error level specified under Error level failed is used if a command
sequence cannot be executed.

The list on the lower part of the dialog box contains the sent command
sequence. Each line represents a single command. The commands are sent in
the listed order. Each command is composed of the following seven entries:
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• Command: Enter the format statement for creating the command string to
send. The format is described further below.

• Pos. response: If the instrument sends a positive response in reply to the
command string, the response can be entered here. The driver then waits
until the response arrives or shows an error message.

• Neg. response: If the instrument sends a negative response in reply to the
command string, the response can be entered here. In this case, the driver
displays an error message.

• Exec. time: The command is considered completed after the time specified
here has passed since sending the first character.

• Timeout: The positive response must arrive within this period.

• Waittime: If a negative response or no positive response was received, the
command is repeated after this period.

• Retries: The command is repeated as specified here before it is aborted.

Format Instructions for Serial Command Strings
Wherever a command string should be sent or received when defining the
driver, the command string must be entered as a valid format instruction. The
instruction consists of ASCII characters, special characters, and variable
references. Variable references can be included only in format instructions that
are sent.

ASCII characters are all characters that can be directly displayed in the edit
field, i.e. letters and numbers. Special characters include all other characters.
To enter special characters, enter \ and two digits with the hexadecimal value
of ASCII table (e.g.: \0D is <CR> and \0A is <LF>.

The current value of the property can be included in the format instruction using
variable references. These must be entered with the following syntax
@[m][.n]f,<name>@:

• @ indicates the start of the variable reference.

• The m and .n parameter related to the definition of a specific number of
digits for the numerical output. The parameters are entered within square
brackets [..]to indicate that these parameters are optional. (The square
brackets are not part of the format instruction and never appear within a
valid instruction. They only serve to clearly structure the instruction.)

• The following character (here ‘f’) represents one of the following control
characters:
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d: Integer variable output as decimal value
u: Unsigned integer variable output as decimal value
o: Integer variable output as octal value
x: Unsigned integer variable output as hexadecimal value with lower case characters
X: Unsigned integer variable output as hexadecimal value with upper case characters
e: Floating-point number in exponential format (3.g. 3000 -> 3e4)
f: Floating-point number
g: Floating-point number in optimum format (e.g. 1.5 -> 1.5 but 2.0 -> 2)
c: Integer variable output as corresponding ASCII character

• ‘,’ is the separation from the variable name.

• 'name' represents the name of a property of the device or a parameter of
the current function. If property is referenced, properties of other devices
contained within the current generic driver can be accessed by using a fully
qualified name: <Device.Property>

• ‘@’ indicates the end of the variable reference.

A simple format instruction with a variable reference for integer variables as the
amplification factor could have the following appearance:

GAIN=@d,Gain@\0D\0A
GAIN= is sent to the instrument as fixed text, followed by the result of the
reference variable. @ introduces the variable reference. d means that the
current value should be returned as an integer decimal value. As no further
information is included on the number of digits, the current value determines
the number of digits. The current value is extracted from the property Gain of
the device. The command is completed via <CR><LF>. For further examples
for more complex format instructions see below.

Defining Standard Property Settings in the "Property/Defaults" Dialog Box
The device driver initializes all properties with invalid values. If it is possible to
establish a connection to an instrument, the field Connect default offers two
possibilities to re-initialize the properties.
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• Set Value: The current value of the property is set to the specified value
without sending the corresponding command sequence to the instrument.

• Send Command: A command sequence is sent to the instrument with the
specified value and is set as the new property value after correct
performance.

Defining Functions "Function/Definition" Dialog Box
To create a new function, proceed as follows:
• Select the element Functions or an existing function in the definition tree.

• Click New....

This creates a new function with default settings. The dialog box for editing the
function is opened.
• Enter the name of the new function. The name must be unique within the

device.

• Audit level indicates the priority with which messages regarding this
property are displayed in the audit trail.

Defining Serial Commands of Functions in the "Function/Command
Sequence" Dialog Box
When a function is selected in the Dionex Chromatography Management
System, the device driver sends a command sequence to the instrument. Use
the procedure described for properties to define these command sequences
(see Defining Serial Commands of Properties in the dialog box
Property/Command sequence).

In the case of functions, format instructions of a command can contain variable
references to properties and to function parameters.
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Defining Parameters in the "Parameter/Definition" Dialog Box
To extend a function by parameters, proceed as follows:
• Choose the element ‘Parameter’ or an existing function parameter from

the definition tree structure.

• Click New....

A new parameter is then created with default settings. The dialog box for
editing the parameter is opened. This dialog box corresponds to the one for
defining properties (see Defining Properties in the dialog box
Property/Definition).

The name of the parameter must be unique within the function. All parameters
of a function must have different names. Assigning the same name to
parameters of different functions is possible. In addition, the same name can
be assigned to a property and a parameter. However, in the latter case it is not
possible to specify a variable reference to the property, as this type of
reference always refers to the parameter by the same name.

Defining Error Messages in the "Error/Definition" Dialog Box
To extend the device driver by an error message, proceed as follows:
• Choose the element Errors or an existing error message from the

definition tree structure.

• Click New....

This creates a new error message with default settings. The dialog box for
editing the message is opened. It contains three fields:
• Error text: Enter the text to be written to the Audit Trail. Each error

message must have its own text.

• Serial string: Enter the format instruction (without variable reference) that
is received to return an error message.

• Error level: Enter the priority of the generated error.

As errors are defined on the driver level, they are valid for all devices of the
driver. The error message is linked to the device that is assigned to the serial
interface on which the matching command string was received.
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Predefined Properties and Functions
The Dionex Chromatography Management System expects drivers and
devices to supply certain properties and functions. The type of properties and
their names depend from the device type. An inject device must have the
function Inject, and the properties Position and Volume. There are also
optional properties and functions that the Dionex Chromatography
Management System supports only if they actually exist.

Setting these properties and functions is partly predefined and cannot be
changed. For the property Volume, the type must be set to Floating Point and
the unit must be µl. The function Inject cannot be extended by parameters.

When generating a new device, all predefined properties and functions are
automatically generated with default settings and must be adapted to the
requirements of the driver. Predefined properties and functions that are
optional can be deleted.

The following paragraphs offer information on the available device types.

Device Type "Standard Device"

The device type Standard Device forms the basis for all other types. All
predefined properties and functions are also included with the other types.

As drivers communicate with external instruments, the Dionex Chromatography
Management System assumes that the communication with the instrument
must be explicitly enabled and disabled. The Dionex Chromatography
Management System uses the functions Connect and Disconnect. In addition,
the optional function Reset is defined.
• Connect: Enter the command string for switching the instrument into the

remote mode. When starting the server, the Dionex Chromatography
Management System automatically performs the Connect function for all
serial instruments. This guarantees that user-defined instruments are reset
to the serial remote mode after restarting the server and that instruments
can be immediately addressed via commands (e.g. after a power failure).

After successfully completing the command sequence of Connect, the action
specified in the default settings (see Defining Default Settings of Properties
in the dialog box Property/Defaults) is performed for each property.
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• Disconnect: Here, the command sequence must be entered for switching
the instrument to the manual mode. This function is opened when closing
the server to make all instruments accessible for the manual mode.

• Reset: If the instrument should be set to a defined status in the event of an
error, the corresponding command sequence can be entered here.

Device Type "Inject Device"

With the device type Standard Device, it is not possible to perform the inject
command correctly (as the return signal sent by the sampler after the injection
cannot be processed). For this reason, a special device type is required for
controlling autosamplers that are not supported by a separate device driver.

In addition to the already described predefined functions of the standard type,
the properties Volume and Position as well as the function Inject are required
here.
• Volume: The Dionex Chromatography Management System always sets

this property to the sample volume to be injected.

• Position: The Dionex Chromatography Management System always sets
this property to the sample position from which to inject.

• Inject: This function starts the injection procedure. As this function does
not have parameters, the current injection parameters of the properties
Volume and Position must be used.

After the Inject command, the Dionex Chromatography Management System
waits for the Inject Response from the driver, indicating that the injection
process is completed. Only then is the time program started.

The device driver offers two possibilities to supply the Inject Response to the
Dionex Chromatography Management System:
• Digital inject response

If the system has a correctly installed remote input, as e.g. the Dionex UVD
340S, the A/D converter board or the Dionex pump control board, the
Inject Response can be recorded via the remote input. Choose the value
Digital inject response when defining the device in the field ‘Inject
response’. When installing the driver, the driver must be assigned the
remote input to record the signal.
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• Serial inject response
Instead of the remote input, the Inject Response can be recorded directly
via a serial connection. However, it is necessary that the autosampler
sends a corresponding string after the injection is completed. If this is the
case, and if the command is listed in the manual for the instrument, choose
Serial inject response in the Inject response field. Enter the appropriate
format instruction in the field Serial string.

Device Type "Channel Device"

For detector drivers, the channels must be connected to analog inputs of the
A/D Converter during installation. In addition, the Dionex Chromatography

Management System supports these devices when automatically generating
programs.

The predefined functions of the standard type are usually sufficient. The
properties Wavelength, Range, and Response and the function Autozero are
optional.
• Wavelength: This property indicates the wavelength of the analysis.
• Range: This property defines the factor, by which the analog output signal

is increased or reduced.
• Response: This property indicates the time the detector requires for

reaching 98% of the full scale.
• Autozero: This property resets the output signal to zero.

When installing the driver, the channel must be connected to an analog signal.
The signal parameters must be set.

Checking the Control Commands
To check whether the definitions are actually supplying the required command
strings for the instrument control, the Demo mode is activated. The device
driver now sends all formatted command strings of a command to the Audit
window of the corresponding timebase. Non-printable characters are output as
hexadecimal codes following a slash.

The control character <CR> is mapped to \0d. The entire output is completed
by a period to enable evaluating the total length of the command string.
Otherwise, leading or appended blank spaces would not be visible. A typical
Audit message has the format:

"{Instrumentname} Send: CommandString."

 Caution: In the Demo mode, there is no output via the serial port!
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If the entire input is interpreted correctly, you can proceed with the following
paragraphs. You will find detailed information on format styles and the use of
truth tables and lists.

Format Instructions in Detail
The optional parameters m and n of the general variable reference
@[m][.n]f,<name>@ are especially interesting here.

In the simplest case, m is an abstract number for the entire length of the
formatted numerical output, including a possibly existing decimal point.
Additional information can also be included (e.g. left-align or right-align
numerical output in the output field, fill superfluous places with blank spaces ( )
or zero (0), etc.). n represents the number of decimal places (only sensible for
floating point numbers, not available for integer variables).

Example:
The following table contains various format instructions for integer and floating-
point numbers. On the right, you can see the corresponding result of the output
with these instructions. The quotation marks serve to indicate the orientation of
the numbers within the output field that is part of the entire command string!

Number Type Format instruction Result
1234 Integer @d ‘1234’

1234 Integer @5d ‘ 1234’

1234 Integer @05d ‘01234’

1234 Integer @09d ‘000001234’

1234 Integer @-7d ‘1234   ’

1234 Integer @o ‘2332’

1234 Integer @x ‘4d2’

1234 Integer @X ‘4D2’

-1234 Integer @x ‘fffffb2f’

1234.5678 Floating point @f ‘1234.567800’

1234.5678 Floating point @.4f ‘1234.5678’

1234.5678 Floating point @.3f ‘1234.568’

1234.5678 Floating point @6.2f ‘1234.57’

1234.5678 Floating point @5.2f ‘1234.57’

1234.5678 Floating point @-15.2f ‘1234.57        ‘

1234.5678 Floating point @15.2f ‘        1234.57’
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Discrete Range of Values and Truth Tables
Frequently, specific parameters can only be modified using discrete steps or
can only assume certain values. Sometimes, it may be a good idea to assign
meaningful terms to specific instrument states that are controlled serially via
numerical parameters, e.g. assigning INJECT and LOAD to the motorized
switching valve settings instead of 0 and 1. To enter settings, the parameters
Step and Table are available for numerical values in the edit dialog box.

Discrete Equidistant Value Distributions
The default setting for Step is zero. As soon as this integer variable is larger
than zero, it determines the number of equidistant steps for the range of values
between Min and Max. The input 1 means that only the values Min and Max
are valid. The input 2 enables Min, Max and the value (Min+Max")/2, etc.
Thus, Step allows selecting a discrete quantity of valid input values from the
progressive range of values between Min and Max. Neighboring values are
divided by (Max-Min)/ Step. If the device driver receives numerical input for
this parameter that do not correspond exactly to the discrete value, input is
automatically replaced by the nearest valid value. A corresponding message is
included in the Audit Trail of the timebase.

Frequently, valid values are not equidistant, or the user does not only require
numerical values for the instrument status. In this case, use the Table (see
below).

User-Defined Value Quantities and Lists

• Activate the table by selecting Use Table.

The Type, Min, Max, Step, and Number of Digits controls for entering the
parameter definition are deactivated. The description of the discrete range of
values is exclusively via the table. Two different modes are available that can
be selected via the Enumerated and Numerical buttons

Example:
In a detector the time constant Response for the output signal is to be
controlled via the CTIME=X<CR><LF> command string. X can assume the
numerical values 1, 2, and 3, which correspond to the instrument presetting
slow, standard, and fast. To view the actual settings instead of the numbers,
activate the Table and choose the Enumerated mode.
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The column headers of the table are now Value and Enumerator. Enter the
terms for the status description below Value, and enter the corresponding
numerical values in the Enumerator column. For this example, the input
should be as follows:

On the screen, the settings slow, standard, and fast appear. These are
converted into the command strings: CTIME=1<CR><LF>,
CTIME=2<CR><LF> and CTIME=3<CR><LF>.

The input mode Numerical serves to select discrete, non-equidistant values, or
their mapping to the corresponding control indices. This can be used e.g. for
specifying amplification factors that are frequently adjustable in the 2,5,10
across several orders.

Example:
For the Gain variable, only the values 0.2, 0.5, 1, 2, 5, 10, 20, 100 are valid.
They are communicated via the GAIN=X<CR><LF> command string to the
instrument. X represents the current value.
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• Choose the Numerical mode and enter the values in the Value column in
an ascending order.

• The Index column remains empty.

Now, only discrete values are valid. If the user enters deviating values that are
within the Min - Max range, the device driver changes the value to the nearest
valid value. Simultaneously, this correction is documented in the Audit Trail.

Indexed Discrete Value Quantities
Frequently, discrete values are indexed in addition, i.e. each value is assigned
an integer value. These values are entered in the Index column.

• If you want to index discrete values, each value must receive a
corresponding integer value in the Index column.
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Within the command string, the integer value is used instead of the floating-
point number. The device driver converts the values into the indices. These are
then sent to the instrument via a format instruction (e.g. d).

You can also use this feature to translate enumerated constants into ASCII
characters. Enter the corresponding ASCII value as the index and use the
format instruction c.

Example:
For the Response variable, the values 0.05, 0.5, and 1.50 are valid only. They
are communicated to the instrument via the RESPONSE=X<CR><LF>
command string. X represents the letter F (ASCII 70), the letter M (ASCII 77) or
S (ASCII 83) corresponding to the variable value.
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Appendix:
Cables and Pin Assignments

Appendix: Cables and Pin Assignments

Operating the various instruments requires different groups of cables:

• Power cables (refer to the information in the Installation Instructions of the
manufacturer that are shipped together with the instrument.)

• Control cables (mainly RS232 cables; most of them are available from
Dionex - see below)

• A/D cables (for data acquisition of analog detectors except the Dionex IC
detectors, the Dionex UVD160/320, UVD170/340, PDA-100, and HP1100
detectors)

Controlling third-party instruments via the various Device Drivers requires
different control cables. For further information on these cables, see:

 Fisons AS: Cable - Dionex P/Ns 8914.0127 / 8914.0143
 Fisons GC: Cable - Dionex P/Ns 8914.0126 / 8914.0142
 Gilson: GSIOC Cable

 HP5890 RS232 Cable
 Modem Cable (1:1 RS Cable)
 Null Modem Cable (RS232)
 THERMOQUEST Trace GC: Cable - Dionex P/Ns 8914.0148 /

     8914.0149
 THERMOQUEST AS2000 / Trace GC: Cable
 TSP/Linear: Cable - Dionex P/N 45789 (Cable AI450 to AS3500)
 Varian: Cable - Dionex P/N 8914.0145
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 FISONS AS: Cable - Dionex P/Ns 8914.0127 / 8914.0143
Instrument for which the cable is required

 Fisons AS800

Pin Assignments

Connecting the Fisons AS800 to the serial interface of the Server PC requires
the following cable:

AS800 PC PC
(9-pin, Sub-D, male) (25-pin; Sub-D, female) (9-pin; Sub-D, female)

1
2 ---------------- 3 (RXD) 2 (RXD)
3 ---------------- 2 (TXD) 3 (TXD)
4 ---------------- 20 (DTR) 4 (DTR)
5 ---------------- 7 (GND) 5 (GND)
6
7
8 ---------------- 5 (CTS) 8 (CTS)
9 ----------------

Dionex Part Numbers

• 8914.0127 25-pin - 25-pin; 5m

• 8914.0143 9-pin - 25-pin; 5m
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 FISONS GC: Cable - Dionex P/Ns 8914.0126 / 8914.0142
Instrument for which the cable is required

 Fisons 8000 GC /Mega 2 GC

Pin Assignment

Connecting the Fisons 8000 to the serial interface of the Server PC requires
the following cable:

Fisons GC PC PC
(25-pin; male) (25-pin; female) (9-pin, female)

4 -------------- 8 1
2 -------------- 3 2
3 -------------- 2 3

5 --- 6 -------------- 20 4
7 -------------- 7 5
20 --------------- 5 --- 6 6 --- 8
8 --------------- 4 7
22 --------------- 22 9

Dionex Part Numbers

• 8914.0126 25-pin - 25-pin; 5m

• 8914.0142 9-pin - 25-pin; 5m
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 Gilson: GSIOC Cable
Instruments for which the cable is required

 Gilson UV Detectors 116, 117, and 118
 Gilson Fraction Collector 201/202 and 206
 Gilson Autosamplers 231, 232 Bio, and 234
 Gilson Pumps 302, 303
 Gilson Pumps 305, 306, 307
 Gilson Valves (817, 819, and UVSM)
 Gilson Autosamplers 231XL, 232XL, 233XL (Old Device Driver)
 RAININ/VARIAN Pumps (SD-1, SD-200/SD-300, ProStar 215)

 Caution:
Under the Dionex Chromatography Management System, the GSIOC bus
available from Gilson is used exclusively for combining several pumps in a
high-pressure gradient system. All other instruments (e.g. Autosampler and
Detectors) are controlled individually via separate serial interfaces. All
instruments (except those with serial interface) must therefore be connected
via an original Gilson cable (GSIOC adapter Model 605) to a PC interface. The
adapter is shipped with the baud rate set to 19200 Baud. For controlling
specific instruments via the Dionex Chromatography Management
System (i.e., in case of specific drivers (see setting on the tab "General"
of the corresponding instrument properties)), it is necessary to set the
baud rate to 9600 Baud. To do this, open the connector housing. Resolder the
cable from land A to land B (for details, see the Gilson 605 RS232 Adapter
and GSIOC Protocol - USER'S GUIDE).

 Tip:
Always connect Gilson instruments requiring a GSIOC cable to the multi-serial
8-fold PCI interface board (Equinox 8-RS232 Multi-COM card, Dionex part no.
5906.2095) as communication problems might occur with other RS232 ports
(e.g. with the COM ports of the PC or the  Dionex Universal
Chromatography Interface). The power supply of the GSIOC adapter (type
605) is directly via the RS232 interface. However, the RS232 ports of the

UCI-100 Universal Chromatography Interface are not designed for this.
Dionex Part Number

This cable is available from Gilson only.
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 HP5890: RS232 Cable
Instrument for which the cable is required

 HP5890

Pin Assignment

RS232 Cable
Replace the 25-pin male connector of the Agilent RS232 cable by a 25-pin
female connector (Dionex part no. 1282.5021).

Pin assignment for the RS232 communication:

HP5890 PC PC

(12-pin, Sub-D, male) (25-pin; Sub-D, female) (9-pin; Sub-D, female)
2 ---------------- 3 (RXD) 2 (RXD)
4 ---------------- 7 (GND) 5 (GND)
6 ---------------- 2 (TXD) 3 (TXD)

Dionex Part Number

The cable is available from Agilent only.
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 HP6890: A/D Cable
Instrument for which the cable is required

 HP6890

Pin Assignment (Front View)

(Please refer to the manufacturer's information in the Installation Instructions
that are shipped together with the instrument.)

1 2

3 4

5 6

HP6890
(Agilent analog cable) A/D Converter

2 (white) ---------------- (-)
4 (black) ---------------- (+)

Dionex Part Number

The cable is available from Agilent only.
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 Modem Cable (1:1 RS Cable)
Instruments for which the cable is required:

 CTC ANALYTICS A200S / Fisons A200S

 Gilson: Liquid Handler 215

 Gilson: Autosamplers 235 and 235p

 Gilson: Autosamplers XL Series (221XL, 222XL, 231XL, 232XL,
     233XL)

 Gilson: Valves (ValveMate only)

Pin Assignment

(Also, see Pin Assignment):

Instrument PC
9-pin

male connector
25-pin

male connector
25-pin

female connector
9-pin

female connector
2 3 ------------ 3 2
3 2 ------------ 2 3
5 7 ------------ 7 5

If there is an additional hardware handshake, the following assignments are also required:

7 4 ------------ 4 7
8 5 ------------ 5 8

Modem cables are also called 1:1-RS cables.
Dionex Part Numbers
• 8914.0144 25-pin - 9-pin, 5m

• 8914.0128 25-pin - 25-pin, 5m

 Tip: Do not confuse non-crossover modem cables (= 1:1 RS cables)
with crossover Null Modem Cables!

For information on additional or other connections, refer to the installation
instructions for the respective instrument for details (also, see  Installing
and Controlling Third-Party Instruments).
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 Null Modem Cable (RS232)
Instruments for which the cable is required

 HP1050
 HP6890
 Gilson: Autosampler 231/232/233XL (Old Device Driver)
 TSP: UV3000 / Linear Detector 206

Pin Assignment

(Also, see Pin Assignment)

Instrument PC
9-pin

female connector
25-pin

female connector
25-pin

female connector
9-pin

female connector
2 3 ------------ 2 3
3 2 ------------ 3 2
5 7 ------------ 7 5

If there is an additional hardware handshake, the following assignments are also required:

4 7 ------------ 6 6
6 6 ------------ 7 4
7 4 ------------ 5 8
8 5 ------------ 4 7

 Tip: Do not confuse crossover null modem cables with non-
crossover Modem Cables (1:1 RS cables)!

Dionex Part Numbers

9-pin to 9-pin:
• 8914.0129 for RS cable RU, 2.5m
• 8914.0130 for RS cable RU, 5m
• 8914.0131 for RS cable RU, 10m

25-pin - 9-pin:
• 8914.0103A for RS cable RU, 2.5m
• 8914.0120 for RS cable RU, 5m
• 8914.0121 for RS cable RU, 10m
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If necessary, use an adapter to connect the cable to a 25-pin socket. These
null modem cables have been slightly modified to ensure data transmission
even with enabled hardware handshake. However, the above hardware
handshake is not realized.

For information on additional or other connections, refer to the installation
instructions for the respective instrument for details (also, see  Installing
and Controlling Third-Party Instruments).

 THERMOQUEST Trace GC: Cable Dionex P/Ns
     8914.0148 / 8914.0149
Instrument for which the cable is required:

 THERMOQUEST: Trace GC

Pin Assignment

Connecting the ThermoQuest Trace GC to the serial interface of the server PC
requires the following cable:

Trace GC PC PC
(9-pin, Sub-D, male) (25-pin; Sub-D, female) (9-pin; Sub-D, female)

1
2 ---------------- 3 (RXD) 2 (RXD)
3 ---------------- 2 (TXD) 3 (TXD)
4 ---------------- 20 (DTR) 4 (DTR)
5 ---------------- 7 (GND) 5 (GND)
6
7
8 ---------------- 5 (CTS) 8 (CTS)
9 ----------------

Dionex Part Number

• 8914.0148 9-pin to 9-pin

• 8914.0149 25-pin to 9-pin
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 THERMOQUEST AS2000 / Trace GC: Cable
Instruments for which the cable is required:

 THERMOQUEST: AS2000 GC Autosampler
 THERMOQUEST: Trace GC

Pin Assignments
(Also, refer to the Installation Instructions supplied with the instrument.)

Dionex Part Number

This cable is available from ThermoQuest only.
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 TSP/Linear: Cable (Cable AI450 to AS3500) - Dionex P/N
    45789
Instruments for which the cable is required:

 TSP AS3500/AS3000 Autosamplers

 TSP P2000 and P4000 Pumps

 TSP UV1000 Detector

 TSP UV2000 / Linear UV205 Detector

Pin Assignment

Autosampler
(RJ11)

PC
(D-Sub 9-pin male)

3 ------------ 2
4 ------------ 3
2 ------------ 5
5 ------------ 5

The pin assignment at the 6-pin RJ11 connector is as follows:

Dionex Part Number

45789 (Cable AI450 to AS3500)
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 VARIAN: Cable - Dionex P/N 8914.0145
Instrument for which the cable is required:

 VARIAN 3400 GC

Pin Assignment

Varian 3400
(D-Sub 9-pin female)

PC
(D-Sub 9-pin female)

6 ------------ 2
4 ------------ 3
7 ------------ 5

Dionex Part Number

8914.0145
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Sequence, Sequence Table, Sample List
A sequence consists of a list of samples to be processed, in which the samples
are described (e.g. name, injection volume, dilution, etc.). Details of sample
processing are referenced by file names and stored in the respective !PGM
Files in the sequence.

To create a sequence, use the  Sequence Wizard.

 Tip: Do not use special characters (e.g. umlaut) for new directory
names or sequences, as this may cause problems in Novell
networks!

The new sequence may be reedited afterwards in the !Browser. Each line of
the table represents a sample. Theoretically, the number of samples is not
limited, but 100 sample entries should be exceeded only in exceptions. The
more sequences are created, i.e., the fewer samples are included in one
sequence, and the higher is the access speed to samples. In addition, it is
easier to keep track of the samples processed.

 Tip: Injections that are made from the same vial are regarded as
separate samples!

The sequence table also defines how to process a sample. This includes
information on the sample itself (injection volume, position, weight, dilution
factor, etc.) as well as references to chromatographic methods that specify
which program (PGM file) to be performed for the analysis and the evaluation
parameters to be used (QNT method).

Usually, sequences are started from a !Control Panel. However, they can be
started directly in the Browser as well provided the sequence has already been
assigned to the respective !Timebase. Either press Start in the !Batch menu
or choose the corresponding button of the online !Toolbar.

The entire data collected in connection with creating and processing a
sequence, including raw data and protocol data recorded during the analysis, is
saved in the sequence directory of a !Datasource or in the underlying
database. Of course, this includes the raw and protocol data recorded during
the analysis.

Similar to datasources, sequences can be "locked." In this status, data and
results can only be read, not modified or extended. For details on locking
datasources, directories, and sequences, see Data:  Datasource.
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The screenshot shows the default configuration of the Browser, which can be
reconfigured as required. You may add or delete columns or change their
order, respectively according to your specific requirements. The layout is saved
as well. Therefore, if you reedit the sequence at later date, the representation
will correspond to the one of your last access. The samples are entered in the
table in the order in which they are to be processed. For information on the
parameters that describe the individual samples, see the ⇒Sample Variables
below.
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Sample Variables (Overview)
Sample Variables

The variables in the  Sample List (Sequence Table) columns are referred
to as sample variables. They characterize a sample and are stored in a
database as part of the !Sample Data. For an explanation of the columns, see
the following pages:

⇒Comment (Sample Comment)

⇒Dil. Factor (Dilution Factor)

⇒Inj. Date/Time

⇒Inj. Vol. (Injection Volume)

⇒ISTD Amount (Amount of the !Internal Standard)

⇒Method (QNT Method)

⇒Name (Sample Name)

⇒No. (Sample Number)

⇒Pos. (Sample Position)

⇒Program (also, see: !PGM File)

⇒Replicate ID

⇒Sample ID

⇒Status (Sample Status)

⇒Type (Sample Type)

⇒Weight (Sample Weight)
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Comment (Sample Comment)
Type: Text
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Name (sample name)

Description: In addition to the sample name, further comments
can be entered. Use F8 to open an enlarged edit
field.
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Dil. Factor (Dilution Factor)
Type: Floating point value
Dimension: ---
Value Range: 0000.001 ... 99999999
Default: 1.0
Related Param.: ⇒Inj. Vol. (injection volume)

⇒Weight (sample weight)

Description: The ⇒Sample Variable Dilution Factor is a
correction factor for amount calculation formulas.
As the injection volume, it can also be used for
multi-point calibrations to define the dilution of
subsequent calibration samples. For integration
samples, it serves to account for any dilution that
was made before the injection.

Function: The calculated values for all peaks of a sample
are corrected by the appropriate dilution factor.

 Note: The effect is reciprocal to injection volume, i.e., a
larger dilution factor indicates that less
component is present.
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Inj. Date / Time (Time of Injection)
Type: Character String
Dimension: Month/Day/Year Hours:Minutes:Seconds
Value Range: ---
Default: ---
Related Param.: Time
Description: This column cannot be edited. The Dionex

Chromatography Management System enters the
injection time and date of the sample in the
corresponding column of the sample list. For
samples with the ⇒Status (Sample Status) M
(multiple), the time of the last injection is entered.

The Dionex Chromatography Management
System stores the time stamps as universal time
(Greenwich time). However, the date notation is
displayed according to the country and system
settings chosen in the operating system.

Function: The kind of entry (empty or time value) indicates
whether and when the sample was processed.

 Note: The time difference between successive samples
is generally the analysis time plus the time
required for injecting the following sample
because the report is generated parallel to the
online batch. As the injection time is generally
minimal, the time value provides a reliable
indication as to whether the sample batch was
processed without incident (e.g. power failure,
third-party interference).
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Inj. Vol. (Injection Volume)
Type: Nonnegative integer
Dimension: µµµµl
Value Range: system-dependent
Default: 20.0
Related Param.: ⇒Dil. Factor (dilution factor)

⇒Weight (sample weight)
Description: The ⇒Sample Variable Injection Volume

defines the injection volume in micro liters (µl).
In automatic operation, the installed !Driver
converts this value into a volume readable by
the autosampler, then the value is sent to the
!Autosampler.
By entering different injection volumes, a
!Dilution Series can be created in case of a
multiple-point calibration (!Single-Point and
Multiple-Point Calibration).

Function: In a multiple-point calibration, using differing
injection volumes, the concentration of the
second calibration sample is calculated from the
injection volumes of the first and the second
sample. The same principle (doubling injection
volume equals doubling the amounts of each
component) is applied to all subsequent
calibration samples.
In a multi-point calibration with a "concentration
series" (varying injection volume) which was
created with an automatic autosampler it is
therefore only necessary to enter the component
amounts for the first standard sample into the
peak table. All additional calibration values, i.e.,
the corresponding amounts of the subsequent
standard samples  (Type: Standard) are
calculated by the data system.

 Note: In order to minimize carry-over effects in such a
multiple-point calibration, standard order should
always be from lowest to highest concentration.
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ISTD Amount (Amount of the internal standard)
Type: Floating point value
Dimension: ---
Value Range: 0.001 ... 999999.9999
Default: 1.0000
Related Param.: ⇒Dil. Factor (dilution factor)

⇒Inj. Vol. (injection volume)

Description: The ⇒Sample Variable ISTD Amount is only
required for a calibration based on a variable
!Internal Standard (internal or internal/external).

In this case, the column serves in the sample list
for entering the amount values of the internal
standards used for the different samples. Input is
directly in the sample list (via the keyboard or the
F8 edit dialog box). Editing the column in the
QNT editor is not possible. Entering the amount
values in the peak table is omitted.

Function: The ISTD Amount parameter is implemented as
a multiplication factor in the !Amount Calculation
Formula and is dimensionless.
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Method (QNT Method)
Type: File name
Dimension: ---
Value Range: ---

Default: Name of QNT file
Related Param.: ⇒Program (PGM file)

Description: The Method column (in the Browser) contains the
name of the  Quantification Method.

The quantification method includes all parameters
that are used for evaluating a peak or the entire
chromatogram.

Function: The QNT method serves as the basis for
calculation for sample evaluation. It includes:
⇒QNT Parameters
All parameters required for (qualitative) peak
identification and for converting the determined
peak areas into amount or concentration values
(quantitatively)

⇒Detection Parameters
All parameters regarding e.g. peak recognition
and peak area evaluation
!Calibration Variables
All parameters regarding the type and
performance of a calibration

!Blank Run Subtraction
Information on baseline subtraction

Peak Tracking
Parameters for comparing spectra to library or
sequence spectra

Spectra Library Screening
Parameters for spectra library screening
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Function (Cont'd): !System Suitability Test (SST)
Parameters for performing the System Suitability
Test

MS
Parameters for evaluating !Mass Spectra

 Tip: Normally it is not necessary to include the QNT
method in the sample list before the analysis
starts. However, if you want to perform a System
Suitability Test, ensure to enter the QNT file into
the sample list before starting the analysis.
Otherwise, the batch cannot be aborted in case of
Fail Action - Abort Batch because the SST will
not yet be performed during the batch run!
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Name (Sample Name)
Type: Character String
Dimension: ---
Value Range: All printable characters
Default: [Sample] [No.]
Related Param.: ---
Description: The ⇒Sample Variable Name serves to identify a

sample and to label graphics and reports.

Function: The Fill Column function (F9) allows automatic
sample name generation. For this purpose, the
currently selected name can be copied or a
character string with wild cards as template can
be entered. These are names that might include
e.g. the sample number (#n, see ⇒No.), the
position (#p, see ⇒Pos.), the replicate number
(#r), and the injection volume (#i, s. ⇒Inj. Vol.).
Thus, telling names can be easily generated
using these wild cards! The replicate number is
calculated from the repetition of a sample
number. Example: If two injections are made from
the first two vials the template �Analysis-
#p_Repl.#r" yields the following names:

Analysis-1_Repl.1

Analysis-1_Repl.2

Analysis-2_Repl.1

Analysis-2_Repl.2

When creating a sample list using
the  Sequence Wizard, automatic sample
name generation is possible as well.

 Note: Each line represents an individual analysis. As
multiple injections of the same sample also
represent multiple analyses, a sample line must
be reserved for each injection.
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No. (Sample Number)
Type: Nonnegative integer
Dimension: ---
Value Range: 1 ... infinite
Default: Ascending number
Related Param.: ---
Description: The user cannot edit the sample number. Each

new line in the sample list (i.e. each analysis) is
assigned its own number.

 Tip: Each injection (or replicate) occupies its own line
in the sample list and is, therefore, an individual
analysis for which an individual raw data file is
created.
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Pos. (Sample Position - Sample List)
Type: Nonnegative integer and/or letters
Dimension: ---
Value Range: Depending on the autosampler
Default: Sample number
Related Param.: Number
Description: The ⇒Sample Variable Pos. determines the

position of the sample in the !Autosampler.

For externally controlled autosamplers, this value
is automatically transmitted to the autosampler for
sample processing. The sampler approaches the
corresponding sample for injection. For non-
controllable autosamplers, this value is for
documentation purposes only. If the sample
position parameter is not entered, the previous
(current) value is used.

Function: Depending on the segment type used, the ASI-
100/ASI-100T sampler offers 63 position for
semiprep vials, 66 positions for Eppendorf vials,
117 positions for analytical vials, or 192 positions
for mini vials.

Letters according to their color describes the
individual segments: R, G, or B (indicating the
red, green, and blue segment, respectively). The
different rows are described from the outer to the
inner row: A, B, C, or D. The individual positions
within the respective rows are number
counterclockwise. The position RA1, for example,
is in the outer row of the red segment (also, see
the ASI-100/ASI-100T Operating Instructions).
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Program (PGM File)
Type: File name
Dimension: ---
Value Range: ---

Default: Name of PGM file
Related Param.: ⇒Method (QNT Method)

Description: The column serves for entering a  Control
Program name.

The file contains all information for
chromatographic sample processing. These are
commands for HPLC instrumentation (flow, %B,
etc.), analysis time, acquisition time, etc.

For further details, see !PGM File.

Input for a sequence is by directly editing the
column in the Browser. The list box offers all
program files that are part of the sequence.

Function: The sample is processed according to the
conditions contained in the PGM file.
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Replicate ID
Type: Text
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Name (sample name)

⇒Sample ID

Description: The Replicate ID column serves to mark samples
as !Replicates.

Function: This column is a mere text column and not used
for evaluation purposes. The replicate ID is used
to identify samples as replicates. If a sequence is
generated using the Sequence Wizard (only
then), the sample position is entered here.

Samples with identical replicate IDs can be
grouped in the report by means of suitable
settings (Sort Summary by smp.sampleID).
Accessing these data for a query (see How
to ...: Actions in the Browser  Performing a
Query) is possible as well.
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Sample ID
Type: Text
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Name (sample name)

⇒Replicate ID

Description: The user or a help program enters a sample ID in
the Sample ID column.

Function: This column is a mere text column and not used
for evaluation purposes. The sample ID is
intended for LIMS connections that usually know
sample IDs.

Samples with identical sample IDs can be
grouped in the report by means of suitable
settings (Sort Summary by smp.sampleID).
Accessing these data for a query (see How
to ...: Actions in the Browser  Performing a
Query) is possible as well.
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Status (Sample Status)
Type: Text
Dimension: ---
Value Range: Single/Finished/Multiple/Running
Default: Single
Related Param.: ⇒Inj. Date/Time (Time of Injection)

Description: The ⇒Sample Variable Status determines the
current sample processing status. A sample is
either unprocessed (Single), or Finished, or due
for multiple processing (Multiple).

The Dionex Chromatography Management
System also maintains a log of the sample status,
i.e., a Single sample is automatically assigned
the status Finished as soon as processing is
completed. A sample may also be excluded from
processing by assigning the status Finished
manually.

The sample status has a special significance for
the built-in !Power-Failure Protection. Upon
recovery from a power failure or starting the
sample batch after a manual interruption, the
Dionex Chromatography Management System
continues processing the sample batch according
to the selected power-failure handling option.

Functions:

Single The sample is processed only once, after which it
receives the status Finished. When loading a
sample list for processing (online), only samples
with the status Single and Multiple are processed.

If a Single sample contains an entry in the time
column, this indicates that the sample was
injected but was interrupted before completion.
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Finished All original Single samples are automatically
assigned the status Finished after successful
processing. A sample with the status Finished will
be omitted in the renewed processing (also
following a !Power Failure). In !GLP
!Datasources, it is not possible to reset the
sample type Finished to Single.

Multiple The sample can be repeatedly acquired. The
system just enters the ⇒Inj. Date/Time (Time of
Injection) in the Time column. Existing !Raw
Data are overwritten with each new data
acquisition.

New samples can have the status Multiple
assigned only if the Enable Sample Status
Multiple option of the corresponding datasource
is activated. The option is available in the
(datasource) Properties (via the Properties
command of the context menu) on the General
tab. Samples that have the status Multiple
already assigned keep their status even with
disabled Enable Sample Status Multiple option.

Running A running sample is marked green. Having been
processed it gets the status Finished or Multiple
assigned (without background color).

 Tip: Samples can be opened as well
while being analyzed, i.e. while
being in Running status (see

 Opening a Sample).

 Tip: Multiple status samples will be acquired each
time. The raw data, therefore, are not protected
from accidental overwriting. The Time column
indicates, however, whether and when the
sample was last injected. If this column is empty,
the sample has not yet been acquired at all.
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Type (Sample Type)
Type: Text
Dimension: ---
Value Range: Blank, Unknown, Standard, Validate, Matrix
Related Param.: Amount, Baseline Subtraction
Default: Unknown
Description: The ⇒Sample Variable Type indicates the

sample type:

• Select Unknown for an unknown analysis
sample: .

• Select Standard for a standard sample with
known concentration: .

• Select Validate for a !Validation Sample: ( ).

• Select Blank for a !Blank Run Sample ( ). If
a sample is corrected by the !Raw Data of a
blank run sample, this is referred to as !Blank
Run Subtraction.

• Select Matrix for a !Matrix Blank Sample: 

Functions:

Blank The sample should not be analyzed; it serves as
a Blank Run. In this case, the baseline is stored
for subsequent subtraction from a later sample.
Thus, if baseline subtraction is switched on for a
following sample, the baseline chromatogram
may be subtracted before the integration.

Unknown The sample should be analyzed (as unknown
sample).

Standard The sample is a calibration standard. The
corresponding ⇒Amount values of the single
peaks are listed in the corresponding Amount
Table column.
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Validate Validation samples are treated as ordinary
analyses (I), the type, however, is written to the
result file. The validation sample points to the
amount column in the subordinated peak table.
The amount column pointed to by such a
validation sample contains the required amount
or concentration for each peak of the sample. It
can be compared in the report with the calculated
actual amount or concentration. For this purpose,
the Amnt. Diff. (amount difference) and Rel.
Amnt. Diff. (relative amount difference) peak
variables are available.

Matrix Contrary to blank run samples, Matrix Blank
Samples are analyzed indeed. The Dionex
Chromatography Management System
automatically subtracts the peak areas (or peak
heights, respectively) of the matrix blind sample
from the corresponding peak areas (peak
heights) of all samples in the sequence. The
resulting areas (heights) are then used for all
other calculations (e.g. calibration).

 Note:

Thus, matrix blank samples are treated differently
from "normal" !Blank Run Samples for which the
chromatogram is subtracted point by point from
that of the current sample.

 Tip:

Matrix blank samples are subtracted only if they
are evaluated in the same QNT method.
Otherwise, they will not be taken into account.
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Weight (Sample Weight)
Type: Floating point value
Dimension: ---
Value Range: 0.0001 ... 999 999.9999
Default: 1.0000
Related Param.: ⇒Dil. Factor (dilution factor)

⇒Inj. Vol. (injection volume)

Description: The ⇒Sample Variable Weight has two
functions. It serves to enter the sample weight but
it can also be used as a weight correction factor.

1. Sample Weight: Enter the sample weight to
calculate the content - normalized to the
basic unit - of a substance in a sample

Should, for example, the calculated
concentrations always be valid for 1 mg of a
sample, the actual weight is entered, e.g.
124.08 mg. The Dionex Chromatography
Management System will then divide all
calculated concentrations by 124.08.

2. Weight Correction Factor: If you wish to
relate the concentrations to be calculated to a
specific concentration, enter the
corresponding correction factor as Sample
Weight.
If, for example, 4.16 mg were weighed
instead of 4.0 mg, you must enter 1.04 (not
4.16!) here. This procedure is called
approximate exact weighting.

Function: Sample Weight is implemented as a multiplication
factor in the !Formula for Amount Calculation of
not explicitly entered amount values (dilution
series). It is dimensionless.
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Program
The control program or in short program is part of the PGM file and is
displayed in the Commands view of the PGM Editor. It contains instrument
commands and definitions for chromatographic sample processing. A control
file for !Mass Spectrometers additionally includes the device settings for the
MS. The control file has the extension PGM and contains a chronological list of
instructions (commands) for the chromatography modules or the data system
itself (e.g. End). The commands are executed in the chronological order.

Creating the basic structure of a PGM file is facilitated by the  Program
Wizard. You may further edit this basic structure via double clicking the PGM
file in the Browser. The Commands view of the  PGM Editor (Basic
Operations section) opens:
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A control command contains, first, a time value at which the command should
be executed. This value is in industry minutes, i.e., "2.500" indicates the time "2
minutes, 30 seconds". Following the time value is the actual program
instruction (e.g. ⇒AcqOn/Off).

You cannot only integrate control commands into a program but also perform
them separately either via the online toolbar or via command buttons in the
control panels.

Should the program instruction require the input of parameters, these are
entered next in the text line. A comma separates them from instructions.
Should several parameters be required, these are specified in the following
lines. Each parameter is identified by its parameter name, followed by "=" and
then the parameter value. Example:
2.500 Pressure.LowerLimit = 10

Pressure.UpperLimit = 250

Between instruction lines, you may also include any number of comment
lines. Simply enter a semicolon to commence the line. When a program file is
sorted, comment lines are always assigned to the next following instruction line
that allows you to explain individual instructions in detail. You may as well
include comments at the end of a program instruction. Simply place a
semicolon after the last parameter and add the comment.

 Note: The injection time, i.e. the time of the Inject command, has, by
definition, the time 0 (zero). All preceding commands are
assigned negative times, all following instructions positive times.

The advantage is that the PGM time corresponds to the retention time of data
reduction, e.g. integration, and thus avoids errors such as falsely interpreted
gradient profiles. The times of the AcqOn and AcqOff commands similarly
coincide with the time axis of the reduction method.

When processing a program file with the program editor of the Dionex
Chromatography Management System, checking the validity of instructions is
automatic. You must only enter the commands and their respective
parameters: The Dionex Chromatography Management System takes care of
the rest, i.e.:

Chronological sorting of lines (use the Control command Sort by Retention
Time)
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Examination of input validity (use the Control command Check), e.g.:
• Does the file contain at least one ⇒Inject command?

• Is the first Inject command at time 0.000?

• Does the file contain at least one Acquisition On command after the first
inject (warning)?

• Is a corresponding Acquisition Off present for each Acquisition On
(compulsory)?

• Are total and partial flow rates set at the beginning of the file (required for
clearly defined gradients)?

• Are the execution times of preceding instructions considered in the start
times of program instructions (otherwise the start times in the program file
does not coincide with the actual start time)?

• Is the final instruction an end command?

When creating program files with a word processor, you must carry out these
checks yourself. It is particularly important to remember that the first line of the
file is always interpreted as the header. If no header is required, you must
leave a blank line at the beginning of the file.

Operation of the PGM Editor
The PGM editor includes three different views that are opened via the
respective icons in the left PGM editor section:
• Commands

• Finnigan AQA (with PGM files for a timebase with MS only)

• Post-acquisition steps

Below please find a description of the Commands view where you can enter
individual control commands. For details on the Finnigan AQQ view, see How
to �: Actions Related to the aQa-MS  Creating a Method for the aQa-
MS.

To assist editing control commands, a dialog box is available, which is opened
via F8 or Command in the Control menu. This box allows the individual entry
of all instruction components (time, instruction, instrument, parameter,
comment). All available instructions and instruments (depending on system
configuration) are listed for simple selection.
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Before starting a program, a Ready Check is performed. The program is
checked (as far as possible) for validity. In case of logical errors (e.g., for the
pressure limits command, the lower limit has to be greater than the upper
limit) the program cannot start and a message will pop up, such as:

In case of errors, which may affect the course of the program without being
critical, a warning is shown. Nevertheless, you may start the batch:
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During program file generation, the Control command Sort by Retention
Time can be used to chronologically sort all entries. Therefore, it is possible to
simultaneously enter all commands pertinent to a specific instrument (e.g. all
flow commands, all signal parameters, etc.) and have them sorted according to
time later.

For detailed information, see How to: Actions in the PGM Editor:

 Control Program
 Program Syntax

 Note: The command syntax is different from the syntax used by the
GynkoSoft Data System. When importing a GynkoSoft PGM
file, its syntax will be adapted automatically to the syntax
used by the Dionex Chromatography Management System.
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Control Commands (Overview)
Control Commands

On the following pages, the most important control commands are described,
together with their corresponding parameters. Which commands and
parameters are actually available, depends on the individual installation. For
example, if a simple UV detector is installed, it is not possible to record a 3D-
field.

 Tip: An extensive explanation of all existing commands for all
devices, which may be controlled, is far beyond the scope of
this reference manual. About 100 commands available just
for the hP6890 GC!

In the following topics, commands concerning various devices are explained
exemplarily:

⇒General Commands

⇒System Commands

⇒Pump Commands

⇒Autosampler Commands

⇒Detector Commands

General Commands
The following general commands are available regardless of the installed
devices
⇒Branch
⇒Delay
⇒End
⇒EndTrigger
⇒Log
⇒Message
⇒Protocol
⇒Trigger
⇒Wait
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System Commands
System control comprises all commands that concern the entire
chromatographic process or the entire system. They are partly available via
both the online toolbar and the context menu. The most important system
commands are:
⇒Abort Batch
⇒AbortSample
⇒Acquisition On/Off
⇒Continue
⇒Hold
⇒Sound
⇒StopFlow

Also, see  System Commands.

Pump Commands
For the most important pump commands, see the topics:

⇒%A, %B, %C, %D
⇒Connect/Disconnect
⇒Flow
⇒Pressure Limits

Autosampler Commands
For the most important autosampler commands, see the topics:

⇒Connect/Disconnect
⇒Dispense
⇒Draw
⇒Inject
⇒NeedleUp
⇒Position
⇒Reset
⇒Relay On/Off
⇒Temperature
⇒Volume
⇒Wash
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Detector Commands
For the most important detector commands, see the topics:

⇒AcqOn/Off
⇒Autozero
⇒Average
⇒Bandwidth
⇒Bunch Width
⇒Connect/Disconnect
⇒Lamp on/off
⇒Reference Bandwidth
⇒Reference Wavelength
⇒Step
⇒Wavelength
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%B, %C, %D (Partial Flows)
Instrument Type: Pump(s)
Related Comm.: ⇒Flow

Description: The amount information for the partial flow is
stated in percent of the flow rate. The total sum of
all partial flows is 100%
(%A+%B+%C+%D=100%), wherein %A is
calculated from the remaining partial flows
(%A=100%-(%B+%C+%D)). It is therefore
sufficient to determine the values for %B, %C,
and %D.

Changing the % ratio during the analysis is
referred to as !%-Gradient.

%B, %C, and %D define the partial flow rates of
the individual pumps in a high pressure mixing
system (as %-values of flow), or the partial flow
rates on the suction side of a low pressure mixing
system. The latter generally refers to a single
pump or a separate mixing vessel with controlled
proportioning valves. The formation of %-
gradients is by the same principle as for Flow.

For each !Timebase, one or more fluidic
systems can be installed. They can be controlled
independently, either manually or via a
!Program.

In case a second fluidic system is installed, the
corresponding device name has to be specified in
the program. Use the F8 key or the Program
Wizard to insert the device name automatically.

 Tip: The ⇒Hold, ⇒Continue, and ⇒StopFlow
commands are always effective for all fluidic
systems!

Function: The partial flow rates of B, C, and D change
linearly with time between two respective %B,
%C, or %D commands. By entering two percent
commands at the same time, even step gradients
can be programmed.
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Function (Cont'd): When sorting, the editor does not change the
order of commands having the same program
time! If the partial flow rates are to remain
constant during analysis (i.e. isocratic), the
appropriate %B, %C, and/or %D commands need
only be entered at the beginning of the file.
-2.000 Flow = 1.000

         %B = 20.0

...  ...

 0.000 Inject

 0.500 %B = 20.0

       %B = 40.0

...  ...

 8.500 %B.Value = 80.0

 8.500 End

In this example, the total flow rate remains
constant at 1.0 ml/min. %B also remains
constant, at 20% from -2.0 to 0.5 min, then
increasing abruptly to 40%, then linearly to 80%
with a gradient of 5%/min/min.

Parameter:

Value Percent value [%]

 Tips: The Dionex Chromatography Management
System is able to run flow and %-gradients
simultaneously. However, in high pressure mixing
systems, this results in non-linear partial flow rate
changes for each individual pump.

Note that due to compressibility and dead volume
considerations, high pressure and low-pressure
applications are not always interchangeable!

The %-values remain constant from the last %-
command to the end of the program. Thus, for
isocratic operation, a single %-entry at the
beginning of the file is sufficient.

The first %-command (%B, %C, or %D) must be
at the beginning of the PGM file immediately
following the Flow command!
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AbortBatch
Instrument Type: System command
Related Comm.: ⇒AbortSample

Description: The Abort Batch command aborts a running
sample batch. In combination with the ⇒Trigger
command, this command offers a possibility to
react, for instance, to external errors. Example:

0.000 Trigger Cond=RemErr

Abort Batch

EndTrigger

Function: Abort batch terminates data acquisition, deletes
all triggers, and aborts the current sample batch.
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AbortSample
Instrument Type: System command
Related Comm.: ⇒AbortBatch

Description: The Abort Sample command interrupts data
acquisition and aborts a running sample.

Function: The batch continues with the next sample.

Use this command e.g., if, by mistake, no
injection was made for a sample.
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AcqOn/Off (Data Acquisition On/Off)
Instrument Type: System command, all detectors
Related Comm.: ⇒Inject

Description: The AcqOn/Off command activates/deactivates
data recording (!Raw Data) for the selected
!Signal (= channel) of a timebase. Each signal
(or channel) is stored in a separate file. The type
of data from each signal is determined via signal
parameters.

Function: To reduce raw data storage requirements,
AcqOn can be given some time after the Inject
command. However, it should be given at least
30 seconds before the elution of the first peak, as
the Dionex Chromatography Management
System requires a baseline segment of several
seconds in order to perform a noise analysis for
the auto-optimized ⇒Step and !Sampling Rate
functions.

The command can be given manually via the
menu command, or automatically via the
!Program.

⇒Trigger commands whose conditions depend
on signal values or their slope are effective during
data acquisition, only.

Tip: The parameters defined in the program (e.g.
⇒Step, ⇒Average) can be changed at any time.
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Tip (cont'd): For clarity, however, we recommend to use to the
following command sequence:
-2.000 Flow = 1.000

 ...  ...

 0.000 Inject

 0.500 UV_VIS_1.AcqOn

 ...  ...

 3.270 UV_VIS_1.Wavelength = 275

 ...  ...

12.000 UV_VIS_1.AcqOff

13.500 End

The parameters of the 3DFIELD signal may
not be altered between AcqOn and AcqOff.

Raw data acquisition is interrupted via the ⇒Hold
and ⇒StopFlow commands. The ⇒Continue
command is used to resume acquisition. To
terminate raw data acquisition, choose the
AcqOff command.
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Autozero
Instrument Type: All detectors
Related Comm.: ---
Description: The Autozero command resets physical or

!Virtual Signals to zero.

Function: The subsequently measured data is interpreted
and displayed in relation to the new zero point. In
the chromatogram, this can be recognized by a
sharp increase of the absorption value.

This command applies to all signals delivered
from a single detector. Thus, autozeroing a diode
array detector (e.g. Dionex UVD 340) causes
the entire 3DFIELD to be zeroed. Autozero
applies to one detector only! When several
detectors are present in a system (e.g. in series),
they must be autozeroed individually.

Tip: After an autozero, usually a jump is observed in
the baseline. Therefore, we recommend that
autozero is carried out before data acquisition,
unless this is specifically required during the
analysis, e.g. after wavelength switching.

If a wavelength switch has been triggered, an
autozero should also be ⇒triggered to follow!
Example:
0.000 Inject

0.100 Trigger SwitchWave UV_VIS_1 >
20

UV_VIS_1.Wavelength = 280

Autozero

EndTrigger

0.500 UV_VIS_1.AcqOn
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Average
Instrument Type: Detector
Default: ON
Related Comm.: ⇒Step

Description: The Average parameter allows averaging
signals. This is possible for digital signals the
detector sends to the server PC (as with the
Dionex Detectors UVD 170S and UVD 340S) as
well as for analog signals recorded via the A/D
Converter.
The Dionex A/D converter records each analog
signal with a frequency of 100 Hz. This
corresponds to a ⇒Step of 0.01 second or a
!Sampling Rate of 100 data points per second.
When increasing the step or decreasing the
sampling rate, less data points are stored than
theoretically possible.

Function: When activating the Average signal parameter,
the data points between the stored values are
considered as well. The Dionex Chromatography
Management System averages all measuring
values that are within a step interval. The
calculated average is stored in the !Raw Data
file. This generally improves the !Signal to Noise
Ratio (using the Average parameter,
chromatograms look smoother when there are
noisy signals). This parameter has no influence
on the precision of the integration.

 Tip: Averaging is always performed in a 3D-field.
For almost all detectors, concentration is
proportional to peak-area (i.e. integral of the
signal over time). A local (time) signal averaging,
therefore, does not influence quantitative
determination.
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Bandwidth
Instrument Type: Detector
Type: integer
Value Range: detector-dependent
Default: 0 [nm]
Related Comm.: ⇒Wavelength

⇒Reference Bandwidth

⇒BunchWidth

Description: Specifies the optical bandwidth in nm with which
the chromatogram is recorded. In general, this
corresponds to the !Optical Resolution of a
detector.

Function: The bandwidth can be simulated, i.e. increased,
by averaging several single photodiode signals.
This process is known as Photodiode
Bunching. Averaging is performed symmetrically
to the selected wavelength. Thus, at a bandwidth
of 30 nm and a wavelength of 255 nm, the signals
of all photodiodes in the range of 240 to 270 nm
are averaged.

Tip: In versions of the Dionex Chromatography
Management System without control option, the
bandwidth cannot be modified during data
acquisition.

Changing the bandwidth can often lead to an
increase in sensitivity. Quadrupling the bandwidth
halves the noise. However, normally the linearity
decreases.
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Branch
Instrument Type: Processed in PC
Related Comm.: ---

Description: In the current !Program, use the Branch
command to branch into a different program or to
start a program via a command button from the
!Control Panel. Combing this command, e.g.,
with the ⇒Trigger Commands allows defining
dynamic program runs.

Function: If a Branch command is given while a program is
running, it stops executing the current control file
and continues with the newly selected control file.
The times used in this file are automatically
corrected by the program time that already
passed.

Example1 (within a program):
0.000 Trigger       Pressure > 300

      Branch       "Overpressure"

      EndTrigger

If the pressure is higher than 300 (bar), the
program Overpressure will be started in this
example. With the Overpressure program you
may slow down the flow, switch off the lamp, and
deliver the ⇒Message that the pressure within
the system was too high and thus, the flow has
been slowed down.

 Tip: In example 1 the program to be
started via the Branch command
has to be stored within the sequence
to be started. Otherwise, the location
has to be included within the
program, using slashes to separate
the different levels, as with the
command button.
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Function (cont'd): Example 2 (as Command Button within a Control
Panel):

Add a Command Button in the Control Panel
(see How to ...: Actions in the Control Panel

 Creating a Command Button) and branch
from there using the corresponding command in
the chosen program.
Branch
"CM_Seminar/Programs/Equilibration"

Via this button, you could start the column
equilibration program that is stored in the
CM_Seminar !Datasource in the Programs
directory.

Parameter:

Program Name of the program file used for further
processing

Tip: When making a backup of a sequence, all PGM
files that are included in the sequence are also
saved. If PGM files, which are pointed to in a
Branch command, shall be saved as well, these
PGM files need to be included in the sequence.
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Bunch Width
Instrument Type: Detector
Type: Fixed point value
Value Range: 1.9 ... 197.6 [nm]
Default: 1.9 [nm]
Related Comm.: ⇒Bandwidth

Description: To enhance the !Signal to Noise Ratio of a
!Photodiode Array Detector the signals of
several photodiodes can be averaged (or
bunched). Bunch Width describes the
⇒Bandwidth of a bunch of photodiodes.

Function: The Bunch Width is closely connected to the
bunch factor, which refers to the number of
photodiode signals of a UV/VIS detector that are
averaged.

If a detector, for example, has 80 photodiodes
distributed on a wavelength range of 160nm, the
(theoretical) optical resolution is 2 nm. With a
bunch factor of 4, 80 : 4 = 20 photodiodes are
averaged to one signal. The theoretical
bandwidth is now reduced to 160 : 20 = 8 [nm].

Tip: Averaging the signals improves the signal-to-
noise ratio. At the same time, however, !Optical
Resolution decreases.
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Connect/Disconnect
Instrument Type: All
Related Comm.: ---
Description: Perform the Connect Device command to

connect a device with the server to enable remote
control.

Execute the Disconnect command to separate a
user PC (client) from a timebase or to operate an
instrument locally.

Functions:

Connect The command checks whether the specified
device is actually connected, and then activates
the instrument. For all installed instruments, the
Connect command is executed automatically
when server of the Dionex Chromatography
Management System is started. Thus, if working
in remote operation mode only, you do not need
to explicitly issue this command.

When the connect command is activated, the
corresponding instrument may now be remotely
operated from the PC. On most instruments (e.g.
all Dionex instruments) the instrument keyboard
is now locked for safety (and !GLP) reasons, i.e.,
the instrument can be operated remotely, only.
This is to ensure that the selected settings are
kept. Input on the instrument itself is possible
again after the Disconnect command.

Disconnect The corresponding instrument is reverted to local
operation mode and the keyboard is unlocked
again. The instrument is no longer monitored by
the data system, nor can it be operated via the
data system.

Tip: Connect and Disconnect should only be used in
interactive (online) mode and not within a
!Program. Otherwise, the !Ready Check may
not be valid.



Control Commands 931

Continue
Instrument Type: System command
Related Comm.: ⇒StopFlow

⇒Hold

Description: The Continue command cancels the Hold and
StopFlow commands.

Function: An interrupted sample !Batch is continued in the
same way as is an interrupted pump flow.
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Delay
Instrument Type: All
Related Comm.: ⇒Trigger

Description: Delays the execution of the following commands
for the given time.

Tip: Usually, Delay is used for Trigger commands,
only. Example:
Trigger PEAK UV_VIS_1 > 20

Delay 5.0

Sound Frequency = 440, Duration = 1

EndTrigger
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Dispense
Instrument Type: !Autosampler

Related Comm.: ⇒Inject

⇒Draw

Description: The Dispense command causes the autosampler
to dispense a specific quantity (volume) from the
sample loop into a certain sample vial
(⇒Position). The amount of time the sampler may
take for this operation is determined via the
!Duration parameter.

When the operation is completed, the
autosampler sends the signal Sampler.Ready
(for the ASI-100/ASI-100T sampler, !Sucked for
the GINA 50/GINA 160 samplers) back to the
data system. The time interval between the
Dispense command and the Sampler.Ready
response signal can vary depending on the
instrument (ASI-100/GINA 50).

Parameters:

Position Sample position

Volume Sample volume

Duration This parameter indicates the minimum time
required by the sampler for the respective
operation.

Tips: For highly viscous liquids, more time must be
allowed for the autosampler to dispense the exact
volume.

In manual operation, the commands are selected
via the control pull-down of the unit window.
When entering the commands to a !Program,
the three parameters need not to be specified.
During execution of a PGM file, the missing
parameters are replaced by the current sample
position, the current inject volume, and by the
value 0 (if there is no duration), respectively.
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Draw
Instrument Type: !Autosampler

Related Comm.: ⇒Inject

⇒Dispense

Description: The Draw command (Draw for the ASI-100/ASI-
100T, Suck for the GINA 50/GINA 160) induces
the autosampler to draw a specific ⇒Inj. Vol.
(injection volume) from a certain sample vial
(⇒Pos. (Sample position)). The amount of time
this operation is allowed to take is determined via
the !Duration parameter.

Function: When the operation is completed, the
autosampler sends the Sampler.Ready signal
(for the ASI-100/ASI-100T sampler, !Sucked for
the GINA 50/GINA 160 samplers) back to the
data system. The time interval between the Draw
(or Suck) command and the Sampler.Ready (or
Sucked) response can vary depending on the
instrument type.

Example:

Via the command sequence
-1.000 Draw Volume=10

Wait Sampler.Ready

Dispense Pos=1, Volume=10

10 µl from the current sample are transported to
the vial 1. Dispense is carried out only after the
draw process has been completed.

Parameters:

Position Sample position

Volume Sample volume

Duration This parameter indicates the minimum time
required by the sampler for the respective
operation.
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 Tip: For highly viscous or low-boiling liquids, more
time must be allowed for the autosampler to draw
the exact volume without bubbles.

In manual operation, the commands are selected
via the control pull-down of the unit window.
When entering the commands to a !Program,
the three parameters need not to be specified.
During execution of a program, the missing
parameters are replaced by the current sample
position, the current inject volume, and by the
value 0 (if there is no !Duration), respectively.
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End
Instrument Type: System Command
Related Comm.: ⇒EndTrigger

Description: Marks the end of a program.
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EndTrigger
Instrument Type: System Command
Related Comm.: ⇒Trigger

Description: Marks the end of a block of triggered commands.

Function: All commands between Trigger and EndTrigger
are executed when the trigger condition becomes
true.

Tip: Define the Trigger identified by its name with the
new condition �0" and mark the end of this trigger
block with the EndTrigger command to finish an
active Trigger.
Time Trigger Name 0

EndTrigger

This is necessary for each trigger separately. It is
not possible to finish all triggers together.
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Equate
Instrument Type: Processed in PC
Related Comm.: ⇒%A, %B, %C, %D

Description: Equate is used to assign different designations to
the three partial flows of the fluidics, %A, %B,
%C, and %D. Example:
 0.000 %A.Equate = "Water"

 0.000 %B.Equate = "MeOH"

 0.000 %C.Equate = "ACN"

Function: In the unit windows, you can assign the partial
flows the actual eluent names. The equate
commands are logged in the audit trail. This to
keep track of the chromatographic conditions at
any time. Consider that a PGM file which contains
equate commands may itself serve as a protocol!

Tip: It is up to the user to check the consistency of
%A, %B, %C, and %D with the eluents actually
used!
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Flow (Flow Rate)
Instrument Type: Pump
Related Comm.: %B, %C, %D
Description: Defines the total flow rate (in [ml/min]) through

the column, i.e., the sum of ⇒Partial Flows
(%A+%B+%C+%D=100%). The value entered
represents the current value. For isocratic
systems, this value remains constant during the
program. In flow-gradient systems, this value
represents an interpolation point of a polygonal
line to which the previous and following flow
values are adjoined by straight lines.

Function: The total flow rate alters linearly with time,
between two flow commands. By entering two
flow commands at the same time, even step
gradients can be programmed. When sorting, the
editor does not change the order of commands
having the same program time! If the flow is to
remain constant for the entire analysis, a single
entry at the beginning of the !Program is
sufficient.
-2.000 Flow= 0.500
 ... ...
 0.000 Inject
 0.500 Flow= 0.500
 0.500 Flow= 1.000
 ...  ...
 8.500 Flow= 5.000
 8.500 End

In this example, the flow rate remains constant at
0.5 ml/min between -2.0 and 0.5 min. Then it
increases abruptly to 1.0 ml/min and then linearly
to 5 ml/min with a gradient of 0.5 ml/min.
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Function (Cont'd): In case a second fluidic system is installed within
the same !Timebase, the corresponding device
name has to be specified in the program. By
using the F8 key for generating command lines,
the device name is inserted automatically.

Tip: The ⇒Hold, ⇒Continue, and
⇒StopFlow commands are always
effective for both fluidic systems!

Tip: The Dionex Chromatography Management
System is able to run flow and %-gradients
simultaneously. However, in high pressure mixing
systems this results in non-linear partial flow rate
changes for each individual pump.

As there are pressures up to 400 bars in the
chromatography column and as solvent mixtures
are subject to volume compression (e.g.
methanol/water), the delivered volume in !High-
Pressure Gradient Systems does not correspond
to the volume transported via the column.
However, the number of delivered and
transported solvent particles is not changed by
this fact.

The flow rate remains constant from the last flow
command to the end of the program. Thus, for
isocratic operation, a single flow entry at the
beginning of the file is sufficient.

The first flow command must be at the beginning
of the PGM file!

Normal flow rates are in the range 0.5 to
10 ml/min. Flow rates deviating from this range
are achieved by using special micro pumps (0.1 -
0.5 ml/min) or preparative pumps (as from
10 ml/min).
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Hold
Instrument Type: System command
Related Comm.: ⇒StopFlow

⇒Continue

Description: The Hold command
• Stops !Data Acquisition

• Interrupts a running !Gradient program

• Stops automatic !Batch Processing

Function: In the Hold mode, no data is acquired, the pump
continues delivery with the current solvent
composition, and evaluation of the batch samples
is stopped.

Tip: All processes can be completely aborted via the
StopFlow command or continued with the
Continue command.
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Inject
Instrument Type: !Autosampler

Related Comm.: ⇒AcqOn

⇒Draw

⇒Dispense

Description: Defines the beginning of a chromatogram, i.e.,
determines the time at which the sample enters
the high-pressure system. Thus, the time of the
first inject command is 0 by definition. The
advantage is that the ⇒Retention Time, as
appearing in chromatograms and reports,
coincides with program execution times. All
commands before inject, are assigned negative
execution times.

Between the Inject command and the actual
injection process (Inject response by the sampler
or the hand-operated valve), a system-dependent
interval is required for reaching the rack and to
draw the sample. During this time, the pump is
kept in the ⇒Hold state (i.e., a possibly running
gradient is stopped). This Inject Wait state is
canceled only by an Inject Response signal. The
response signal is delivered either automatically
(via an interface) or via a remote input signal.
Only from this point, time keeping is started.

Function: The function is dependent on the individual
installation. For manual injection, the Dionex
Chromatography Management System simply
holds the analysis time and waits for inject
response. For a controlled autosampler, the inject
command (at least) is relayed to this. For
autosamplers with variable injection volumes
and random sample access (e.g. ASI-100), the
inject volume and vial position are relayed as
well. Such autosamplers are ideal for automated
multipoint calibration.
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Function (Cont'd): For interactive operation (online) of the inject
command, the Sample Position and Inject
Volume parameters must be entered as well.
During automated batch operation, these
values are read from the sequence. Thus,
parameters do not have to be set individually in
the !Program.

Parameters: (When a hand-operated valve is used for
injection, this information can be used for
documentation purposes.)

Position Vial ⇒Position in the autosampler

Inject Volume Injection ⇒Volume in µl

Blank Specifies whether !Blank Run Samples are
actually injected:

Skip: no injection

Inject: Injection is performed.

Tip: Data acquisition (⇒AcqOn/Off) should be started
after the Inject signal, at least 30 seconds before
the first peak. Also, there should be !Isocratic
conditions during the injection process.

A program should only contain one inject
command.
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Lamp On/Off
Instrument Type: All optical detectors
Related Comm.: ---
Description: This command switches the lamp of an optical

detector on and off. UV/VIS detectors often have
a separate lamp  (deuterium/halogen) for each
range. Then, the commands are as follows:
UV_Lamp = On/off and Visible_Lamp = On/Off.

Function: The lamp is switched on or off.

Tip: Practically all optical detectors require a
considerable warm-up period for high sensitivity,
drift-free operation. The inject command should,
therefore, be placed several minutes (minimum)
after this command. Note also that lamp(s) should
never be switched off during a sample batch. It is
common practice is many laboratories to operate
detectors 24 hours a day with the lamp being
switched on.

Detector lamps are subject to aging. Do not use
the LampIntensity variable, e.g., to receive the
value of the current lamp intensity at 254 nm via
the ⇒Log command. If a value was measured
when the lamp was new, the value indicates how
much the intensity decreased since then.
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Log
Instrument Type: Processed in PC
Related Comm.: ⇒Message

⇒Protocol

Description: The Log command allows you to document the
values of variables in the !Audit Trail at any time.

Function: This option is especially useful to log information
that is not periodically retrieved.

If, for example, the pressure at the time t = 5.000
min during sample processing should be logged,
include the following line in the  Control
Program:

5.000 Log Pressure.Value

In the example mentioned above, the current
pressure will be logged. In exceptions, the Log
command is sent directly by the device driver
(e.g. fraction collector).
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Message
Instrument Type: Processed in PC
Related Comm.: ⇒Wait

⇒Protocol
⇒Log

Description: During execution of the program, a message
pops up on the screen that is to be acknowledged
by the user with Ok. Only then the program is
continued.

The Message command allows the user to enter
reminders for things to do or to consider while
executing a !Program.

Function: When executing the program, a window
containing the respective message text is
displayed. The program is interrupted until the
user acknowledges the message. Besides, the
command and the message are written to the
Audit Trail.
If, for example, a user should be reminded to
check and, if necessary, refill eluents prior to the
analysis, the following command can be included
in the program:
-1.000 Message "Check eluent
containers!"

When executing the program, the text in
quotation marks is displayed on the user's screen
at the specified time (in the above example one
minute prior to injection). Simultaneously, the
command and the message are included in the
Audit Trail. The server is then in Hold mode.
During this time, the monitor icon indicates this
status by its yellow/red coloring.
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Function (cont'd): If the Dionex Chromatography Management
System is operated in a network, the message
appears on the client that currently has control
privileges.
The program continues operating as soon as the
message is confirmed!

Parameter:

Text The message to be displayed.

Tip: For as long as the message dialog box is
displayed on the screen, the time is interrupted,
the flow conditions are in Hold mode.
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NeedleUp
Instrument Type: !Autosampler

Related Comm.: ⇒Wash

Value Range: Depends on device and installed syringe
Description: The NeedleUp command enables lifting the

sample needle.

Function: Then the internal sample valve is switched (see
the example for a load/inject process in the
Autosampler).

When lifting the needle, a running ⇒Wash
process is automatically interrupted, i.e., the
solvent flow is not through the sample loop but
directly from the pump onto the column. Use the
Load command to perform the same operation
without moving the needle up.

 Tip: Use the Wash and NeedleUp commands to
prevent crystallization of substances (e.g. buffers)
by washing the sample loop.
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Position
Instrument Type: !Autosampler

Related Comm.: ⇒Inject

⇒Volume

Value Range: Depends on device and installed carrier
segment

Description: Specifies the position of the vial from which a
sample shall be injected.

Function: If you use a controllable autosampler, the entered
position is transmitted automatically to the
sampler. The sampler approaches the
corresponding sample for injection. If using a
non-controlled autosampler or a hand-operated
valve, this column only serves for documentation
purposes. If the sample position parameter is not
entered, the previous (current) value is used.



950 Control Commands

Pressure Limits
Instrument Type: Pump
Related Comm.: ⇒Flow

Description: Define the pressure limits within which the
pump(s) is permitted to operate.

Function: Should the pressure go beyond a set limit, the
Dionex Chromatography Management System
turns off the flow, displays an error message,
and terminates the current sample batch.

Parameters: (The values that can be entered depend on the
pump type.)

Lower Limit Lower pressure limit in Bar.
Upper Limit Upper pressure limit in Bar.

Tip: Pressure limits apply to all connected pumps on
the high-pressure side.

Exceeding the upper pressure limit can be due to
a blocked column or capillary or to a defective
injection valve.

If the pressure is below the lower limit, this is
usually due to a leak in the fluidic system.
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Protocol
Instrument Type: Processed in PC
Related Comm.: ⇒Message

⇒Log

Description: Writes a comment to the audit trail (without
screen message). Thus, program steps can be
additionally commented or chromatographic
conditions can be written to the audit trail (PGM
comments are not written to the audit trail).
-2.000 Protocol "Separation
according to DFG-method, residue
analysis"

-2.000 Protocol "0.05 M
Natriumdihydrogenephosphate buffer"

-2.000 Protocol "Column: LiChrospher
RP-18"

Function: Unlike simple green comments starting with a
semicolon, which are only part of the program,
the Protocol text is included in the Audit Trail and
is thus directly linked with the corresponding
sample. The Protocol text can thus be used for
commenting individual samples. The program run
is not affected by a Protocol command.

Parameter:

Text The text that is written to the audit trail.

Tip: Event-controlled execution of the command is
also possible. Example:
0.000 Trigger Protocol UV_VIS_1 > 1000

Protocol "Valid absorption
range exceeded"

EndTrigger
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RefBandwidth (Reference Bandwidth)
Type: Integer
Value Range: Detector-dependent
Default: 0 [nm]
Related Comm.: ⇒Reference Wavelength

⇒Bandwidth

Description: The reference bandwidth can be selected
separately for each channel. The 3D-field of a
photodiode array detector also has its own
reference bandwidth.

Analogous to the conventional bandwidth of a
channel, the reference bandwidth serves to
average several photodiode signals of the
Reference Wavelength.

Function: For example, if the reference wavelength is
350 nm and the reference bandwidth is 5 nm,
wavelengths in the range of 348 - 352 nm are
averaged and used as the reference.

Tip: For UVD 160S/320S and UVD 170S/340S
detectors, alter the reference bandwidth only if
the reference wavelength cannot be set to
600 nm (i.e., for substances clearly absorbing at
600 nm, especially blue substances). This is the
only case where using a higher bandwidth can
improve the signal to noise ratio.

For PDA-100 detectors and other two-lamp PDA
detectors, select a reference bandwidth that
includes a majority of light from the same lamp as
the sample wavelength. For the PDA-100, the
deuterium lamp provides wavelengths of 190 nm
to 380 nm and the tungsten lamp provides
wavelengths of 380 nm to 800 nm. Select a
reference bandwidth that is narrow enough not to
interfere with nearby compounds and select an
area of the spectrum where the sample does not
absorb.
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RefWavelength (Reference Wavelength)
Instrument Type Detector
Type: Integer
Value Range: Detector-dependent
Default: Off
Related Comm.: ⇒Reference Bandwidth

⇒Wavelength

Description: With Dionex Photodiode Array Detectors, the
reference wavelength is used to correct the
absorption values of the wavelength that has
been selected for the analysis.

Function: If the absorption of the reference wavelength
changes during the analysis, absorption values of
the analysis wavelengths are adjusted up or
down accordingly. The selected reference
wavelength should be in a quiet area of the
spectrum where little absorption occurs. Each
change in the absorption then indicates
substantially changed conditions, for example, a
reduction of the lamp energy (lamp drift). Each
change can be used to correct the absorption in
the remaining wavelength range even during the
analysis (the recorded signal is reduced or
amplified accordingly, as necessary).

Reference wavelengths are especially useful for
gradient analyses because as the light intensity
changes over time (due to the gradient),
absorption values are adjusted, thus minimizing
baseline drift.

Peaks are not detected in the reference
wavelength range where the system is "blind" per
definition. Should peaks be detected,
nevertheless, select a different reference
wavelength. You can deliberately use this as well
to inhibit peaks.
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Function (Cont'd): If the reference wavelength is chosen in a light-
deficient range, it is recommended to average the
signals of several photodiodes by increasing the
Reference Bandwidth and thus improve the signal
to noise ratio.

 Tip: Do not confuse the reference wavelength with the
!Reference Channel used for !Baseline
Correction.

Settings: Details about reference wavelengths vary
depending on the type of detector:

Dionex UVD 160/320S PDA and UVD
170S/340S PDA Detectors
For Dionex UV/PDA Detectors UVD 160S/320S
PDA and UVD 170S/340S PDA, a reference
wavelength of 600nm should be selected
because relatively small absorption values are
observed there. In addition, these Dionex
Detectors have a special noise optimum at this
value. However, when the reference wavelength
is changed, the special noise optimum of the
Dionex detectors no longer applies.

 Tip: Referencing the measured
wavelength range, i.e., verifying
whether the actual nanometer
value corresponds to the
nominal value is via a
!Holmium Oxide Filter
(Spectra Calibration).

Dionex PDA-100 Detector
By default, the reference wavelength is turned off
for the PDA-100. With UV channels (≠ 3D-Field),
the absorption at the first scan after the autozero
is used as a reference. This results in lower noise
but less drift compensation. The
Reference_Wavelength=Off command in a
program or on the control panel turns off the
reference wavelength.



Control Commands 955

Settings (Cont'd): During collection of !3D-Field data, the
absorption after autozero is always used as a
reference (as described above). After data
collection, a reference wavelength can be applied
to the data. The reference wavelength in this
case defaults to the highest wavelength in the
analysis range. For example, if the analysis
wavelength range is 190 - 350 nm, the default
reference wavelength is 350 nm. If you select a
different reference wavelength, the selected
reference must be within in the stored wavelength
range.
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Relay On/Off
Instrument Type: All relays
Related Comm.: ---

Description: Relay-Name.On (Off) closes (opens) a relay
output (closure contact) for a specific instructed
time. Switching valves are treated as relays also.

Function: The specified relay is opened or closed for a
specified time in seconds. Relay-Name.On
opens the relay upon completing a certain period
(!Duration), Relay-Name.Off closes the relay
after completing the duration. If no duration is
specified for Relay-Name.On (Off), the relay
remains closed (open) until the next relay
command is given.

Parameter:

Duration Closure or opening time in seconds [s] (optional).

Tip: Relay On/Off duration for the same relay may not
overlap!
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Reset
Instrument Type: All
Related Comm.: ⇒Autozero

Description: Resets an instrument to its initial conditions, as
attained after power-up, i.e. standby mode.

Function: Activates (in general) a "warm start", i.e. the
instrument regains its initial state as immediately
after power-up. The reset command is particularly
useful when an instrument has been operated
locally, or has an undefined status (to the data
system), e.g. after an instrument fault.

Tip: Activating the reset of an autosampler may
require a considerable time to completion, as
generally this involves a mechanical recalibration
and a complete wash cycle.
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Sound
Instrument Type: Processed in PC
Related Comm.: ---
Description: Sound generates a tone (of selectable frequency)

on the internal loudspeaker of the PC. This may
be used to acoustically monitor the progress of a
program, by setting sound commands at key-
points in the file. Combining this function with the
⇒Trigger command allows, for example, "hearing"
eluting peaks. By selecting different frequencies
for ascending and descending peak flanks, these
can be acoustically distinguished!

Example:
-2.000 Flow =        1.000

-2.000 %B =          50

 0.000 Inject

 0.000 Trigger Up    UV-VIS-1 > 20

       Sound Frequency=440, Duration=1

       EndTrigger

       Trigger Down  UV-VIS-1 < 40

       Sound Frequency=880, Duration=1

       EndTrigger

 0.500 Acquisition On

 ...  ...

 8.000 Acquisition Off

 9.000 Program End
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Function: Sound generates a tone of selectable frequency
and duration on the PC loudspeaker. If the
command cannot be performed due to a missing
sound card, a default sound is generated at the
PC speaker.

Also, see How to ...: Device Control  Trigger
Commands.

Parameters:

File Sound File (normally WAV file)

Frequency In Hertz [Hz] (concert pitch a = 440 Hz

Duration In seconds [sec].
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Step
Instrument Type: Detector
Type: Fixed point value
Value Range: Depending on the channel (e.g. for a UV

channel: 0.01 ... 4.8 [sec] or Auto)
Default: 0.25 s (GC: 0.05 s)

 Note: For uncontrolled GCs: 0.25 s.

Related Comm.: !Data Collection Rate

Description: Determines the time interval between two
consecutive data points within the signal's

 Raw Data file. This value can be fixed or auto
(i.e. variable). A fixed sampling rate is especially
required in the event that the recorded raw data
are to be exported where the recipient program
can only process equidistant data points.

Function: Fixed Step [0.01 .... 4.8 sec]
Every step seconds, a data point is stored in the
export Raw Data file. For example, selecting step
= 0.5 means that 2 data points per second are
acquired and stored. The smaller the step, the
more data points will be recorded per time unit
(regardless whether there is a baseline segment
or a peak).

For the 3D field, step (here 0.1 - 4.0 sec) defines
the data rate with which the connected
!Photodiode Array Detector collects spectra.

The distance between individual data is as
follows: for the Dionex UV Detector = 0.01 s, the
!A/D Converter = 0.01 s; !3D-Field = 0.1 s.
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Function (Cont'd): Automatic Step [auto]
At a variable sampling rate, the last 10 seconds
of a chromatogram are temporarily stored in
system memory with the highest sampling rate.
For each new data point (every 0.01 s), the oldest
data point can be removed.

A complex algorithm allows determining and
storing only those data points in the raw data file
that are actually required. All "unnecessary"
datapoints are filtered out and the chromatogram
is stored almost without a loss in representation
(!).

Depending on whether there are narrow or wide
peaks or a baseline segment, between 0.2 and
100 data points per second are stored as the
result. Thus, the step is automatically varied
between 0.01 and 5 seconds.

Saving raw data with automatic step reduces the
storage requirement up to 75% and thus
increases data processing.

In the Report, you can view the chosen raw data
points via the Raw Data Point option on the
Peak Decoration tab of Decoration in the
context menu.

 Tip: Select the step in such a way that 20 data points
are placed on the narrowest, relevant peak of
your chromatogram. If you acquire more data
points, this will use unnecessary disc capacity
and the integration might become incorrect,
especially with heavier baseline noise.

Use the step Auto for fast peak chromatograms
for which you do not know the width of the
expected peak. For a precise and reproducible
analysis, always use a fixed step (see above).
Especially with heavier baseline noise, using
Auto may result in an incorrect integration.
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StopFlow
Instrument Type: System Command
Related Comm.: ⇒Hold

⇒Flow

⇒Continue

Function: The Stop Flow command switches off the pump
flow; data acquisition is interrupted. A running
batch is stopped, as in the hold mode.

Use the Continue command to undo this
command.
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Temperature
Instrument Type: Column Oven / Autosampler / GC
Related Comm.: ---
Description: Temperature adjusts the required temperature

for a column thermostat, autosampler, or GC.

Function: If the program file contains more than one
Temperature command, you will get a step profile
instead of linear interpolation between two
commands, which is happening with all
temperature commands. In other words: Every
new temperature command drives the thermostat
to the new temperature as fast as possible
(device-dependent). With GCs, the temperature is
changed according to the desired temperature
program.

Parameters:

Value Actual column thermostat temperature

Nominal Required temperature for the column oven.

Upper/LowerLimit Upper/lower limit for the temperature of the
column oven.

Tip: As with all device parameters, the Dionex
Chromatography Management System tries to
display the status on the screen! Whether this is
possible depends on the column oven connected.
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Trigger
Instrument Type: System Command
Related Comm.: ⇒EndTrigger

Description: Executes the command immediately following
once defined conditions are satisfied, e.g. a
defined signal voltage threshold and/or your time
gradients exceeds a specified threshold. The
condition is defined via the Condition parameter.

In the program, the entire Trigger block is
indicated in blue color.

Examples • A typical use for this function is the control of
a !Fraction Collector. If the absorption signal
of a given channel exceeds a threshold value,
a relay is activated, switching to the next
collection vial. Further important applications
are

• Signal-dependent !Wavelength Switches,
e.g. immediately after completion of a peak.
Thus, retention time variations can be
neglected!

• Programs can be ⇒Branched off according to
external conditions, e.g. a digital input or the
value of an analog signal. Thus, the
chromatographic reaction to external
conditions (pressure, conductivity, etc.) can
be flexibly determined.

• Acoustic signals can be generated when
certain conditions become true (⇒Sound).
Thus, your peaks can be made audible!
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Function: The trigger condition is active from the time of the
trigger command and has to be specifically
deactivated. However, signal values are received
only after the ⇒AcqOn command of the program.
The following command is executed every time
the specified conditions are satisfied (flank
triggering), i.e. from each transition from false to
true. Thus, in the previous example, the trigger
condition must be entered only once in the
program; the fraction collector will then be
switched for each new peak.

Trigger commands can only be activated from
programs or programmable buttons but not in the
online control. The following syntax is valid:
Time Trigger NAME Condition, True,
                  Delay, Limit,
Hysteresis

Triggered command 1

Triggered command 2

Triggered command 3

...

EndTrigger     

As a response to a !Trigger condition becoming
true, virtually any instruction can be performed.
Examples:
• AbortBatch

• Acquisition.on/off

• BranchTo

• ⇒Message

• ⇒Protocol

• Relayname.on/off

• Signalname.Parameter

• Sound
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Function (Cont'd): Triggering the flow rate and the solvent
composition is also possible. However, a gradient
will be interrupted, and the analysis will be
continued under isocratic conditions. Yet, you can
use the Branch command to start a new gradient
program.

The inject command cannot be triggered, as it is
linked to t = 0.000 and can be given dependently
from the time.

Even trigger commands can be triggered!

Parameters:

Name The name of the trigger command is obligatory. It
serves for its identification. Therefore, the name
must be unique, i.e., the trigger cannot have the
same name as a device or another command.
Then, several triggers with different names can
be activated simultaneously.

Tip: To be able to find the trigger in an
Audit Trail or a Report, it is
recommended to include the trigger
name in capital letters in the program.

Condition Defines the trigger condition and can have two
forms:

<Parameter><Comparison
Operator><Value> or
<Signal.Delta><Comparison
Operator><Value>

or

<Remote-Input-Name>

<Parameter>
All installed channels, but also parameters such
as Temperature (column temperature), Pressure
(system pressure), Flow (flow rate), and %A,
%B, %C, and %D can be used.
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Condition
     (Cont'd):

<Signal.Delta>
For signals, the first derivative of the parameter
can be evaluated. This is achieved by adding the
signal property !DELTA.
<Comparison Operator>
<, >, =, <=, >= and <>
<Value>
Fixed-point number. The dimension of the
<Value> corresponds to the signal dimension.
Parameters that are combined with DELTA have
the dimension [signal dimension / sec].
<Remote-Input-Name>
is reported from the instrument to the data
system, e.g. Sample.Ready or Leak
If several parameters are to be linked, this can be
realized via mathematical (+, -, *, / , **) or logical
(AND, OR, NOT, XOR) operators. Parenthesis
show combinations and hierarchy, e.g.:
• (UV_VIS_1>100) AND (UV_VIS_2>100)

• (UV_VIS_1+UV_VIS_2)>200

Logical links of entire conditions are also
possible.
• (UV_VIS_1>100) AND NOT (UV_VIS_2>200)

True Validity in seconds. The trigger condition must
be true for this time, to activate the trigger.
Example:
Trigger DIGIN1 Remote1, True=2.0

The input signal must be active for at least 2
seconds to trigger DIGIN1.

The True parameter is also used as a criterion for
the truth of signals, e.g., to differentiate between
true signals and spikes.
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Delay In seconds. Indicates the delay time between
fulfillment of the conditions and execution of the
command, e.g.:
1.220 Trigger SIGNAL UV_VIS_1>20, Delay=5.0

1.220 Relay On FracCol

The FraCol relay is switched 5 seconds after
trigger activation only.

The Delay parameter is usually used for switching
a fraction collector with a time delay. Thus, the
dead volume between the detector and the
fraction collector is taken into account.

If the Delay parameter is used in combination with
the True parameter, the command is executed
only <TRUE> + <DELAY> seconds after the
condition is true.

Limit The upper limit for executing the trigger command.
Without the limit parameter, a trigger command is
carried out any number of times until the trigger off
command is activated. The limit parameter
automatically deletes the trigger after a
corresponding number of activations. Example:
1.220 Trigger BRANCH RemoteIn, Limit=1

      Branch NEWPGM

The trigger command is only carried out once, and
then the trigger is deleted.

Hysteresis To prevent multiple trigger execution with very
noisy signals, each trigger receives the
Hysteresis parameter in addition to the True
parameter.

In contrast to the True parameter, Hysteresis is
not time but signal-dependent. The parameter can
vary between 0 and 100%. The default value is
5%.



Control Commands 969

Hysteresis
     (Cont'd):

A 5 % hysteresis causes, e.g., the condition
Cond = UV_VIS_1 > 20,0

To change from FALSE to TRUE when reaching
the value 20.0, but only changing from TRUE to
FALSE at 19.0. Thus, a difference is made
between signal increases and decreases. This
corresponds to the different paths of a hysteresis
loop.

If the operator < is used instead of >, the
calculation is reversed! For the above example,
this means that the condition
Cond = UV_VIS_1 < 20,0

Becomes TRUE immediately when the value falls
below 20, but is reset from TRUE to FALSE only
at 20 + 5% = 21.

Tips: While acquisition is switched off or interrupted,
signal values cannot be evaluated.

If the True and Delay parameters are used, the
command is switched only <TRUE> + <DELAY>
seconds after the condition becomes true.

End program automatically deactivates all trigger
conditions!

Triggering of the commands Flow, %B, %C, and
%D is restricted to isocratic separations.

Example:

When the trigger condition becomes true, the
following program switches the flow to 0.1 ml/min
and sets %B to 0.
-1.000 Trigger ELUENT UV_VIS_1 > 20

Flow = 0.100
%B.Value = 0.0
EndTrigger

 0.000 Inject
 0.000 UV_VIS_1.AcqOn
 .... ........
15.000 UV_VIS_1.AcqOff
15.000 End
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Volume
Instrument Type: !Autosampler

Related Comm.: ⇒Inject

⇒Position

Value Range: Depends on device and installed syringe
Description: Specifies the injection volume in micro liters (µl).

Function: In automatic operation, the installed !Driver
converts this value into a volume readable by the
autosampler, then the value is sent to the
autosampler.

By entering different injection volumes, a
!Dilution Series can be created in case of a
multiple-point calibration (!Single-Point and
Multiple-Point Calibration).

 Tip: In order to minimize carry-over effects in multiple-
point calibrations, you should always start with
the sample with the highest dilution or the
smallest injection volume.
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Wait
Instrument Type: !Remote Input

Related Comm.: ⇒Message

⇒Inject

⇒AcqOn/Off

Description: The Wait command interrupts program execution
until the specified remote input signal arrives.

Function: Wait stops the program time and the acquisition; the
pump(s) are in hold-mode. For examples for using the
Wait command see How to ...: Device Control:

 Control - Autosampler

 Mixed Commands
Parameter:

Condition Condition for the realization of which the system waits
(see ⇒Trigger)
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Wash
Instrument Type: !Autosampler

Related Comm.: ⇒Inject

⇒NeedleUp

Value Range: Depends on device and installed syringe
Description: The Wash command serves for rinsing the

autosampler.

Function: It causes the autosampler to lower the needle into
the needle seat and to rinse the sample loop and
needle with solvent in the Inject state. This
corresponds to the normal solvent flow following
an Inject command.

 Tip: Use the Wash and NeedleUp commands to
wash the sample loop and thus prevent
crystallization of substances in the sample loop.
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Wavelength
Instrument Type: Detector
Type: Integer
Value Range: Detector-dependent
Default: 0 [nm]
Related Comm.: ⇒Bandwidth

⇒Reference Wavelength

Description: Specifies the wavelength at which the
chromatogram is recorded.

Function: For controlled detectors (e.g. Dionex detectors)
this value is automatically transferred to the
detector (requires control option). The
wavelength can also be entered manually during
the analysis or in the program.

In configurations of the Dionex Chromatography
Management System without control option, the
selected wavelength remains fixed during the
analysis. In controlled versions, the wavelength
can be altered during analysis.
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QNT Editor
The QNT editor allows defining the method of quantification (in short: QNT
Method or just method). The quantification method defines parameters that
identify the peaks within a chromatogram (assign substances - peak
identification) and others that enable the calculation of amount/concentration
from the recorded peak areas (calibration).

Peak Identification
The Dionex Chromatography Management System has two possibilities for
identifying detected peaks, i.e. assignment of substance names.

Generally, peaks are identified by their ⇒Retention Times. If a peak elutes
within a defined time window, it is assigned the corresponding name,
calibration function, etc.

In the event that many peaks are obtained in rapid succession, or their order is
altered by a change in chromatographic conditions (e.g. pH-value),
identification by the UV spectrum or the !Mass Spectrum is considerably
more reliable.

Tip: Peak identification by UV spectra requires use of a !Photodiode
Array Detector (e.g. Dionex UVD 340 or PDA-100) and the
appropriate software configuration.

Mass spectra acquisition requires an aQa !Mass Spectrometer
and the !Xcalibur software in addition to the Dionex
Chromatography Management System software.

Calibration
The peak table contains all information for the calibration. Using the amount
column and the recorded peak areas, the offset, slope, and curve parameters
are calculated.

Tip: With each new calibration the results are recalculated
automatically for the report, as the calibration constants and the
recorded integration values are entered to the peak table by the
integration programs.

To save the user from having to determine the retention time of each peak
manually, peak tables can be generated automatically (see How to ...: Actions
in the QNT Editor  Autogenerating the Peak Table).
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The QNT editor offers the following tabs for parameter input:
• General (general settings)

• Detection (⇒Detection Parameters)

• Peak Table (general peak table)

• Amount Table (parameters to determine the amount)

• Peak Tracking (parameters for peak assignment via UV reference spectra)

• MS Tracking (parameters for peak assignment via !Mass Spectra)

• Calibration
• Spectra Library Screening (spectra search parameters)

• SST (!System Suitability Test (SST) parameters)

• MS (parameters for mass spectra evaluation)

The General tab lists those parameters that apply to all peaks, e.g.
• ⇒Use Recent Retention Time: automatic correction of expected retention

times during calibration runs.

• ⇒(Calibration) Mode: Specification which sample is calibrated using which
standard(s).

• ⇒Dimension of Amounts

The peak table (on the Peak Table, Amount Table, Peak Tracking, and MS
Tracking tabs) lists peak-specific parameters, e.g.
• Expected retention time
• Peak name
• Integration type (area/height)
• Calibration type (linear, exponential, etc.)

The general and the peak table parameters are described below.
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QNT Parameters (Overview)
QNT Parameters

The QNT editor allows you to define general, peak table, and detection
parameters. For a description of the latter ones, see ⇒Detection Parameters
(Overview). For information on the general parameters and the peak table
parameters, see the following topics:

⇒Amount
⇒Calibration Mode
⇒Calibration Type
⇒Check Derivative
⇒Check Extrema
⇒Comment (Peak)
⇒Dead Time
⇒Delay Time
⇒Dimension of Amounts
⇒Group (Peak Group)
⇒Integration Type
⇒Kovats Index
⇒Left/Right Limit
⇒Match Criterion
⇒Maximum/Minimum Wavelength
⇒Name (Peak Name)
⇒Reference Spectrum
⇒Relative Maximum Deviation
⇒Response Factor
⇒Retention Index
⇒Retention Time
⇒Standard
⇒Threshold
⇒Type (Peak Type)
⇒Use Recently Detected Retention Time
⇒Window
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Amount
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Floating point number
Dimension: Determined by the Dimension of Amounts

parameter on the General tab

Value Range: 0.000001 ... 9999999.999999
Default: 1.000000
Related Param.: ⇒Dimension of Amounts

Description: Determines the content (amount, concentration)
of a standard sample or a !Validation Sample of
a particular mixture component. For multi-point
calibration with various standards (i.e. not via the
variation of the injection volume), several values
must be entered for each peak. Thus, a matrix of
standard contents is created, whose lines
correlate to the peaks and the columns to the
various standards.

Function: The amount can be entered either as
concentration value (e.g. µg/µl) or as absolute
amount (e.g. µg). In the report, the result is
displayed accordingly, either as concentration
value or as an absolute amount. Use the
respective inverse function for calculation (see:

 Calculating the Peak Variable Amount).
In absolute amounts, the result always relates to
the injected volume, e.g. 17.6µg per 20µl injection
volume. Use the !Concentration peak result
variable to receive normalization to 1 µl (e.g. 17.6
/ 20 = 0.88 µg/µl) by dividing the absolute value
by the injection volume.

 Tip: If a concentration unit has been
chosen as Dimension of Amount,
the Concentration peak variable
has lost its sense.
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Function (Cont'd): In a single-point calibration, only one standard is
used. This means that there is only one value per
component (peak).

In a "real" multiple-point calibration (!Single-
Point and Multiple-Point Calibration - no variation
of the injection volume), the number of amount
values for each component must correspond
exactly to the number of standards.

 Tip: In a multiple-point calibration, the values of the
Amount columns are corrected by the ratio of the
injection volumes (for which the reference volume
defined on the General tab of the QNT editor is
used) and the dilution factors in comparison to
the first standard. You can thus combine the
amount values with the !Dilution Series!

Even for multi-point calibration normally only one
peak table is required!
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Calibration Mode
Location: Tab General / Report Variable (Peak

Calibration)
Type: Character
Dimension: No dimension
Value Range: Fixed / Total / Group / Additional / Bracketed
Default: Total
Related Param.: ⇒Calibration Type

Description: The calibration mode determines which standards
are used for calibrating a specific sample of a
sequence. The Dionex Chromatography
Management System has five different calibration
modes.

The mode is selected on the  General sheet in
the QNT editor.

Function:

Fixed This setting enables the calibration using various
standards (also from other sequences).

The desired standards are entered via the Insert
Standard or Append Standard commands to the
Calibration sheet of the QNT editor. The
sequence the standards are taken from is
included in the Sequence column.

Entering individual calibration coefficients is
possible as well via the c0, c1, and c2 columns in
the amount table.

 Tip: Always perform the calibration
manually (Calibrate). The Auto-
Recalibrate option is not available.

Total Calibration is performed using all valid standard
samples of a sequence. The standard samples
deactivated in the Enabled column of the
Calibration sheet (QNT editor) are not included.
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Group The calibration of a sample series from the
sample list (e.g. samples 3 to 50) is performed
based on the standard samples listed directly
before this series (e.g. no. 1 and 2). If this sample
list includes further standards (e.g. no. 51 and
52), the following samples (e.g. 53 to 100) will be
evaluated based on these. The standard samples
in lines 1 and 2 will no longer be considered (For
an example, see below.)

Additional For calibrating a sample, all standard samples
that are listed before this sample in the sample
list are used. The further down the sample is
listed in the table, the more standard samples will
be considered. (For an example, see below.)

Bracketed Samples are evaluated based on all standard
samples immediately surrounding. In case of an
alternating list of two standards, two samples, two
standards, two samples, etc. the samples 1 and 2
(located at positions 3 and 4) are evaluated with
the standards 1, 2, 3, and 4 (located at positions
1, 2, 5, and 6) while the samples 3 and 4 are
evaluated using the standards 3, 4, 5, and 6
(located at positions 5, 6, 9, and 10), etc. (For an
example, see below.)
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Calibration Type
Location: Tab Peak Table / Report Variable (Peak

Calibration)
Type: Code
Dimension: ---
Value Range: Linear (Lin) / Linear with Offset (LOff) /

Quadratic (Quad) / Quadratic with Offset
(QOff) /
Exponential (Exp) / Point-to-Point (P-P)

Combine with: No Weights, 1/Amount (X), 1/Amount²  (XX),
1/Response (Y), 1/Response² (YY) (with
Average all response values... additionally
1/Rel.Std.Dev., 1/Rel.Std.Dev.²)

Default: Linear
Related Param.: ⇒Standard

⇒Calibration Mode

Description: The Calibration Type determines the !Calibration
Function and the !Weights. In calibration, for
each peak up to three calibration constants are
entered into the calibration file, defining the peak
area/amount ratio. The minimum number of
required samples depends on the type of
calibration curve chosen. A maximum of 20
samples from different sample files may be
marked and used as calibration samples. The
calibration points can also be weighted with
1/Amount, 1/Amount², 1/Response, and
1/Response². The type of the weight function is
entered together with the curve type. We
recommend using the F8 box for selecting the
desired specifications, e.g. the field value XXQOff
stands for quadratic with offset and weight
function 1/amount2.
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Function: A series of methods, differing with respect to their
model function and the number of coefficients is
available. The number of calibration samples
needs to be at least equal to the number of
coefficients to be determined.

Calibration functions:
Linear
(Lin)

Minimum number of standards: 1

The model function presents a straight line
passing the origin. For more than one standard,
the regression line is calculated. The calibration
curve is based on the following equation:

Model function: AxcAf 1)( =

Where x is the peak area and a(x) the calculated
amount.

c1 (linear coefficient, slope) is calculated and
stored.

Linear with offset
(LOff)

Minimum number of standards: 2

The calibration curve presents a straight line,
crossing the ordinate at a finite value.

Model function: AxccAf 10)( +=

c0 and c1 are calculated and stored.

Quadratic
(Quad)

Minimum number of standards: 2

The calibration curve presents a parabola
passing the origin. For more than two calibration
samples, the regression parabola is calculated.

Model function: 221)( AxcAxcAf +=

c1 and c2 are calculated and stored.
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Quadratic with
     offset  (QOff)

Minimum number of standards: 3

The calibration curve presents a parabola
crossing the ordinate at a finite value. For more
than three calibration samples, the regression
parabola is calculated.

Model function: 2210)( AxcAxccAf ++=

c0, c1, and c2 are calculated and stored.

Exponential
(Exp)

Minimum number of standards: 2

The calibration curve presents an exponential
function.

Model function: 10)( cAxcAf =

c0 and c1 are calculated and stored.

Point-to-Point Minimum number of standards: 1

The calibration curve is polygon, i.e. a linear
interpolation between two calibration points. If
there are several replicates of a calibration level,
they are averaged before interpolation.

Weighting:
No Weights Default: higher weighting of higher amounts /

signal values.

1/Amount (X) Nearly cancels out the weighting of higher
amounts.

1/Amount² (XX) Causes over-proportional weighting of smaller
amounts.

1/Response (Y) Nearly cancels out the weighting of higher signal
values. In this case, the Y-values (dependent
signal values) of the calibration points are used
as weight factors instead of the X-values
(nominal amounts).
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1/Response² (YY) Causes over-proportional weighting of smaller
signal values. In this case, the Y-values
(dependent signal values) of the calibration
points are used as weight factors instead of the
X-values (nominal amounts).

1/Rel.Std.Dev. (S) Weights signal values with small relative
standard deviations more than those with large
relative standard deviations.

1/Rel.Std.Dev. ² (SS) Weights signal values with small relative
standard deviations clearly more than those with
large relative standard deviation.

Options: Average all response values of each
calibration level before curve fitting averages
the calibration level points before calculating the
calibration curve from the average values.
Include point (0,0) for curve fitting includes
the origin into the calibration curve calculation for
calibration functions with offset without forcing
the calibration curve through the origin.

 Tip: All procedures are possible both, with the area
method and the height method. Note that
integration and calibration should fit together, i.e.
either area method in both cases, or height
method. Only the area method can be
substantiated by physics.

For further information on the available calibration types, see the following
topics in the Theory of Calibration section:

 Calibration Types (Linear)
 Calibration Types (Non-Linear)
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Check Derivative
Location: Tabs Peak Tracking and Spectra Library

Screening / Report Variable (Peak Table)
Type: Selection
Dimension: -
Value Range: Off; 1st derivative; 2nd derivative
Default: Off
Related Param.: Additional parameters for comparing spectra:

⇒Check Extrema
⇒Match Criterion
⇒Maximum/Minimum Wavelength
⇒Relative Maximum Deviation
⇒Threshold

Description: Comparison of two or more spectra with each
other can be performed in three different ways
(comparison functions):

• Based on the curve shape of the spectrum itself

• Based on the curve shape of the first derivative
of the spectrum

• Based on the curve shape of the second
derivative of the spectrum

Function: Comparing the curve shape of the first or second
derivative of the spectrum is more characteristic
(shoulders become extremes). However, the
!Signal to Noise Ratio decreases considerably.
Depending on the comparison function different
⇒Threshold values are useful.

 Note: Differentiating once or twice can lead to well
matching hits, although the absorption heights of
the original spectra differ significantly.
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Check Extrema
Location: Tabs Peak Tracking and Spectra Library

Screening / Report Variable (Peak Table)
Type: Selection
Dimension: -
Value Range: Off; On
Default: Off
Related Param.: Additional parameters for comparing spectra:

⇒Check Derivative
⇒Match Criterion
⇒Maximum/Minimum Wavelength
⇒Relative Maximum Deviation
⇒Threshold

Description: The parameter indicates whether the spectra
search compares the number of extrema in the
reference spectra with the ones in the peak
spectrum.

 Note: If there is strong noise (see !Signal to Noise
Ratio), it is possible that noise peaks are
considered extrema. In this case, it is
recommended to deactivate the Check Extrema
option.
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Comment (Peak)
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Text
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Name (Peak Name)

Description: In addition to the peak name, further comments
can be entered. Double-clicking or pressing the
F8 key opens an enlarged entry field.

 Note: If the peak table is generated in the QNT editor
via the Autogenerate Peak Table function (for
details, see the respective Online Help topic), this
will be automatically indicated in the Comment
column of the peak table:
• If Enumerate peaks of current

chromatogram is selected, the comment will
be Autogenerated.

• If Use spectra library screening results is
selected, the corresponding comment will be
Autogenerated, Spectrum: Name of
Reference Spectrum, Match: !Match
Factor number.
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Dead Time
Location: Tab General / Report Variable (Quantification

Method)
Type: Floating point value
Dimension: Minutes
Value Range: 0.000 ... 9999.999
Default: Not chosen
Related Param.: ⇒Retention Time

⇒Delay Time
⇒Window

Description: The Dead Time To is defined as the time required
for the peak maximum of an unretained
substance to reach the detector from the point of
injection. The dead time thus corresponds to the
residual time (of all substances) in the mobile
phase.

Enter the dead time in the QNT Editor on the
General tab.

Function: The adjusted retention time, T'(S), of a substance
is defined as the time this substance remains in
the stationary phase. The sum of the residual
times in the mobile and stationary phases is the
!Retention Time:

T(S)   =   T�(S)  + To.

The dead time is required to calculate the
!Capacity Factors and the ⇒Kovats Indexes.
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Delay Time

Location: Tab General / Report Variable (Quantification
Method)

Type: Floating point value
Dimension: Minutes
Value Range: -9999.999 ... 9999.999
Default: Not selected
Related Param.: ⇒Dead Time

⇒Retention Time

Description: The time needed by a substance to travel from
the detector cell of one detector to the detector
cell of a second detector is referred to as Delay
Time.

Function: Usually, a constant ⇒Flow is used. With
constant flow, the delay time between two
detectors is constant as well. In this case, it can
be measured and entered on the  General
tab of the ⇒QNT Editor.

The entered delay times can be positive or
negative depending on whether the detector
directly following the column or any other
detector is defined as 2nd detector.

 Tip: Entering a delay time for !Flow Gradients does
not make sense because the delay is not
constant in this case. Proceed as described
under  Defining the QNT Method for
Several Detectors.

You cannot use the Delay Time parameter in
MT2 and GynkoSoft datasources or in any raw
data that are imported from them.
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Dimension of Amounts
Location: Tab General / Report Variable (Peak Table)
Type: String
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Amount

Description: This parameter defines the physical dimension of
the amount values. Usually, it should be an
amount dimension but you may as well choose a
concentration dimension.

Function: The chosen dimension is entered in the column
header of the amount column of the report table.
It is only relevant to the documentation of results
and has no influence on the calculation
algorithms.

 Tip: Consistency of dimensions is entirely up to the
user. If weight was read as g, do not enter mg
here. There will be no automatic conversion!

For the calculation of the concentration in the
report or the printer layout, the Dionex
Chromatography Management System presumes
that a dimension of amount was chosen. If a
dimension of concentration was entered as
Dimension of Amounts, this calculation does
not make sense.
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Group (Peak Group)
Location: Tab Peak Table / Report Variable (Peak Table)
Type: String
Dimension: ---
Value Range: All printable characters
Default: ---
Related Param.: ⇒Peak Group Start/End

⇒Integration Type
⇒Calibration Type

Description: Peaks may be grouped and then be calibrated
and integrated together. You may assign the
group any name, whilst it is recommended to use
the name of the group's most "important"
member. The members must not necessarily
succeed one another.

(If you wish to group peaks that lie close together,
use the Peak Group Start and Peak Group End
detection parameters (on the Detection tab of the
QNT editor.)

Function: During calibration (not during peak detection), the
peak group is treated as one non-resolved peak:
The calibration constants of the amount value
and the area sum of all peaks being part of the
group are calculated. The calibration curve,
therefore, is identical for all peaks.

During integration, the amount/concentration
values for each peak are calculated individually
for each peak from its area and calibration
constants.

 Tip: The Integration and Calibration types must be
identical for all peaks within a peak group.

Also see: How to ...: Actions in the QNT Editor  Grouping Peaks
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Integration Type
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Selection
Dimension: No dimension
Value Range: Area / Height / Relative Area / Relative Height /

CE Area
Can be combined with: All peaks, identified Peaks only / Exclude

ISTD peaks (only with Relative Area / Relative
Height)

Default: Area
Related Param.: ⇒Calibration Type

⇒Group

Description: Indicates the peak property to be used for the
calculation of quantitative results. Different Area
and height methods are the alternatives.

Functions:

Area Peak area integration.

All amount calculations refer to the peak area
which itself is calculated numerically according to
the trapezoidal method. Area delimiters in this
case, consist of chromatogram, baseline and, if
necessary, perpendiculars in order to exclude
adjacent non-resolved peaks. In case of !Riders,
an appropriate skimming tangent substitutes the
baseline.

Height Peak height integration.

All amounts refer to the peak height, i.e., the
height of the peak maximum as related to the
baseline.
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Relative Area Relative peak area integration. The area can be
chosen relative to the area of
• All peaks or

• Identified peaks only

In both cases the internal standard(s) may be
excluded (Exclude ISTD peaks).

Relative Height Relative peak height integration. Reference
corresponding to the relative peak area
integration is possible.

CE Area Integration type for capillary electrophoresis

CE-Area = Area / Ret. Time in [mAU])

 Tip: Integration and calibration always require the
same method!

All peaks of a Group require the same method.

Only the area methods can be substantiated by
physics.
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Kovats Index
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Integer
Dimension: No dimension
Value Range: 0 ... 999.999
Default: -
Related Param.: ⇒Retention Time

⇒Dead Time

Description: Data exchange between laboratories for
substance identification based on relative
retention times is not exact. Therefore, especially
in gas chromatography, retention indexes are
used. They use a series of chemically similar
standard substances to achieve uniform scaling
of the Retention Time.
Advantage is taken of the fact that within a
homologous series of compounds the logarithms
of the adjusted retention times are proportional to
the number of carbon atoms (adiabatic and
isothermal conditions presumed). The most
frequently used Kovats Index is defined as
follows:

)]('log)1('[log
)]('log)('[log100100
nTnT
nTxTnKI

−+
−+∗=

Wherein:
KI: Kovats index
T�(x): Adjusted retention time (with:  T�(x) = T(x) -
)To)
T(x): Retention time
To: Dead time
n: Number of carbon atoms (normally of n-alcane)
x: substance of interest
While the following must be true:
T(n)  <  T(x)  <  T(n+1).
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Function: As the Kovats indexes for the markers are freely
selectable the following formula is used for the
calculation:

)]('log)1('[log
)]('log)('[log))()1(()(
zTzT
zTxTzKIzKIzKIKI

−+
−−++=

With KI = Kovats index (usually KI  = 100 * n is
entered) and

z = number of the marker peak.

If no marker peaks or no dead time is determined,
the Kovats index is not defined (n.a.). In addition,
the Kovats index is not defined for any peaks that
occur before the first and behind the last marker
peaks. For further information on how to enter
marker peaks and dead time see How
to �: Actions in the QNT Editor  Defining
the Retention Index and the Kovats Index.

 Tip: In the Dionex Chromatography Management
System, the substances of interest must be
between two marker peaks.
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Left/Right Limit
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Fixed point number
Dimension: Minutes
Value Range: 0 ... 999.999 [min]
Default: 0 (no function)
Related Param.: ⇒Retention Time

Description: Normally, peak integration is performed
automatically. It is possible to limit or extend
integration on the left, right, or on both sides with
the appropriate peak table parameters. This may
be done in the peak table via a left and/or a right
limit.

Function: The peak is integrated between left and right limit,
i.e. between:
RT - LL   ...  RT + RL
Wherein:
RT = Retention Time
LL = Left Limit
RL = Right Limit.
The value 0 deactivates the limitation.
Example 1:
For the right and the left integration limit, the
value 0.5 min is entered. The peak maximum is at
the retention time of 8 min. The peak is integrated
from 7 min 30 sec to 8 min 30 sec.

 Tip: The limits LL and RL can also be
activated/deactivated independently.

Example 2:
For the left integration limit the value 0.5 min and
for the right integration limit the value 0 is
entered. As before, the peak maximum is at the
retention time of 8 min. The peak is integrated
from 7 min 30 sec. The end of the integration is
automatically determined then.
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Match Criterion
Location: Tabs Peak Table and Spectra Library

Screening / Report Variable (Peak Table)
Type: Selection
Dimension: no dimension
Value Range: Least Square, Weighted Least Square, or

Correlation
Default: Least Square
Related Param.: Additional parameters for comparing spectra:

⇒Check Derivative
⇒Check Extrema
⇒Maximum/Minimum Wavelength
⇒Relative Maximum Deviation
⇒Threshold

Description: The match criterion defines the mathematical
method with which two standardized spectra are
compared with each other.

Function: The signal deviation, i.e., the difference between
the UV spectrum and a reference spectrum at
defined wavelength, is checked (∆1, ∆2, ...).
Since the square of the deviations is calculated
as well, the direction of the subtraction does not
matter.

200 350 [nm]
0

100 [%]
UV spectrum

comparison spectrum

∆1
∆2

∆...

The method provides a value of similarity (match)
between completely different (= 0) and identical
(= 1000).
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Function (Cont'd): The following mathematical methods are
available in the Dionex Chromatography
Management System:

Least Square: Forms the sum of the squared signal deviations
at each wavelength and determines the average
square deviation between two spectra (standard
method)

Weighted Least
Square:

Analogue to Least Square; the squared
deviations are weighted by the signal height (for
spectra extracted close to the detection limit).

Correlation: Usual match criterion in statistics if a linear
correlation between two curves is presumed
(similar to Least Square; usually provides the
same result).
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Maximum/Minimum Wavelength
Location: Tab Peak Tracking and Spectra Library

Screening / Report Variable (Peak Table)
Type: Floating point number
Dimension: nm
Value Range: Auto;   190.0 - 900.0 nm
Default: Auto
Related Param.: Additional parameters for comparing spectra:

⇒Check Derivative
⇒Check Extrema
⇒Match Criterion
⇒Relative Maximum Deviation
⇒Threshold

Description: The Maximum/Minimum Wavelength (=
Max./Min. WL) column allows you to enter the
upper/lower wavelength limits for spectra
screening. In case of Auto, the respective limits
will not be considered.

 Tip: The value entered here has no significance for
any currently displayed peak spectrum.
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Name (Peak Name)
Location: Tab Peak Table / Report Variable (Peak Table)
Type: String
Dimension: no dimension
Value Range: All printable characters
Default: With automatic table generation: <Name of the

QNT Method>x, wherein x is the current peak
number.
When appending a new cell: Peak-x

Description: In this column, you may enter the chemical name
of the substance that created the peak at the time
t (default is used with auto-generated peaks,
only).

Function: The substance name is taken for the report and
the !Printer Layout.

 Tip: Only letters, numbers, and punctuation marks
should be used, since the complete MS-DOS
character set is not available on all printers.
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Reference Spectrum
Location: Tab Peak Tracking / Report Variable (Peak

Table)
Type: Selection
Dimension: No dimension
Value Range: ---
Default: Empty
Related Param.: ⇒Window

Description: Reference spectra are used for substance
identification. For each peak such a reference
spectrum can be chosen. Such spectra are
acquired with the DAD license of the Dionex
Chromatography Management System.

Identifying peaks by means of peak tracking can
be activated via an input in the Window column.
In the corresponding F8 dialog box (press the F8
key or double-click in the Window column),
select one of the options Spectrum or Spectrum
and time of the group Peak Match.

Function: Peak tracking is performed (limited to the
specified time window in the case of Spectrum
and time) using the reference spectra in the
corresponding column (see How to ...: Actions
in the QNT Editor  Peak Tracking).

 Tip: Spectra acquisition is possible with the DAD
license, only.
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Relative Maximum Deviation
Location: Tab Peak Tracking and Spectra Library

Screening / Report Variable (Peak Table)
Type: Floating point number
Dimension: nm
Value Range: Off; 0.0-100.0 nm
Default: Off
Related Param.: Additional parameters for comparing spectra:

⇒Check Derivative
⇒Check Extrema
⇒Match Criterion
⇒Maximum/Minimum Wavelength
⇒Threshold

Description: The column Relative Maximum Deviation allows
you to enter the maximum permissible deviation
of the wavelength maxima of the reference
spectra from the maximum of the current peak
spectrum.

Function: If the setting is Off, the deviation is not checked.
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Response Factor
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Floating point number
Dimension: ---
Value Range: 0.000000 ... 9999999.999999
Default: 1.000000
Related Param.: ⇒Weight (sample weight)

⇒Dil. Factor (dilution factor)

Description: The response factor is a peak-specific
dimensionless, multiplicative factor, used to
compensate for absorption differences in the
case of differing wavelengths.

Function:

Absolute Select Absolute to correct the amount value
received from the peak area via the !Formula for
Amount Calculation by the entered factor. In this
way, e.g. absorption differences at different
wavelengths can be compensated. Besides,
losses of readily volatile samples can thus be
considered in the calculation (especially common
in gas chromatography).

Relative To Peak Select Relative To Peak for a correction in
relation to a reference peak. As a reference peak,
all peaks that are assigned a peak name in the
peak table can be used. As the normal (absolute)
response factor, the value of the relative
response factor is used as a multiplicative factor
in the amount evaluation. The basis of the
evaluation is not the calibration curve of the peak
in the peak table, but that of the selected
reference peak.
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Relative To Peak
(Cont'd):

Example: Relative to Peak
Under certain conditions, an active agent in a
tablet decomposes into various products. As
standards for these products are difficult to
produce or very expensive, the active agent and
the decomposition products are calibrated e.g.
once a year.

If the active agent and the decomposition
products are calibrated via the linear without
offset function, there is a direct correlation
between the slope of the active agent calibration
curve and the calibration curves of the individual
decomposition products. This proportionality
between the calibration coefficient c1 of the active
agent and that of the decomposition product is
expressed as the Response Factor and must be
determined by the user.

Should the active agent and/or the decomposition
product be determined in an analysis, the existing
calibration and the Response Factor determined
for each decomposition product is used. The
factors are entered as relative values (Response
Factor column) in the peak table, i.e., the active
agent in the tablet is used as the reference peak.

Calculating the amount values of all
decomposition products is according to the
calibration coefficients of the active agent,
corrected by the Response Factor.

 Tip: The response factor is peak-specific!

In contrast to this, the Sample Weight and the
Dilution Factor of the sequence table are sample
specific, i.e., they apply to all peaks.
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Retention Index
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Integer
Dimension: No dimension
Value Range: 0 - 999.999
Default: -
Related Param.: ⇒Retention Time

⇒Dead Time
⇒Kovats Index

Description: Retention indexes are used to facilitate positive
assignment of substances in inter-laboratory data
exchange. For programmed GC as well as for
HPLC linear retention indexes are defined.

Function: The Dionex Chromatography Management
System calculates the following linear retention
index:

)()1(
)]()([*)]1()1([)()(

zTzT
zTxTzRIzRIzRIxRI

−+
−+−++=

With
RI: Retention index (usually RI = 100, 200, 300 is
entered)
z: number of the marker
The following is true:

T(z)  <  T(x)  <  T(z+1).
If the peak occurs before the first maker peak, the
following formula is used:

RI (x)   =   RI(1)  *  [T(x)  /  T(1)]
If the peak occurs behind the last marker peak,
the following formula is used:

RI (x)   =   RI(last)  *  [T(x)  /  T(last)]
For information how to determine marker peaks
see, How to ...: Actions in the QNT Editor

 Defining the Retention Index and the
Kovats Index.
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Retention Time
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Floating point value
Dimension: Minutes
Value Range: 0.000 ... 9999.999
Default: 0.000

With Autogenerate Peak Table, the retention
time of the current chromatogram is used.

Can be combined with: Absolute time; Time distance / ratio to
reference peak; Reference peak

Related Param.: ⇒Window
⇒Use Recently Detected Retention Times
⇒Dead Time

Description: The retention time is used for peak identification.
The peak Retention Time variable refers to the
time (in minutes) that passed since the injection
(also see ⇒Dead Time).

By definition, the injection time always equals
zero. Therefore, control commands issued before
this time will have negative times. The advantage
is that the times stated in the !PGM File (file type
.PGM) are compatible with the retention times,
rather than being delayed by the injection time.

Peak retention times are generally interpreted as
time between injection and peak maximum.
However, indication of the distance to a reference
peak is possible as well. As the reference peak
does not need to be at the beginning of the
chromatogram, such difference retention times
can also have negative values. Relative retention
times are time quotients in percent as to a
reference peak.
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Function: On the page Peak Table in the QNT editor, the
retention time can be entered either manually by
the user or automatically by the system. The
latter is possible via the Autogenerate Peak
Table command from the Edit or context menus.

The user enters the expected retention time,
while the system enters the actually detected
retention time of the actually analyzed sample.

Interpretation Input in the Retention Time for Peak X dialog
box (to be opened via F8 or double-clicking the
Ret. Time column)

Absolute time Select Absolute time [min] to display the
retention times as usual (time period between
injection and peak maximum).

Time distance to
reference peak
[min]

Select Time distance to reference peak [min]
to express  the time difference to the reference
peak in minutes. All peak lines except the line for
the reference peak show time differences in the
time column.

Time ratio to
reference peak [%]

Select Time ratio to reference peak [%] to
express the retention time relatively to the
reference peak in % values. The retention times
are indicated as time ratio (percent) to the
reference peak. All peak lines except the line for
the reference peak show the time ratios to the
reference peak in percent.

Reference peak Select a peak from the peaks listed in the
selection box. The reference peak line in the peak
table is highlighted in light blue. It always shows
the absolute retention time!

Tips: If the Use Recently Detected Retention Time
option (retention time correction) is activated in
the peak table, the retention times entered
manually on the page Peak Table are no longer
used as nominal retention times for all identified
peaks. Instead, the values detected for the
previously analyzed sample (its nominal times)
are used.
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Tips (Cont'd): It is to be distinguished between:

• The originally expected retention time which
was entered on the Peak Table sheet,

• The nominal retention time which, in this case,
corresponds to the actual retention time of the
previously analyzed sample, and

• The actual retention time of the actually
analyzed sample.

⇒Retention Windows are also interpreted as
percentage value of the absolute retention time
for both, difference, and relative retention times!
Only the retention times of identified peaks are
corrected!

In the Peak Table, you can toggle the three
options. The retention time column is
automatically re-calculated.
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Standard
Location: Tab Peak Table / Report Variable (Peak Table)
Type: String
Dimension: ---
Value Range: External; Internal; Internal/External; Use this

peak as internal Standard
Default: External
Can be combined with: Use sample amount as reference (only with Use

this peak as internal Standard)
Related Param.: ⇒Amount

Description: Indicates the standard method to be used for
calibration. For a detailed description including
numerical examples, see How to ...: Actions in
the QNT Editor  Calibration

Function:

External The calibration curve determines the area/amount
ratio. During calibration, the calibration coefficients
(see !Calibration Function and  Standard
Methods) are calculated from mixtures of known
components.

Internal Calibration corresponds to the External Standard
method. In addition, an !Internal Standard is
added. The internal standard itself is calibrated as
all other peaks. When performing the integration,
the calculated amounts of the remaining peaks
are corrected by the nominal/actual ratio of the
internal standard.

The Dionex Chromatography Management
System recognizes any number of internal
standards. Theoretically, each peak may have its
own internal standard! Furthermore, the standard
method may be selected for each peak
individually.
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Internal
(Cont'd):

During calibration, the amount ratio (instead of
amount against area) is given in the diagram with
regard to the respective peak. From these data
points, the calibration function is calculated.

During integration also, the area ratio is inserted
into the stored calibration function and the amount
ratio is calculated.

 Tip: Before you can use this option, at
least one internal standard must be
defined (see Use this peak as
internal Standard). Select the
desired ISTD peak in the
Associated ISTD Peak checkbox.

Entering Several Internal Standards
It is also possible to define several internal
standards. Via the F8 box, define the respective
peaks of the peak table in the Standard column of
the peak table as ISTD peaks. A yellow
background will highlight the corresponding line of
the peak table. For the remaining peaks, enter the
standard method to be used (external,
internal/external, internal). If this should be
performed in relation to an ISTD peak, it is
possible to choose between the previously defined
ISTD peaks.

Internal/External When calibrating with an internal standard,
calculation is with area and amount ratios instead
of absolute areas and amounts. During
integration, the area ratio is inserted into the
saved calibration function to calculate the amount
ratio. The result is the amount in relation to its
reference peak. Each peak can have its own
internal standard.

Calibration does not vary from the external
standard method, except for a defined peak (i.e.
internal standard) being added to the analyses.
The internal standard is calibrated as all other
peaks.
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Internal
(Cont'd):

During integration, the calculated amounts of the
other peaks are corrected according to the
relation of the internal standard to the actual peak.

 Tip: Before you can use this option, at
least one internal standard must be
defined (see Use this peak as
internal Standard). Select the desired
ISTD peak in the Associated ISTD
Peak checkbox.

Use this peak as
Internal Standard

This option allows you to define the current peak
as ISTD peak. Use the Use sample amount as
reference checkbox to use the amount of the
internal standard from the ISTD amount column of
the sample list (instead of the Amount columns of
the QNT peak table). In this way, you can enter a
different amount of internal standard for each
sample.

 Tip: For internal standard as well as internal/external
standard methods, a substance whose
concentration is known, must be added to the
standards and to the analyses. This can be
conveniently carried out by means of an
appropriate !Autosampler. Quantitative accuracy
reached with this method, exceeds that of the
external standard method by one dimension.

For these two options, the name of the internal
standard must be indicated.

Internal standard methods compensate even
small injections deviations, since possible loss or
excess apply to the internal standard as well.
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Threshold
Location: Tab Peak Tracking and Spectra Library

Screening / Report Variable (Peak Table)
Type: Integer
Dimension: No dimension
Value Range: 0 - 1000
Default: 950
Related Param.: Additional parameters for comparing spectra:

⇒Check Derivative
⇒Check Extrema
⇒Match Criterion
⇒Maximum/Minimum Wavelength
⇒Relative Maximum Deviation
⇒Threshold

Description: This parameter defines the threshold of the
!Match Factor above which two spectra may be
accepted as matching.

Function: Depending on the comparison function the
following settings can usually be recommended:

Spectrum (Off): 950

1st derivative: 900

2nd derivative: 800
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Type (Peak Type)
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Alternatives
Dimension: No dimension
Value Range: Autodetect (Auto) / Rider (R) / Main (M) /

Baseline-Main (B-M) / Main-Baseline (M-B) /
Baseline-Main-Baseline (B-M-B)

Default: Autodetect
Related Param.: ⇒Rider Threshold

⇒Maximum Rider Ratio
⇒Valley to Valley
⇒Lock Baseline

Description: Determines the type of baseline contact and the
separation of other, non-resolved peaks. An
integration program algorithm usually defines the
peak type. The peak type can also be altered as
desired via the detection parameters (see How
to ...: Actions in the QNT Editor  Modifying
Detection Parameters). In order to determine
the peak type regardless of other factors, this
should be done in the peak table. Type
specifications of the peak table have priority.

Functions:
Autodetect (Auto) The peak type is determined via an algorithm, or

via detection parameters.

Determine at
Calibration

Not yet implemented

Rider (R) / Main (M) The peak is integrated as rider or main peak
without baseline contact. This, of course, applies
to non-resolved peaks, only.
In the case of rider peaks, an additional
distinction is made between peaks on the
ascending edge (u = up) and peaks on the
descending edge (d = down). Of course, this
does not affect the type of baseline contact of the
reference peak.
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Baseline-Main(B-M) /
Main-Baseline(M-B) /
Baseline-Main-
Baseline (M-B-M)

The peak is integrated as main peak with left,
right, or bilateral baseline contact.

A further distinction between b and B is made in
the report: If a main peak has direct baseline
contact on the left and/or right side, this is
indicated by a capital B. If the baseline below
non-resolved peaks is drawn from minimum to
minimum (⇒Valley to Valley), i.e. from peak end
to peak end, this type of baseline contact is
characterized by a small b.

BMB BMBBMBM bMb

MB
RdRu

bMBBMbBM

 Tip: The peak type determined here can only be
realized with non-resolved peaks. For resolved
peaks, peak type is always Baseline-Main-
Baseline!

The distinction between b and B is made only in
the report output. The baseline is checked
automatically. Then, the baseline contact is
determined. In the peak table, the classification is
always B.

The peak type that is defined in the peak table
has priority over the type assignments of the
Rider Threshold and Maximum Rider Ratio
detection parameters.
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Use Recently Detected Retention Time
Location: Tab General / Report Variable Use Prev.

Retention Time (Peak Table)
Type: Check-box
Dimension: ---
Value Ranges: Marked / not marked

Use recently detected ret. times of last sample
/ standard
Set reference time to Last value / Average of
last n values / Global average

Defaults: Not marked
Last sample
Last value

Related Param.: ⇒Retention Time
⇒Window

Description: This QNT file parameter (General sheet) defines
whether the retention time stored in the peak table
(nominal time) is used by default to identify a peak
or whether the actual retention time of a peak in
the last sample is used. Thus, many types of drift
phenomena can be compensated (e.g.
evaporation of volatile components in pre-mixed
solvents or column age).
If the peak is not found in this sample, the
chronologically previous sample in the sequence
is searched, etc. (The chronological order is
important and not the order in the sample list).
If you have chosen this option, you may select
whether you want to use the retention times of the
last unknown sample (Sample) or of the last
Standard.
Via the Options button, you can also define
whether you want to use the last retention time
(Last value), the average of the last x retention
times (Average of last x values), or the average
of all retention times (Global average).
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Function: If the check box Use Recently Detected
Ret.Time is selected, the Dionex Chromatography
Management System always stores the last actual
retention time of the peak and positions the
Window specified in the peak table around this
actual value, not around the nominal value stated
in the peak table.
This allows positive identification of peaks even
when the retention time changes due to column
trends, and thus the peak leaves the defined
retention time window.

Example: The first sample of a sequence containing 10
samples is processed in an automatic batch.
Based on the retention times stated in the peak
table and the selected window values (e.g. 0.2G),
four peaks are identified in the first sample (A, B,
C, and D). Each one of these peaks may have an
actual retention time that deviates from the
nominal retention time. The Dionex
Chromatography Management System stores
these actual values and uses them as the basis
for positioning the time window in the second
sample. If single peaks are then identified in the
second sample, the "stored" actual values are
replaced by the current actual values. The time
window is repositioned accordingly. If, for
example, the retention time of peak A from the
first sample (1 min) is delayed by 10 sec in each
sample, the peak will be appear at 1 min + 9 x
10 sec = 150 sec or 2.5 min in the tenth sample.
As the time window is also moved by 10 sec with
each sample, peak A can be clearly identified in
the tenth sample, although the peak is no longer
within the originally specified time window (48 sec
to 1 min 12 sec).

Tip: Only retention times of identified peaks are
corrected!
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Window (Retention Window)
Location: Tab Peak Table / Report Variable (Peak Table)
Type: Positive floating point number or string
Dimension: Minutes or %
Value Range: 0.000 ... 999.999 or 0 - 100%

Absolute / Relative and
First / Greatest / Nearest / Spectrum /
Spectrum and time

Default: Autogenerate Peak Table: A third of the
distance to the preceding or the succeeding peak
depending on which distance is smaller

Else: 0.100 min or %
Absolute Greatest

Can be combined with: Check the best hits only (with the peak match
options Spectrum and Spectrum and Time only)

Related Param.: ⇒Retention Time

Description: Defines a tolerance interval within which the peak
is expected. The start and end times of the
retention window result from adding the window
value to and subtracting it from the retention time
(retention time +/- window value), i.e., the window
width is always twice as wide as your input. A
peak outside this window is not identified. The
window value defined here is either interpreted as
absolute (minutes) or relative (percentage) value
by the integration programs. For each peak, the
interpretation can be individually specified, by
adding a suffix to the window time.
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Function: The dimension W of the time windows is
calculated according to the following formula:

Absolute time window: W = TW

Relative time window: W = T x TW / 100

Where T is the retention time of the table and TW
the entered window value. All peaks whose
maximum falls into the time interval T+W belong
to the time window.

Function of the suffixes:
• Select Absolute or add a capital A to the window value to indicate the

window width in minutes.

• Select Relative or add a capital R to the window value to indicate the
window width relative to the retention time.

If a peak is registered within this window, it is assigned the peak name
entered in the peak table. If several peaks are located in the same window,
the window parameter can be extended to determine which peak is
identified:
• Select First to identify the first peak within the window (F).

• Select Greatest to identify the largest peak within the window (G).

• Select Nearest to identify the peak nearest to the specified retention
time (N).

• Select Spectrum to identify a peak by a spectrum. The reference
spectrum is specified in the Spectrum column of the peak table (S).

• Select Spectrum and time to identify a peak within a specific window
width by a spectrum. The reference spectrum is specified in the
Reference Spectrum column of the peak table (ST).

Via the Check the best hits only option, Spectrum and Spectrum and
time allow you to check the hits with the largest !Match Factors for the
respective peaks only (= checkbox selected, default). The abbreviation for
this is B (SB or STB).

If you have MS options installed, you can also enable the Check mass
ratios option to check whether the masses indicated on the Mass
Tracking tab are found in the defined ratio range.
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Examples: Window Values: 0.2 AF / 0.2 AG / = 0.2 AN
If the expected retention time of the peak is
Ret.Time = 5.0min and the window value is 0.2 A,
the time window is 5.0min +/-
 0.2min = 4min 48sec to 5min 12sec. By adding
the suffix F, the first peak in the time window, by
adding the suffix G, the greatest peak in the
window, and by adding the suffix N, the peak
nearest to the expected retention time is
assigned.

Window Values: 10 RF / 10 RG
If the expected retention time of the peak is
Ret.Time = 5.0min and the window value is 10 R,
the time window has the range 5.0 min ± 10% =
5 min ± 0.5 min = 4 min 30 sec to 5min 30 sec.
By adding the suffix F, the first peak in the time
window, by adding the suffix G, the largest peak
in the window is assigned.

 Tip: The absolute time interval of the window is twice
as wide as the window value entered, since the
interval reaches from T-W to T+W!



1020 QNT: Detection

QNT: Detection
Integration and detection parameters are determined on the Detection page of
the QNT method. They control peak detection, baseline treatment, peak
classification, and inhibition (integration parameters). The values of these
parameters are assigned time-dependently and channel-dependently; thus,
they may be altered several times during a chromatogram.

Example of a detection table

Generally, about 90% of all chromatograms are integrated correctly by the
system. In critical cases (e.g. wavelength switching), the user may influence
the baseline or the peak type (e.g. rider or main peak), or he can inhibit
detection entirely for certain periods. The figure illustrates a detection table.

Besides, detection parameters can be defined graphically. This is extremely
useful for the two parameters ⇒Sensitivity and ⇒Peak Slice. For details, see
How to ...: Actions in the Chromatogram  Defining Detection Parameter
Graphically.

Each of the 26 differing parameters described in detail below, can be assigned
a new value at any time. The last value is valid for the duration of a sample,
then the parameters are assigned their original default values. The assignment
of a new value to a parameter is called an event. Events can be printed in the
Report, with identification and a numerical value at the respective execution
time.

Events need not be entered in chronological order. They are sorted
automatically in chronological (ascending) order before being stored.
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Parameter tables include the following columns:

No. Line number, cannot be edited.

Ret. Time [min] Retention time, specified in minutes within a
range of 0.000 - 9999.999.

Param. Name Parameter name; dialog box (F8 or double click)
displays a list of all available parameters.

Param. Value Parameter value; contains detailed information
concerning all permitted values of the selected
parameter type.

Channel Via the arrow or the dialog box (open via F8), all
options available can be chosen. In addition to All
Channels, the single channels that have been
recorded can be chosen.

Many parameters can only have the values ON or OFF. They are called
switches. All other parameters are called variables.

The parameters are described in detail on the following pages (the order of
description corresponds to the order in which they can be selected in the QNT
editor).

For details on how to define individual detection parameters, see:

How to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Detection Parameters (Overview)
Detection Parameters

The Dionex Chromatography Management System provides the following
detection parameters:

⇒Baseline Point
⇒Detect Negative Peaks
⇒Front Riders to Main Peaks
⇒Inhibit Integration
⇒Lock Baseline
⇒Maximum Area Reject
⇒Maximum Height Reject
⇒Maximum Peak Height
⇒Maximum Rider Ratio
⇒Maximum Width
⇒Minimum Area
⇒Minimum Height
⇒Minimum Width
⇒Peak Group Start/End
⇒Peak Purity Start/End Wavelength  (PWlStart/PPWIEnd)
⇒Peak Purity Threshold (PPTrshold)
⇒Peak Shoulder Threshold
⇒Peak Slice
⇒Rider Skimming
⇒Rider Threshold
⇒Sensitivity
⇒Tailing/Fronting Sensitivity Factor
⇒Valley to Valley

For details on how to define detection parameters, see How to ...: Actions in
the QNT Editor  Defining Detection Parameters.
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Baseline Point
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Command
Dimension: ---
Value Range: ---
Default: ---
Related Param.: ⇒Lock Baseline

⇒Valley to Valley
⇒Inhibit Integration
⇒Type (Peak Type)

Description: The Baseline Point detection parameter defines
a baseline point at the indicated time.

Tips: When setting a baseline point, keep in mind that
this point will be valid for all chromatograms that
are evaluated with the respective QNT method. If
in one of these chromatograms a peak maximum
occurs by coincidence at the time of your hard
entered baseline point, the peak maximum will be
defined as base point and the peak will not be
detected.

This command has priority over ⇒Lock Baseline
and ⇒Valley to Valley, but not over ⇒Type (Peak
Type) from the peak table.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Detect Negative Peaks
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Switch
Dimension: ---
Value Range: On / Off
Default: Off (i.e., negative peaks are not detected)

Description: Enables/disables detection of negative peaks ON
or OFF. When turned on, negative as well as
positive peaks are detected.

Function: Enabling detection of negative peaks
automatically activates the ⇒Lock Baseline 
parameter. Disabling negative peak detection
locks the baseline to the default again. In the
result report, the area of negative peaks is
indicated as a positive value.

To correct the baseline without labeling the peaks
or including peaks in the peak list, select the
Don't label option.

Tip: In order to be effective, this switch must be
activated before the peak start.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.



Detection Parameters 1025

Front Riders to Main Peaks
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Selection
Dimension: -
Value Range: Off, On
Default: Off
Rel. Param.: ⇒Rider Threshold

⇒Maximum Rider Ratio
⇒Type (Peak Type)

Description: The Front Riders to Main Peaks detection
parameter allows you to change rider peaks on
the ascending edge of a peak into main peaks.

Function: Set the parameter value to On to change upward
riders to main peaks even if riders are enforced
(e.g., ⇒Rider Threshold = 0.00%, ⇒Maximum
Rider Ratio = 100.0%).

Tip: This parameter has priority over the Rider peak
type in the peak table (see !Rider).

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Inhibit Integration
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Switch
Dimension: ---
Value Range: On / Off
Default: Off
Description: The Inhibit Integration detection parameter

serves to fade out certain chromatogram areas.
When turned on, peak detection is de-activated,.

Function: If the value is set to On before the first peak to
inhibit, no peak detection will take place until the
parameter is deactivated (Off), i.e., no peaks are
recognized in this area. The chromatogram is
displayed on the screen, but it is not integrated.

Inhibit Integration can be used to inhibit the
injection peak by activating the criterion at the
start time of the chromatogram and by
deactivating it after the dead time.

Tip: To have any effect, this switch must be activated
before the start of the first peak to be inhibited.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Lock Baseline
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Alternatives
Dimension: ---
Value Range: Off / On / At current level /

At global minimum
Default: No
Related Param.: ⇒Valley to Valley

⇒Inhibit Integration
⇒Baseline Point
⇒Type (Peak Type)

Description: In case this parameter is set to Off, the detection
program calculates the baseline below non-
resolved peaks according to a complex pattern
recognition process. The other values are used to
lock the baseline on different levels.

Function:

Off Below non-resolved peaks, the baseline is
determined automatically. The Valley-to-Valley
parameter is effective in this mode, only. With all
other lock-values, lock baseline has priority, while
valley-to-valley is ignored.

On In the case of non-resolved peaks, the baseline is
not pulled up to the relative minima (valleys). The
baseline connects the start of the first with the
end of the last non-resolved peak.

If one of the valleys in between is located below
the baseline, the baseline is connected with this
minimum to avoid cutting off a peak foot. The
Valley-to-Valley parameter is not effective.
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At current level The baseline is fixed at the current signal level
and is extrapolated horizontally to the right. The
Valley-to-Valley parameter will not take effect.

At global minimum The Dionex Chromatography Management
System searches to the right for the next absolute
minimum. The search is performed either to the
end of the chromatogram or to the next Lock
Baseline. Within this interval, the baseline is
locked on the found minimum and is horizontal.
The Valley-to-Valley parameter is not effective.

Tips: The end of the last non-resolved peak in a series
of peaks is always a baseline point, since the
chromatogram itself forms the baseline outside
the peak!

Lock baseline needs to be turned off, before
switching from At global minimum to another
lock baseline value.

The classification criterion ⇒Type (Peak Type) in
the peak table has priority. The criterion specified
here is effective only for Peak Type = AUTO!

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.



Detection Parameters 1029

Maximum Area Reject
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Signal dimension ∗∗∗∗ Minute
Value Range: 0.000 ... 1,000,000.000
Default: The default setting is Off, i.e. all peaks are

integrated.

Related Param.: ⇒Minimum Area
⇒Maximum Height Reject

Description: The Maximum Area Reject parameter allows
limiting the number of integrated peaks. This
parameter is very similar to ⇒Minimum Area.

Function: The parameter defines the maximum peak area
up to which a peak is rejected. No peaks with a
peak area below the defined value are integrated.

 Tip: Contrary to the Minimum Area the Maximum
Area Reject parameter does not affect the
baseline course.

 
For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Maximum Height Reject
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Signal dimension (e.g. mAU)
Value Range: 0.000 ... 1,000,000.000
Default: The default setting is Off, i.e., all peaks are

integrated.

Related Param.: ⇒Minimum Height

⇒Maximum Peak Height

⇒Maximum Area Reject

Description: The Maximum Height Reject parameter allows
limiting the number of integrated peaks. This
parameter is very similar to ⇒Minimum Height.

Function: The parameter defines the maximum peak height
up to which a peak is rejected. Not all peaks with
a peak height below the defined value are
integrated. (Determination of the height is always
relatively to the baseline).

 Tip: Contrary to Minimum Height the Maximum
Height Reject parameter does not affect the
baseline course.

 
For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Maximum Peak Height (MaxHght)
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Signal dimension (e.g. mAU)
Value Range: Off; 0.000 ... 1,000,000.000
Default: The default setting is Off, i.e., all peaks are

integrated.

Related Param.: ⇒Minimum Height
⇒Maximum Area Reject

Description: Positive peak identification is via the ⇒Minimum
Height parameter. All peaks above this height
value are identified.

The Max. Peak Height detection parameter is
used as a maximum criterion determining the
height threshold above which peaks are not
identified.

Function: All peaks above the specified peak height are
classified as Unknown; i.e., despite the positive
identification, they are not assigned a name from
the peak table (the height is always determined
relative to the baseline).

This option is very useful when working with two
detectors switched in series. Peaks that are
clearly identified in the channel of the first
detector (e.g. a UV detector) can cause problems
in the second detector (e.g. a fluorescence
detector) due to an excessive concentration.
These peaks are outside the linear range. Due to
the positive identification, they would be
considered in the calibration and they would
falsify the result. If they are classified as
Unknown, they are not considered.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.



1032 Detection Parameters

Maximum Rider Ratio
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Percent [%]
Value Range: 0 ... 99.99
Default: 20
Related Param.: ⇒Rider Threshold

⇒Type

Description: If one or several peaks (h1 to h4) are above the
Rider Threshold in a series of non-resolved
peaks, the Dionex Chromatography Management
System determines via the Maximum Rider
Ratio detection parameter, whether a peak is
classified as main peak or !Rider.

Function: For this, the height of the peak to classify is put in
relation to the height of the greatest peak in the
series (reference peak).
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As can be seen in the figure, not the "real" peak
height of the peak to be classified is evaluated
but the distance between the peak maximum and
the skimming tangent.

If the ratio h/b multiplied by 100 percent produces
a value larger than the one defined as maximum
rider ratio, the peak is a main peak.

If the ratio h/b multiplied by 100 percent produces
a value smaller than the one defined as maximum
rider ratio, the peak is a rider peak.
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Function (Cont'd): Starting with the largest peak in the series
(reference peak), all adjacent peaks are then
classified. As soon as another main peak is
recognized, this peak automatically becomes the
new reference peak (b´). The maximum rider ratio
is recalculated considering b´. The remaining
peaks are classified again. The process is
continued until all peaks of the series are
classified.

Riders can be recognized as such by the
skimming tangent drawn in the chromatogram
plot and by a Ru (Rider up) or Rd (Rider down)
entry in the Type column of the report (tab
Integration).

Tip: In order to be effective, the criterion must be
activated before the peak start!

The criterion ⇒Type (Peak Type) in the peak
table has priority! The criterion specified here, is
effective only in combination with PEAK TYPE =
AUTO!

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Maximum Width
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: min
Value Range: 0.01 ... 999.99
Default: The presetting is 999.99 min so that all peaks

are considered.
Related Param.: ⇒Minimum Width

⇒Maximum Peak Height

Description: The Maximum Width detection parameter
defines the maximum width above which peaks
are ignored during peak detection. The peak
width is measured on the baseline. For peaks that
do not reach the baseline, the width is
extrapolated.

 Tip: The criterion must be activated before the peak
end. The maximum width influences peak
recognition and thus the baseline! In order to
avoid this and to inhibit small peaks in the report
only, choose the Properties command from the
Table menu and activate the Reject peak with
smaller area than ...% option.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.



Detection Parameters 1035

Minimum Area
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Signal dimension ∗∗∗∗ Minute
Value Range: 0.000 ... 1,000,000.000
Default: The default setting is 0.001, i.e. all peaks with an

area > 0.001 [Sig.dimension x minutes] are
integrated.

Related Param.: ⇒Maximum Area Reject
⇒Minimum Width
⇒Minimum Height

Description: The Minimum Area detection parameter is used
as a minimum criterion determining the area
threshold below which peaks are identified during
peak detection or integration.

Function: Should only this inhibition criterion be applied,
peak numbers in the integration report table may
not be consecutive, because two detection
phases are carried out for a chromatogram (i.e.
peak detection and area calculation). The
minimum area parameter might be effective in the
second run only, i.e., a peak may be sorted out
only then, the result being a gap. The No. column
of the result file thus indicates which criterion was
responsible for inhibiting a peak.

 Tip: This parameter must be activated at a retention
time before the start of a peak. It influences peak
recognition and, therefore, also the baseline! In
order to avoid this and to inhibit small peaks in
the report only, choose the Properties command
from the Table menu and activate the Reject
peak with smaller area than ...% option.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Minimum Height
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Signal dimension
Value Range: 0.000 ... 1,000,000.000
Default: The default setting is zero, i.e. all peaks with the

height > 0 [Sig.dimension] are integrated.

Related Param.: ⇒Maximum Height Reject
⇒Minimum Area
⇒Minimum Width
⇒Maximum Peak Height

Description: The Minimum Height detection parameter is
used as a minimum criterion determining the
height threshold below which peaks are identified.

Function: The peak height is measured relative to the
baseline (a). For !Rider Peaks, the height
measurement is relative to the profile of the
carrier peak (b). The baseline can strongly
influence these criteria (c,d).

a) b) c) d)

 Tip: This parameter must be activated for a retention
time before the start of a peak. It influences peak
recognition and, therefore, also the baseline! In
order to avoid this and to inhibit small peaks in
the report only, choose the command Properties
from the Table menu and activate the Reject
peak with smaller area than ...% option.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Minimum Width
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Minute
Value Range: 0.000 ... 1,000,000.000
Default: The default setting is zero, i.e. all peaks with the

width > 0 [minutes] are integrated.

Related Param.: ⇒Minimum Area
⇒Minimum Height

Description: The Minimum Width detection parameter is used
as a minimum criterion defining the minimum
width below which peaks are ignored during peak
detection. Peak width is measured on the
baseline. In the case of peaks not reaching the
baseline, the width is extrapolated

 Tip: This parameter must be activated for a retention
time before the start of a peak. It influences peak
recognition and, therefore, also the baseline! In
order to avoid this and to inhibit small peaks in
the report only, choose the Properties command
from the Table menu and activate the Reject
peak with smaller area than ...% option.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Peak Group Start / Peak Group End
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Selection
Dimension: ---
Value range: Auto, Fixed
Default: Auto
Related Param.: ⇒Baseline Point

⇒Lock Baseline
⇒Inhibit Integration

Description: The two detection parameters Peak Group Start
and Peak Group End allow identification of
several successive peaks as one peak group. A
peak group that has been defined in such a way
is treated as one single peak. The peak
maximum of the largest peak becomes the peak
maximum of the entire group. For the group, only
one name and number is entered in the
chromatogram. Parameters such as area value,
peak height, etc. are determined and displayed
only once.

Function: The Peak Group Start parameter (Peak Group
End parameter, respectively) defines the start
(end) of such a group. The QNT editor sheet
Detection allows you to set the start of the peak
group automatically (Auto). If you choose the
Fixed mode, the baseline will start and end
exactly at the mentioned retention times. The
setting made for the Peak Group Start
parameter is also adopted for Peak Group End.
The system toggles between Peak Group Start
and Peak Group End when appending a line.
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Function (Cont'd): Within one group, the entire peak detection
algorithm is switched off; i.e., the Rider
Threshold and Maximum Rider Ratio detection
parameters are not considered. The area defined
by Peak Group Start and Peak Group End only
indicates the limits in which the algorithm is not
active. Peak start and end as well as the baseline
are determined as usual.

Tip: The time interval defined by peak group start and
peak group end defines only the limits within
which the algorithm is disabled. Peak start, peak
end, and baseline course are determined as
usual!

Instead of setting the peak group start and peak
group end, you can group individual peaks that
are not necessarily consecutive. To do so, use
the ⇒Group column of the peak table in the QNT
editor. Contrary to a peak group that has been
defined via peak group start and peak group end
the individual peaks of this group are still
indicated.

Also see: How to ...: Actions in the QNT Editor  Grouping Peaks.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Peak Purity Start/End Wavelength
(PPWlStart/PPWIEnd)
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Floating point number
Dimension: nm
Value range: 190.0 - 900.0
Default: Start: 190.0 nm; End: 900.0 nm
Related Param.: ⇒Peak Purity Threshold

Description: The two detection parameters Peak Purity Start
Wavelength and Peak Purity End Wavelength
limit the wavelength range for peak purity
calculations.

Function: For calculating the !Peak Purity Index (PPI) and
the !Peak Purity Match Factor, only the
wavelength range within the values limited by
start and end is used.

Tip: As the default limits, the values 190nm (Start)
and 900nm (End) are used. The actually
recorded wavelength range is used for the
calculation if the recorded range of the 3D-field is
smaller.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Peak Purity Threshold (PPTrshold)
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Command
Dimension: ---
Value range: 0.00 ... 100.00
Default: 10.00
Related Param.: ⇒Peak Purity Start/End Wavelength

Description: The Peak Purity Threshold detection parameter
determines the threshold for the signal height
above which spectra comparison is performed for
the UV and !Mass Spectra. The parameter is
important for the Peak Purity Analysis (PPA) and
the Peak Ratio.

Peak Purity Analysis (PPA)
When determining the !Peak Purity Index (PPI)
or the !Peak Purity Match Factor, the parameter
defines the signal height above the baseline,
from which the spectra are extracted for
calculation.

Peak Ratio
For the Peak Ratio, the PPTrshold parameter
defines the signal height above which the ratio is
formed.

Function: Peak Purity Analysis (PPA)
The value is stated in percent of the peak height,
i.e. at the value 20%, only the spectra are used to
determine the match factor for which the signal
height of the peak is at least 20%.
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Function (Cont'd): The smaller the selected value, the wider the
match factor curves. The calculation may include
spectra that no longer have an optimum !Signal
to Noise Ratio. The match factor curve then has
"fringes" at the margins (peak start and peak
end). This can be avoided by a smaller threshold
value.

Limiting the wavelength range that is used for
calculating the center wavelength of the PPI is
possible via the ⇒Peak Purity Start/End
Wavelength detection parameters. A
corresponding limitation to a specified mass
range is not possible for the MS Peak Purity
Match.

Peak Ratio
A value of 10% means that the signal ratio
between two channels is only formed where
the signal intensity exceeds 10% in two
channels (!).

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.



Detection Parameters 1043

Peak Shoulder Threshold
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: -
Value Range: Off; 0.01 ... 1000.00
Default: Off

(i.e., shoulders without relative maximum are not
recognized as peaks. Only if value ≠ Off,
shoulders are detected.)

Rel. Param.: ⇒Rider Threshold
⇒Type (Peak Type)

Description: The Peak Shoulder Threshold parameter
defines a threshold value for peak shoulder
recognition.

Function: First, the average baseline curvature is
determined for the entire chromatogram. The
curvature threshold value is the product of the
average baseline curvature and the threshold
value.
Detected peak shoulders with a maximum
curvature above this threshold value are not
considered. The ⇒Sensitivity detection parameter
allows you to influence the determination of the
average baseline curvature. Higher sensitivity
results in a smaller average baseline curvature
and thus effects peak shoulder recognition.

Tip: Peak shoulders are treated like "normal" peaks.
All other detection parameters (such as rider
criteria, minimum criteria as well as peak
recognition via peak table) except the peak group
parameters (⇒Peak Group Start / Peak Group
End) and the ⇒Valley to Valley parameter are
used for peak shoulders as well.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Peak Slice
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Floating point number
Dimension: Seconds [sec]
Value Range: 0.01 ... 100,000.00
Default: 0.05
Related Param.: This parameter should always be considered in

combination with the ⇒Sensitivity!

Description: The Peak Slice detection parameter determines
the width (= time span) from which several
successive data points are interpreted as peak or
as noise. The presetting is 5/100 seconds.

Function: General Rule
If a specific peak should "just" be interpreted as a
peak and if this was not reached via the Auto
setting, a manual peak slice value can be
specified by selecting the peak width.

Tip: This parameter only refers to peak detection, not
to integration. For area calculation, the original
signal is used.

To change the variables, Sensitivity and Peak
Slice, is only necessary in case of
chromatograms comprising very wide (many
minutes) or very narrow (< 0.1 sec) peaks. Under
normal conditions, the default values should not
be changed.
Graphical definition is recommended above all for
Sensitivity and Peak Slice. For details see. How
to ...:  Actions in the QNT Editor / Modifying
the Peak Recognition Algorithm.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Rider Skimming
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Selection
Dimension: -
Value Range: Tangential at lower peak end, Tangential at

both peak ends or Exponential
Default: Tangential at lower peak end
Rel. Param.: ⇒Rider Threshold

⇒Maximum Rider Ratio
⇒Type (Peak Type)

Description: This parameter indicates how !Rider Peaks are
skimmed.

Function: There are three options:
• Tangential at lower peak end (default and

the common skimming method): For
ascending rider peaks, the peak start, and for
descending rider peaks, the peak end is
defined in such a way that rider skimming is
tangential to the chromatogram.

• Tangential at both peak ends: Peak start
and peak end are determined so that rider
skimming is tangential at both chromatogram
ends.

• Exponential: The chromatogram is
approximated by an exponential function, so
that the slope of the chromatogram and the
exponential function correspond at the peak
start and the peak end of the rider peak. This
option clearly distinguishes from the two
others. In most cases, Exponential maps the
actual course of the curve very accurate. With
this option, the rider peak will usually receive
a more realistic larger area. A sufficient
number of data points must be available to
ensure that this option can be used.
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Tip: When reprocessing a chromatogram, the
skimming function can be set manually for each
rider peak. The required commands are included
in the context menu of the selected peak.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Rider Threshold
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Fixed point number
Dimension: Percent [%]
Value Range: 0.00 ... 100.00
Default: 10.00
Related Param.: ⇒Maximum Rider Ratio

⇒Type (Peak Type)

Description: Both rider variables Rider Threshold and
Maximum Rider Ratio decide whether individual
peaks in a series of non-resolved peaks are
classified as !Rider (skimming peak) or as main
peaks.

Function: The classification as rider or main peak is
decided via the !Peak Height ratio of each
individual peak (here h1 to h5) to the largest peak
(b) in the series (reference peak).
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If the height ratio h/b multiplied by 100 percent
produces a value below the defined rider
threshold, the corresponding peak is by definition
a main peak. Here, this is only the case for the h5
peak.

If the height ratio h/b multiplied by 100 percent
produces a value above the defined rider
threshold, the Rider Threshold criterion is not
sufficient for a clear classification.
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Function (Cont'd): In this case, the ⇒Maximum Rider Ratio is
established. The resulting value allows the
classification of the remaining peaks as rider or
main peaks.

Riders can be recognized as such by the
skimming tangent drawn in the chromatogram
plot and by a Ru (Rider up) or Rd (Rider down)
entry in the Type column of the report
(Integration tab).

Tips: In order to be effective, the criterion must be
activated before the peak start!

The ⇒Type (Peak Type) classification criterion in
the peak table has priority! The criterion specified
here, is effective only in combination with PEAK
TYPE = AUTO!

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Sensitivity
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Floating point number
Dimension: Signal dimension
Value Range: 0.0001 ... 10,000,000.0
Default: 0.0010
Related Param.: Always consider this parameter in combination

with the ⇒Peak Slice

Description: Sensitivity determines in combination with Peak
Slice the granularity of the peak detection
algorithm, i.e., when using small values, even the
smallest signals (e.g. pump pulsation) are
interpreted as peaks, whereas such signals are
ignored when using higher values.

Function: Peak recognition is performed using a rectangle
formed by the granularity of the y-axis
(Sensitivity) and the granularity of the x-axis
(Peak Slice) (see figure a):

Y-Axis

X-Axis

Sensitivity

Peak Slice

)
As shown in figure a), this rectangle is placed
with its lower left corner on the first data point,
and is duplicated by mirroring in the direction of
negative y-values. As long as none of the
subsequent data points is above or below the
mirrored rectangle, the last data point will be used
for positioning further rectangles (b). The
measured signal is interpreted as noise.



1050 Detection Parameters

Function (Cont'd):

b) c)

If three successive data points are located above
or below the rectangle (simplified!), the peak
recognition algorithm will recognize a peak. When
the signal difference of one data point to the next
one becomes so small that they are within the
bandwidth again, the peak end is indicated (c).

Manually Setting the Parameters Sensitivity
and Peak Slice
You can manually modify the granularity of the
peak recognition, i.e., determine the size of the
rectangle or the bandwidth. The larger the area,
the lower the sensitivity of the system. Smaller
peaks are likely to be interpreted as noise.

General Rule
If a specific peak shall "just" be interpreted as a
peak and if this was not achieved via the Auto
setting, specify a manual Sensitivity value of a
third of the signal height of the peak.

Tip: This parameter refers to peak detection only, not
to integration. For area calculation, the original
signal is used.

Using the Sensitivity and Peak Slice variables is
only necessary in case of chromatograms
comprising very wide (many minutes) or very
narrow (< 0.1 sec) peaks. Under normal
conditions, the default values should not be
changed.
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Tip (Cont'd): Sensitivity is always interpreted in the dimension
installed (e.g. mAU)!

Graphical definition is recommended above all for
Sensitivity and Peak Slice. For details, see How
to ...:  Actions in the QNT Editor / Modifying
the Peak Recognition Algorithm.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Tailing/Fronting Sensitivity Factor
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Floating point number
Dimension: ---
Value range: Off; 1.0 ... 100.0
Default: Off
Related Param.: Baseline Point, Lock baseline, Inhibit Integration
Description: This detection parameter is an implicit threshold for

setting the peak end. In the case of the Fronting
sensitivity factor, the options refer to the peak
start.

Function: The following paragraphs describe the Tailing
sensitivity factor options. The Fronting sensitivity
factor behaves in the same way.

Off (=0): The peak end is moved on the time axis until the
slopes of the chromatogram and of the baseline
correspond in the peak end.

Factor 1 - 100: Determining the time for the peak end is as
described in the above case (Off). Then, the right
baseline width is determined. (This is the !Right
Width peak variable, Baseline Level parameter or
peak.right_width(0)). This value is then multiplied
by the Tailing sensitivity factor and forms the
upper limit for the distance between peak retention
time and peak end. If this limit is exceeded, the peak
end is corrected and is reset accordingly.

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Valley to Valley
Location: Tab Detection / Report Variable (Detection

Parameters)
Type: Switch
Dimension: ---
Value Range: On / Off
Default: Off
Description: Usually, the baseline is determined with an

algorithm. This switch enables baseline treatment
from valley-to-valley, i.e., from minimum to
minimum, in a series of non-resolved peaks.

Function: When turned on, the baseline below non-resolved
peaks leads from peak end to peak end.

Default Valley to Valley

Tips: The end of the last non-resolved peak in a series
of peaks is always a baseline point since the
chromatogram itself forms the baseline outside
the peak!

This parameter is invalidated by ⇒Lock Baseline!

The ⇒Type (Peak Type) criterion of the peak
table has absolute priority!

For a description on how to use individual detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.
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Report Definition File (RDF)
Report Definition Files (RDFs) have two functions: They serve to display and
reprocess your results on the screen (Report) on the one hand and to prepare
the printout (!Printer Layout) on the other.

All settings regarding user-specific representation of chromatographic data in
different windows are stored in the Report Template (= Report Definition). In
connection with the !Workspace, this enables the user to arrange the screen
according to individual requirements.

If no workspace is loaded, each new window is opened based on the most
recently used RDF. If no Report Definitions were stored, the default RDF
included in the Dionex Chromatography Management System (DEFAULT-
RDF) is used. It is located in the Report directory.

Each RDF contains specific information on window sections and views, window
presentations, and captions, color, size of individual elements, and the
presentation of reports. This regards the following questions:

• Is the window contents (e.g. a chromatogram) shown in the zoomed view
or in the full-scale view?

• Which type of axis scaling is used?

• Which additional objects (e.g. grid, comparison chromatogram, units, etc.)
are displayed?

• Which colors are used for comparison chromatograms, captions, etc.?

• Are other window sections displayed (Spectra Plot, Calibration Curve,
Report, etc.)?

• Which worksheet make up the report and how is the report formatted?

• Which columns does the worksheet include?

etc.

On the following pages, you will find a table listing the various ⇒Report
Categories as well as tables for the individual categories with brief explanations
on the individual report variables.
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Report Categories
Proceed as described under How to ...: Actions in the Report  Linking
Report Variables to link report variables listed on the following pages via the
four basic arithmetic operations, and thus create user-defined report variables.

The report variables belong to the following categories:
Category Formula Variables

⇒General gen.* General variables (in the !Printer
Layout only)

⇒Sequence seq.* ⇒Sequence variables

⇒Sample smp.* Sample variables

⇒Audit Trail AUDIT.*  Audit Trail variables (protocol
variables)

⇒Chromatogram chm.* Chromatogram variables

⇒Detection Parameters det.* ⇒Detection Parameters variables

⇒Peak Results peak.* Peak result variables

⇒Peak Calibration peak.* Calibration variables

⇒Peak Table peakTab.* Peak table variables

⇒Mass Spectrometry ms.* !Mass Spectra variables

⇒Peak Purity peak.* Peak purity variables

⇒Quantification Method qnt.* Quantification method variables (in
the Printer Layout only)

⇒System Suitability
Test

sst. !System Suitability Test (SST)
variables (in the Printer Layout
only)

⇒History history.* !History variables (in the history
report only)

⇒Integration/Summary
Table

table.group* Variables for statistics concerning
sample groups / replicates (named
Summary Table from the sheet
Summary - else: Integration
Table)
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Category Formula Variables

⇒Mass Spectrum msspec.* Mass spectra variables (accessible
via the Select Spectrum variable
of the Mass Spectrometry
category)

⇒Spectrum Data peak.spectru
m.*

Peak spectra variables (accessible
via the Reference Spectrum
variable of the Peak Table
category)

⇒Hit Spectrum hitSpec.* Variables concerning spectra of
spectra libraries (accessible via the
SLS Hit variable of the Peak Purity
category)

⇒Spectra Library specLib.* Spectra library variables
(accessible via the Library Record
variable of the Hit Spectrum
category)

⇒User Information ~.* Variables concerning the
corresponding user (accessible via
all Operator variables of the
different categories. ~: Formula
depends on the way you opened
the category.)

These Help pages briefly describe the respective variables of the
corresponding categories.
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Category "General"
The General category is available only in the !Printer Layout. It contains the
following variables:

Variable Formula Description
Version Number gen.version
Operator Name gen.operator User name - branches to the

⇒User Information category
Serial Number gen.serialNo
Key Code gen.keyCode
Computer Name gen.computerName

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.

Category "⇒Sequence"
Variable Formula Description

Name seq.name Sequence name
Directory seq.path Directory in which the

sequence is stored
Datasource seq.dsn Name of the corresponding

!Datasource
Timebase seq.timebase !Timebase of last run
Title seq.title Sequence header
Number of Samples seq.nSamples
Creation Date & Time seq.creation_time (See! Time)
Creation Operator seq.creation_operator Branches to the ⇒User

Information category
Last Update Date & Time seq.update_time
Last Update Operator seq.update_operator Branches to the User

Information category
Preferred RDF File seq.prefRdf Preferred ⇒Report Definition

File
Preferred Channel seq.prefChl Preferred !Channel
Sign Status seq.signStatus Status of the! Electronic

Signature
Submit Date & Time seq.submitTime Date and time when

submitting the electronic
signature
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Variable Formula Description
Submit Operator seq.submitOperator� User who submitted the

electronic signature -
branches to the User
Information category

Submit Comment seq.submitComment Comment when submitting
the electronic signature

Review Date & Time seq.reviewTime Date and time when
checking the electronic
signature

Review Operator seq.reviewOperator� User who checked the
electronic signature -
branches to the User
Information category

Review Comment seq.reviewComment Comment when checking
the electronic signature

Approve Date & Time seq.approveTime Date and time when the
approving the electronic
signature

Approve Operator seq.approveOperator� User who approved the
electronic signature -
branches to the User
Information category

Approve Comment seq.approveTime Comment when approving
the electronic signature

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "⇒Sample"
Variable Formula Description

Sample Number smp.number ⇒No.
Sample Name smp.name ⇒Name
Raw Data ID smp.id
Sample ID smp.ident ⇒Sample ID
Comment smp.comment ⇒Comment
Sample Type smp.type ⇒Type (sample type)
Vial Number smp.position See ⇒Pos. (sample position)
Replicate ID smp.replicate ⇒Replicate ID
Status smp.status ⇒Status (sample status):

Single/Finished/Multiple/Runn
ing

Date & Time Sample Run smp.time See: ⇒Inj. Date/Time and
!Time

Inject Volume smp.inject_volume ⇒Inj. Vol. (injection volume)
Dilution Factor smp.dilution_factor See: ⇒Dil. Factor
Sample Weight smp.weight ⇒Weight (sample weight)
ISTD Amount smp.amount See: ⇒ISTD Amount (amount

of the !Internal Standard
(ISTD))

Program smp.program !PGM File
Quantification Method smp.method !Quantification Method (QNT

method)

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Audit Trail"
Depending on the connected instrumentation hundreds of !Audit Trail
variables are available. The list below shows those variables only that are
available during data acquisition with a P580 pump and an UVD 340 detector.

Variable Formula Description
Lower Limit (Pressure) AUDIT.Pressure.Lower

Limit
Lower ⇒Pressure Limit

Upper Limit (Pressure) AUDIT.Pressure.Upper
Limit

Equate (%A) AUDIT.%A.Equate Name of eluent component A
Max. Wavelength
(3DFIELD)

AUDIT.3DFIELD.Max
Wavelength

Max. wavelength of the !3D-Field

Min. Wavelength
(3DFIELD)

AUDIT.3DFIELD.Min
Wavelength

Min. wavelength of the 3D field

Bunch Width AUDIT.3DFIELD.Bunch
Width

⇒Bunch Width of the diode bundle

Wavelength AUDIT.Wavelength ⇒Wavelength
Bandwidth AUDIT.BandWidth ⇒Bandwidth
Step AUDIT.Step ⇒Step
Average AUDIT.Average Status of Averaging ( see:⇒ Average)
Ref Wavelength AUDIT.RefWavelength ⇒Reference Wavelength
Ref Bandwidth AUDIT.RefBandwidth ⇒Reference Bandwidth
Flow AUDIT.Flow ⇒Flow rate
%A (%B, %C  or  %D) AUDIT.%A Percentage of the respective

component in the eluent (⇒%B, %C,
%D)

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Chromatogram"
Depending on the connected detector(s), several different chromatogram
variables are available. The list below shows those variables only that are
available during data acquisition with an UVD340 detector or an aQa !Mass
Spectrometer.

Variable Formula Description
Channel Name chm.channel
Raw Data File Path Name chm.rawpath See: !Raw Data
Number of Peaks chm.nPeak
Select Peak chm.peak(OPT) ⇒Select Peak selects peak in

the chromatogram according to
input; opens the ⇒Peak
Results category

Count Peaks if ... chm.countIF Counts the peaks which ...
Sum Peak Results if ... chm.sumIF Adds up the peak

characteristics of peaks which
....

Start Time (relative to Inject
Time)

chm.start_time Chromatogram start time [min]

End Time (relative to Inject
Time)

chm.end_time Chromatogram end time [min]

Signal Value chm.sig_value Signal value [e.g. in mAU]
Signal Dimension chm.sig_dim
Signal Noise chm.noise [in mAU]
Sample Rate chm.sig_step
Modified? chm.manipulated (Yes/no)
Modification Time chm.manip_time Corresponding date/time
Modification Operator chm.manip_operator Corresponding operator -

branches to the ⇒User
Information category

XXXXX Start Value chm.XXXXX Start value of the signal
parameter XXXXX when
acquiring data.

Delay Time Value chm.delayTimeValue ⇒Delay Time between two
detectors

Delay Time Detector chm.delayTimeDetector Name of the second detector
Average chm.Average ⇒Average (for UV channels

only)
Step chm.Step ⇒Step (for UV channels only)
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Variable Formula Description
Wavelength chm.Wavelength ⇒Wavelength (for UV channels

only)
Bandwidth chm.Bandwidth ⇒Bandwidth (for UV channels

only)
RefWavelength chm.RefWavelength See ⇒Reference Wavelength)

(for UV channels only)
RefBandwidth chm.RefBandwidth See ⇒Reference Bandwidth)

(for UV channels only)
MassRange chm.MassRange Mass range of the mass

spectrometer channel (for MS
channels only)

Polarity chm.Polarity Polarity of the !Mass
Spectrometer channel (for MS
channels only)

Source Voltage chm.Voltage Voltage of the mass
spectrometer channel (for MS
channels only)

Smoothing chm.Smoothing Smoothing algorithm (in
parenthesis: number of
smoothing points) (for MS
channels only or if explicitly
performed)

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Detection Parameters"
Variable Formula Description

Minimum Area det.minArea ⇒Minimum Peak Area
Maximum Area Reject det.maxAreaRj ⇒Maximum Area Reject
Minimum Height det.minHeight ⇒Minimum Height
Maximum Height Reject det.maxHeightRj ⇒Maximum Height Reject
Maximum Peak Height det.maxHeight ⇒Maximum Peak Height
Minimum Width det.minWidth ⇒Minimum Width
Maximum Width det.maxWidth ⇒Maximum Width
Rider Threshold det.riderMin ⇒Rider Threshold
Maximum Rider Ratio det.riderRatio ⇒Maximum Rider Ratio
Rider Skimming det.riderSkim !Rider⇒ Skimming
Peak Shoulder Threshold det.shoulderThrshld ⇒Peak Shoulder Threshold
Front Riders to Main Peaks det.frontRiderToMain ⇒Front Riders to Main Peaks
Detect Negative Peaks det.negDetect ⇒Detect Negative Peaks
Lock Baseline det.lockBl ⇒Lock Baseline
Valley to Valley det.valval Baseline from ⇒Valley to

Valley
Inhibit Integration det.noInteg ⇒Inhibit Integration
Sensitivity det.noise ⇒Sensitivity
Peak Slice det.filter ⇒Peak Slice
Fronting Sensitivity Factor det.frontFac ⇒Fronting Sensitivity Factor
Tailing Sensitivity Factor det.tailFac ⇒Tailing Sensitivity Factor
Part of a Peak Group? det.isInGroup See: ⇒Group
Peak Purity Threshold det.ppThrshld ⇒Peak Purity Threshold
Peak Purity Start Wavelength det.ppStartWl ⇒Peak Purity Start

Wavelength
Peak Purity End Wavelength det.ppEndWl ⇒Peak Purity End

Wavelength

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Peak Results"
Variable Formula Description

Number peak.number
Name peak.name ⇒Name (Peak Name)
Group peak.group ⇒Group (Peak Group)
Link Count peak.linkCount Number of substances

assigned in one peak
Retention Time peak.retention_time ⇒Retention Time in [min]
Retention Deviation peak.retention_deviation Deviation in [min] or [%],

depending on parameter (abs
or rel)

Relative Retention Time peak.rel_retention_time
Retention Window Width peak retention windows Width of the Retention⇒

Window
Area peak.area Peak area for UV detectors in

[min * mAU]
Relative Area peak.rel_area Parameters: total, identified,

group, istd, rel
Group Area peak.groupArea Total of the peak ⇒Group

areas
Height peak.height Peak height for UV detectors

in [mAU]
Relative Height peak.rel_height Parameters total, identified,

group, istd, rel
Group Height peak.groupHeight Total of the heights of the

peak group
Amount peak.amount ⇒Amount or concentration
Amount Deviation peak.amount_deviation Deviation analogous to

retention_deviation
Concentration peak.concentration Concentration:

amount/injection volume
Relative Amount peak.rel_amount Parameters total, group,

istd, rel
Group Amount peak.groupAmount Peak ⇒Group amount
Width peak.width Peak width (Parameters 0, 5,

10, 50 in % of signal height
above baseline - 0 base width
with tangent method)

Left Width peak.left_width For the parameters, see
Width

Right Width peak.right_width For the parameters, see
Width
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Variable Formula Description
Peak Start Time peak.start_time In [min]
Peak Stop Time peak.stop_time In [min]
Signal Value at Peak Start peak.start_value !Signal Value at Peak Start

in [mAU]
Signal Value at Peak End peak.stop_value !Signal Value at Peak Stop

in [mAU]
Baseline Value at Peak Start peak.start_value_baseline !Baseline Value at Peak

Start in [mAU]
Baseline Value at Peak End peak.stop_value_baseline !Baseline Value at Peak

Stop in [mAU]
Detection Code at Peak Start peak.start_detection_code !Det. Code (AIA) -Peak Start
Detection Code at Peak End peak.stop_detection_code !Det. Code (AIA) -Peak Stop
Type peak.type Peak⇒ Type
Modified peak.modified Modified peak?
Manually Assigned peak.assigned Manually assigned peak?
Resolution peak.resolution !Resolution (parameters EP

and USP)
Asymmetry peak.asymmetry Peak !Asymmetry,

parameters EP and AIA
Theoretical Plates peak.theoretical_plates !Theoretical Plates

(parameters EP and USP)
Skewness peak.skewness !Skewness
K' peak.kValue !Capacity Factor
Retention Index peak.ri Linear ⇒Retention Index
Kovats Index peak.ki ⇒Kovats Index

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Peak Calibration"
Variable Formula Description

Calibration Mode peak.calMode ⇒Calibration Mode
Auto Recalibrate peak.autoRelCal Auto calibration On/Off
Reference Inject Volume peak.reference_inject_volume Reference Injection Volume
Calibration Type peak.calibration_type ⇒Calibration Type
Weights peak.calibration_weight !Weights
Offset (c0) peak.offset !Offset c0
Slope (c1) peak.slope !Slope c1
Curve (c2) peak.curve !Curve c2
RF-Value (Amount/Area) peak.rf_value (1/c1) (see: !RF-Value

(Amount/Area))
Number of Calibration Points peak.nCalpoints !Number of Calibration

Points
Number of Disabled Calibr.
Points

peak.nCalDisabled !Number of Disabled
Calibration Points

Variance peak.variance !Variance
Variance Coefficient peak.variance_coefficient !Variance Coefficient
Standard Deviation peak.standard_deviation !Standard Deviation
Relative Standard Deviation peak.rel_standard_deviation !Relative Standard

Deviation
Correlation Coefficient peak.correlation_coefficient !Correlation Coefficient
Coefficient of Determination peak.rQuadrat !Coefficient of

Determination
DOF-Adj. Coefficient of
Determination

peak.rQuadratAdj !DOF-Adjusted Coefficient
of Determination

Calibration Point x peak.calPointX
Calibration Point y peak.calPointY
Calibration Point Weight peak.calPointWeight !Calibration Point weighting
Evaluation of Calibration
Function

peak.calPointFX

Residual for Cal. Point x peak.calPointDist
Calibration Point Status peak.calPointStatus
Relative Retention Index peak.rri("lin")

peak.rri("log")
Linear rel. retention index
logarithmic rel. ret. index

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Peak Table"
Variable Formula Description

Number peakTab.number Peak number
Peak Name peakTab.name Peak ⇒Name
Retention Time peakTab.retention_time ⇒Retention Time in [min]
Retention Time Interpretation peakTab.retention_type Specification of retention

times
Use Prev. Retention Time peakTab.use_previous_rettime Status of corresponding

variable in QNT file (see
⇒Use Recent Retention
Time)

Window peakTab.window Time ⇒Window width
Standard Method peakTab.standard_method see ⇒Standard
Integration Type peakTab.integration_type ⇒Integration Type
Calibration Type peakTab.calibration_type ⇒Calibration Type
Peak Type peakTab.type See ⇒Type
Left Limit peakTab.left_limit ⇒Left Limit)
Right Limit peakTab.right_limit See ⇒Right Limit)
Peak Group peakTab.group See ⇒Group
Response Factor peakTab.response_factor ⇒Response Factor
Amount peakTab.amount ⇒Amount
Amount Dimension peakTab.amount_dimension
C0 Value peakTab.C0 Y !Offset of the

calibration curve
C1 Value peakTab.C1 !Slope of the calibration

curve
C2 Value peakTab.C2 Curvature of the

calibration! Curve
Reference Spectrum peakTab.reference_spectrum.x ⇒Reference Spectrum,

opens the category
⇒Spectrum Data

Match Criterion peakTab.spec_compare_metho
d

⇒Match Criterion

Check Derivative peakTab.spec_derivative ⇒Check Derivative
Minimum Wavelength peakTab.spec_min_wavelength Lower limit of the

compared wavelength
range (see ⇒Minimum
Wavelength)

Maximum Wavelength peakTab.spec_max_wavelength Upper limit of the
compared wavelength
range (see ⇒Maximum
Wavelength)
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Variable Formula Description
Threshold peakTab.spec_threshold ⇒Threshold value for

spectra search
Relative Maximum Deviation peakTab.spec_relmaxdev ⇒Relative Maximum

Deviation during spectra
search

Check Number of rel.
Extrema

peakTab.spec_check_extrema Checking the number of
extrema during spectra
search (see ⇒Check
Extrema)

Comment peakTab.comment ⇒Comment
Retention Index peakTab.ri Linear ⇒Retention Index
Kovats Index peakTab.ki ⇒Kovats Index
Mass Peak x peakTab.ms_peakx Mass of Peak x
MS Threshold peakTab.ms_threshold Threshold for Mass
MS Filter peakTab.ms_filter Mass Filter
Check of mass ratios peakTab.ms_enable_rejection
Check of MS retention times peakTab.ms_check_traces

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Mass Spectrometry"
Variable Formula Description
Spectrum
Enhancement

ms.spec_enhanced Indicates whether !Mass Spectra
averaging is activated

Peak Top Region ms.nSpec_peak_top Number of averaged single spectra at peak
maximum

Left Background
Subtraction Region

ms.nSpec_left_BG Number of single spectra that are averaged
for the left background spectrum

Right Background
Subtraction Region

ms.nSpec_right_BG Number of single spectra that are averaged
for the right background spectrum

Delay Time ms.delay_time ⇒Delay Time of the !Mass Spectrometer
Instrument
Information

ms.instrument Information on the mass spectrometer

Tune Data ms.tune Tune data of the !Xcalibur raw data file
Instrument Method ms.method MS method
Status Log ms.statusLog Information on the status of the MS system

at a specified time
Spectra Count ms.spec_count Number of mass spectra
Select Spectrum ms.spectrum Opens the ⇒Mass Spectrum category

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.



1070 Report Categories

Category "Peak Purity and Identification"
Variable Formula Description

Peak Purity Index peak.ppi Average !PPI (Peak Purity
Index) in nm over the entire
peak (from a specific height)

RSD Peak Purity Index peak.rsd_ppi Correspond. Rel.Std.Dev.
Peak Purity Match peak.match Average !Peak Purity Match

Factor (0..1000) over the
entire peak (from a specific
height detection parameter)

RSD Peak Purity Match peak.rsd_match Corresponding Rel.Std.Dev.
Peak Ratio Mean Value peak.ratio Average ratio value (BL-

corrected) with the "next"
channel.

RSD Peak Ratio peak.rsd_ratio Corresponding Rel.Std.Dev.
value

Peak Spectrum peak.spectrum.x Opens the ⇒Spectrum Data
category

Reference Spectrum Match peak.refMatch (See: !Match Factor)
Number of SLS Hits peak.nSlsHits No. of reference spectra
SLS Hit hitSpec.x Opens the ⇒Hit Spectrum

category
Mass of n-th MS peak peak.ms_peak_

mass(n)
Intensity of n-th MS peak peak.ms_peak_

intens(n,"peak1")
Position of mass peak
maximum

peak.ms_peak_
maximum(n."retTime")

Mass of MS base peak peak.ms_base_peak_mass (See: !Base Peak and
!Mass Spectrum

Intensity of MS base peak peak.ms_base_peak_
intens

Mass Spectrum peak.msspectrum Opens the �Mass Spectrum
category

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Quantification Method"
The Quantification Method category is available only in Summary tables and
in individual cells in the !Printer Layout. It contains the following variables:

Variable Formula Description
Name qnt.name QNT file name
Directory qnt.path Directory where the QNT file

is saved
Datasource qnt.dsn Name of corresponding

datasource
Title qnt.title QNT file description
Creation Date & Time qnt.creation_time
Creation Operator qnt.creation_operator.x Branches to the ⇒User

Information category
Last Update Date & Time qnt.update_time
Last Update Operator qnt.update_operator Branches to the User

Information category
Parent Sequence Name qnt.seq_name
Sequence Header Record qnt.sequence.x Opens the ⇒Sequence

category
Dead Time qnt.deadTime ⇒Dead Time
Delay Time Value qnt.delayTimeValue Also, see ⇒Delay Time
Delay Time Detector qnt.delayTimeDetector Corresponding detector
Blank Run Subtraction qnt.blankRun Mode Status of !Blank Run

Subtraction
Blank Run Sample Record qnt.blankRunSample.x Opens the ⇒Sample

category
Number of Detection
Parameters

qnt.nDet

Number of Peaks in the Peak
Table

qnt.nPeaks

Select Peak in the Peak
Table

qnt.peakTabLine("OPT") ⇒Select Peak in the Peak
Table selects peak in
chromatogram according to
the included option - opens
the ⇒Peak Table category
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Variable Formula Description
SST Result qnt.sst-result Total result of all single

!System Suitability Tests
(SST)

SST Rows qnt.sst_rows Number of lines (= number of
single System Suitability
Tests) on the SST page in the
QNT editor

Select SST qnt.sst(n).x Opens the category: ⇒SST.
You can then select a
variable for the chosen single
System Suitability Test with
the number n.

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "System Suitability Test"
Usually, the !System Suitability Test category is available only in the !Printer
Layout or in the SST Report. However, it can be opened as well via the Select
SST variable of the ⇒Quantification Method. In this case, the formulas start
with qnt.sst(n).x instead of sst.x and the variables refer to the single SST
referenced by the number n in brackets. Otherwise, the variables refer to the
current single SST.

The System Suitability Test category contains the following variables:

Variable Formula Description
Number sst.number Number of the SST
Name sst.name Name of the SST
Sample Condition sst.sample_condition Sample condition for the SST
Test Condition qnt.test_condition
Aggregate Condition qnt.aggregate Aggregate function
Operator qnt.operator
Value qnt.value
Channel qnt.channel
Peak Condition qnt.peak
N.A. qnt.n_a User defined test result if the

condition cannot be evaluated.
Fail Action sst.fail_action
Aggregated Samples sst.agg_number_real
Sample Condition Result sst.sample_cond_result
Test Results sst.results
List of Aggregated Samples sst.agg_list
Result List for Aggr. Samples sst.agg_list_results
Results of Test Condition or
Aggregate

sst.test_cond_result

Result of Compare Value sst.value_result

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "History"
The !History category is available in the History Report only. It contains the
following variables:

Variable Formula Description
Object Name history.name
Object Path history.path Data path, object path and name.
Object Version history.version Version of the modified object.
Date/Time history.time Date and Time (see! Time) of the

modification.
Operator history.operator User - branches to the ⇒User

Information category.
Operation history.operation Short description of the modification.
Comment history.comment
Detail Number history.detail_number
Detail Object history.detail_object
Detail Column history.detail_column
Detail Old Value history.detail_old_value Old value of the modified field.
Detail New Value history.detail_new_value New value of the modified field.
Detail Comment history.detail_comment

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Categories "Integration Table" and "Summary Table"
The variables of the Integration/Summary Table category allow you to
calculate various statistical values of samples/replicates. Using these variables
makes sense only if the table has been sorted before applying them.

The category contains the following variables:

Variable Formula Description
Group Sum table.groupSum Total number of report lines

with identical group criterion
Group Count table.groupCount Number of report lines with

identical group criterion
Group Average table.groupAverage Average of report lines with

identical group criterion
Group Standard Deviation table.groupStdev Standard deviation of report

lines with identical group
criterion

Group Relative Standard
Deviation

table.groupRelStdev Relative standard deviation
of report lines with identical
group criterion

 Note: On the sheet Summary the category is named Summary Table.
Else, it is called Integration Table.

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Spectrum Data"
Open the Spectrum Data category via the Reference Spectrum variable of
the ⇒Peak Table category. It contains the following variables:

Variable Formula Description
Lambda Min peak.spectrum.wlmin Lower limit of

wavelength range
Lambda Max peak.spectrum.wlmax Upper limit of

wavelength range
Lambda Resolution peak.spectrum.wlResolution Wavelength resolution
Sample Rate peak.spectrum.acqStep
Absorbance Value peak.spectrum.sig_value("max")
Absorbance Extremum
at [nm]

peak.spectrum.extremum("relMax")

For an overview on the different report variable categories including links to the
lists for the respective categories, see: ⇒Report Categories.

Category "Mass Spectrum"
Open the Mass Spectrum category via the Select Spectrum variable of the
⇒Mass Spectrometry category. It contains the following variables:

Variable Formula Description
Number of Data Points mspec.mass_count
Mass mspec.mass Mass [amu]
Intensity mspec.intensity Intensity [counts]
Relative Intensity mspec.rel_intensity Relative Intensity (%)
Minimal Mass mspec.mass_min Minimal mass [amu]
Maximal Mass mspec.mass_max Maximal mass [amu]
Spectrum Type mspec.type Spectra type (centroid /

profile)
Resolution mspec.resolution Resolution of the !Mass

Spectrum
Total Ion Current mspec.TIC Number of !TIC channels
Noise Removed mspec.threshold.*

(z.B. mspec.threshold.mass)
Opens the ⇒Mass
Spectrum category for
spectra with reduced
!Signal to Noise Ratio

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Hit Spectrum"
Open the Hit Spectrum category via the SLS Hit variable of the ⇒Peak Purity
category. It contains the following variables for the matching reference
spectrum:

Variable Formula Description
Substance Name hitSpec.name
Match Factor hitSpec.match !Match Factor
Library Name hitSpec.lib_name Spectra library name
Library Record hitSpec.specLib.x Opens the ⇒Spectra Library

category
Number of rel Extrema hitSpec.nExtrema
Solvents hitSpec.solvent
Comment hitSpec.comment !Comment
Sequence Name hitSpec.seq_name
Sequence Header Record hitSpec. sequence.x Opens the ⇒Sample category
Sample Name hitSpec.smp_name
Sample Record hitSpec.sample.x Branches to the ⇒Sample

category
Acquisition Time hitSpec.acqTime
Timebase hitSpec.timebase !Timebase
Program hitSpec.program !PGM File used for recording

the library spectrum.
Sample Rate hitSpec.acqStep
Retention Time hitSpec.retention_time ⇒Retention Time
Lambda Min hitSpec.wlMin Lower limit of wavelength range
Lambda Max hitSpec.wlMax Upper limit of wavelength range
Lambda Range hitSpec.wlRange Wavelength range
Lambda Resolution hitSpec.wlResolution Wavelength resolution
Detector Name hitSpec.detectorName
Detector Serial No. hitSpec.detectorSerNo
Extract Time hitSpec.extrTime
Extract Operator hitSpec.operator Branches to the ⇒User

Information category
Retention Index (lin) hitSpec.ri Linear ⇒Retention Index
Kovats Index hitSpec.ri ⇒Kovats Index

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "Spectra Library"
Open the Spectra Library category via the Library Record variable of the
⇒Hit Spectrum category. It contains the following variables:

Variable Formula Description
Name specLib.name Spectra library name
Directory specLib.path Directory in which the

spectra library is saved
Datasource specLib.dsn Name of corresponding

datasource
Timebase specLib.timebase Timebase where the

reference spectrum was
recorded

Title specLib.title Spectra library description
Number of Spectra specLib.nSpectra
Creation Date & Time specLib.creation_time (See !Time)
Creation Operator specLib.creation_operator Branches to the ⇒User

Information category
Creation Software Version specLib.creation_ version
Last Update Date & Time specLib.update_time
Last Update Operator specLib.update_operator Branches to the User

Information category
Last Update Software Version specLib.update_version

Retention Index (lin) specLib.ri Linear ⇒Retention Index

Kovats Index (log) specLib.ki ⇒Kovats Index

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.
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Category "User Information"
You can open the User Information category via all Operator variables of the
different categories (e.g. via the Creation Operator variable of the ⇒Sequence
category except the Operator variable of the System Suitability Test
Category). The category contains the following variables (formulas according to
the above mentioned example):

Variable Formula Description
User ID seq.creation_operator.userID ID of the user

User Name seq.creation_operator.userName Name of the user
Job Title seq.creation_operator.jobTitle Job title of the user

For an overview on the different report variable categories including links to the
lists for the respective categories, see ⇒Report Categories.

"Select Peak" Options (OPT)
For the Select Peak and Select Peak in the Peak Table report variables, you
can choose between various options in the Formula field. These variables are
included in the ⇒Chromatogram and ⇒Quantification Method report
categories. Depending on the category, the options have different meanings:

Report Category "Chromatogram":
"Formula": chm.peak(OPT, [Name, Number])

OPT = "By Number"
(default):

Searches the chromatogram for the peak with the indicated
number. Example: chm.peak("By Number," 1).area
determines the area of the first peak in the chromatogram.

OPT = "By Name": Searches the chromatogram for the peak with the indicated
name. Example: chm.peak("By Name," "Benzene").amount
determines the amount of benzene in the sample.

OPT = "By Tab.Number": Searches the chromatogram for the peak that was identified by
the corresponding line in the peak table. Example:
chm.peak("By Tab.Number," 2).height searches the
chromatogram for the peak that was identified by the second
peak in the peak table, and then it determines its height.

OPT = "By Group": Searches the chromatogram for the first peak in a specific peak
group. Example: chm.peak("By Group," "CKW").amount
searches the chromatogram for the first peak in the ⇒Group
(Peak Group) called CKW and then determines its ⇒Amount.
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OPT = "By SLS-Hit": Searches the chromatogram for a peak for which at least one
SLS hit is available. Example: chm.peak("By SLS-Hit,"
2).hitSpec(1).name selects the second peak in the
chromatogram for which at least one SLS hit is available. In
addition, the name of the respective library spectrum with the
best match is indicated.

OPT = "ISTD": Searches the chromatogram for the !Internal Standard peak. If
there are several ISTD peaks, the number of the ISTD peak
can be indicated by a second parameter. Example:
chm.peak("ISTD").area searches the chromatogram for the
first ISTD peak and then calculates its area. chm.peak("ISTD,"
2).area calculates the area of the second ISTD peak.

OPT = "Ref": Searches the chromatogram for the reference peak (Retention
Time Interpretation as Time Distance to ... or Time Ratio
to...). For example: chm.peak("Ref").retention_time searches
for the reference peak and then calculates the corresponding
retention time.

Report Category "Quantification Method"

"Formula": qnt.peakTabLine(OPT, [name, number])
OPT = "By Name": Searches the peak table for the first line with the corresponding

name. Example: qnt.peakTabLine("By Name,"
"Benzene").amount(1) returns the value in the first amount
column for the peak �Benzene�.

OPT = "By Number"
(default):

Searches the peak table for the line with the corresponding
number. Example: qnt.peakTabLine("By Number," 1).name
returns the name of the first peak in the peak table.

OPT = "By Group": Searches the peak table for the first line with the specified
group entry. Example: qnt.peakTabLine("By Group,"
"CKW").amount(1) returns the value in the first amount column
for the first peak in the group called CKW.

OPT = "ISTD": Searches the peak table for the line with the ISTD peak. If there
are several ISTD peaks, the corresponding number can be
specified via the second parameter. If no number is specified,
the first ISTD peak will be used. Example:
qnt.peakTabLine("ISTD," 2).name returns the name of the
second ISTD peak.

OPT = "Ref": Searches the peak table for the line with the reference peak
(Retention Time Interpretation as Time Distance to ... or Time
Ratio to...). Example: qnt.peakTabLine ("Ref").name returns
the name of the reference peak.
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%B, %C, %D (Partial Flows)
The amount information for the partial flow is stated in percent of the ⇒Flow
Rate. The total sum of all partial flows is 100%
(%A + %B + %C + %D = 100%), where %A is calculated from the remaining
partial flows (%A = 100% - (%B + %C + %D)). It is therefore sufficient to
determine the values for %B, %C, and %D.

Changing the % ratio during the analysis is referred to as %-Gradient.

Also, see ⇒%B, %C, %D (Partial Flows).

%-Gradient
If the composition of the delivered solvent mixture changes during the analysis,
this is referred to as %-gradient. The composition can be modified immediately
( Step Gradient) or over a certain period.

 Caution: Depending on the dead volume of the pump, the required time
for changing the mixing ratio varies. The greater the dead
volume, the later the new mixing ratio will be realized and the
later the solvent mixture will reach the column. The user should
therefore take care to perform gradient courses in sensible
intervals.

3D-Field
A Photodiode Array Detector (PDA) simultaneously measures the different
absorptions in a wavelength range at the time t. The two-dimensional view of a
chromatogram (retention time and absorption height) is extended by another
dimension (wavelength). Each recorded data point contains information on the
detected wavelength (λ) in addition to the retention time (t) and the absorption
value (A).

The resulting 3D-field stretches in x, y, and z-direction.

Dionex Photodiode Array Detectors record data points via the 3DFIELD signal.
Similar to other signals, the recorded signals can be influenced via Signal
Parameters.

Depending on the selected Sampling Rate, the Optical Resolution of the
detector and the selected wavelength range, recording a 3D-field can produce
an enormous amount of data. This not only requires special data compression
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procedures (see  Data / Raw Data Compression), but also makes it
impossible to control photodiode array detectors via conventional serial
interfaces. Dionex PDAs are therefore connected to the PC via powerful
special connectors and separate interface boards. This connection even allows
online representation of the 3D-field within a Control Panel.

Existing 3D-fields can be viewed and evaluated in different Presentation
Modes. This is via the partial method Peak Purity Analysis (PPA).

3D-Field: Presentation Modes
The 3D-Field represents the relation between the three values retention time
(t), wavelength (λ), and absorption (A). For presenting these three-dimensional
figures, two presentation modes have proved to be useful: the ISO plot and the
3D-plot presentation. Toggling between the two modes is via the Decoration
dialog of the window.

Presentation Mode: Description:
ISO Plot In the area formed by t and λ, lines with equivalent absorption are

shown in the same color. The resolution increases with the
number of drawn lines (levels).
The ISO plot can be viewed online, i.e., in real time.

3D-Plot: A combination of perspective projection and iso-line plot. The iso-
lines are moved to the third dimension, depending on the
absorption degree. A grid containing all retention time and
wavelength values is placed over the created profile.

 Note: As more computing resources are required for the 3D-plot
presentation mode than for the ISO plot presentation, the
representation on the screen will require more time. In addition,
copying a 3D-plot to the clipboard or printing requires more time.

3D-Plot
See 3D-Field: Presentation Modes

A-Groups
See Access Groups
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A/D Converter (Technical Data)
The A/D Converter serves to convert electrical detector voltages into digital
data for further processing in the Dionex Chromatography Management
System.

The A/D converter functions on the basis of the auto ranging principle, i.e. it
has 8 different measuring ranges in steps of 2, which are set by a 32-bit
microprocessor, depending on the signal. The processor enables smooth
transitions between the individual measuring ranges, by comparing and
correcting with a calibrated power source. Non-linearity at the switch points and
maladjustment by aging components and potentiometers are thus excluded.

Due to the fine measuring range graduation and the refined analog technology,
sensitivity is less than 1mV at a dynamic ratio of 24bit; resolution and linearity
is 16 bit over the entire measuring range.

The A/D converter can record up to 16 channels simultaneously at a sampling
rate of 100 Hz. That means that from a continuous signal, a maximum of 100
values is recorded per second (sampling rate). The output voltage range of the
detector is irrelevant; the A/D converter automatically adjusts to it. The A/D
converter is designed for input voltages ranging from -10V to +10V (output
voltage of a detector is usually 1 or 2V at the integrator output, in exceptions,
as in GC, it can be up to 10V).

In addition to the 16 analog inputs, the A/D Converter is supplied with digital
(remote) inputs. These inputs are designed for input voltages between 0V and
+5V (TTL level). They enable reactions to external events (e.g. inject signal).

For further information, see

 Device Communication / A/D Converter
 Installation of the A/D Converter

 Caution: Wrong polarity (remote inputs) and input voltages beyond the
valid range will destroy the board!
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Access Groups (A-Groups)
An A-group comprises various Dionex Chromatography Management System
users. The membership in a specific A-group determines which objects (server,

Timebases, Data Sources, and directories) can be accessed. Each user
can be a member of several A-groups.

For example, the A-group All could consist of the users "A," "B," "C," "X," "Y,"
and "Z," while the group Specials consists of the users "A," "B," and "C."

The more A-groups are defined, the more specific the  Access Control (see
Installation section) can be handled in the Dionex Chromatography
Management System. Creating A- and P-groups is performed by the
administrator with the CmUser program (CmUser.EXE).

As soon as the A-groups are created via the CmUser program, it is possible to
determine where the groups have access. The administrator also performs this
task:

a)  For datasources, directories, and sequences, access is defined in the
Client program of the Dionex Chromatography Management System, and

for

b)  For servers, and timebases, access is defined in Server Configuration
program.

To define the access, select the object. Open the context menu or the Edit
menu, then select the Properties dialog to define the user groups who are
granted access.

If a user is a member of a specific A-group, certain privileges are assigned.
These Privileges are defined in privilege groups.

Account
Each user has an account that is checked each time the user logs on with
enabled User Mode. The administrator can determine via the CmUser
program whether a user's account shall be locked after a specified number of
failed Logons. This is to prevent penetration from the outside. In addition, a
user account can be locked completely (Account locked). In both cases, the
user can restart the Dionex Chromatography Management System client only
when the administrator allows access to the account again.
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Acquisition On/Off
The Acquisition on command activates data recording ( Raw Data) from all
selected Signals or channels of a Timebase. The type of data from each
signal is determined via signal parameters.

Also, see ⇒AcqOn/Off.

Additional Functions
The Report Publisher that is an add-on module to the Dionex
Chromatography Management System provides 141 additional functions for
creating user-defined formulas in the Printer Layout. Information on the
significance of the individual formulas is included in the Online Help of the
Dionex Chromatography Management System only.

For an application example, see How to ... Actions in the Printer Layout
 Entering User-defined Formulas.

For an overview of the available functions, see the following list (these topics
are available in the Online Help only):

ABS
ACOS
ACOSH
ADDRESS
AND
ASC
ASIN
ASINH
ATAN
ATAN2
ATANH
AVERAGE
CEILING
CHAR
CHOOSE
CLEAN
CODE
COLUMN
COLUMNS

EXACT
EXP
FACT
FALSE
FIND
FINDB
FIXED
FLOOR
HLOOKUP
HOUR
IF
INDEX
INDIRECT
INT
ISBLANK
ISERR
ISERROR
ISLOGICAL
ISNA

MATCH
MAX
MID
MIDB
MIN
MINUTE
MOD
MONTH
N
NA
NOT
NOW
ODD
OFFSET
OR
PI
PRODUCT
PROPER
RAND

SECOND
SIGN
SIN
SINH
SQRT
STDEV
STDEVP
SUBSTITUTE
SUM
SUMIF
SUMSQ
T
TAN
TANH
TEXT
TIME
TIMEVALUE
TODAY
TRIM



A-8 Glossary

CONCATENATE
COS
COSH
COUNT
COUNTA
COUNTIF
DATE
DATEVALUE
DAY
DAYS360
DBCS
ERROR.TYPE
EVEN

ISNONTEXT
ISNUMBER
ISREF
ISTEXT
LEFT
LEFTB
LEN
LENB
LN
LOG
LOG10
LOOKUP
LOWER

REPLACE
REPLACEB
REPT
RIGHT
RIGHTB
ROUND
ROUNDDOWN
ROUNDUP
ROW
ROWS
SEARCH
SEARCHB

TRUE
TRUNC
TYPE
UPPER
VALUE
VAR
VARP
VLOOKUP
WEEKDAY
YEAR

AIA
AIA is the abbreviation for Analytical Instrument Association. This
association of manufacturing and sales companies for chemical analysis
instruments and software aims at developing guidelines for a standardized
chromatography file format to facilitate the data exchange between laboratory
systems produced by different manufacturers.

This refers especially to the independence from operating systems and the
selected transfer type, but standardization efforts also involve operation,
documentation, maintenance, and GLP requirements.

The generally valid AIA export format for chromatography data is known as
ANDI (ANalytical Data Interchange/Chromatography).

Since 1992, there are five data format categories (Category 1, ... 5). However,
only the categories 1 and 2 are widely accepted so far.

Data formats of category 1 comply with standard raw data, unit, and scaling
guidelines, and include information where original data and corresponding
methods are stored. This allows exact restoration of a chromatogram from raw
data.

In addition to amount values and names for substance identification, data
formats of category 2 also transmit all calculated results, e.g. based on a
chromatogram. The data can thus be managed in a database or a LIMS
system.

Using the AIA format (ANDI) in the Dionex Chromatography Management
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System
To export data from the Dionex Chromatography Management System, the
ANDI format can be used. Select the Export/Backup command in the File
menu of the Browser and open the corresponding dialog box with the
ANDI/Chromatography (AIA) option.

It is also possible to export and print data simultaneously. Select the Batch
Report command in the File menu of the Browser. The Export option opens
the Batch Setup dialog. The AIA format is defined on the AIA format (*.cdf)
tab.

You can also import AIA files into the Dionex Chromatography Management
System. Select the Import / Restore command in the File menu and choose
ANDI/Chromatography AIA. A dialog box is opened in which you may select
the file you want to import.

AIA Peak Type
See Detection Code at Peak Start / End

Align
Use the Align function to align two or more selected Controls in the Layout
Mode (left, right, top, bottom) or to assign the same dimensions (width,
height, size) to them.

The Control Frame of the control that is selected first is used as reference for
the aligned control(s).

Amount
The Amount peak table parameter defines the content of a component in a
standard. For each component of the standard used for calibration, exactly one
amount value is entered in the Amount column of the peak table in the ⇒QNT
Editor.

Also, see ⇒Amount
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Amount Deviation
The Amount Deviation peak table variable specifies the difference between
the nominal ⇒Amount included in the Amount column of the peak table and
the value actually determined via the area calculation (actual amount).

By default, the difference is expressed in absolute amount units (= Absolute
parameter). Alternatively, input is possible in percent of the expected amount
value (= Relative parameter).

Use this variable to check the quality of a calibration. The smaller the
determined deviation, the closer the corresponding calibration point is to the
calibration curve.

 Note: GynkoSoft users know this variable under the name Amount
Difference (Amnt Dif.).

Area
The Area peak result variable specifies the area between the signal curve, the
baseline, and the perpendicular delimiters, if required. The size of the peak
area is considerably influenced by the baseline (resolved or non-resolved).

signal

rider

skimming
tangent

base-
line

non-resolved
baseline

perpen-
dicular

Rider peaks have a separate area that is limited by a skimming tangent and the
signal curve.

The peak area is computed via summation of trapezoids. The trapezoidal area
between the two data points (T1,A1) and (T2,A2) is

Area =  (T2-T1)*((A1+A2)/2).
After summation over the corresponding trapezoids of all data points, the
baseline is subtracted. For the (B_T1,B_A1) and (B_T2,B_A2) baseline points
at peak start and at peak end, the baseline area is computed as

Area =  (B_T2-B_T1)*((B_A1+B_A2)/2).
The areas of the rider peaks are computed accordingly and subtracted from the
corresponding main peaks.
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The dimension of the area depends on the used detector type. For UV
detectors, the dimension is usually specified in mAU * min (milliabsorbance
minutes).

AS50 Sample Prep Commands (Overview)
The AS50 provides several functions for preparing the sample before injection.
The Dionex Chromatography Management System can control these functions
with commands programmed into a Program. The standard AS50 supports
six sample prep commands. If the AS50 is equipped with the Sample
Preparation option, two additional commands are available.

Standard Sample Prep Commands
Pipet

Mix

Delay

Flush

Needle Height

Sample Preparation Option Commands
Dilute

Dispense

Aspect Ratio
Signals or chromatograms that are assigned an aspect ratio value, are
displaced by the parallel projection of the y and z-axes in x direction.
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Asymmetry
The Asymmetry peak result variable is a measure for the peak fronting or
tailing. With identical analysis conditions (identical solvent, identical column
type, etc.), the Asymmetry can be used to evaluate the column quality.

Theoretically, peaks correspond to a symmetrical Gauss distribution. As any
insufficient separation results in a deviation from this ideal, the reasons for any
distinct asymmetry should be analyzed and eliminated

The parameter has no dimension and is defined differently, depending on
whether using the US/ EU or AIA standard:

Asymmetry Calculation
US/EU standard
AIA standard

With:
RW5% LW5%
RW10/%, LW10%

A = (RW5% + LW5%) / (2 x LW5%)
A = RW10% / LW10%

Right and Left peak width in 5%
and 10% of the peak height.

100 %

10 %
5 %W5 %

W10 %

RWLW

Peak Height 

For ideal peaks, Asymmetry is A = 1. For realistic, tailing peaks, however, A is
between 1.2 and 5. Values higher than 5 often produce imprecise quantitative
results.

If the Asymmetry is calculated in 10% of the peak height, this value is referred
to as Skewness.

Select the column in the report, choose the Column Properties command
from the context menu, and select the variable in the selection box. Press the
Parameter button to define whether the calculation is based on the EU or US
standard.

Atlas Electrolytic Suppressor (AES)
See Suppressor
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Audit Trail
An audit trail is a daily sample protocol that is kept independently by the
system. It contains all GLP (Good Laboratory Practice) relevant operations,
such as current and future commands, events, and error messages.

For further information, see:

 Audit Trail (in the Hardware and Software Chromatography
     Components section).

 Protocol Data

Auto Autoscale
Use the Auto Autoscale option to automate the performance of the

Autoscale function.

During data acquisition, this option adjusts the scaling of the signal axis exactly
to the size of the current chromatogram whenever the signal leaves the signal
plot in y direction.

Autosampler
Autosamplers allow automating routine analysis. Depending on the
autosampler type and model, a number of samples can be prepared and then
processed (injected) in automatic Batch Processing.

A distinction is made between the following two states:

Loading the Sample
The fluidic input and output are directly connected. The solvent flow delivered
by the pump is via the sampler to the column. In a second cycle, the volume to
be injected is drawn from a sample vial into the sample loop using a syringe.

Injecting the Sample
To inject the sample, the needle is lowered into the needle seat (Gina 50, Gina
160, and ASI-100/ASI-100T) or the inject port (AS50). Via a switched valve, the
solvent flow is directed from the pump via the sample loop and the needle seat
or via the inject port to the column. Residues in the syringe are dispensed into
the waste.

Example for a load/inject process (here: the Dionex ASI-100 sampler):
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The Dionex Autosamplers Gina 50, Gina 160, ASI-100/ASI-100T, and AS50
function on this basis. Apart from the standard model, a coolable version (Gina
50T) and a model with integrated derivatization or method program (Gina 160)
are available. (With the ASI-100/ASI-100T samplers, derivatization and method
programming is possible with the standard version.)

For further information, see  Dionex Autosamplers
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Autoscale
Each time when performed, the Autoscale command adjusts the scaling of the
signal plot exactly to the displayed window section (e.g. the height of a peak).
The adjustment depends on the method.

For instance, the difference between maximum and minimum value of the
largest peak fills 80% of the signal axis in the online mode and 100% in the
PPA representation.

Select the Auto Autoscale option to perform Autoscale automatically.

Autozero
The Autozero command resets physical or Virtual Signals to zero. The
subsequently measured data is interpreted and displayed in relation to the new
zero point. In the chromatogram, this can normally be recognized by a sharp
increase of the absorption value.

 Tip: For detectors switched in series, the command must be entered
separately for each detector.

Also, see ⇒Autozero

Average
The Average parameter allows averaging signals. This is possible for digital
signals the detector sends to the server PC (as with the Dionex Detectors UVD
170S and UVD 340S) as well as for analog signals recorded via the A/D
Converter card.

The Dionex A/D converter records each analog signal with a frequency of
100Hz. This corresponds to a ⇒Step of 0.01 second or a Sampling Rate of
100 data points per second. When increasing the step or decreasing the
sampling rate, less data points than theoretically possible are stored.

Also, see ⇒Average
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Averaged Baseline
The Averaged Baseline is a baseline that is valid throughout the entire
chromatogram. The baseline can be defined for individual chromatograms.

For details, see How to ...: Actions in the Chromatogram  Defining an
Averaged Baseline.

Backup
The Backup command allows storing data for data security. For a description
of the procedure see How to ...: Actions in the Browser  Creating Backup
Files.

The Dionex Chromatography Management System stores data in databases
and other files organized in a hierarchical directory structure. There are many
cross-links between the included objects.

For problem-oriented data archiving, it is necessary to know how the individual
objects are linked with each other. As conventional backup and archiving
programs do not offer this support, the Dionex Chromatography Management
System has its own backup program. This integrated backup program offers
the following functions:
• Archiving all objects displayed in the Browser (samples, sequences, files,

entire directory trees, etc.) together with all linked files ( Raw Data, Audit
Trail (  Protocol Data), history, preferred Report Definition File (RDF),
etc.)

• Selective restoration of objects stored via backup
• Compressing the stored data
• Dividing the backup files on several media (e.g. diskettes or ZIP media)
• Optionally deleting original files after the successful backup
• Generating corresponding entries in the History

Backup files are located outside the Datasource. Therefore, backup files
cannot be stored within the directory structure of the datasources. They have
no file history and the user management does not protect them.

Use the Restore command (see How to ...: Actions in the Browser
 Restoring Backup Files) to restore backup files that were created via the

Backup function.
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Bandwidth
The bandwidth is the nm range at which the chromatogram is recorded. In
general, this corresponds to the Optical Resolution.

The bandwidth can be selected by averaging several single photodiode signals.
This process is known as Diode or Wavelength Bunching. Averaging is
performed symmetrically to the selected wavelength. Thus, at a bandwidth of
31nm and a wavelength of 255nm, the signals of all photodiodes in the range
of 240 to 270nm are averaged.

Also, see ⇒Bandwidth

Baseline
The line drawn from peak start to peak end for calculating the peak area is
called baseline.

 Note: In colloquial language, the chromatogram section between two
peaks is also referred to as baseline.

Baseline Correction
Automatically correcting a spectrum by a calculated baseline spectrum allows
comparing individual spectra even under different conditions. Especially the
spectra of a rider peak can thus be presented more precisely as, in general, a
large "underground portion" must be considered, which must be attributed to
the larger main peak.

When displaying the spectra plot (Show Spectra), it is always corrected by the
baseline spectrum, in the PPA method baseline correction is performed only
after activating the corresponding option.

Establishing a Baseline Spectrum
Based on the peak recognition algorithm, the Dionex Chromatography
Management System establishes the start and end of peaks for the

Reference Channel and marks these points by positioning peak delimiters (ta
and te). The Baseline (I) is drawn between the two delimiters.
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A

t

λ

a)

b)

I II III

ta te

This is performed for all detected wavelengths. The absorption values at all
wavelengths measured at the time ta and te result in the baseline spectrum of
peak start and peak end (II, a and b). Between these two spectra, the Dionex
Chromatography Management System performs an interpolation and thus
calculates a separate baseline spectrum for each peak data point. Outside the
peak limits, the 3D-field is by definition zero.

Each spectrum measured at any given time t can now be corrected by a
calculated baseline spectrum (III).

Baseline Correction with Manual Re-Integration
Manual shifting of peak delimiters necessarily affects the baseline spectrum.
After each manipulation, there is an automatic re-interpolation and re-
calculation of new baseline spectra.

Depending on the modification to the peak delimiters this will change the
spectrum (e.g. Spectra Plot).

 Tip: A baseline correction can only be performed for the spectra of
those peaks that are part of the integrated reference channel!
Near the detection limit, activating the baseline correction often
results in considerable smoothing of the PPI and Match
Curve, as the spectral baseline portion is eliminated.
In principle, the PPA report is baseline corrected.
If a spectrum is included in a spectra library from the Spectra
Plot via the Windows clipboard, it is always baseline corrected.
If a spectrum is included in a spectra library from the PPA
method via the Windows clipboard, the baseline correction is
activated or deactivated via the BL-Correction option.
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Baseline Point
The Baseline Point detection parameter defines a baseline point at the
indicated time.
Also, see ⇒Baseline Point

For details on how to apply detection parameters, see How to ...: Actions in
the QNT Editor  Modifying Detection Parameters.

Baseline Value at Peak End
This peak result variable gives the baseline signal value of the peak end (in
contrast to the Signal Value at Peak End variable which gives the actual
signal value of the signal curve).

Baseline Value at Peak Start
This peak variable gives the baseline signal value at the peak start (in contrast
to the variable Signal Value at Peak Start which gives the actual signal value
of the signal curve).

Base Peak
In a Mass Spectrum, the mass peak with the highest intensity is called base
peak. It serves as reference point (base peak = 100 %) for representing relative
intensities.

Batch Processing
Repeating a processing step several times is referred to as batch processing
(also called batch or online batch). In chromatography, this means
automatically processing or analyzing several samples in a defined order.

For further details, see  Samples and Sequences / Online Batch.

 Note: The automatic offline batch performed in the GynkoSoft data
system for the recalculation of results is no longer required in the
Dionex Chromatography Management System, as each
modification of a quantification method results in an immediate
recalculation of all involved variables. It is not necessary to
recalculate data, as the displayed data is always up to date.
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Binary-Coded Decimal Code ("BCD")
Autosamplers controllable via binary code (BCD-capable Autosamplers) can

inform the data system, from which sampler position injection was performed.
This requires connecting the remote inputs with the sampler outputs (e.g.
Remote Inputs of the A/D Converter).

For details on how to proceed, refer to the configuration of the Remote Inject
Device Driver in the Server Configuration program (F1-key).

Blank Run Sample
A blank run is a chromatogram where no sample is injected but the solvent
absorption (= baseline) is recorded.

In the sample list, blank samples are labeled with the sample type Blank and
marked by the following symbol . The optionally available Blank parameter
of the ⇒Inject command forces an injection for blank run samples via Inject.
Usually no injection is made for these samples (default: Skip). Blank samples
are therefore treated in the Program like normal integration samples.

Blank samples are stored together with the sequence. After a baseline or
Blank Run Subtraction is performed, it can be undone at any time.

Also, see Matrix Blank Sample

Blank Run Subtraction
If the Raw Data of a signal (channel or 3D-field) is corrected by the raw data
of a comparable Blank Run sample, this is called blank run subtraction. The
chromatogram of the blank sample is subtracted point by point from the current
chromatogram.

With a Matrix Blank Sample, however, the peak areas are determined first
before being subtracted from the corresponding peak areas of all samples in
the sequence.
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 Tips: Blank run subtraction should be performed if peak detection is
disturbed due to a strongly ascending chromatogram (e.g.
gradient elution).

As both the normal and the blank run sample are saved, the
subtraction can be undone or restored at any time.

With a special interpolation procedure, the subtraction of two 3D-
fields functions even if the recording conditions are not identical
(e.g. different wavelength range or optical resolution). However,
this procedure should only be used in exceptional cases.

Branch
In the current Program, use the Branch command to branch into a different
program or to start a program via a command button from the Control Panel.

Also, see ⇒Branch

Browser
The Browser of the Dionex Chromatography Management System enables
setting up, deleting and moving Datasources, subordinate directories and
files.

It shows samples, methods, and programs as well as further details of a
Sequence. The functions and the structure are similar to the Windows

Explorer. Open the individual files by double-clicking.

 Caution: Functions and structure are similar to the Windows Explorer.
However, do not confuse the Browser window with the Windows
Explorer! Do use the Windows Explorer for operations within
datasources of the Dionex Chromatography Management
System!

For further details, see   Browser
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Bunch Width
To enhance the Signal to Noise Ratio of a Photodiode Array Detector the
signals of several photodiodes can be averaged (or bunched). Bunch Width
describes the sample bandwidth of a bunch of photodiodes.

Also, see ⇒Bunch Width.

c0
See Offset c0

c1
See Slope c1

c2
See Curve c2

Calibration Functions, Calibration Coefficients
In each calibration, a mathematical ratio is established between the ⇒Amount
of a standard sample f(A) and the corresponding area value (A). Depending on
the location of the Calibration Points, the ratio can be linear, a parabola or
exponential. By selecting a ⇒Calibration Type, the user can evaluate, to which
shape the calibration point should be assigned. The corresponding
mathematical functions are called calibration functions.

Linear (Lin) AxcAf 1)( = min. 1 calib. point

Linear with offset (LOff) AxccAf 10)( += min. 2 calib. points

Quadratic (Quad)
221)( AxcAxcAf += min. 2 calib. points

Quadratic with offset (QOff)
2210)( AxcAxccAf ++= min. 3 calib. points

Exponential (Exp)
10)( cAxcAf = min. 2 calib. points
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The slope of the straight line (linear) or the shape of the curve (non-linear) is
described by the value of the corresponding calibration coefficient c0, c1, and
c2. The coefficients are calculated by simply replacing known amount and area
values in the corresponding calibration function (standard sample). If c0, c1,
and c2 are known, amounts of an unknown sample can also be calculated.

For further details, see  Theory of Calibration / Calibration Principle

Calibration Mode
The calibration mode determines which standards are used for calibrating a
specific sample of a sequence.
Also, see ⇒Calibration Mode

The mode is selected on the  General page in the ⇒QNT Editor.

Calibration Point, Calibration Level, Replicates
If the corresponding peak area is determined for the known amount of a
standard sample, the point resulting from both values in an x, y-diagram is
referred to as calibration point.

If the corresponding peak area is determined several times for the same
⇒Amount, different area values are received depending on the precision.
Thus, a larger number of calibration points is obtained. Calibration points based
on the same concentration are referred to as replicates of the same
concentration level.

Calibration points of different levels are obtained when area values are
determined for various amounts of a standard. This can be via Dilution Series
or variation of the injection volume. From the calibration points, the data system
calculates the calibration coefficients of the Calibration Function selected by
the user.

For further information, see the following topics in the Theory of Calibration
section:

 Calibration (Overview)
 Calibration Principle

as well as How to ...: Actions in the QNT Editor  Weighting and
Averaging Calibration Points in the Creating a Peak Table section.
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Calibration Type
The Calibration Type peak table parameter describes the mathematical model
function ( Calibration Function) based on which the data system calculates the
calibration curve by inserting the calibration coefficients c0, c1 and c2.

Also, see ⇒Calibration Type

For details on the available calibration types, see Theory of Calibration:

 Calibration Types (Linear)
 Calibration Types (Non-linear)

Also, see How to ...: Actions in the QNT Editor  Weighting and
Averaging of Calibration Points.

Calibration Variables
Numerical calibration values are referred to as calibration variables. They can
be included in a separate column in any table created by the Dionex
Chromatography Management System. The following variables are calculated:

⇒Calibration Type
Coefficient of Determination
Correlation Coefficient
DOF-Adjusted Coefficient of Determination
Curve c2
Number of Calibration Points
Number of Disabled Calibration Points
Offset c0
Relative Standard Deviation
RF Value
Slope c1
Standard Deviation
Variance Coefficient
Variance
Weights
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Capacity Factor (k´)
The peak result variable k´ refers to the capacity factor, i.e. the ratio of the net
retention time to the ⇒Dead Time To:

k´  =  ( T - To ) / To

To achieve a reasonable compromise between retention and required analysis
time, k´ should be a value between 1 and 5.

Calculation is only possible if the dead time of the system was entered in the
⇒QNT Editor on the  General sheet.

To may either be measured at the inert peak, or calculated as the quotient of
dead volume and flow.

If To = 0, k´ is not calculated.

Select the column in the report, choose the Column Properties command
from the context menu, and select the variable in the selection box. Press the
Parameter button to define the dead time required for the calculation.

Cascade
The Cascade command of the Window menu allows arranging the open
windows one behind the other. This provides an overview on the currently open
windows and allows you to quickly change to the desired window.

Channel
If a detector delivers more than one Signal, as a multi-channel UV detector,
the single signals are referred to as channels.

Check Commands
Various checks are available in the Dionex Chromatography Management
System:

Syntax Check
A syntax check is automatically performed for each Program. The syntax
check verifies that a program complies with the program syntax. For example,
the syntax check may detect the following:
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Exceeded value ranges
• Incorrect punctuation
• Misspellings

Red coloring indicates any detected errors.

Semantics Check
The semantics check verifies the (chromatographic) meaning of a program.
This includes for example the following checks:
• Is the sum of all partial flows 100%?
• Does the program contain an ⇒Inject command at the time t = 0.000?
• Are the Inject/⇒AcqOn/Off commands listed in the correct order?
• Is the minimum difference between the emission and the excitation value

observed?
• Is the last command an ⇒End command? (Absolutely necessary)

The semantics check can be performed via the Check command in the PGM
editor or the Check button in the Properties of a command button. Detected
errors are indicated in a dialog box.

Ready Check
The Ready Check allows you the check whether the connected instruments
are ready to operate, e.g. to process a sample batch. The following items are
checked:
• Is the instrument switched on?
• Are all instruments connected correctly?
• Is the lamp switched on?
• Are all required files available?
• Is there sufficient storage capacity?

You can perform a ready check via the Ready Check button in the Batch
dialog box. In addition, a ready check is automatically performed for each
online command. If there is a problem, an error message or warning will be
displayed.

The semantics check usually includes the syntax check. In addition, the ready
check includes the semantics check.
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Check Derivative
See ⇒Check Derivative

Chromatogram Overlay
See Overlay

Chromatographic Methods
All instructions and parameters regarding the chromatographic treatment, i.e.
the analysis and the processing of a sample, are referred to as
chromatographic methods. Depending on the included information, the
following distinction is made:

Chromatographic method Description
Program (part of the PGM file) Commands and instructions enabling automation of the

analysis.
Quantification methods (QNT) All parameters required for qualitative peak identification

and for quantitative area determination.

The data is stored in the Sequence Directory or is copied there by the data
system.

Chromatography Server
See Server

Client
Workstations that can start the Dionex Chromatography Management System
are called clients. The client provides a user interface that allows accessing
chromatography data and Datasources as well as appropriately representing
their contents.

To control or monitor a chromatography system from a client PC, the client
must be connected to the Chromatography Server Normally, this connection
is established when opening a Control Panel and connecting to the desired

Timebase. As soon as there is a connection, the user has access to the
devices installed on the server.
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To manage database access, the Dionex Chromatography Management
System uses the capability of modern  Operating Systems to share
resources, i.e. a client can access all files or datasources for which sharing was
issued on a different workstation.

In addition, monitoring and controlling a system is only possible via the client.
To do this, the client must establish a connection to a (chromatography)

Server.

In combination with a  Network, this allows operating a system and online
representation of the system status and the current chromatogram course from
any client! Synchronous control of a system via several clients is not possible.

CmUser and CmSecure (User Management)
For the user management of the Dionex Chromatography Management
System, two separate programs are available to the Administrator: the CmUser
program (CmUser.EXE) for creating the User Database and managing the
actual users and the CmSecure program (CmSecure.EXE) for activating the
User Mode. Both programs are located in the CmUser directory of the Setup
and are not automatically copied to the program directory.

The CmUser program is password-protected and can only be opened by the
Administrator or persons with a similar function.

 Tip: Authorized persons should copy the CmUser directory to a
floppy disk to enable on-site changes to user management. This
directory also contains an Online Help file (CmUser_E.HLP)
describing all steps and options of user management.

The main task of the CmUser program is the administration of Users,
Privileges, and Access Groups. The following operations are possible:

• Creating and editing access groups ( Access Groups)
• Creating and editing Privileges (privilege groups or P-Groups)
• Creating and editing new users in the Dionex Chromatography

Management System. The user’s name and title, the Logon and
signature  Passwords, and the reaction on a failed logon can be defined.

The CmSecure program allows enabling and disabling the User Mode on client
of the Dionex Chromatography Management System. In addition, the user
database containing the status of each user and his/her rights is selected in the
CmSecure program. Starting the Dionex Chromatography Management
System requires a password when the User Mode is enabled. Signing
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sequences electronically (see: Electronic Signature) is possible with enabled
User Mode only.

 Caution: Activate the Compatibility Mode (via the Datasource
Properties command in the CmUser File menu) to allow

Clients of previous versions (version 6.01 and earlier) of the
Dionex Chromatography Management System to logon to the
system.

Coefficient of Determination
This variable allows you to view the Coefficient of Determination, i.e. the
deviation of the measured data points from the calibration curve. The
coefficient of determination can have value between 0 and 1. A coefficient of 1
indicates that all calibration points are exactly on the calibration curve. The
coefficient of determination is calculated as follows:
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With: N Number of standard samples participating in the calibration
i Index for standard samples
Wi Weight factor of the standard sample no. i
F(x) Model function of the calibration
Xi X-value of the standard sample no. i
Yi Y-value of the standard sample no. i
Y Average of all Y-values.

 Tip: If a linear calibration function leads through the origin, the
coefficient of determination is identical to the Correlation
Coefficient.

Also, see DOF-Adjusted Coefficient of Determination

Column Mode (DX-120)
Column mode enables switching of flow from one column set to another in a
DX-120 Ion Chromatograph equipped with the dual-column option. When the
column is switched, the eluent flow is also switched. For example, when
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column A is selected, flow is from eluent reservoir A through column A. If a
command switches the flow to column B, flow is then from eluent reservoir B
through column B. Also, see Eluent Mode

The ColumnAB command is used to switch the flow from one column set to the
other. The command can be included in a Program, executed directly from
the Commands dialog box (select Command from the Control menu), or linked
to a Control on the control panel. To link the command to a control, place an
edit box or switch control on the control panel (see Layout Toolbar). Then,
link the control to the ColumnAB object property. For details, see How
to ...: Actions in the Control Panel  Linking a Control to a Device.

To enable Column mode:

1. Open the Server Configuration.

2. Select the DX-120 under the timebase.

3. Double-click to open the Properties dialog box (or right-click and select
Properties).

4. Select the Mode tab, and then the Column option.

Column Temperature
The Column Temperature command determines the nominal temperature of
the column thermostat (column oven).

After defining the nominal temperature, the thermostat is set as quickly as
possible to the new temperature (device-dependent). A linear interpolation
between the actual value and the nominal value is performed.

It is also possible to enter several temperature commands ( PGM File). In this
case, the result is a Step Profile instead of a linear interpolation between two
values!

 Tip: As with all instrument parameters, the Dionex Chromatography
Management System attempts to represent the actual
temperature on the screen. It depends on the connected column
thermostat whether this is possible.

Comment
The Dionex Chromatography Management System allows entering a comment
at different places.
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• The ⇒Comment column allows you to enter any comment in addition to the
sample name.

• The Comment column in the Peak Table of the ⇒QNT Editor allows you to
enter comments regarding the sample.

• Comments are often needed in Program. To enter a comment in the
PGM file, enter a semicolon (;) in front of the comment text. The text is then
given in green.

• A Comment column is also available in spectra libraries where you may
enter any comment on the individual spectra.

• The General tab of the Datasource Properties (to be opened via the
Properties command of the context menu) allows you to specify that all
modifications are logged in the History. If the Comment required option
is enabled, a dialog box opens whenever you save a modification and
prompts you to comment the respective change.

If required, the Dionex Chromatography Management System automatically
enters a comment at two places in the QNT editor:
• If the peak table is created automatically (via the Autogenerate Peak

Table command), the Comment column of the peak table shows the
following entry:
- Autogenerated (if Enumerate peaks of current chromatogram is
selected) or
- Autogenerated. Spectrum: Reference spectrum name, Match: Match
Factor (if Use spectra library screening results is selected).

• In the Calibration Comment column on the Calibration tab, the Dionex
Chromatography Management System issues commands regarding the
calibration. Usually, this comment will be OK. However, it may also indicate
a calibration error or inconsistencies in calibration.

You may output the respective comments via the corresponding variables of
the individual ⇒Report Categories in the Report and in the Printer Layout.

Concentration
The Concentration peak result variable describes the quotient of the
calculated ⇒Amount and the injection ⇒Volume. The value thus specifies the
amount of a substance contained in a micro liter (µl) of the injected volume.

 Tip: This variable is especially meaningful if an absolute amount
value (e.g. 15.00 µg) is entered in the amount column of the
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peak table instead of a concentration value (e.g. 1.0 µg/µl).

In this case, the value is divided by the injected volume (e.g.
20 µl), which results in comparable absolute amount values,
always normalized to 1 µl (e.g. 15 µg/20 µl = 0.75 µg per µl).

Connect
Execute the Connect to Timebase command to connect a user PC ( Client)
with a Timebase ( Chromatography Server). In a network installation, a
connection can thus be established between the current client and any server
within the network.

Perform the command Connect Device to connect a device with the server to
enable remote control. The command checks whether the specified device is
actually connected. It then activates the instrument. For all installed
instruments, the Connect command is automatically executed when the
program is started.

 Note: For safety and GLP reasons, the instrument keyboard is
locked on most instruments that are connected via the
Connect command. This means that in the Connect status,
the instrument is operated by remote control exclusively.
Input on the instrument is possible again after the
Disconnect command.

Also, see ⇒Connect/Disconnect

Contents (Button)
The tab dialog box Contents in Online Help shows the contents list. Click a
book icon to see further topics of a chapter. Click a document icon to open a
specific help topic.

Continue
The Continue command cancels the ⇒Hold and ⇒StopFlow commands. An
interrupted sample batch is continued as well as an interrupted pump flow.

Also, see ⇒Continue
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Control
Elements that can be fitted with a Control Frame by pressing the left mouse
button in the Layout Mode are referred to as Controls.

The Dionex Chromatography Management System provides various standard
controls via the Layout Toolbar. These can be used by authorized persons to
create a new Control Panel in the layout mode.

If a control is later placed on the area of another control, it is subordinate to the
first control, i.e. modifications to the reference control below, such as the font or
the function Autosize, will also affect the new control.

Use the Shift key to select several controls.

Control Frame
The control frame marks the outline of a Control. By drawing the control
frame, the control can be moved, enlarged, or reduced in size.

Control Panel
In online control, the control and display elements combined in one window are
referred to as Control Panel. The control and display elements allow controlling
and/or monitoring a Timebase. The timebase that can be controlled is defined
when creating the control panel. The assignment can be changed via the
Connect to Timebase command of the Control menu and can be saved by
closing the window.

The user interface of a control panel can be adapted to the requirements of the
individual user via the design tools of the Layout Toolbar. Provided you have
the corresponding authorization, it is also possible to generate a completely
new control panel. In order to create or alter a control panel, change to the

Layout Mode.
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Each new control panel is saved as a PAN file (*.pan) and is then available to
the user. New users open the default control panels of the Dionex
Chromatography Management System that are easy to use.

Also, see

How to ...:  Actions in the Control Panel.

Correlation Coefficient (Linear)
The linear Correlation Coefficient is an indication for the "linear dependence"
in the amount/area ratio.

If all data points are located on a straight line, the correlation coefficient is
exactly 1 (or 100%). If the data points are scattered very much, the coefficient
approximates 0.

In contrast to the Coefficient of Determination, the correlation coefficient is
only an indicator for the linear dependence. This means that e.g. in a quadratic
calibration function, the correlation coefficient may be very bad due to the curve
shape, although all data points are located on or close to the calculated curve.
In this case, the coefficient of determination will be near 0 or 100%.

The mathematical description of the correlation coefficient is as follows:
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With: N Number of standard samples involved in the calibration,
i Index for standard samples,
Wi Weight factor of the standard sample no. i
Xi X-value of the standard sample no. i

 X Average value of all x-values
Yi Y-value of the standard sample no. i

Y Average value of all y-values

 Tip: If a linear calibration function leads through the origin, the
correlation coefficient is identical to the Coefficient of
Determination.
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Cumulated Workload
The cumulated workload is an indication of the wear and tear of the pump. The
Dionex pump P 580 allows you to display the cumulated workload in megajoule
(MJ). For information how to display this information, see How to ...: Device
Control  Viewing Leak Sensor and Workload Status.

Curve (c2)
The Curve (c2) calibration variable gives the curve value of the used

Calibration Function.

This value is available only for the functions Quadratic and Quadratic with
Offset.

Cut Segment Volume (AS50 Command)
The Cut Segment Volume AS50 Autosampler command determines the
volume of sample discarded from each end of the aspirated sample. The
middle portion of the sample is positioned in the loop and injected. The Cut
Volume is used only for partial-loop injections. To perform a partial-loop
injection from a limited amount of sample, specify a Cut Volume of 0. For full-
loop injections, the Cut Volume is ignored. See Injection Types for details.

Cycle Time (AS50 Command)
The Cycle Time AS50 Autosampler command determines the time between
injections. To set a uniform time between injections, specify a cycle time in
minutes (1 to 999). When a cycle time is specified, the autosampler delays
sample injection until the specified time has elapsed since the previous
injection. If the cycle time is set to 0, the time between injections is determined
by the commands in the Program specified for each sample injection in a

Sequence. Specifying a cycle time allows a uniform time interval between
injections, regardless of time differences in sample preparation and timed steps
among program files.
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Data Collection Rate
The data collection rate (or sampling rate) is the rate at which the data system
collects digital data points from the detector, expressed as points per second or
hertz (Hz).

In general, each peak should be defined by at least 20 data points. For
chromatograms with co-eluting peaks or low peak-to-noise ratios, 40 points per
peak is better. If you expect all of the peaks to be relatively wide, use a slow
data collection rate; if any peaks of interest are less than a few seconds wide,
set a fast data collection rate.

If the data collection is too slow, the starts and ends of peaks will not be
precisely determined. If the data collection rate is too fast, data files will occupy
more disk space and take longer to process than necessary.

In addition to the data collection rate, a ⇒Step value is also set. The default
step value is the reciprocal of the data collection rate. For example, if you set a
data collection rate of 5 Hz, the step value is automatically set to 0.2. In
general, the automatically selected step value is preferred. It is possible to
specify a step value that is independent from the data collection rate, but only
advanced users should do this. Refer to the detector operator's manual for
guidelines.

Datasource
The term datasource is used for a database that is registered on a Dionex
Chromatography Management System Client. Setting up (registering) a
datasource is performed in the Browser. The user specifies the format and
the location of the database. For details, see How to ...: Actions in the
Browser  Setting up a Datasource.

During the initial installation of the Dionex Chromatography Management
System, a local default datasource is created on each Client PC. In network
operation, the datasource name is composed of the computer name and the
addendum LOCAL (<PC-NAME_LOCAL>). In a local station not included in a
network, the name stated in the operating system below Control Panel /
Network / Identification is used. If no identification is entered, the datasource
is named PC-NAME_LOCAL.

Normally, Dionex Chromatography Management System data is stored in an
Access database, i.e. in an mdb (Microsoft Data Base) container. The default
datasource is also based on an Access database. The ODBC Capability of
the data system also allows using various other formats (dBASE, SQL, Oracle
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etc.). Independently of the chosen format, data of single samples ( Sample
Data) is saved as well as data of sequences ( Sequence Data).

Datasources can be saved on a local hard disk or any other mass storage
device.

The Directory command allows creating individual subdirectories below a
datasource. The directories are used for saving Sequences and
corresponding data and programs.

Network Datasource
If the datasource is located on a centralized network PC, the database is
accessible by all clients that are granted the appropriate access rights by the
system administrator. If the datasource is stored on a local hard disk, it is up to
the corresponding client to decide whether the datasource can be accessed via
the Windows File Sharing. The Dionex Chromatography Management System
also offers the possibility to lock datasources, directories, or sequences.

For further details on datasources, see Data  Datasource

Non-Availability of the Network Datasource
In many companies and organizations, the database server is shut down during
the daily backup. As with a network breakdown (see Network Failure
Protection), the network datasource will not be available during this time. In this
case, it is known, however, when the datasource will not be available. The
Dionex Chromatography Management System should be disconnected before
to ensure data integrity. When the database is available again, the Dionex
Chromatography Management System automatically connects to the database
and writes back any data that were acquired during the breakdown.

Also, see How to ...: Actions in the Browser  Network Failure/Non-
Availability

 Note: "Old" GynkoSoft data has the required database structure. The
Dionex Chromatography Management System is therefore
capable of handling this data as "real" Dionex Chromatography
Management System data. The user simply establishes a
connection (Connect) to the data stored under Drive ....

Data Smoothing
See Smoothing
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DC Mode
The basic operating mode of an electrochemical detector is the DC mode
(direct current).
When applying a fixed potential between reference and working electrode, a
proportional current is observed depending on the concentration of an oxidable
or reducible substance.

For optimum results, the potential must be adjusted to the substance to be
detected. This is performed in the SCAN Mode.

If modifications occur during the analysis, e.g. due to separating processes, the
detector should be operated in the PULSE Mode.

DC Voltage
The DC Voltage command for the ED40, ED50, and ED50A electrochemical
detectors sets the fixed potential applied to the working electrode, in the range
of -2.04V to +2.04V.

Dead Time
The Dead Time To is defined as the time required for the peak maximum of an
unretained substance to reach the detector from the point of injection.

Also, see ⇒Dead Time

Delay (AS50 Sample Prep Command)
The Delay Sample Prep Command specifies a number of minutes to pause
before proceeding to the next step in a sample preparation sequence.

Delay Time
The time needed by a substance to travel from the detector cell of one detector
to the detector cell of a second detector is referred to as Delay Time. It can be
entered on the  General tab of the ⇒QNT Editor.

See ⇒Delay Time.
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DELTA (Signal Property)
The Dionex Chromatography Management System is capable of recording and
evaluating signals or output variables supplied by a detector (e.g. UV/VIS
channel 1, Temperature, Pressure, %A, Flow rate, etc.).

Instead of the actual value (in mAU, Volt, °C, ml, etc.), the changes of a
variable in a specific period can be calculated. This is possible via the signal
property DELTA.

This option is especially useful when creating complex ⇒Trigger conditions. A
peak can thus not only be recognized by the height of its absorption signal
within a chromatogram, but also by a sharp increase of the signal, for example.

For information on how to express this type of trigger condition, see How
to ...: Device Control  Trigger Commands.

 Note: The calculation of the first derivative is once per second,
independently of the Sampling Rate or the ⇒Step that is used
for the data acquisition.

Demo Mode
Demo Mode lets you simulate data acquisition by loading a pre-recorded demo
file and then displaying the data from the demo file in the Control Panel's
signal plot. The demo file is "read back" as though the data were being
acquired in real time.

For information on how to simulate data acquisition see How to ...: Actions in
the Control Panel  Using/Recording Demo Data

Detect Negative Peaks
The Detect Negative Peaks detection parameter determines whether negative
peaks are recognized apart from positive peaks.

Also, see ⇒Detect Negative Peaks

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Modifying Detection Parameters.



A-40 Glossary

Detection Code at Peak Start / End (AIA Peak Type)
This peak result variable indicates how the peak start is classified. In principle,
this corresponds to the ⇒Peak Type classification used in the Dionex
Chromatography Management System (CMS). The classification described
below complies with the AIA convention.

The following AIA peak types are evaluated:

AIA Peak Type Description Dionex CMS Peak Type
B (baseline peak) The peak starts on the

baseline.
BM, bM

VD (vertical drop) The peak starts with a
perpendicular line dropped to
the baseline.

MB, M

PT (pretangent skim) The peak is interpreted as a
rider.

Ru or Rd

Device Driver
Each controllable instrument has its own device driver that is activated when
the Dionex Chromatography Management System is started. The device driver
translates the user's PC instructions (via "mouse click") into device-specific
digital commands that are then converted in "real control commands" after the
data is transferred to the instrument. In the opposite direction, the signals of all
instruments (readings, status information etc.) is converted so that they can be
read by the Dionex Chromatography Management System and can be
displayed on the screen.

Device drivers are also capable of monitoring regularly inquired or
automatically given device parameters in a target/actual value comparison.
Unexpected events can be corrected or displayed (in an error message). Full
support for all instrument functions by the device driver can only be guaranteed
for Dionex instruments. Support for third party instruments may be limited. If
the functionality of the driver can be modified via parameters (e.g. determining
the shared A/D channels, relays or remote inputs), this is performed in
the  Server Configuration.

The names of the device drivers are derived from the corresponding
instrument. The extension CDD means "Chromatographic Device Driver." For
example, the device driver for the A/D Converter is SADCONV.CDD, for the
Dionex M480 pump the driver is M480.CDD.

During the installation of the Dionex Chromatography Management System, all
device drivers are saved to the BIN directory and receive a version ID that can
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be viewed via the Properties command in the context menu, e.g. in the
Explorer.

In special cases, the generic device driver can be used to create a user-defined
device driver (for details, see  Generic Device Driver).

Digital Input
See Remote Input

Dilute (AS50 Sample Prep Command)
The Dilute Sample Prep Command dilutes a sample with a specified volume
of reagent. This command can be used only when the AS50 Sample
Preparation option is installed.
• Concentrate Source is the vial that contains the concentrated sample.

• Concentrate Volume is the amount of concentrated sample to be diluted.

• Diluent Source is the reservoir that contains the diluent.

• Diluent Volume is the amount of diluent to be used.

• Destination is the vial in which the concentrated sample and diluent are
dispensed.
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Dilution Factor
The ⇒Sample Variable Dilution Factor is a correction factor for diluting
consecutive calibration samples.

See ⇒Dil. Factor (dilution factor)

Dilution Series
A dilution series ("concentration series") consists of several samples with
different concentrations. The samples were generated from a common original
sample. Alternatively, varying the injection volume can also generate a dilution
series.

Preparing a dilution series is especially useful when performing a multiple-point
calibration. Instead of injecting standard samples of various concentrations,
various volumes are injected from a standard sample (principle: the double
injection volume contains exactly the double amount of each component).

The corresponding amount is calculated as follows:

Amount Am
Inj Vol
Inj Vol

Smp Wght
Dil FactorPeak Tab

unknownAmount

known Amount
= −. *

. .
. .

*
.
.( .)

 Caution: Note that the calculated amount values refer to the same
standard sample. In the peak table, only one ⇒Amount value
(column 1) must be entered for each substance contained in the
standard.

Dimension of Amounts
This peak table parameter defines the physical dimension of the amount values
(⇒Amount), i.e. either amount or concentration.

Also, see ⇒Dimension of Amounts

Diode Array Detector
See Photodiode Array Detector
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Disconnect
Execute the Disconnect command to separate a user PC (client) from a

Timebase or to operate an instrument locally. The specified instrument is no
longer monitored by the data system, nor can it be operated via the data
system, as the instrument keyboard lock of the ⇒Connect command is no
longer valid.

 Note: Use the Connect command to undo the operation.

Also, see ⇒Connect/Disconnect

Dispense
The Dispense command causes the Autosampler to dispense a specific
quantity (volume) from the sample loop into a certain sample vial (⇒Position).
The amount of time the sampler may take for this operation, is determined via
the Duration parameter.

After the operation is completed, the sampler sends the signal Sampler.Ready
(in case of an ASI-100 / ASI-100T sampler or Ready for a GINA50/GINA160
sampler) back to the data system. The time interval between the Dispense
command and the response signal Sampler.Ready (or Sucked) can vary
depending on the instrument.

Also, see ⇒Dispense

Dispense (AS50 Sample Prep Command)
The Dispense Sample Prep Command moves a volume of reagent from a
reservoir to a vial. This command can be used only when the AS50 Sample
Preparation option is installed. Source is the reservoir from which reagent is
dispensed. Volume is the amount of reagent to dispense and Destination is
the vial in which reagent is dispensed.

DOF-Adjusted Coefficient of Determination
The calibration variable DOF-Adjusted Coefficient of Determination allows
to return the coefficient of determination corrected by the degree of freedom.
The calculation is as follows:
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With: N Number of standard samples involved in the calibration
m Number of degrees of freedom (= coefficients to be determined according to

the ⇒Calibration Type: LIN: m = 1; LOFF: m = 2; QUAD: m = 2;
QUOFF: m = 3 and EXP: m = 2),

i Index for standard samples
Wi Weight factor of the standard sample no. i
F(x) Model function of the calibration
Xi X-value of the standard sample no. i
Yi Y-value of the standard sample no. i and
Y Average of all Y-values.

Also, see Coefficient of Determination

Dongle
A dongle is an adapter that is placed on the parallel PC interface. The free end
of the adapter is designed as a parallel interface connector; thus, it provides
the parallel interface functions.

Similar to the PAL Plug-In Board, the dongle serves to store the serial
number of a Dionex Chromatography Management System station. Each
station has its own serial number.

Only if the serial number of the dongle and the Key Code stored in the
Dionex Chromatography Management System match, can the Dionex
Chromatography Management System be operated correctly. Otherwise, it will
run in Demo Mode only.

If there is neither PAL, dongle, nor license server (or if the key code is
incorrect), the Dionex Chromatography Management System can be operated
only in demo mode.

For further details, see Installation  Software Protection and How
to ...: Actions in the Server Configuration  Selecting the Copy
Protection Location and Entering the Key Code
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Drag & Drop
Instead of respective menu options, you can use the Drag & Drop function to
copy, move, and print any element. The function is available in the online and
offline modules, and is most useful when editing lists.

Press the mouse button and keep it pressed to move the selected element to
its new position. To move an object, use the left mouse button, to copy use the
right mouse button.

Draw
The Draw command (Draw for the ASI-100/ASI-100T, Suck for the
GINA 50/GINA 160) induces the Autosampler to draw a specific injection
⇒Volume from a certain sample vial (⇒Sample Position). The amount of time
this operation is allowed to take is determined via the Duration parameter.

When the operation is completed, the autosampler sends the signal
Sampler.Ready (in case of an ASI-100/ASI-100T sampler, Ready for a
GINA 50/GINA 160 sampler) back to the data system. The time interval
between the command Draw (or Suck) and the response Sampler.Ready (or
Sucked) can vary depending on the instrument type.

Also, see ⇒Draw

DS3 Detection Stabilizer
A temperature-controlled chamber that houses a conductivity cell and an eluent
heat exchanger.

The DS3 Temperature command can be used to set the temperature of the
DS3. The command can be executed directly from the Control Panel or linked
to a Control. To link the command to a control, place a string display, gauge
slider, or edit box control on the control panel (see Layout Toolbar). Then,
link the control to the object property, DS3_Temperature. For details, see How
to ...: Actions in the Control Panel  Linking a Control to a Device.

 Tip: The DS4, which is installed in the DX-120 Ion Chromatograph, is
identical in function to the DS3. The only difference is the
connections required for installation in the DX-120.
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Duration

Relay On/Off
Closing or opening duration in seconds [sec]. Specifying the duration is
optional. The relay on/off duration for the same relay may not overlap! Some

Device Drivers support trigger contacts that are treated as two (dependent)
relays R1 and R2. Switching on R1 will switch off R2 and vice versa. Thus, you
can control a trigger contact with only one Relay On command. However, you
can also ignore the second relay R2 and control the trigger contact via the
⇒Relay On/Off commands of relay R1.

Autosampler
The Duration parameter indicates the minimum time that the Autosampler
may take to perform ⇒Draw or ⇒Dispense operations. To prevent evaporation
of the sample load, not more than 10µl per second should be sucked or
dispensed. Otherwise, the gas bubbles resulting from an insufficient Suck
duration may considerably impair measuring precision.

Sound
Duration defines the time in seconds of the tone reproduction for the ⇒Sound
command.

DX-LAN
The local-area network (LAN) that connects Dionex modules to the PC on
which the Dionex Chromatography Management System is installed (for
details, see  DX-LAN).

Electronic Signature
According to the "21 CFR Part 11" rules and regulations published by the FDA
in 1997 electronic signature means " a computer data compilation of any
symbol or series of symbols executed, adopted, or authorized by an individual
to be the legally binding equivalent of the individual's handwritten signature.

In the Dionex Chromatography Management System, electronic signature
allows you to sign the results from your Raw Data that is important within the
scope of quality assurance and GLP. With enabled User Mode, you can
sign and save Sequence reports that have been accepted as correct so that
your results can be completely verified and understood.

Electronic signature includes three steps:
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• Submit
• Review
• Approve

Typically, the report will be signed and submitted by the user who created it.
Having reviewed the report, e.g. the laboratory manager will sign it again.
Finally, the quality assurance manager can approve the results.

 Note: Electronic signature requires the User Mode to be enabled and
is available for user databases only that were created with a

CmUser program version 6.10 or higher. Update your
database if an error message notifies you that electronic
signature will not be possible.

For information on how to sign reports electronically, see: How to ...: Actions
in the Browser  Signing Sequences Electronically as well as the CmUser
Online Help (CmUser_E.HLP).

Eluent Generator (EG40)
The EG40 eluent generator can generate high-purity acid or base eluents on-
line at the point of use, using only deionized water as the carrier. The EG40
consists of a high-precision programmable current source (power supply), a

DX-LAN automation interface, a high-pressure gas removal device, and a
disposable eluent generator cartridge (EluGen).

The EG40 is configured in a Timebase as part of the IC pump (for example, a
GP50 or IP25).

The Dionex Chromatography Management System provides the following
EG40 control functions:
• Control of the generated eluent concentration (from 0.0 to 100 mM)
• Monitoring of the ions remaining in the EluGen cartridge
• Monitoring of the EluGen cartridge expiration date

Also, see: How to ...: Device Control:

 Controlling the Eluent Generator Concentration

 Monitoring the Eluent Generator Cartridge Lifetime
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Eluent Mode (DX-120)
Eluent mode enables switching of flow from one eluent to another in a DX-120
Ion Chromatograph equipped with the dual-column option. In this mode, the
column-switching valve is disabled. The selected eluent always flows to the
column that was selected when Eluent mode was enabled. Also, see Column
Mode

The EluentAB command is used to switch the flow from one eluent reservoir to
the other. The command can be included in a Program, executed directly
from the Commands dialog box (select Command from the Control menu), or
linked to a Control on the control panel. To link the command to a control,
place an edit box or switch control on the Control Panel) (see Layout
Toolbar). Then, link the control to the EluentAB object property. For details,
see How to ...: Actions in the Control Panel  Linking a Control to a
Device.

To enable Eluent mode:

1. Open the Server Configuration program.

2. Select the DX-120 under the Timebase.

3. Double-click to open the Properties dialog box (or right-click and select
Properties).

4. Select the Mode tab page and select the Eluent option.

Emergency Program
The Dionex Chromatography Management System differentiates between
three types of errors:
• Fatal Error (Abort - batch is aborted)

• Serious Error (Error - batch continues - error is corrected as far as
possible)

• Error (Warning - batch continues - a warning is issued)

• Minor Error (Ignore - batch continues - only logged in the audit trail)

For the first error types, an emergency program can be defined. Instead of
aborting the batch, the emergency program is started automatically.
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The retention time continues while the emergency program is active and the
times are interpreted as offset. Data acquisition and audit trail will continue as
well. Upon termination of the emergency program, an End of Sample entry is
made in the audit trail.

For emergency program examples, see How to ...: Actions in the PGM Editor
 Creating an Emergency Program.

Emission
If a substance is fluorescent, it emits light at a specific wavelength range. The
fluorescence is measured via a fluorescence detector that is set to the
respective emission wavelength maximum. This emission wavelength is
entered via the Emission parameter.

 Note: The excitation wavelength of the fluorescence detector is
entered via the Excitation parameter.

Excitation
To induce a substance to fluoresce, the irradiating light must be of higher
energy than the emitted light. Therefore, the selected excitation wavelength
must be lower than the emission wavelength. To enable the analyzed
substance to absorb as much as possible of the irradiated energy, the highest
absorption maximum below the emission wavelength should be selected as the
excitation wavelength. This excitation wavelength is entered via the Excitation
parameter.

 Note: The emission wavelength of the fluorescence detector is entered
via the Emission parameter.

F1 Key
Use the F1 key to open context-sensitive Online Help, i.e. the displayed help
text refers to the current cursor position.



A-50 Glossary

Filter
The Dionex Chromatography Management System distinguishes three types of
filters:

Data Acquisition Filters
These filters can be set via the Control Panel if the device driver of the
detector supports this option.

Data Reprocessing Filters
Often, Smoothing filters are used to improve the Signal to Noise Ratio.
They allow smoothing chromatograms that have already been acquired. The
following smoothing filters are available:

• Moving Average (Boxcar)

• Olympic

• Savitzky-Golay

• Gaussian

Data Display Filters
1. MS Filter: In case of Mass Spectra, you can define the ionization polarity

and the ionization voltage for the mass spectrum plot.

If, in Full-Scan mode, several ionization settings are used, you may enter
an MS filter index in the mass spectra plot of the control panel to display
those mass spectra of the entire signal ( TIC) that correspond to a
specified group of settings. For example: The index 1 corresponds to the
first line in the Simultaneous acquisitions table (= TICF_1 - in the following
example: polarity "+ve", maximum voltage 100 V):
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The numbers of the settings (1 to 4) are also called filter index.

2. Audit Trail Filters: In the control panel, Report, and Printer Layout you
may specify the filter level for displaying messages. This is to avoid that the
Audit Trail (see Basic Operation / Control Panel  Audit Trail) includes
messages that are not relevant for you and thus becomes unnecessarily
long. Errors, warnings, and system messages are always given. However,
commands are displayed only from the specified level on (color code in the
control panel):

Errors and Warnings: no commands

Normal: green

Advanced: yellow ("normal" and "advanced" commands
                                                   are displayed)

Expert: red ("expert" and "advanced" commands
                                               are displayed)

Find (Button)
The Find tab in the Online Help window allows you to find specific words,
terms, or text included in Online Help. All help texts of the Dionex
Chromatography Management System are searched.
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Flow Gradient
Alterations to the ⇒Flow within one chromatogram are referred to as flow
gradient. The gradient can be generated manually or program-controlled.

 Note: Pumps that are controlled serially will deliver a specific flow rate
via command. As it is not possible to enter an unlimited number
of these commands in very short intervals, this type of flow
gradient will have small steps. Pumps with voltage, frequency, or
pulse width control can continually change the delivery rate.
There are virtually no steps.

Flow Rate
In general, the Flow Rate indicates the total volume (in [ml/min]) delivered by
the chromatography pump. It is composed of the sum of all ⇒Partial Flows
(%A+%B+%C+%D=100%).

Normal flow rates are in the range 0.5 to 10 ml/min. Flow rates deviating from
this range are achieved by using micro pumps (0.1 - 0.5 ml/min) or especially
equipped pumps (as from 10ml/min). For gas chromatographs, the amount of
mobile gas phase is also called flow rate.

 Caution: As there are pressures up to 400bar in the chromatography
column and as solvent mixtures are subject to volume
compression (e.g. methanol/water), the delivered volume in

High-Pressure Gradient Systems does not correspond to the
volume transported via the column. However, the number of
delivered and transported solvent particles is not changed by this
fact.

Also, see ⇒Flow

Flush (AS50 Sample Prep Command)
The Flush Sample Prep Command flushes the inject port with a specified
volume of flush fluid. During the flush cycle, the needle moves to the waste port
and expels any fluid. The needle then moves to the inject port and delivers a
volume of fluid for flushing the inject port. If the injection valve is set to the Load
position, the loop is also flushed. The needle then moves to the flush port and
delivers a volume of flush fluid, which washes the outside of the needle.
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Flush Volume (AS50 Command)
The Flush Volume AS50 Autosampler command determines the volume of
fluid used to flush the inject port. The flush cycle is performed either before or
after each injection, depending on the option selected.

Formula for Amount Calculation
The formula calculates the substance amount in an analysis sample. The
prerequisite is that all necessary Calibration Coefficients as well as the peak
areas of the unknown sample were determined.

Amount a x Fact ISTD Fact
Dil Factor
Smp Wghtp p p p

n

n
= −( ) * . . * *

.
.

Resp

 p Peak number

pa Calibration function for peak p calculated in the calibration.

pX Determined area of peak p

pFactResp. Scaling factor that can be entered peak-specifically, e.g. serving as a
compensation for the differing absorption behavior.

 ISTD Fact. Correction factor for internal/external standard method. For the external
standard, this factor equals 1.

 Dil.Fact. Corresponding parameter from the sample list.
 Smp.Wght. As sample-specific factors, they always refer to all peaks!
 n Sample number

Formula for Amount Calculation (Rel. to ISTD)
The function calculates the substance amount in an unknown sample relative
to the added Internal Standard. The prerequisite is that all peak areas of the
sample were determined (including that of the internal standard).

Amount
Amount

Am a
Area
Area

Fact
Dil Fact
Smp Wght

Peak

ISTD
p rel p

Peak

IS
p

n

n
= =. * * . . *

. .

. .. Resp
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 p Peak number

pa Calibration function for peak p calculated in the calibration.

pX Determined area of peak p

pFactResp. Scaling factor that can be entered peak-specifically, e.g. serving as a
regression function for the differing absorption behavior.

 ISTD Name of the internal standard
 Dil.Fact. Corresponding parameter from the sample list.
 Smp.Wght. As a sample-specific factor, Smp.Wght. always refers to all peaks!
 n Sample number

Fraction Collector
At the detector output, fractions can be collected for occasional preparative
chromatography as well as for the exact determination of the separated
substances in subsequent analytical procedures. A fraction collector is
imperative if this is routine operation.

The fraction collector must collect the fractions depending on the incoming
signal, i.e., fraction collector control is via extensive Programs. If the
absorption signal exceeds a specified threshold value, ⇒Trigger commands
are used to close a relay and move to the next collecting tube.

Installing the Fraction Collection Automation driver in the Server
Configuration considerably shortens the respective program and thus facilitates
fraction collector control. In addition, the Device Driver of the respective
fraction collector has to be installed in the server configuration. The Fraction
Collection Automation driver compares to the Integrator Driver that is
required in addition to the respective pump driver for recording the pump
pressure.

For information on how to control fraction collectors, see How to ..: Device
Control  Controlling Fraction Collectors.
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Front Riders to Main Peaks
The Front Riders to Main Peaks detection parameter allows you to change
rider peaks on the ascending edge of a peak into main peaks.

 Tip: This parameter has priority over the Rider peak type
indicated in the peak table.

Also, see ⇒Front Riders to Main Peaks

For detailed information on how to apply the detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters

Fronting Sensitivity Factor
For information on this topic, see Tailing Sensitivity Factor.

Full-Loop Injections (AS50 Sample Prep Command)
When performing a full-loop injection, the AS50 Autosampler draws four
times the loop volume from the sample vial and delivers it to the injection valve.
The middle portion of the sample is positioned in the loop and injected.

    Important: For very small loop sizes (less than 17 µl), 2.5 times the loop
volume plus 25 µl is delivered to the valve.

The maximum loop size for full-loop injections is 300 ml. If a
larger loop size is used, sample can contaminate the flush
bottle because the sample volume drawn is greater than the
sample transfer line volume of 1200 ml.
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Full-Loop Injection Sequence

Full-Scale
The Full-Scale command sets the voltage for a full-scale analog output. For
example, if 0.1V is selected and a recorder is connected to the detector’s
analog output, the recorder’s full-scale response will be at 0.1V. For the AD20
detector, the full-scale voltage is fixed at 1V.

Full-Scan
Full-Scan is the Mass Spectrometer method for recording TIC
chromatograms. Contrary to SIM (Selected Ion Monitoring), this method
records the entire Mass Spectrum of each individual analyte.

In full-scan mode, you can extract Mass Traces already during data
acquisition (see How to …: Actions Related to the aQa-MS  Extracting
Mass Traces Afterwards).

Also, see:  Defining the Number of MS Channels.
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Full Size
The Full Size function undoes all previous Zoom operations. To undo only the
last operation, use the Unzoom function.

In the signal plot, double-click in the Overview Window to perform the Full
Size function.

Gain
For the fluorescence spectrometers RF1002 and RF2000, the Gain signal
parameter determines the factor with which the analog output signal is
increased or reduced. Gain has therefore the same significance as the

Range parameter for other detectors.

 Note: The Dionex A/D Converter ranges from -10V to +10V and thus
covers virtually all detector output signals. It is possible to record
signals directly, without considering the Gain parameter. If size
adjustment is still necessary, this can be performed via the
Factor parameter of the A/D converter.

GLP ("Good Laboratory Practice")
Good Laboratory Practice means the adherence to regulations on the
organization and conditions of planning, performing, and monitoring laboratory
work.

A special focus is the complete and clear listing of the complete data in an
analysis process. In addition, regular checks of the instruments and the
software are required.

GLP contributes to enhancing the quality of test data. In Germany, the GLP
principles were introduced in 1983. In 1990, they became part of the chemical
law (ChemG).

Gradient
Usually, gradients are used in HPLC/IC and GC to accelerate the separation of
substance mixtures. Due to the different separation mechanisms in HPLC/IC
on the one hand and GC on the other, different gradient types can be used.
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In HPLC/IC, there are two different gradient types:

If the composition of the mobile phase changes, this is referred to as %-
Gradient. If the flow rate is altered, this is called a Flow Gradient. The Dionex
Chromatography Management System can generate flow and %-gradients.
Both gradient types can be performed at the same time (!).

 Tips: This results in non-linear partial flow alterations in the total flow.
With High-Pressure Gradient Systems with more than one
pump it will result in non-linear partial flow alterations for each
individual pump. Not all chromatography pumps support this
option.

The chromatographic conditions for high-pressure and low-
pressure gradients are not transferable due to the different
properties in solvent compressibility and dead volume!

In GC, there are three different gradient types:

Usually, temperature gradients are used. In addition, flow or pressure gradients
can be used with some GCs. With GC gradients, the flow (or the temperature,
or the pressure) is usually increased during the chromatogram. Changing one
of the three variables automatically changes the remaining two according to the
equitation of state for ideal gases and the Hagen-Poisseuille law. Nevertheless,
it is also possible in GC to run a temperature and a flow or pressure gradient
simultaneously. In this case, the flow or pressure change which results from the
temperature increase is considered for the flow and pressure settings,
respectively.

Independently of the gradient types described above, the gradient forms can be
different: Ramps and Step Gradients are distinguished. In case of a ramp the
solvent composition, for example, changes slowly until the desired composition
is finally reached at the desired end. In case of a step gradient, however, the
composition would be set immediately. (Depending on the column, the solvent
change, and the flow, it may nevertheless take some time until the desired
composition is reached on the column.)

Gradient Curves
The Dionex pumps GP40, GP50, and GS50 let you specify linear or non-linear

%-Gradient profiles (gradient curves). Eluent Generators can also deliver
non-linear %-gradient profiles. Also, see Gradient Curves Equations for the
mathematical descriptions of the curve types.
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Curve 5 (the default) is linear. Changes in composition of the delivered solvent
over time are constant.

Curves 1 - 4 are convex upward. Convex curves cause rapid changes in
solvent composition at the beginning of the gradient and slower changes at the
end. Slope changes over time become extreme as curves go from 4 (least
convex) to 1 (most convex).

Curves 6 - 9 are concave upward. Concave curves cause slower changes in
solvent composition at the beginning of the gradient and rapid changes at the
end. Slope changes over time become extreme as curves go from 6 (least
concave) to 9 (most concave).

The figure below shows the solvent composition profiles of curves 1 through 9,
for a change from 0 - 100% B over 10 minutes.
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Gradient Curves Equations
The following equations describe the Gradient Curve profiles generated by
the Dionex gradient pumps GP40, GP50, and GS50, and by the eluent
generator.

For convex gradients:
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Where: k = 0, ¼, ½, ¾, 1 for curve numbers 1, 2, 3, 4, 5 respectively
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For concave gradients:

( )( )
( )

( ) ( )( )
( )TfTt

TfTeVfVtkVfVtkVfVe TfTt
TeTt

−
−−+










−−+= −

−−10

21

Where: k = ¾, ½, ¼, 0 for curve numbers 6, 7, 8, 9 respectively

Ve Current eluent value

Vf Eluent value at the previous step time

Vt Eluent value at the next step time

Te Current elapsed time

Tf Time at the beginning of the gradient step

Tt Time at the ending of the gradient step

k Parameter that is changed to produce different curve number results

Group (Peak Group)
Within a chromatogram, it is possible to group individual peaks and to calibrate
and integrate them together. Assign a common name to these peaks in the
Group peak table column in the ⇒QNT Editor. The peaks do not have to
succeed each other directly but can be scattered at will.

Also, see ⇒Group

If a peak belongs to a user-defined group, the Group report peak variable
indicates the group's name. In addition to the user-defined peak groups, two
pre-defined groups are available:

1. The group of all unidentified peaks without explicit group entry (empty group)

2. The group of all identified peaks without explicit group entry (empty group)

All other peak groups must be defined on the Peak Table tab in the QNT
Editor. For unidentified peaks, the group defined in the dialog Unidentified
Peaks is indicated provided the peaks occurs in the corresponding time
interval.
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Height (Peak Height)
This peak result variable refers to the peak height in the maximum, i.e. at the
retention time, relative to the baseline.

The height dimension depends on the detector type. For UV detectors the area
is usually specified in mAU (milliabsorbance units).

Also, see Relative Height

Help
See Online Help

High-Pressure Gradient System
In a high-pressure gradient system, each partial flow is delivered via a separate
pump into the mixing chamber against the pressure of the column. Differences
in volume contraction and compressibility, as observed in most solvent
mixtures, are not important during delivery but when mixing the solvents on the
high-pressure side of the pump.

Unlike Low-Pressure Gradient Systems, the delivered volume of each partial
flow can be determined precisely in high-pressure gradient systems. The
gradient profile is more precise and can be achieved with relatively simple
pumps. However, the costs for the additional pump are disadvantageous.

In Dionex instruments, control of additional pumps ("slave") is usually by a
main ("master") M480 pump. The new Dionex pump P 580 combines master
and slave pump in one housing. Alternatively, several pumps e.g. 2x M300 can
be controlled centrally via the data system and the pump control board.

 Caution: Due to solvent compressibility and differing dead volumes, the
chromatographic conditions of high-pressure and low-pressure
gradient systems are not interchangeable.
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History
The History mode (or more exactly the File History Mode or Modification
History Mode) completely documents any changes and operations performed
in specific objects and files. Objects include samples, Sequences or

Datasources, Control Panels, Report Definition Files (RDFs), PGM
Files, and/or QNT Files, and of course modified chromatograms.

The History mode can be activated (or deactivated) individually for each
datasource (see Properties of a datasource / Enable Modification History).
If the Comment required option is activated, each user is prompted to enter a
comment before saving the changed object (defined above).

Select a datasource, a directory, or a single object and choose the Show
History command to view the changes that are already documented.

Entering and editing comments as well as enabling or disabling the History
Mode requires the corresponding Privileges.

Hit Criteria
If there are too many hits in a spectra comparison (see How to ...: Actions in
the UV Spectra and Mass Spectra  Starting a UV Spectra Search) due to
the selected comparison function (see ⇒Check Derivative) or ⇒Match
Criterion, this list can be limited by adding the following selection criteria:

Comparison Conditions Additional Limitations
Standard of comparison Number of extrema
Minimum match degree Retention time deviation
Comparison function Solvent composition (*)
Wavelength range PGM File name (*)
Comparison of the largest relative maximum

Only spectra fulfilling the corresponding criterion will be admitted into the
selection.

All fields accepting alphanumeric input (*), can be searched with a so-called
regular expression, which may contain the wildcards '?' and '*' also used in MS-
DOS.
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Example: If  *y?ene is entered as name filter, the hydrocarbons pyrene,
chrysene and perylene would be hits, but not anthracene. The hit
criteria can be used to comfortably generate sub-libraries. If
using these filters, without comparing spectra, the hit list
contains the spectra fulfilling the hit criteria. The partial quantity
can be stored as a separate library.

 Caution: Please note that a distinction is made between upper and lower
case letters in the case of alphanumeric input. When using a
capital letter in the filter expression, hits must also contain a
capital letter at exactly the same position. When using lower
case letters, the corresponding hit may contain lowercase and
uppercase letters.

Hold
In the Hold mode, no more data is acquired, the pump continues delivery with
the current solvent composition, and processing of the batch samples is
stopped before the next sample.

Also, see ⇒Hold

Holmium Oxide Filter
Recent Dionex UV/photodiode array detectors (the two-channel detector
UVD170S and the Photodiode Array Detectors UVD340S and PDA-100)
feature holmium oxide filters.

For the UVD170S and UVD340S detectors, the holmium oxide filter allows
calibrating UV/VIS spectra recorded with the detector due to the typical
absorption spectrum of holmium oxide.

For the PDA-100 detector, the holmium oxide filter is used to verify wavelength
accuracy.

 Note: It is also possible to fit older UVD170S/340S instruments with
holmium oxide filters. Please contact Dionex Service.
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Index (Button)
The Index tab dialog box contains the alphabetical index list of Online Help
terms that are available in the Dionex Chromatography Management System.
Enter the initial letter of the topic and choose Display to view help information
on this topic.

Industry Minute
An industry minute (also referred to as decimal minute) has 100 units instead of
60 seconds.

"2.500" (industry minutes) therefore means "2 minutes, 30 seconds," and
"2.100" means "2 minutes, 6 seconds" etc.

Inhibit Integration
The Inhibit Integration detection parameter serves to shut off certain
chromatogram areas

Also, see ⇒Inhibit Integration.

For information on how to apply detection parameters, see

How to ...: Actions in the QNT Editor  Defining Detection Parameters.

Inject Command
The Inject command defines the start of a chromatogram and thus the time
when the sample is brought into the high-pressure cycle of the system. By
definition, the time of the first Inject command is set to zero.

In a dialog box, you define the sample vial position in the Autosampler
(⇒Position) and the quantity of the substance (⇒Volume) to be injected. When
a hand-operated valve is used for injection, this information is used for
documentation purposes.

Also, see ⇒Inject Command

Injection Time
The Inj. Time column in the peak table shows the day, month, year, hour,
minute, and second when the sample was injected (Also, see Time). This
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column cannot be edited. The Dionex Chromatography Management System
enters the injection time of the sample in the corresponding column of the
sample list. For samples with the ⇒Status (sample status) "M" the time of the
last injection is entered.

The kind of entry (empty or time value) indicates whether and when the sample
was processed.

Also, see ⇒Inj. Date / Time (Time of Injection)

Injection Types (AS50 Autosampler)
The type of injection performed by the AS50 Autosampler is selected
automatically, depending on the settings of other variables:
• A full-loop injection is performed when the ⇒Inj. Vol. (injection volume) is

greater than the Loop Volume (see Full-Loop Injections).

• A partial-loop injection is performed when the injection volume is less than
the loop volume and the Cut Segment Volume is greater than 0 (see

Partial-Loop Injections).

• A partial-loop, limited-sample injection is performed when the injection
volume is less than the loop volume and the cut segment volume is 0 (see

Partial-Loop, Limited-Sample Injections).

 Tip: Partial-loop, and partial-loop, limited-sample injections are
available only when the injection valve is installed in the AS50
autosampler compartment, or in the AS50 chromatography or
thermal compartment.

Injection Volume (Volume)
The ⇒Sample Variable Inj. Vol. is in micro liters (µl). In automatic operation,
the installed Device Driver converts this value into a volume readable by the

Autosampler, and then the value is sent to the autosampler.

By entering different injection volumes, a Dilution Series can be created in
case of a multiple-point calibration (see Single-Point and Multiple-Point
Calibration).

Also, see ⇒Inj. Vol. (injection volume) and ⇒Volume (command).
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Installation Qualification (IQ)
As defined in cooperation with EURACHEM, Installation Qualification (=IQ) is
"the process of installing an instrument up to and including its response to the
initial start of operation" [P. Bedson and M. Sargent, Accred. Qual. Assur.
(1996) 1, 265-274].

An important task of Installation Qualification is to ensure that the instrument
and its individual components are supplied as ordered (i.e. according to the
specification agreed on by the customer and the manufacturer). In addition, the
correct installation in the selected environment is checked. Finally, the IQ must
be formally documented.

For Dionex hardware, the IQ is performed in accordance with this definition and
the Dionex Installation Qualification, Operational Qualification,
Performance Qualification SOP. For an "instrument" of the Dionex
Chromatography Management System, the IQ can be started via the
Chromeleon IQ and Check Installation commands of the Qualification
menu in the Browser. The IQ checks the system information, the data system
status, as well as all installed files. Examine the report for possible installation
errors.

 Note: This may result in warnings stating that previous versions of the
system files and the ODBC files already existed before the
Dionex Chromatography Management System was installed.
However, as these warning are not critical they can be ignored.

Use the Save, Save as or Print commands of the File menu to formally
document the IQ of the Dionex Chromatography Management System from
within the indicated report (dialog box CHK.Setup.log - Editor)
For further information on the Installation Qualification, see CHROMELEON
Installation Qualification in the Online Help.

Integrated Amperometry Mode
In addition to the DC Amperometry Mode, Dionex electrochemical detectors
can be operated in Integrated Amperometry mode. Integrated amperometry
detection employs a repeating Waveform. The cell current is integrated
during a specific section of the waveform. It is a more general technique than

Pulsed Amperometric Detection in that pulsed amperometry employs a
repeating sequence of three potentials, while integrated amperometry can be
any waveform.
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With the integrated amperometry waveform shown below, the current is
integrated twice - first, while the potential is swept across the metal oxide
formation wave, and then during the reverse sweep across the oxide reduction
wave. Without the presence of analyte molecules, the net charge is around
zero. Positive and negative cleaning pulses are added to the waveform
following the integration period.

Integration Parameters
In the Dionex Chromatography Management System, these parameters are
referred to as Detection Parameters. For an overview, see ⇒Detection
Parameters.

Integration Period
In Integrated Amperometry detection, the integration period is the time during
the Waveform in which data is recorded. The integration period is also
referred to as analysis or sample time.

Integration Type
The Integration Type peak table parameter indicates which peak property is to
be used for the calculation of quantitative results.

Also, see ⇒Integration Type.
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Integrator Driver
The Dionex Chromatography Management System does not directly process
analog signals that are received via a Sharable Device (e.g. the A/D
Converter or the UCI-100 Universal Chromatography Interface). Recording
these analog signals (e.g. from gas chromatographs or pumps) via the
channels of the A/D board requires the Integrator Driver (also, see Device
Driver) that assigns the individual channels of the sharable device.

The advantage is that you do not have to rewrite all PGM Files concerned if
you plan to connect a device to a different channel. Instead, only change the
A/D port assignment in the integrator driver. This also allows you to distribute
the channels of a Sharable Device to several Timebase, thus, eliminating
the need to have e.g. one individual A/D converter for each timebase.

The integrator driver allows you, for example, to record the pump pressure in
order to check whether signal variations in the chromatogram are caused by
pump pressure variations. Also, see How to ...: Device Control  Recording
the Pump Pressure.

Intercept
See Offset (c0)

Internal Standard ("ISTD")
An internal standard is a substance that is added both to standard and
unknown samples. The internal standard should have a similar retention time
behavior as the analyzed substances, but it should be easily separated from
them.

As a rule, the amount of injected internal standard is constant, i.e. all samples
receive precisely the required amount of internal standard so that identical
amounts reach the column when injecting the same volumes. In the case of a

Dilution Series, the internal standard must be pipetted after the dilution! The
dilution can therefore not be simulated by variation of the injection volume but
must be actually performed.

 Note: With an appropriate Autosampler (e.g. Dionex ASI-100),
pipetting can be performed automatically. The quantitative
accuracy thus reached is one level above the standard method
External. The methods with internal standard also compensate
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minor injection inaccuracies, as the internal standard is equally
affected by a possible loss or excess.

Substances serving as an internal standard are labeled as such in the
Standard column of the peak table. Depending on the type of internal
calibration, they receive the label Internal/External; Peak or Internal; Peak.

"Internal/External" Principle
All substances contained in a sample are calibrated as usual with known
standard substances (including the internal standard). As the same amount of
ISTD is contained in all samples of a sequence, a uniform value for the ISTD
should result. If this is not the case, this is an indication for an error during
sample processing (provided that the same amount of the internal standard is
actually contained in all samples). The results of the remaining substances of
this sample can then be relativized.

"Internal" Principle
Instead of absolute areas and amounts, calculation is based on area and
amount ratios. Calculation of all substance amounts is relative to the internal
standard. By forming the ratio, inaccuracies in sample processing (from adding
the ISTD) can be eliminated (const. Internal standard).

Due to the high experimental expenses, this type of calibration is rarely used
(the internal standard must be added with a pipette to each sample, in the case
of a dilution series this must be after the dilution).

Exceptions (= Variable Internal Standard)
The method itself or the properties of the internal standard make it impossible
to add the same amount of ISTD to all samples. To solve this problem, the
Dionex Chromatography Management System offers the Use sample amount
as reference (Variable) option (see F8 box of the Standard column in the
peak table).

In this case (irrelevant whether Internal/External or Internal), the amount of
the internal standard is entered in the ⇒Amount column of the sample list, not
in the ⇒ISTD Amount column of the peak table. For each sample, the amount
of internal standard can thus be entered separately.

Also, see ⇒Standard
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IQ
See Installation Qualification (IQ)

ISTD
See Internal Standard ("ISTD")

Isocratic
A solvent flow of constant composition is called isocratic. It is irrelevant whether
it is a pure solvent or a solvent mixture of constant composition.

ISO Plot
See 3D-Field: Presentation Modes
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Jump to Another Help Topic
As soon as the mouse cursor is positioned on a link term, it changes into a
pointing hand. All link terms are displayed in green.

Terms underlined by a dotted line (e.g. F1 Key) are links to additional
information in a pop-up; terms underlined by a single line are links to a new
help topic.

Key Code
The range of functions available for the individual stations of the Dionex
Chromatography Management System is determined during installation by a
key code.

A 12-digit or a 24-digit number serves as key code that makes available
specific functions and options. Each station of the Dionex Chromatography
Management System has a Dongle or a PAL Plug-In Board and can only be
operated if the serial number coded there matches the key code.

If a user expands the scope of functions of the Dionex Chromatography
Management System by acquiring the corresponding licenses, s/he receives a
new key code. The extended scope of functions is made available immediately
upon entering the new code.

The key code is entered via the About box in the Help menu or via the
Server Configuration program. Valid characters are numbers, letters, spaces,

and hyphens. Input is not case-sensitive.

For further details, see Installation  Software Protection and How
to ...: Actions in the Server Configuration  Selecting the Copy
Protection Location and Entering the Key Code

Kovats Index
The Kovats Index serves for achieving a uniform scaling of the ⇒Retention
Time. Define the Kovats Index on the Peak Table tab of the ⇒QNT Editor.

Also, see ⇒Kovats Index
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Lamp On/Off
This command switches the lamp of an optical detector on and off. UV/VIS
detectors often have a separate lamp for each range (deuterium/halogen). To
activate both lamps, the command must be entered and executed twice.
However, it is also possible to switch both lamps simultaneously or to switch on
the second one automatically when the first lamp reaches a certain value.

Also, see ⇒Lamp On/Off

Layout Mode
For some elements of the Dionex Chromatography Management System, a
special Layout Mode is available that allows designing them according to your
requirements:
• Control Panel
• Printer Layout (printout) and
• Report (screen table)
• History report

Control Panel
Choose the Layout Mode command in the Edit menu or context menu to
change from the online mode to the layout mode. In the Layout mode, you can
create new control panels or modify the appearance and the functions of
existing ones. Running online processes will be continued. However,
controlling the system is not possible in this mode.

Click an icon on the layout toolbar to add a new control to the control panel by
a simple mouse click. The pointer function of the Layout Toolbar enables the
selection of a Control (display and control elements). Selected controls are
indicated by a Control Frame and can be modified in size, shape, and
function.

For detailed instructions on how to modify a control panel, see How
to ...: Actions in the Control Panel  Modifying a Control Panel.

 Note: Creating a new or modifying an existing control panel can only be
performed, if the user has the corresponding access rights.
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Printer Layout
In the Printer Layout, you can enable and disable the Layout Mode via the
Layout Mode command of the Edit menu. Inserting, modifying, and copying
the different Printer Layout elements is possible only if the Layout Mode is
enabled.
With enabled Layout Mode, an additional field for entering text is given in the
upper report section. Input is similar to MS Excel.

Report
In the Report, the Layout Mode command of the Table menu allows enabling
and disabling the Layout Mode. With enabled Layout Mode, an additional text
field for entering the desired values is given in the upper report section.

History Report
A special Layout Mode is available in the History Report. If Detail columns
are available, you can enable this Layout Mode via the Layout tab of the
History Report Properties dialog box.
A shortened report is displayed in which you can easily define the layout.

Layout Toolbar
The layout toolbar contains icons of all default Controls and display elements
of the Control Panel that are available in the Layout Mode. The layout
toolbar is only accessible in the layout mode.

Click an icon to position the selected default control within the current control
panel. The display of the layout toolbar can be enabled/disabled via the
Toolbars command from the View menu.
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The following default controls are available (links available in the Online Help
only; for further details, see the respective Online Help topics)

Pointer (selecting, moving ...) Lamp

Check Box Switch

Color Box Entry Field (Edit Field)

String Display Audit Trail

Gauge Indicator Gradient Control

Command Button 3D-Plot

Online Signal Plot Rack Control ( Rack)

Group Box Mass Spectrum

Slider

Left Limit
Normally, peak integration is performed automatically. However, it is possible
to limit or extend integration on the left, right or on both sides. This is by
entering a left and/or a right integration limit in the peak table.

Also, see ⇒Left/Right Limit

Left Width
If a perpendicular line is dropped to the baseline from the peak maximum, the

Width of the peak is divided in a left and a right section. The two sections are
referred to as left width and right width and can be expressed as separate
peak result variables.

The Dionex Chromatography Management System also determines the left and
right peak width at 5, 10, and 50% of the peak height. As pointed out under the
glossary term Width, height is very important for the calculation of the peak
width. This also applies to the calculation of the left and right peak widths.

The abbreviations for the left and right peak widths are LW and RW.
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To display the left peak width in the report, please proceed as follows: Select
the column in the report, choose the command Column Properties from the
context menu and select the Left Width variable in the selection box. Press the
Parameter button to determine at which peak height to determine the peak
width.

License Server
If installations include a large number of computers, a License Server is
optionally available for Dionex Chromatography Management System that can
manage the licenses of the Dionex Chromatography Management System.
With this type of installation, it would not make sense to equip all Client PCs
with Dongles or PAL Plug-In Boards and to enter the corresponding Key
Codes.

If no PAL, dongle, or License Server is specified, the Dionex Chromatography
Management System can be operated in Demo Mode, only.

For information on how to install the License Server, see Installation
Instructions for Different Devices  Installing the License Server

For further information, see Installation  Software Protection and How
to ...: Actions in the Server Configuration  Selecting the Copy
Protection Location and Entering the Key Code.

LIMS
LIMS is the abbreviation for Laboratory Information Management System.
LIMS receives electronic tasks, ensures that they are processed, and makes
the results available in a defined format.

In the chromatography system, this can mean that the samples to be analyzed
are read via bar code, before the samples are included in a sequence and are
processed one after another. The results are saved in a default format (e.g.
AIA). The sequence is generated by the data system if the required information
is supplied in a defined format.

In the Dionex Chromatography Management System, reading this type of data
is via the defined format of a Worklist.
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Lock Baseline
By activating this parameter, it is possible to keep the baseline on the
prescribed level.

Also, see ⇒Lock Baseline

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Modifying Detection Parameters.

Log
The Log command allows you to document the values of variables in the Audit
Trail at any time. This option is especially useful to log information that is not
periodically retrieved.

The command is also available directly in the Command dialog box of the
Control menu.

Also, see ⇒Log

Logon
The Logon dialog ensures access to the respective program. Access is
permitted for authorized users only who are identified via a Password in the
logon dialog.

In the Dionex Chromatography Management System, access to the CmUser
program is always via the logon dialog. Opening a Dionex Chromatography
Management System client requires a logon with a password only if the User
Mode is enabled.

Loop Volume
Loop Volume is the sample loop volume obtained from the value entered in
the Plumbing Configuration screen on the AS50 Autosampler front control
panel.
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Low-Pressure Gradient System
In low-pressure gradient systems, the same pump delivers all partial flows.

Simple systems generate the required solvent mixing ratio in the mixing
chamber. Then, the mixture is sucked from the chamber and carried to the
column. The solvent composition is controlled via different valve closing times
in the feed lines of the individual components. As the mixing chamber volume
represents a dead volume, producing the correct mixing ratio on the column is
delayed.

Systems that are more complex mix the individual partial flow during the
suction period in the piston. This requires the calculation of how much volume
can be sucked (the value is not constant as delivery is not always against the
same external pressure, i.e. small volumes are pumped if the external pressure
is high, larger volumes are delivered if the external pressure is low). Also, it is
necessary to calculate the time of how long each valve must be opened for the
individual partial flows to reach the exact mixing ratio.

Despite these mechanical and electronic procedures, the gradient profile
produced by low-pressure gradient systems is less precise than High-
Pressure Gradient Systems, however, it is the less expensive alternative.

 Caution: Due to solvent compressibility and differing dead volumes, the
chromatographic conditions of high-pressure and low-pressure
gradient systems are not interchangeable.

Manipulations
Minor changes during the integration of single chromatograms are called
Manipulations. For information on how to perform manipulations, see: How
to ...: Actions in the Chromatogram  Manual Re-Integration. The Save
Manipulations and Delete Manipulations commands of the Edit menu allow
accepting or rejecting these manipulations.

Mark
The Mark command sends a positive pulse to the detector’s analog output as
an event marker. The pulse is 10% of the full-scale analog output. A mark is
typically used to indicate a sample injection.
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Mass Defect
The mass defect is the difference between the calculated mass and the
nominal mass (integer). Summing the masses of all the components of the
compound uses calculated mass. The masses of the elements come from the
periodic table, with the mass of C12  being exactly 12.0000000 amu. Most of the
other elements have masses close to their nominal elemental mass (the
difference between the integer and the actual mass is the mass defect):

H1 1.007825 amu

C12 12.00000 amu

C13 13.00335 amu

N14 14.00307 amu

O16 15.99940 amu

F19 18.99840 amu

So, when you want the mass of a compound you can calculate as follows:

Formula Nominal Mass [amu] Actual Mass [amu] Defect [amu]

5105 OHC 5(12) + 10(1) + 5(16)
= 150

5(12.00) + 10 (1.008) + 5(15.999)
= 150.075

0.075

10250HC 50(12) + 102(1) = 702 5(12.00) + 102(1.008) = 702.8 0.8

Therefore, as you get to larger compounds with more atoms in it, you will sum
all the "defects" of the individual atoms together and the difference can get to
be substantial, especially if you display the mass as an integer. In the
examples above, the first would be displayed as an integer 150 amu either
way. In the second example, the actual mass in integer format would be 703
amu that is a whole mass unit from the nominal mass of 702 amu.

If you have organic compounds with nitrogens and hydrogens in them and the
only other element is carbon you end up with a positive mass defect. Since
many hydrocarbon compounds have a lot of hydrogen, it can be a very large
defect.

If you have in addition a substantial amount of oxygen, its negative mass defect
can offset the nitrogen and hydrogen and the mass defect will not be as large.
That is why the user sets the type and magnitude of the mass defect
depending upon what kind or class of compounds he is working with. The
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correction for mass defect is generally set as x mmu per 100 amu where mmu
is millimass unit or one thousandth of a mass unit.

So if the correction is set to 100 mmu/100 amu (it is usually set from 30 to
120 mmu/100 amu) the correction for the examples above would be:
Correction Factor [amu] Corrected Mass [amu] In Integer Format
150 (0,100/100) = 0.15 150.075 - 0.15 = 149.925 150 amu
702 (0,100/100) = 0.7 702.8 - 0.7 = 702.1 702 amu

Thus, the correction factor just works to "modify" the data so that people used
to working with integer masses for their elements in a compound end up with
what they expected.

Mass Spectrometer
Mass spectrometer were originally developed as stand-alone instrumentation to
analyze the structure of unknown, mostly organic compounds. In combination
with chromatographic separation procedures, however, they also allow the
qualitative and quantitative analysis of complex mixtures of substances. While
the GC/MS coupling has long been part of the standard equipment in analytical
laboratories, HPLC-MS is not yet that widely spread because of its problematic
coupling. However, acceptance is steadily growing as the HPLC/MS coupling
has been decisively enhanced during the past years. Besides, with the MS
Detector another detector allowing qualitative statements on individual
substances of a chromatogram is available in addition to the Photodiode
Array Detector

Mass spectrometry includes four steps:
• Sample loading (neutral molecules)

• Ionization of individual molecules

• Ion separation according to their masses

• Ion registration in form of a Mass Spectrum

Different processes can be used for ionizing and separating ions with different
masses. The following image illustrates ionization by means of an electron
impact and the subsequent mass separation by means of a vertical magnetic
field:
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The ions that are created via the electron impact are first accelerated by means
of the cones and then separated according to their mass in the magnetic field.
Due to the varying intensity of the magnetic field (or the accelerating voltage),
ions of different masses are directed through the exit slit into the collector and
registered. In this way, mass spectrometers perform a mass scan similar to the
wavelength scanning of many photodiode array detectors.

For information on how to record and process MS Data with the Dionex
Chromatography Management System, see

How to ...:  Actions Related to the aQa-MS.

Mass Spectrum
An MS detector ( Mass Spectrometer) allows recording of a mass spectrum at
any time t of a chromatogram. The two-dimensional view of a chromatogram
(retention time and intensity) is extended by a third dimension (mass). In
addition to the information on retention time (t) and intensity (I) information,
each of the recorded data points also includes information on the masses (m)
detected in the mass spectrometer.

Mass spectra usually include a great number of narrow peaks. To distinguish
them from the comparatively wide chromatogram peaks they are called mass
peaks.
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The Dionex Chromatography Management System allows viewing in the report
the mass spectrum of a peak or the mass spectrum at any time of the
chromatogram. During data acquisition, you can view the current mass
spectrum in the control panel.

In addition, you may aggregate single mass spectra, thus, enhancing their
Signal to Noise Ratio (see How to ...: Actions in the QNT Editor
 Processing Mass Spectra).

To view recorded mass spectra in the Mass Spectra Plot press the

button on the Method toolbar.

Mass spectra are generally represented via their relative intensities. The base
peak, i.e., the mass peak with highest intensity, is used as reference point.
Thus, its relative intensity is always 100 %.

The base peak in the above example is the mass peak at 733.6 amu. The time
when the mass spectrum was recorded is indicated as well. The mass spectra
in the example were aggregated to the displayed total mass spectrum between
0.29 and 0.35 min.
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Mass Trace
Contrary to original TIC or SIM chromatograms that are recorded during
data acquisition, a mass trace is a MS chromatogram for a specific mass area.
Mass traces can be extracted from a Mass Spectrum and saved as a new
channel. This is possible online during data acquisition but can be done later as
well.

Also, see How to ...: Actions Related to the aQa-MS

 Extracting Mass Traces Online
 Extracting Mass Traces Afterwards
 Defining the Number of MS Channels.

Match Criterion
The match criterion defines the mathematical method of comparison for the
curve shape (= standardized (!) spectra).

Also, see ⇒Match Criterion

Match Factor
The match factor is an indicator of the similarity between two chromatograms. It
varies from 0 (=no match) to 1000 (=perfect match).

The match factor is calculated as soon as two spectra are compared with each
other in a spectra search (Library Search command or on the Spectra Library
Screening tab of the ⇒QNT Editor). This command is possible in windows or
partial methods capable of displaying a spectrum (see:  Spectra Library
and  PPA: Peak Purity Analysis). The displayed spectrum is used as the
basis. It is calculated by averaging all spectra recorded for one peak.

The result of the spectra search is the Hit List. It lists all spectra that have a
certain similarity with the original spectrum. The match value in the Match
column indicates how much they correspond.

 Note: Within the method PPA, the match can be indicated as a curve.
Please note that instead of determining the similarity of two
independent spectra, the spectra of the same peak (at different
wavelengths) are compared with each other here (see Peak
Purity Match Factor)!
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Matrix Blank Sample
The sample matrix can considerably influence the sample analysis. To consider
this, the matrix of the standard samples should be the same or at least similar.
In addition, matrix blank samples can be used to filter out the influence of the
sample matrix in the individual samples.

Select the sample type Matrix for the respective blank sample. Matrix blank
samples are marked by the symbol . The different peak areas (or peak
heights, if these were used for quantification) are determined for this sample as
well. The Dionex Chromatography Management System automatically
subtracts the peak areas (or peak heights) of the matrix blank sample from the
corresponding peak areas (peak heights) of all sequence samples. The
resulting areas (heights) are then used for all further calculations (e.g. for the
calibration).

 Note: Thus, matrix blank values are treated differently from "normal"
Blank Run Samples for which the chromatogram is subtracted

point by point from that of the current sample.

If more than one matrix blank sample was recorded in the sequence, the
respective peak areas (peak heights) are averaged and the resulting value is
subtracted from the corresponding peak areas (peak heights) of the other
samples.

 Tip: Matrix blank samples are subtracted only if they are evaluated in
the same QNT method. Otherwise, they will not be taken into
account.

Maximum Area Reject
The Maximum Area Reject parameter defines the maximum peak area up to
which a peak is rejected. Peaks with a peak area below the defined value are
not identified.

Also, see ⇒Maximum Area Reject

For detailed information on how to use the detection parameters, see How to
...: Actions in the QNT Editor  Defining Detection Parameters
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Maximum Height Reject
The Maximum Height Reject parameter defines the maximum peak height up
to which a peak is rejected. Peaks with a peak height below the defined value
are not identified. (Determination of the height is always relatively to the
baseline).

Also, see ⇒Maximum Height Reject

Maximum Peak Height (MaxHght)
Positive peak identification is via the ⇒Minimum Height parameter. All peaks
above this height value are identified.

Also, see ⇒Maximum Height Reject

Maximum Rider Ratio
If one or several peaks (h1 to h4) is above the Rider Threshold in a series of
non-resolved peaks, the Dionex Chromatography Management System
determines via the Maximum Rider Ratio detection parameter whether it is
classified as a peak or a Rider.

 Caution: The ⇒Peak Type peak table classification criterion has priority!
The criterion indicated here is valid for Peak Type = AUTO only!

Also, see ⇒Maximum Rider Ratio

Maximum Width
The Maximum Width detection parameter defines the maximum width above
which peaks are ignored during peak detection.

Also, see ⇒Maximum Width

For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.
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Message
The Message command allows the user to enter reminders for things to do or
to consider when executing a Program. The message is then displayed on
the screen. The user must confirm the message by clicking OK before the
program is continued.

Also, see ⇒Message

Minimum Area
The Minimum Area detection parameter is used as a minimum criterion
determining the area threshold, below which peaks are ignored during peak
detection or integration.

Also, see ⇒Minimum Area

For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Minimum Height
The Minimum Height detection parameter is used as a height threshold, below
which peaks are ignored. The peak height is measured relative to the baseline
(a).

Also, see ⇒Minimum Height

For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Minimum Width
The Minimum Width detection parameter is used as a minimum criterion,
defining the minimum width, below which peaks are ignored during peak
detection.

Also, see ⇒Minimum Width
For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.
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Mix (AS50 Sample Prep Command)
The Mix Sample Prep Command mixes the contents of a vial by repeatedly
drawing and expelling a volume of the vial contents. Vial is the vial to be mixed.
Volume is the amount of the vial contents to draw and expel, and Cycles is the
number of times to draw and expel the specified volume.

Modem Cable (1:1 RS Cable)
Modem cables are frequently used standard cables for connecting instruments
to a PC. The cable assignment is as follows (Also, see: Pin Assignment):

Instrument PC
9-pin

male connector
25-pin

male connector
25-pin

female connector
9-pin

female connector
2 3 ------------ 3 2
3 2 ------------ 2 3
5 7 ------------ 7 5

If there is an additional hardware handshake, the following assignments
are also required:

7 4 ------------ 4 7
8 5 ------------ 5 8

Modem cables are also called 1:1-RS cables.

Dionex part number 8914.014: (25-pin - 9-pin, 5m)

8914.0128: (25-pin - 25-pin, 5m)

 Tip: Do not confuse non-crossover modem cables (= 1:1 RS cables)
with crossover Null Modem Cables!

For information on additional or other connections, refer to the installation
instructions for the respective instrument for details (Also, see:  Installing
and Controlling Third-Party Instruments).

Moduleware
The instrument control firmware installed on all modules connected to the

DX-LAN. Moduleware sends status information and data to the Dionex
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Chromatography Management System and receives control parameters from
the Dionex Chromatography Management System.

"Monitor Only" Mode
If a user establishes a connection to the local server via a control panel, the
user can control the instruments connected to a Timebase via the controls on
the control panel (control mode).

If a second user accesses the same timebase, this user only receives the
monitor only status. In this case, the control panel displays all current values
and states, but changing any values, e.g. the flow rate, is not possible. This
prevents several users from simultaneously controlling the same timebase. If
one user accesses a timebase on the network, the monitor only status is
assigned.

Changing from Monitor Mode to Control Mode
Changing between the two modes is by activating or deactivating the function
Monitor Only in the Control menu. If the user A takes over the control of the
local timebase B, user B is automatically assigned the monitor only status.

Organizing Access Options
If the User Mode feature is activated, the privileges assigned to a user define,
whether this user has the monitor only status, control access or whether
changing between the two modes is possible.

If access control is disabled, each user has all privileges at all times. Objects
that are members of an Access Group will not be visible.

Independently of this, access can be generally limited directly on the server or
on the timebase. Only if monitoring and/or controlling a server or a timebase is
explicitly enabled in the Server Configuration program, individual users have
control and/or monitoring access (via the network). This does not apply to
users accessing their own local servers.

Move to Background
Use the Move to Background function to move a selected object to the
background.
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Move to Front
Use the function Move to Front to move a selected object to the foreground.

Multi-Tasking
Multitasking refers to simultaneous operations of several programs on a PC.
Unlike earlier Windows versions (3.1; 3.11), allocation of processing time under
Windows 98 and Windows NT/2000 is no longer between programs
(cooperative), but is monitored and controlled externally (preemptive). This
guarantees that each application (process) is automatically continued after a
specific time. A single process cannot claim the entire processing time at the
expense of other processes.

 Caution: The key combination Alt-Ctrl-Del interrupts Multitasking in
Windows 98. All running processes are stopped. The device
control of the Dionex Chromatography Management System is
interrupted. Do not use the key combination Alt-Ctrl-Del in
Windows 98 during a running batch or during data
acquisition. Otherwise, data overrun and communication
problems with the controlled instruments will result. This
does not apply to the operating system Windows NT.

Multi-Threading
Multi-threading allows simultaneous execution of two or more application parts
as separate processes.

If, for example, many control commands are communicated simultaneously to a
chromatography system, a certain amount of time is required for this. Before, it
was not possible to continue work during this time, regardless of whether the
operation took a split second or longer.
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Multi-threading allows simultaneous execution of this type of operation
(Threads). This is possible because each operation is internally separated into
many small steps that are executed with a time lag, without being noticed by
the user.

Thus, the user can perform other tasks, e.g. manually re-integrating a
chromatogram despite the comprehensive communication of control
commands.

Name
The user enters the Name for the substance in the peak table. The name is
available as peak result variable.

Needle
The NeedleUp command allows lifting the sample needle. Then the internal
sample valve is switched (see the example for a load/inject process in the

Autosampler section).

Also, see ⇒NeedleUp

Needle Height (AS50 Sample Prep Command)
The Needle Height Sample Prep Command positions the tip of the needle at
the specified height (in mm) above the bottom of the vial. A value of 0 is closest
to the bottom of the vial; a value of 46 is closest to the top. This height is used
for subsequent sample preparation steps (mixing, pipetting, and dispensing)
until another Needle Height command is given.

 Tip: The Needle Height value is not used for sample injections.
Instead, the Sample Needle Height command determines the
position of the needle at injection.

Network Failure Protection
Often it is useful to store important data on central data server PCs. In case the
network connection is interrupted or the central data server PC crashes, data
acquisition should continue, nevertheless. For this purpose, all data that are
relevant for the server of the Dionex Chromatography Management System are
stored locally on the server's hard disc. If the network connection is interrupted,
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the Server will continue to process these sequences, nevertheless.
Therefore, all data that may be relevant for the server must be mirrored locally
before the sequence is started.

An interruption of the network connection is logged in the Audit Trail
(  Protocol Data). The server continues to process the Batch using the last
conditions. All data are saved locally. The mirrored data are filed in the TEMP
directory of Windows the position of which can be influenced by the
environment variables TMP or TEMP. However, ensure that a local drive is
used. A network share or a RAM disc is unsuitable. Thus, they would ruin the
actual object and aim of such a protection.

In order to ensure that Windows and all other applications work properly after
the network recovery we recommend rebooting your PC. With the restart, the
locally saved data are automatically written back to the network datasource.
Again, this is logged in the audit trail.

In addition to the network-failure protection, a Power-Failure Protection is
available.

 Tip: The network-failure protection is available for Windows NT and
Windows 2000 only! It is disabled on Windows 98 because
these systems are unstable under network failure conditions.

If there is a network failure while ACCESS databases are
accessed, the datasource (mdb file) of the Dionex
Chromatography Management System could be damaged.
Therefore, we recommend using MS SQL or ORACLE servers
as central database to protect your data even in case of a
network failure.

Also, see How to ...: Actions in the Browser  Network Failure / Non-
Availability

Nice Size
Use the function Nice Size to optimize the size of one or more controls. The

Control Frame is adjusted so that the Control including the caption is just
visible.

(Signal) Noise
The Signal Noise parameter indicates the signal noise within a chromatogram
calculated by the Dionex Chromatography Management System. The value
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serves as the basis for the Signal to Noise Ratio determined from the raw
data at the start of the data acquisition.

Determining the Signal Noise (according to the default)
All datapoints recorded during the first 10 seconds of a chromatogram form the
basis for determining the noise value. The Dionex Chromatography
Management System calculates a regression line using the method of least
squares, then determines the maximum distance of two datapoints above and
below the line. (When calculating the regression line, all datapoints are
weighted with their corresponding step unless the step is equidistant.) Adding
both values supplies the first noise value.

The same procedure is used for the last 10 seconds of a chromatogram; it
supplies a further noise value.

The lower value is given under Noise and used as Sensitivity.

Signal Noise in User-defined Range (Input of Parameters)
You can also determine the signal noise for a specific range of the
chromatogram. Select a range without any peaks in the window Report
Properties Column (after double-clicking the column to edit or the window
Add Report Column via Add from the Table menu). Select the Signal Noise
variable of the Chromatogram Category. Open the Parameter Input for
"Signal Noise" via the Parameter button and enter the desired range under
Specific Range.

 Caution: To define the determination, identification, and detection limit
via the signal to noise ratio, the noise of the user-defined range
must always be used! If not, the determination, identification, and
detection limits might be miscalculated.

Normalization (Overview)
In the linear range, the height of a spectrum recorded at the time t is always
proportional to the current substance concentration in the flow cell. An objective
comparison of two spectra is therefore only possible if the concentration is
identical.

As this condition is rarely fulfilled, and as it is not possible to convert a
spectrum recorded at a specific concentration to another concentration, the
height of one spectrum must be scaled to the height of the other. This is called
normalization. The following factors must be considered:
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• The base area portion must be considered - especially in trace analysis
(see Baseline Correction).

• The noise portion depends on the wavelength and the solvent. Thus, at
200nm, not only the lamp energy of a deuterium lamp is considerably lower
than at 250nm, but also the absorption of common solvents is especially
high.

• Normalization should be performed where little influence on the above
factors is expected and where a relative absorption maximum of the
substances to be compared is observed.

Normalization can therefore be performed by the Absolute Maximum, by the
Relative Maximum or by a fixed Wavelength.

 Note: Chromatograms and peaks can also be compared. They are
referred to as normalized chromatograms, areas, or amounts.

Normalization (Absolute Maximum)
The absolute maximum of the spectrum is determined. The absorption
maximum is chosen as reference point and it receives the absolute height 1
(=100%).

Also, see Normalization (Overview)

Normalization (Relative Maximum)
The relative maximum of the spectrum is determined. This will be the greatest
λ-peak of the spectrum. After normalization, this peak has the height 0.5 (50%).
This prevents normalization with incomplete maxima on spectrum margins.

%
100

50

0
λλλ min rel. max max
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 Tip: Note that spectrum maxima can exceed the 100% line on the
margin of the spectrum, due to the definition!

Also, see Normalization (Overview)

Normalization (Fixed Wavelength)
Normalization with a fixed wavelength is analogous to normalization at a
relative maximum.

Instead of the relative maximum, the user can choose the wavelength of the
absorption value, which seems suited best for normalization.

 Tips: Note that spectrum maxima on the margin of the spectrum can
exceed 100%, due to the definition!

If you use the wavelength of the absolute maximum for the
normalization, it is possible that this wavelength is on the margin
of the spectrum. Often, this will be on a flank. On flanks,
wavelength fluctuations will have stronger effects, so that the
results there are somewhat less precise. This is especially true
for detectors that have an optical bandwidth higher than 5nm.

Also, see Normalization (Overview)

Null Modem Cable (RS232)
Null modem cables are frequently used (crossover) standard cables for
connecting instruments to the PC. The cable assignment is as follows: (Also,
see Pin Assignment):

Instrument PC
9-pin

female connector
25-pin

female connector
25-pin

female connector
9-pin

female connector
2 3 ------------ 2 3
3 2 ------------ 3 2
5 7 ------------ 7 5

If there is an additional hardware handshake, the following assignments
are also required:

4 7 ------------ 6 6
6 6 ------------ 7 4
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7 4 ------------ 5 8
8 5 ------------ 4 7

 Tip: Do not confuse crossover null modem cables with non-crossover
Modem Cables (1:1 RS cables)!

To order null modem cables from Dionex, use the following part numbers:

9-pin to 9-pin:
• Dionex part no. 8914.0129 for RS cable RU, 2.5m
• Dionex part no. 8914.0130 for RS cable RU, 5m
• Dionex part no. 8914.0131 for RS cable RU, 10m

25-pin - 9-pin:
• Dionex part no. 8914.0103A for RS cable RU, 2.5m
• Dionex part no. 8914.0120 for RS cable RU, 5m
• Dionex part no. 8914.0121 for RS cable RU, 10m

If necessary, use an adapter to connect the cable to a 25-pin socket. These
null modem cables have been slightly modified to ensure data transmission
even with enabled hardware handshake. However, the above hardware
handshake is not realized.

For information on additional or other connections, refer to the installation
instructions for the respective instrument for details (Also, see:  Installing
and Controlling Third-Party Instruments).

Number (No.)
The Number variable is the successive number assigned to a peak during
peak detection. The peak number can be output as peak result variable.

If the values in this column are not successive but contain gaps, the missing
peaks fell victim to one of the inhibition criteria, e.g. Relative Area Threshold
or Report Unidentified Peaks = OFF.

Number of Calibration Points
The Number of Calibration Points calibration variable gives the number of
values that are used for the calibration.
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The Number of Disabled Calibration Points can be displayed separately.

Number of Disabled Calibration Points
The Number of disabled calibration points calibration variable indicates the
number of values that were not considered in the calibration.

The Number of Calibration Points can be displayed separately.

ODBC (Open DataBase Connectivity)
ODBC is the name of a standard database interface that allows accessing
various databases (e.g. SQL server, dBASE or ORACLE) via an ODBC driver.

Offset
Signals or chromatograms with an assigned offset value (in %) are offset
vertically by this value in percent of the window size. Valid entries are from 0 to
50.
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Offset (c0)
The Offset (c0) calibration variable gives the offset value of the used

Calibration Function.

As a y intercept is available for the Linear with Offset (= LOff), Quadratic
with Offset (= QOff), and Exponential (= Exp) functions only, no output is
possible for the Linear (= Lin) and Quadratic (= Quad) functions.

Offset Level
The Offset Level command (also called zero position) offsets the detector’s
analog output signal as a percentage of the full-scale voltage. Offsetting the
output allows an attached recording device to plot the signal if it becomes
negative.

Offset Volume
The Eluent Generator Offset Volume option specifies the loop volume
between the pump outlet and the injection valve. Because the EG40 is located
between the pump and the injection valve, the eluent concentration gradient
produced by the EG40 reaches the column more quickly than the %-Gradient
produced by the pump. The Dionex Chromatography Management System
uses the offset volume to calculate a time delay in starting the EG40. The delay
synchronizes EG40 and gradient pump operation.

The default offset volume of 400 µL is used for most systems. The actual offset
volume may be different, however, depending on the system configuration. To
change the value, start the Server Configuration program and double-click
the pump entry in the list of devices for the Timebase. The pump’s
configuration properties open. Select the Eluent Generator tab.

The offset volume has no effect during isocratic operation and can be set to
0.00 µL.
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Online Help
The   Online Help of the Dionex Chromatography Management System
offers help information in any situation on the screen.

• Press the Help button on the toolbar  to view help information on a
specific item on the screen.

• Press the F1 key to see context-sensitive help information for a
specific situation. A description of the selected menu bar, (tab) dialog
box, or the activated control will appear.

• Select Index in the Help menu to view the table of contents of Online
Help. Select Using Help to see more details on working with Online Help.

Operational Qualification (OQ)
According to the definition formulated together with EUROACHEM Operational
Qualification is "the process of demonstrating that an instrument will function
according to its operational specification in the selected environment" [P.
Bedson and M. Sargent, Accred. Qual. Assur. (1996) 1, 265-274]

The purpose of OQ is to prove and document that your analytical system
functions according to its operating specification while your specific
environmental conditions are taken into account. Normally OQ is performed
following the installation of new devices or following a repair or system service.

The Qualification menu that is available in the Browser of the Dionex
Chromatography Management System offers the menu items Instruments OQ
OQ Setup (for details, see OQ Setup in the Online Help). Select Instruments
OQ to perform the operational qualification. Select OQ Setup to generate those
templates required for performing the operational qualification. Normally this is
only necessary after a new installation or when the configuration has been
modified.

The individual report pages of the Instrument OQ correspond to the pages
Performance Qualification for instruments. However, the limits valid for OQ

are stricter than those that are used for PQ.



A-98 Glossary

It is also possible to check the Operational Qualification of the Dionex
Chromatography Management System. Select  CHROMELEON OQ in the
Qualification menu.

 Tip: For further details regarding the Operational Qualification please
refer to the Operation Manual Operational Qualification /
Performance Qualification that can be ordered from your
Dionex Service.

Optical Resolution (Spectral Resolution)
The difference between two detectable wavelengths [in nm] that can only just
be separated is referred to as optical resolution of a photodiode array detector.
It is determined by two factors:
• Photodiode Resolution

• Quality of grating required for spectral dispersion (optical bandwidth)

The values for the optical resolution of conventional detectors are approx. 2 -
6nm (Dionex Detector UVD340S: 1.9nm (UV range), Dionex PDA-100
Detector: 1.0nm).

 Caution: The optical resolution is only one criterion for the quality of a
detector. The combination of optical resolution and signal to
noise ratio leads to a meaningful detector comparison. In this
connection, it is also important that the ratio between the
individual factors is balanced. This correlation becomes clear
when taking the example of benzene in the 230 - 265nm range.
A fine structure ("benzene finger") is only recognizable if the
number of photodiodes, the imaging optics, and the Signal to
Noise Ratio are in a sensible performance relation to each other.

Optimum Integration Path
A chromatogram recorded at a fixed wavelength usually does not have an
optimum Signal to Noise Ratio for all included peaks. The selected
wavelength represents a compromise that allows "seeing" all substances.

It would be ideal to detect Peak 1 at 230nm, peak 2 at 254nm, peak 3 at
320nm etc.
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This is enabled by performing Wavelength Switches (if the wavelength switch
points are known) or recording a 3D-Field using the Photodiode Array
Technology with subsequent determination of the optimum integration path.

Definition
The optimum integration path is characterized by
• An optimized signal to noise ratio,
• Minimum overlay of neighboring peaks, and/or
• Optimum linearity.

This means that the integration path must pass through the absorption
maximum of a peak, without being influenced by another peak. As the precision
of the recording is greater in relative maxima and minima than in steep spectra
flanks (this is especially true for large optical bandwidths of a detector),
selecting the largest relative absorption maximum is recommended, and not
the absolute maximum. In addition, the absolute maximum of UV spectra is
frequently located in the low UV range, i.e. near 200nm. In this range, the
sensitivity of the detector usually decreases, while interferences such as
solvent absorption or humidity increase.

When dealing with large substance quantities, as in preparative chemistry, total
absorption should be below 2 AU. For optimum precision, select a relative
spectra extremum for the recording.

If the complete chromatographic separation of two peaks is not possible, it
makes sense to record each channel at a point where the other peak has its
absorption minimum, or ideally, is inhibited entirely.

Implementation
The Dionex Chromatography Management System automatically calculates the
course of the optimum integration path and can display the path in the 3D-
Field. The transition between two wavelengths is exactly between the peak end
of one and the peak start of the other peak. For neighboring peaks, the peak
end, peak start, and switch time therefore coincide.

The result, i.e., the switch times at which the Wavelength signal parameter is
changed, can be included in a Program via the command: Extract:
Opt.Int.Path to clipboard.

For details, see How to ...: Actions in the Peak Purity Analysis (PPA)
window  Selecting the Optimum Integration Path.
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OQ
See Operational Qualification (OQ)

Origin
See How to ...: Actions in the QNT Editor  Selecting the Calibration
Function in the Creating a Peak Table section.

Original Size
See Full Size

Overlay
An Overlay is a chromatogram that is displayed in addition to the current
chromatogram, i.e., it overlays the current chromatogram. Overlays are often
used to compare chromatograms. For chromatogram comparison several
chromatograms can be overlaid at several positions in the Dionex
Chromatography Management System:

Control Panel
Overlaying chromatograms is possible already during data acquisition. During
data acquisition, the Chromatogram Overlay command that is available in the
context menu of an online signal plot of a Control Panel allows displaying a
chromatogram that was acquired earlier in addition to the currently recorded
channels.

QNT Editor and Report

The Add Overlay command of the File menu in the Report or in the ⇒QNT
Editor allows overlaying any chromatograms after data acquisition.

Printer Layout
In the printout, too, you can plot overlaid chromatograms using the Overlay tab
of the Chromatogram Decoration (to be accessible via the Chromatogram
Properties command in the context menu of a chromatogram) in the Printer
Layout. In each plot, the comparison chromatogram can be taken from an
already processed sample of the current sequence or any other sequence.

Also, see  Performing a Chromatogram Comparison
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Overview Window
When zooming, an overview window is displayed in the upper right corner of
the signal plot. The overview window shows the entire chromatogram and
indicates the currently enlarged section.

P-Groups
See Privilege

PAL Plug-In Board
A PAL is a PC plug-in board that is placed on another board such as the A/D
Converter or the pump control board or is inserted in the PC as a separate
board.

As the Dongle, the PAL plug-in board serves to store the serial number of a
station of the Dionex Chromatography Management System. Each station has
its own serial number.

Only if the serial number of the PAL plug-in board or the dongle and the Key
Code stored in the Dionex Chromatography Management System match, can
the Dionex Chromatography Management System be operated correctly.

If neither PAL, nor dongle nor license server is specified, the Dionex
Chromatography Management System can only be operated in the demo
mode.

For further details, see Installation  Software Protection and How
to ...: Actions in the Server Configuration  Selecting the Copy
Protection Location and Entering the Key Code.

Panel
See Control Panel

Partial Flows
See %B, %C, %D
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Partial-Loop Injections (AS50 Autosampler)
When performing a partial-loop injection, the AS50 autosampler draws from the
sample vial the volume to be injected, plus two times the Cut Volume.

 Tip: Partial-loop injections are possible only when the injection valve
is installed in the autosampler compartment or in a
chromatography or thermal compartment. If the injection valve is
installed externally (for example in a DX-120), only full-loop
injections can be performed.

Partial-Loop Injection Sequence

Partial-Loop, Limited-Sample Injections (AS50
Autosampler)
When performing a partial-loop, limited-sample injection, the AS50 autosampler
draws from the sample vial only the volume to be injected.

 Tip: Partial-loop, limited-sample injections are possible only when the
injection valve is installed in the autosampler compartment or in
a chromatography or thermal compartment. If the injection valve
is installed externally (for example in a DX-120), only full-loop
injections can be performed.

Partial-Loop, Limited-Sample Injection Sequence
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Password
Passwords protect the access to specific software or areas thereof. The Dionex
Chromatography Management System requires passwords in different
situations:

Opening the CmUser program always requires a password. The administrator
allocates a password upon creation of the user database.

With enabled User Mode, the client of the Dionex Chromatography
Management System can only be opened upon input of the correct password.
The administrator allocates each user an individual password in the CmUser
program. However, having entered the currently valid password, the user can
change this password later.

Signing sequences electronically (see: Electronic Signature) requires a
password as well. Each user has his/her own password that allows
transmitting, checking, and approving the signature according to his/her
privileges. This password, too, is allocated by the administrator in the CmUser
program and can be changed later by the user. Signing sequence electronically
is possible with enabled User Mode only.
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Peak Group Start / Peak Group End
The two detection parameters Peak Group Start and Peak Group End allow
identification of several successive peaks as one peak group. A peak group
that has been defined in such a way is treated as one single peak.

Also, see ⇒Peak Group Start/End

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Defining Detection Parameters.

Peak Name
The Peak Name peak table column in the ⇒QNT Editor is used to enter the
name of the substance detected at the time t. The peak name can be indicated
as separate peak variable in the report.

Also, see ⇒Name (Peak Name)

Peak Number (No.)
See Number (No.)

Peak Purity
See the following topics:

PPA (Peak Purity Analysis)

PPI (Peak Purity Index)

PPA Report

Peak Purity End Wavelength (PPWlEnd)
In combination with the Peak Purity Start Wavelength detection parameter,
Peak Purity End Wavelength limits the wavelength range for peak purity
calculations.

Also, see ⇒Peak Purity Start/End Wavelength.

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Defining Detection Parameters.
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Peak Purity Match Factor
The Match Factor expresses the similarity of two curves. A peak purity match
factor can be expressed for both, UV spectra and mass spectra.

With UV spectra, the match factor (= UV match factor) refers to the correlation
between the spectrum in the peak maximum and the spectra in the ascending
and descending flanks. Ideally, none of the spectra between peak start and
peak end deviates from the spectrum in the peak maximum. They correspond
to 100%, i.e., the match value is 1000. For Mass Spectra, the distance
between the single masses and the relative height of the different mass peaks
are taken into account. Similar to UV spectra, a match factor of 1000 indicates
a perfect match. However, the MS match factor is far more selective than the
UV match factor.

 Caution: The calculation of the match factor is more inaccurate on the
peak margins due to the poorer Signal to Noise Ratio. Using
the ⇒Peak Purity Threshold detection parameter, the selection
of the UV and mass spectra can be limited to a sensible peak
height in the ⇒QNT Editor.

If the match factor of a peak is included in a report column, the value will be
averaged from all determined match values of the peak. The UV match factor is
always baseline-corrected (see Baseline Correction), as this portion usually
cannot be neglected; it would falsify the result.

With mass spectra, you may define in the QNT editor whether to subtract
background mass spectra and which ones. This also defines whether the
match factor shall be output baseline-corrected.

For details, see How to …: Actions in the Chromatogram  Subtracting
MS Background Spectra.

The deviation of the averaged single match values can be included in the
PPA Report as the Peak Purity: Relative Standard Deviation of the Match

Factor (RSD Match).
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Peak Purity: Relative Standard Deviation of the
Match Factor (RSD Match)
The relative standard deviation of the Peak Purity Match Factor indicates its
homogeneity over the entire course of the peak.

Calculation is analogous to the Relative Standard Deviation of the PPI (RSD
PPI). Instead of the PPI values, the corresponding match values are used. The
relative standard deviation of the match factor (RSD Match) in percent results
when the standard deviation is divided by the average of all match values
(Match Ø), and the result is multiplied by 100%.

%100*)(
∅

=
Match
SDMatchRSD

Peak Purity Start Wavelength (PPWlStart)
In combination with Peak Purity End Wavelength, the Peak Purity Start
Wavelength detection parameter limits the wavelength range for the peak
purity calculations.

Also, see ⇒Peak Purity Start/End Wavelength.

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Defining Detection Parameters.

Peak Purity Threshold (PPTrshold)
The Peak Purity Threshold detection parameter determines the threshold for
the signal height above which spectra comparison is performed. The parameter
is important for the Peak Purity Analysis (PPA) and the Peak Ratio.

Peak Purity Analysis (PPA)
In the PPA, the parameter defines the signal height above the baseline, from
which the UV or Mass Spectra are extracted for calculating the PPI (Peak
Purity Index) or the Peak Purity Match Factor.
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Peak Ratio
For the Peak Ratio, the PPTrshold parameter defines the signal height above
which the ratio of two UV or MS channels shall be calculated.

Also, see ⇒Peak Purity Threshold

For information on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Defining Detection Parameters.

Peak Shoulder Threshold
The Peak Shoulder Threshold parameter defines a threshold value for peak
shoulder recognition.

Also, see ⇒Peak Shoulder Threshold

For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Defining Detection Parameters.

Peak Slice
The Peak Slice detection parameter determines from which width (= time
span) several successive data points are interpreted as peak or as noise.

 Note: This parameter should always be considered in combination with
the ⇒Sensitivity!

Also, see ⇒Peak Slice

For detailed information on how to use the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Peak Start Time
This peak result variable refers to the peak start in minutes. The peak start is
determined via the left peak delimiter.

Peak Stop Time
This peak result variable refers to the peak end in minutes. The peak end is
determined via the right peak delimiter.
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Peak Summary
A Peak Summary lists peak and sample variables of any required samples in a
table. Generally, it includes samples of one sequence. A Summary can also be
created based on a Query.

For details, see

 Peak Summary Report

Peak Table
The peak table is part of the ⇒QNT Editor. The QNT editor allows defining
parameters for the identification and calibration of peaks.

For details, see

 QNT Editor / Peak Table

Peak Type
See Type

Peak Width
See Width

Performance Qualification (PQ)
As defined in cooperation with EURACHEM, Performance Qualification is "the
process of demonstrating that an instrument consistently performs according to
a specification appropriate for its routine use" [P. Bedson and M. Sargent,
Accred. Qual. Assur. (1996) 1, 265-274].

The task of PQ is both to ensure and to document that your system functions
as required by your special (routine) operation. The frequency and the scope of
the Performance Qualification depend on the special requirements in your
laboratory. This can be specified in internal instructions or in a SOP. The
parameters should be similar to the normal routine operation. In addition to the
Performance Qualification the Operational Qualification as well as the

Installation Qualification is an important factor for validating instruments and
software.
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The Qualification menu in the Browser of the Dionex Chromatography
Management System offers the menu items Instruments PQ and PQ Setup
(for details, see the PQ Setup in the Online Help). Select Instruments PQ to
perform the performance qualification. Select PQ Setup to generate those
templates required for performing the performance qualification. Normally this
is only necessary after a new installation or when the configuration was
modified.

The Dionex Chromatography Management System CD supplies a datasource
with a master template in the directory PQ\Templates\PQ. This template is
designed for the Performance Qualification in a standard HPLC configuration.
In addition to various sequences, the template contains a PQ report template
with the following sheets:

SPECIFICATION: The sheet SPECIFICATION allows you to enter the system
specifications (instruments, fluidics, and limits).

INJ_REPRO_AND_RET_REPRO and ASI_REPRO_AND_RET_REPRO,
respectively: The sheet INJ_REPRO_AND_RET_REPRO allows checking the
reproducibility of the injector and the retention time. If the result is within the
specified limits, the Result column indicates OK.

INJ_CARRY_OVER: The sheet INJ_CARRY_OVER supplies a measure for
the carry over in your system. If the result is within the specified limits, the
Result column indicates OK.

INJ_LINEARITY: The sheet INJ_LINEARITY supplies a measure for the
linearity of injection volume and peak area.

PUMP_GRADIENT: The sheet PUMP_GRADIENT serves to check gradient
precision. The limits of the Specification sheet are included. If the values are
within the specified limits, the last column (Result) indicates OK. The Result
column of all tests’ then indicates Test passed.

PUMP_3_GRADIENT: The sheet PUMP_3_GRADIENT serves for checking
the gradient reproducibility (with 3 repetitions in this example). The limits of the
Specification sheet are included. If the values are within the specified limits,
the last column (Result) indicates OK. The Result of all tests column then
indicates Test passed.

DET_NOISE_AND_DRIFT: The sheet DET_NOISE_AND_DRIFT serves to
check whether noise and drift in your system correspond to the limits on the
SPECIFICATION sheet. If the values are within the specified limits, OK is
indicated under Results.

DET_WAVELENGTH: The sheet DET_WAVELENGTH supplies a measure for
the wavelength precision of the corresponding detector.
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DET_LINEARITY: The sheet DET_LINEARITY serves for checking the
detector linearity. From five different injections at different concentrations, the
correlation coefficient (supplied in %) between the peak height and the
concentration is determined. If the value is above the specified limit, Test
passed is returned as the result.

RF_DET_NOISE and RF_DET_WAVE: These sheets evaluate the noise
and the wavelength precision of the fluorescence detector.

Audit Trail: The sheet Audit Trail shows the protocol data (Audit Trail) for the
analyzed sample.

  Caution: Do not edit report sheets, even if editing is possible! The
Dionex Chromatography Management System automatically
reads the corresponding values. Within the report, individual
data sheets are very often accessed via references. If you insert
or delete lines and columns, these references will be lost. Thus,
the calculations will be wrong!

The report must be printed as Batch Report from the browser to
ensure that, in the report, the data are read in and processed
correctly. Select the sequence for which the report shall be
printed. Make sure that no sample is selected. Select Batch
Report in the File menu and start printing by clicking Ok.

 Tip: Enter the actual concentrations of the used standards in the
amount columns of the QNT file for evaluating the detector
linearity.

For further details on the Performance Qualification, see the Operating Manual
Operational Qualification / Performance Qualification Operating Manual
available from Dionex service.

PGM File
The PGM file (also called control file) can include up to three parts that
correspond to the different views of the PGM editor:
• The actual Program (Commands view in the PGM editor)

• The instruments method for the Mass Spectrometer (Finnigan AQA view
in the PGM editor - only with PGM files for a timebase including MS)

• Extractions and data smoothing steps that are performed after the data
acquisition (Post-acquisition steps view in the PGM editor)
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The  Program Wizard allows easy creation of the PGM file (especially of the
program). All user inputs are automatically converted into uniform command
syntax so that it is readable by the data system. This allows even new users to
quickly create functioning programs.

Having terminated the Program Wizard, the user needs to enter the mass
spectrometer method and the Post acquisition steps on the corresponding
pages of the PGM editor.

Photodiode Array Detector
A photodiode array detector is a special multi-channel UV Detector. For
further information, see

Photodiode Array Detectors (Main Features)

Photodiode Array Detectors (Functionality)

Highest optical resolution and at the same time high sensitivity are decisive
factors for the quality of a photodiode array detector. For further information,
please refer to Optical Resolution (Spectral Resolution).

 Main Features
Photodiode Array Detectors (PDAs) feature high sensitivity and a large

linearity range, they are relatively independent from temperature fluctuations,
and can be used for gradient elution (%-gradient). The simultaneous detection
of all wavelengths at the time t is made possible by:
• Peak Purity Analysis

• Peak identification via Spectra Library

• Determination of optimum integration path for later wavelength alterations

• Normalization of spectra

• Quantification of non-resolved peaks

The measuring range of the PDA-100 detector is from 190 to 800nm. The
measuring range of the UVD 340S detector is from 200 to 355nm in the UV
range, and from 357 to 600nm in the visible range.
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 Functionality
Unlike conventional (1 or 2-channel) UV Detectors, multi-channel detectors
(PDAs) send the entire spectrum of the light source (a), in focused form (b),
through the flow cell (c). Thus, absorption not only causes the intensity of a
single wavelength to change, but that of all wavelength portions of the entire
spectrum. After that, the white light is dispersed spectrally using a grating (d).
The resulting spectrum is measured by adjoining photodiodes (e) almost
synchronously.

a

b

c

d

e

Dionex detectors store this information analog to a UV channel via the signal
3D-Field. Apart from the quality of the optics and the grating, the number and

size of the photodiodes determine the Optical Resolution of the detector.

 Caution: The optical resolution cannot be considered by itself, but must
be seen in connection with the achieved signal to noise ratio!

Photodiode (Pixel) Resolution
The bandwidth of wavelengths on an individual photodiode is referred to as
photodiode or pixel resolution.

If 150 photodiodes are available in the UV range (200 - 350nm), the photodiode
resolution is 150nm / 150 photodiodes = 1nm per photodiode.

Photodiode resolution and the optics (mirror, slit, grating, optical bandwidth)
determine the Optical Resolution of the UV detector.
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Pin Assignment
Usually 9-pin or 25-pin Modem Cables or Null Modem Cables are used for
instrument connections. The pin assignments are as follows (only the most
important pins are mentioned):

25-pin 9-pin Abb. Description
2 3 TxD Transmitted data
3 2 RxD Received data
4 7 RTS Request to send
5 8 CTS Clear to send
6 6 DSR Data set ready
7 5 GND Signal ground/common return
8 1 DCD Received line signal detector
20 4 DTR Data terminal ready

The pin numbering (order for plug) is as follows:

Should other connectors be required, see the installation instruction for the
respective instrument for details (also, see  Installing and Controlling
Third-Party Instruments).
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Pipet (AS50 Sample Prep Command)
The Pipet Sample Prep Command moves a volume of sample from one vial
to another. Source is the vial from which to pick up the sample volume,
Volume is the amount of sample to be pipetted, and Destination is the vial in
which to add the sample volume.

Polarity (Analog Output)
The Polarity command switches the polarity (+/-) of the analog output signal
on Dionex detectors. For example, if components are appearing as negative
peaks instead of positive, use this command to switch the analog output
polarity from + to -.

Power-Failure Protection
The Dionex Chromatography Management System recognizes during the load
sequence of the data system whether online Batch Processing was
interrupted by a power failure.

This is possible, because the date and the time are entered in the sequence
editor whenever processing of a new sample is started. The Dionex
Chromatography Management System checks whether all "started" samples
(labeled with date and time) were completed, e.g. whether they reached the
status F (finished). If this is not the case, the Power-Failure Handling allows
you to define (via the Error Handling command of the Batch menu) how to
continue processing:
• Continue with the interrupted sample

• Continue with the next sample

• Reprocess the entire online batch

• Abort the batch

• Prompt the user what to do

In addition, you can define a PGM File which shall be started after booting
the server (see How to ...: Actions in the PGM Editor  Creating a Power-
Failure Program).

In addition to this power-failure protection, a Network Failure Protection is
available in your Dionex Chromatography Management System.
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PPA (Peak Purity Analysis)
Peak purity analysis (PPA) is a partial method of the offline module. It consists
of a graphical section and the PPA Report.

For details, see  PPA: Peak Purity Analysis (Overview).

PPA Report
The PPA report represents the numerical addition to the partial method Peak
Purity Analysis. In a table, this report combines variables characteristic for the
peak purity analysis and variables freely selectable by the user.

Especially meaningful variables are:
• PPI (Peak Purity Index),
• Relative Standard Deviation (RSD PPI),
• Peak Purity Match Factor, and
• Relative Standard Deviation of the Match Factor (RSD Match).

PPI (Peak Purity Index)
The peak purity index (PPI) represents the central wavelength of a spectrum. In
simplified terms, this is the wavelength where the areas of the spectrum to the
left and right are identical. The PPI is thus independent of the concentration.

A pure single peak should supply the same PPI value from peak start to peak
end for each spectrum recorded in this range. The following conditions must be
fulfilled:
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• The baseline portion must be insignificant. If this is not the case, a Blank
Run Subtraction must be performed.

• During analysis, the solvent composition and thus the UV absorption of the
solvent may not change significantly (special attention is required for
gradient applications).

• Compared to the signal height, the drift must be very small.

• The Lambert-Beer Law must be valid for the entire range.

In the ideal case of a pure peak, entering individual PPI values results in a
rectangle curve. The height of each single rectangle corresponds to the value
of the central wavelength. The deviation from the rectangle shape can be
expressed mathematically by the relative standard deviation of the PPI value.

PPI A

t

350

238
252

200 0

1000
[nm] [mAU]

PPI 1
PPI 2

Chromatogram

Significant deviations from the rectangle shape indicate peak impurity.
However, it is not necessarily correct to deduce from the rectangular shape that
the peak is pure.

 Tip: The calculation of the PPI value becomes inaccurate near peak
limits due to the poorer Signal to Noise Ratio. Using the
⇒Peak Purity Threshold detection parameter, the selection of
spectra can be limited to a sensible peak height in the ⇒QNT
Editor.

If the Peak Purity Index (PPI) is entered in a report column, this value is
averaged from all determined PPI values of a peak.

The deviation of single PPI values from each other can be expressed as the
Relative Standard Deviation (RSD PPI) in the PPA Report.
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PPI: Relative Standard Deviation of the PPI (RSD
PPI)
The relative standard deviation of the PPI expresses the degree of deviation of
the computed individual PPI values from each other.

To determine this value, all PPI values of a peak are averaged (PPIØ) and are
then squared (Q-Sum).

Q Sum PPI PPI
i

n

− = − ∅
=
∑( )2
1

The standard deviation (SD) is defined as the root that is extracted from the Q-
sum divided by (n-1), with n being the number of data points.

SD
Q Sum
n

=
−

−( )1

The relative standard deviation of the PPI (RSD (PPI)) in percent is obtained by
dividing the standard deviation by the average of all PPI values (PPIØ), and by
multiplying the result by 100%.

RSD PPI
SD
PPI

( ) *=
∅

100%

PQ
See Performance Qualification (PQ)

Pressure Limits
Depending on solvent composition and the selected ⇒Flow, pressures of up to
450bar occur on the high-pressure side of a chromatography system. The
Dionex Chromatography Management System is capable of monitoring the
pressure value provided by the pump. The user can define upper and lower
pressure limits. When one of the limits is exceeded, the Dionex
Chromatography Management System stops the flow, displays an error
message, and stops the sample batch, as necessary.

Also, see ⇒Pressure Limits
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Printer Layout
The Printer Layout allows preparing your data for the printout. If the Layout
Mode is enabled, different elements can be added to the Printer Layout:
• Sheets (worksheets that can also include the following elements)
• Report Table
• Row(s)
• Column(s)
• Variable (individual variables)
• Chromatogram
• Calibration Plot (calibration curve)
• Spectra Plot (UV spectrum)
• Mass Spectra Plot ( Mass Spectrum)
• 3DFIELD Plot ( 3D-Field)
• Chart (graphical display of the values of the individual cells/columns)

The Printer Layout is saved in the ⇒Report Definition File (RDF) together with
the (screen) report. You can open the Printer Layout of the selected report
definition file with the current sample data via the following button from the
Method toolbar:

For information on how to design a report template, see How to...:  Actions
in the Printer Layout.
For information on how to print your results, see How to: Actions in the
Printer Layout  Printing with a Report Template.

Privilege
Most actions in the Dionex Chromatography Management System can be
executed by the user only if he/she has the corresponding rights (privileges).
The Dionex Chromatography Management System offers almost 100 different
user privileges (e.g. Read Sequence, Copy Sample, Delete Sequence, etc.).
Instead of assigning individual privileges to each user, the privileges are
combined in P-groups (Privilege Groups). Thus, the P-Group membership
defines the privileges of the respective user.
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Each P-group defines a specific range of operations. These are divided in the
areas CM Server Control, Datasource, Sequence, Data Reduction,
Reporting, and Miscellaneous. The scope of functions available for one P-
group increases with the number of privileges activated in the individual areas.
(For further information on the user privileges, see the CmUser Online Help if
this program is installed on your PC: CmUser_E.HLP)

Members of a specific P-group can use all privileges assigned to this group.
Each user can be a member of one or several P-group(s). The names of the
current members are listed in each P-group.

Creating a larger number of different P-groups allows defining access control in
the Dionex Chromatography Management System more precisely. The
privileges available for an individual user are defined by the combined
privileges of all P-groups in which the user is a member.

Privileges (e.g. Delete Sequence) are assigned globally, i.e. a specific privilege
is granted for all datasources the user can access. To restrict this access,

Access Groups (Access Groups) can be defined in addition to P-groups.

A-groups and P-groups are created by the administrator in the CmUser
program (CmUser.EXE).

Program
The control program (in short: program) is part of the PGM File and is
displayed in the Commands view of the PGM editor. It can be considered a
"schedule" for the execution of different ⇒Control Commands. In this file, the
user notes all commands to be executed before, during, and after analyzing a
sample. This enables complete automation of the analysis including routine
procedures before and after the analysis, e.g. conditioning a column or rinsing
with various solvents.

Monitoring parameters or limits as well as triggering reactions to be performed
at specific values, is also possible via the program.

A Wizard, the  Program Wizard facilitates creating the basic structure of a
program. The user input is converted automatically into a uniform syntax that is
readable by the data system. This allows even new users to quickly create
functioning programs.
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For further details, see Control  Control Program and  Program
Syntax.

Also, see ⇒Program

 Note: The command syntax is different from the syntax of the
GynkoSoft data system. When importing GynkoSoft PGM files,
their syntax is automatically converted into the syntax of the
Dionex Chromatography Management System.

Protocol Command
The Protocol command enables you to log specific events in the Audit Trail
while executing a PGM File.

Unlike simple comments that are only part of the Program, the Protocol text
is included in the Audit Trail and is thus directly linked with the corresponding
sample. The Protocol text can thus be used for commenting individual
samples. Event-controlled execution of the command is also possible.

Also, see ⇒Protocol

Pulse Mode
In addition to the DC Mode, most electrochemical detectors can be operated
in the Pulse Mode. This method is also called PAD (pulsed amperometric
detection) and is characterized by a series of potential changes. This method
allows a continuous regeneration of the electrode surface (platinum or gold
electrode).

A distinction is made between three different potentials (E1, E2, E3) and the
period (T1, T2, T3) for which a potential is connected to the electrode. T1 + T2
+ T3 form a cycle that is constantly repeated.

E1

E3

T2

T2 = Cleaning

T1` = Stabilisation (Delay) time

= Measurement time

T1

T1´ Ts

T1 = T1´ + Ts

Ts

T3

T3 = Conditioning

7000

0

t[msec]

E[mV]

E2
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Data is recorded only during the second half of T1. The duration of Ts is either
set directly or is determined by defining a delay T1´ (stabilizing phase).

The material of the working electrode largely determines the period and the
height of the various potentials.

Quantification Method (QNT Method)
A quantification method includes all parameters that are used for the evaluation
of a peak or the entire chromatogram. The QNT method serves as the basis of
calculation for evaluating a sample and contains:

• All data for the assignment according to the order of elution within defined
limits (time windows) (identification) and

• The parameters (calibration constants) that are part of the
area/concentration (amount) conversion formulas as well as the calibration
points required for the calculation.

Also, see: ⇒QNT Editor.

The Method column of the sample list (in the  Browser) contains the name
of a  Quantification Method (also known as QNT Method).

Also, see ⇒Quantification Method

Query
The Dionex Chromatography Management System offers the possibility to
efficiently search e.g., directories, sequences, samples, or comment lines for
specific names or character strings:

• In the Browser choose the Query command in the context menu or select
New / Query (using Wizard) in the File menu. A wizard opens which
facilitates entering the desired conditions.

• On the first page, define whether to perform the query in the currently open
Datasource or in a different one. In addition, define whether to find

certain sequence properties and/or sample properties, and/or other result
properties.

• Having pressed Finish, you can enter additional conditions to limit the
query.
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From the entered information, the Dionex Chromatography Management
System generates an SQL statement that can start a query within all

ODBC-capable databases.

For details on performing a query, see How to ...: Actions in the Browser
 Performing a Query.

The result of a query can be saved as a new sequence via the Save as
command. QNT files and PGM Files are copied; raw data is copied optionally.
File names occurring more than once receive a consecutive number. The
following symbol indicates the query sequence: 

QNT Method
See Quantification Method (QNT Method)

Rack
Many Autosamplers offer a choice of racks to meet individual capacity and
vial number requirements. For optimum operation, the currently used rack must
be specified in the Server Configuration. This is performed when the
corresponding device driver is installed.

The rack of the Dionex Autosampler ASI-100 consists of three different colored
segments. The following segment types are available:

Rack types Description

Analytical: Choose this option if you are using the default segment. The
analytical segment can house up to 39 vials at 1.1 or 1.8 ml + 1 vial at
4 ml.

Semiprep: Choose this option if you are using the semipreparative segment. The
semiprep segment can house up to 21 vials at 4 ml each.

Mini: Choose this option if you wish to analyze a large number of samples
or if small sample volumes are available only. The mini segment can
house up to 64 vials at 1.2 ml + 1 vial at 4 ml.

Eppendorf: Choose this option, if you are using the rack for Eppendorf reaction
vials. The Eppendorf segment can house up to 22 reaction vials at 1.5
or 2 ml + 1 vial at 4 ml.
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If you are using a coolable rack (Dionex ASI-100T), you can determine the
controllable temperature range. The range can be from +4°C to +45°C (39.2°F
to 113°F), i.e. an exact set temperature can be observed only within this
temperature range. The ASI-100T autosampler allows cooling the rack by 18K
from ambient as well as heating the samples by up to 35K from ambient.

Range
For controllable detectors, the Range parameter determines the factor by
which the analog output signal is amplified or reduced.

 Note: The Dionex A/D Converter offers the measuring range -10V to
+10V, thus it covers virtually all detector output signals. It is
therefore possible to record the signal directly and to adjust the
size via the Factor parameter of the A/D converter.

For the fluorescence detector RF1002 the term Range has a
different meaning. Instead, the Gain parameter is used.

Raw Data
Raw data refers to all analog and digital data points that are stored digitally on
a PC. Raw data therefore only exists for signals or channels that were selected
by the user before data acquisition.

The scope and precision of the stored raw data depends on the selected
Sampling Rate or ⇒Step.

For details, see Data  Raw Data Storage and  Raw Data Compression.

Ready (Signal)
After each autosampler operation (e.g., Draw for the ASI-100/ASI-100T
samplers or Suck for the GINA 60/GINA 160 samplers), a ready signal
command (Sampler.Ready for the ASI-100 sampler or Sucked for the
GINA 50/GINA 160 samplers) is sent to the data system as confirmation. Other
commands (e.g., Dispense) can only be executed after receipt of this signal.

The time interval between the sampler operation and the response
Sampler.Ready (or Sucked) is the minimum value for the Duration command.
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To execute two commands successively, ⇒Wait is entered after the first
command in the Program. The next command will then be executed
immediately after the arrival of the Sampler.Ready (or Sucked) signals.

Ready Check
The Ready Check command verifies whether performing the automatic batch
is actually possible. The Ready Check allows you to check whether the
instruments in the HPLC system are ready to operate (instruments are
switched on, connected, lamp is switched on, etc.). In addition, this check
verifies that all required files exist and that the storage capacity is sufficient.

As the batch list can be extended by further sequences during operation, the
Ready Check command can also be performed during operation.

Reconnect
Use the Reconnect command to check the connection between the user PC
and the timebase or the instrument and the data system. If there is no
connection, the ⇒Connect command will be issued automatically.

Recorder Calibration
The Recorder Calibration commands allows calibration of the recorder’s
response to three detector analog output settings:

AU Sets the analog output to AU, scaled from 0 to 1 V, based on the AU full-scale
response selected by the Recorder Range command.

Zero Sets the analog output to 0 volts.
Full Scale Sets the analog output to the full-scale setting (1V).
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Recorder Range
The Recorder Range command sets the range of a full-scale recorder
response in the signal units appropriate for the detector. For example, for
conductivity detectors, the Recorder Range is given in microSiemens (µS).
This command can be used to adjust the recorder output to accommodate
larger or smaller peak heights.

Reference Bandwidth
The reference bandwidth can be selected separately for each channel. The 3D-
field of a photodiode array detector also has its own reference bandwidth.

Analogous to the conventional ⇒Bandwidth of a channel, the reference
bandwidth serves to average several photodiode signals of the ⇒Reference
Wavelength.

Also, see ⇒Reference Bandwidth

Reference Channel

= Reference Channel for Baseline Correction
Performing an automatic Baseline Correction requires a reference channel.

As a channel, either a physical channel can be used or a channel that was
extracted from the 3D field and stored afterwards. The wavelength of the
channel is variable, i.e., a channel recorded via Wavelength Switching is also
valid.

Which channel is actually used as reference channel in the PPA method
depends on how the PPA window is opened.

If the PPA window is opened in the Browser by selecting the Open ... 3DFIELD
command, the channel specified in the File menu under Preferences is used
as reference channel.

If the PPA window is accessed from a different method, the currently displayed
channel is used as reference channel.

The current reference channel can be included in the PPA chromatogram
window via Draw Reference Channel (Decoration dialog box). The channel
serves as a basis for the integration and peak detection.
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 Tip: Do not confuse the reference channel with the ⇒Reference
Wavelength of the signals from a photodiode array detector.

Reference Peak
Reference peaks are references for calculating relative retention times for
different substance peaks. The relative retention time can be indicated as
absolute time difference (in minutes) or as percent quotient (retention time
substance peak/retention time reference peak). In addition, the reference
peaks can be used for calculating the Relative Peak Area and the Relative
Peak Height.

You can specify the reference peaks in the QNT file on the Peak Table tab.
Double click the Ret. Time column to open the Retention Time for ... dialog
box (see Retention Time Interpretation) or the corresponding peaks. Choose
one of the options Time distance to reference peak or Time ratio to
reference peak to select a reference peak for each substance peak via the
selector arrow.

The retention time is re-calculated automatically when a different reference
peak is selected. Only peaks with absolute retention times can be selected as
reference peaks. It is not possible to delete reference peaks from the peak
table.

Besides, the retention time can be entered directly in the entry field in the
following format:

[<Reference Peak>] <Ret. Time> [<Unit>]

You are free to choose the order in which the fields are used. If no name is
entered for the reference peak, the time is interpreted as absolute time,
otherwise as relative time.

Either min or % can be selected as unit. If no entry is made, min is used. The
unit determines whether the time given is the difference (min) or the ratio (%)
to the time of the reference peak. For absolute times only min is permitted.

 Note: Even if the retention time is then specified in Absolute times,
the Dionex Chromatography Management System saves the
selected reference peaks.
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Reference Wavelength
For Dionex photodiode array detectors, the reference wavelength is used to
correct absorption values of the wavelength(s) selected for analysis. If the
absorption of the reference wavelength changes during the analysis,
absorption values of the analysis wavelengths are adjusted up or down
accordingly. The selected reference wavelength should be in a quiet area of
the spectrum where little absorption occurs. Each change in the absorption
then indicates substantially changed conditions, for example, a reduction of the
lamp energy (lamp drift). Each change can be used to correct the absorption in
the remaining wavelength range even during the analysis (the recorded signal
is reduced or amplified accordingly, as necessary).

Reference wavelengths are especially useful for gradient analyses, because as
the light intensity changes over time (due to the gradient), absorption values
are adjusted, thus minimizing baseline drift.

The reference wavelength is freely selectable, not only for each channel of the
detector, but also for a 3D-field. Because the absorption of the reference
wavelength is stored, it is possible to undo a correction later. The reference
wavelength can be changed later by extracting the absorption values of the
"new" reference wavelength from the 3D-field and using them for correction.

Also, see ⇒Reference Wavelength

Relative Amount
This peak result variable refers to the amount portion of a peak relative to
others. The peaks used as a reference are determined via the following
options:

Option Description
All Peaks: Amount portion relative to the sum of all amount

portions of all peaks (default setting).
All Peaks of the same Group Amount portion relative to the sum of all amount

portions in one group.
The corresponding ISTD Peak Amount portion relative to the amount of the peak of

the Internal Standard.
The corresponding Reference Peak Amount portion relative to the amount of a

Reference Peak.
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 Note: The values of the options 2 to 4 can considerably exceed 100
%.

Select the respective column in the report, choose the Column Properties
command from the context menu, and select the variable in the selection box.
Press the Parameter button to determine the peak to be used as reference.

Relative Area
The Relative Area peak variable is the portion of the peak area in the sum of
all peak areas (total area).

Which peak areas form the total area, is determined by selecting one of the
following options (The values of all relative peak areas always result in 100%
for the options 1 to 3).

Option Description
All detected Peaks The areas of all detected peaks are used for the

calculation (default setting).
All identified Peaks Only the areas of identified peaks are used for the

calculation.
All Peaks of the same Group Only the peaks of one group are used for the

calculation.
The corresponding ISTD Peak The area of a peak is put in relation to the area of the

Internal Standard peak
The corresponding Reference Peak The area of a peak is put in relation to a Reference

Peak.

Select a column in the report, choose the Column Properties command from
the context menu, and select the variable in the selection box. Press the
Parameter button to choose another option.

Relative Height
This peak variable refers to the peak height relative to the average height of a
certain peak group or a specific peak. As with the Height variable, the
maximum (i.e. at the retention time) is measured, relative to the baseline. The
dimension does not depend on the detector type.

The selection of the peak heights is possible via the following options:

Option Description
All detected peaks The relative peak height is indicated in relation to the
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average height of all detected peaks (default setting).
All identified peaks The relative peak height is indicated in relation to the

average height of all identified peaks.
All Peaks of the same group The relative peak height is indicated in relation to the

average height of all peaks in one group.
The corresponding ISTD peak The relative peak height is indicated in relation to the

height of the Internal Standard Peak.
The corresponding reference peak The relative peak height is indicated in relation to the

height of a selected Reference Peak.

Select the column in the report, choose Column Properties from the context
menu, and select the variable in the selection box. Press the Parameter button
to choose another option.

Relative Retention Time (Rel. Ret. Time)
The Relative Retention Time peak variable of the Peak Results category is
the quotient of the peak retention time ⇒Retention Time (T ret.) and the
retention time of the corresponding reference peak (T ret. Ref.) in percent.

Relative retention time =  100 x T ret.(Peak) / T ret.Ref.

The reference peak is specified in the peak table (see Online Help: Retention
Time Interpretation).

The Parameter button offers the following options:

Reference Peak: The relative retention time refers to the reference peak (default)
Fixed Peak: The relative retention time refers to a user-defined peak. If so, enter

the name of the reference peak as second parameter that can be
selected from the list of identified peaks with the selector arrow.

Relative Standard Deviation
The Relative Standard Deviation is the standard deviation in relation to the
size of the measured area values, i.e. the standard deviation is normalized. In
contrast to absolute standard deviations, relative standard deviations can be
compared (for area values around 1000 a standard deviation of 1 is minor, for
values around 10, this is a major deviation). Usually, the relative standard
deviation is expressed in percent.

The relative standard deviation (relStdDev) is calculated as follows from the
absolute standard deviation (StdDev):
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relStdDev StdDev
Y

=

With: Y : Average value of all Y-values. .

Relay
Relays are closing contacts that can be switched by the data system. Apart
from the physical ("real") relays on the rear of various Dionex instruments,
there are also virtual relays that can only be used within the data system.
Virtual relays are mostly used for defined functions, such as moving the needle.
Virtual relays are available if the respective instrument or function is installed.

Before using a "real" instrument relay, it must be installed in the Server
Configuration, i.e. it must receive identification. This ID consists of the relay
name and the relay number.

 Note: Some device drivers support trigger contacts, which function as
two dependent relays. When the first relay is switched on, the
second is switched off and vice versa.

Relay On/Off
The Relay On (Off) command closes (opens) a relay output (contact closure
relay) for a defined time. Switching valves are also treated as contact closure
relays.

The specified relay is opened or closed for a specified time in seconds. Relay
On opens the relay upon completing a certain period ( Duration), Relay Off
closes the relay after completing the duration. If no duration is specified for
Relay On (Off), the relay remains closed (open) until the next relay command
is given.

Also, see ⇒Relay On/Off

Remote Inject
The Remote Inject driver is required for non-controlled chromatography
systems. Typically, non-controlled systems are GC systems or third-party
HPLC systems for which no separate driver is available.
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With controlled HPLC systems, the Autosampler directly communicates the
time of injection to the Dionex Chromatography Management System via an
RS232 cable. This is not possible with non-controlled systems. The Remote
Inject driver then serves to communicate the time of injection from the
autosampler to the Dionex Chromatography Management System. Via a digital
input (typically via the detector), the autosampler communicates the inject
signal to the Dionex Chromatography Management System. As soon as the
signal is received, for example, the data acquisition (⇒AcqOn/Off can be
started. With GC systems, the time of injection is communicated in the same
way.

Choose for example the following setting if the inject output of the autosampler
is connected to the input of the UVD:

Remote Input
To enable a reaction to external events (e.g. injection), several Dionex
instruments and additional boards offer remote inputs. The remote inputs are
suitable for input voltages between 0V and +5V (TTL level).

As the remote input level is kept at +5V by internal board resistors (pull-up
resistance), a simple contact closure relay can be used as external signal
source. This contact must be switched between GND and the respective
remote input. If the contact is closed, the digital voltage is grounded. The relay
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itself is under a low current of approximately 1mA. Opening the contact
restores the initial state.

If the signal source itself is active (e.g., Dionex Photodiode Array Detector
UVD340S), the polarization of the remote input must be correct. Ground must
be connected to ground, and the digital output must be connected to the
remote input.

Installation is for the instrument that supplies the remote inputs. Determine
clear installation names and numbers for the required remote inputs. The
instrument determines the timebase to which the remote inputs are assigned.
Only in the case of remote inputs of an A/D Converter, the Timebase must
be specified in addition.

 Caution: Do not supply higher voltages (>5V) to the remote inputs, as this
may result in a malfunction of the microprocessor system on the
A/D board, in the destruction of the input modules or in further
damage.

Example:
A hand-operated valve (injection valve) is connected to a Remote Input of the
A/D converter. In the  Server Configuration, a free input number, the name
of the remote input signal (= INJECT), and the name of the timebase (e.g.
SYS1) is entered below the A/D board. By switching the hand-operated valve
(from the Load to the Inject position), the two contacts of the remote input are
connected and grounded. This state is recognized as an Inject signal by the
system and as the start of the chromatogram. When switching back the hand-
operated valve, the original state is restored. The remote input is in the initial
state again.

Replicate
In the case of multiple injections from a standard or sample vial, all samples
following the first injection are called replicates. The name Replicate is used
independently of the injected volume (see ⇒Inj. Vol. (injection volume))

Each replicate must be added to the sample list of the sequence as an
independent sample! Document the injection from a single vial (identical
sample position) in the ⇒Replicate ID column by entering the same number /
the same text. When a new sequence is generated using the Sequence
Wizard, the ⇒Pos. (sample position) is automatically entered as replicate ID.
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Replicates of a standard sample with the same injection volume will produce
Calibration Points on the same level. Each alteration of the injection volume

will generate calibration points of a new level.

Replot from Beginning
Enable the Replot from beginning option to automatically replot when the
signal leaves the right-hand border of the signal plot. The current
chromatogram is then replotted from the beginning. One unit scales the time
axis to fit the chromatogram into the window. For example, if the first time axis
was 2min, after 2min the window is enlarged by 2min to show 4min, after 4min
it is enlarged by another 2min to show 6min, etc.

Report Definition File (RDF)
Report Definition Files (RDFs) have two functions: They serve to display and
reprocess your results on the screen (Report) on the one hand and to prepare
the printout ( Printer Layout) on the other.

For details, see: ⇒Report Definition File.

Report Publisher
The Report Publisher is an add-on product to the Dionex Chromatography
Management System. With its 141 Additional Functions is provides
considerable enhancements to report templates in the Printer Layout.

Choose the About item in the Help menu to see whether this add-on is
available on your system.

Report Publisher = On
This setting indicates that the Report Publisher is available on your system.
After activating the edit line in the Printer Layout, you can enter the character
= followed by the required formula. In addition, the Insert ... Chart command is
available via the context menu. It allows the graphical representation of specific
cell values.

For details on the available options, see How to ...:  Actions in the Printer
Layout.
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Report Publisher = Off
In this case, the Report Publisher is not installed on your system. Please
contact Dionex if you are interested in purchasing the add-on product.

Reserved Relay, Remote Input, and Signal Names
The following names are reserved for special functions:

Description
3DFIELD The signal 3DFIELD is composed of the absorption values recorded at the

time t at different wavelengths using a photodiode array detector. Each
absorption value is entered as a data point in a wavelength by time grid,
producing a three-dimensional data field. The number of data points is
determined by the optical resolution and the selected bandwidth (limits) of the
3D-field.

INJECT refers to the signal that is recognized as the INJECT signal by the system and
that defines the start of the chromatogram.

Resolution
The Resolution peak result variable is the distance between two adjacent
peaks. This resolution is a measure for the separating capability of the column.
It is calculated based on the following formulas (EU and US standards):
US standard:  R  =  2 x (Tnext  - Tret) / (BWnext + BWret)
EU standard:  R  =  1.18 x (Tnext  - Tret ) / (W50%next + W50%ret)

With:
Tnext / Tret Quotient of the retention times of the two peaks
BWnext / BWret Quotient of the Peak Widths of the two adjacent peaks
W50%next / W50%ret Quotient of the width of the two adjacent peaks at 50% of the peak

height

The distance between the peak maxima is divided by the arithmetic average of
the peak widths.

Select the column in the report, choose the Column Properties command
from the context menu, and select the variable in the selection box. Press the
Parameter button to define whether the calculation is based on the EU (EP
formula) or the US (USP formula) standard.

These abbreviations refer to:

EP = European Pharmacopeia

USP = United States Pharmacopeia.
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Response
Response is the time the detector requires for reaching 98% of the full
deflection. With a longer time interval, the Signal to Noise Ratio improves, but
the resolution is reduced.

Response Factor
The Response Factor peak table parameter is a peak-specific, multiplicative
factor without dimension. Its default value is 1.000 and is changed for special
applications. The response factor is entered in the corresponding column of the
Amount Table in the ⇒QNT Editor.

Also, see ⇒Response Factor

Restore (File)
The Restore command allows restoring files previously stored via the

Backup function. The procedure is described under How to ...: Actions in
the Browser  Restoring Backup Files.

To execute the Restore command, select Import/Restore in the Browser File
menu.

 Tip: The easiest way to open these archive files, which have the
extension *.cmb, usually is to double click on them in the
Windows Explorer.

Retention Index
The retention index serves for achieving uniform scaling of the ⇒Retention
Time

Also, see ⇒Response Factor

For information how to enter the retention index, see How to...: Actions in the
QNT Editor   Defining the Retention Index and the Kovats Index.
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Retention Time
The retention time is used for peak identification. The Retention Time peak
variable refers to the time (in minutes) that passed since the injection (also, see
⇒Dead Time). The retention time of a peak is defined by the time of the data
point with the highest absorbance value. (This does not have to be the data
point with the largest distance to the baseline.)

In the Dionex Chromatography Management System, the retention time is
especially important at two points:
• In the ⇒QNT Editor as part of the peak table

• In the Report / Printer Layout on the Integration, Peak Analysis, and
Summary sheets.

QNT Editor
On the page Peak Table in the QNT Editor, the retention time can be entered
either manually by the user or automatically by the system.

Also, see ⇒Response Factor

Report
In contrast to the QNT editor, the actually measured retention times of the
corresponding samples are stated in the report. This is the default setting for
the Retention Time variable of the Peak Results category. With this variable,
it is also possible to indicate the actual nominal retention time. Then, the
settings of ⇒Use Recently Detected Retention Times are taken into account.
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However, it is also possible to include the expected retention times (from the
peak table of the QNT editor) using the category Peak Table. Choose the
Retention Time variable from the report category Peak Table. It is not always
the nominal retention time that is displayed.

Retention Time Correction
See ⇒Use Recently Detected Retention Time

Retention Time Deviation (Ret. Deviation)
The Retention Time Deviation peak result variable indicates the deviation of
the actual retention time from the nominal ⇒Retention Time according to the
peak table (in [minutes]).

Retention time deviation = T ret. (nominal) - T ret. (actual)
The retention time deviation can be set via two different methods. The setting
can be either

• Absolute, i.e. in minutes, or

• Relative, i.e. relative to the retention time.

Select the column in the report, choose the Column Properties command
from the context menu, and select the variable in the selection box. Press the
Parameter button to determine whether the deviation is expressed as a relative
or absolute value.

Retention Time Interpretation
This QNT file parameter determines the appearance of ⇒Retention Times in
the peak table.

Select the Absolute Times [min] option to display the retention times as usual
(time interval between injection and peak maximum).

Instead of this representation, relative time intervals to any peak can be
displayed in the peak table (reference peak).
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Select the Time distance to Reference peak [min] option to express the
difference to the reference peak in minutes.

Select the Time ratio to Reference peak [%] option to express the difference
to the reference peak in % values.

As the reference peak can be located in the center of the chromatogram, the
difference expressed in minutes or percent can assume negative or positive
values, or values below or above 100%.

 Caution: For difference and relative retention times also, relative (time)
⇒Window are interpreted as percentage values of the absolute
retention time! Only the retention times of identified peaks are
corrected! In the peak table, you can choose between the three
options, as required. The retention time column is re-calculated
automatically.

Retention Time Spectrum
The retention time of a peak is determined at the peak maximum. The
spectrum the photodiode array detector records at this time is referred to as
retention spectrum.

Retention Time Window
See Window

Retention Window Width
The Retention Window Width peak variable provides the width of the
⇒Retention Window (in minutes) that was used to detect the peak. This
variable is also available for not identified peaks.
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RF Value (Amount/Area)
The ascending slope of the calibration curve, specified as amount/area value,
is referred to as RF Value. This is the reciprocal value of the Slope c1.

 Note: The RF value is sometimes called Response Factor. Do not
confuse this term with the Response Factor used in the peak
table.

Rider Peak
In a series of non-resolved peaks, all peaks - with the exception of the largest
peak (reference peak) - are referred to as rider peaks. Alternatively, they are
called skimming peaks.

Depending on the position of the rider peak (in the ascending or descending
flank of the reference peak), a distinction is made between rider up and rider
down.

The ⇒Rider Threshold and ⇒Maximum Rider Ratio detection parameters
determine the peaks that are classified as rider peaks within a series of non-
resolved peaks.

Peaks classified as riders are recognized in the chromatogram plot by the
skimming tangent. In the result report, they are labeled Ru (Rider up) or Rd
(Rider down).

Rider peaks can be skimmed in different ways (see ⇒Rider Skimming).

Rider Skimming
This parameter indicates how Rider Peaks are skimmed.

Also, see ⇒Rider Skimming

For information on how to apply the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Rider Threshold
The Rider Threshold detection parameter decides whether individual peaks in
a series of non-resolved peaks are classified as Rider or as main peak.
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Also, see ⇒Rider Threshold

For information on how to apply the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Right Mouse Button
The most common commands and functions are available in the context menu.
The choice is context-sensitive, i.e. the commands most likely to be used in the
current situation will be offered.

Pressing the right mouse button usually opens a context-sensitive menu
(= context menu).

Right Limit
Normally, peak integration is performed automatically. It is possible to limit or
extend integration on the left, right or on both sides with the appropriate peak
table parameters.

Each (minute) limit is relative to retention time, i.e., the peak is integrated
between the retention time - left integration limit .... and .... retention time +
right integration limit. The value 0 deactivates the limit.

Example: For the right and the left integration limit, the value 0.5min is
entered. The peak maximum is at the retention time of 8
minutes. The peak is integrated from 7 minutes 30 seconds to 8
minutes 30 seconds.

Example: For the left integration limit the value 0.5min and for the right
integration limit the value 0 is entered. As before, the peak
maximum is at the retention 8 minutes. The peak is integrated
from 7 minutes 30 seconds. The end of the integration is then
automatically determined.

Right Width
If a perpendicular line is dropped to the baseline from the peak maximum, the

Peak Width is divided in a left and right section. The two sections are referred
to as left width and right width and can be expressed as separate peak result
variables.
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The Dionex Chromatography Management System also determines the left and
right peak width at 5, 10, and 50% of the peak height. As described under Peak
Width in the Glossary, the selected height is very important for the calculation
of the peak width. This also applies to the calculation of the left and right peak
widths. The abbreviations for the left and right peak widths are LW and RW.

Select the column in the report, choose the Column Properties command
from the context menu, and select the variable in the selection box. Press the
Parameter button to determine at which peak height to determine the peak
width.

Rise Time
Rise Time is a measure of how quickly the detector responds to a change in
signal. Rise time is defined as the time it takes the output signal to rise from
10% of its final value to 90% of its final value. Choosing an appropriate rise
time value can optimize performance by keeping the Signal to Noise Ratio at
a minimum level.  A longer rise time allows averaging of the noise frequencies,
and subsequently, the baseline will contain much less short-term noise.
However, longer rise times may have the following effects on peaks:
• Peak shape will become asymmetric.
• The peak maximum will be shifted.
• The peak height will be reduced.

 Note: The rise time should be approximately 25% of the peak width at
half height of the narrowest peak of interest.

For example, for a peak width of 5 seconds, calculate the rise time as: 1/4 (5
sec) = 1.25 sec. Because 1.25 seconds is not one of the available settings for
rise time, select the next fastest rise time, which is 1 second in this case.

 Tip: In the AD25 and PDA-100 detectors, rise time applies to both
digital and analog output.

RPC (Remote Procedure Calls)
The RPC technology introduced with Windows 95/NT allows running a program
on a different computer.

Unlike true full-control programs as PC-DUO or PC-ANYWHERE, the amount
of transferred data is considerably lower with this type of control. Processes
started from a remote computer run almost without any time delay. For the user
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it is not possible to determine whether the process is performed on the local or
on a remote PC.

RPC requires a functioning network connection between the involved
computers. It is irrelevant whether the computers are part of the same network
or whether they are linked via a modem connection. Communication also
functions between different networks (Novell, Windows), provided the networks
communicate via a common protocol.

The Dionex Chromatography Management System generally communicates
via the network protocols IPX/SPX, TCP/IP, or NetBEUI. Under Windows
NT/2000, the protocol Named Pipes is also valid.

Sample Data
Data that contributes to characterize a single sample is stored in a database by
the Dionex Chromatography Management System. This does not only include
the entered data (name, volume etc.), but all results calculated from the Raw
Data and the chromatographic conditions under which the sample was
analyzed (column, temperature, solvent, instruments etc.).

Sample Name
The Name ⇒Sample Variable serves to identify a sample and also to label
graphics and result reports. The user generally enters the sample name.

When creating a sample list with the  Sequence Wizard, automatic sample
name generation will be possible.

Also, see ⇒Name (sample name)

Sample Needle Height (AS50 Command)
The Sample Needle Height AS50 Autosampler command positions the tip of
the needle at the specified height (in mm) above the bottom of the vial. A value
of 0 is closest to the bottom of the vial; a value of 46 is closest to the top. This
height is used for all sample injections. It is also the default for sample
preparation steps unless a separate Needle Height command is specified.
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Sample-Oriented Operation
Due to the object-oriented concept of the Dionex Chromatography
Management System, emphasis is on samples and Sequences, not on
methods or activities.

The user selects the sample or sequence to process and automatically
receives the corresponding view, i.e. calibration methods are displayed in the
calibration window, integration samples in the integration window and
sequences in the sample editor, etc. For each sample or sequence, only the
selectable or expected views, methods, or functions are available to the user.
This saves time and reduces the number of simultaneously active windows.

This context-sensitive procedure is also valid for options selectable in the
context menu. The selection depends on the position and the time of the
mouse click.

Sample Position
The Pos. ⇒Sample Variable determines the position of the sample in the

Autosampler.

If you use a controllable autosampler, the entered position is transmitted
automatically to the sampler. The sampler approaches the corresponding
sample for injection. If using a non-controlled autosampler or a hand-operated
valve, this column only serves for documentation purposes. If the sample
position parameter is not entered, the previous (current) value is used.

Also, see ⇒Pos. (sample position) and ⇒Position (autosampler command).

Sample Preparation Vial Positions
In AS50 autosampler sample preparation operations, a vial position can be
specified either as an absolute position or as a relative position.

To specify an absolute position, enter the number of the vial’s position in the
tray. Valid numbers depend on the tray type in use: 1 to 100 for the 2 ml tray; 1
to 49 for the 10 ml plastic tray.

To specify a relative position, select CurrentVial for the current sample vial,
CurrentVial+1 for one vial past the current vial, CurrentVial+2 for two vials
past the current vial, and so on, up to CurrentVial+9.

Some operations let you specify FlushPort instead of a vial.
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Sample Status
The Status ⇒Sample Variable determines the current sample processing
status. A sample is either unprocessed (Single), or Finished, or due for multiple
processing (Multiple).

The Dionex Chromatography Management System also maintains a log of the
sample status, i.e. a Single sample is automatically assigned the status
Finished as soon as processing is completed. A sample may also be excluded
from processing by assigning the status Finished.

The sample status has a special significance for the built-in Power-Failure
Protection. Upon recovery from a power failure or starting the sample batch
after a manual interruption, the Dionex Chromatography Management System
begins processing the sample batch according to the selected power-failure
handling option.

Also, see ⇒Status (sample status)

Sample Type
The ⇒Sample Variable Type specifies which type of sample is used.

Select the Unknown option if the sample is an unknown analysis sample. This
sample type is indicated by the symbol: .

Select the Standard option if the sample is a standard sample with known
concentration. This sample type is indicated by the symbol: .
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Select the Validate option if the sample is a Validation Sample ( ).

Select the Blank option if the sample is a Blank Run Sample ( ). If a sample
is corrected by the Raw Data e.g. of a blank run sample, this is referred to as

Blank Run Subtraction.

Select the Matrix option for a Matrix Blank Sample. This sample type is
indicated by the symbol: 

Also, see ⇒Type (sample type)

Sample Weight
The Weight ⇒Sample Variable has two functions. It serves to enter the sample
weight but it can also be used as a weight correction factor.

Sample Weight is implemented as a multiplication factor in the Formula for
Amount Calculation of not explicitly entered amount values (dilution series). It is
without dimension.

Also, see ⇒Weight (sample weight)

Sampler.Ready
See Ready

Sampling Rate
The number of stored signal values per second is referred to as sampling rate
(or Data Collection Rate).

The maximum of stored values corresponds to the number of values generated
per second and depends upon the device, for example, Dionex UVD
170S/340S Detectors = 100, A/D Converter = 100, 3D-field = 10, Dionex
AD25 and PDA-100 Detectors = 10.

The reciprocal value, i.e., the time interval between data points, is called
⇒Step (Dionex UV detectors = 0.01, A/D converter = 0.01, 3D-field = 0.1,
Dionex AD25 and PDA-100 detectors = 0.1).
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 Tip: For Dionex detectors that are installed via the DX-LAN, a Data
Collection Rate command determines the data collection
(sampling) rate and the step value is automatically set to the
reciprocal of the selected data collection rate. For other Dionex
devices, only the step value is set and a separate Data
Collection Rate command is not used. See How to...: Device
Control  Defining Step and Average for details.

SCAN Mode
The SCAN Mode of an electrochemical detector serves to determine the
analytical potential of a substance.

At a constant concentration in the flow cell, e.g. realized by strongly reducing or
by stopping the pump flow, the potential between reference and working
electrode is changed linearly.

The change is either a linear increase or decrease between two values (E1 and
E2; Half scan), or an increase with a subsequent decrease (Full scan). If the
increase and decrease are constantly repeated, this is referred to as
Continuous scan.

E [V]

I [A]

0 EAE1 E2

In all three cases, current/voltage curves (here represented by a half scan) are
recorded. The working electrode potential (= EA) here corresponds to the
optimum analytical potential of a substance. Determining this potential is
required for accurate analysis in the DC Mode and the PULSE Mode.

Practical Application with the Antec Detector DECADE
The analysis is performed in the DC mode or the PULSE mode. If the peak of a
substance is detected for which the analytical potential is to be determined,
stop the pump flow, switch to the SCAN mode, and slowly change the potential.
When the final value is reached, return to the previous mode and reset the
pump flow to its original value.
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The entire process can be performed by a key click, if the required commands
are placed on a Command Button.

In the signal plot of the Control Panel, the following curve can be observed.

t [min]
0 0.2 0.4 0.6 0.8 1.0 1.2 1.4

EAE1 E2

Signal [mV]

Unlike the pump, the chromatogram run time is not stopped. The retention
times of the subsequent peaks will be shifted accordingly. However, the signal
height of the peaks will be lower as part of the substance is "used up" during
the Scan mode.

The optimum analytical potential cannot be directly read on the y-axis (time
axis), but is determined with the printed chromatogram.

Self-Regenerating Suppressor (SRS)
See Suppressor

Sensitivity (Detection Parameter)
The Sensitivity detection parameter determines the signal height from which
the detected data points are interpreted as peak or as noise. It is always
interpreted in the installed dimension (e.g. mAU).

 Tip: Always consider this parameter in combination with the ⇒Peak
Slice detection parameter!

Also, see ⇒Sensitivity

For information on how to apply the detection parameters, see How
to ...: Actions in the QNT Editor  Modifying Detection Parameters.
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Sensitivity (Signal Parameter)
The Sensitivity parameter adjusts the data system to the sensitivity of the
detector (i.e. to the Signal to Noise Ratio). The fluorescence detector
RF 1002 supplies the values LOW and HIGH, the model RF 2000 supports the
values LOW, MED (Default) and HIGH.

Sequence, Sequence Table, Sample List
A sequence combines samples that belong together due to their origin or
processing. The names of all samples that belong to one sequence from the
user's point of view are entered in the sample list (also called sequence table).
A sequence is thus a container for various samples.

To create a sequence, use the  Sequence Wizard.
Also, see ⇒Sequence

Sequence Data
Data that serves to characterize a Sequence instead of a single sample (!)
(see Sample Data), is referred to as sequence data.

This includes, e.g. the date of the last change, the corresponding timebase or
the name of the user who created the sequence. As the sample data, this
information is stored in a database.

(Chromatography) Server
PCs connected to the components of an HPLC system via a serial interface
can be used as chromatography servers.

A chromatography server is automatically installed on the PC during the
installation of the Dionex Chromatography Management System. The
chromatography server controls the data exchange between the system and
the PC. Upon starting, each server is capable of serving up to six controlled or
16 non-controlled systems (timebases). The server receives the commands
entered by a Client PC in a Control Panel and executes them at the
specified time (e.g. by transmitting them to the corresponding device driver of
the HPLC system). In the opposite direction, the server also assumes this
buffer function. Thus, the raw data of each system is stored at the location
specified by the client and the entire system-relevant data is forwarded to the
client.
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Starting (loading) the server can be performed manually or automatically.
Select the required options in the Server Monitor Program. For optimum
functionality, the server must be configured. This is performed via the Server
Configuration of the Dionex Chromatography Management from any client PC.

If the server and the client software of the data system are located on the same
PC, the installation is local, if not, it is a network installation (see 

 Network).

 Tips: In the case of manual data acquisition, the Raw Data from the
system is always stored in the PCNAME_LOCAL server
directory. In the case of Batch Processing, each user can
choose where to store the data.

To minimize the risk of losing data, raw data should always be
stored temporarily on the server. In the course of archiving, it
can be transferred to a different computer.

Server Configuration
The Server Configuration includes information on the assignment of HPLC
devices to Timebases, the connection of servers to timebases, and the
configuration of the individual devices. It is defined in the Server
Configuration program.

The information is saved in an installation file (*.CFG file). The current
configuration is always saved in the CMSERVER.CFG file on the
chromatography server.

The user can create different installation files in the Server Configuration,
transfer them to any server via the Import function, and use them accordingly.

Executing the Save command saves the current configuration as the new
CSERVER.CFG file on the server.

For further information, see How to ..: Actions in the Server Configuration
 Changing the Server Configuration.

Server Monitor Program
The program required for starting and monitoring the chromatography server is
called the Server Monitor. During installation, it can be included in the Autostart
group of the operating system.
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When starting the Server Monitor, an additional icon appears on the Windows
status bar indicating the status of the server.

• Move the mouse cursor over the icon to view the server status via a quick
info field.

• Open the corresponding context menu  (right mouse button) to start or to
stop the server (Start/Stop Server), or to exit the monitor program (Quit
Monitor).

• Double-click the icon for further options, e.g. automatically starting the
server when booting the computer.

The server status is also indicated by the icon's color:

Icon Color Message
Crossed out
red

CHROMELEON (PeakNet) Server is not running.

Yellow CHROMELEON (PeakNet) Server is starting / is closing.

Green CHROMELEON (PeakNet) Server is active.

Turquoise CHROMELEON (PeakNet) Server is reconfiguring.

Gray CHROMELEON (PeakNet) Server is running idle.

Yellow/
red

CHROMELEON (PeakNet) Server needs attention.

The server waits for the response to a message (⇒Message
command). For example, after a power failure the user must decide
how the program should continue the interrupted sample
processing.

Sharable Devices
The Dionex Chromatography Management System records signals from
several devices and controls different instruments. Via PC plug-in boards (such
as the Dionex  A/D Converter or the  Pump Control Board) or via the

UCI-100 Universal Chromatography Interface the signals are sent to the



Glossary A-151

Server PC. In order to avoid that an individual board or interface has to be
available for each device from which signals are recorded and to which signals
are sent, respectively, the boards / interface provides several channels.

The different devices need not necessarily be part of the same Timebase. To
enable e.g. signal recording by detectors from different timebases the PC plug-
in boards or the interface should not be assigned to one specific timebase.
Instead, the devices of different timebases address the same board / interface,
i.e., the board / interface is shared between these timebases. Therefore, the
PC plug-in boards / interfaces are called Sharable Devices.

Each slot of a PC plug-in board / interface corresponds to a channel. The used
channels must then have a signal assigned in the Server Configuration.
Install the corresponding device driver and assign the signals on the Signals
page. The Remote Inject and the Integrator Driver are available for non-
controlled systems (usually GC, but also non-controlled HPLC systems). The
Integrator Driver can also be used to record the pump pressure.

The advantage of this conception is that you do not have to rewrite all
Programs concerned if you plan to connect a device to a different channel.

Instead, just change the A/D port assignment in the respective driver.

Shared Relays and Inputs
Relays and remote inputs of the PC-plug-in boards (e.g.  A/D Converter or

 Pump Control Board) and the UCI-100 Universal Chromatography
Interface that are installed under Sharable Device in the Server
Configuration are timebase-independent (Sharable Device), e.g. they can
by used and addressed by different Timebases.

To make these relays and remote inputs visible as controls on a Control
Panel and usable in the case of a relay, the corresponding relay or the used
remote input must be installed below the corresponding timebase.

As for any other device, it is necessary to load a device driver (Add Device
command). For relays and remote inputs, choose the Shared Relays and
Inputs device driver.

After installing the device driver, double-click the driver name to enable
configuration. A tab dialog box will appear for relays (Relays) and another one
for remote inputs (Inputs).

Each of the two tab dialog boxes shows the current assignment of the currently
used relays and/or remote inputs. If there is no entry in the list, either no
Sharable Device component was previously installed or the relays and remote
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inputs have not been assigned. Press ADD to install a new relay or remote
input.

Signal
The data transferred directly from an instrument (ideally a detector), either in
analog or digital form via A/D Converter or RS232 interface to the data
system, is referred to as physical signals. If an instrument delivers several
signals, these are also called channels (e.g. two different wavelengths of a UV
detector). Calculated data, such as the arithmetic average of several channels,
can represent a signal. This type of signal is called Virtual Signal.

Each signal has its own signal name that is assigned during instrument
installation. The symbolic name of each signal must be clear. Some special
signals have pre-defined signal names assigned to them.

The properties of a signal are determined via separate Signal Parameters.
They can be modified manually or program-controlled ( PGM File) at any time.

The measuring data of the different physical and virtual signals is stored in
uniform raw data files.

Signal Name
The symbolic signal name is freely selectable, however, it must be unique.
Within one system, no other signal can have the same name. Virtual Signals
also receive a signal name. This name is defined by the data system.

 Caution: The signal name is also stored within a partial method or a file.
To be able to read and use older data at any time, the chosen
names should not be changed!

Signal Noise
See Noise

Signal Parameters
Each signal delivered by a detector has detector-specific parameters. These
signal parameters can be modified on the instrument, or in the case of
controlled systems, via the data system. A manual or program-controlled
( PGM File) alteration is thus possible during chromatogram run time.
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The following parameters are available for Dionex instruments and third party
instruments controlled by the Dionex Chromatography Management System
via device drivers:

Signal type Parameter Signal type Parameter
UV channel ⇒Step Fluorescence channel Excitation

⇒Average Emission
Data Collection

Rate
Gain

⇒Wavelength Response
⇒Bandwidth Sensitivity
⇒Reference
Wavelength

⇒Step

⇒Reference
Bandwidth

⇒Average

3D-field Min/Max
Wavelength

Electrochemical channel ⇒Step

⇒BunchWidth ⇒Average
⇒Step Data Collection

Rate
⇒Reference
Wavelength
⇒Reference
Bandwidth

ESA channel ⇒Step

⇒Average
MS Channel Min/MaxMass

FilterIndex

 Tip: In controlled systems, user input on the instrument is disabled.

Signal to Noise Ratio
The signal to noise ratio serves to characterize electronic components such as
the A/D Converter or a UV or photodiode array detector. The lower the noise,
the smaller the possible signal variations that can be recorded. As a general
rule, the average of a signal should be at least twice, better three times the
standard deviation of the signal value.

The signal to noise ratio of the Dionex Photodiode Array Detector UVD340S is
0.5/100000 AU. Measurement of this technical specification is within a clearly
defined scope. This includes the wavelength information (254nm), the
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bandwidth, and the ⇒Step. The values can only be realized with an empty flow
cell and a new but burnt-in lamp (approx. 40 h). The maximum signal variation
(in AU) is measured at maximum light radiation through the flow cell.

If establishing comparable specifications is not relevant, the signal to noise
ratio can be improved by the following operations:
• Selecting a low Sampling Rate

• Using photodiode bunching ( Bandwidth)

• Selecting the Optimum Integration Path

Signal Value at Peak End
This peak result variable gives the signal value at the time of the peak end. The
peak end is determined via the right peak delimiter.

Signal Value at Peak Start
This peak result variable gives the signal value at the time of the peak start.
The peak start is determined via the left peak delimiter.

Signature
See Electronic Signature

SIM (Selected Ion Monitoring)
SIM is the Mass Spectrometer method used for recording an MS
chromatogram at a specific mass. As only single ions are recorded with specific
masses, the SIM mode is more sensitive than the Full-Scan mode. You can
use up to 32 channels, which are called SIM_1 to SIM_32, for data acquisition.
In the SIM mode, too, one TIC channel is recorded which is the sum of the
results of the individual SIM channels.

With SIM chromatograms, the counts of specific masses (or more exactly: with
a particular mass-to-charge ratio) are added up. Thus, contrary to TIC
chromatograms, SIM chromatograms contain data of a specific mass.

Contrary to Mass Traces that are extracted later from Mass Spectra (see
How to ...: Actions Related to the aQa-MS  Extracting Mass Traces
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Afterwards), SIM chromatograms are always recorded during data acquisition.
If an important SIM channel is not taken into account during data acquisition, it
can be extracted later as mass trace.

Also, see: How to ...: Actions Related to the aQa-MS  Defining the
Number of MS Channels.

Single-Point and Multiple-Point Calibration
If the position of the calibration curve is determined only by the Calibration
Points of one Calibration Level, this is called single-point calibration. In this
case, the ⇒Calibration Type linear must be chosen.

If calibration points on different levels determine the position of the calibration
curve, this is referred to as multiple-point (e.g., two-point, three-point, etc.)
calibration. The number of calibration levels determines possible calibration
types.

In both cases, the number of replicates is irrelevant for the number of
calibration levels. Replicates only serve to statistically secure the measuring
results.

Skewness
Similarly, to Asymmetry, the Skewness peak result variable is a measure for
the column quality.

Its definition is also similar. This peak result variable is frequently mentioned in
HPLC literature.

Skewness Calculation
S

With:

LW10

RW10

S = (RW10 + LW10) / ( 2 x LW10)

Left peak width in 10% of
the peak height

Right peak width in 10% of
the peak height

100 %

10 %W10 %

Also, see Asymmetry.
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Slope c1
The Slope c1 calibration variable indicates the c1-value of the currently used

Calibration Function.

Smoothing
Data smoothing serves to reduce signal noise and help improve chromatogram
appearance and reproducibility of peak baselines applying different digital
filters without altering the raw data. The Dionex Chromatography Management
System makes the following filter types available in the context menu of the
Chromatogram window:

Moving Average (Boxcar)
The Moving Average (or Boxcar) filter equally weights each point. Thus, its
ability to discriminate between noise and signal is limited  (also, see Signal to
Noise Ratio).

Olympic
Compared to the Moving Average filter, the Olympic filter provides better
rejection of impulse noise (spikes).

Savitzky-Golay
Savitzky-Golay smoothing is useful for reducing high-frequency noise of a data
set that is continuous (such as a chromatogram) without significantly degrading
the underlying signal.

For further details, see How to ...: Actions in the Chromatogram
 Performing Data Smoothing

In addition, the Dionex Chromatography Management System allows
smoothing MS chromatograms during acquisition or mass trace extraction
using the Gaussian and Boxcar (= Moving Average, see above) filters which
are both offered by Xcalibur.

Gaussian
The Gaussian filter applies the Gaussian distribution for chromatogram
smoothing.
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For further information see How to...: Actions Related to the
aQa-MS  Extracting a Mass Trace.

For details on the different filter types and their respective parameters, see
 Data Smoothing in the Integration section.

Snap to Grid
Use the Snap to Grid function to reduce, enlarge, or move the control frame in
units of the mesh size.

Select File/Preferences to determine the mesh size of the grid.

SOR File (Signed Off Results)
SOR files (Signed Off Results) are electronically signed sequences (see:

Electronic Signature). They are indicated as follows:

SOR files merely contain the tabs with the corresponding data for the sequence
that have been selected in the respective Report Definition File (RDF). The
data cannot be changed unless the signature is undone. However, to do so, the
user must have the UndoSignResults Privilege. He/she has to re-enter
his/her user-ID and the respective signature Password if this has been
defined accordingly in the CmUser program (File menu > Database
Properties > Electronic Signature tab).

Sound
The Sound command allows playing WAV files. The PC must be fitted with a
sound card to support this command. WAV files are part of the Windows
installation and contain various acoustic signals. Numerous example files are
supplied e.g. in the WINNT/MEDIA directory (full Windows installation).

The command syntax of the Dionex Chromatography Management System for
playing a WAV file is:

0.000 Sound File= "Example.wav"

If the command cannot be performed due to a missing sound card, a default
sound is generated at the PC speaker.
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Also, see ⇒Sound

Spectra Calibration
Dionex UV Detectors UVD170S and UVD340S perform a spectra calibration
after each Lamp on command. A Holmium-Oxide Filter allows calibrating
UV/VIS spectra recorded with the detector, due to the typical absorption
spectrum of holmium oxide.

Dionex AD25 and PDA-100 detectors perform a spectra calibration at power
up. New wavelengths are assigned to each pixel, based on the emission
spectrum from the deuterium lamp.

With defined absorption maxima, spectra calibration ensures that the data
delivered by the detector corresponds to the expected wavelength values.

Spectra Criteria
Apart from absorption values, each spectrum in a library contains various ID
data fields that are freely editable by the user and that facilitate spectra
searches. The following fields are available:

Column Description
Name This column shows the name under which the substance is included

in the spectra library. Select a column entry to assign a new name
to the corresponding substance.

ID This column shows the short ID that is assigned to the spectrum.
Use this column to save several spectra under the same substance
name in a spectra library. The Ids (e.g. consecutive numbers). Then
distinguish the spectra. ID

Column Description
#Extrema This column shows the number of extreme values in the spectrum

determined by the system. Select a column entry to change the
number.

Solvents: This column shows the solvent in which the spectrum was recorded.
Select a column entry to edit.

Comment: Use this column to document details on the saved spectrum.

WL-Range: This column indicates the wavelength range of the recorded
spectrum.

WL-Resolution: This column shows the ⇒Bandwidth with which the spectrum was
recorded.

Ret.Time: This column indicates the retention time at which the spectrum was
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extracted from a peak.

Acq.Step: This column indicates the Step with which the underlying 3D-Field
was recorded.

Detector: This column indicates the detector with which the spectrum was
recorded. The name is taken from the Server Configuration.

Detector Serial No.: This column indicates the serial number of the detector from the
Server Configuration.

Timebase: This column indicates the name of the timebase with which the
spectrum was recorded.

Sequence: This column indicates the name and the patch of the sequence from
which the extracted spectrum is taken.

Sample Name: This column shows the name of the sample from which the
extracted spectrum is taken.

Acq. Date/Time: This column shows the date and time at which the spectrum or the
underlying 3D-field was originally acquired.

Program: This column shows the name of the PGM File which was used for
generating the underlying chromatogram.

Extract Date/Time: This column shows the data and time at which the spectrum was
extracted and saved.

Extract Operator: This column shows the name of the user who extracted the
spectrum and saved it to the spectra library.

SQL (Structured Query Language)
SQL is a computer language that has been developed especially for queries in
databases. The Dionex Chromatography Management System uses an
adapted SQL for Queries in the Browser (queries for specific
samples/sequences) as well as for "Database Queries" in the report and in the

Printer Layout.

Standard
The Standard column input in the peak table defines the reference peak to be
used for calibration. The term Standard can also be used for a calibration
sample or a standard sample. Calibration can be performed with an external
and/or internal standard.

Also, see ⇒Standard



A-160 Glossary

Standard Deviation
Extracting the square root of the variance value produces the Standard
Deviation calibration variable:

Std Dev Variance. .=

Thus, the square standard deviation is the Variance.

Status Bar
In the status bar on the lower window margin, messages regarding the current
system status are shown on the left, the current timebase and the currently
executed command are shown on the right.

The display of the status bar can be enabled and disabled via the View menu.

Step
The time interval between two successively recorded data points is referred to
as step; the sum of all recorded data points is called raw data. The reciprocal
value of the step value is the Sampling Rate.

Also, see ⇒Step

Step Gradient
Immediate modifications to the solvent composition are referred to as step
gradients. They ensure a rapid change of the elution conditions. The realization
of the gradient on the column depends among others on the size of the dead
volume between the pump and the column end.

Stop Flow
The Stop Flow command switches off the pump flow and interrupts data
acquisition. A running batch is stopped, as in the hold mode.
Also, see ⇒StopFlow

Suck
See Draw
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Sucked
See Ready

Suppressor
The Self-Regenerating Suppressor (SRS) and Atlas Electrolytic Suppressor
(AES) are patented electrolytic eluent suppression devices from Dionex Corp.
The suppressors reduce background signals and enhance analyte signals in
ion chromatography using conductivity detection. Ion chromatography requires
eluents that contain strong electrolytes. These electrolytes can interfere with
detection of the ionic analytes of interest. The suppressors use ion exchange to
neutralize (suppress) the electrolytes in the eluent, thus reducing the
background conductivity. In addition, the ion exchange mechanism replaces a
less conductive counter ion, with one that is highly conductive (hydronium ions
in anion exchange and hydroxide ions in cation exchange). Because both the
analyte and the counter ion produce the detector response, the analyte signals
are increased. For details, see the Self-Regenerating Suppressor manual or
the Atlas Electrolytic Suppressor manual.

Also, see: How to ...: Device Control  Controlling a Suppressor and
 Setting Atlas Suppressor Currents.

Syringe Speed (AS50 Command)
The Syringe Speed AS50 Autosampler command sets the speed of the
sample syringe. Select the default value of 5 (the fastest) for water; select a
slower setting for more viscous samples. The table below lists the sample
syringe flow rates at each speed setting.

Syringe
Setting

Flow Rate
(ml/min)

1 0.06
2 0.12
3 0.24
4 0.6
5 2.4

Syringe Type
The volume that can be injected with an autosampler depends on the installed
syringe type. Many autosamplers support several syringe types and thus allow
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using a different type with a larger or smaller volume. In addition to the default
types 25, 50, 100, 250, 500, 1000, and 4000 µl, using special syringes is
possible. If the syringe type is changed, the new type must be specified in the
Server Configuration of the Dionex Chromatography Data System. In
addition, when installing a new autosampler, the currently used syringe type
must be defined by configuring the corresponding device driver.

 Caution: For the autosampler Dionex GINA 50, syringe types with the
volumes 250 µl and 1000 µl are supported. If using different
syringe types, the reproducibility stated in the instrument’s
specification cannot be guaranteed.

System Suitability Test (SST)
As defined in cooperation with EURACHEM, System Suitability Checking
(SSC) or System Suitability Test (SST) is "a series of tests to check the
performance of a measuring process " [P. Bedson and M. Sargent, Accred.
Qual. Assur. (1996) 1, 265-274]. Aim and objective of System Suitability
Testing is to ensure the performance of the operating system and the system.

SST or SSC can be applied to single measuring processes and thus may be
part of the validation process. The System Suitability Test establishes for
example that the operational conditions required for a specific measurement
process are being achieved.

 Tip: If you want to perform a System Suitability Test, ensure to enter
the QNT file into the sample list before starting the analysis.
Otherwise, the batch cannot be aborted in case of Fail Action -
Abort Batch because the SST will not yet be performed during
the batch run!

In addition to the System Suitability Test, Operational Qualification and
Performance Qualification are also important for validating instruments and

software (see  Validation).

For details on how to perform a system suitability test in the Dionex
Chromatography Management System, see How to ...: Actions in the QNT
Editor  Defining the System Suitability Test.
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Tailing/Fronting Sensitivity Factor
This detection parameter is an implicit threshold for setting the peak end. The
Fronting sensitivity factor refers to the peak start, respectively.

Also, see ⇒Tailing/Fronting Sensitivity Factor

For information on how to apply the detection parameters, see

How to ...: Actions in the QNT Editor  Modifying Detection Parameters.

Temperature Compensation Factor
A temperature coefficient used in conductivity detection to stabilize conductivity
readings. The temperature compensation factor corrects for changes in
ambient temperatures that occur during a run and normalizes conductivity
measurements to 25 °C.

If the cell is installed in a DS3 Detection Stabilizer or a chromatography oven,
the default factor of 1.7% is appropriate. When operating without a DS3 or
oven, the compensation factor can be optimized to help minimize the baseline
drift caused by fluctuations in ambient temperature. See the detector operator’s
manual for details.

Template
Templates facilitate entering data. The Dionex Chromatography Management
System offers various pre-defined templates, e.g. report templates
(DEFAULT.RDF and DEFLTDAD.RDF).

Theoretical Plates
The Theoretical Plates peak result variable is a measure for the separating
capability of the column. Theoretical plates are calculated from the peak width
and the corresponding retention time. As with asymmetry, there are different
US and EU standards:

Name Calculation Comment
Theoretical Plates TB =  5.54 * (TRET / W50%)2 EU standard
Theoretical Plates TP =  16.0 * (TRET / BW)2 US standard
Theoretical Plates TB =  5.55 * (TRET / W50%)2 JP standard

With:
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TB or TP: Number of theoretical plates
TRET Retention time
W50% Peak width at 50% height (half-width)
BW Peak Width on the base line.

TB or TP do not have a dimension. If they are placed in relation to the currently
used column (L), the result is the theoretical plate height (H):

H = L / TB or H = L / TP

However, the reciprocal value says more about the quality of the currently used
column. It gives the number of theoretical plates per column meter.

1 / H = TB / L or 1 / H = TP / L

Select the report column, choose the Column Properties command from the
context menu, and select the variable in the selection box. Press the
Parameter button to determine whether the calculation is based on the EU,
US, or JP standard.

TIC (Total Ion Current)
TIC chromatograms add up all counts at the respective retention time. Contrary
to SIM chromatograms, TIC chromatograms include the data of the entire
mass range.

Independent of the mode in the MS method (Full-Scan or SIM), a TIC channel
is recorded. In Full-Scan mode, up to four additional TICF_n channels can be
recorded for which the data acquisition conditions may vary (e.g., the
acceleration voltage in the Mass Spectrometer). The channels are called
TICF_1 to TICF_4. The TIC channel summarizes the results of these individual
channels. A TIC channel can be recorded in SIM mode as well. In this case, it
corresponds to the sum of the results of the single SIM channels.

From the Mass Spectrum, separate Mass Traces (this may be mass ranges
as well) can be extracted and saved as new channels (see How to ...: Actions
Related to the aQa-MS  Extracting a Mass Trace. In this way, you can
limit the size of the mass range of TIC channels according to your
requirements.

Also, see: How to ...: Actions Related to the aQa-MS  Defining the
Number of MS Channels.
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Time
The Dionex Chromatography Management System stores the time stamps as
universal time (Greenwich time). However, the date notation is displayed
according to the local settings chosen in the operating system (also, see ⇒Inj.
Date/Time (Time of Injection)).

Timebase
All components combined in a chromatography system to enable the
chromatographic separation and related in a time context with each other, are
assigned to the same timebase.

A timebase can be a very complex system (e.g. two pumps, one autosampler,
one column oven and two detectors switched in series). However, an isolated
integrator or a gas chromatograph can be a timebase as well.



A-166 Glossary

Only another system that is completely independent represents a new
timebase. Administration of different timebases is on one or several

(Chromatography) Servers.

The name of a timebase and the assignment of the devices are specified in the
Server Configuration.

Toolbars
Frequently used commands and features are available as icons; related
functions are combined on toolbars directly below the menu bar. When starting
the Dionex Chromatography Management System, the standard toolbar is
displayed. Select the Toolbars command from the View menu to enable or
disable the display of individual toolbars. The following toolbars are available:
• Standard (standard functions)

• Online (commands for the Control Panels)

• Layout (commands for the Layout Mode are via the Layout Toolbar)

• Method (for changing to other method sections, samples, or channels)

• Integration (commands for processing chromatograms)

• Status Bar (enables/disables the Status Bar)

Move the mouse pointer over an icon to view its name in the quick info
display.
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Transmission
Transmission is 100%, when light passes through the UV detector flow cell
without restraint. Transmission decreases with increasing absorption. For the
UVD 340S detector, the maximum transmission value is determined via zero
order at a reference wavelength of 630nm.

 Caution: The substance mixture passing through the flow cell must not
absorb in the reference wavelength range. If this is the case,
either change the reference wavelength or select transmission
without reference.

Tray Temperature (AS50 Command)
The Tray Temperature AS50 Autosampler command sets the temperature of
the sample tray to between 4°C and 60°C. This command is available only
when the AS50 sample temperature control option is installed.

Trigger Commands
A trigger refers to the automatic execution of a command as soon as a
condition becomes true.

The Trigger command can be included in a Program or a programmable
button, but not in the online control. The following syntax is valid:

Time Trigger TRIGGERNAME Condition,True,Delay,Limit,Hysteresis

Reaction 1

Reaction 2

Reaction ...

Time EndTrigger

 Note: A pure basis license does not include the advanced feature
Trigger (also, see  Options of the Dionex Chromatography
Management System).

Also, see ⇒Trigger Commands
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TTL
TTL (Transistor-Transistor Logic) inputs and outputs are electronic switching
devices for controlling instruments.

TTL Input Mode
The PDA-100 TTL inputs respond to four types of device output signals. The
default TTL signal mode, normal edge, is compatible with the output signals
provided by Dionex modules.

If the device connected to the PDA-100 outputs a different signal type, select a
different signal mode

The four input signal modes are:

Normal Edge: In normal edge operation, the negative (falling) edge of a signal
turns on the function and the positive (rising) edge turns off the function.

Inverted Edge: The inverted edge mode works identically to the normal edge
mode, except that the positive and negative edges are reversed in function.

Normal Pulse: In normal pulse operation, the negative (falling) edge of the TTL
signal is the active edge and the positive (rising) edge is ignored.

The minimum pulse width guaranteed to be detected is 50 ms. The maximum
pulse width guaranteed to be ignored as noise or invalid is 4 ms. The action of
the PDA-100 is undefined for pulses less than 50 ms or greater than 4 ms.

Inverted Pulse: The inverted pulse mode operates identically to the normal
pulse mode, except that the positive and negative edges are reversed in
function.



Glossary A-169

EDGE

PULSE

+5V

+5V

Off

Off

Off

Off

Normal Polarity (negative) Inverted Polarity (positive)

Inverted (positive-going)Normal (negative-going)

On

On

On

On

Default

Off

Off

Off

Off
0V

0V

Type (Peak Type)
The Type peak result variable classifies a peak as main peak (M=Main) or

Rider (R=Rider). This variable also indicates the type of baseline contact
(B=Baseline) and whether the peak data has been manually modified
(*=modified).

Also, see ⇒Type (Peak Type)

UCI-100 Universal Chromatography Interface
The UCI-100 Universal Chromatography Interface serves as a data acquisition
and device control module. It provides several different interfaces and makes
them available to the chromatography server:
• Analog inputs

• Serial RS232 ports

• Digital inputs

• Digital outputs

• BCD inputs

For communication between the different devices and the server's
chromatography data system, either a USB or an Ethernet connection can be
used.

 Tip: Use the RS232 interfaces (COM ports) via USB only (no
TCP/IP)! NT4 computers do not support USB. Thus, if LAN
connections are required, additional Equinox boards must be
used for instrument control via RS232. We recommend using a
peer-to-peer connection for analog data acquisition via LAN
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(= installation of a second network interface card (= NIC; in the
operating system = adapter) in the server PC - see

 Connecting the UCI-100 via a Peer-to-Peer Connection
under NT4).

 Tip: Always connect instruments requiring a GSIOC cable (such as
 GILSON devices and the  VARIAN/RAININ (Pumps)) to

the multi-serial 8-fold PCI interface board (Equinox 8-RS232
Multi-COM card, Dionex part no. 5906.2095). Otherwise,
communication problems might occur with other RS232 ports
(e.g. with the COM ports of the PC or the Dionex Universal
Chromatography Interface (UCI-100)). The power supply of the
GSIOC adapter (type 605) is directly via the RS232 interface.
The RS232 ports of the UCI-100 Universal Chromatography
Interface, however, are not designed for this.

Also, see  Dionex Universal Chromatography Interface (UCI-100)

UI20 Universal Interface
The UI20 Universal Interface functions as a communications and control link
between the PC and instruments that are not directly connected to the DX-
LAN. This enables the Dionex Chromatography Management System to collect
data from any chromatographic detector with an analog output. The UI20
collects up to two analog detector voltage signals and converts them to digital
data with 20-bit resolution.

Unzoom
The Unzoom command undoes the last zoom operation.

In the signal plot, the Unzoom command can be performed by double-clicking
in the Overview Window.

Use Recently Detected Retention Time
This ⇒QNT Editor parameter (General sheet) defines whether the retention
time stored in the peak table (nominal time) is used by default to identify a peak
or whether the actual retention time of a peak in the last sample is used.
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The parameter serves to compensate many types of drift appearances (e.g.
evaporation of volatile components in pre-mixed solvents or column aging).

Also, see ⇒Use Recently Detected Retention Time.

User Database
The user database defines the user rights (= Privileges) and the membership
of the individual users in Access Groups. Creation of the user database is in
the CmUser program. Activation of the user database is in the CmSecure
program so that the User-Mode is enabled.

 Tip: Due to the similarity of the term, do not confuse a user database
with a Datasource (database) of the Dionex Chromatography
Management System. Although both may be e.g. ACCESS
databases (= mdb container), they are two completely different
databases.

User-defined Columns
The Dionex Chromatography Management System contains tables with
different meanings at various positions within the program, for example:
• The different tables in the Report and in the Printer Layout

• The sample list in the  Browser

• The peak table in the ⇒QNT Editor... .

While the user defines the Report and the Printer Layout, anyway, the form of
the sample list and peak table is mainly default. Nevertheless, you can define
your own columns in all three tables.

In the Report and the Printer Layout, new columns can be created via the
Report Publisher to display special aspects of your data. For further

information, see How to ...: Actions in the Printer Layout  Entering User-
defined Formulas.

User-defined columns in the sample list and the peak table can be used as
further variables for generating a report. In the sample list, they can be used in
addition as further search words for a Query. Also, see How to ...: Actions in
the Browser  Creating User-defined Columns.
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 Tip: Be careful when creating user-defined columns in the sample
list of the Browser. Do not assign column names twice in
different Datasources or even on different computers that
may communicate with each other. Otherwise, unless the
column definitions are identical, problems may occur when
copying sequences or during the  Restore of backup files.

User Mode
The User Mode (= Access Control) can be enabled and disabled via the
CmSecure program. When the User Mode is enabled, the Dionex
Chromatography Management System offers numerous options to limit user
access to Servers, Timebases, Clients, and Datasources.

System access is password-protected. Access is only granted to users who are
identified by the system after password input.

Each user identified by the system is granted personal privileges. The system
administrator assigns these privileges. Via the Access Group and Privilege
group membership of a user, the administrator defines the operations the user
can perform within the system.

If access control is disabled, each user receives all rights. Datasources or
directories that have access groups assigned cannot be accessed when the
User Mode is disabled. With enabled User Mode, the user can access an
object if he/she is a member of a group granting access to the respective
object. If no access group is assigned to an object, each user can access the
object independently of his/her access group membership.

Enabled User Mode allows the user to access any object provided it is part of
the respective access group. The sum of all privileges granted to the user
(depending on his P-group membership) determines what the user is allowed
to do with the object. Signing sequences electronically (see Electronic
Signature) is possible with enabled User Mode only.

For a detailed description, see  Access Control.

UV Cutover
The UV Cutover command for the AD20 Absorbance Detector sets the
wavelength above which the second order filter is inserted in the light path.
Typically, the UV cutover wavelength is 380nm.
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UV Detector
UV detectors (strictly speaking UV/VIS detectors) serve to quantify absorption
of UV/VIS-active substances in the range from 190 to 380nm (UV range) and
380 to 900nm (VIS range). UV detectors provide high sensitivity and a large
linearity range. UV detectors are relatively independent from temperature
fluctuations; they can be used for gradient elution (%-gradient).

Functionality
A grating (b) disperses the light that is emitted from a light source (a) in a
discontinued spectrum. Simultaneously, the grating serves as a filter and
directs only the wavelengths required for detection to a beam splitter (c). A
portion of the beam is directed through the flow cell (d) onto a photodiode (e),
the other part is used as a reference (f).

a

b

c d e

f

Theory

Depending on the absorptivity (ε) of the substance, the light beam is more or
less attenuated when traversing the flow cell. For the absorption (E), the
following is true:

E = ε c d

As the length of the cell (d) is constant and the absorptivity (ε) depends only on
the substance itself or the absorbed wavelength, there is a direct connection
between the substance concentration (c) and the absorption (E). The
absorption measured in AU ("absorbance unit") is thus proportional to the
number of particles in the beam path ("Lambert-Beer absorption law").

Spectra Calibration

Spectra calibration is performed automatically after each ⇒Lamp On/Off or
⇒Connect command (detector calibration). The CheckWavelength
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command allows you to include the largest wavelength deviation of this
calibration in the Audit Trail.
A calibration is possible only when certain conditions are met:

1. During calibration, the baseline must be sufficiently stable. This may not be
the case e.g. when the solvent composition was modified or when there
were air bubbles in the solvent.

2. The solvent in the cell must not be fully absorbing in the wavelength range
that shall be calibrated. This will be the case e.g. if the cell is filled with
96% hexane / 4 % ethyl acetate.

3. Ensure for the calibration that the deuterium lamp is already warm because
its spectrum changes much during the first minutes after switching on the
lamp.

If these conditions are not met, the process will be interrupted with the
corresponding error message. When the problem is solved, repeat the
calibration using the Disconnect command first followed by Connect.

Detector Calibration
To calibrate the detector, the transmission spectrum of the deuterium lamp is
compared with that of the holmium oxide filter. With the resulting spectrum, the
maxima are determined and are compared with the holmium oxide values
stated in the literature. If, for a maximum, a difference is detected between the
measured and the known value, an interpolation is performed between this
maximum and the two adjacent maxima to correct the wavelength allocation of
the affected photodiodes. The spectra calibration can take up to 2 minutes.
During this time, data acquisition is not possible.

Also, confer Photodiode Array Detector.

UV Lamp
This command switches the UV lamp on Dionex absorbance and PDA
detectors on and off. For the AD20 Absorbance Detector (see UV Detector),
the command options are Low, High, and Off.

 Tip: If you switch the AD20 lamp from Off to Low or High, there is a
22 second pause while the UV lamp warms up. During this time,
the status of the lamp on the Control Panel remains at Off.
Once the warm-up period is complete, the status changes to the
selected setting (Low or High). The Audit Trail window logs the
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UV_Lamp command and the warm-up time.

 Tip: Detector lamps require a considerable warm-up time for high-
sensitivity and drift-free operation. Therefore, the ⇒Inject
command should be placed 10 minutes (minimum) after the
lamp is switched on. Note also that lamp(s) should never be
switched off during a sample batch.

Validation Sample
Samples of known concentration that serve to verify a calibration are referred
to as validation samples. In the sample list, they are labeled with the sample
⇒Type Validate and have the following symbol: .

Verification is by regular insertion of the validation samples in the normal
analysis. The resulting (actual) area values are converted into amounts via the

Calibration Function and parameters and are then compared with the
expected (nominal) values in the ⇒Amount table. The result of the
nominal/actual comparison can be displayed as direct amount (Result Variable
Amount Deviation) or as deviation in percent (Rel. Amount Deviation).

Checking can also be performed visually if you display the validation samples
(marked by colors) in the calibration curve. They will not be considered for
calibration, though.

Validation samples can also be injected from vials that are normally used for
injection of standard (calibration) samples. Validation samples are not relevant
for the calculation of the calibration function!

For further information on validation samples, see How to ...: Actions in the
QNT Editor:

 Entering the Concentration/Amount of the Validation Sample

 Validating the Calibration Curve

Valley to Valley
The activated Valley to Valley detection parameter draws the baseline from
peak minimum to peak minimum below non-resolved peaks, i.e., from peak end
to peak end.

Also, see ⇒Valley to Valley
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For in formation on how to apply detection parameters, see How to ...: Actions
in the QNT Editor  Modifying Detection Parameters.

Variance
The Variance calibration variable is the average deviation of all area values F
from the corresponding ideal area value in a calibration. The ideal area value is
the value at the point of intersection between the calculated calibration curve
and the corresponding amount value.

Amount

Area

0
c0

F(ideal)
F4

A4

F3

A3

F2

A2

F1

A1

Calibration curve

Variance

Variance is therefore a criterion for the measuring accuracy in the calibration.
With an increasing value, calibration points are increasingly scattered.

The mathematical description of the variance is as follows:
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N: Number of standard samples involved in the calibration,
m: Number of coefficients to determine (depending on the ⇒Calibration Type: LIN: m = 1;

LOFF: m = 2; QUAD: m = 2; QUOFF: m = 3 and EXP: m = 2),
i: Index for standard samples,
F(x): Model function of the calibration,
Xi: X-value of the standard sample no. i,
Yi: Y-value of the standard sample no. i,
Wi: Weight factor of the standard sample no. i, and
∆ i: Yi - F(Xi)

If the square root of the variance value is extracted, the result is the Standard
Deviation calibration variable, i.e., the square standard deviation is the
variance.

Variance Coefficient
The Variance Coefficient calibration variable can be considered a type of
normalized Variance value. It is more meaningful when comparing variances
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of different peaks with different concentrations. A variance coefficient near zero
means that the calibration curve well approximates the calibration points.

Thus, the variance coefficient indicates how well the data points correspond to
the theoretically assumed course of the curve. Similar to Coefficient of
Determination and in contrast to the Correlation Coefficient   it depends on
the calibration type. The mathematical description of the variance coefficient is
as follows:
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N: Number of standard samples involved in the calibration,
i: Index for standard samples,
F(x): Model function of the calibration,
Xi: X-value of the standard sample no. i,
Yi: Y-value of the standard sample no. i,
Wi: Weight factor of the standard sample no. i.

Virtual Channel Driver (VCD)
The Virtual Channel Driver offers the possibility to record, display, save, and
export the system status (e.g. relay status, gradients, pump pressure) or

Virtual Signals (e.g. UV_VIS_1/UV_VIS_2) as signals. The   Virtual
Channel Driver allows you to calculate any arithmetic expression during data
acquisition, and then display the result as a signal channel and save it. Any
combination of numeric characters can be used as terms in the expression.

For information on how to install the Virtual Channel Driver (VCD), see
 Virtual Channel Driver: Installation.

Virtual Signals
Signals that are composed of or calculated from several readings at the time t
are referred to as virtual signals (e.g. the arithmetic average of several
channels or the signal of a photodiode array detector). Virtual signals frequently
have Reserved Signal Names (e.g. 3DFIELD). ). Virtual signals are
generated with the Virtual Channel Drivers.
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As virtual signal cannot be generated manually, the corresponding program
must be started. For information on how to enter commands, see How
to ...: Device Control  Virtual Channel Commands.

Visible Lamp
This command switches the visible lamp of Dionex absorbance (see: UV
Detectors) and Photodiode Array Detectors on and off. For the AD20
Absorbance Detector, the command options are Low, High, and Off.

 Tip: Detector lamps require a considerable warm-up time for high-
sensitivity and drift-free operation. Therefore, the ⇒Inject
command should be placed 10 minutes (minimum) after the
lamp is switched on. Note also that lamp(s) should never be
switched off during a sample batch.

Volume
See Injection Volume

Wait
The Wait command interrupts program execution until the specified remote
input signal arrives. During this time, program time and data acquisition are
stopped. Controlled pumps are kept in the Hold mode.

For examples for using the Wait command, see the following topics: How to ...:
Device Control:

  Control - Autosampler

  Special Commands, Relays, and Others

Also, see ⇒Wait

Wait for Stable Temperature (AS50 Command)
The Wait for Stable Temperature AS50 Autosampler command delays the
start of a timebase program until the temperature of the thermal compartment
and/or sample tray has stabilized.
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Wash
The Wash command causes the autosampler to lower the needle into the
needle seat and to rinse the sample loop and needle with solvent in the Inject
state. This corresponds to the normal solvent flow following an ⇒Inject
Command.

 Tip: Use the Wash and ⇒NeedleUp commands to wash the sample
loop and thus prevent crystallization of substances in the sample
loop.

Also, see ⇒Wash

Waveform
A series of steps, defined as points on a plot of potential vs. time. A waveform
must be defined when using the Dionex electrochemical detector in

Integrated Amperometry Mode.

Wavelength
UV Detectors and Photodiode Array Detectors are the most commonly

used detector types in HPLC. Simple UV detectors record chromatograms at a
defined wavelength (λ) while PDA detectors record them in a defined
wavelength range. The wavelength and the wavelength range, respectively,
depend on the detector and can vary between 190 to 900 nm.

This value indicates the wavelength at which a chromatogram is measured.

On Dionex photodiode array detectors, the wavelength is not set directly on the
instrument, but via the PC. In Dionex Chromatography Management System
installations with a controlling option, the wavelength can also be entered
manually during the analysis or in the PGM File.

In the case of the UV-VIS, 3DFIELD, and SPECTRA signals, wavelength
means the central wavelength, i.e., the wavelength around which a field with a
symmetrical ⇒Bandwidth is formed.

Also, see ⇒Wavelength
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Wavelength Switching
The exact switching of the measuring wavelength on a UV detector is referred
to as wavelength switching.

Wavelength switching allows simultaneously measuring substances with
strongly differing absorption maxima and no or little absorption at the
wavelength of the other maximum.

Generally, switching the wavelength is program-controlled, i.e., the switch
times at which the wavelength of a specific channel is changed, is entered in a
control Program. This can also be performed by extracting the Optimum
Integration Path from an opened 3D-Field (Extract: Opt.Int.Path to
Clipboard).

 Note: With fluorescence detectors, wavelength switching is also
possible. In virtually all cases, the excitation wavelength must be
changed at the exact time in addition to the detection
wavelength.

Weights
The Weights calibration variable indicates the weighting (see How
to ...: Actions in the QNT Editor  Weighting and Averaging Calibration
Points in the Creating a Peak Table chapter ) assigned to the individual

Calibration Points when creating the calibration curve.

Define the weighting in the ⇒Calibration Type column of the ⇒QNT Editor.
The following options are available:

No weight Default: higher weighting of higher amounts.

1/Amount (X) Nearly cancels out the weighting of higher amounts/signal values.

1/Amount2 (XX) Causes over-proportional weighting of smaller amounts.
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1/Response (Y) Nearly cancels out the weighting of higher signal values. In this case, the
Y-values (dependent signal values) of the Calibration Points are used
as weight factors instead of the X-values (nominal amounts).

1/Response2 (YY) Causes over-proportional weighting of smaller signal values. In this case,
the Y-values (dependent signal values) of the calibration points are used
as weight factors instead of the X-values (nominal amounts).

Width
This peak result variable refers to the peak width extrapolated on the baseline.
Peak tangents are drawn from the turning points of the ascending and the
descending flanks. Then the points of intersection with the baseline are
calculated. The time distance between the two points of intersection is defined
as the base width. If the base width is used for calculating other parameters,
the abbreviation is BW.

100 %

50 %

10 %
5 %W5 %

W10 %

W50 %

BW

Height

The Dionex Chromatography Management System also determines the peak
width at 5, 10, and 50% of the peak height (abbreviations: W5%, W10% and
W50%).

 Caution: In contrast to the base width BW, the peak widths at 5, 10, and
50% of the peak height (W5%, W10%, and W50%) are not only
measured up to the point of intersection with the two tangents,
but up to the signal curve!

Determining the peak width is only possible if the peak is
resolved at least to half the height.

If you wish to display the peak width in the report, please proceed as follows:
Select the column in the report, choose the Column Properties command
from the context menu and select the Width variable in the selection box.
Press the Parameter button to determine at which peak height to determine
the peak width.
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Window
The Window peak table parameter defines the tolerance interval, within which
the peak is expected. Adding and subtracting the window value to the retention
time (retention time +/- window value), determines the window size, i.e., the
window always has twice the width of your input. In addition, the value can be
interpreted as absolute or relative value:

Also, see ⇒Window

Wizard
Various input procedures such as creating a Sequence, or a Program or
defining Query conditions are facilitated by using Wizards. The system
prompts the user to define conditions and to enter the required information. The
Wizard then adds default elements and thus completes a basic structure. If
required, the user can extend or modify this structure according to individual
requirements.

Use the Wizards to avoid unnecessary typing, syntax errors in command
entries and overlooking important information and parameters.

Worklist
The format for reading data (sequences) of a LIMS in the Dionex
Chromatography Management System is referred to as Worklist (WLE file).
The worklist describes the contents and the structure of a sequence (also, see

Worklist Format).

Choose the New... command from the File menu and then Sequence (From
LIMS Worklist) to import an existing worklist.

If importing is possible, the imported sequence is listed in the Browser. The
existing worklist is deleted to prevent importing it again.

If an error occurs when importing, the Dionex Chromatography Management
System reports an error describing the error and the error location in the
worklist. The error message is also saved in a log file. This log file carries the
worklist name and the extension log. The incorrect worklist file is renamed to
*.err.
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Worklist Format
Worklists have the file extension .wle (Work List Export). The structure and the
syntax of the Worklists are similar to the Windows INI files.

There are various sections. Each section starts with a new line. The name of
he section is written in brackets. There are one or several entries below the
section name, with the syntax name = value. Comments start with a semicolon
and finish at the end of the line.

Example of a valid worklist:

; Worklist generated by MegaLIMS 3.11.5622.00a
; Wed 05/27/98, 16:25:02

[options]
Application = CHROMELEON
Delete Worklist = No
Rename On Error = No

[file names]
; datasource, path, and name for the generated sequence
Sequence = \labor2_local\sys58\sequences\lims4711
; default for the program column
pgm = pgm0815
; default for the QNT method column.
qnt = qnt0815
; copy PGM Files from here (datasource, and path)
pgm templates = \server1\templates\hplc

; copy Quantification Methods (QNT Methods) as stated here (datasource, path, and name)
[qnt files]
qnt0815 = \server1\templates\hplc\pah\qnt0815
noint = \server1\templates\common\noint

[defaults]
; default for injection volume
Injection Volume = 10.0



A-184 Glossary

[1]
Name=Wash
Type=Blank Run
Pos=1
; use the "Wash" program instead of  the default ("pgm0815")
PGM=Wash
QNT=NOINT
; default for the user-defined column Water Contents - the marking asterisk * is omitted with

User-defined Columns
Water contents = 72.3

[2]
Name=Std
Type=Standard
Pos=99

[3]
Name=Sample1
Pos=2

[4]
Name=Sample2
Pos=3

[5]
Name=Sample3
Pos=4

[6]
Name=Sample4
Pos=5

[7]
Name=Stop
Type=Blank Run
Pos=1
PGM=Stop
QNT=NOINT
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With this worklist, a sequence named lims4711 is created in the datasource
labor2_local in the sys58\sequences directory. The sequence contains a
rinse sample, a standard, four unknown samples, and a stop program.

All control programs are copied from the subdirectory \templates\hplc of the
datasource Server1 (central file server). The source must contain the
pgm0815, wash, and stop programs.

The evaluation method for the rinse and stop samples is copied from
\templates\common\noint.qnt, the method for the analysis samples is copied
from  \templates\hplc\pah\qnt0815.qnt (both in the datasource server1).

Path Information
The entire path information of the worklist is related to the data structure of the
Dionex Chromatography Management System. Therefore, the path name starts
with the Datasource, not the hard disk name. Relative paths are not
accepted. Path names can be expressed either in the internal syntax of the
Dionex Chromatography Management System (Moniker) (e.g.
SEQ::\labor2_local\sys58\sequences\lims4711) or in a simplified syntax (as
above), which omits the type abbreviation and the double colon. In this case, a
slash or a colon can be used instead of the backslash.

Sequence = SEQ::\labor2_local\sys58\sequences\lims4711

Sequence = \labor2_local\sys58\sequences\lims4711

Sequence = Labor2_local:sys58/sequences/lims4711

All of the above paths refer to the sequence lims4711 in the directory
sys58/sequences of the datasource Labor2_local.

Do not include type extensions (.PGM, .QNT, .SEQ) in the path information.

Handling of PGM Files and QNT Files
The program and the method columns of the sequence only include the file
name without the path information, as the files are always located in the
sequence. The same applies to the corresponding options (PGM= and QNT=)
in the WLE file (see below).

The LIMS import module creates these files by copying them to the sequence.
There are two possibilities to specify where to find these templates to copy:
• If all used files of a type are located in the same directory (the template

directory), its path can be determined in the section [file names] via

PGM Templates = path to template directory  or. QNT Templates= for QNT files
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The Dionex Chromatography Management System searches the
corresponding template directory for a file with the specified name and
copies this file to the sequence.

• If the copy templates are located in different directories, the path of each
section has to be given in the section ‘[PGM file]’ or ‘[QNT files]’. On the left
side of the equal sign, the file name is located, and on its right side, the
complete path of the template is indicated.

Technically, it may be possible that the file name of the template differs
from the name of the copied file. However, this will not be accepted.

Both methods can be mixed. In case of doubt, the second method has priority.
If there is an entry in the section [PGM files], the PGM template file is not
searched.

If all samples use the same PGM and QNT files, it makes no difference which
method is used.

Section [OPTIONS]
The options listed in this section will influence the import function. Usually, no
entries are required here. When testing a worklist, it may be useful to disable
the Delete Worklist and Rename On Error commands. Thus, the worklist is
retained instead of being deleted after importing.

Application = Chromeleon indicates that this worklist is intended for the
Chromeleon. If there is a different entry here, the worklist will not be accepted
by the Chromeleon. In this case, no log file is created, and the worklist is
neither deleted nor renamed.

Computer Name = <Name of PC> indicates where to copy the worklist. If this
entry does not correspond to the local computer, the worklist is not accepted. In
this case, no log file is created, and the worklist is neither deleted nor renamed.

Log Error = Yes creates a log file containing the error message in the event of
an error.

Log Success = Yes creates a log file documenting the successful import.
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Delete Worklist = Yes deletes the worklist when importing was successful.

Rename On Error = Yes renames the worklist in *.err in the event of an error.

Character Set = Windows indicates the character set of the worklist. Any
generated log file is also written with this character set. Change this option if
some special characters, e.g. umlauts, are not transferred correctly. Valid
values: Windows or ANSI (system character set, i.e. no conversion) DOS or
OEM (PC character set, conversion by Windows function OEMToAnsi).

Section [FILE NAMES]
This section determines various file names. Sequence = indicates the path and
the name of the sequence to generate. This parameter must always be
specified. PGM = or QNT = determines the default value for the PGM column
or the QNT column. (The default value can be overwritten for each sample).

PGM Templates = and QNT Templates = determine the corresponding
template directory (see above).

Sections [PGM Files], [QNT Files]
The sections define from where to copy the PGM and the QNT files. Entries in
this section take priority over a template directory. Entries have the following
syntax:

name = path

On the left side of the equals sign, the file name is located, and on its right side
the complete path of the template.

Section [DEFAULTS]
This section defines default values for various sample variables. Name=,
Comment=, Pos=, Type=Unknown, Status=Single, Sample Weight=1.0,
Dilution Factor=1.0 and Injection Volume=20.0 have the same meaning as in
the Browser. The corresponding value range is also identical.

Note: The default values for the PGM and the QNT files are defined in the
section [FILE NAMES].

Section [SEQUENCE]
This section defines the properties of the sequence.

Title = Created from worklist <Name of Worklist> determines the name
(description) of the sequence.
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Timebase = determines the timebase on which the sequence is executed.

Report = determines the default value for the report template (appears in the
print dialog)

Channel = determines the default value for the channel when printing (appears
in the print dialog)

Section [n] (Sample Data Records)
Each sample is described by one section. The section must have the name
[n], where n is the sample number (without leading zero). The samples must
be numbered consecutively. With a new sequence, sample numbering must
start with 1. Samples can be appended to existing sequences. In this case,
sample numbering must start with the next free sample number in the
sequence (as number of samples in the sequence plus one). A sample section
can have the entries PGM=, QNT=, Name=, Comment=, Sample ID=,
Replicate ID=, Pos=, Type=Unknown/Blank/Validation/Standard/Matrix,
Status=Single/Multiple/Finished, Sample Weight=1.0, Dilution Factor=1.0
and Injection Volume=20.0. Missing entries are completed by the defaults in
the sections [DEFAULTS] and [FILE NAMES].

 Tip: In the worklist, omit the asterisk (*) which marks User-defined
Columns  in the Browser.

Workspace
The area between the menu bar or Toolbar and the Status Bar is called
Workspace. Within this area, the currently open windows of the various
"window types" are displayed.

The Workspace allows you to open a specific set of windows. Normally, this is
the most recently used workspace.

Choose Autosave Workspace in the Workspace menu to open the most
recently used workspace whenever starting the Dionex Chromatography
Management System (e.g. two Control Panels showing the status of two
different HPLC systems).

Of course, it is also possible to save or open any view with a separate name.
The Dionex Chromatography Management System stores this information in
WSP files. Use this option to save a view for data processing and a view for
peak purity analysis etc.
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If you want to save settings of an individual window without changing the
Workspace, you can use a Report Definition File (RDF). The RDF is used
whenever a sample or a window is opened individually, not in connection with a
Workspace.

Combining RDFs and a Workspace allows each user to have a personal
representation of the screen. For a detailed description, see  User Profiles.

Xcalibur
Xcalibur (= XC) is the software data system of ThermoQuest Corporation.
Controlling the Finnigan aQa Mass Spectrometer via the Dionex
Chromatography Management System requires the Xcalibur software. Two XC
setup programs are available on the installation CD. For installation information
see How to ...: Actions Related to the aQa-MS  Installing MS
Components.

Xcalibur allows you to define programs for the aQa mass spectrometers in a
PGM File. You can create the control file via the Dionex Chromatography

Management System (see How to ...: Actions Related to the aQa-MS
 Creating a Method for the aQa-MS) using the corresponding XC Editor.

Year 2000 Conformity
According to the document PD2000-1:1998 which was published by the British
Standards Institution (BSI) "year 2000 conformity shall mean that neither
performance nor functionality is affected by dates prior to, during and after the
year 2000."

In particular, this means that the following rules are adhered to:

1. General Integrity: No value for current date will cause any interruption in
operation.

2. Data Integrity: Date-based functionality must behave consistently for dates
before, during, and after year 2000.

3. Explicit/Implicit Indication of the Century: In all interfaces and data storage,
the century in any date must be specified either explicitly or by unambiguous
algorithms or inferencing rules.

4. Leap Year: Year 2000 must be recognized as a leap year. (According to the
Gregorian Calendar the year 1900 was not a leap year.)
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Versions 4.20 and higher of the Dionex Chromatography Management System
fulfill the BSI rules mentioned above. As previous versions (4.12 and lower) do
not completely fulfill the year 2000 conformity, upgrading to the current version
is recommended.

The Dionex hardware fulfills the BSI rules in the same way. Two instruments of
the previous generation that is no longer available (M480 pump and GINA160

Autosampler) the year 2000 are displayed as 1900. This, however, does not
affect the functionality.

Please do not hesitate to contact Dionex Service for the corresponding Year
2000 Certificate.

Zoom
Press the left mouse button and draw a frame around a section of a signal plot
or a 3D-field that you wish to zoom. Select Unzoom to undo the last zoom
operation. Select Full size to return to the original display (100%
representation).

 Notes: In the online signal plot, an Overview Window is displayed in
the upper right corner in addition to the enlarged section.

While drawing a zoom frame, the operation can be canceled by
pressing the ESC key or the right mouse button. Use this
function to prevent redrawing the window (e.g. a 3D plot) when
the wrong frame was selected.
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